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End User License Agreement
1. READ CAREFULLY
YOU SHOULD READ THE FOLLOWING TERMS AND CONDITIONS BEFORE ACCEPTING THIS
END-USER LICENSE AGREEMENT ("EULA"). THIS EULA IS A LEGAL AGREEMENT BETWEEN
YOUR ORGANIZATION, THE END USER, AND SPECTRA LOGIC CORPORATION ("SPECTRA")
FOR THE SPECTRA SOFTWARE PRODUCT WHICH INCLUDES COMPUTER SOFTWARE AND
MAY INCLUDE ASSOCIATED MEDIA, PRINTED MEDIA, AND "ONLINE" OR ELECTRONIC
DOCUMENTATION (COLLECTIVELY, "SOFTWARE PRODUCT"). BY INSTALLING, COPYING, OR
OTHERWISE USING THE SOFTWARE PRODUCT, YOU AGREE TO BE BOUND BY THE TERMS
OF THIS EULA. IF YOU DO NOT AGREE TO THE TERMS OF THIS EULA, YOU MAY NOT
INSTALL, COPY, DOWNLOAD OR USE THE SOFTWARE PRODUCT. YOU AGREE THAT YOUR
USE OF THE SOFTWARE ACKNOWLEDGES THAT YOU HAVE READ THIS AGREEMENT,
UNDERSTAND IT, AND AGREE TO BE BOUND BY ITS TERMS AND CONDITIONS.
2. OWNERSHIP
It is understood and agreed that Spectra Logic Corporation, a Delaware corporation with offices at
6285 Lookout Road, Boulder, CO 80301 ("Licensor") is the owner of all right, title and interest to the
Software Product, regardless of the media or form of the original download, whether by the World
Wide Web, disk or otherwise. You, as licensee ("Licensee") through your downloading, installing,
copying or use of this product do not acquire any ownership rights to the Software Product.
3. GENERAL
The Software Product is licensed, not sold, to you by Spectra for use only under the terms of this
EULA. The Software Product is protected by copyright laws and international copyright treaties, as
well as other intellectual property laws and treaties. The rights granted herein are limited to Spectra's
and its licensors' intellectual property rights in the Software Product and do not include any other
patents or intellectual property rights. The terms of this EULA will govern any software upgrades
provided by Spectra that replace and/or supplement the original Software Product, unless such
upgrade is accompanied by a separate license in which case the terms of that license will govern.
4. SOFTWARE PRODUCT
The Software Product, as used in this EULA, means, collectively and/or as applicable:
• The Software Product package;
• Any and all contents, components, attachments, software, media, and code with which this

Agreement is provided and delivered;
• Any and all images, photographs, art, art work, clip art, fonts or other artistic works (the "Art

Work");
• Related explanatory written materials and instructions, and any other possible documentation

related thereto ("Documentation"); and
• Upgrades, modified versions, updates, additions and copies of the Software Product (the

"Upgrades"), if any, licensed to by Spectra under this EULA.
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5. GRANT OF LICENSE AND RESTRICTIONS
a. Spectra grants you a non-exclusive, non-transferable End-User license right to install the

Software Product solely for the purpose for which it was created.
b. Unless provided otherwise in the Documentation or by prior express written consent of

Spectra, you shall not display, modify, reproduce and distribute any Art Work, or portion(s)
thereof, included with or relating to the Software Product, if any. Any such authorized
display, modification, reproduction and distribution shall be in full accord with this EULA.
Under no circumstances will your use, display, modification, reproduction and distribution of
the Art Work give you any Intellectual Property or Proprietary Rights of the Art Work. All
rights, title, and interest belong solely to Spectra.

c. Except for the initial loading of the Software Product, you shall not, without Spectra's express
written consent:

• Copy or reproduce the Software Product; or
• Modify, adapt, or create derivative works based on the Software Product or any accompanying

materials.
6. DESCRIPTION OF OTHER RIGHTS AND LIMITATIONS

a. Spectra will provide you with support services related to the Software Product ("Support").
Such Support will be provided in accordance with the Spectra Master Support Agreement,
available for download and viewing on the Spectra Corporate Web site. Use of Support is
governed by this EULA and Spectra's Master Support Agreement.

b. Any supplemental software, code, content, or media provided to you in the course of Support
shall be considered part of the Software Product and subject to the terms and conditions of this
EULA.

c. Spectra retains all right, title, and interest in and to the Software Product, and any rights not
granted to you herein are reserved by Spectra. You hereby expressly agree not to extract
information, reverse engineer, disassemble, decompile, or translate the Software Product, or
otherwise attempt to derive the source code of the Software, except to the extent allowed
under any applicable law. In the event that such activities are permitted by applicable law, any
information you, or your authorized agent, discover shall be promptly disclosed to Spectra
and shall be deemed the confidential information of Spectra.

d. You shall not modify, sublicense, assign, or transfer the Software Product or any rights under
this EULA, except as expressly provided in this EULA. Any attempt to sublicense, assign, or
transfer any of the rights, duties, or obligations will be void.

e. You may permanently transfer all of your rights under this EULA, provided you retain no
copies. The other party must agree to accept the terms and conditions of the EULA.

7. ALL RESERVED
All rights not expressly granted herein are reserved by Spectra.
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8. TERM
a. This License is effective until terminated. Licensee may terminate it at any time by destroying

the Software Product with all copies, full or partial, and removing all of its component parts.
b. Your rights under this EULA will terminate automatically without notice from Spectra if you

fail to comply with any term(s) or condition(s) of this EULA. In such event, no notice shall be
required by Spectra to effect such termination.

c. Upon termination of this EULA, you shall cease all use of the Software Product and destroy all
copies, full or partial, together with all backup copies, modifications, printed or written
materials, and merged portions in any form and remove all component parts of the Software
Product.

9. INTELLECTUAL PROPERTY RIGHTS
a. Spectra shall retain all right, title, and interest in the Software Product and to any

modifications or improvements made thereto, and any upgrades, updates or Documentation
provided to End User. End User will not obtain any rights in the Software Product, its
updates, upgrades, and Documentation, as a result of its responsibilities hereunder.

b. End User acknowledges Spectra's exclusive rights in the Software Product and that the
Software Product is unique and original to Spectra and that Spectra is owner thereof. Unless
otherwise permitted by law, End User shall not, at any time during or after the effective Term
of the Agreement, dispute or contest, directly or indirectly, Spectra's exclusive right and title to
the Software Product or the validity thereof.

10. U.S. GOVERNMENT END USERS
The Software Product and related documentation are "Commercial Items," as that term is defined at
48 C.F.R. §2.101, consisting of "Commercial Computer Software" and "Commercial Computer Software
Documentation," as such terms are used in 48 C.F.R. §12.212 or 48 C.F.R. §§227.7202-1 through
227.7202-4, as applicable. The Commercial Computer Software and Commercial Computer Software
Documentation are being licensed to U.S. Government end users (a) only as Commercial Items and (b)
with only those rights as are granted to all other End Users pursuant to the terms and conditions
herein. Unpublished rights reserved under the copyright laws of the United States.
11. EXPORT LAW ASSURANCES
You may not use or otherwise export or re-export the Software Product except as authorized by
United States law and the laws of the jurisdiction in which the Software Product was obtained. In
particular, but without limitation, the Software Product may not be exported or re-exported (a) into
(or to a nation or resident of) any U.S. embargoed countries or (b) to anyone on the U.S. Treasury
Department's list of Specially Designated Nationals or the U.S. Department of Commerce Denied
Persons List or Entity List. By installing or using any component of the Software Product, you
represent and warrant that you are not located in, under control of, or a national or resident of any
such country or on any such list.
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12. DISCLAIMER OF WARRANTIES
YOU EXPRESSLY ACKNOWLEDGE AND AGREE THAT USE OF THE SOFTWARE PRODUCT IS
AT YOUR SOLE RISK AND THAT THE ENTIRE RISK AS TO SATISFACTORY QUALITY,
PERFORMANCE, ACCURACY AND EFFORT IS WITH YOU. TO THE MAXIMUM EXTENT
PERMITTED BY APPLICABLE LAW, AND EXCEPT AS MAY BE STATED IN THE SPECTRA
MASTER SERVICE AGREEMENT, THE SOFTWARE PRODUCT IS PROVIDED "AS IS," WITH ALL
FAULTS AND WITHOUT WARRANTY OF ANY KIND, AND SPECTRA AND SPECTRA'S
AFFILIATES (COLLECTIVELY REFERRED TO AS "SPECTRA" FOR THE PURPOSES OF SECTIONS
12 AND 13) HEREBY DISCLAIM ALL WARRANTIES AND CONDITIONS WITH RESPECT TO THE
SOFTWARE PRODUCT, EITHER EXPRESS, IMPLIED OR STATUTORY, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIED WARRANTIES AND/OR CONDITIONS OF MERCHANTABILITY, OF
SATISFACTORY QUALITY, OF FITNESS FOR A PARTICULAR PURPOSE, OF ACCURACY, OF
QUIET ENJOYMENT, AND NON-INFRINGEMENT OF THIRD-PARTY RIGHTS. SPECTRA DOES
NOT WARRANT AGAINST INTERFERENCE WITH YOUR ENJOYMENT OF THE SOFTWARE
PRODUCT THAT THE FUNCTIONS CONTAINED IN THE SOFTWARE PRODUCT WILL MEET
YOUR REQUIREMENTS, THAT THE OPERATION OF THE SOFTWARE PRODUCT WILL BE
UNINTERRUPTED OR ERROR-FREE, OR THAT DEFECTS IN THE SOFTWARE PRODUCT WILL
BE CORRECTED. NO ORAL OR WRITTEN INFORMATION OR ADVICE GIVEN BY SPECTRA OR
A SPECTRA AUTHORIZED REPRESENTATIVE SHALL CREATE A WARRANTY. SOME
JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES OR
LIMITATION ON APPLICABLE STATUTORY RIGHTS OF A CONSUMER, SO THE ABOVE
EXCLUSION AND LIMITATIONS MAY NOT APPLY TO YOU.
13. LIMITATION OF LIABILITY
TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, IN NO EVENT SHALL
SPECTRA, ITS AFFILIATES OR LICENSEES, BE LIABLE FOR ANY SPECIAL, INCIDENTAL,
INDIRECT, OR CONSEQUENTIAL DAMAGES WHATSOEVER (INCLUDING, WITHOUT
LIMITATION, DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION, LOSS
OF BUSINESS INFORMATION, OR ANY OTHER PECUNIARY LOSS) ARISING OUT OF THE USE
OF OR INABILITY TO USE THE SOFTWARE PRODUCT OR THE PROVISION OF OR FAILURE TO
PROVIDE SUPPORT SERVICES, EVEN IF SPECTRA HAS BEEN ADVISED OF THE POSSIBILITY OF
SUCH DAMAGES. IN ANY CASE, SPECTRA'S ENTIRE LIABILITY UNDER ANY PROVISION OF
THIS EULA SHALL BE LIMITED TO THE AMOUNT ACTUALLY PAID BY YOU FOR THE
SOFTWARE PRODUCT; PROVIDED HOWEVER, IF YOU HAVE ENTERED INTO A MASTER
SUPPORT AGREEMENT, SPECTRA'S ENTIRE LIABILITY REGARDING SUPPORT SERVICES
SHALL BE GOVERNED BY THE TERMS OF THAT AGREEMENT. BECAUSE SOME STATES AND
JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION OF LIABILITY, THE
ABOVE LIMITATION MAY NOT APPLY TO YOU.
14. CONTROLLING LAW AND SEVERABILITY
This EULA will be governed by and construed in accordance with the laws of the State of Colorado,
as applied to agreements entered into and to be performed entirely within Colorado between
Colorado residents. This EULA shall not be governed by the United Nations Convention on Contracts
for the International Sale of Goods, the application of which is expressly excluded. If for any reason a
court of competent jurisdiction finds any provision, or portion thereof, to be unenforceable, the
remainder of this EULA shall continue in full force and effect.
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Contacting Spectra Logic

To Obtain General Information

Spectra Logic Website: spectralogic.com

United States Headquarters European Office

Spectra Logic Corporation
6285 Lookout Road
Boulder, CO 80301
USA
Phone: 1.800.833.1132 or 1.303.449.6400
International: 1.303.449.6400
Fax: 1.303.939.8844

Spectra Logic Europe Ltd.
329 Doncastle Road
Bracknell
Berks, RG12 8PE
United Kingdom
Phone: 44 (0) 870.112.2150
Fax: 44 (0) 870.112.2175

Spectra Logic Technical Support

Technical Support Portal: support.spectralogic.com

United States and Canada
Phone:
Toll Free US and Canada: 1.800.227.4637
International: 1.303.449.0160

Europe, Middle East, Africa
Phone: 44 (0) 870.112.2185
Deutsch Sprechende Kunden
Phone: 49 (0) 6028.9796.507
Email: spectralogic@stortrec.de

Mexico, Central and South America, Asia, Australia, and New Zealand
Phone: 1.303.449.0160

Spectra Logic Sales

Website: shop.spectralogic.com

United States and Canada
Phone: 1.800.833.1132 or 1.303.449.6400
Fax: 1.303.939.8844
Email: sales@spectralogic.com

Europe
Phone: 44 (0) 870.112.2150
Fax: 44 (0) 870.112.2175
Email: eurosales@spectralogic.com

To Obtain Documentation

Spectra Logic Website: support.spectralogic.com/documentation
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ABOUT THIS REFERENCE
This reference describes the DS3 API, which is a data transport and communication interface
that allows software clients to direct and manage bulk storage read or write operations of
data objects. The first implementation supports bulk object storage operations with tape.

Intended Audience 25

Related Information 25

Online Forum 27

INTENDED AUDIENCE

This API reference is intended for software engineers or application developers who need to
understand the client interface of the DS3 RESTful protocol and who want to transfer data to
and from the Spectra® BlackPearl® Nearline Gateway. The reference assumes a working
knowledge of using a standard programming language such as C# (.NET), Java®, or Python®,
as well as an understanding of XML, HTTP, and Amazon® S3™ (Simple Storage Service).

RELATED INFORMATION

Spectra BlackPearl Nearline Gateway
The following documents related to the BlackPearl gateway are available on the Support
Portal website at support.spectralogic.com, and from the Documentation screen on the
BlackPearl user interface.

• The Spectra BlackPearl Nearline Gateway User Guide provides detailed information about
configuring, using, and maintaining your BlackPearl gateway.

• The Spectra BlackPearl Nearline Gateway Site Preparation Guide provides important
information that you should know before installing a BlackPearl gateway in your storage
environment.

• The Spectra BlackPearl Nearline Gateway RackMount Installation Guide provides detailed
instructions for installing BlackPearl Gen1 S or V Series chassis in a standard rack.

• The Spectra BlackPearl Network Setup Tips document provides helpful instructions for
troubleshooting common connectivity problems.

• The Spectra BlackPearl HotPair Installation & Configuration Guide document provides
detailed information on installing and using a the BlackPearl gateway in a HotPair
configuration.
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About This Reference Related Information

The following documents are available after logging into your Support portal account at:
support.spectralogic.com.

• The Spectra BlackPearl Release Notes and Documentation Updates provide the most up-to-date
information about the BlackPearl gateway, including information about the latest software
releases and documentation updates.

• The Spectra 12- & 36-Drive Chassis Boot Drive Replacement Guide provides instructions for
replacing a failed boot drive in the BlackPearl gateway.

• The Spectra 12-, 36- & 45-Drive Chassis Drive Replacement Guide provides instructions for
replacing a failed data drive after the BlackPearl gateway is installed.

• The Spectra 12-, 36- & 45-Drive Chassis Fan Replacement Guide provides instructions for
replacing a failed fan in the BlackPearl gateway.

• The Spectra 12-, 36- & 45-Drive Chassis Power Supply Replacement Guide provides
instructions for replacing a failed power supply after the BlackPearl gateway is installed.

• The Spectra 12-Drive Chassis HBA Replacement Guide and Spectra 36-Drive Chassis HBA
Replacement Guide provide instructions for replacing a failed HBA in the BlackPearl
gateway.

• The Spectra 96-Drive Chassis Drive Replacement Guide provides instructions for replacing a
failed data drive in the 96-bay expansion node.

• The Spectra 96-Drive Chassis Fan Replacement Guide provides instructions for replacing a
failed fan in the 96-bay expansion node.

• The Spectra 96-Drive Chassis Power Supply Replacement Guide provides instructions for
replacing a failed power supply in the 96-bay expansion node.

• The Spectra 96-Drive Chassis I/O Module Replacement Guide provides instructions for
replacing a failed I/O module in the 96-bay expansion node.

• The Spectra 107-Bay Expansion Node Part Replacement Guide provides instructions for
replacing a failed I/O module in the 96-bay expansion node.

Amazon S3 Interface
The following documents, from Amazon™, provide detailed information about the Amazon
S3 operations supported by the DS3 interface.

• The Amazon Simple Storage Service Getting Started Guide provides an introduction and
simple example of how to use Amazon S3, along with tips and links to other resources.

• The Amazon Simple Storage Service API Reference provides detailed information about all
Amazon S3 API operations. It also provides sample requests, responses, and errors.
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About This Reference Online Forum

Typographical Conventions
This document uses the following conventions to highlight important information:

WARNING Read text marked by the “Warning” icon for information you must know to avoid
personal injury.

CAUTION Read text marked by the “Caution” icon for information you must know to avoid
damaging the library, the tape drives, or losing data.

IMPORTANT Read text marked by the “Important” icon for information that helps you complete
a procedure or avoid extra steps.

Note: Read text marked with “Note” for additional information or suggestions about the
current topic.

ONLINE FORUM

Need help with Spectra Logic’s DS3 software development kits or the DS3 API? Post your
question at the Spectra Logic DS3-SDK discussion forum located at:
https://developer.spectralogic.com/forums.
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CHAPTER 1 - OVERVIEW
This chapter provides an overview of DS3, request syntax, and this guide.
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Using this Command Reference 31

DS3 OVERVIEW

The Spectra BlackPearl Nearline Gateway allows data to move seamlessly into deep storage
in a way not previously possible. DS3 is the first native REST-based interface to deep storage
which enables easy archiving of large amounts of bulk data. It enables users to deploy tape,
nearline disk, and online disk storage that is cost effective, easy to manage, and scalable to
exabytes of data.

DS3 utilizes the standard Amazon S3 operations plus additional operations specifically
designed to optimize the transport of data objects to and from deep storage. The additional
operations define the job so that the BlackPearl gateway interacts with the objects efficiently
and define the data policy to customize where and for how long specific data is stored.

The first of these additional operations is called START BULK PUT. It is an HTTP PUT
operation that provides the BlackPearl gateway with information about the objects that the
client wants to send as a single job for storing on tape. The Create Bulk PUT command is sent
with a payload that is made up of a list of object names and corresponding object sizes. This
information allows the BlackPearl gateway to plan the initial storage of the objects in its
cache, and how it will store the data on tape. The response to the Create Bulk PUT command
is a specifically ordered list of how the BlackPearl gateway wants those files (objects) sent.
See Processing a Bulk PUT Job on page 149 and Create Bulk PUT on page 172 for details.

The second command is called Create Bulk GET. The Create Bulk GET command is actually
an HTTP PUT command because it too contains a payload for the BlackPearl gateway. This
payload is a list of objects that the client wants to get from the BlackPearl gateway. It is not
necessary for the request payload to contain the size of the files because the BlackPearl
gateway already knows the sizes of the objects (files). The response to the request is again an
ordered list of the objects and information about the objects, including if they are already in
the cache and ready to be retrieved from cache by a GET command.
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Knowing the files that the client wants to retrieve, the BlackPearl gateway can make the best
use of its resources in retrieving the objects. For example, if the list of objects spans across
four different tapes and there are four tape drives available, those four tapes can all be loaded
into drives and the objects can be read back in parallel, greatly improving the speed at which
the client can get all of the objects. Without the Create Bulk GET request, the client would be
asking the BlackPearl gateway for those objects in a less efficient manner. See Processing a
Bulk GET Job on page 148 and Create Bulk GET on page 165 for details.

Storing large amounts of bulk data on tape has historically presented challenges. DS3
addresses these challenges:

• Tape drives are sequential block storage devices, with data laid out in a sequential
manner along the full length of the tape. This makes it inefficient to retrieve data out of
order. DS3 plans and queues a large amount of data to be efficiently written to tape; it
logically groups data on tape in a way that reflects how the client is likely to read it back.

• Because of the mechanical nature of the tape media and drives, tape drives demand a
large amount of data to be available, via a fast connection. When data is not efficiently
streamed for the tape drives to write (due to slow data buffering or a slow connection to
the drive), the result is poor write performance. This poor performance is due to a
phenomenon referred to as "shoe-shining". When a drive is sent a small amount of data, it
writes the data and then is forced to stop. Because the tape cannot stop instantaneously,
the drive overshoots a small amount and the tape is not in position for the next write
operation. To compensate, the tape drive rewinds to get back to the correct position for
the next write. If the next write also has a small amount of data, then the drive writes the
next portion and again stops, overshoots, and rewinds, causing a back and forth "shoe-
shining" like action. DS3 caches data on the Spectra BlackPearl Nearline Gateway before
starting the transfer to tape, which prevents the shoe-shining behavior from occurring.

• Classically, different tape storage devices wrote data to tape in unique ways, locking you
into a proprietary and single vendor solution to retrieve previously written data. DS3
writes data to tape using the open source Linear Tape File System® (LTFS). With LTFS,
data is always accessible with any LTFS enabled system.

ISSUING COMMANDS

A standard programming language such as C# (.NET), Java, or Python can be used to send a
series of DS3 commands to the library. In addition to sending the DS3 commands, the
programs can parse the data that the library returns as the command response and interpret
any output generated by the command.
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COMMAND SYNTAX

All of the DS3 commands use standard HTTP URL structure. The general syntax for a DS3
command is:
Request_Type http[s]://{datapath DNS name}/[_rest_]/[{rest domain}]/

[{item specification}]?[{parameter 1}={value}]&[{parameter 2}={value}]&...&

[{parameter n}={value}

where:

• Request_Type = The HTTP request type (DELETE, GET, HEAD, POST, PUT)

• {datapath DNS name} = The DNS name or IP address for the Spectra BlackPearl Nearline
Gateway.

• [_rest_] = Indicates that the operation is a DS3-style request.

• [{rest domain}] = The type of item that is acted upon by the request, for example, object,
bucket, job.

• [{item specification}] = The specification for the specific item that is acted upon by the
request.

• [{parameter 1}] through [{parameter n}] = Parameters whose values further define how
the library responds to the request.

Notes:

• The first parameter must be separated from the base URL by a question mark
(?) and from any additional parameters by an ampersand (&).

• To set a parameter to null use &{parameter n}=& or {parameter n}&
• DS3 only supports the "path-style" bucket specification, not the "virtual-hosted-
style".

This reference uses the following conventions for describing the syntax and command
response for each command:

• Optional parameters are shown in square brackets ([  ]).
• Variables in the command syntax are shown as {variable}. Do not include the bracket
characters ({   }) when you type variables.

WILD CARD SYNTAX

For DS3-style GET requests (with “/_rest_/” in the syntax), wild cards are allowed in string
parameters.

• Use “_” for a single character.
• Use “%” for zero or more characters.
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COMMON REQUEST HEADER ELEMENTS

The DS3 API uses Amazon S3 Signature Version 2 headers to pass authentication
information. See Signing and Authenticating REST Requests for more information.

The following table describes headers that can be used by various requests.

Note: CRC_32, MD5, and SHA-512 perform the best for their corresponding
cryptographic strengths on the BlackPearl gateway.

Header Name Description

Content-
CRC32

The base64 encoded CRC32 checksum described in RFC 1952. This is limited to
about 800 MB/sec per data stream.

Content-
CRC32C

The base64 encoded CRC32C checksum described in RFC 3720 section B4. This is
limited to about 300 MB/sec per data stream.

Content-MD5 The base64 encoded 128 bit MD5 cryptographic checksum. This is limited to
about 200 MB/sec per data stream.

Content-
SHA256

The base64 encoded 256 bit SHA cryptographic checksum. This is limited to
about 75 MB/sec per data stream.

Content-
SHA512

The base64 encoded 512 bit SHA cryptographic checksum. This is limited to
about 100 MB/sec per data stream.

Naming-
Convention

The naming convention for the response tags.
Values: CONCAT_LOWERCASE, CONSTANT, UNDERSCORED, CAMEL_CASE_WITH_
FIRST_LETTER_UPPERCASE, CAMEL_CASE_WITH_FIRST_LETTER_LOWERCASE
Default: CAMEL_CASE_WITH_FIRST_LETTER_UPPERCASE

USING THIS COMMAND REFERENCE

This reference has been divided into seven sections.

• The first section describes the Amazon S3 Operations operations supported by the
BlackPearl gateway.

• The second section describes DS3 Bucket, Object, and Job Operations. These along with
the Amazon S3 operations, are the most commonly used operations for transferring data.

• The third section describes Access Control Operations. Use these operations to provide
users and groups of users with permissions to perform different operations on the
BlackPearl gateway.
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• The fourth section describes Advanced Bucket Management Operations. These operations
let configure where and for how long data is stored.

• The fifth section describes Hardware Operations that let you interact with the tape
libraries and disk storage.

• The sixth section describes Notification Operations. The BlackPearl gateway can notify
users of job and hardware status.

• The seventh section describes Miscellaneous Operations that are available to provide
information and make rarely needed changes to the BlackPearl configuration.

Within each chapter, the requests are arranged alphabetically by the description of the action.

For each request, the chapter provides a description, the request syntax and parameters, and
response parameters. It also provides an example of the command usage and the response.

April 2023 DS3 API Reference-Spectra BlackPearl Nearline Gateway
- 32 -



VOLUME A - AMAZON S3 OPERATIONS
This section describes the standard Amazon S3 operations supported by DS3.

• Amazon S3 Bucket Operations on page 34

• Amazon S3 Object Operations on page 44

• Amazon S3 Multipart Object Operations on page 54

- 33 -



CHAPTER 2 - AMAZON S3 BUCKET
OPERATIONS

This section describes common operations performed on buckets. A bucket represents a
collection of related objects with common data policy settings. Objects in buckets are
completely independent of each other.

Buckets can be stored in various storage domains. When additional physical data stores are
needed for a bucket, another tape or disk pool is assigned to the storage domain.

Create Bucket (Put Bucket) 34

Delete Bucket 36

Get Bucket (List Objects) 37

Get Buckets (Get Service) 41

Head Bucket 43

CREATE BUCKET (PUT BUCKET)

Description
Create a bucket. The default data policy for the user creating the bucket is assigned to the
bucket. If a default data policy cannot be determined, the operation fails. No media are
initially allotted. This is an Amazon S3 compatible operation.

IMPORTANT

When creating a bucket for use with a data policy including an Amazon S3 or
Microsoft Azure replication target, the bucket name must adhere to the cloud
target naming requirements.
• For BlackPearl software version 3.5.2 or earlier, the BlackPearl gateway
changes bucket names with upper case letters to all lower case letters when
needed. If you are using bucket names that only differ by case, the buckets
are combined on the cloud target causing possible data collision and bucket
ownership/permission problems.

• For BlueScale software version 4.0 or later, if the bucket name is
incompatible with the naming requirements of the cloud target provider,
bucket creation fails and an error is returned.
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Notes:

• The bucket name cannot contain a colon (:), forward slash (/), or space.

• The bucket name cannot exceed 255 characters.

See Put Bucket for Amazon S3 operation details.

Also see Create Bucket - DS3 on page 70.

Requests

Syntax
PUT http[s]:/{datapathDNSname}/{bucket_name}/

{bucket_name} must be unique on the BlackPearl gateway.

Responses

Response Elements
The operation returns status only.

Notable status codes:

• 200: OK (success)
• 400: Bad Request (data policy cannot be determined, bucket name is not allowed)
• 403: Forbidden (user does not have permission for the data policy, bucket name is
reserved)

• 409: Conflict (bucket already exists)

Example

Sample Request
This request creates the bucket named “bucket1”.
PUT http://blackpearl-hostname/bucket1/ HTTP/1.1

Sample Response
HTTP/1.1 200 OK
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DELETE BUCKET

Description
Delete a bucket. All objects contained in the bucket must be deleted prior to deleting a
bucket. For tape partitions, the bucket is marked for deletion, but may not be deleted from
tape until the space is needed.

See Delete Bucket for Amazon S3 operation details.

Also see Delete Bucket - DS3 on page 73.

Requests

Syntax
DELETE http[s]://{datapathDNSname}/{bucket_name}/

Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 403: Forbidden (the bucket is reserved and cannot be deleted)
• 404: Not Found (no such bucket)
• 409: Conflict (bucket is not empty)
• 411: Missing HTTP header

Example

Sample Request
This request deletes the bucket named “bucket1”.
DELETE http://blackpearl-hostname/bucket1/ HTTP/1.1

Sample Response
HTTP/1.1 204 No Content
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GET BUCKET (LIST OBJECTS)

Description
Returns a list of the objects contained in a bucket. Use parameters as selection criteria to
return a list of a subset of the objects. This is an Amazon S3 compatible operation. The
parameter max-keys is set by default, so paging is required to get the full list.

See Get Bucket (List objects) for Amazon S3 operation details.

Also see Get Bucket - DS3 on page 74.

Requests

Syntax
GET http[s]://{datapathDNSname}/{bucket_name}/[?delimiter={string}][&marker=

{string}][&max-keys={integer}][&prefix={string}][&versions]

Request Parameters 

Parameter Description Required

delimiter A character used to group object names. no

marker The object name to start with when listing objects in a bucket. no

max-keys The maximum number of keys (object names) returned in the
response.
Default: 1000

no

prefix Limits the response to object names that begin with the specified
prefix. If a delimiter is specified, unique text strings before the
delimiter in object names are considered prefixes.

no

versions If included, the response includes the version UUID for the objects. no

April 2023 DS3 API Reference-Spectra BlackPearl Nearline Gateway
- 37 -

http://docs.amazonwebservices.com/AmazonS3/latest/API/RESTBucketGET.html


Chapter 2 - Amazon S3 Bucket Operations Get Bucket (List Objects)

Responses

Response Elements
<ListBucketResult>

   <CommonPrefixes>

      <Prefix>{string}</Prefix>

   </CommonPrefixes>

   ...

   <Contents>

      <ETag>"{string}"</ETag>
      <Key>{string}</Key>

      <LastModified>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastModified>

      <Owner>

         <DisplayName>{string}</DisplayName>

         <ID>{string}</ID>

      </Owner>

      <Size>{64-bit integer}</Size>

      <StorageClass>{string}</StorageClass>

      <VersionId>{string}</VersionId>

   </Contents>

   ...

   <CreationDate>{YYYY-MM-DDThh:mm:ss.xxxZ}</CreationDate>

   <Delimiter>{string}</Delimiter>

   <IsTruncated>TRUE|FALSE</IsTruncated>

   <Marker>{string}</Marker>

   <MaxKeys>{integer}</MaxKeys>

   <Name>{string}</Name>

   <NextMarker>{string}</NextMarker>

   <Prefix>{string}</Prefix>

</ListBucketResult>

where the response elements are defined as follows:

Parameter Description

ListBucketResult The container for the response.

CommonPrefixes If a delimiter is specified, CommonPrefixes contains the portion of an
object’s name between the prefix and the next occurrence of the delimiter.

Prefix The string used to limit the response keys. Only object names that begin
with the specified prefix are listed.
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Parameter Description

Contents The container for object information.

ETag The HTTP entity tag.

Key The object name.

LastModified The last date and time the object was modified in the format YYYY-MM-
DDThh:mm:ss.xxxZ. If this attribute is null, then the object has not yet
been completely received into cache.

Owner The container for owner information.

DisplayName The username of the object owner.

ID The UUID of the object owner.

Size The size of the object in bytes.

StorageClass Not used.

VersionId 1 The UUID for the version of the object.

CreationDate The date and time the bucket was created in the format YYYY-MM-
DDThh:mm:ss.xxxZ.

Delimiter The character used to group object names.

IsTruncated Specifies whether the results were truncated (TRUE) or not (FALSE) due to
the number of results exceeding MaxKeys. Values: TRUE, FALSE

Marker The object name where the bucket listing begins. Marker is included in the
response if it was specified in the request.

MaxKeys The maximum number of keys (object names) returned in the response.

Name The name of the bucket.

NextMarker If the delimiter parameter was specified, and IsTruncated is TRUE, then
NextMarker indicates the object name to use in the marker field in the next
request to get the next set of objects.

1) Only returned if versions is included.
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Example

Sample Request
This request lists the objects in the bucket named “bucket1” using the delimiter “/”.
GET http://blackpearl-hostname/bucket1/?delimiter=/ HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<ListBucketResult>

   <CommonPrefixes>

      <Prefix>movies/</Prefix>

   </CommonPrefixes>

   ...

   <Contents>

      <ETag>"88d576b1d168ab4c6582de17cbb9780f-4"</ETag>

      <Key>LICENSE</Key>

      <LastModified/>

      <Owner>

         <DisplayName>user1</DisplayName>

         <ID>2d7a060f-640a-4186-875f-e413a47a85c2</ID>

      </Owner>

      <Size>0</Size>

      <StorageClass/>

   </Contents>
   ...
   <CreationDate>2014-10-02T11:40:12.000Z</CreationDate>

   <Delimiter>/</Delimiter>

   <IsTruncated>FALSE</IsTruncated>

   <Marker/>

   <MaxKeys>1000</MaxKeys>

   <Name>bucket1</Name>

   <NextMarker/>

   <Prefix/>

</ListBucketResult>
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GET BUCKETS (GET SERVICE)

Description
Retrieves a list of all buckets owned by the sender of the request. This is an Amazon S3
compatible operation.

See Get Service for Amazon S3 operation details.

Also see Get Buckets - DS3 on page 76.

Requests

Syntax
GET http[s]://{datapathDNSname}/

Responses

Response Elements
<ListAllMyBucketsResult>

   <Buckets>

      <Bucket>

         <CreationDate>{YYYY-MM-DDThh:mm:ss.xxxZ}</CreationDate>

         <Name>{string}</Name>

      </Bucket>

      ...

   </Buckets>
   <Owner>

      <DisplayName>{string}</DisplayName>

      <ID>{string}</ID>

   </Owner>

</ListAllMyBucketsResult>

where the response elements are defined as follows:

Parameter Description

ListAllMyBuckets
Result

The container for the response.
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Parameter Description

Buckets The container for one or more buckets.

Bucket The container for bucket information.

CreationDate The date the bucket was created in the format
YYYY-MM-DDThh:mm:ss.xxxZ.

Name The name of the bucket.

Owner The container for owner information.

DisplayName The username of the bucket owner.

ID The UUID of the bucket owner.

Example

Sample Request
This request lists the buckets owned by the sender.
GET http://blackpearl-hostname/ HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<ListAllMyBucketsResult>

   <Buckets>

      <Bucket>

         <CreationDate>2014-09-10T20:21:27.000Z</CreationDate>

         <Name>bucket1</Name>

      </Bucket>
      <Bucket>

         <CreationDate>2014-09-12T17:28:41.000Z</CreationDate>

         <Name>bucket2</Name>

      </Bucket>

   </Buckets>
   <Owner>

      <DisplayName>spectra</DisplayName>

      <ID>2d7a060f-640a-4186-875f-e413a47a85c2</ID>

   </Owner>

</ListAllMyBucketsResult>
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HEAD BUCKET

Description
Returns bucket metadata values as HTTP headers. This operation is useful to determine if a
bucket exists and you have permission to access it. This is an Amazon S3 compatible
operation.

See Head Bucket for Amazon S3 operation details.

Requests

Syntax
HEAD http[s]://{datapathDNSname}/{bucket_name}/

Responses

Response Elements
The operation returns status only.

Notable status codes:

• 200: OK
• 403: Forbidden (the requester does not have list permission)
• 404: Not Found

Example

Sample Request
This request gets the header information for “bucket1”.
HEAD http://blackpearl-hostname/bucket1/ HTTP/1.1

Sample Response
HTTP/1.1 200 OK

April 2023 DS3 API Reference-Spectra BlackPearl Nearline Gateway
- 43 -

http://docs.amazonwebservices.com/AmazonS3/latest/API/RESTBucketHEAD.html


CHAPTER 3 - AMAZON S3 OBJECT
OPERATIONS

This section describes operations you can perform on objects. Each object has data, a key
(name) that uniquely identifies the object, and metadata, such as creation date.

Delete Object 44

Delete Multiple Objects 45

Get Object 48

Head Object 50

Put Object 52

DELETE OBJECT

Description
Deletes an object. Due to the nature of tape storage, objects on tape are marked for deletion
but the storage is not immediately reclaimed. The tape library will, in the background,
reclaim tapes which contain only deleted objects. This is an Amazon S3 compatible operation.

See Delete Object for Amazon S3 operation details.

Requests

Syntax
DELETE http[s]://{datapathDNSname}/{bucket_name}/{object_name}/[?version_id=

{string}]

Request Parameters

Parameter Description Required

version_id The UUID for the version of the object. If KEEP_MULTIPLE_
VERSIONS is configured for the data policy and version_id is not
included, Latest is set to FALSE for all versions, but no versions are
deleted.

no
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Responses

Response Elements
The operation returns status only. Notable status codes:

• 204: No Content (success)
• 404: Not Found

Example

Sample Request
This request deletes the object named “object1” in the bucket “bucket1”.
DELETE http://blackpearl-hostname/bucket1/object1/ HTTP/1.1

Sample Response
HTTP/1.1 204 No Content

DELETE MULTIPLE OBJECTS

Description
Delete up to 1,000 specified objects from a bucket. For buckets stored in tape libraries, objects
are marked for deletion but the storage is not immediately reclaimed. The tape library will, in
the background, reclaim tapes which contain only deleted objects. This is an Amazon S3
compatible operation.

See Delete Multiple Objects for Amazon S3 operation details.

Requests

Syntax
POST http[s]://{datapathDNSname}/{bucket_name}/?delete

Request Parameters

Parameter Description Required

delete Included to indicate a delete operation. yes
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Request Elements
An XML payload, formatted as follows, must be sent to describe the objects to delete:
<Delete>

   <Object>

      <Key>{string}</Key>

   </Object>

   ...

</Delete>

where the parameters are defined as follows:

Parameter Description Required

Delete The container for all objects to delete. yes

Object The container for the information about a single object to delete. yes

Key The name of an object to delete. yes

version_id The UUID for the version of the object. If KEEP_MULTIPLE_
VERSIONS is configured for the data policy and version_id is not
included, Latest is set to FALSE for all versions, but no versions are
deleted.

no

Responses

Response Elements
<DeleteResult>

   <Deleted>

      <Key>{string}</Key>

   </Deleted>

   ...

   <Error>

      <Code>{string}</Code>

      <Key>{string}</Key>

      <Message>{string}</Message>

   </Error>

   ...

</DeleteResult>
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where the response elements are defined as follows:

Parameter Description

DeleteResult The container for the response.

Deleted The container for one or more objects successfully deleted.

Key The name for the object.

Error The container for one or more objects that were not successfully deleted.

Code The status code for the failed delete.

Message A description of the error for the failed delete.

Example

Sample Request
This request deletes objects named “TFINITY-4-frame_shadow.png” and “BlackPearl-
LeftFacing.png” from “bucket1”.
POST http://blackpearl-hostname/bucket1/?delete HTTP/1.1
<Delete>

   <Object>

      <Key>TFINITY-4-frame_shadow.png</Key>

   </Object>

   <Object>

      <Key>BlackPearl-LeftFacing.png</Key>

   </Object>

</Delete>
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Sample Response
HTTP/1.1 200 OK

<DeleteResult>

   <Deleted>

      <Key>TFINITY-4-frame_shadow.png</Key>

   </Deleted>

   <Error>

      <Key>BlackPearl-LeftFacing.png</Key>

      <Code>AccessDenied</Code>

      <Message>Access Denied</Message>

   </Error>

</DeleteResult>

GET OBJECT

Description
Retrieves an object from storage. Spectra Logic recommends using DS3 requests to create a
GET job rather than using this request stand alone in a strict Amazon S3 manner. This is
particularly important when getting many small objects or getting very large objects that
have been broken up for physical placement. This is an Amazon S3 compatible operation
with additional request parameters. The job and offset parameters should always be used
when doing a GET object as part of a bulk GET job.

If the object is on tape, clients should expect latency and/or non-error response codes detailed
below.

See Get Object for Amazon S3 operation details.

Notes:

• A Create Bulk GET (see page 165) request should be issued to the BlackPearl
gateway before the GET object request. The BlackPearl gateway may choose
to fail any GET object request which does not match the plan returned by the
prior Create Bulk GET request.

• For more information about bulk GET jobs, see Processing a Bulk GET Job on
page 148.

• If the job and offset parameters are not provided and the object has multiple
parts because it was PUT using multipart upload, or it was PUT using a DS3
PUT job and the object was broken up into more than one part, the GET request
fails.
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Requests

Syntax
GET http[s]://{datapathDNSname}/{bucket_name}/{object_name}/[?job={string}][&offset=

{64-bit integer}][&version_id={string}]

Request Parameters

Parameter Description Required

job The UUID or a unique attribute for the job. recommended

offset The offset in bytes from the start of the object. recommended

version_id The UUID for the version of the object. If KEEP_MULTIPLE_
VERSIONS is configured for the data policy and version_id is
not included, Latest is set to FALSE for all versions, but no
versions are deleted.

no

Request Header
• The HTTP header for the checksum is returned when applicable (see Put Object on
page 52), so that the client can verify that the data received is correct. End-to-end data
protection requires that the client provide the CRC when uploading the object and then
verify the CRC after downloading the object at a later time. The BlackPearl gateway also
verifies the CRC when reading from physical data stores so the gateway can identify
problems before transmitting data to the client.

• This operation supports the HTTP Range header as implemented by Amazon S3 to
download the specified range bytes of an object. See Get Object for more information.

Responses

Response Elements
The operation returns a header, the requested object content, and status information. It does
not return response elements.

When possible, the response header has the status code 200 OK.
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The header may also contain the following non-error statuses:

• 304 Not Modified (without object content):
• if the `if-none-match` header was specified, but the object ETag is different than the
given tag;

• if the `if-modified-since` header was specified but the object has not been modified
since the given time.

• 307 Temporary Redirect: In the event a tape library cannot retrieve an object within the
allotted time, it will respond with 307 Temporary Redirect (along with the host address
and port of the specific BlackPearl gateway which contains this object) before the timeout
expires, and continue retrieving the object. The client must resend the `GET Object`
request to the given address and port.

• 412 Precondition Failed (without object content):
• `if-match` header was specified, but the object ETag did not match the specified tag;

• `if-unmodified-since` header was specified but the object has been modified since the
given time.

Example

Sample Request
This request GETs the object named “object1” from the bucket “bucket1”.
GET http://blackpearl-hostname/bucket1/object1/ HTTP/1.1

Sample Response
HTTP/1.1 200 OK
{object data}

HEAD OBJECT

Description
Get object metadata values returned as an HTTP header. This operation is useful to
determine if an object exists and you have permission to access it. This is an Amazon S3
compatible operation.

See Head Object for Amazon S3 operation details.
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Requests

Syntax
HEAD http[s]://{datapathDNSname}/{bucket_name}/{object_name}/

Responses

Response Elements
The operation returns status only.

Notable status codes:

• 200: OK
• 404: Not Found

Example

Sample Request
This request gets the header information for “object1” in “bucket1”.
HEAD http://blackpearl-hostname/bucket1/object1/ HTTP/1.1

Sample Response
HTTP/1.1 200 OK

with header information
requesthandler-version: 1.CF182CD57551902A475553F26582BC78
etag: "ccf72718895ee98441a2211f30c14cc2-3"
  creation-date: 2019-07-11T20:35:47.000Z
version-id: eec64ea6-8434-492f-a068-ef516da801a3
x-amz-meta-bucket: bucket-000002
x-amz-meta-filename: file-000000-31e04edf-2%2Fe88-4b5c-9b9b-3b73dd4cd993
ds3-blob-checksum-type: MD5
ds3-blob-checksum-offset-68719476736: rCfop/wnvdwEuX59FikQIA==
ds3-blob-checksum-offset-0: rCfop/wnvdwEuX59FikQIA==
ds3-blob-checksum-offset-137438953472: mnhaBwDj9tR95jevtmpZgQ==
x-amz-request-id: 2546
content-language: en-US
content-length: 200000000000
date: Mon, 2 Dec 2019 21:13:48 GMT
connection: close
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PUT OBJECT

Description
Create an S3 object in a bucket. Include the data for the object with your request. Spectra
Logic recommends using DS3 requests to create a PUT job rather than using this request
stand alone in a strict Amazon S3 manner. This is particularly important when putting many
small objects or putting very large objects that must be broken up for physical placement.

This is an Amazon S3 compatible operation with additional request parameters. The job and
offset parameters should always be used when doing a PUT object as part of a bulk PUT
job (see Processing a Bulk PUT Job on page 149). If not using the job and offset
parameters, the maximum object length is 1 TB (1,099,511,627,776 bytes).

See Put Object for Amazon S3 operation details.

Requests

Syntax
PUT http[s]://{datapathDNSname}/{bucket_name}/{object_name}/[?job={string}][&offset=

{64-bit integer}]

{object_name} must follow the Amazon S3 naming restrictions. See Object Key and Metadata
for more information.

Request Parameters

Parameter Description Required

job The UUID or a unique attribute for the job. recommended

offset The offset in bytes from the start of the object. recommended

Request Header
The client-side checksum is passed to the BlackPearl gateway by supplying the applicable
CRC HTTP header (see Common Request Header Elements on page 31). If this is done, the
BlackPearl gateway verifies that the data received matches the checksum provided. End-to-
end data protection requires that the client provide the CRC when uploading the object and
then verify the CRC after downloading the object at a later time (see Get Object on page 48).
The BlackPearl gateway also verifies the CRC when reading from physical data stores so the
gateway can identify problems before transmitting data to the client.
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Responses

Response Elements
The operation returns status only.

Notable status codes:

• 200: OK (success)
• 409: Conflict (object exists)

Example

Sample Request
This request creates the object named “object1” in the bucket “bucket1”.
PUT http://blackpearl-hostname/bucket1/object1/ HTTP/1.1

Sample Response
HTTP/1.1 200 OK
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OBJECT OPERATIONS

Multipart Uploads are a way of uploading objects that are too large to upload in a single
action.

Note: Spectra Logic recommends that you use DS3 requests to create a PUT job, then
upload each object piece in the PUT job, rather than using Multipart Upload (see
Processing a Bulk PUT Job on page 149). Using a bulk PUT job achieves better
scalability and performance. Note that a maximum upload size can be specified on
a PUT job if smaller transfer sizes are required.

The general process for Multipart Uploads is as follows:

1. Initiate the multipart upload; see Initiate Multipart Upload on page 58 for details.

2. Upload all parts; see Upload Part on page 67 for details. Note the PartNumber and ETag
for each part.

3. Complete the MultiPart Upload; see Complete Multipart Upload on page 56 for details.
This request reassembles the object parts into one object. You must provide the
PartNumber and ETag for each part.

Abort Multipart Upload 54

Complete Multipart Upload 56

Initiate Multipart Upload 58

List Multipart Upload Parts 60

List Multipart Uploads 63

Upload Part 67

ABORT MULTIPART UPLOAD

Description
Cancel a multipart upload that has been initiated but has not yet completed. This is an
Amazon S3 compatible operation.

See Abort Multipart Upload for Amazon S3 operation details.
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Requests

Syntax
DELETE http[s]://{datapathDNSname}/{bucket}/{object}?upload_id={string}

To determine the UUID of the multipart upload, see List Multipart Uploads on page 63.

Request Parameters

Parameter Description Required

upload_id The UUID of the multipart upload. yes

Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 404: Not Found

Example

Sample Request
This request deletes the multipart upload with the UUID 18baa28f-1c85-4cd2-9023-
71600b1759f3.
DELETE http[s]://blackpearl-hostname/bucket1/test.aaf?upload_id=18baa28f-1c85-4cd2-

9023-71600b1759f3 HTTP/1.1

Sample Response
HTTP/1.1 204 No Content
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COMPLETE MULTIPART UPLOAD

Description
Commit a multipart upload that has been initiated, but not yet completed or aborted. Run
this command after successfully uploading all parts of a multipart upload. The BlackPearl
gateway assembles the previously uploaded parts in ascending order by part number to
create a new object. This process can take several minutes to complete. This is an Amazon S3
compatible operation.

See Complete Multipart Upload for Amazon S3 operation details.

Requests

Syntax
POST http[s]://{datapathDNSname}/{bucket}/{object}?upload_id={string}

To determine the UUID of the multipart upload, see List Multipart Uploads on page 63.

Request Parameters

Parameter Description Required

upload_id The UUID of the multipart upload. yes

Request Elements
An XML payload, formatted as follows, must be sent to describe the parts in the upload:

Note: If you did not note the PartNumber and ETag for all object parts when they were
uploaded using Upload Part on page 67, use List Multipart Upload Parts on
page 60 to determine the PartNumber and ETag.

<CompleteMultipartUpload>

   <Part>
      <PartNumber>{64-bit integer}</PartNumber>
      <ETag>"{string}"</ETag>
   </Part>
   ...
</CompleteMultipartUpload>
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where the parameters are defined as follows:

Parameter Description Required

CompleteMultipartUpload A container for the list of parts. yes

Part A container for the information about one part. yes

PartNumber The user defined number that uniquely identifies
the uploaded part and its position in the object.

yes

ETag The HTTP entity tag for the object part. yes

Responses

Response Elements
<CompleteMultipartUploadResult>

   <Bucket>{string}</Bucket>

   <ETag>"{string}"</ETag>

   <Key>{string}</Key>

   <Location>{string}</Location>

</CompleteMultipartUploadResult>

where the response elements are defined as follows:

Parameter Description

CompleteMultipartUploadResult The container for the response.

Bucket The name for the bucket in which the object resides.

ETag The HTTP entity tag for the newly created object.

Key The object name for the newly created object.

Location The URI (uniform resource identifier) that identifies the
newly created object.
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Example

Sample Request
This request commits the multipart upload with the UUID 18baa28f-1c85-4cd2-9023-
71600b1759f3.
POST http[s]://blackpearl-hostname/bucket1/test.aaf?upload_id=18baa28f-1c85-4cd2-

9023-71600b1759f3 HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<CompleteMultipartUploadResult>

   <Bucket>bucket1</Bucket>

   <ETag>"98d476a1d168aa4c4592ce06cab9880f-3"</ETag>

   <Key>test.aaf</Key>

   <Location>d57cdcf7-df15-4cec-bcbd-559b651634b8</Location>

</CompleteMultipartUploadResult>

INITIATE MULTIPART UPLOAD

Description
Initiates a multipart upload for an object. This operation attempts to allocate 5 TB of cache
space for the multipart upload, which may be significantly more than the actual cache space
necessary. If cache space cannot be allocated in full, an error is returned. If this call succeeds,
it is guaranteed that neither part uploads nor a complete multipart upload request will fail
due to cache allocation issues. This is an Amazon S3 compatible operation.

See Initiate Multipart Upload for Amazon S3 operation details.

Notes:

• Spectra Logic recommends that you use DS3 requests to create a PUT job, then
upload each object piece in the PUT job, rather than using Multipart Upload
(see Processing a Bulk PUT Job on page 149). Using a bulk PUT job achieves
better scalability and performance. Note that a maximum upload size can be
specified on a PUT job if smaller transfer sizes are required.

• The cache space allocated by this call is not released until the multi-part upload
is aborted, completed, or times out.
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Requests

Syntax
POST http[s]://{datapathDNSname}/{bucket}/{object}?uploads

Request Parameters

Parameter Description Required

uploads Indicates that this operation initiates a multipart upload. yes

Responses

Response Elements
HTTP/1.1 200 OK

<InitiateMultipartUploadResult>

   <Bucket>{string}</Bucket>

   <Key>{string}</Key>

   <UploadId>{string}</UploadId>

</InitiateMultipartUploadResult>

where the response elements are defined as follows:

Parameter Description

InitiateMultipart UploadResult The container for the response.

Bucket The name for the bucket in which the object resides.

Key The object name.

UploadID The UUID for the multipart upload.

Example

Sample Request
This request initiates a multipart upload for the object test.aaf.
POST http[s]://blackpearl-hostname/bucket1/test.aaf?uploads HTTP/1.1
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Sample Response
HTTP/1.1 200 OK

<InitiateMultipartUploadResult>

   <Bucket>bucket1</Bucket>

   <Key>test.aaf</Key>

   <UploadId>18baa28f-1c85-4cd2-9023-71600b1759f3</UploadId>

</InitiateMultipartUploadResult>

LIST MULTIPART UPLOAD PARTS

Description
Lists parts that have been uploaded for a specified multipart upload. This is an Amazon S3
compatible operation.

See List Parts for Amazon S3 operation details.

Requests

Syntax
GET http[s]://{datapathDNSname}/{bucket}/{object}?upload_id={string}[&max_parts=

{64-bit integer}][&part_number_marker={64-bit integer}]

To determine the UUID of the multipart upload, see List Multipart Uploads on page 63.

Request Parameters

Parameter Description Required

upload_id The UUID of the multipart upload. yes

max_parts The maximum number of parts to list in the response. The default
is 1000.

no

part_
number_
marker

Specifies the part number after which the listing begins. Only parts
with higher part numbers will be listed.

no
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Responses

Response Elements
<ListPartsResult>

   <Bucket>{string}</Bucket>

   <IsTruncated>TRUE|FALSE</IsTruncated>

   <Key>{string}</Key>

   <MaxParts>{64-bit integer}</MaxParts>

   <NextPartNumberMarker>{64-bit integer}</NextPartNumberMarker>

   <Owner>

      <DisplayName>{string}</DisplayName>

      <ID>{string}</ID>

   </Owner>
   <Part>

      <ETag>"{string}"</ETag>

      <LastModified>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastModified>

      <PartNumber>{string}</PartNumber>

   </Part>

   ...

   <PartNumberMarker>{64-bit integer}</PartNumberMarker>

   <UploadId>{string}</UploadId>

</ListPartsResult>

where the response elements are defined as follows:

Parameter Description

ListPartsResult The container for the response.

Bucket The name for the bucket in which the object resides.

IsTruncated Specifies whether the results were truncated (TRUE) or not (FALSE) due to
the number of results exceeding MaxParts. Values: TRUE, FALSE

Key The object name.

MaxParts Maximum number of parts to include in the response.

NextPartNumber
Marker

When the list is truncated, this element specifies the value to use for the
part_number_marker request parameter in a subsequent request.

Owner The container for information about the owner.

DisplayName The username for the owner.
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Parameter Description

ID The UUID for the owner.

Part The container for information about an object part.

ETag The HTTP entity tag for the part.

LastModified The last date and time the object was modified in the format YYYY-MM-
DDThh:mm:ss.xxxZ.

PartNumber The number that uniquely identifies the uploaded part and its position in
the object.

PartNumberMarker Part number after which listing begins.

UploadID The UUID for the multipart upload.

Example

Sample Request
This request gets a list of up to three parts that have been uploaded for the multipart upload
with the upload ID 125c261c-5c84-49e3-bcda-07d312e28019.
GET http[s]://blackpearl-hostname/bucket1/test.aaf?upload_id=125c261c-5c84-49e3-

bcda-07d312e28019&max_parts=3 HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<ListPartsResult>

   <Bucket>bucket1</Bucket>

   <IsTruncated>TRUE</IsTruncated>

   <Key>test.aaf</Key>

   <MaxParts>3</MaxParts>

   <NextPartNumberMarker>3</NextPartNumberMarker>

   <Owner>

      <DisplayName>default_user_name</DisplayName>

      <ID>31569b32-3cd5-4687-ab3b-88f5aea8f54d</ID>

   </Owner>
   <Part>

      <ETag>"c4ca4238a0b923820dcc509a6f75849b"</ETag>

      <LastModified>2015-02-12T17:28:41.000Z</LastModified>

      <PartNumber>1</PartNumber>

   </Part>
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   <Part>

      <ETag>"c81e728d9d4c2f636f067f89cc14862c"</ETag>

      <LastModified>2015-02-12T17:28:41.000Z</LastModified>

      <PartNumber>2</PartNumber>

   </Part>
   <Part>

      <ETag>"eccbc87e4b5ce2fe28308fd9f2a7baf3"</ETag>

      <LastModified>2015-02-12T17:28:41.000Z</LastModified>

      <PartNumber>3</PartNumber>

   </Part>

   <PartNumberMarker/>

   <UploadId>125c261c-5c84-49e3-bcda-07d312e28019</UploadId>

</ListPartsResult>

LIST MULTIPART UPLOADS

Description
Lists and gives information about multipart uploads currently in progress for the specified
bucket. This is an Amazon S3 compatible operation.

See List Multipart Uploads for Amazon S3 operation details.

Requests

Syntax
GET http[s]://{datapathDNSname}/{bucket}/?uploads[&delimiter={string}][&key_marker=

{64-bit integer}][&max_uploads={64-bit integer}][&prefix={string}][&upload_id_

marker={string}]

Request Parameters

Parameter Description Required

uploads Indicates that this operation initiates a multipart upload. yes

delimiter A character used to group object names. no
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Parameter Description Required

key_marker Together with upload_id_marker, this parameter specifies the
multipart upload after which listing should begin.
If upload_id_marker is not specified, only the keys
lexicographically greater than the specified key_marker are
included in the list.
If upload_id_marker is specified, any multipart uploads for a key
equal to the key_marker are included if the multipart uploads
have upload IDs lexicographically greater than the specified
upload_id_marker.

no

max_
uploads

Maximum number of uploads to include in the response. no

prefix Limits the response to object names that begin with the specified
prefix. If a delimiter is specified, unique text strings before the
delimiter in object names are considered prefixes.

no

upload_id_
marker

Together with key_marker, specifies the multipart upload after
which listing should begin. If key_marker is not specified, this
parameter is ignored. Otherwise, any multipart uploads for a key
equal to the key_marker are included in the list if they have an
upload ID lexicographically greater than the specified upload_id_
marker.

no

Responses

Response Elements
<ListMultipartUploadsResult>

   <Bucket>{string}</Bucket>

   <Delimiter>{string}</Delimiter>

   <IsTruncated>TRUE|FALSE</IsTruncated>

   <KeyMarker>{string}</KeyMarker>

   <MaxUploads>{64-bit integer}</MaxUploads>

   <NextKeyMarker>{string}</NextKeyMarker>

   <NextUploadIdMarker>{string}</NextUploadIdMarker>

   <Prefix>{string}</Prefix>
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   <Upload>

      <Initiated>{YYYY-MM-DDThh:mm:ss.xxxZ}</Initiated>

      <Key>{string}</Key>

      <Owner>

         <DisplayName>{string}</DisplayName>

         <ID>{string}</ID>

      </Owner>

      <UploadId>{string}</UploadId>

   </Upload>

   ...

   <UploadIdMarker>{string}</UploadIdMarker>

</ListMultipartUploadsResult>

where the response elements are defined as follows:

Parameter Description

ListMultipart
UploadsResult

The container for the response.

Bucket The name for the bucket in which the object resides.

Delimiter The character used to group object names.

IsTruncated Specifies whether the results were truncated (TRUE) or not (FALSE) due to the
number of results exceeding MaxParts. Values: TRUE, FALSE

KeyMarker The key at or after which the listing began.

MaxUploads Maximum number of uploads included in the response.

NextKeyMarker When the list is truncated, this element specifies the value to use for the
key_marker request parameter in a subsequent request.

NextUploadId
Marker

When the list is truncated, this element specifies the value to use for the
upload_id_marker request parameter in a subsequent request.

Prefix The string used to limit the response keys. Only object names that begin with
the specified prefix are listed.

Upload The container for information about one upload.

Initiated Date and time when the multipart upload was initiated in the format YYYY-
MM-DDThh:mm:ss.xxxZ.

Key The name of the object for which the multipart upload was initiated.
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Parameter Description

Owner The container for information about the owner.

DisplayName The username for the owner.

ID The UUID for the owner.

UploadID The UUID for the multipart upload.

UploadIdMarker Upload ID after which listing began.

Example

Sample Request
This request gets a list of the multipart uploads in-progress for bucket1.
GET http[s]://blackpearl-hostname/bucket1/?uploads HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<ListMultipartUploadsResult>

   <Bucket>bucket1</Bucket>

   <Delimiter/>

   <IsTruncated>FALSE</IsTruncated>

   <KeyMarker>test_object_1</KeyMarker>

   <MaxUploads>1000</MaxUploads>

   <NextKeyMarker/>

   <NextUploadIdMarker/>

   <Prefix/>
   <Upload>

      <Initiated>2015-02-12T17:28:41.000Z</Initiated>   

      <Key>test_object_2</Key>

      <Owner>

         <DisplayName>user_name</DisplayName>

         <ID>2d7a060f-640a-4186-875f-e413a47a85c2</ID>

      </Owner>

      <UploadId>870c99ca-9d94-4e2f-a344-2596d1ebdaf4</UploadId>

   </Upload>

   <UploadIdMarker/>

</ListMultipartUploadsResult>
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UPLOAD PART

Description
Upload a multipart upload part. This is an Amazon S3 compatible operation.

See Upload Part for Amazon S3 operation details.

Requests

Syntax
PUT http[s]://{datapathDNSname}/{bucket}/{object}?part_number=

{32-bit integer}&upload_id={string}

To determine the UUID of the multipart upload, see List Multipart Uploads on page 63.

Request Parameters

Parameter Description Required

part_number A user defined number between 1 and 10,000. A part number
uniquely identifies a part and its position in the object you are
uploading. If you upload a new object part using the same part
number as a previously uploaded part, the previously uploaded
part is overwritten.

yes

upload_id The UUID of the multipart upload. yes

Responses

Response Elements
The operation returns status only.

Notable status codes:

• 200: OK (success): ETag is returned in the header
• 404: Not Found (bucket or object does not exist)
• 409: Conflict (object exists)
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Example

Sample Request
This request puts the second part of the multipart upload with the UUID 18baa28f-1c85-4cd2-
9023-71600b1759f3.
PUT http[s]://blackpearl-hostname/bucket1/test.aaf?part_number=2&upload_id=18baa28f-

1c85-4cd2-9023-71600b1759f3 HTTP/1.1

Sample Response
HTTP/1.1 200 OK
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VOLUME B - DS3 BUCKET, OBJECT, AND
JOB OPERATIONS

This section describes operations that control where data is stored and for how long.

• DS3 Bucket Operations on page 70

• DS3 Object Operations on page 82

• Job Operations on page 147
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This section describes operations you can perform on buckets. A bucket represents a
collection of related objects with common policy settings. Objects in buckets are completely
independent of each other.

Create Bucket - DS3 70

Delete Bucket - DS3 73

Get Bucket - DS3 74

Get Buckets - DS3 76

Modify Bucket - DS3 79

CREATE BUCKET - DS3

Description
Create a bucket using a specific data policy. The data policy must have at least one
permanent persistence rule configured.

IMPORTANT

When creating a bucket for use with a data policy including an Amazon S3 or
Microsoft Azure replication target, the bucket name must adhere to the cloud
target naming requirements.
• For BlackPearl software version 3.5.2 or earlier, the BlackPearl gateway changes

bucket names with upper case letters to all lower case letters when needed. If
you are using bucket names that only differ by case, the buckets are combined
on the cloud target causing possible data collision and bucket
ownership/permission problems.

• For BlueScale software version 4.0 or later, if the bucket name is incompatible
with the naming requirements of the cloud target provider, bucket creation
fails and an error is returned.

Also see Create Bucket (Put Bucket) on page 34.

Requests

Syntax
POST http[s]://{datapathDNSname}/_rest_/bucket/?name={string}[&data_policy_id=

{string}][&id={string}][&protected=TRUE|FALSE][&user_id={string}]
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To determine the UUID for a data policy, see Get Data Policies on page 353.

Request Parameters 

Parameter Description Required

name The name for the new bucket.
IMPORTANT When creating a bucket for use with a data policy
including an Amazon S3 or Microsoft Azure replication target, the
bucket name must adhere to the cloud target naming requirements.
• For BlackPearl software version 3.5.2 or earlier, the BlackPearl
gateway changes bucket names with upper case letters to all lower
case letters when needed. If you are using bucket names that only
differ by case, the buckets are combined on the cloud target causing
possible data collision and bucket ownership/permission problems.

• For BlueScale software version 4.0 or later, if the bucket name is
incompatible with the naming requirements of the cloud target
provider, bucket creation fails and an error is returned.

Notes:
• The bucket name cannot contain a colon (:), forward slash (/), or
space.

• The bucket name cannot exceed 255 characters.

yes

data_policy_
id

The UUID, name, or other unique attribute for the data policy.
Default:
• If only one data policy exists, that is the default data policy.
• If the user has a default data policy assigned, that is the default
data policy.

• If more than one data policy exists and the user does not have a
default data policy assigned, then the data_policy_id parameter is
required or the operation fails.

in some
cases

Id The UUID for the bucket. no

protected The protection setting for the bucket. Protected buckets cannot be
deleted. Values: TRUE, FALSE (default).

no

user_id The UUID, username, or other unique attribute for the bucket
owner.
Default: The user creating the bucket.

no
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Responses

Response Elements
<Data>

   <CreationDate>{YYYY-MM-DDThh:mm:ss.xxxZ}</CreationDate>

   <DataPolicyId>{string}</DataPolicyId>

   <Id>{string}</Id>

   <LastPreferredChunkSizeInBytes>

{64-bit integer}

   </LastPreferredChunkSizeInBytes>

   <Name>{string}</Name>
   <Protected>{TRUE|FALSE}</Protected>

   <UserId>{string}</UserId>
</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

CreationDate The date and time the bucket was created in the format YYYY-MM-
DDThh:mm:ss.xxxZ

DataPolicyId The UUID for the assigned data policy.

Id The UUID for the bucket.

LastPreferred
ChunkSizeInBytes

The last preferred chunk size computed for a PUT job for this bucket.

Name The name of the bucket.

Protected The protection setting for the bucket.

UserId The UUID for the bucket owner.

Example

Sample Request
This request creates the bucket named “new_bucket” using the data policy with the UUID
22bdea46-4b7f-4f70-873c-ff953fa97b3b:

April 2023 DS3 API Reference-Spectra BlackPearl Nearline Gateway
- 72 -



Chapter 5 - DS3 Bucket Operations Delete Bucket - DS3

POST http://blackpearl-hostname/_rest_/bucket/?name=new_bucket&data_policy_

id=22bdea46-4b7f-4f70-873c-ff953fa97b3b HTTP/1.1

Sample Response
HTTP/1.1 201 CREATED

<Data>

   <CreationDate>2015-07-22T14:22:49.224Z</CreationDate>

   <DataPolicyId>

      22bdea46-4b7f-4f70-873c-ff953fa97b3b

   </DataPolicyId>

   <Id>1acb4e56-ae93-49a0-b288-db93f0a70ea4</Id>

   <LastPreferredChunkSizeInBytes/>

   <Name>new_bucket</Name>
   <Protected>FALSE</Protected>

   <UserId>c0a80d43-c1ae-4ee1-87d5-12ca632e8205</UserId>
</Data>

DELETE BUCKET - DS3

Description
Delete a DS3 bucket. All objects must be deleted prior to deleting a bucket or the force
parameter must be specified. For tape partitions, the bucket is marked for deletion, but may
not be deleted from tape until the space is needed.

Also see Delete Bucket on page 36.

Requests

Syntax
DELETE http[s]://{datapathDNSname}/_rest_/bucket/{bucket_name}/[?force]

Request Parameters

Parameter Description Required

force If included, the bucket and all objects in the bucket are deleted. no
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Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 404: Not Found
• 409: Conflict (force was not specified, bucket is not empty)

Example

Sample Request
This request deletes the bucket named “bucket1”.
DELETE http://blackpearl-hostname/_rest_/bucket/bucket1/ HTTP/1.1

Sample Response
HTTP/1.1 204 No Content

GET BUCKET - DS3

Description
Shows information about the specified bucket, such as logical used capacity and data policy.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/bucket/{bucket UUID, name, or other unique

attribute}/

To determine the UUID for a bucket, see Get Buckets - DS3 on page 76.
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Responses

Response Elements
<Data>

   <CreationDate>{YYYY-MM-DDThh:mm:ss.xxxZ}</CreationDate>

   <DataPolicyId>{string}</DataPolicyId>

   <Id>{string}</Id>

   <LastPreferredChunkSizeInBytes>

{64-bit integer}

   </LastPreferredChunkSizeInBytes>

   <LogicalUsedCapacity>{64-bit integer}</LogicalUsedCapacity>

   <Name>{string}</Name>
   <Protected>TRUE|FALSE</Protected>

   <UserId>{string}</UserId>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

CreationDate The date and time the bucket was created in the format YYYY-MM-
DDThh:mm:ss.xxxZ

DataPolicyId The UUID for the assigned data policy.

Id The UUID for the bucket.

LastPreferred
ChunkSizeInBytes

The last preferred chunk size computed for a PUT job for this bucket.

LogicalUsed Capacity The logical capacity used in bytes.

Name The name of the bucket.

Protected The protection status of the bucket.

UserId The UUID for the bucket owner.

Example

Sample Request
This request gets the bucket capacity summary and default settings for “bucket1”.
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GET http://blackpearl-hostname/_rest_/bucket/bucket1/ HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>

   <CreationDate>2015-07-22T14:22:50.083Z</CreationDate>

   <DataPolicyId>

      33cfbff0-bd43-43b9-a144-8abe69328217

   </DataPolicyId>

   <Id>f00729b7-dfa6-4a18-9bf7-a0759aa7dbb3</Id>

   <LastPreferredChunkSizeInBytes/>

   <LogicalUsedCapacity>0</LogicalUsedCapacity>

   <Name>bucket1</Name>
   <Protected>FALSE</Protected>

   <UserId>22de0f70-be2e-4d9b-b28a-ac250a2a2405</UserId>

</Data>

GET BUCKETS - DS3

Description
Shows information, such as logical used capacity and data policy, about all buckets
configured on the BlackPearl gateway. Use parameters as selection criteria to return
information for a subset of all buckets.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/bucket/[?data_policy_id={string}][&last_page]

[&name={string}][&page_length={32-bit integer}][&page_offset={32-bit integer}]

[&page_start_marker={string}][&user_id={string}]
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Request Parameters 

Parameter Description Required

data_policy_
id

The UUID, name, or other unique attribute for the data policy. no

last_page If included, only the last page of results is returned. no

name 1 The name of the bucket. no

page_length The maximum number of buckets to list. The default is all items
after page_offset.

no

page_offset The starting point for the first bucket to list. The default is 0. no

page_start_
marker

The UUID or other unique attribute for the item just before the first
item to list.
Notes:
• Specifying both page_offset and page_start_marker causes
an error.

• If neither page_offset, nor page_start_marker are specified,
the page_offset default is used.

no

user_id 1 The UUID, username, or a unique attribute for the bucket owner. no

Responses

Response Elements
<Data>

   <Bucket>

      <CreationDate>{YYYY-MM-DDThh:mm:ss.xxxZ}</CreationDate>

      <DataPolicyId>{string}</DataPolicyId>

      <Id>{string}</Id>

      <LastPreferredChunkSizeInBytes>

{64-bit integer}

      </LastPreferredChunkSizeInBytes>
      <LogicalUsedCapacity>{64-bit integer}</LogicalUsedCapacity>

      <Name>{string}</Name>

1) Parameter values can use wild cards (see Wild Card Syntax on page 30).
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      <Protected>TRUE|FALSE</Protected>

      <UserId>{string}</UserId>

   </Bucket>

   ...

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

Bucket The container for information about a single bucket.

CreationDate The date and time the bucket was created in the format YYYY-MM-
DDThh:mm:ss.xxxZ

DataPolicyId The UUID for the assigned data policy.

Id The UUID for the bucket.

LastPreferred
ChunkSizeInBytes

The last preferred chunk size computed for a PUT job for this bucket.

LogicalUsed Capacity The logical capacity used in bytes.

Name The name of the bucket.

Protected The protection status of the bucket.

UserId The UUID for the bucket owner.

Example

Sample Request
This request gets data policy and logical used capacity information for all buckets.
GET http://blackpearl-hostname/_rest_/bucket/ HTTP/1.1
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Sample Response
HTTP/1.1 200 OK

<Data>

   <Bucket>

      <CreationDate>2015-07-22 14:22:50.284</CreationDate>

      <DataPolicyId>

         704401b4-03a1-4752-9329-08e8c77fce23

      </DataPolicyId>

      <Id>ccef9b22-aa77-449e-9f4f-3fe6ecc4be03</Id>

      <LastPreferredChunkSizeInBytes/>

      <LogicalUsedCapacity>1024</LogicalUsedCapacity>

      <Name>bucket1</Name>
      <Protected>FALSE</Protected>

      <UserId>7bd66b10-1d8e-49ce-b7ef-c680432dbfc8</UserId>

   </Bucket>

   ...

</Data>

MODIFY BUCKET - DS3

Description
Modify the owner or data policy for a bucket.

Note: The data policy for a bucket can be changed to another data policy provided that
all of the criteria below are met:

• The checksum type of the new data policy is the same as the old

• All persistence rules in the old data policy must have a State of NORMAL.
They cannot be in the State INCLUSION_IN_PROGRESS

• All persistence rules in the new data policy must have a State of NORMAL.
They cannot be in the State INCLUSION_IN_PROGRESS

• The sets of storage domains targeted by permanent, temporary, and retired
persistence rules are each identical between the new and old data policies

• The isolation levels match identically for each storage domain targeted

• The versioning policy of the new data policy is the same as the old

If an optional request parameter is not included, the previous setting is retained.
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Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/bucket/{bucket_name}/[?data_policy_id=

{string}][&protected=TRUE|FALSE][&user_id={string}]

Request Parameters 

Parameter Description Required

data_policy_
id

The UUID, name, or other unique attribute for the data policy. no

protected The protection status of the bucket. Protected buckets cannot be
deleted. Values: TRUE, FALSE (default).

no

user_id The UUID, username, or other unique identifier for the bucket
owner.

no

Responses

Response Elements
<Data>

   <CreationDate>{YYYY-MM-DDThh:mm:ss.xxxZ}</CreationDate>

   <DataPolicyId>{string}</DataPolicyId>

   <Id>{string}</Id>

   <LastPreferredChunkSizeInBytes>

{64-bit integer}

   </LastPreferredChunkSizeInBytes>
   <Name>{string}</Name>
   <Protected>{TRUE|FALSE}</Protected>

   <UserId>{string}</UserId>
</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.
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Parameter Description

CreationDate The date and time the bucket was created in the format YYYY-MM-
DDThh:mm:ss.xxxZ

DataPolicyId The UUID for the assigned data policy.

Id The UUID for the bucket.

LastPreferred
ChunkSizeInBytes

The last preferred chunk size computed for a PUT job for this bucket.

Name The name of the bucket.

Protected The protection setting for the bucket.

UserId The UUID for the bucket owner.

Example

Sample Request
This request modifies “bucket1” to use the data policy with the name “DP2”:
PUT http://blackpearl-hostname/_rest_/bucket/bucket1/?data_policy_id=DP2 HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>

   <CreationDate>2015-07-22 14:22:50.53</CreationDate>

   <DataPolicyId>

      edc234bc-5acd-4de2-a158-2a166ad607e8

   </DataPolicyId>

   <Id>173de2f9-a6b5-4b88-ba0e-2fd925aa1e4c</Id>

   <LastPreferredChunkSizeInBytes/>

   <Name>bucket1</Name>
   <Protected>FALSE</Protected>

   <UserId>47e1051f-0536-42e7-a3b8-4e4acfe19ace</UserId>

</Data>
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This section describes DS3 operations you can perform on objects.

Delete Folder Recursively 82

Get Object - DS3 83

Get Objects - DS3 85

Get Physical Placement 107

Undelete Object 126

Verify Physical Placement 128

DELETE FOLDER RECURSIVELY

Description
Recursively deletes the folder specified and all folders and objects beneath it associated with
the specified bucket.

Requests

Syntax
DELETE http[s]://{datapathDNSname}/folder/{Folder UUID, path, or other unique

attribute}/?bucket_id={string}&recursive

Request Parameters

Parameter Description Required

bucket_id 1 The UUID or name for a bucket. yes

recursive Included to indicate a recursive operation. yes

1) Parameter values can use wild cards (see Wild Card Syntax on page 30).
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Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 404: Not Found

Example

Sample Request
This request recursively deletes all objects and folders in the folder “movies/raw” associated
with the bucket “bucket1”.
DELETE http://blackpearl-hostname/folder/movies/raw/?bucket_id=bucket1&recursive

HTTP/1.1

Sample Response
HTTP/1.1 204 No Content

GET OBJECT - DS3

Description
Get information about an object.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/object/{object_name}/?bucket_id={string}
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Request Parameters

Parameter Description Required

bucket_id 1 The UUID, name, or other unique attribute for a bucket. yes

Responses

Response Elements
<Data>

   <BucketId>{string}</BucketId>

   <CreationDate>{YYYY-MM-DDThh:mm:ss.xxxZ}</CreationDate>

   <Id>{string}</Id>
   <Latest>TRUE|FALSE</Latest>

   <Name>{string}</Name>

   <Type>DATA|FOLDER</Type>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

BucketId The UUID for the bucket in which the object resides.

CreationDate The date and time the bucket was created in the format YYYY-MM-
DDThh:mm:ss.xxxZ.

Id The UUID for the object.

Latest Whether this version of the object is the latest.
Values: TRUE, FALSE

Name The name of the object.

Type The type of object. Values: DATA, FOLDER

1) Parameter values can use wild cards (see Wild Card Syntax on page 30).
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Example

Sample Request
This request GETs information about the object with the UUID 073fe9c2-5983-4a46-9974-
60804b8a6349 in the bucket with the UUID 6d17cd22-d456-4458-8cb6-b553eb81ce3f.
GET http://blackpearl-hostname/_rest_/object/073fe9c2-5983-4a46-9974-

60804b8a6349/?bucketId=6d17cd22-d456-4458-8cb6-b553eb81ce3f HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>

   <BucketId>6d17cd22-d456-4458-8cb6-b553eb81ce3f</BucketId>

   <CreationDate/>

   <Id>073fe9c2-5983-4a46-9974-60804b8a6349</Id>

   <Latest>TRUE</Latest>

   <Name>object_name</Name>

   <Type>DATA</Type>

</Data>

GET OBJECTS - DS3

Description
Lists information about all objects. Use parameters as selection criteria to return information
about a subset of the objects.

Note: Selection criteria should always be used to reduce the size of the response. The full
list can be very large and take a long time for the response.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/object/[?bucket_id={string}][&end_date={64-

bit integer}][&full_details][&include_physical_placement][&last_page]

[&latest=TRUE|FALSE][&name={string}][&page_length={32-bit integer}][&page_offset=

{32-bit integer}][&page_start_marker={string}][&start_date={64-bit integer}]

[&type=DATA|FOLDER]
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Request Parameters

Parameter Description Required

bucket_id 1 The UUID or name for a bucket. no

end_date If included, only objects created between the end_date and
start_date are included in the response.

no

full_details If included the ETag, owner, and size of the object is included
in the response.

no

include_physical_
placement

If included, the response includes physical placement
information.
Note: This parameter can only be used along with full_
details.

no

last_page If included, only the last page of results is returned. no

latest Whether this version of the blob is the latest. The default is
false. Values: TRUE, FALSE

no

name 1 The name of an object. no

page_length The maximum number of objects to list. The default is all items
after page_offset.

no

page_offset The starting point for the first object to list. The default
is 0.

no

page_start_
marker

The UUID or other unique attribute for the item just before the
first item to list.
Notes:
• Specifying both page_offset and page_start_marker
causes an error.

• If neither page_offset, nor page_start_marker are
specified, the page_offset default is used.

no

start_date If included, only objects created between the end_date and
start_date are included in the response.

no

type The type of object. Values: DATA, FOLDER no

1) Parameter values can use wild cards (see Wild Card Syntax on page 30).
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Responses

Response Elements
With full_details:
<Data>

   <Object or S3Object>
      <Blobs> (only if include_physical_placement is included)

         <Object

            Bucket="{string}"

            Id="{string}"

            InCache="TRUE|FALSE"

            Latest="TRUE|FALSE"

            Length="{64-bit integer}"

            Name="{string}"

            Offset="{64-bit integer}"

            VersionId="{string}">
            <PhysicalPlacement>

               <AzureTargets>

                  <AzureTarget>

                     <AccountKey>{string}</AccountKey>
                     <AccountName>{string}</AccountName>
                     <AutoVerifyFrequencyInDays>

{integer}
                     </AutoVerifyFrequencyInDays>
                     <CloudBucketPrefix>

{string}

                     </CloudBucketPrefix>

                     <CloudBucketSuffix>

{string}

                     </CloudBucketSuffix>
                     <DefaultReadPreference>

                        MINIMUM_LATENCY|AFTER_ONLINE_POOL|

                        AFTER_NEARLINE_POOL|

                        AFTER_NON_EJECTABLE_TAPE|LAST_RESORT|

                        NEVER

                     </DefaultReadPreference>
                     <Https>TRUE|FALSE</Https>

                     <Id>{string}</Id>

April 2023 DS3 API Reference-Spectra BlackPearl Nearline Gateway
- 87 -



Chapter 6 - DS3 Object Operations Get Objects - DS3

                     <LastFullyVerified/>

                     <Name>{string}</Name>

                     <PermitGoingOutOfSync>

                        TRUE|FALSE

                     </PermitGoingOutOfSync>
                     <Quiesced>NO|PENDING|YES</Quiesced>

                     <State>ONLINE|OFFLINE|LIMITED_ACCESS</State>

                  </AzureTarget>

                  ...

               </AzureTargets>

               <Ds3Targets>

                  <Ds3Target>

                     <AccessControlReplication>

                        NONE|USERS

                     </AccessControlReplication>

                     <AdminAuthId>{string}</AdminAuthId>

                     <AdminSecretKey>{string}</AdminSecretKey>

                     <DataPathEndPoint>{string}</DataPathEndPoint>

                     <DataPathHttps>TRUE|FALSE</DataPathHttps>

                     <DataPathPort>{16-bit integer}</DataPathPort>

                     <DataPathProxy>{string}</DataPathProxy>

                     <DataPathVerifyCertificate>

                        TRUE|FALSE

                     </DataPathVerifyCertificate>

                     <DefaultReadPreference>

                        MINIMUM_LATENCY|AFTER_ONLINE_POOL

                        |AFTER_NEARLINE_POOL

                        |AFTER_NON_EJECTABLE_TAPE|LAST_RESORT

                        |NEVER

                     </DefaultReadPreference>

                     <Id>{string}</Id>

                     <Name>{string}</Name>

                     <PermitGoingOutOfSync>

                        TRUE|FALSE

                     </PermitGoingOutOfSync>

                     <Quiesced>NO|PENDING|YES</Quiesced>
                     <ReplicatedUserDefaultDataPolicy>

{string}

                     </ReplicatedUserDefaultDataPolicy>

                     <State>ONLINE|OFFLINE</State>

                  </Ds3Target>
               </Ds3Targets>

April 2023 DS3 API Reference-Spectra BlackPearl Nearline Gateway
- 88 -



Chapter 6 - DS3 Object Operations Get Objects - DS3

               <Pools>

                  <Pool>

                     <AssignedToStorageDomain>

                        TRUE|FALSE

                     </AssignedToStorageDomain>

                     <AvailableCapacity>

{64-bit integer}

                     </AvailableCapacity>

                     <BucketId>{string}</BucketId>

                     <Guid>{string}</Guid>

                     <Health>OK|DEGRADED</Health>

                     <Id>{string}</Id>
                     <LastAccessed>

{YYYY-MM-DDThh:mm:ss.xxxZ}

                     </LastAccessed>

                     <LastModified>

{YYYY-MM-DDThh:mm:ss.xxxZ}

                     </LastModified>
                     <LastVerified>

{YYYY-MM-DDThh:mm:ss.xxxZ}

                     </LastVerified>

                     <Mountpoint>/{string}</Mountpoint>

                     <Name>{string}</Name>

                     <PartitionId>{string}</PartitionId>

                     <PoweredOn>TRUE|FALSE</PoweredOn>

                     <Quiesced>NO|PENDING|YES</Quiesced>

                     <ReservedCapacity>

{64-bit integer}

                      </ReservedCapacity>

                     <State>

                        NORMAL|FOREIGN|IMPORT_IN_PROGRESS|

                        IMPORT_PENDING|LOST

                     </State>

                     <StorageDomainMemberId>

{string}

                     </StorageDomainMemberId>
                     <TotalCapacity>

{64-bit integer}

                     </TotalCapacity>

                     <Type>NEARLINE|ONLINE</Type>

                     <UsedCapacity>{64-bit integer}</UsedCapacity>

                  </Pool>
                  ...

               </Pools>

April 2023 DS3 API Reference-Spectra BlackPearl Nearline Gateway
- 89 -



Chapter 6 - DS3 Object Operations Get Objects - DS3

               <S3Targets>

                  <S3Target>

                     <AccessKey>{string}</AccessKey>

                     <AutoVerifyFrequencyInDays>

{integer}

                     </AutoVerifyFrequencyInDays>
                     <CloudBucketPrefix>

{string}

                     </CloudBucketPrefix>
                     <CloudBucketSuffix>

{string}

                     </CloudBucketSuffix>
                     <DataPathEndPoint>{string}</DataPathEndPoint>
                     <DefaultReadPreference>

                        MINIMUM_LATENCY|AFTER_ONLINE_POOL|

                        AFTER_NEARLINE_POOL|

                        AFTER_NON_EJECTABLE_TAPE|LAST_RESORT|

                        NEVER

                     </DefaultReadPreference>
                     <Https>TRUE|FALSE</Https>
                     <Id>{string}</Id>
                     <LastFullyVerified>

{string}

                     </LastFullyVerified>
                     <Name>{string}</Name>
                     <NamingMode>BLACK_PEARL|AWS_S3</NamingMode>
                     <OfflineDataStagingWindowInTb>

{64-bit integer}
                     </OfflineDataStagingWindowInTb>
                     <PermitGoingOutOfSync>

                        TRUE|FALSE

                     </PermitGoingOutOfSync>
                     <ProxyDomain>{string}</ProxyDomain>
                     <ProxyHost>{string}</ProxyHost>
                     <ProxyPassword>{string}</ProxyPassword>
                     <ProxyPort>{64-bit integer}</ProxyPort>
                     <ProxyUsername>{string}</ProxyUsername>
                     <Quiesced>NO|PENDING|YES</Quiesced>
                     <Region>

                        US_EAST_1|US_EAST_2|US_WEST_1|US_WEST_2|

                        EU_WEST_1|EU_WEST_2|EU_CENTRAL_1|

                        AP_SOUTH_1|AP_SOUTHEAST_1|AP_SOUTHEAST_2|

                        AP_NORTHEAST_1|AP_NORTHEAST_2|SA_EAST_1|

                        CN_NORTH_1|GOV_CLOUD|CA_CENTRAL_1

                     </Region>
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                     <SecretKey>{string}</SecretKey>
                     <StagedDataExpirationInDays>

{64-bit integer}
                     </StagedDataExpirationInDays>
                     <State>ONLINE|OFFLINE|LIMITED_ACCESS</State>
                  </S3Target>
                  ...
               </S3Targets>
               <Tapes>

                  <Tape>

                     <AssignedToStorageDomain>

                        TRUE|FALSE

                     </AssignedToStorageDomain>

                     <AvailableRawCapacity>

{64-bit integer}

                     </AvailableRawCapacity>

                     <BarCode>{string}</BarCode>
                     <BucketId>{string}</BucketId>

                     <DescriptionForIdentification>

{string}

                     </DescriptionForIdentification>

                     <EjectDate>

{YYYY-MM-DDThh:mm:ss.xxxZ}

                     </EjectDate>

                     <EjectLabel>{string}</EjectLabel>

                     <EjectLocation>{string}</EjectLocation>

                     <EjectPending>

{YYYY-MM-DDThh:mm:ss.xxxZ}

                     </EjectPending>

                     <FullOfData>TRUE|FALSE</FullOfData>

                     <Id>{string}</Id>

                     <LastAccessed>

{YYYY-MM-DDThh:mm:ss.xxxZ}

                     </LastAccessed>

                     <LastCheckpoint>{string}</LastCheckpoint>

                     <LastModified>

{YYYY-MM-DDThh:mm:ss.xxxZ}

                     </LastModified>

                     <LastVerified>

{YYYY-MM-DDThh:mm:ss.xxxZ}

                     </LastVerified>
                     <PartiallyVerifiedEndOfTape>

{YYYY-MM-DDThh:mm:ss.xxxZ}

                     </PartiallyVerifiedEndOfTape>
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                     <PartitionId>{string}</PartitionId>
                     <PreviousState>

                        NORMAL|AUTO_COMPACTION_IN_PROGRESS|BAD|

                        BAR_CODE_MISSING|CANNOT_FORMAT_DUE_TO_

                        WRITE_PROTECTION|DATA_CHECKPOINT_FAILURE|

                        DATA_CHECKPOINT_FAILURE_DUE_TO_READ_ONLY|

                        DATA_CHECKPOINT_MISSING|EJECT_FROM_EE_

                        PENDING|EJECT_TO_EE_IN_PROGRESS|EJECTED|

                        FOREIGN|FORMAT_IN_PROGRESS|FORMAT_PENDING

                        |IMPORT_IN_PROGRESS|IMPORT_PENDING|

                        INCOMPATIBLE|LOST|LTFS_WITH_FOREIGN_DATA|

                        OFFLINE|ONLINE_IN_PROGRESS|ONLINE_PENDING

                        |PENDING_INSPECTION|RAW_IMPORT_IN_

                        PROGRESS|RAW_IMPORT_PENDING

                        |SERIAL_NUMBER_MISMATCH|UNKNOWN

                     </PreviousState>
                     <Role>NORMAL|TEST</Role>
                     <SerialNumber>{string}</SerialNumber>
                     <State>

                        NORMAL|AUTO_COMPACTION_IN_PROGRESS|BAD|

                        BAR_CODE_MISSING|CANNOT_FORMAT_DUE_TO_

                        WRITE_PROTECTION|DATA_CHECKPOINT_FAILURE|

                        DATA_CHECKPOINT_FAILURE_DUE_TO_READ_ONLY|

                        DATA_CHECKPOINT_MISSING|EJECT_FROM_EE_

                        PENDING|EJECT_TO_EE_IN_PROGRESS|EJECTED|

                        FOREIGN|FORMAT_IN_PROGRESS|FORMAT_PENDING

                        |IMPORT_IN_PROGRESS|IMPORT_PENDING|

                        INCOMPATIBLE|LOST|LTFS_WITH_FOREIGN_DATA|

                        OFFLINE|ONLINE_IN_PROGRESS|ONLINE_PENDING

                        |PENDING_INSPECTION|RAW_IMPORT_IN_

                        PROGRESS|RAW_IMPORT_PENDING

                        |SERIAL_NUMBER_MISMATCH|UNKNOWN

                     </State>
                     <StorageDomainMemberId>

{string}

                     </StorageDomainMemberId>
                     <TakeOwnershipPending>

                        TRUE|FALSE

                     </TakeOwnershipPending>
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                     <TotalRawCapacity>

{64-bit integer}

                     </TotalRawCapacity>

                     <Type>

                        FORBIDDEN|LTO5|LTO6|LTO7|LTO8|LTOM8|LTO9|

                        LTO_CLEANING_TAPE|TS_JC|TS_JD|TS_JE|

                        TS_JL|TS_JK|TS_JM|TS_JV|TS_JY|TS_JZ|

                        TS_CLEANING_TAPE|UNKNOWN

                       </Type>

                     <VerifyPending>

                        CRITICAL|URGENT|HIGH|NORMAL|LOW|

                        BACKGROUND

                     </VerifyPending>
                     <WriteProtected>TRUE|FALSE</WriteProtected>

                  </Tape>

               </Tapes>

            </PhysicalPlacement>

         </Object>

         ...

      </Blobs>
      <BlobsBeingPersisted>{string}</BlobsBeingPersisted>

(only if include_physical_placement is included)

      <BlobsDegraded>{64-bit integer}</BlobsDegraded>

(only if include_physical_placement is included)

      <BlobsInCache>{64-bit integer}</BlobsInCache>

(only if include_physical_placement is included)

      <BlobsTotal>{64-bit integer}</BlobsTotal>

(only if include_physical_placement is included)

      <BucketId>{string}</BucketId>

      <CreationDate>{YYYY-MM-DDThh:mm:ss.xxxZ}</CreationDate>
      <ETag>{string}</ETag> (only if full_details is included)

      <Id>{string}</Id>

      <Latest>TRUE|FALSE</Latest>

      <Name>{string}</Name>

      <Owner>{string}</Owner>

(only if full_details is included)

      <Size>{string}</Size> (only if full_details is included)

      <Type>DATA|FOLDER</Type>

   </Object or S3Object>

   ...

</Data>
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where the response elements are defined as follows:

Parameter Description
Only if
full_details
is included

Only if
include_
physical_
placement is
included

Data The container for the response.

Object The container for information about one
object that was split into multiple blobs.

S3Object The container for information about one
object that was kept whole.

Blobs The container for information about the
blobs that are part of the object.

yes

Object The container for information about one
blob.

yes

Bucket The name of the bucket to which the object is
assigned.

yes

Id The UUID for the blob. yes

InCache Whether the object is currently in cache on
the BlackPearl gateway. Values: TRUE, FALSE

yes

Latest Whether this version of the blob is the latest.
Values: TRUE, FALSE

yes

Length The length in bytes of the blob. yes

Name The name of the object. yes

Offset The offset in bytes from the start of the
object.

yes

VersionId The UUID for the version of the object. yes

Physical Placement  The container for the list of tapes containing
the object.

yes

AzureTargets The container for information about all
Azure targets with degraded objects.

yes
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Parameter Description
Only if
full_details
is included

Only if
include_
physical_
placement is
included

AzureTarget The container for information about one
Azure target with a degraded object.

yes

AccountName The account name for the Microsoft Azure
account.
Note: You can not use the same Account
Name for multiple Microsoft Azure targets.

yes

AutoVerify
FrequencyIn Days

The frequency at which a full verify of the
data on the target is scheduled. If null, no
full verify is scheduled.

yes

CloudBucket Prefix  The Azure target bucket prefix. The gateway
adds the prefix to the BlackPearl bucket
name when it replicates the bucket to the
Azure target.

yes

CloudBucket Suffix  The Azure target bucket suffix. The gateway
adds the suffix to the BlackPearl bucket
name when it replicates the bucket to the
Azure target.

yes

DefaultRead
Preference

When it is preferable to read from the Azure
target rather than the replication source.
Values: MINIMUM_LATENCY, AFTER_
ONLINE_POOL, AFTER_NEARLINE_POOL,
AFTER_NON_EJECTABLE_TAPE, LAST_
RESORT, NEVER. See read_preference on
page 455.

yes

Https Whether the BlackPearl gateway uses the
HTTPS protocol to setup and replicate data
to the target.
Values: TRUE, FALSE.

yes

Id The UUID for the Azure target instance. yes

LastFullyVerified The date and time the target was last fully
verified in the format YYYY-MM-
DDThh:mm:ss.xxxZ.

yes
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Parameter Description
Only if
full_details
is included

Only if
include_
physical_
placement is
included

Name The name for the Azure target. yes

PermitGoingOut
OfSync

Whether a target is allowed to be out of sync
with the source. See permit_going_out_of_
sync on page 474.
Note: This parameter is deprecated for
Azure targets.

yes

Quiesced Whether the Azure target is in a temporarily
inactive state. Values: NO, PENDING, YES

yes

State The state of the Azure target.
Values: ONLINE, OFFLINE, LIMITED_ACCESS

yes

Ds3Targets The container for information about all
BlackPearl targets.

yes

Ds3Target The container for information about one
BlackPearl target.

yes

AccessControl
Replication

The access control that is replicated to the
BlackPearl target.
Values:
NONE — No access control is replicated.
USERS — The source BlackPearl gateway
replicates its users and passwords to the
target gateway.

yes

AdminAuthId The S3 access ID assigned to an
Administrator.

yes

AdminSecretKey The S3 secret key for the account matching
the given AdminAuthId.

yes

DataPathEnd Point  The IPv4 address or DNS name for the data
path of the BlackPearl target.

yes

DataPathHttps Whether the source BlackPearl gateway uses
the HTTPS protocol to setup and replicate
data to the target gateway. Values: TRUE,
FALSE

yes
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Parameter Description
Only if
full_details
is included

Only if
include_
physical_
placement is
included

DataPathPort The value of the port on which the target
BlackPearl gateway’s S3 server is running. If
null, the parameter defaults to port 80 for
HTTP connections and port 443 for HTTPS
connections.

yes

DataPathProxy The proxy server for the source BlackPearl
gateway to use to connect to the target
gateway.

yes

DataPathVerify
Certificate

Whether the data path certificate is verified.
When DataPathVerifyCertificate and
DataPathHttps are both TRUE, the source
BlackPearl gateway fully validates the target
gateway’s certificate. If the certificate is not
trusted or problematic in anyway, it is not
honored.
Values: TRUE, FALSE

yes

DefaultRead
Preference

When it is preferable to read from the
BlackPearl target rather than the replication
source.
Values: MINIMUM_LATENCY, AFTER_
ONLINE_POOL, AFTER_NEARLINE_POOL,
AFTER_NON_EJECTABLE_TAPE, LAST_
RESORT, NEVER. See read_preference on
page 455.

yes

Id The UUID for the BlackPearl target instance.
Note: If a BlackPearl target has its instance
identifier reset after it is registered on other
BlackPearl gateways, the replication link is
forever invalid and must be deleted and re-
created.

yes

Name The name for the BlackPearl target. yes
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Parameter Description
Only if
full_details
is included

Only if
include_
physical_
placement is
included

PermitGoingOut
OfSync

Whether a target is allowed to be out of sync
with the source. By default, if the data policy
specifies that the BlackPearl gateway must
replicate local actions, actions that the
gateway cannot replicate fail. You can
temporarily set this parameter to TRUE in
order to operate in full capacity locally while
one or more targets is down for a prolonged
period of time.

yes

Quiesced Whether the BlackPearl target is in a
temporarily inactive state. Values: NO,
PENDING, YES

yes

ReplicatedUser
DefaultData Policy 

The data policy the target applies as the
default data policy for any users replicated
to the target.

yes

State The state of the BlackPearl target.
Values: ONLINE, OFFLINE, LIMITED_ACCESS

yes

Pools The container for information about all
pools.

yes

Pool The container for information about one
pool.

yes

AssignedTo
StorageDomain

Whether the pool is currently assigned to a
storage domain. Values: TRUE, FALSE

yes

Available Capacity  The amount of unused capacity on the pool
in bytes.

yes

BucketId The UUID for the bucket to which the pool
is assigned.

yes

Guid The ZFS identifier for the pool. yes

Health Whether the pool is in good health or
degraded.
Values: OK, DEGRADED

yes
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Parameter Description
Only if
full_details
is included

Only if
include_
physical_
placement is
included

Id The UUID for the pool. yes

LastAccessed The last date and time the pool was accessed
in the format YYYY-MM-
DDThh:mm:ss.xxxZ.

yes

LastModified The last date and time the object was
modified in the format YYYY-MM-
DDThh:mm:ss.xxxZ.

yes

LastVerified The last date and time the checksum of the
data was verified in the format YYYY-MM-
DDThh:mm:ss.xxxZ.

yes

MountPoint The logical directory used by the BlackPearl
gateway to access the pool.

yes

Name The name for the pool. yes

PartitionId The UUID of the pool partition. yes

PoweredOn Whether the pool is powered on. Values:
TRUE, FALSE

yes

Quiesced Whether the pool is in a temporarily inactive
state. Values: NO, PENDING, YES

yes

ReservedCapacity The capacity reserved to ensure pool
performance.

yes

State The status of the pool. See State on page 600. yes

StorageDomain
MemberId

The UUID for the storage domain member. yes

TotalCapacity The total capacity of the pool including used,
reserved and available capacity.

yes

Type The type of pool.
Values: NEARLINE (Deep Storage), ONLINE
(High Performance)

yes
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Parameter Description
Only if
full_details
is included

Only if
include_
physical_
placement is
included

UsedCapacity The amount of used capacity on the pool in
bytes.

yes

S3Targets The container for information about all
Amazon S3 targets with degraded objects.

yes

S3Target The container for information about one
Amazon S3 target with a degraded object.

yes

AccessKey The S3 Access Key of the user for the
Amazon S3 account.

yes

AutoVerify
FrequencyInDays

The frequency at which a full verify of the
data on the target is scheduled. If null, no
full verify is scheduled.

yes

CloudBucket
Prefix

The S3 target bucket prefix. The gateway
adds the prefix to the BlackPearl bucket
name when it replicates the bucket to the
Amazon S3 target.

yes

CloudBucket
Suffix

The S3 target bucket suffix. The gateway
adds the suffix to the BlackPearl bucket
name when it replicates the bucket to the
Amazon S3 target.

yes

DataPath Endpoint  The IPv4 address or DNS name for the data
path of the AWS cloud service.

yes

DefaultRead
Preference

When it is preferable to read from the
Amazon S3 target rather than the replication
source.
Values: MINIMUM_LATENCY, AFTER_
ONLINE_POOL, AFTER_NEARLINE_POOL,
AFTER_NON_EJECTABLE_TAPE, LAST_
RESORT, NEVER. See read_preference on
page 455.

yes
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Parameter Description
Only if
full_details
is included

Only if
include_
physical_
placement is
included

Https Whether the BlackPearl gateway uses the
HTTPS protocol to setup and replicate data
to the target.
Values: TRUE, FALSE.

yes

Id The UUID for the Amazon S3 target
instance.

yes

LastFullyVerified The date and time data on the target was last
fully verified in the format YYYY-MM-
DDThh:mm:ss.xxxZ.

yes

Name The name for the Amazon S3 target. yes

NamingMode Whether files written to the target use
BlackPearl (file UUIDs) or Amazon S3 (file
names) naming conventions.
Values: BLACK_PEARL, AWS_S3

yes

OfflineData
StagingWindow
InTb

The maximum size, in TB, of the window
available for staging data that is offline (in
Glacier) so that it can be read.

yes

PermitGoingOut
OfSync

Whether a target is allowed to be out of sync
with the source. See permit_going_out_of_
sync on page 474.
Note: This parameter is deprecated for S3
targets.

yes

ProxyDomain The domain name for the proxy server. yes

ProxyHost The host name or IP address for the proxy
server to which the BlackPearl gateway
connects.

yes

ProxyPassword The password used when connecting
through the proxy server.

yes

ProxyPort The proxy server port through which the
BlackPearl gateway connects.

yes
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Parameter Description
Only if
full_details
is included

Only if
include_
physical_
placement is
included

ProxyUsername The username used when connecting
through the proxy server.

yes

Quiesced Whether the Amazon S3 target is in a
temporarily inactive state. Values: NO,
PENDING, YES

yes

Region The world region where the Amazon S3
target is physically located. Values: US_
EAST_1, US_EAST_2, US_WEST_1, US_WEST_
2, EU_WEST_1, EU_WEST_2, EU_CENTRAL_1,
AP_SOUTH_1, AP_SOUTHEAST_1, AP_
SOUTHEAST_2, AP_NORTHEAST_1, AP_
NORTHEAST_2, SA_EAST_1, CN_NORTH_1,
GOV_CLOUD, CA_CENTRAL_1

yes

SecretKey The secret key associated with the
AccessKey.

yes

StagedData
ExpirationInDays

The number of days before the pre-staged
copy of data can expire.

yes

State The state of the Amazon S3 target.
Values: ONLINE, OFFLINE, LIMITED_ACCESS

yes

Tapes The container for information about all
tapes.

yes

Tape The container for information about the tape
containing the object.

yes

AssignedTo
StorageDomain

Whether the tape is currently assigned to a
storage domain. Values: TRUE, FALSE

yes

AvailableRaw
Capacity

The amount of unused raw capacity on the
tape in bytes.

yes

BarCode The barcode on the label of the tape
cartridge.

yes

BucketId The UUID for the bucket to which the tape is
assigned.

yes
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Parameter Description
Only if
full_details
is included

Only if
include_
physical_
placement is
included

DescriptionFor
Identification

The LTFS Volume ID and name, if applicable.
This is only provided if the BlackPearl
gateway cannot identify the tape.

yes

EjectDate The date and time that the BlackPearl
gateway discovered that the tape was
ejected, in the format YYYY-MM-
DDThh:mm:ss.xxxZ. If the parameter is
empty, the tape has not been ejected.

yes

EjectLabel The user-entered information to assist in the
handling of the tape.

yes

EjectLocation The user-entered information to describe
where the ejected tape can be located.

yes

EjectPending The date and time that the tape was put in
the queue to be ejected in the format YYYY-
MM-DDThh:mm:ss.xxxZ. If the parameter
is empty, the tape has not been queued to be
ejected or the eject has started and is no
longer cancelable.

yes

FullOfData Whether the tape is completely full of data.
Values: TRUE, FALSE

yes

Id The UUID for the tape. yes

LastAccessed The last date and time the tape was loaded
into a tape drive in the format YYYY-MM-
DDThh:mm:ss.xxxZ.

yes

LastCheckpoint An identifier, internal to the BlackPearl
gateway, for verifying the application
integrity of the tape.

yes

LastModified The last date and time the object was
modified in the format YYYY-MM-
DDThh:mm:ss.xxxZ.

yes
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Parameter Description
Only if
full_details
is included

Only if
include_
physical_
placement is
included

LastVerified The last date and time the checksum of the
data was verified in the format YYYY-MM-
DDThh:mm:ss.xxxZ.

yes

PartiallyVerified
EndOfTape

The last date and time the BlackPearl
gateway verified the data on a specified
percentage of the tape capacity before the
EOD marker in the format
YYYY-MM-DDThh:mm:ss.xxxZ.

yes

PartitionId The UUID for the partition to which the tape
belongs.

yes

PreviousState The previous status of the tape. See State on
page 664.

yes

Role The role assigned to the tape. Values:
Normal, Test

yes

SerialNumber The manufacturer-assigned serial number for
the tape.

yes

State The status of the tape. See State on page 664. yes

StorageDomain
MemberId

The UUID for the storage domain member. yes

TakeOwnership
Pending

Whether a tape from another BlackPearl
gateway is waiting for the current gateway
to complete taking ownership.
Values:
• TRUE — The foreign tape was imported
when WriteProtected was TRUE,
preventing the tape from being claimed by
the current BlackPearl gateway.

• FALSE — The tape was imported
successfully.

yes

TotalRawCapacity The total raw capacity of the tape in bytes. yes
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Parameter Description
Only if
full_details
is included

Only if
include_
physical_
placement is
included

Type The tape format and generation of the tape
cartridge.
Values: LTO5, LTO6, LTO7, LTO8, LTOM8,
LTO9, LTO_CLEANING_TAPE, TS_JC, TS_JD,
TS_JE, TS_JK, TS_JL, TS_JM, TS_JV, TS_JY,
TS_JZ, TS_CLEANING_TAPE, UNKNOWN,
FORBIDDEN

yes

VerifyPending The priority for the verify requested, or null
if a verify has not been requested. The
priority determines the resources assigned
and the processing order.
Values: CRITICAL, URGENT, HIGH, NORMAL,
LOW, BACKGROUND

yes

WriteProtected Whether the tape is write protected. Values:
TRUE, FALSE

yes

BlobsBeing
Persisted

The number of blobs for the object currently
being written to physical data stores.

yes yes

BlobsDegraded The number of blobs for the object in a
degraded state.

yes yes

BlobsInCache The number of blobs for the object existing
in cache.

yes yes

BlobsTotal The total number of blobs for the object. yes yes

BucketId The UUID for the bucket in which the object
resides.

CreationDate The date and time the bucket was created in
the format YYYY-MM-DDThh:mm:ss.xxxZ.

ETag The HTTP entity tag. yes

Id The UUID for the object.

Latest Whether this version of the object is the
latest.
Values: TRUE, FALSE
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Parameter Description
Only if
full_details
is included

Only if
include_
physical_
placement is
included

Name The name of the object.

Owner The owner of the object. yes

Size The size of the object in bytes. yes

Type The type of object. Values: DATA, FOLDER

Example

Sample Request
This request GETs information about all of the objects in all buckets with full details.
GET http://blackpearl-hostname/_rest_/object/?full_details HTTP/1.1

Sample Response
HTTP/1.1 200 OK
<Data>

   <Object>

      <BucketId>e980121b-d809-480e-90d3-04254e8ea7b2</BucketId>

      <CreationDate/>

      <ETag/>

      <Id>2373760e-fa82-4b76-9a04-e52b0199172f</Id>

      <Latest>TRUE</Latest>

      <Name>/audio/</Name>

      <Owner/>

      <Size>0</Size>

      <Type>FOLDER</Type><

   </Object>

April 2023 DS3 API Reference-Spectra BlackPearl Nearline Gateway
- 106 -



Chapter 6 - DS3 Object Operations Get Physical Placement

   <Object>

      <BucketId>e980121b-d809-480e-90d3-04254e8ea7b2</BucketId>

      <CreationDate/>

      <ETag/>

      <Id>471054f9-7452-45e0-8ed1-2b7cb92ec6d0</Id>

      <Latest>TRUE</Latest>

      <Name>/cover.jpg</Name>

      <Owner>owner name</Owner>

      <Size>98789</Size>

      <Type>DATA</Type>

   </Object>

</Data>

GET PHYSICAL PLACEMENT

Description
Get the list of media on which the specified objects are physically located. Errors are not
returned if the object does not exist or if the object does not have a physical placement. If the
full_details request parameter is specified, physical placement is shown on a per-object-
piece basis. If the full_details request parameter is not specified, a summary physical
placement is provided. Use the storage_domain_id parameter to return the physical
placement of the objects within the specified storage domain only.

Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/bucket/{bucket name}/?operation=get_physical_

placement[&full_details][&storage_domain={string}]
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Request Parameters

Parameter Description Required

operation The operation to perform. For this request, the operation is to get
physical placement.
Value: GET_PHYSICAL_PLACEMENT

yes

full_details If included, physical placement is shown on a per-object-piece basis.
If not included, a summary physical placement is provided

no

storage_
domain

The UUID, name, or other unique attribute for the storage domain. no

Request Elements
An XML payload, formatted as follows, must be sent to describe the object for which to get
physical placement information:
<Objects>

      <Object Name="{string}" Version_Id="{string}"/>

      <Object Name="{string}" Version_Id="{string}"/>

</Objects>

where the parameters are defined as follows:

Parameter Description Required

Objects A container for the list of objects. yes

Object The container for information about one object or object part. yes

Name The name of an object to eject. All objects in the list must be in the
same bucket.

yes

Version_Id The UUID for the version of the object. no
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Responses

Response Elements
<Data>

   <Object Id="{string}" InCache="TRUE|FALSE" Latest="TRUE|FALSE"

      Length="{64-bit integer}" Name="{string}"

      Offset="{64-bit integer}" VersionId="{string}">

(only if full_details is included)

      <PhysicalPlacement>(only if full_details is included)
         <AzureTargets>

            <AzureTarget>

               <AccountKey>{string}</AccountKey>
               <AccountName>{string}</AccountName>
               <AutoVerifyFrequencyInDays>

{integer}
               </AutoVerifyFrequencyInDays>
               <CloudBucketPrefix>{string}</CloudBucketPrefix>

               <CloudBucketSuffix>{string}</CloudBucketSuffix>

               <DefaultReadPreference>

                  MINIMUM_LATENCY|AFTER_ONLINE_POOL|

                  AFTER_NEARLINE_POOL|AFTER_NON_EJECTABLE_TAPE|

                  LAST_RESORT|NEVER

               </DefaultReadPreference>
               <Https>TRUE|FALSE</Https>

               <Id>{string}</Id>
               <LastFullyVerified/>

               <Name>{string}</Name>

               <PermitGoingOutOfSync>

                  TRUE|FALSE

               </PermitGoingOutOfSync>
               <Quiesced>NO|PENDING|YES</Quiesced>

               <State>ONLINE|OFFLINE|LIMITED_ACCESS</State>

            </AzureTarget>

            ...

         </AzureTargets>
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         <Ds3Targets>

            <Ds3Target>

               <AccessControlReplication>

                  NONE|USERS

               </AccessControlReplication>

               <AdminAuthId>{string}</AdminAuthId>

               <AdminSecretKey>{string}</AdminSecretKey>

               <DataPathEndPoint>{string}</DataPathEndPoint>

               <DataPathHttps>TRUE|FALSE</DataPathHttps>

               <DataPathPort>{16-bit integer}</DataPathPort>

               <DataPathProxy>{string}</DataPathProxy>

               <DataPathVerifyCertificate>

                  TRUE|FALSE

               </DataPathVerifyCertificate>

               <DefaultReadPreference>

                  MINIMUM_LATENCY|AFTER_ONLINE_POOL

                  |AFTER_NEARLINE_POOL

                  |AFTER_NON_EJECTABLE_TAPE|LAST_RESORT|NEVER

               </DefaultReadPreference>

               <Id>{string}</Id>

               <Name>{string}</Name>

               <PermitGoingOutOfSync>

                  TRUE|FALSE

               </PermitGoingOutOfSync>

               <Quiesced>NO|PENDING|YES</Quiesced>
               <ReplicatedUserDefaultDataPolicy>

{string}

               </ReplicatedUserDefaultDataPolicy>

               <State>ONLINE|OFFLINE</State>

            </Ds3Target>
         </Ds3Targets>
         <Pools>

            <Pool>

               <AssignedToStorageDomain>

                  TRUE|FALSE

               </AssignedToStorageDomain>

               <AvailableCapacity>

{64-bit integer}

               </AvailableCapacity>

               <BucketId>{string}</BucketId>

               <Guid>{string}</Guid>

               <Health>OK|DEGRADED</Health>

               <Id>{string}</Id>
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               <LastAccessed>

{YYYY-MM-DDThh:mm:ss.xxxZ}

               </LastAccessed>

               <LastModified>

{YYYY-MM-DDThh:mm:ss.xxxZ}

               </LastModified>
               <LastVerified>

{YYYY-MM-DDThh:mm:ss.xxxZ}

               </LastVerified>

               <Mountpoint>/{string}</Mountpoint>

               <Name>{string}</Name>

               <PartitionId>{string}</PartitionId>

               <PoweredOn>TRUE|FALSE</PoweredOn>

               <Quiesced>NO|PENDING|YES</Quiesced>

               <ReservedCapacity>

{64-bit integer}

                </ReservedCapacity>

               <State>

                  NORMAL|FOREIGN|IMPORT_IN_PROGRESS|

                  IMPORT_PENDING|LOST

               </State>

               <StorageDomainMemberId>

{string}

               </StorageDomainMemberId>
               <TotalCapacity>{64-bit integer}</TotalCapacity>

               <Type>NEARLINE|ONLINE</Type>

               <UsedCapacity>{64-bit integer}</UsedCapacity>

            </Pool>
            ...

         </Pools>
         <S3Targets>

            <S3Target>

               <AccessKey>{string}</AccessKey>

               <AutoVerifyFrequencyInDays>

{integer}

               </AutoVerifyFrequencyInDays>
               <CloudBucketPrefix>{string}</CloudBucketPrefix>
               <CloudBucketSuffix>{string}</CloudBucketSuffix>
               <DataPathEndPoint>{string}</DataPathEndPoint>
               <DefaultReadPreference>

                  MINIMUM_LATENCY|AFTER_ONLINE_POOL|

                  AFTER_NEARLINE_POOL|AFTER_NON_EJECTABLE_TAPE|

                  LAST_RESORT|NEVER

               </DefaultReadPreference>
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               <Https>TRUE|FALSE</Https>
               <Id>{string}</Id>
               <LastFullyVerified>{string}</LastFullyVerified>
               <Name>{string}</Name>
               <NamingMode>BLACK_PEARL|AWS_S3</NamingMode>
               <OfflineDataStagingWindowInTb>

{64-bit integer}
               </OfflineDataStagingWindowInTb>
               <PermitGoingOutOfSync>

                  TRUE|FALSE

               </PermitGoingOutOfSync>
               <ProxyDomain>{string}</ProxyDomain>
               <ProxyHost>{string}</ProxyHost>
               <ProxyPassword>{string}</ProxyPassword>
               <ProxyPort>{64-bit integer}</ProxyPort>
               <ProxyUsername>{string}</ProxyUsername>
               <Quiesced>NO|PENDING|YES</Quiesced>
               <Region>

                  US_EAST_1|US_EAST_2|US_WEST_1|US_WEST_2|

                  EU_WEST_1|EU_WEST_2|EU_CENTRAL_1|AP_SOUTH_1|

                  AP_SOUTHEAST_1|AP_SOUTHEAST_2|AP_NORTHEAST_1|

                  AP_NORTHEAST_2|SA_EAST_1|CN_NORTH_1|GOV_CLOUD|

                  CA_CENTRAL_1

               </Region>
               <SecretKey>{string}</SecretKey>
               <StagedDataExpirationInDays>

{64-bit integer}
               </StagedDataExpirationInDays>
               <State>ONLINE|OFFLINE|LIMITED_ACCESS</State>
            </S3Target>
            ...
         </S3Targets>
         <Tapes>

            <Tape>

               <AssignedToStorageDomain>

                  TRUE|FALSE

               </AssignedToStorageDomain>

               <AvailableRawCapacity>

{64-bit integer}

               </AvailableRawCapacity>

               <BarCode>{string}</BarCode>
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               <BucketId>{string}</BucketId>

               <DescriptionForIdentification>

{string}

               </DescriptionForIdentification>

               <EjectDate>{YYYY-MM-DDThh:mm:ss.xxxZ}</EjectDate>

               <EjectLabel>{string}</EjectLabel>

               <EjectLocation>{string}</EjectLocation>

               <EjectPending>

{YYYY-MM-DDThh:mm:ss.xxxZ}

               </EjectPending>

               <FullOfData>TRUE|FALSE</FullOfData>

               <Id>{string}</Id>

               <LastAccessed>

{YYYY-MM-DDThh:mm:ss.xxxZ}

               </LastAccessed>
               <LastCheckpoint>{string}</LastCheckpoint>

               <LastModified>

{YYYY-MM-DDThh:mm:ss.xxxZ}

               </LastModified>
               <LastVerified>

{YYYY-MM-DDThh:mm:ss.xxxZ}

               </LastVerified>
               <PartiallyVerifiedEndOfTape>

{YYYY-MM-DDThh:mm:ss.xxxZ}

               </PartiallyVerifiedEndOfTape>

               <PartitionId>{string}</PartitionId>
               <PreviousState>

                  NORMAL|AUTO_COMPACTION_IN_PROGRESS|BAD|

                  BAR_CODE_MISSING|CANNOT_FORMAT_DUE_TO_WRITE_

                  PROTECTION|DATA_CHECKPOINT_FAILURE|

                  DATA_CHECKPOINT_FAILURE_DUE_TO_READ_ONLY|

                  DATA_CHECKPOINT_MISSING|EJECT_FROM_EE_PENDING|

                  EJECT_TO_EE_IN_PROGRESS|EJECTED|FOREIGN|

                  FORMAT_IN_PROGRESS|FORMAT_PENDING|IMPORT_IN_

                  PROGRESS|IMPORT_PENDING|INCOMPATIBLE|

                  LOST|LTFS_WITH_FOREIGN_DATA|OFFLINE|

                  ONLINE_IN_PROGRESS|ONLINE_PENDING|PENDING_

                  INSPECTION|RAW_IMPORT_IN_PROGRESS|RAW_IMPORT_

                  PENDING|SERIAL_NUMBER_MISMATCH|UNKNOWN

               </PreviousState>
               <Role>NORMAL|TEST</Role>
               <SerialNumber>{string}</SerialNumber>
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               <State>

                  NORMAL|AUTO_COMPACTION_IN_PROGRESS|BAD|

                  BAR_CODE_MISSING|CANNOT_FORMAT_DUE_TO_WRITE_

                  PROTECTION|DATA_CHECKPOINT_FAILURE|

                  DATA_CHECKPOINT_FAILURE_DUE_TO_READ_ONLY|

                  DATA_CHECKPOINT_MISSING|EJECT_FROM_EE_PENDING|

                  EJECT_TO_EE_IN_PROGRESS|EJECTED|FOREIGN|

                  FORMAT_IN_PROGRESS|FORMAT_PENDING|IMPORT_IN_

                  PROGRESS|IMPORT_PENDING|INCOMPATIBLE|

                  LOST|LTFS_WITH_FOREIGN_DATA|OFFLINE|

                  ONLINE_IN_PROGRESS|ONLINE_PENDING|PENDING_

                  INSPECTION|RAW_IMPORT_IN_PROGRESS|RAW_IMPORT_

                  PENDING|SERIAL_NUMBER_MISMATCH|UNKNOWN

               </State>
               <StorageDomainMemberId>

{string}

               </StorageDomainMemberId>
               <TakeOwnershipPending>

                  TRUE|FALSE

               </TakeOwnershipPending>
               <TotalRawCapacity>

{64-bit integer}

               </TotalRawCapacity>
               <Type>

                  LTO5|LTO6|LTO7|LTO8|LTOM8|LTO9|LTO_CLEANING_TAPE|

                  TS_JC|TS_JD|TS_JE|TS_JK|TS_JL|TS_JM|TS_JV|

                  TS_JY|TS_JZ|TS_CLEANING_TAPE|UNKNOWN|FORBIDDEN

               </Type>
               <VerifyPending>

                  CRITICAL|URGENT|HIGH|NORMAL|LOW|BACKGROUND

               </VerifyPending>

               <WriteProtected>TRUE|FALSE</WriteProtected>

            </Tape>

         </Tapes>
      </PhysicalPlacement>

   </Object>

   ...

</Data>
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where the response elements are defined as follows:

Parameter Description
Only if full_
details is
included

Data A container for the response.

Object The container for information about one object. yes

Id The UUID for the object. yes

InCache Whether the object is currently in cache on the
BlackPearl gateway. Values: TRUE, FALSE

yes

Latest Whether this version of the object is the latest.
Values: TRUE, FALSE

yes

Length The length in bytes of the object. yes

Name The name of the object. yes

Offset The offset in bytes from the start of the object. yes

VersionId The UUID of the version of the object. yes

PhysicalPlacement The container for the list of tapes containing the
object.

yes

AzureTargets The container for information about all Azure
targets with degraded objects.

AzureTarget The container for information about one Azure
target with a degraded object.

AccountKey The account key associated with the account name
below.

AccountName The account name for the Microsoft Azure account.
Note: You can not use the same Account Name for
multiple Microsoft Azure targets.

AutoVerifyFrequency
InDays

The frequency at which a full verify of the data on
the target is scheduled. If null, no full verify is
scheduled.
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Parameter Description
Only if full_
details is
included

CloudBucketPrefix The Azure target bucket prefix. The gateway adds
the prefix to the BlackPearl bucket name when it
replicates the bucket to the Azure target.

CloudBucketSuffix The Azure target bucket suffix. The gateway adds
the suffix to the BlackPearl bucket name when it
replicates the bucket to the Azure target.

DefaultRead Preference When it is preferable to read from the Azure target
rather than the replication source.
Values: MINIMUM_LATENCY, AFTER_ONLINE_
POOL, AFTER_NEARLINE_POOL, AFTER_NON_
EJECTABLE_TAPE, LAST_RESORT, NEVER. See read_
preference on page 455.

Https Whether the BlackPearl gateway uses the HTTPS
protocol to setup and replicate data to the target.
Values: TRUE, FALSE.

Id The UUID for the Azure target instance.

LastFullyVerified The date and time the target was last fully verified
in the format YYYY-MM-DDThh:mm:ss.xxxZ.

Name The name for the Azure target.

PermitGoingOutOf Sync Whether a target is allowed to be out of sync with
the source. See permit_going_out_of_sync on
page 474.
Note: This parameter is deprecated for Azure
targets.

Quiesced Whether the Azure target is in a temporarily
inactive state. Values: NO, PENDING, YES

State The state of the Azure target.
Values: ONLINE, OFFLINE, LIMITED_ACCESS

Ds3Targets The container for information about all BlackPearl
targets.

Ds3Target The container for information about one BlackPearl
target.
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Parameter Description
Only if full_
details is
included

AccessControl
Replication

The access control that is replicated to the
BlackPearl target.
Values: NONE — No access control is replicated.
USERS — The source BlackPearl gateway replicates
its users and passwords to the target gateway.

AdminAuthId The S3 access ID assigned to an Administrator.

AdminSecretKey The S3 secret key for the account matching the
given AdminAuthId.

DataPathEndPoint The IPv4 address or DNS name for the data path of
the BlackPearl target.

DataPathHttps Whether the source BlackPearl gateway uses the
HTTPS protocol to setup and replicate data to the
target gateway. Values: TRUE, FALSE

DataPathPort The value of the port on which the target
BlackPearl gateway’s S3 server is running. If null,
the parameter defaults to port 80 for HTTP
connections and port 443 for HTTPS connections.

DataPathProxy The proxy server for the source BlackPearl gateway
to use to connect to the target gateway.

DataPathVerify
Certificate

Whether the data path certificate is verified. When
DataPathVerifyCertificate and DataPathHttps are
both TRUE, the source BlackPearl gateway fully
validates the target gateway’s certificate. If the
certificate is not trusted or problematic in anyway,
it is not honored.
Values: TRUE, FALSE

DefaultRead Preference When it is preferable to read from the BlackPearl
target rather than the replication source.
Values: MINIMUM_LATENCY, AFTER_ONLINE_
POOL, AFTER_NEARLINE_POOL, AFTER_NON_
EJECTABLE_TAPE, LAST_RESORT, NEVER. See read_
preference on page 455.
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Parameter Description
Only if full_
details is
included

Id The UUID for the BlackPearl target instance.
Note: If a BlackPearl target has its instance
identifier reset after it is registered on other
BlackPearl gateways, the replication link is forever
invalid and must be deleted and re-created.

Name The name for the BlackPearl target.

PermitGoingOutOf Sync Whether a target is allowed to be out of sync with
the source. By default, if the data policy specifies
that the BlackPearl gateway must replicate local
actions, actions that the gateway cannot replicate
fail. You can temporarily set this parameter to TRUE
in order to operate in full capacity locally while one
or more targets is down for a prolonged period of
time.

Quiesced Whether the BlackPearl target is in a temporarily
inactive state. Values: NO, PENDING, YES

ReplicatedUserDefault
DataPolicy

The data policy the target applies as the default
data policy for any users replicated to the target.

State The state of the BlackPearl target.
Values: ONLINE, OFFLINE, LIMITED_ACCESS

Pools The container for information about all pools.

Pool The container for information about one pool.

AssignedToStorage
Domain

Whether the pool is currently assigned to a storage
domain. Values: TRUE, FALSE

AvailableCapacity The amount of unused capacity on the pool in
bytes.

BucketId The UUID for the bucket to which the pool is
assigned.

Guid The ZFS identifier for the pool.

Health Whether the pool is in good health or degraded.
Values: OK, DEGRADED
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Parameter Description
Only if full_
details is
included

Id The UUID for the pool.

LastAccessed The last date and time the pool was accessed in the
format YYYY-MM-DDThh:mm:ss.xxxZ.

LastModified The last date and time the object was modified in
the format YYYY-MM-DDThh:mm:ss.xxxZ.

LastVerified The last date and time the checksum of the data
was verified in the format YYYY-MM-
DDThh:mm:ss.xxxZ.

MountPoint The logical directory used by the BlackPearl
gateway to access the pool.

Name The name for the pool.

PartitionId The UUID of the pool partition.

PoweredOn Whether the pool is powered on. Values: TRUE,
FALSE

Quiesced Whether the pool is in a temporarily inactive state.
Values: NO, PENDING, YES

ReservedCapacity The capacity reserved to ensure pool performance.

State The status of the pool. See State on page 600.

StorageDomain
MemberId

The UUID for the storage domain member.

TotalCapacity The total capacity of the pool including used,
reserved and available capacity.

Type The type of pool.
Values: NEARLINE (Deep Storage), ONLINE (High
Performance)

UsedCapacity The amount of used capacity on the pool in bytes.

S3Targets The container for information about all Amazon S3
targets with degraded objects.
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Parameter Description
Only if full_
details is
included

S3Target The container for information about one Amazon
S3 target with a degraded object.

AccessKey The S3 Access Key of the user for the Amazon S3
account.

AutoVerifyFrequency
InDays

The frequency at which a full verify of the data on
the target is scheduled. If null, no full verify is
scheduled.

CloudBucketPrefix The S3 target bucket prefix. The gateway adds the
prefix to the BlackPearl bucket name when it
replicates the bucket to the Amazon S3 target.

CloudBucketSuffix The S3 target bucket suffix. The gateway adds the
suffix to the BlackPearl bucket name when it
replicates the bucket to the Amazon S3 target.

DataPathEndpoint The IPv4 address or DNS name for the data path of
the AWS cloud service.

DefaultRead Preference When it is preferable to read from the Amazon S3
target rather than the replication source.
Values: MINIMUM_LATENCY, AFTER_ONLINE_
POOL, AFTER_NEARLINE_POOL, AFTER_NON_
EJECTABLE_TAPE, LAST_RESORT, NEVER. See read_
preference on page 455.

Https Whether the BlackPearl gateway uses the HTTPS
protocol to setup and replicate data to the target.
Values: TRUE, FALSE.

Id The UUID for the Amazon S3 target instance.

LastFullyVerified The date and time data on the target was last fully
verified in the format YYYY-MM-
DDThh:mm:ss.xxxZ.

Name The name for the Amazon S3 target.
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Parameter Description
Only if full_
details is
included

NamingMode Whether files written to the target use BlackPearl
(file UUIDs) or Amazon S3 (file names) naming
conventions.
Values: BLACK_PEARL, AWS_S3

OfflineDataStaging
WindowInTb

The maximum size, in TB, of the window available
for staging data that is offline (in Glacier) so that it
can be read.

PermitGoingOutOf Sync Whether a target is allowed to be out of sync with
the source. See permit_going_out_of_sync on
page 474.
Note: This parameter is deprecated for S3 targets.

ProxyDomain The domain name for the proxy server.

ProxyHost The host name or IP address for the proxy server
to which the BlackPearl gateway connects.

ProxyPassword The password used when connecting through the
proxy server.

ProxyPort The proxy server port through which the
BlackPearl gateway connects.

ProxyUsername The username used when connecting through the
proxy server.

Quiesced Whether the Amazon S3 target is in a temporarily
inactive state. Values: NO, PENDING, YES

Region The world region where the Amazon S3 target is
physically located. Values: US_EAST_1, US_EAST_2,
US_WEST_1, US_WEST_2, EU_WEST_1, EU_WEST_2,
EU_CENTRAL_1, AP_SOUTH_1, AP_SOUTHEAST_1,
AP_SOUTHEAST_2, AP_NORTHEAST_1, AP_
NORTHEAST_2, SA_EAST_1, CN_NORTH_1, GOV_
CLOUD, CA_CENTRAL_1

SecretKey The secret key associated with the AccessKey.

StagedDataExpiration
InDays

The number of days before the pre-staged copy of
data can expire.
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Parameter Description
Only if full_
details is
included

State The state of the Amazon S3 target.
Values: ONLINE, OFFLINE, LIMITED_ACCESS

Tapes The container for information about all tapes.

Tape The container for information about the tape
containing the object.

AssignedToStorage
Domain

Whether the tape is currently assigned to a storage
domain. Values: TRUE, FALSE

AvailableRaw Capacity The amount of unused raw capacity on the tape in
bytes.

BarCode The barcode on the label of the tape cartridge.

BucketId The UUID for the bucket to which the tape is
assigned.

DescriptionFor
Identification

The LTFS Volume ID and name, if applicable. This is
only provided if the BlackPearl gateway cannot
identify the tape.

EjectDate The date and time that the BlackPearl gateway
discovered that the tape was ejected, in the format
YYYY-MM-DDThh:mm:ss.xxxZ. If the parameter
is empty, the tape has not been ejected.

EjectLabel The user-entered information to assist in the
handling of the tape.

EjectLocation The user-entered information to describe where the
ejected tape can be located.

EjectPending The date and time that the tape was put in the
queue to be ejected in the format YYYY-MM-
DDThh:mm:ss.xxxZ. If the parameter is empty,
the tape has not been queued to be ejected or the
eject has started and is no longer cancelable.

FullOfData Whether the tape is completely full of data.
Values: TRUE, FALSE
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Parameter Description
Only if full_
details is
included

Id The UUID for the tape.

LastAccessed The last date and time the tape was loaded into a
tape drive in the format YYYY-MM-
DDThh:mm:ss.xxxZ.

LastCheckpoint An identifier, internal to the BlackPearl gateway,
for verifying the application integrity of the tape.

LastModified The last date and time the object was modified in
the format YYYY-MM-DDThh:mm:ss.xxxZ.

LastVerified The last date and time the checksum of the data
was verified in the format YYYY-MM-
DDThh:mm:ss.xxxZ.

PartiallyVerifiedEnd
OfTape

The last date and time the BlackPearl gateway
verified the data on a specified percentage of the
tape capacity before the EOD marker in the format
YYYY-MM-DDThh:mm:ss.xxxZ.

PartitionId The UUID for the partition to which the tape
belongs.

PreviousState The previous status of the tape. See State on
page 664.

Role The role assigned to the tape. Values: Normal, Test

SerialNumber The manufacturer-assigned serial number for the
tape.

State The status of the tape. See State on page 664.

StorageDomain
MemberId

The UUID for the storage domain member.
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Parameter Description
Only if full_
details is
included

TakeOwnership Pending Whether a tape from another BlackPearl gateway is
waiting for the current gateway to complete taking
ownership.
Values:
• TRUE — The foreign tape was imported when
WriteProtected was TRUE, preventing the
tape from being claimed by the current
BlackPearl gateway.

• FALSE — The tape was imported successfully.

TotalRawCapacity The total raw capacity of the tape in bytes.

Type The tape format and generation of the tape
cartridge.
Values: LTO5, LTO6, LTO7, LTO8, LTOM8, LTO9,
LTO_CLEANING_TAPE, TS_JC, TS_JD, TS_JE, TS_JK,
TS_JL, TS_JM, TS_JV, TS_JY, TS_JZ, TS_CLEANING_
TAPE, UNKNOWN, FORBIDDEN

VerifyPending The priority for the verify requested, or null if a
verify has not been requested. The priority
determines the resources assigned and the
processing order.
Values: CRITICAL, URGENT, HIGH, NORMAL, LOW,
BACKGROUND

WriteProtected Whether the tape is write protected. Values: TRUE,
FALSE

Example

Sample Request
This request returns a list of the tapes on which the objects specified in the payload reside.
PUT http://blackpearl-hostname/_rest_/bucket/bucket1/?operation=get_physical_

placement&full_details HTTP/1.1
<Objects>

      <Object Name="o1"/>

</Objects>
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Sample Response
HTTP/1.1 200 OK

<Data>

   <Object Bucket="b1" Id="0cdeed57-c962-4e58-9e70-3c20fc88d257"

      InCache="false" Latest="true" Length="10" Name="o1"

      Offset="0" VersionId="d3ac09a1-15b1-4c72-9a44-d0a3e3c39d31">
      <PhysicalPlacement>

         <AzureTargets/>

         <Ds3Targets/>
         <Pools>

            <Pool>

               <AssignedToStorageDomain>false</AssignedToStorageDomain>

               <AvailableCapacity>10000</AvailableCapacity>

               <BucketId/>

               <Guid>d276b9a9-02e4-4528-972d-8e621719510c</Guid>

               <Health>OK</Health>
               <Id>8b5a44e5-cfe8-4021-a745-bc70832cd6b5</Id>

               <LastAccessed/>

               <LastModified/>

               <LastVerified/>

               <Mountpoint>/mountpoint-0</Mountpoint>

               <Name>p1</Name>
               <PartitionId/>

               <PoweredOn>true</PoweredOn>

               <Quiesced>NO</Quiesced>

               <ReservedCapacity>0</ReservedCapacity>

               <State>NORMAL</State>
               <StorageDomainMemberId>

                  db43b9ee-f2a5-4e8d-8620-f7aa14508bba

               </StorageDomainMemberId>

               <TotalCapacity>0</TotalCapacity>

               <Type>NEARLINE</Type>

               <UsedCapacity>20000</UsedCapacity>

            </Pool>

         </Pools>
         <S3Targets/>

         <Tapes/>

      </PhysicalPlacement>

   </Object>

</Data>
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UNDELETE OBJECT

Description
Restores the most recent version of an object when the data policy specifies versioning=KEEP_
MULTIPLE_VERSIONS.

Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/object/?bucket_id={string}&name={string}

Request Parameters

Parameter Description Required

bucket_id 1 The UUID, name, or other unique attribute for a bucket. yes

name 1 The name, UUID, or other unique attribute of an object. yes

Responses

Response Elements
<Data>

   <BucketId>{string}</BucketId>

   <CreationDate>{YYYY-MM-DDThh:mm:ss.xxxZ}</CreationDate>

   <Id>{string}</Id>
   <Latest>TRUE|FALSE</Latest>

   <Name>{string}</Name>

   <Type>DATA|FOLDER</Type>

</Data>

1) Parameter values can use wild cards (see Wild Card Syntax on page 30).
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where the response elements are defined as follows:

Parameter Description

Data The container for the response.

BucketId The UUID for the bucket in which the object resides.

CreationDate The date and time the bucket was created in the format YYYY-MM-
DDThh:mm:ss.xxxZ.

Id The UUID for the object.

Latest Whether this version of the object is the latest.
Values: TRUE, FALSE

Name The name of the object.

Type The type of object. Values: DATA, FOLDER

Example

Sample Request
This request restores the object with the UUID 073fe9c2-5983-4a46-9974-60804b8a6349 in the
bucket named bucket1.
PUT http://blackpearl-hostname/_rest_/object/?bucketId=bucket1 &name=073fe9c2-5983-

4a46-9974-60804b8a6349 HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>

   <BucketId>6d17cd22-d456-4458-8cb6-b553eb81ce3f</BucketId>

   <CreationDate/>

   <Id>073fe9c2-5983-4a46-9974-60804b8a6349</Id>

   <Latest>TRUE</Latest>

   <Name>object_name</Name>

   <Type>DATA</Type>

</Data>
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VERIFY PHYSICAL PLACEMENT

Description
Get the list of media on which the specified objects are physically located. A 404, not found,
error is returned if one or more objects either does not exist, or has no physical placement.
Therefore, if you don’t receive an error, you know that all objects have a physical placement
without having to parse the entire response. If the full_details request parameter is
specified, physical placement is shown on a per object piece basis. If the full_details
request parameter is not specified, a summary physical placement is provided. Use the
storage_domain_id parameter to verify the physical placement of the objects within the
specified storage domain only.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/bucket/{bucket name}/?operation=verify_

physical_placement[&full_details][&storage_domain={string}]

Request Parameters

Parameter Description Required

operation The operation to perform. For this request, the operation is to verify
physical placement.
Value: VERIFY_PHYSICAL_PLACEMENT

yes

full_details If included, the list also contains information about which objects
are on each tape.

no

storage_
domain

The UUID, name, or other unique attribute for the storage domain. no

Request Elements
An XML payload must be sent to describe the objects, formatted as follows:
<Objects>

   <Object Name="{string}" Version_Id="{string}/>

   <Object Name="{string}" Version_Id="{string}/>

</Objects>
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where the parameters are defined as follows:

Parameter Description Required

Objects A container for the list of objects. yes

Object The container for information about one object or object part. yes

Name The name of an object to eject. All objects in the list must be in the
same bucket.

yes

Version_Id The UUID for the version of the object. no

Responses

Response Elements
<Data>

   <Object Id="{string}" InCache=”TRUE|FALSE” Latest="TRUE|FALSE"

      Length="{64-bit integer}" Name="{string}"

      Offset="{64-bit integer}" VersionId="{string}">

(only if full_details is included)

      <PhysicalPlacement>(only if full_details is included)

         <AzureTargets>

            <AzureTarget>

               <AccountKey>{string}</AccountKey>
               <AccountName>{string}</AccountName>
               <AutoVerifyFrequencyInDays>

{integer}
               </AutoVerifyFrequencyInDays>
               <CloudBucketPrefix>{string}</CloudBucketPrefix>

               <CloudBucketSuffix>{string}</CloudBucketSuffix>

               <DefaultReadPreference>

                  MINIMUM_LATENCY|AFTER_ONLINE_POOL|

                  AFTER_NEARLINE_POOL|AFTER_NON_EJECTABLE_TAPE|

                  LAST_RESORT|NEVER

               </DefaultReadPreference>
               <Https>TRUE|FALSE</Https>

               <Id>{string}</Id>
               <LastFullyVerified/>

               <Name>{string}</Name>

               <PermitGoingOutOfSync>

                  TRUE|FALSE

               </PermitGoingOutOfSync>
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               <Quiesced>NO|PENDING|YES</Quiesced>

               <State>ONLINE|OFFLINE|LIMITED_ACCESS</State>

            </AzureTarget>

            ...
         </AzureTargets>
         <Ds3Targets>

            <Ds3Target>

               <AccessControlReplication>

                  NONE|USERS

               </AccessControlReplication>

               <AdminAuthId>{string}</AdminAuthId>

               <AdminSecretKey>{string}</AdminSecretKey>

               <DataPathEndPoint>{string}</DataPathEndPoint>

               <DataPathHttps>TRUE|FALSE</DataPathHttps>

               <DataPathPort>{16-bit integer}</DataPathPort>

               <DataPathProxy>{string}</DataPathProxy>

               <DataPathVerifyCertificate>

                  TRUE|FALSE

               </DataPathVerifyCertificate>

               <DefaultReadPreference>

                  MINIMUM_LATENCY|AFTER_ONLINE_POOL

                  |AFTER_NEARLINE_POOL

                  |AFTER_NON_EJECTABLE_TAPE|LAST_RESORT|NEVER

               </DefaultReadPreference>

               <Id>{string}</Id>

               <Name>{string}</Name>

               <PermitGoingOutOfSync>

                  TRUE|FALSE

               </PermitGoingOutOfSync>

               <Quiesced>NO|PENDING|YES</Quiesced>
               <ReplicatedUserDefaultDataPolicy>

{string}

               </ReplicatedUserDefaultDataPolicy>

               <State>ONLINE|OFFLINE</State>

            </Ds3Target>
            ...
         </Ds3Targets>
         <Pools>

            <Pool>

               <AssignedToStorageDomain>

                  TRUE|FALSE

               </AssignedToStorageDomain>
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               <AvailableCapacity>

{64-bit integer}

               </AvailableCapacity>

               <BucketId>{string}</BucketId>

               <Guid>{string}</Guid>

               <Health>OK|DEGRADED</Health>

               <Id>{string}</Id>
               <LastAccessed>

{YYYY-MM-DDThh:mm:ss.xxxZ}

               </LastAccessed>
               <LastModified>

{YYYY-MM-DDThh:mm:ss.xxxZ}

               </LastModified>
               <LastVerified>

{YYYY-MM-DDThh:mm:ss.xxxZ}

               </LastVerified>

               <Mountpoint>/{string}</Mountpoint>

               <Name>{string}</Name>

               <PartitionId>{string}</PartitionId>

               <PoweredOn>TRUE|FALSE</PoweredOn>

               <Quiesced>NO|PENDING|YES</Quiesced>

               <ReservedCapacity>

{64-bit integer}

                </ReservedCapacity>

               <State>

                  NORMAL|FOREIGN|IMPORT_IN_PROGRESS|

                  IMPORT_PENDING|LOST

               </State>
               <StorageDomainMemberId>

{string}

               </StorageDomainMemberId>

               <TotalCapacity>{64-bit integer}</TotalCapacity>

               <Type>NEARLINE|ONLINE</Type>
               <UsedCapacity>{64-bit integer}</UsedCapacity>

            </Pool>
            ...

         </Pools>
         <S3Targets>

            <S3Target>

               <AccessKey>{string}</AccessKey>

               <AutoVerifyFrequencyInDays>

{integer}

               </AutoVerifyFrequencyInDays>
               <CloudBucketPrefix>{string}</CloudBucketPrefix>
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               <CloudBucketSuffix>{string}</CloudBucketSuffix>
               <DataPathEndPoint>{string}</DataPathEndPoint>
               <DefaultReadPreference>

                  MINIMUM_LATENCY|AFTER_ONLINE_POOL|

                  AFTER_NEARLINE_POOL|AFTER_NON_EJECTABLE_TAPE|

                  LAST_RESORT|NEVER

               </DefaultReadPreference>
               <Https>TRUE|FALSE</Https>
               <Id>{string}</Id>
               <LastFullyVerified>{string}</LastFullyVerified>
               <Name>{string}</Name>
               <NamingMode>BLACK_PEARL|AWS_S3</NamingMode>
               <OfflineDataStagingWindowInTb>

{64-bit integer}
               </OfflineDataStagingWindowInTb>
               <PermitGoingOutOfSync>

                  TRUE|FALSE

               </PermitGoingOutOfSync>
               <ProxyDomain>{string}</ProxyDomain>
               <ProxyHost>{string}</ProxyHost>
               <ProxyPassword>{string}</ProxyPassword>
               <ProxyPort>{64-bit integer}</ProxyPort>
               <ProxyUsername>{string}</ProxyUsername>
               <Quiesced>NO|PENDING|YES</Quiesced>
               <Region>

                  US_EAST_1|US_EAST_2|US_WEST_1|US_WEST_2|

                  EU_WEST_1|EU_WEST_2|EU_CENTRAL_1|AP_SOUTH_1|

                  AP_SOUTHEAST_1|AP_SOUTHEAST_2|AP_NORTHEAST_1|

                  AP_NORTHEAST_2|SA_EAST_1|CN_NORTH_1|GOV_CLOUD|

                  CA_CENTRAL_1

               </Region>
               <SecretKey>{string}</SecretKey>
               <StagedDataExpirationInDays>

{64-bit integer}
               </StagedDataExpirationInDays>
               <State>ONLINE|OFFLINE|LIMITED_ACCESS</State>
            </S3Target>
            ...
         </S3Targets>
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         <Tapes>

            <Tape>

               <AssignedToStorageDomain>

                  TRUE|FALSE

               </AssignedToStorageDomain>

               <AvailableRawCapacity>

{64-bit integer}

               </AvailableRawCapacity>

               <BarCode>{string}</BarCode>

               <BucketId>{string}</BucketId>

               <DescriptionForIdentification>

{string}

               </DescriptionForIdentification>
               <EjectDate>{YYYY-MM-DDThh:mm:ss.xxxZ}</EjectDate>

               <EjectLabel>{string}</EjectLabel>

               <EjectLocation>{string}</EjectLocation>
               <EjectPending>

{YYYY-MM-DDThh:mm:ss.xxxZ}

               </EjectPending>

               <FullOfData>TRUE|FALSE</FullOfData>

               <Id>{string}</Id>

               <LastAccessed>

{YYYY-MM-DDThh:mm:ss.xxxZ}

               </LastAccessed>

               <LastCheckpoint>{string}</LastCheckpoint>
               <LastModified>

{YYYY-MM-DDThh:mm:ss.xxxZ}

               </LastModified>
               <LastVerified>

{YYYY-MM-DDThh:mm:ss.xxxZ}

               </LastVerified>
               <PartiallyVerifiedEndOfTape>

{YYYY-MM-DDThh:mm:ss.xxxZ}

               </PartiallyVerifiedEndOfTape>

               <PartitionId>{string}</PartitionId>
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               <PreviousState>

                  NORMAL|AUTO_COMPACTION_IN_PROGRESS|BAD|

                  BAR_CODE_MISSING|CANNOT_FORMAT_DUE_TO_WRITE_

                  PROTECTION|DATA_CHECKPOINT_FAILURE|

                  DATA_CHECKPOINT_FAILURE_DUE_TO_READ_ONLY|

                  DATA_CHECKPOINT_MISSING|EJECT_FROM_EE_PENDING|

                  EJECT_TO_EE_IN_PROGRESS|EJECTED|FOREIGN|

                  FORMAT_IN_PROGRESS|FORMAT_PENDING|IMPORT_IN_

                  PROGRESS|IMPORT_PENDING|INCOMPATIBLE|

                  LOST|LTFS_WITH_FOREIGN_DATA|OFFLINE|

                  ONLINE_IN_PROGRESS|ONLINE_PENDING|PENDING_

                  INSPECTION|RAW_IMPORT_IN_PROGRESS|RAW_IMPORT_

                  PENDING|SERIAL_NUMBER_MISMATCH|UNKNOWN

               </PreviousState>
               <Role>NORMAL|TEST</Role>
               <SerialNumber>{string}</SerialNumber>
               <State>

                  NORMAL|AUTO_COMPACTION_IN_PROGRESS|BAD|

                  BAR_CODE_MISSING|CANNOT_FORMAT_DUE_TO_WRITE_

                  PROTECTION|DATA_CHECKPOINT_FAILURE|

                  DATA_CHECKPOINT_FAILURE_DUE_TO_READ_ONLY|

                  DATA_CHECKPOINT_MISSING|EJECT_FROM_EE_PENDING|

                  EJECT_TO_EE_IN_PROGRESS|EJECTED|FOREIGN|

                  FORMAT_IN_PROGRESS|FORMAT_PENDING|IMPORT_IN_

                  PROGRESS|IMPORT_PENDING|INCOMPATIBLE|

                  LOST|LTFS_WITH_FOREIGN_DATA|OFFLINE|

                  ONLINE_IN_PROGRESS|ONLINE_PENDING|PENDING_

                  INSPECTION|RAW_IMPORT_IN_PROGRESS|RAW_IMPORT_

                  PENDING|SERIAL_NUMBER_MISMATCH|UNKNOWN

               </State>

               <StorageDomainMemberId>

{string}

               </StorageDomainMemberId>

               <TakeOwnershipPending>

                  TRUE|FALSE

               </TakeOwnershipPending>
               <TotalRawCapacity>

{64-bit integer}

               </TotalRawCapacity>
               <Type>

                  LTO5|LTO6|LTO7|LTO8|LTOM8|LTO9|LTO_CLEANING_TAPE|

                  TS_JC|TS_JD|TS_JE|TS_JK|TS_JL|TS_JM|TS_JV|

                  TS_JY|TS_JZ|TS_CLEANING_TAPE|UNKNOWN|FORBIDDEN

               </Type>
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               <VerifyPending>

                  CRITICAL|URGENT|HIGH|NORMAL|LOW|BACKGROUND

               </VerifyPending>
               <WriteProtected>TRUE|FALSE</WriteProtected>

            </Tape>

            ...
         </Tapes>

      </PhysicalPlacement>

   </Object>
   ...

</Data>

where the response elements are defined as follows:

Parameter Description
Only if
full_details
included

Data A container for the response.

Object The container for information about one object. yes

Id The UUID for the object. yes

InCache Whether the object is currently in cache on the
BlackPearl gateway. Values: TRUE, FALSE

yes

Latest Whether this version of the object is the latest.
Values: TRUE, FALSE

yes

Length The length in bytes of the object. yes

Name The name of the object. yes

Offset The offset in bytes from the start of the object. yes

VersionId The UUID of the version of the object. yes

PhysicalPlacement The container for the list of tapes containing
the object.

yes

AzureTargets The container for information about all Azure
targets with degraded objects.

AzureTarget The container for information about one Azure
target with a degraded object.
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Parameter Description
Only if
full_details
included

AccountName The account name for the Microsoft Azure
account.
Note: You can not use the same Account Name
for multiple Microsoft Azure targets.

AutoVerify
FrequencyInDays

The frequency at which a full verify of the data
on the target is scheduled. If null, no full verify
is scheduled.

CloudBucketPrefix The Azure target bucket prefix. The gateway
adds the prefix to the BlackPearl bucket name
when it replicates the bucket to the Azure
target.

CloudBucketSuffix The Azure target bucket suffix. The gateway
adds the suffix to the BlackPearl bucket name
when it replicates the bucket to the Azure
target.

DefaultRead Preference When it is preferable to read from the Azure
target rather than the replication source.
Values: MINIMUM_LATENCY, AFTER_ONLINE_
POOL, AFTER_NEARLINE_POOL, AFTER_NON_
EJECTABLE_TAPE, LAST_RESORT, NEVER. See
read_preference on page 455.

Https Whether the BlackPearl gateway uses the
HTTPS protocol to setup and replicate data to
the target.
Values: TRUE, FALSE.

Id The UUID for the Azure target instance.

LastFullyVerified The date and time the target was last fully
verified in the format YYYY-MM-
DDThh:mm:ss.xxxZ.

Name The name for the Azure target.
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Parameter Description
Only if
full_details
included

PermitGoingOutOfSync Whether a target is allowed to be out of sync
with the source. See permit_going_out_of_sync
on page 474.
Note: This parameter is deprecated for Azure
targets.

Quiesced Whether the Azure target is in a temporarily
inactive state. Values: NO, PENDING, YES

State The state of the Azure target.
Values: ONLINE, OFFLINE, LIMITED_ACCESS

Ds3Targets The container for information about all
BlackPearl targets.

Ds3Target The container for information about one
BlackPearl target.

AccessControl Replication The access control that is replicated to the
BlackPearl target.
Values:
NONE — No access control is replicated.
USERS — The source BlackPearl gateway
replicates its users and passwords to the target
gateway.

AdminAuthId The S3 access ID assigned to an Administrator.

AdminSecretKey The S3 secret key for the account matching the
given AdminAuthId.

DataPathEndPoint The IPv4 address or DNS name for the data
path of the BlackPearl target.

DataPathHttps Whether the source BlackPearl gateway uses
the HTTPS protocol to setup and replicate data
to the target gateway. Values: TRUE, FALSE

DataPathPort The value of the port on which the target
BlackPearl gateway’s S3 server is running. If
null, the parameter defaults to port 80 for
HTTP connections and port 443 for HTTPS
connections.
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Parameter Description
Only if
full_details
included

DataPathProxy The proxy server for the source BlackPearl
gateway to use to connect to the target
gateway.

DataPathVerify Certificate Whether the data path certificate is verified.
When DataPathVerifyCertificate and
DataPathHttps are both TRUE, the source
BlackPearl gateway fully validates the target
gateway’s certificate. If the certificate is not
trusted or problematic in anyway, it is not
honored.
Values: TRUE, FALSE

DefaultRead Preference When it is preferable to read from the
BlackPearl target rather than the replication
source.
Values: MINIMUM_LATENCY, AFTER_ONLINE_
POOL, AFTER_NEARLINE_POOL, AFTER_NON_
EJECTABLE_TAPE, LAST_RESORT, NEVER. See
read_preference on page 455.

Id The UUID for the BlackPearl target instance.
Note: If a BlackPearl target has its instance
identifier reset after it is registered on other
BlackPearl gateways, the replication link is
forever invalid and must be deleted and re-
created.

Name The name for the BlackPearl target.

PermitGoingOutOfSync Whether a target is allowed to be out of sync
with the source. By default, if the data policy
specifies that the BlackPearl gateway must
replicate local actions, actions that the gateway
cannot replicate fail. You can temporarily set
this parameter to TRUE in order to operate in
full capacity locally while one or more targets is
down for a prolonged period of time.

Quiesced Whether the BlackPearl target is in a
temporarily inactive state. Values: NO,
PENDING, YES
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Parameter Description
Only if
full_details
included

ReplicatedUser DefaultDataPolicy The data policy the target applies as the
default data policy for any users replicated to
the target.

State The state of the BlackPearl target.
Values: ONLINE, OFFLINE, LIMITED_ACCESS

Pools The container for information about all pools.

Pool The container for information about one pool.

AssignedToStorageDomain Whether the pool is currently assigned to a
storage domain. Values: TRUE, FALSE

AvailableCapacity The amount of unused capacity on the pool in
bytes.

BucketId The UUID for the bucket to which the pool is
assigned.

Guid The ZFS identifier for the pool.

Health Whether the pool is in good health or
degraded.
Values: OK, DEGRADED

Id The UUID for the pool.

LastAccessed The last date and time the pool was accessed
in the format YYYY-MM-DDThh:mm:ss.xxxZ.

LastModified The last date and time the object was modified
in the format YYYY-MM-DDThh:mm:ss.xxxZ.

LastVerified The last date and time the checksum of the
data was verified in the format YYYY-MM-
DDThh:mm:ss.xxxZ.

MountPoint The logical directory used by the BlackPearl
gateway to access the pool.

Name The name for the pool.

PartitionId The UUID of the pool partition.
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Parameter Description
Only if
full_details
included

PoweredOn Whether the pool is powered on. Values: TRUE,
FALSE

Quiesced Whether the pool is in a temporarily inactive
state. Values: NO, PENDING, YES

ReservedCapacity The capacity reserved to ensure pool
performance.

State The status of the pool. See State on page 600.

StorageDomain
MemberId

The UUID for the storage domain member.

TotalCapacity The total capacity of the pool including used,
reserved and available capacity.

Type The type of pool.
Values: NEARLINE (Deep Storage), ONLINE
(High Performance)

UsedCapacity The amount of used capacity on the pool in
bytes.

S3Targets The container for information about all
Amazon S3 targets with degraded objects.

S3Target The container for information about one
Amazon S3 target with a degraded object.

AccessKey The S3 Access Key of the user for the Amazon
S3 account.

AutoVerify
FrequencyInDays

The frequency at which a full verify of the data
on the target is scheduled. If null, no full verify
is scheduled.

CloudBucketPrefix The S3 target bucket prefix. The gateway adds
the prefix to the BlackPearl bucket name when
it replicates the bucket to the Amazon S3
target.
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Parameter Description
Only if
full_details
included

CloudBucketSuffix The S3 target bucket suffix. The gateway adds
the suffix to the BlackPearl bucket name when
it replicates the bucket to the Amazon S3
target.

DataPathEndpoint The IPv4 address or DNS name for the data
path of the AWS cloud service.

DefaultRead Preference When it is preferable to read from the Amazon
S3 target rather than the replication source.
Values: MINIMUM_LATENCY, AFTER_ONLINE_
POOL, AFTER_NEARLINE_POOL, AFTER_NON_
EJECTABLE_TAPE, LAST_RESORT, NEVER. See
read_preference on page 455.

Https Whether the BlackPearl gateway uses the
HTTPS protocol to setup and replicate data to
the target.
Values: TRUE, FALSE.

Id The UUID for the Amazon S3 target instance.

LastFullyVerified The date and time data on the target was last
fully verified in the format YYYY-MM-
DDThh:mm:ss.xxxZ.

Name The name for the Amazon S3 target.

NamingMode Whether files written to the target use
BlackPearl (file UUIDs) or Amazon S3 (file
names) naming conventions.
Values: BLACK_PEARL, AWS_S3

OfflineDataStagingWindowInTb The maximum size, in TB, of the window
available for staging data that is offline (in
Glacier) so that it can be read.

PermitGoingOutOfSync Whether a target is allowed to be out of sync
with the source. See permit_going_out_of_sync
on page 474.
Note: This parameter is deprecated for S3
targets.
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Parameter Description
Only if
full_details
included

ProxyDomain The domain name for the proxy server.

ProxyHost The host name or IP address for the proxy
server to which the BlackPearl gateway
connects.

ProxyPassword The password used when connecting through
the proxy server.

ProxyPort The proxy server port through which the
BlackPearl gateway connects.

ProxyUsername The username used when connecting through
the proxy server.

Quiesced Whether the Amazon S3 target is in a
temporarily inactive state. Values: NO,
PENDING, YES

Region The world region where the Amazon S3 target
is physically located. Values: US_EAST_1, US_
EAST_2, US_WEST_1, US_WEST_2, EU_WEST_1,
EU_WEST_2, EU_CENTRAL_1, AP_SOUTH_1,
AP_SOUTHEAST_1, AP_SOUTHEAST_2, AP_
NORTHEAST_1, AP_NORTHEAST_2, SA_EAST_
1, CN_NORTH_1, GOV_CLOUD, CA_CENTRAL_1

SecretKey The secret key associated with the AccessKey.

StagedData
ExpirationInDays

The number of days before the pre-staged copy
of data can expire.

State The state of the Amazon S3 target.
Values: ONLINE, OFFLINE, LIMITED_ACCESS

Tapes The container for information about all tapes.

Tape The container for information about the tape
containing the object.

AssignedToStorageDomain Whether the tape is currently assigned to a
storage domain. Values: TRUE, FALSE
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Parameter Description
Only if
full_details
included

AvailableRaw
Capacity

The amount of unused raw capacity on the
tape in bytes.

BarCode The barcode on the label of the tape cartridge.

BucketId The UUID for the bucket to which the tape is
assigned.

DescriptionFor
Identification

The LTFS Volume ID and name, if applicable.
This is only provided if the BlackPearl gateway
cannot identify the tape.

EjectDate The date and time that the BlackPearl gateway
discovered that the tape was ejected, in the
format YYYY-MM-DDThh:mm:ss.xxxZ. If the
parameter is empty, the tape has not been
ejected.

EjectLabel The user-entered information to assist in the
handling of the tape.

EjectLocation The user-entered information to describe
where the ejected tape can be located.

EjectPending The date and time that the tape was put in the
queue to be ejected in the format YYYY-MM-
DDThh:mm:ss.xxxZ. If the parameter is
empty, the tape has not been queued to be
ejected or the eject has started and is no longer
cancelable.

FullOfData Whether the tape is completely full of data.
Values: TRUE, FALSE

Id The UUID for the tape.

LastAccessed The last date and time the tape was loaded
into a tape drive in the format YYYY-MM-
DDThh:mm:ss.xxxZ.

LastCheckpoint An identifier, internal to the BlackPearl
gateway, for verifying the application integrity
of the tape.
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Parameter Description
Only if
full_details
included

LastModified The last date and time the object was modified
in the format YYYY-MM-DDThh:mm:ss.xxxZ.

LastVerified The last date and time the checksum of the
data was verified in the format YYYY-MM-
DDThh:mm:ss.xxxZ.

PartiallyVerified
EndOfTape

The last date and time the BlackPearl gateway
verified the data on a specified percentage of
the tape capacity before the EOD marker in the
format
YYYY-MM-DDThh:mm:ss.xxxZ.

PartitionId The UUID for the partition to which the tape
belongs.

PreviousState The previous status of the tape. See State on
page 664.

Role The role assigned to the tape. Values: Normal,
Test

SerialNumber The manufacturer-assigned serial number for
the tape.

State The status of the tape. See State on page 664.

StorageDomain
MemberId

The UUID for the storage domain member.

TakeOwnership Pending Whether a tape from another BlackPearl
gateway is waiting for the current gateway to
complete taking ownership.
Values:
• TRUE — The foreign tape was imported
when WriteProtected was TRUE,
preventing the tape from being claimed by
the current BlackPearl gateway.

• FALSE — The tape was imported
successfully.

TotalRawCapacity The total raw capacity of the tape in bytes.
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Parameter Description
Only if
full_details
included

Type The tape format and generation of the tape
cartridge.
Values: LTO5, LTO6, LTO7, LTO8, LTOM8,
LTO9, LTO_CLEANING_TAPE, TS_JC, TS_JD, TS_
JE, TS_JK, TS_JL, TS_JM, TS_JV, TS_JY, TS_JZ,
TS_CLEANING_TAPE, UNKNOWN, FORBIDDEN

VerifyPending The priority for the verify requested, or null if
a verify has not been requested. The priority
determines the resources assigned and the
processing order.
Values: CRITICAL, URGENT, HIGH, NORMAL,
LOW, BACKGROUND

WriteProtected Whether the tape is write protected. Values:
TRUE, FALSE

Example

Sample Request
This request returns a list of which objects specified in the payload are on which media.
GET http://blackpearl-hostname/_rest_/bucket/bucket1/?operation=get_physical_

placement&full_details HTTP/1.1
<Objects>

      <Object Name="object1"/>

</Objects>
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Sample Response
HTTP/1.1 200 OK

<Data>

   <Object Id="72886aed-6865-4173-b87f-a60e1f82966e"

      InCache=”FALSE” Latest="TRUE" Length="10" Name="o4"

      Offset="0" VersionId="7ee8bd7a-b883-4100-ad2b-13440a44f200">

      <PhysicalPlacement>

         <AzureTargets/>

         <Ds3Targets/>

         <Pools>

            <Pool>

               <AssignedToStorageDomain>

                  false

               </AssignedToStorageDomain>

               <AvailableCapacity>10000</AvailableCapacity>

               <BucketId/>

               <Guid>d276b9a9-02e4-4528-972d-8e621719510c</Guid>

               <Health>OK</Health>

               <Id>8b5a44e5-cfe8-4021-a745-bc70832cd6b5</Id>

               <LastAccessed/>

               <LastModified/>

               <LastVerified/>

               <Mountpoint>/mountpoint-0</Mountpoint>

               <Name>p1</Name>

               <PartitionId/>

               <PoweredOn>true</PoweredOn>

               <Quiesced>NO</Quiesced>

               <ReservedCapacity>0</ReservedCapacity>

               <State>NORMAL</State>

               <StorageDomainMemberId>

                  db43b9ee-f2a5-4e8d-8620-f7aa14508bba

               </StorageDomainMemberId>

               <TotalCapacity>0</TotalCapacity>

               <Type>NEARLINE</Type>

               <UsedCapacity>20000</UsedCapacity>

            </Pool>

         </Pools>

         <S3Targets/>

         <Tapes/>

      </PhysicalPlacement>

   </Object>

</Data>
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This chapter provides detailed information for operations performed on jobs and job chunks.
These operations set up bulk PUT, GET, and VERIFY operations.
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Stage Objects 250

Truncate Active Job 256

Truncate Active Jobs 257

Truncate Job 258

Truncate Jobs 259

Verify That It Is Safe to Create a PUT Job 260

DS3 BULK OPERATIONS OVERVIEW

To more efficiently work with deep storage and accommodate very large object sizes on a
single storage device, DS3 provides an alternative method of doing object GET and PUT
operations as well as VERIFY operations. This section describes how the bulk transfer
strategy works.

Processing a Bulk GET Job
The first step in creating a bulk GET job is to issue a Create Bulk GET request (see page 165).
The Create Bulk GET request specifies the bucket name and a list of object names.

When the objects were written to deep storage, the BlackPearl gateway organized them for
efficient transfer both when writing them and when reading them back later. The Create Bulk
GET response provides a job ID and a list of chunks, where each chunk has a list of objects or
object parts. For each object part, the response provides the object name, offset, and length.

The client should then issue a Get Job Chunks Ready for Processing request (see page 222)
using the job ID. The response is in the same format as the Create Bulk GET response, but it
only lists chunks that are ready for the client to retrieve. If the list is empty, then the
BlackPearl gateway provides an HTTP Retry-After header with the number of seconds the
client should wait before issuing the request again.

Finally, the client should GET all of the object parts in the available chunks and repeat this
process until all chunks are transferred. The client can use any level of concurrency when
transferring object parts within a chunk.

The GET object operation used in the DS3 API is an extended version of the Amazon S3 GET
object operation. While the Amazon S3 version of the GET object request transfers a single
object or a number of object parts of a single object, the DS3 API version transfers up to
500,000 objects or object parts, allowing the BlackPearl gateway to efficiently organize each
individual object or object part transfer into job chunks.
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The client may need to issue multiple GET requests for a single object if it has been broken
up into multiple pieces due to its large size. For example, in the Create Bulk GET request
Sample Response on page 171, the BlackPearl gateway split the object “test.aaf” into one 100
GB part and one 50 GB part. If you want to retrieve test.aaf, you must GET the first 100 GB,
specifying the job ID and an offset of 0, followed by getting the remaining 50 GB, specifying
the job ID and an offset of 107374182400 (since 100 GB = 100*(2^30)).

Processing a Bulk PUT Job
The steps for processing a bulk PUT job are similar to the steps for a bulk GET job. The first
step in creating a bulk PUT job is to issue a Create Bulk PUT request (see page 172). The
Create Bulk PUT request specifies the bucket name and a list of object names and sizes.

The BlackPearl gateway then breaks up the objects and organizes them for efficient transfer.
The Create Bulk PUT response provides a job ID and a list of chunks, where each chunk has
a list of objects or object parts. For each object part, the response provides the object name,
offset, and length.

The PUT object operation used in the DS3 API is an extended version of the Amazon S3 PUT
object operation. While the Amazon S3 version of the PUT object request transfers entire
objects, the DS3 API version transfers parts of an object as defined by a byte offset and a byte
length. The client may need to specify multiple PUT operations per object.

For example, if you want to PUT an object that is 150 GB, the BlackPearl gateway splits that
object into one 100 GB part (the largest object part length for a bulk PUT) and one 50 GB part.
You must PUT the first 100 GB, specifying the job ID and an offset of 0, followed by putting
the remaining 50 GB, specifying the job ID and an offset of 107374182400 (since 100 GB = 100*
(2^30)). The offset to use is specified in the response to the Create Bulk PUT. The length of
the object part you are transferring is specified by the Content-Length HTTP request header
in the PUT object request.

For each job chunk, the client should issue a Get Job Chunks Ready for Processing request
(see page 222) using the job ID. This will allocate a working window of job chunks, if
possible, and return a list of the job chunks that the client can upload. The client should PUT
all of the object parts from the list of job chunks returned and repeat this process until all
chunks are transferred. Chunks must be sent by the client in order; however, objects within a
given chunk may be sent in any order.

The following is a conceptual code example:
while ( true ) {
   ready_chunks, http_return_code =

      GetJobChunksReadyForClientProcessing
if ( 410 == http_return_code) {
   // we're done
   break;
}
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for ( object piece in ready_chunks ) {
   put_object(object,offset,length)
}
}

If the Get Job Chunks Ready for Processing request (see page 222) returns an empty list, then
the server's cache is currently saturated and the client must wait before sending more data.
The client should wait the number of seconds specified in the Retry-After HTTP response
header.

Processing a Bulk VERIFY Job
To process a bulk VERIFY job, issue a Create VERIFY Job request (see page 180). The Create
VERIFY Job request specifies the bucket name and a list of object names. The job reads the
data for each object from the permanent data store and verifies that the CRC of the data read
matches the expected CRC. No additional requests are required.

ALLOCATE JOB CHUNK

Description
Allocate a specific job chunk that is part of a PUT job before beginning the PUT operation.
This avoids the HTTP 307 retries on the object PUTs and increases performance.

Notes:

• For most purposes, it is better to use Get Job Chunks Ready for Processing on
page 222 instead of this request.

• Aggregating PUT jobs (see aggregating on page 173) are always entirely pre-
allocated. Submitting this request will return a 404 error.

Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/job_chunk/{job chunk id}/?operation=ALLOCATE

To Determine the UUID for the job chunk, see Create Bulk PUT on page 172.
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Request Parameters

Parameter Description Required

operation The operation to perform. For this request, the operation is allocate.
Value: ALLOCATE

yes

Responses

Response Elements
<Objects

   ChunkId="{string}"

   ChunkNumber="{32-bit integer}"

   NodeId="{string}">

   <Object

      Id="{string}"

      InCache="TRUE|FALSE"

      Length="{64-bit integer}"

      Name="{string}"

      Offset="{64-bit integer}"

      VersionId="{string}"/>

   ...

</Objects>

where the response elements are defined as follows:

Parameter Description

Objects The container for the response.

ChunkID The UUID for the job chunk.

ChunkNumber The position of the chunk within the job.

NodeId The UUID for the node.

Object The container for object information.

Id The UUID for the object.

InCache Indicates if the object is currently in cache on the BlackPearl gateway. Values:
TRUE, FALSE

Length The length in bytes of the object or part of the object.
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Parameter Description

Name The name of the object.

Offset The offset in bytes from the start of the object.

VersionId The UUID of the version of the object.

Example

Sample Request
This request allocates the job chunks for the job with the UUID 38ada8a6-0116-42ac-9b58-
a95cc89ddec9.
PUT http://blackpearl-hostname/_rest_/job_chunk/38ada8a6-0116-42ac-9b58-

a95cc89ddec9/?operation=ALLOCATE

Sample Response
HTTP/1.1 200 OK

<Objects ChunkId="5721e057-036e-4eda-8b9e-f842cc667352"

   ChunkNumber="1"

   NodeId="86aa6d66-2438-49cd-9dba-0b17c109daab">

   <Object

      Id="Cabernet-9e86-474a-8c83-e2b425b8ad1d" InCache="FALSE"

      Length="1024" Name="test" Offset="0"

      VersionId="536d118c-d58c-4a6e-9fb5-5bd299b76808"/>

</Objects>

CANCEL ACTIVE JOB

Description
Cancel a job that is in progress. Any objects in the job that were written in their entirety to
physical data stores are retained. Any objects in the job that were received in their entirety in
cache are retained unless the force flag is used. Additionally, if the force flag is used, any
objects in the job that were partially written to physical data stores (regardless of whether or
not they are completely written to cache) are deleted and any space the object pieces
consumed on physical data stores are marked as eligible for reclamation. The BlackPearl
gateway does not expect any more objects from the job.

Note: This command is an alias for Cancel Job on page 155.
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Requests

Syntax
DELETE http[s]://{datapathDNSname}/_rest_/active_job/{job_id}/?force

To determine the UUID for a job, see Get Active Jobs on page 190.

Request Parameters

Parameter Description Required

force Any objects in the job that were partially written to physical data
stores are deleted and any space the object pieces consumed on
physical data stores are marked as eligible for reclamation.
Additionally, objects received in cache are also deleted.
Note: Objects written entirely to the physical data stores are not
deleted. If you need to ensure that all objects from a job are deleted
from the BlackPearl gateway after canceling the job, issue a delete
object command for each of the objects.

yes

Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 403: Forbidden (user does not have permission to cancel the job)
• 404: Not Found

Example

Sample Request
This request cancels the job with the UUID e140e1a3-4938-4615-b08d-6dd7a7e79e4f.
DELETE http://blackpearl-hostname/_rest_/active_job/e140e1a3-4938-4615-b08d-

6dd7a7e79e4f/?force HTTP/1.1

Sample Response
HTTP/1.1 204 No Content
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CANCEL ACTIVE JOBS

Description
Cancel all jobs that are in progress. Any objects in the jobs that were written in their entirety
to physical data stores are retained. Any objects in the jobs that were received in their entirety
in cache are retained unless the force flag is used. Additionally, if the force flag is used, any
objects in the jobs that were partially written to physical data stores (regardless of whether or
not they are completely written to cache) are deleted and any space the object pieces
consumed on physical data stores are marked as eligible for reclamation. The BlackPearl
gateway does not expect any more objects from the jobs. Use parameters to cancel a subset of
the jobs.

Note: This command is an alias for Cancel Jobs on page 157.

Requests

Syntax
DELETE http[s]://{datapathDNSname}/_rest_/active_job/?force[&bucket_id={string}]

[&request_type=PUT|GET|VERIFY]

Request Parameters

Parameter Description Required

force Any objects in the jobs that were partially written to physical data
stores are deleted and any space the object pieces consumed on
physical data stores are marked as eligible for reclamation.
Additionally, objects received in cache are also deleted.
Note: Objects written entirely to the physical data stores are not
deleted. If you need to ensure that all objects from a job are deleted
from the gateway after canceling the job, issue a delete object
command for each of the objects.

yes

bucket_id 1 The UUID, name, or other unique identifier for the bucket on which
the job is operating.

no

request_type Type of job request. Values: GET, PUT, VERIFY no

1) Parameter values can use wild cards (see Wild Card Syntax on page 30).

April 2023 DS3 API Reference-Spectra BlackPearl Nearline Gateway
- 154 -



Chapter 7 - Job Operations Cancel Job

Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 403: Forbidden (user does not have permission to cancel the jobs)

Example

Sample Request
This request cancels all jobs in progress.
DELETE http://blackpearl-hostname/_rest_/job/?force HTTP/1.1

Sample Response
HTTP/1.1 204 No Content

CANCEL JOB

Description
Cancel a job that is in progress. Any objects in the job that were written in their entirety to
physical data stores are retained. Any objects in the job that were received in their entirety in
cache are retained unless the force flag is used. Additionally, if the force flag is used, any
objects in the job that were partially written to physical data stores (regardless of whether or
not they are completely written to cache) are deleted and any space the object pieces
consumed on physical data stores are marked as eligible for reclamation. The BlackPearl
gateway does not expect any more objects from the job.

Note: This command is an alias for Cancel Active Job on page 152.
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Requests

Syntax
DELETE http[s]://{datapathDNSname}/_rest_/job/{job_id}/?force

To determine the UUID for a job, see Get Jobs on page 229.

Request Parameters

Parameter Description Required

force Any objects in the job that were partially written to physical data
stores are deleted and any space the object pieces consumed on
physical data stores are marked as eligible for reclamation.
Additionally, objects received in cache are also deleted.
Note: Objects written entirely to the physical data stores are not
deleted. If you need to ensure that all objects from a job are deleted
from the gateway after canceling the job, issue a delete object
command for each of the objects.

yes

Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 403: Forbidden (user does not have permission to cancel the job)
• 404: Not Found

Example

Sample Request
This request cancels the job with the UUID 38ada8a6-0116-42ac-9b58-a95cc89ddec9.
DELETE http://blackpearl-hostname/_rest_/job/38ada8a6-0116-42ac-9b58-

a95cc89ddec9/?force HTTP/1.1

Sample Response
HTTP/1.1 204 No Content
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CANCEL JOBS

Description
Cancel all jobs that are in progress. Any objects in the jobs that were written in their entirety
to physical data stores are retained. Any objects in the jobs that were received in their entirety
in cache are retained unless the force flag is used. Additionally, if the force flag is used, any
objects in the jobs that were partially written to physical data stores (regardless of whether or
not they are completely written to cache) are deleted and any space the object pieces
consumed on physical data stores are marked as eligible for reclamation. The BlackPearl
gateway does not expect any more objects from the jobs. Use parameters to cancel a subset of
the jobs.

Note: This command is an alias for Cancel Active Jobs on page 154.

Requests

Syntax
DELETE http[s]://{datapathDNSname}/_rest_/job/?force[&bucket_id={string}][&request_

type=PUT|GET|VERIFY]

Request Parameters

Parameter Description Required

force Any objects in the jobs that were partially written to physical data
stores are deleted and any space the object pieces consumed on
physical data stores are marked as eligible for reclamation.
Additionally, objects received in cache are also deleted.
Note: Objects written entirely to the physical data stores are not
deleted. If you need to ensure that all objects from a job are deleted
from the gateway after canceling the job, issue a delete object
command for each of the objects.

yes

bucket_id 1 The UUID, name, or other unique identifier for the bucket on which
the job is operating.

no

request_type Type of job request. Values: GET, PUT, VERIFY no

1) Parameter values can use wild cards (see Wild Card Syntax on page 30).
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Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 403: Forbidden (user does not have permission to cancel the jobs)

Example

Sample Request
This request cancels all jobs in progress.
DELETE http://blackpearl-hostname/_rest_/job/?force HTTP/1.1

Sample Response
HTTP/1.1 204 No Content

CLEAR CANCELED JOBS

Description
Clears the canceled job history. Jobs are automatically cleared from the history after 30 days.

Requests

Syntax
DELETE http[s]://{datapathDNSname}/_rest_/canceled_job/
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Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 404: Not Found

Example

Sample Request
This request clears the canceled jobs history.
DELETE http://blackpearl-hostname/_rest_/canceled_job/ HTTP/1.1

Sample Response
HTTP/1.1 204 No Content

CLEAR COMPLETED JOBS

Description
Clears the completed jobs history. Jobs are automatically cleared from the history after 30
days.

Requests

Syntax
DELETE http[s]://{datapathDNSname}/_rest_/completed_job/
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Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 404: Not Found

Example

Sample Request
This request clears the completed jobs history.
DELETE http://blackpearl-hostname/_rest_/completed_job/ HTTP/1.1

Sample Response
HTTP/1.1 204 No Content

CLOSE AGGREGATING JOB REQUEST

Description
Closes an existing aggregating job so that no additional PUTs or GETs are appended to it. See
aggregating on page 165 for more information about aggregating jobs.

Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/job/{job UUID or other unique

identifier}/?CLOSE_AGGREGATING_JOB

To determine the UUID for a job, see Get Jobs on page 229.
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Request Parameters

Parameter Description Required

close_aggregating_job Included to indicate a close aggregating job operation. yes

Responses

Response Elements
<MasterObjectList

   Aggregating="TRUE|FALSE"

   BucketName="{string}"

   CachedSizeInBytes="{64-bit integer}"

   ChunkClientProcessingOrderGuarantee="IN_ORDER|NONE"

   CompletedSizeInBytes="{64-bit integer}"

   EntirelyInCache="TRUE|FALSE"

   JobId="{string}"

   Naked="TRUE|FALSE"

   Name="{string}"

   OriginalSizeInBytes="{64-bit integer}"

   Priority="CRITICAL|URGENT|HIGH|NORMAL|LOW|BACKGROUND"

   RequestType="GET"
   StartDate="YYYY-MM-DDThh:mm:ss.xxxZ"

   Status="IN_PROGRESS|COMPLETED|CANCELED"

   UserId="{string}"
   UserName="{string}">

   <Nodes>

      <Node EndPoint="{string}" Id="{string}"/>

   </Nodes>

   <Objects

      ChunkId="{string}"

      ChunkNumber="{32-bit integer}">

      <Object Id="{string}" InCache="TRUE|FALSE"

         Latest="TRUE|FALSE" Length="{64-bit integer}"

         Name="{string} "Offset="{64-bit integer}"

         VersionId="{string}"/>

      ...

   </Objects>

   ...

</MasterObjectList>
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where the response elements are defined as follows:

Parameter Description

MasterObjectList The container for the response.

Aggregating Whether the job can have additional PUTs or GETs appended to it. Jobs
aggregate if created with the aggregating request parameter set to
TRUE, or if created by the BlackPearl gateway in response to Amazon S3
PUT and GET requests. Values: TRUE, FALSE

BucketName The name of the bucket that is acted on by the job request.

CachedSizeInBytes The amount of data that has been transferred to the cache for this job. For
RequestType=GET, this is the amount of data either in cache originally,
or loaded into cache from the permanent data store.

ChunkClient
ProcessingOrder
Guarantee

Specifies whether the job chunks will be processed in order. Values: IN_
ORDER, NONE

CompletedSizeIn
Bytes

The amount of data that is completely processed for this job. For
RequestType=GET, this indicates the amount of data that has been read
successfully by the client.

EntirelyInCache Whether all objects in the job are in the BlackPearl cache.
Values: TRUE, FALSE

JobId The UUID for the job.

Naked Whether the job was created as the result of a native S3 command (TRUE)
or a Create Bulk GET/PUT/VERIFY job command (FALSE). Values: TRUE,
FALSE

Name The name assigned to the job for tracking.

OriginalSizeInBytes The full size of the job.

Priority The priority for processing this job. The job priority determines the
assigned resources and processing order.
Values: CRITICAL, URGENT, HIGH, NORMAL, LOW, BACKGROUND

RequestType Type of job request. Values: GET

StartDate The date and time the job was started in the format YYYY-MM-
DDThh:mm:ss.xxxZ.
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Parameter Description

Status The current status of the job.
Values:
• IN_PROGRESS — The job is currently running.
• COMPLETED — The job completed.
• CANCELED — The job was canceled by the user or automatically due to
internal timeouts.

UserId The UUID for the user who initiated the job.

UserName The username of the user who initiated the job.

Nodes A container for information about all BlackPearl nodes.

Node A container for information about a single BlackPearl node.

EndPoint The IP address or DNS name of the BlackPearl node.

Id The UUID for the node.

Objects Container for information about the objects in one chunk.

ChunkId The UUID for the job chunk.

ChunkNumber The position of the chunk within the job.

Object The container for information about a single object.

Id The UUID for the object.

InCache Indicates if the object is currently in cache on the BlackPearl gateway.
Values: TRUE, FALSE

Latest Whether this version of the object is the latest.
Values: TRUE, FALSE

Length The length in bytes of the object.

Name The name of the object.

Offset The offset in bytes from the start of the object.

VersionId The UUID of the version of the object.
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Example

Sample Request
This request ends aggregation for the job with the UUID 78dba377-a02a-4c15-b2a1-
412514342f17.
PUT http://blackpearl-hostname/_rest_/job/78dba377-a02a-4c15-b2a1-

412514342f17/?CLOSE_AGGREGATING_JOB HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<MasterObjectList

   Aggregating="FALSE"

   BucketName="bucket1"

   CachedSizeInBytes="0"

   ChunkClientProcessingOrderGuarantee="IN_ORDER"

   CompletedSizeInBytes="0"

   EntirelyInCache="FALSE"

   JobId="78dba377-a02a-4c15-b2a1-412514342f17"

   Naked="FALSE"

   Name="GetJob"

   OriginalSizeInBytes="0"

   Priority="HIGH"

   RequestType="GET"

   StartDate="2017-06-05T17:59:08.000Z"

   Status="IN_PROGRESS"

   UserId="a6a04b3d-960a-4799-9c88-6801f5cf5449"

   UserName="user_name">

   <Nodes>

      <Node EndPoint="blackpearl-hostname"

      Id="aed40ca0-5289-49ca-9cd9-cf5a7559a1db"/>

   </Nodes>

   <Objects

      ChunkId="a909e72e-a96a-4c3e-95a3-f3472e14ae17"

      ChunkNumber="1">

      <Object Id="2ee4f397-c169-4a59-96cc-a07280412f43"

         InCache="FALSE" Latest="TRUE" Length="10"

         Name="o1" Offset="10"

         VersionId="536d118c-d58c-4a6e-9fb5-5bd299b76808"/>

   </Objects>

</MasterObjectList>
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CREATE BULK GET

Description
Create a job to stream GET object requests. See Processing a Bulk GET Job on page 148 for an
overview of the process.

IMPORTANT The BlackPearl gateway processes a maximum of 1,000 concurrent active jobs.

Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/bucket/{bucket UUID or

name}/?operation=START_BULK_GET[&aggregating=TRUE|FALSE][&chunk_client_processing_

order_guarantee=IN_ORDER|NONE][&dead_job_cleanup_allowed=TRUE|FALSE][&implicit_job_

id_resolution=TRUE|FALSE][&name={string}][&priority=URGENT|HIGH|NORMAL|LOW]

[&protected=TRUE|FALSE]

Request Parameters

Parameter Description Required

operation The operation to perform. For this request, the operation is to start
a bulk GET. Value: START_BULK_GET

yes

aggregating Whether or not to aggregate jobs. When selected, if additional
GET jobs using the same bucket and chunk_client_
processing_order_guarantee are created within 30 minutes
of the initial job creation, they are appended to the initial job to
create a larger job.
Values: TRUE, FALSE (default)
Notes:
• Do not use aggregating for jobs larger than 50 GB.
• The client must be able to handle the changing job structure to
use this feature.

• Data is not written to tape storage domains until the 30 minute
aggregation time is complete.

no

April 2023 DS3 API Reference-Spectra BlackPearl Nearline Gateway
- 165 -



Chapter 7 - Job Operations Create Bulk GET

Parameter Description Required

chunk_client_
processing_
order_
guarantee

Specifies whether the job chunks must be processed in order.
Setting a value of NONE will achieve maximum performance, but
requires the client to get chunks as they become available, even if
they become available out of order.
Values: IN_ORDER, NONE
Default: Configured in the data policy for the bucket.

no

dead_job_
cleanup_
allowed

Whether or not a job can be canceled or truncated automatically
after 24 hours of inactivity. Values: TRUE (default), FALSE.

no

implicit_job_
id_
resolution

Whether GET requests that are part of this job determine the job
ID implicitly (TRUE), or must specify the job ID (FALSE).
Implicitly resolving a GET to a job is not always reliable. For
example, if two clients GET the same object using two different
jobs, implicit resolution may result in the wrong job marking the
GET complete. Clients that are aware of the job ID are strongly
encouraged to explicitly provide the job ID and leave implicit_
job_id_resolution=FALSE.
Values: TRUE, FALSE (default)

no

name A name to assign to the job for tracking. no

priority The priority for processing this job. The job priority determines
the assigned resources and processing order. Jobs with Priority
URGENT can use up all of the resources and prevent other jobs
from making progress. Use this priority sparingly.
Values: URGENT, HIGH, NORMAL, LOW
Default: Configured in the data policy for the bucket.

no

protected The protection setting for the job. Protected jobs cannot be
canceled. Values: TRUE, FALSE (default).

no

Request Elements
An XML payload, formatted as follows, must be sent to describe the GET job to create:
<Objects

   <Object Name="{string}" Length="{64-bit integer}"

      Offset="{64-bit integer}" Version_Id="{string}"/>

   ...

</Objects>
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where the parameters are defined as follows:

Parameter Description Required

Objects A container for the list of objects. yes

Object The container for information about one object. yes

Name The name of an object to GET. All objects in the list must be in the
same bucket.

yes

Length The length in bytes to get. no

Offset The offset in bytes from the start of the object to start the get. no

Version_Id The UUID for the version of the object. no

Responses

Response Elements
<MasterObjectList

   Aggregating="TRUE|FALSE"

   BucketName="{string}"

   CachedSizeInBytes="{64-bit integer}"

   ChunkClientProcessingOrderGuarantee="IN_ORDER|NONE"

   CompletedSizeInBytes="{64-bit integer}"
   DeadJobCleanupAllowed="TRUE|FALSE"

   EntirelyInCache="TRUE|FALSE"
   JobId="{string}"

   Naked="TRUE|FALSE"

   Name="{string}"

   OriginalSizeInBytes="{64-bit integer}"

   Priority="CRITICAL|URGENT|HIGH|NORMAL|LOW|BACKGROUND"
   Protected="TRUE|FALSE"

   RequestType="GET"
   StartDate="YYYY-MM-DDThh:mm:ss.xxxZ"

   Status="IN_PROGRESS|COMPLETED|CANCELED"

   UserId="{string}"

   UserName="{string}">
   <Nodes>

      <Node EndPoint="{string}" Id="{string}"/>

   </Nodes>
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   <Objects

      ChunkId="{string}"

      ChunkNumber="{32-bit integer}">

      <Object Id="{string}" InCache="TRUE|FALSE"

         Latest="TRUE|FALSE" Length="{64-bit integer}"

         Name="{string} "Offset="{64-bit integer}"

         VersionId="{string}"/>

      ...

   </Objects>

   ...

</MasterObjectList>

where the response elements are defined as follows:

Parameter Description

MasterObjectList The container for the response.

Aggregating Whether the job can have additional PUTs or GETs appended to it.
Jobs aggregate if created with the aggregating request parameter
set to TRUE, or if created by the BlackPearl gateway in response to
Amazon S3 PUT and GET requests. Values: TRUE, FALSE

BucketName The name of the bucket that is acted on by the job request.

CachedSizeInBytes The amount of data that has been transferred to the cache for this
job. For RequestType=GET, this is the amount of data either in
cache originally, or loaded into cache from the permanent data
store.

ChunkClient
ProcessingOrder Guarantee

Specifies whether the job chunks will be processed in order. Values:
IN_ORDER, NONE

CompletedSizeIn
Bytes

The amount of data that is completely processed for this job. For
RequestType=GET, this indicates the amount of data that has been
read successfully by the client.

DeadJobCleanupAllowed

EntirelyInCache 1 Whether all objects in the job are in the BlackPearl cache.
Values: TRUE, FALSE

JobId The UUID for the job.

1) Not always included for GET jobs.
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Parameter Description

Naked Whether the job was created as the result of a native S3 command
(TRUE) or a Create Bulk GET/PUT/VERIFY job command (FALSE).
Values: TRUE, FALSE

Name The name assigned to the job for tracking.

OriginalSizeInBytes The full size of the job.

Priority The priority for processing this job. The job priority determines the
assigned resources and processing order.
Values: CRITICAL, URGENT, HIGH, NORMAL, LOW, BACKGROUND

Protected The protection setting for the job. Protected jobs cannot be canceled.
Values: TRUE, FALSE (default).

RequestType Type of job request. Values: GET

StartDate The date and time the job was started in the format YYYY-MM-
DDThh:mm:ss.xxxZ.

Status The current status of the job.
Values:
• IN_PROGRESS — The job is currently running.
• COMPLETED — The job completed.
• CANCELED — The job was canceled by the user or automatically
due to internal timeouts.

UserId The UUID for the user who initiated the job.

UserName The username of the user who initiated the job.

Nodes A container for information about all BlackPearl nodes.

Node A container for information about a single BlackPearl node.

EndPoint The IP address or DNS name of the BlackPearl node.

Id The UUID for the node.

Objects Container for information about the objects in one chunk.

ChunkId The UUID for the job chunk.

ChunkNumber The position of the chunk within the job.

Object The container for information about a single object.
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Parameter Description

Id The UUID for the object.

InCache Indicates if the object is currently in cache on the BlackPearl
gateway. Values: TRUE, FALSE

Latest Whether this version of the object is the latest.
Values: TRUE, FALSE

Length The length in bytes of the object.

Name The name of the object.

Offset The offset in bytes from the start of the object.

VersionId The UUID for the version of the object.

Error Response
If one or more objects requested only exist on tapes outside of the library, then the following
response is provided:
<Error>

   <Code>CONFLICT</Code>

   <HttpErrorCode>409</HttpErrorCode>

   <Message>

     RPC DataPlanner.createGetJob&lt;60821823&gt; FAILED:

     Some of the data requested is offline (e.g. ejected, offline,

     or quiesced) and must first be brought online. Online:

[TEST079L7]

   </Message>

   <Resource>/_rest_/bucket/eject</Resource>

   <ResourceId>40727470</ResourceId>

</Error>

Import and online the tape with the requested barcode. In the example above, the required
tape is TEST079L7.

Example

Sample Request
This request creates a GET job for two objects in the bucket “bucket1”.
PUT http://blackpearl-hostname/_rest_/bucket/bucket1/?operation=start_bulk_

get&name="GetJob" HTTP/1.1
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<Objects

   <Object Name="o1" Length="10" Offset="10" Version_Id="1"/>

   ...

</Objects>

Sample Response
HTTP/1.1 200 OK

<MasterObjectList

   Aggregating="FALSE"

   BucketName="bucket1"

   CachedSizeInBytes="0"

   ChunkClientProcessingOrderGuarantee="IN_ORDER"

   CompletedSizeInBytes="0"
   DeadJobCleanupAllowed="FALSE"

   EntirelyInCache="FALSE"

   JobId="78dba377-a02a-4c15-b2a1-412514342f17"
   Naked="FALSE"

   Name="GetJob"

   OriginalSizeInBytes="0"

   Priority="HIGH"
   Protected="TRUE"

   RequestType="GET"

   StartDate="2015-10-07T22:33:17.000Z"
   Status="IN_PROGRESS"

   UserId="a6a04b3d-960a-4799-9c88-6801f5cf5449"

   UserName="user_name">
   <Nodes>

      <Node EndPoint="blackpearl-hostname"

      Id="aed40ca0-5289-49ca-9cd9-cf5a7559a1db"/>

   </Nodes>
   <Objects

      ChunkId="a909e72e-a96a-4c3e-95a3-f3472e14ae17"

      ChunkNumber="1">

      <Object Id="2ee4f397-c169-4a59-96cc-a07280412f43"

         InCache="FALSE" Latest="TRUE" Length="10"

         Name="o1" Offset="10"

         VersionId="536d118c-d58c-4a6e-9fb5-5bd299b76808"/>

   </Objects>

</MasterObjectList>
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CREATE BULK PUT

Description
Create a job to stream PUT object requests. Clients should use this before putting objects to
physical data stores. See Processing a Bulk PUT Job on page 149 for an overview of the
process.

When this request is issued, an idle timer starts and the reservation expires after 24 hours
elapse. The timer is reset by performing an IO operation (such as a `PUT Object` operation) or
by issuing a Modify Job request (see Modify Job on page 239), even if you do not modify
anything.

IMPORTANT The BlackPearl gateway processes a maximum of 1,000 concurrent active jobs.

Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/bucket/{bucket UUID or

name}/?operation=START_BULK_PUT[&aggregating=TRUE|FALSE][&dead_job_cleanup_

allowed=TRUE|FALSE][&force][&ignore_naming_conflicts][&implicit_job_id_

resolution=TRUE|FALSE][&max_upload_size={64-bit integer}][&minimize_spanning_across_

media=TRUE|FALSE][&name={string}][&pre_allocate_job_space]

[&priority=URGENT|HIGH|NORMAL|LOW][&protected=TRUE|FALSE][&verify_after_

write=TRUE|FALSE]

Request Parameters

Parameter Description Required

operation The operation to perform. For this request, the operation is to start
a bulk PUT. Value: START_BULK_PUT

yes

dead_job_
cleanup_
allowed

Whether or not a job can be canceled or truncated automatically
after 24 hours of inactivity. Values: TRUE (default), FALSE.

no
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Parameter Description Required

aggregating Whether or not to aggregate jobs. When selected, if additional
PUT jobs using the same bucket and chunk_client_
processing_order_guarantee are created within 30 minutes
of the initial job creation, they are appended to the initial job to
create a larger job.
Values: TRUE, FALSE (default)
Notes:
• Do not use aggregating for jobs larger than 50 GB.
• The client must be able to handle the changing job structure to
use this feature.

• Data is not written to tape storage domains until the 30 minute
aggregation time is complete.

no

force If included, the PUT job is created even if one or more replication
targets the BlackPearl gateway must PUT to are unavailable, or if
there are global issues that would likely prevent the completion of
the job.
Note: Using this parameter is discouraged, and using it for jobs on
both source and target BlackPearl gateways at the same time is
extremely discouraged. Running jobs on both gateways when they
are not able to communicate with each other can create replication
conflicts that must be manually resolved.
Values: TRUE, FALSE (default)

no

ignore_
naming_
conflicts

If included, any objects included in the PUT job, that already exist
in the bucket, are ignored if the lengths are the same.
CAUTION The content of the object is not checked, only the object
length. The original object is overwritten. Do not use this parameter
unless you are sure that in your data set, a matching object length
indicates a matching object.

no

implicit_job_
id_
resolution

Whether PUT requests that are part of this job determine the job
ID implicitly (TRUE), or must specify the job ID (FALSE).
Implicitly resolving a PUT to a job is not always reliable. For
example, if two clients PUT the same object using two different
jobs, implicit resolution may result in the wrong job marking the
PUT complete. Clients that are aware of the job ID are strongly
encouraged to explicitly provide the job ID and leave implicit_
job_id_resolution=FALSE.
Values: TRUE, FALSE (default)

no
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Parameter Description Required

max_upload_
size

The maximum size for any object part transferred. The default is
64GB. The maximum is 1TB. Only specify a smaller max_upload_
size if the network connection cannot reliably handle large
uploads.

no

minimize_
spanning_
across_media

Whether to minimize spanning across tape media. Minimizing
spanning across media is useful when you plan to eject tapes and
it is likely that you will retrieve all objects from the PUT job in a
single GET job. With this setting, you may only need to import
one ejected tape, rather than many tapes, when servicing a GET
job.
Notes:
• This setting only applies to tape partitions.
• For jobs less than or equal to 1 TB in size, there is an absolute
guarantee that the data from the job will never span across
multiple tapes. For larger jobs, spanning is minimized, but not
completely prevented. You can further reduce the probability of
spanning across media by using the CAPACITY write
optimization for the storage domains.

• Minimizing spanning across media may reduce capacity
utilization and performance.

Values: TRUE, FALSE (default)

no

name A name to assign to the job for tracking. no

pre_allocate_
job_
space

If included, the space for processing the job is pre-allocated. If
there is not enough space available, job creation fails.

no

priority The priority for processing this job. The job priority determines
the assigned resources and processing order. Jobs with Priority
URGENT can use up all of the resources and prevent other jobs
from making progress. Use this priority sparingly.
Values: URGENT, HIGH, NORMAL, LOW
Default: Configured in the data policy for the bucket.

no

protected The protection setting for the job. Protected jobs cannot be
canceled. Values: TRUE, FALSE (default).

no

verify_after_
write

Whether data for this job is verified after it is written. This
parameter overrides the default_verify_after_writes setting in the
data policy. Values: TRUE, FALSE (default)

no
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Request Elements
An XML payload must be sent to describe the PUT job to create, formatted as follows:
<Objects

   WriteOptimization="CAPACITY|PERFORMANCE">

   <Object Name="{string}" Size="{64-bit integer}"/>

   <Object Name="{string}" Size="{64-bit integer}"/>

</Objects>

where the parameters are defined as follows:

Parameter Description Required

Objects A container for the list of objects. yes

WriteOptimization Specifies whether job chunks are written as quickly as
possible or across as few pieces of media as possible. When
CAPACITY mode is used for writing to tape, job chunks are
written concurrently to multiple tapes using multiple drives
if the tapes being written to are already assigned to the
bucket, or there is so much data to write that the gateway
knows multiple tapes are needed to write all of the data.
When in PERFORMANCE mode, job chunks are written as
quickly as possible, even if that means that more tapes are
allocated to the bucket than are necessary to write the data.
It is better to use CAPACITY mode if the tapes will be ejected
after the job completes or if the bucket is written to very
rarely and capacity in the library is of concern.
PERFORMANCE mode is recommended in all other cases.
Pools should generally have a CAPACITY write optimization
since pools are very fast and under less contention. It is rare
for a pool storage domain to benefit from a PERFORMANCE
write optimization.
Values: CAPACITY, PERFORMANCE
Default: Configured in the data policy for the bucket.

no

Object The container for information about one object. yes

Name The name of an object to PUT. All objects in the list must be
PUT in the same bucket.
Note: Object_names must follow the Amazon S3 naming
restrictions. See Object Key and Metadata for more
information.

yes

Size The size of the object in bytes. yes
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Responses

Response Elements
<MasterObjectList

   Aggregating="TRUE|FALSE"

   BucketName="{string}"

   CachedSizeInBytes="{64-bit integer}"

   ChunkClientProcessingOrderGuarantee="IN_ORDER|NONE"

   CompletedSizeInBytes="{64-bit integer}"
   DeadJobCleanupAllowed="TRUE|FALSE"
   EntirelyInCache="TRUE|FALSE"

   JobId="{string}"

   Naked="TRUE|FALSE"

   Name="{string}"

   OriginalSizeInBytes="{64-bit integer}"

   Priority="CRITICAL|URGENT|HIGH|NORMAL|LOW|BACKGROUND"
   Protected="TRUE|FALSE"   
   RequestType="PUT"

   StartDate="YYYY-MM-DDThh:mm:ss.xxxZ"

   Status="IN_PROGRESS|COMPLETED|CANCELED"

   UserId="{string}"

   UserName="{string}">

   <Nodes>

      <Node EndPoint="{string}" Id="{string}"/>

   </Nodes>

   <Objects

      ChunkId="{string}"

      ChunkNumber="{32-bit integer}">

      <Object Id="{string}" InCache="TRUE|FALSE"

         Latest="TRUE|FALSE" Length="{64-bit integer}"

         Name="{string}" Offset="{64-bit integer}"

         VersionId="{string}"/>

      ...

   </Objects>

   ...

</MasterObjectList>

where the response elements are defined as follows:

Parameter Description

MasterObjectList The container for the response.
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Parameter Description

Aggregating Whether the job can have additional PUTs or GETs appended to it.
Jobs aggregate if created with the aggregating request parameter
set to TRUE, or if created by the BlackPearl gateway in response to
Amazon S3 PUT and GET requests. Values: TRUE, FALSE

BucketName The name of the bucket that is acted on by the job request.

CachedSizeInBytes The amount of data that has been transferred to the cache for this
job. For RequestType=PUT, this is the amount of data successfully
transferred to the BlackPearl gateway from the client.

ChunkClient
ProcessingOrder Guarantee

Specifies whether the job chunks will be processed in order. Values:
IN_ORDER, NONE

DeadJobCleanupAllowed

CompletedSizeIn
Bytes

The amount of data that is completely processed for this job. For
RequestType=PUT, this indicates the amount of data written to all
permanent data stores.

EntirelyInCache Whether all objects in the job are in the BlackPearl cache.
Values: TRUE, FALSE

JobId The UUID for the job.

Naked Whether the job was created as the result of a native S3 command
(TRUE) or a Create Bulk GET/PUT/VERIFY job command (FALSE).
Values: TRUE, FALSE

Name The name assigned to the job for tracking.

OriginalSizeInBytes The full size of the job.

Priority The priority for processing this job. The job priority determines the
assigned resources and processing order. Values: CRITICAL,
URGENT, HIGH, NORMAL, LOW, BACKGROUND

Protected The protection setting for the job. Protected jobs cannot be canceled.
Values: TRUE, FALSE (default).

RequestType Type of job request. Values: PUT

StartDate The date and time the job was started in the format YYYY-MM-
DDThh:mm:ss.xxxZ.
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Parameter Description

Status The current status of the job.
Values:
• IN_PROGRESS — The job is currently running.
• COMPLETED — The job completed.
• CANCELED — The job was canceled by the user or automatically
due to internal timeouts.

UserId The UUID for the user who initiated the job.

UserName The username of the user who initiated the job.

Nodes A container for information about all BlackPearl nodes.

Node A container for information about a single BlackPearl node.

EndPoint The IP address or DNS name of the BlackPearl node.

Id The UUID for the node.

Objects Container for information about the objects in one chunk.

ChunkId The UUID for the job chunk.

ChunkNumber The position of the chunk within the job.

Object The container for information about a single object.

Id The UUID for the object.

InCache Indicates if the object is currently in cache on the BlackPearl
gateway. Values: TRUE, FALSE

Latest Whether this version of the object is the latest.
Values: TRUE, FALSE

Length The length in bytes of the object.

Name The name of the object.

Offset The offset in bytes from the start of the object.

VersionId The UUID for the version of the object.
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Example

Sample Request
This request creates a job to PUT two objects into the bucket named “bucket1”.
PUT http://blackpearl-hostname/_rest_/bucket/bucket1/?operation=start_bulk_

put&name="PutJob" HTTP/1.1
<Objects

   WriteOptimization="CAPACITY">

   <Object Name="test.aaf" Length="107426611200"/>

   <Object Name="T950.tif" Length="9572972"/>

</Objects>

Sample Response
HTTP/1.1 200 OK

<MasterObjectList

   Aggregating="FALSE"

   BucketName="bucket1" CachedSizeInBytes="0"

   ChunkClientProcessingOrderGuarantee="NONE"

   CompletedSizeInBytes="0"
   EntirelyInCache="FALSE"

   JobId="823f7f21-8af4-44fd-b0f0-70c5a0ab52aa"

   Naked="FALSE"
   Name="PutJob"

   OriginalSizeInBytes="0" Priority="LOW" RequestType="PUT"

   StartDate="2015-10-07T22:33:22.000Z" Status="IN_PROGRESS"

   UserId="b332af88-0130-4e4d-bbb5-fac6f3ec1970" UserName="user1">
   <Nodes>

      <Node EndPoint="blackpearl-hostname"

      Id="a3f5c59e-6bdd-457d-9dde-0ffcf7236c7a"/>

   </Nodes>
   <Objects ChunkId="2e0353e1-96d7-42a5-a507-d60f61c28d6e"

      ChunkNumber="1">

      <Object Id="2ee4f397-c169-4a59-96cc-a07280412f43"

         InCache="FALSE" Latest="TRUE" Length="10"

         Name="o2" Offset="0"

         VersionId="536d118c-d58c-4a6e-9fb5-5bd299b76808/>

   </Objects>
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   <Objects ChunkId="e8d5e8b1-2e15-45a5-8b2d-e48a59114a40"

      ChunkNumber="2">

      <Object Id="ce6f4fef-2aa0-49fd-b9a3-1f0bf51e7274"

         InCache="FALSE" Latest="TRUE" Length="10" Name="o1"

         Offset="0"

         VersionId="42ed4ef4-23fc-4f7f-99e6-4fa8b60cf210"/>

   </Objects>

</MasterObjectList>

CREATE VERIFY JOB

Description
Create a job to verify objects. A VERIFY job reads data from the permanent data store and
verifies that the CRC of the data read matches the expected CRC. VERIFY jobs ALWAYS read
from the data store - even if the data currently resides in cache.

IMPORTANT The BlackPearl gateway processes a maximum of 1,000 concurrent active jobs.

Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/bucket/{bucket UUID or

name}/?operation=START_BULK_VERIFY[&aggregating=TRUE|FALSE][&name={string}]

[&priority=URGENT|HIGH|NORMAL|LOW]

Request Parameters

Parameter Description Required

operation The operation to perform. For this request, the operation is to start
a bulk VERIFY. Value: START_BULK_VERIFY

yes
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Parameter Description Required

aggregating Whether or not to aggregate jobs. When selected, if additional
VERIFY jobs using the same bucket and chunk_client_
processing_order_guarantee are created within 30 minutes
of the initial job creation, they are appended to the initial job to
create a larger job.
Values: TRUE, FALSE (default)
Notes:
• Do not use aggregating for jobs larger than 50 GB.
• The client must be able to handle the changing job structure to
use this feature.

• Data is not written to tape storage domains until the 30 minute
aggregation time is complete.

no

name A name to assign to the job for tracking. no

priority The priority for processing this job. The job priority determines
the assigned resources and processing order. Jobs with Priority
URGENT can use up all of the resources and prevent other jobs
from making progress. Use this priority sparingly. Verify jobs can
be interrupted every 30 minutes if a job with a higher priority is
received.
Values: URGENT, HIGH, NORMAL, LOW
Default: Configured in the data policy for the bucket.

no

Request Elements
An XML payload must be sent to describe the VERIFY job to create, formatted as follows:
<Objects

   <Object Name="{string}" Length="{64-bit integer}"

      Offset="{64-bit integer}" Version_Id="{string}"/>

</Objects>

where the parameters are defined as follows:

Parameter Description Required

Objects A container for the list of objects. yes

Object The container for information about one object. yes

Name The name of an object to verify. All objects in the list must be in the
same bucket.

yes
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Parameter Description Required

Length The length in bytes of the object. no

Offset The offset in bytes from the start of the object to start the get. no

Version_Id The UUID for the version of the object. no

Responses

Response Elements
<MasterObjectList

   Aggregating="TRUE|FALSE"

   BucketName="{string}"

   CachedSizeInBytes="{64-bit integer}"

   ChunkClientProcessingOrderGuarantee="IN_ORDER|NONE"
   CompletedSizeInBytes="{64-bit integer}"

   EntirelyInCache="TRUE|FALSE"

   JobId="{string}"

   Naked="TRUE|FALSE"

   Name="{string}"
   OriginalSizeInBytes="{64-bit integer}"

   Priority="CRITICAL|URGENT|HIGH|NORMAL|LOW|BACKGROUND"

   RequestType="VERIFY"
   StartDate="YYYY-MM-DDThh:mm:ss.xxxZ"

   Status="IN_PROGRESS|COMPLETED|CANCELED"

   UserId="{string}"

   UserName="{string}">
   <Nodes>

      <Node EndPoint="{string}" Id="{string}"/>

   </Nodes>
   <Objects

      ChunkId="{string}"

      ChunkNumber="{32-bit integer}">
      <Object Id="{string}" InCache="TRUE|FALSE"

         Latest="TRUE|FALSE" Length="{64-bit integer}"

         Name="{string}" Offset="{64-bit integer}"

         VersionId="{string}"/>

      ...

   </Objects>

   ...

</MasterObjectList>
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where the response elements are defined as follows:

Parameter Description

MasterObjectList The container for the response.

Aggregating Whether the job can have additional PUTs or GETs appended to it. Jobs
aggregate if created with the aggregating request parameter set to
TRUE, or if created by the BlackPearl gateway in response to Amazon S3
PUT and GET requests. Values: TRUE, FALSE

BucketName The name of the bucket that is acted on by the job request.

CachedSizeInBytes The amount of data that has been transferred to the cache for this job. For
RequestType=VERIFY, this is the amount of data loaded into cache from
the permanent data store.

ChunkClient
ProcessingOrder
Guarantee

Specifies whether the job chunks will be processed in order. Values: IN_
ORDER, NONE

CompletedSizeIn
Bytes

The amount of data that is completely processed for this job. For
RequestType=VERIFY, this indicates the amount of data with CRCs
verified.

EntirelyInCache Whether all objects in the job are in the BlackPearl cache.
Values: TRUE, FALSE

JobId The UUID for the job.

Naked Whether the job was created as the result of a native S3 command (TRUE)
or a Create Bulk GET/PUT/VERIFY job command (FALSE). Values: TRUE,
FALSE

Name The name assigned to the job for tracking.

OriginalSizeInBytes The full size of the job.

Priority The priority for processing this job. The job priority determines the
assigned resources and processing order. Values: CRITICAL, URGENT,
HIGH, NORMAL, LOW, BACKGROUND

RequestType Type of job request. Values: VERIFY

StartDate The date and time the job was started in the format YYYY-MM-
DDThh:mm:ss.xxxZ.
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Parameter Description

Status The current status of the job.
Values:
• IN_PROGRESS — The job is currently running.
• COMPLETED — The job completed.
• CANCELED — The job was canceled by the user or automatically due to
internal timeouts.

UserId The UUID for the user who initiated the job.

UserName The username of the user who initiated the job.

Nodes A container for information about all BlackPearl nodes.

Node A container for information about a single BlackPearl node.

EndPoint The IP address or DNS name of the BlackPearl node.

Id The UUID for the node.

Objects Container for information about the objects in one chunk.

ChunkId The UUID for the job chunk.

ChunkNumber The position of the chunk within the job.

Object The container for information about a single object.

Id The UUID for the object.

InCache Indicates if the object is currently in cache on the BlackPearl gateway.
Values: TRUE, FALSE

Latest Whether this version of the object is the latest.
Values: TRUE, FALSE

Length The length in bytes of the object.

Name The name of the object.

Offset The offset in bytes from the start of the object.

Version_Id The UUID for the version of the object.
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Example

Sample Request
This request creates a job to verify two objects in the bucket named “bucket1”.
PUT http://blackpearl-hostname/_rest_/bucket/bucket1/?operation=START_BULK_

VERIFY&name="VerifyJob" HTTP/1.1
<Objects

   WriteOptimization="CAPACITY">

   <Object Name="test.aaf" Length="107426611200"/>

   <Object Name="T950.tif" Length="9572972"/>

</Objects>

Sample Response
HTTP/1.1 200 OK

<MasterObjectList

   Aggregating="FALSE"

   BucketName="bucket1"

   CachedSizeInBytes="0"

   ChunkClientProcessingOrderGuarantee="NONE"

   CompletedSizeInBytes="0"
   EntirelyInCache="FALSE"

   JobId="28f15f6d-3a14-4f97-b81d-8c2908030e7b"

   Naked="FALSE"

   Name="VerifyJob"

   OriginalSizeInBytes="0"
   Priority="LOW"

   RequestType="VERIFY"

   StartDate="2015-10-07T22:33:22.000Z"

   Status="IN_PROGRESS"
   UserId="9f7b5821-0f66-4bd5-a0e2-d5b944b49a82"

   UserName="user_name">
   <Nodes>

      <Node EndPoint="blackpearl-hostname"

         Id="f304e3d8-b167-4fd7-bdb2-7f91afab4549"/>

   </Nodes>
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   <Objects ChunkId="4d09ce4c-8dc3-43e9-806e-25ac79a3d9b7"

      ChunkNumber="1">

      <Object Id="98e754ac-2015-4c90-bdb3-fc7414e0fde1"

         InCache="FALSE" Latest="TRUE" Length="10" Name="o1"

         Offset="10"

         VersionId="536d118c-d58c-4a6e-9fb5-5bd299b76808"/>

   </Objects>

</MasterObjectList>

GET ACTIVE JOB

Description
Get information about the specified active job.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/active_job/{job UUID or other unique

identifier}/

To determine the UUID for a job, see Get Active Jobs on page 190.

Responses

Response Elements
<Data>

   <Aggregating>TRUE|FALSE</Aggregating>

   <BucketId>{string}</BucketId>

   <CachedSizeInBytes>{64-bit integer}</CachedSizeInBytes>

   <ChunkClientProcessingOrderGuarantee>

      IN_ORDER|NONE

   </ChunkClientProcessingOrderGuarantee>
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   <CompletedSizeInBytes>{64-bit integer}</CompletedSizeInBytes>

   <CreatedAt>YYYY-MM-DDThh:mm:ss.xxxZ</CreatedAt>

   <ErrorMessage>{string}</ErrorMessage>

   <Id>{string}</Id>

   <ImplicitJobIdResolution>TRUE|FALSE</ImplicitJobIdResolution>

   <MinimizeSpanningAcrossMedia>

      TRUE|FALSE

   </MinimizeSpanningAcrossMedia>
   <Naked>TRUE|FALSE</Naked>

   <Name>{string}</Name>

   <OriginalSizeInBytes>{64-bit integer}</OriginalSizeInBytes>

   <Priority>CRITICAL|URGENT|HIGH|NORMAL|LOW|BACKGROUND</Priority>
   <Protected>TRUE|FALSE</Protected>
   <Rechunked>{YYYY-MM-DDThh:mm:ss.xxxZ}</Rechunked>

   <RequestType>GET|PUT|VERIFY</RequestType>

   <Restore>YES|NO|PERMANENT_ONLY</Restore>

   <Truncated>TRUE|FALSE</Truncated>

   <UserId>{string}</UserId>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

Aggregating Whether the job can have additional PUTs or GETs appended
to it. Jobs aggregate if created with the aggregating request
parameter set to TRUE, or if created by the BlackPearl
gateway in response to Amazon S3 PUT and GET requests.
Values: TRUE, FALSE

BucketId The UUID of the bucket that is acted on by the job request.

CachedSizeInBytes The amount of data that has been transferred to the cache for
this job. For RequestType=PUT, this is the amount of data
successfully transferred to the BlackPearl gateway from the
client. For RequestType=GET, this the amount of data either
in cache originally, or loaded into cache from the permanent
data store. For RequestType=VERIFY, this the amount of
data loaded into cache from the permanent data store.

ChunkClient ProcessingOrder
Guarantee

Specifies whether the job chunks will be processed in order.
Values: IN_ORDER, NONE
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Parameter Description

CompletedSizeIn
Bytes

The amount of data that is completely processed for this job.
For RequestType=PUT, this indicates the amount of data
written to all permanent data stores. For RequestType=GET,
this indicates the amount of data that has been read
successfully by the client. For RequestType=VERIFY, this
indicates the amount of data for which the CRC has been
verified.

CreatedAt The date and time the job was created in the format YYYY-
MM-DDThh:mm:ss.xxxZ.

ErrorMessage A description of the error.

Id The UUID for the job.

ImplicitJobId
Resolution

Whether GET or PUT requests that are part of this job
determine the job ID implicitly (TRUE), or must specify the job
ID (FALSE).
Values: TRUE, FALSE

MinimizeSpanningAcrossMedia Whether the PUT job was configured to minimize spanning
across media.
Values: TRUE, FALSE.

Naked Whether the job was created as the result of a native S3
command (TRUE) or a Create Bulk GET/PUT/VERIFY job
command (FALSE). Values: TRUE, FALSE

Name The name assigned to the job for tracking.

OriginalSizeInBytes The full size of the job.

Priority The priority for processing this job. The job priority
determines the assigned resources and processing order.
Values: CRITICAL, URGENT, HIGH, NORMAL, LOW,
BACKGROUND

protected The protection status of the job. Protected jobs cannot be
canceled. Values: TRUE, FALSE (default).

Rechunked The date and time, in the format YYYY-MM-
DDThh:mm:ss.xxxZ, when a chunk of a GET or VERIFY job
had to be rechunked to target other media due to the original
target becoming unavailable or corrupt. If this attribute is
null, then the job was not rechunked.
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Parameter Description

RequestType Type of job request. Values: GET, PUT, VERIFY

Restore Whether the job is restoring existing data such as an IOM job
(see iom_enabled on page 1045) or a Stage job (see Stage
Objects on page 250).
Values: YES, NO, PERMANENT_ONLY

Truncated Whether the job was truncated (made smaller) from its
original definition. A job is truncated when a PUT job is
canceled and objects that haven't been entirely uploaded to
cache are deleted from the job so that the job can complete
without any further transmission of data from the client. Or, a
job is truncated if, when processing a GET or VERIFY job, the
BlackPearl gateway determines that some of the blobs cannot
be retrieved (for example, all media containing a blob has
been ejected), in which case the gateway truncates the parts of
the job that it cannot GET or VERIFY. Values: TRUE, FALSE

UserId The UUID for the user who initiated the job.

Example

Sample Request
This request gets information about the active job with the UUID 874735d1-3526-4e22-ae21-
c3203b03745c.
GET http://blackpearl-hostname/_rest_/active_job/874735d1-3526-4e22-ae21-

c3203b03745c/ HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>

   <Aggregating>FALSE</Aggregating>

   <BucketId>cf8f4bf7-9bf0-4355-b6a7-94d928bf939e</BucketId>

   <CachedSizeInBytes>0</CachedSizeInBytes>

   <ChunkClientProcessingOrderGuarantee>

      IN_ORDER

   </ChunkClientProcessingOrderGuarantee>
   <CompletedSizeInBytes>0</CompletedSizeInBytes>

   <CreatedAt>2016-05-19T00:48:10.000Z</CreatedAt>

   <ErrorMessage/>

   <Id>874735d1-3526-4e22-ae21-c3203b03745c</Id>

   <ImplicitJobIdResolution>FALSE</ImplicitJobIdResolution>
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   <MinimizeSpanningAcrossMedia>

      FALSE

   </MinimizeSpanningAcrossMedia>

   <Naked>FALSE</Naked>

   <Name>Untitled</Name>

   <OriginalSizeInBytes>0</OriginalSizeInBytes>
   <Priority>URGENT</Priority>
   <Protected>FALSE</Protected>

   <Rechunked/>

   <RequestType>PUT</RequestType>

   <Restore>NO</Restore>

   <Truncated>FALSE</Truncated>

   <UserId>e53eb0fe-21bd-42d3-817c-a3810bc72af3</UserId>

</Data>

GET ACTIVE JOBS

Description
Get a list of all jobs currently active. Use parameters to return a subset of the jobs.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/active_job/[?aggregating=TRUE|FALSE][&bucket_

id={string}][&chunk_client_processing_order_guarantee=NONE|IN_ORDER][&last_page]

[&name={string}][&page_length={32-bit integer}][&page_offset={32-bit integer}]

[&page_start_marker={string}][&priority=CRITICAL|URGENT|HIGH|NORMAL|LOW|BACKGROUND]

[&rechunked={date}][&request_type=PUT|GET|VERIFY][&truncated=TRUE|FALSE][&user_id=

{string}]
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Request Parameters

Parameter Description Required

aggregating Whether the job can have additional work appended to it. Jobs
can aggregate if they are created with the aggregating request
parameter set to TRUE (Naked=FALSE) or if they are created by the
BlackPearl gateway in response to Amazon S3 PUT and GET
requests (Naked=TRUE). Values: TRUE, FALSE

no

bucket_id 1 The UUID, name, or other unique identifier for the bucket on
which the job is operating.

no

chunk_client_
processing_
order_
guarantee

Specifies whether the job chunks must be processed in order.
Setting a value of NONE will achieve maximum performance, but
requires the client to get chunks as they become available, even if
they become available out of order.
Values: IN_ORDER, NONE
Default: Configured in the data policy for the bucket.

no

last_page If included, only the last page of results is returned. no

name The name assigned to the job. no

page_length The maximum number of objects to list. The default is all items
after page_offset.

no

page_offset The starting point for the first object to list. The default is 0. no

page_start_
marker

The UUID or other unique attribute for the item just before the
first item to list.
Notes:
• Specifying both page_offset and page_start_marker
causes an error.

• If neither page_offset, nor page_start_marker are
specified, the page_offset default is used.

no

priority The priority for processing this job. The job priority determines
the assigned resources and processing order.
Values: CRITICAL, URGENT, HIGH, NORMAL, LOW, BACKGROUND

no

1) Parameter values can use wild cards (see Wild Card Syntax on page 30).
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Parameter Description Required

rechunked The date and time when a chunk of a GET or VERIFY job had to
be re-chunked to target other media due to the original target
becoming unavailable or corrupt in the format YYYY-MM-
DDThh:mm:ss.xxxZ or as the number of seconds that have
elapsed since January 1, 1970 at 00:00:00 GM.

no

request_type Type of job request. Values: GET, PUT, VERIFY no

truncated Whether the job was truncated (made smaller) from its original
definition. A job is truncated when a PUT job is canceled and
objects that haven't been entirely uploaded to cache are deleted
from the job so that the job can complete without any further
transmission of data from the client. Or, a job is truncated if, when
processing a GET or VERIFY job, the BlackPearl gateway
determines that some of the blobs cannot be retrieved (for
example, all media containing a blob has been ejected), in which
case the gateway truncates the parts of the job that it cannot GET
or VERIFY. Values: TRUE, FALSE

no

user_id The UUID, username, or other unique attribute for the user who
initiated the job.

no

Responses

Response Elements
<Data>

   <Job>

      <Aggregating>TRUE|FALSE</Aggregating>

      <BucketId>{string}</BucketId>

      <CachedSizeInBytes>{64-bit integer}</CachedSizeInBytes>

      <ChunkClientProcessingOrderGuarantee>

         IN_ORDER|NONE

      </ChunkClientProcessingOrderGuarantee>
      <CompletedSizeInBytes>

{64-bit integer}

      </CompletedSizeInBytes>

      <CreatedAt>{YYYY-MM-DDThh:mm:ss.xxxZ}</CreatedAt>

      <ErrorMessage>{string}</ErrorMessage>
      <Id>{string}</Id>

      <ImplicitJobIdResolution>

         TRUE|FALSE

      </ImplicitJobIdResolution>
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      <Naked>TRUE|FALSE</Naked>

      <Name>{string}</Name>

      <OriginalSizeInBytes>{64-bit integer}</OriginalSizeInBytes>

      <Priority>

         CRITICAL|URGENT|HIGH|NORMAL|LOW|BACKGROUND

      </Priority>
      <Rechunked>{YYYY-MM-DDThh:mm:ss.xxxZ}</Rechunked>

      <RequestType>GET|PUT|VERIFY</RequestType>

      <Restore>YES|NO|PERMANENT_ONLY</Restore>

      <Truncated>TRUE|FALSE</Truncated>

      <UserId>{string}</UserId>

   </Job>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

Job The container for information about a single job.

Aggregating Whether the job can have additional PUTs or GETs appended to it. Jobs
aggregate if created with the aggregating request parameter set to
TRUE, or if created by the BlackPearl gateway in response to Amazon S3
PUT and GET requests. Values: TRUE, FALSE

BucketId The UUID of the bucket that is acted on by the job request.

CachedSizeInBytes The amount of data that has been transferred to the cache for this job. For
RequestType=PUT, this is the amount of data successfully transferred to
the BlackPearl gateway from the client. For RequestType=GET, this the
amount of data either in cache originally, or loaded into cache from the
permanent data store. For RequestType=VERIFY, this the amount of
data loaded into cache from the permanent data store.

ChunkClient
ProcessingOrder
Guarantee

Whether the job chunks are guaranteed to be processed in order. Values:
IN_ORDER, NONE

CompletedSizeIn
Bytes

The amount of data that is completely processed for this job. For
RequestType=PUT, this indicates the amount of data written to all
permanent data stores. For RequestType=GET, this indicates the amount
of data that has been read successfully by the client. For
RequestType=VERIFY, this indicates the amount of data for which the
CRC has been verified.
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Parameter Description

CreatedAt The date and time the job was created in the format YYYY-MM-
DDThh:mm:ss.xxxZ.

ErrorMessage A description of the error.

Id The UUID for the job.

ImplicitJobId
Resolution

Whether GET or PUT requests that are part of this job determine the job
ID implicitly (TRUE), or must specify the job ID (FALSE).
Values: TRUE, FALSE

Naked Whether the job was created as the result of a native S3 command (TRUE)
or a Create Bulk GET/PUT/VERIFY job command (FALSE). Values: TRUE,
FALSE

Name The name assigned to the job for tracking.

OriginalSizeInBytes The full size of the job.

Priority The priority for processing this job. The job priority determines the
assigned resources and processing order. Values: CRITICAL, URGENT,
HIGH, NORMAL, LOW, BACKGROUND

Rechunked The date and time when a chunk of a GET or VERIFY job had to be re-
chunked to target other media due to the original target becoming
unavailable or corrupt. If this attribute is null, then the job was not
rechunked.

RequestType Type of job request. Values: GET, PUT, VERIFY

Restore Whether the job is restoring existing data such as an IOM job (see iom_
enabled on page 1045) or a Stage job (see Stage Objects on page 250).
Values: YES, NO, PERMANENT_ONLY

Truncated Whether the job was truncated (made smaller) from its original definition.
A job is truncated when a PUT job is canceled and objects that haven't
been entirely uploaded to cache are deleted from the job so that the job
can complete without any further transmission of data from the client. Or,
a job is truncated if, when processing a GET or VERIFY job, the BlackPearl
gateway determines that some of the blobs cannot be retrieved (for
example, all media containing a blob has been ejected), in which case the
gateway truncates the parts of the job that it cannot GET or VERIFY.
Values: TRUE, FALSE

UserId The UUID for the user who initiated the job.
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Example

Sample Request
This request gets a list of all currently active jobs on the Spectra BlackPearl Nearline
Gateway.
GET http://blackpearl-hostname/_rest_/active_job/ HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>

   <Job>

      <Aggregating>FALSE</Aggregating>

      <BucketId>2e41abd0-e681-4f5f-af2c-724c7b7d60f3</BucketId>

      <CachedSizeInBytes>0</CachedSizeInBytes>

      <ChunkClientProcessingOrderGuarantee>

         IN_ORDER

      </ChunkClientProcessingOrderGuarantee>
      <CompletedSizeInBytes>0</CompletedSizeInBytes>

      <CreatedAt>2015-11-24T02:00:17.000Z</CreatedAt>

      <Id>b053a7a8-8f25-454c-831a-e4d4618a0981</Id>

      <ImplicitJobIdResolution>FALSE</ImplicitJobIdResolution>

      <Naked>FALSE</Naked>

      <Name>Untitled</Name>

      <OriginalSizeInBytes>0</OriginalSizeInBytes>

      <Priority>URGENT</Priority>

      <Rechunked/>
      <RequestType>PUT</RequestType>

      <Truncated>FALSE</Truncated>

      <UserId>dc3cf8b0-ab38-4ce9-8d82-789352d71117</UserId>

   </Job>

</Data>

GET CANCELED JOB

Description
Get information about the specified canceled job.
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Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/canceled_job/{job UUID or other unique

identifier}/

To determine the UUID for a job, see Get Canceled Jobs on page 199.

Responses

Response Elements
<Data>

   <BucketId>{string}</BucketId>

   <CachedSizeInBytes>{64-bit integer}</CachedSizeInBytes>

   <CanceledDueToTimeout>TRUE|FALSE</CanceledDueToTimeout>

   <ChunkClientProcessingOrderGuarantee>

      IN_ORDER|NONE
   </ChunkClientProcessingOrderGuarantee>

   <CompletedSizeInBytes>{64-bit integer}</CompletedSizeInBytes>

   <CreatedAt>YYYY-MM-DDThh:mm:ss.xxxZ</CreatedAt>

   <DateCanceled>YYYY-MM-DDThh:mm:ss.xxxZ</DateCanceled>

   <ErrorMessage>{string}</ErrorMessage>
   <Id>{string}</Id>

   <Naked>TRUE|FALSE</Naked>

   <Name>{string}</Name>

   <OriginalSizeInBytes>{64-bit integer}</OriginalSizeInBytes>
   <Priority>CRITICAL|URGENT|HIGH|NORMAL|LOW|BACKGROUND</Priority>

   <Rechunked>{YYYY-MM-DDThh:mm:ss.xxxZ}</Rechunked>

   <RequestType>GET|PUT|VERIFY</RequestType>

   <Truncated>TRUE|FALSE</Truncated>

   <UserId>{string}</UserId>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

BucketId The UUID of the bucket that is acted on by the job request.

April 2023 DS3 API Reference-Spectra BlackPearl Nearline Gateway
- 196 -



Chapter 7 - Job Operations Get Canceled Job

Parameter Description

CachedSizeInBytes The amount of data that has been transferred to the cache for this job. For
RequestType=PUT, this is the amount of data successfully transferred to
the BlackPearl gateway from the client. For RequestType=GET, this the
amount of data either in cache originally, or loaded into cache from the
permanent data store. For RequestType=VERIFY, this the amount of
data loaded into cache from the permanent data store.

CanceledDueTo
Timeout

Whether the job was canceled due to a timeout.
Values: TRUE, FALSE

ChunkClient
ProcessingOrder
Guarantee

Whether the job chunks are guaranteed to be processed in order. Values:
IN_ORDER, NONE

CompletedSizeIn
Bytes

The amount of data that is completely processed for this job. For
RequestType=PUT, this indicates the amount of data written to all
permanent data stores. For RequestType=GET, this indicates the amount
of data that has been read successfully by the client. For
RequestType=VERIFY, this indicates the amount of data for which the
CRC has been verified.

CreatedAt The date and time the job was created in the format YYYY-MM-
DDThh:mm:ss.xxxZ.

DateCanceled The date and time the job was canceled in the format YYYY-MM-
DDThh:mm:ss.xxxZ.

ErrorMessage A description of the error.

Id The UUID for the job.

Naked Whether the job was created as the result of a native S3 command (TRUE)
or a Create Bulk GET/PUT/VERIFY job command (FALSE). Values: TRUE,
FALSE

Name The name assigned to the job for tracking.

OriginalSizeInBytes The full size of the job.

Priority The priority for processing this job. The job priority determines the
assigned resources and processing order. Values: CRITICAL, URGENT,
HIGH, NORMAL, LOW, BACKGROUND
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Parameter Description

Rechunked The date and time, in the format YYYY-MM-DDThh:mm:ss.xxxZ, when a
chunk of a GET or VERIFY job had to be re-chunked to target other media
due to the original target becoming unavailable or corrupt. If this attribute
is null, then the job was not rechunked.

RequestType Type of job request. Values: GET, PUT, VERIFY

Truncated Whether the job was truncated (made smaller) from its original definition.
A job is truncated when a PUT job is canceled and objects that haven't
been entirely uploaded to cache are deleted from the job so that the job
can complete without any further transmission of data from the client. Or,
a job is truncated if, when processing a GET or VERIFY job, the BlackPearl
gateway determines that some of the blobs cannot be retrieved (for
example, all media containing a blob has been ejected), in which case the
gateway truncates the parts of the job that it cannot GET or VERIFY.
Values: TRUE, FALSE

UserId The UUID for the user who initiated the job.

Example

Sample Request
This request gets information about the canceled job with the UUID 7a3b83f2-9d9a-459d-82c8-
8f83a8a318b8.
GET http://blackpearl-hostname/_rest_/canceled_job/7a3b83f2-9d9a-459d-82c8-

8f83a8a318b8/ HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>

   <Aggregating>FALSE</Aggregating>

   <BucketId>e8df5804-fe8a-4bbf-a419-67bc2a511582</BucketId>

   <CachedSizeInBytes>0</CachedSizeInBytes>

   <CanceledDueToTimeout>FALSE</CanceledDueToTimeout>

   <ChunkClientProcessingOrderGuarantee>

      IN_ORDER

   </ChunkClientProcessingOrderGuarantee>
   <CompletedSizeInBytes>0</CompletedSizeInBytes>

   <CreatedAt>2016-05-19T00:48:10.000Z</CreatedAt>

   <DateCanceled>2016-05-19T00:48:11.000Z</DateCanceled>

   <ErrorMessage/>
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   <Id>7a3b83f2-9d9a-459d-82c8-8f83a8a318b8</Id>
   <MinimizeSpanningAcrossMedia>

      FALSE

   </MinimizeSpanningAcrossMedia>
   <Naked>FALSE</Naked>
   <Name>Untitled</Name>
   <OriginalSizeInBytes>0</OriginalSizeInBytes>
   <Priority>URGENT</Priority>

   <Rechunked/>

   <RequestType>PUT</RequestType>

   <Truncated>FALSE</Truncated>

   <UserId>e53eb0fe-21bd-42d3-817c-a3810bc72af3</UserId>

</Data>

GET CANCELED JOBS

Description
Get a list of all canceled jobs within the last 5,000 jobs. Use parameters to return a subset of
the jobs.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/canceled_job/[?bucket_id={string}][&canceled_

due_to_timeout=TRUE|FALSE][&chunk_client_processing_order_guarantee=NONE|IN_ORDER]

[&last_page][&name={string}][&page_length={32-bit integer}][&page_offset=

{32-bit integer}][&page_start_marker={string}]

[&priority=CRITICAL|URGENT|HIGH|NORMAL|LOW|BACKGROUND][&rechunked={date}][&request_

type=PUT|GET|VERIFY][&truncated=TRUE|FALSE][&user_id={string}]
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Request Parameters

Parameter Description Required

bucket_id 1 The UUID, name, or other unique identifier for the bucket on
which the job is operating.

no

canceled_
due_to_
timeout

Whether the job was canceled due to a timeout.
Values: TRUE, FALSE

no

chunk_client_
processing_
order_
guarantee

Specifies whether the job chunks must be processed in order.
Setting a value of NONE will achieve maximum performance, but
requires the client to get chunks as they become available, even if
they become available out of order.
Values: IN_ORDER, NONE
Default: Configured in the data policy for the bucket.

no

last_page If included, only the last page of results is returned. no

name 1 The name assigned to the job. no

page_length The maximum number of objects to list. The default is all items
after page_offset.

no

page_offset The starting point for the first object to list. The default is 0. no

page_start_
marker

The UUID or other unique attribute for the item just before the
first item to list.
Notes:
• Specifying both page_offset and page_start_marker
causes an error.

• If neither page_offset, nor page_start_marker are
specified, the page_offset default is used.

no

priority The priority for processing this job. The job priority determines the
assigned resources and processing order.
Values: CRITICAL, URGENT, HIGH, NORMAL, LOW, BACKGROUND

no

rechunked The date and time when a chunk of a GET or VERIFY job had to
be re-chunked to target other media due to the original target
becoming unavailable or corrupt in the format YYYY-MM-
DDThh:mm:ss.xxxZ or as the number of seconds that have
elapsed since January 1, 1970 at 00:00:00 GM.

no

1) Parameter values can use wild cards (see Wild Card Syntax on page 30).
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Parameter Description Required

request_type Type of job request. Values: GET, PUT, VERIFY no

truncated Whether the job was truncated (made smaller) from its original
definition. A job is truncated when a PUT job is canceled and
objects that haven't been entirely uploaded to cache are deleted
from the job so that the job can complete without any further
transmission of data from the client. Or, a job is truncated if, when
processing a GET or VERIFY job, the BlackPearl gateway
determines that some of the blobs cannot be retrieved (for
example, all media containing a blob has been ejected), in which
case the gateway truncates the parts of the job that it cannot GET
or VERIFY. Values: TRUE, FALSE

no

user_id 1 The UUID, username, or other unique attribute for the user who
initiated the job.

no

Responses

Response Elements
<Data>

   <CanceledJob>

      <BucketId>{string}</BucketId>

      <CachedSizeInBytes>{64-bit integer}</CachedSizeInBytes>

       <CanceledDueToTimeout>TRUE|FALSE</CanceledDueToTimeout>

      <ChunkClientProcessingOrderGuarantee>

         IN_ORDER|NONE

      </ChunkClientProcessingOrderGuarantee>
      <CompletedSizeInBytes>

{64-bit integer}

      </CompletedSizeInBytes>

      <CreatedAt>{YYYY-MM-DDThh:mm:ss.xxxZ}</CreatedAt>

      <DateCanceled>{YYYY-MM-DDThh:mm:ss.xxxZ}</DateCanceled>

      <ErrorMessage>{string}</ErrorMessage>
      <Id>{string}</Id>

      <Naked>TRUE|FALSE</Naked>

      <Name>{string}</Name>

      <OriginalSizeInBytes>{64-bit integer}</OriginalSizeInBytes>

      <Priority>

         CRITICAL|URGENT|HIGH|NORMAL|LOW|BACKGROUND

      </Priority>
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      <Rechunked>{YYYY-MM-DDThh:mm:ss.xxxZ}</Rechunked>

      <RequestType>GET|PUT|VERIFY</RequestType>

      <Truncated>TRUE|FALSE</Truncated>

      <UserId>{string}</UserId>

   </CanceledJob>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

CanceledJob The container for information about a single job.

BucketId The UUID of the bucket that is acted on by the job request.

CachedSizeInBytes The amount of data that has been transferred to the cache for this job. For
RequestType=PUT, this is the amount of data successfully transferred to
the BlackPearl gateway from the client. For RequestType=GET, this the
amount of data either in cache originally, or loaded into cache from the
permanent data store. For RequestType=VERIFY, this the amount of
data loaded into cache from the permanent data store.

CanceledDueTo
Timeout

Whether the job was canceled due to a timeout.
Values: TRUE, FALSE

ChunkClient
ProcessingOrder
Guarantee

Specifies whether the job chunks will be processed in order. Values: IN_
ORDER, NONE

CompletedSizeIn
Bytes

The amount of data that is completely processed for this job. For
RequestType=PUT, this indicates the amount of data written to all
permanent data stores. For RequestType=GET, this indicates the amount
of data that has been read successfully by the client. For
RequestType=VERIFY, this indicates the amount of data for which the
CRC has been verified.

CreatedAt The date and time the job was created in the format YYYY-MM-
DDThh:mm:ss.xxxZ.

DateCanceled The date and time the job was canceled in the format YYYY-MM-
DDThh:mm:ss.xxxZ.

ErrorMessage A description of the error.

Id The UUID for the job.
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Parameter Description

Naked Whether the job was created as the result of a native S3 command (TRUE)
or a Create Bulk GET/PUT/VERIFY job command (FALSE). Values: TRUE,
FALSE

Name The name assigned to the job for tracking.

OriginalSizeInBytes The full size of the job.

Priority The priority for processing this job. The job priority determines the
assigned resources and processing order. Values: CRITICAL, URGENT,
HIGH, NORMAL, LOW, BACKGROUND

Rechunked The date and time when a chunk of a GET or VERIFY job had to be re-
chunked to target other media due to the original target becoming
unavailable or corrupt. If this attribute is null, then the job was not
rechunked.

RequestType Type of job request. Values: GET, PUT, VERIFY

Truncated Whether the job was truncated (made smaller) from its original definition.
A job is truncated when a PUT job is canceled and objects that haven't
been entirely uploaded to cache are deleted from the job so that the job
can complete without any further transmission of data from the client. Or,
a job is truncated if, when processing a GET or VERIFY job, the BlackPearl
gateway determines that some of the blobs cannot be retrieved (for
example, all media containing a blob has been ejected), in which case the
gateway truncates the parts of the job that it cannot GET or VERIFY.
Values: TRUE, FALSE

UserId The UUID for the user who initiated the job.

Example

Sample Request
This request GETs a list for all canceled jobs on the BlackPearl gateway.
GET http://blackpearl-hostname/_rest_/canceled_job/ HTTP/1.1
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Sample Response
HTTP/1.1 200 OK

<Data>

   <CanceledJob>

      <BucketId>e800c074-5bb4-4a5d-a404-f431ed2f1f29</BucketId>

      <CachedSizeInBytes>0</CachedSizeInBytes>

      <CanceledDueToTimeout>FALSE</CanceledDueToTimeout>

      <ChunkClientProcessingOrderGuarantee>

         IN_ORDER

      </ChunkClientProcessingOrderGuarantee>
      <CompletedSizeInBytes>0</CompletedSizeInBytes>

      <CreatedAt>2015-11-24T02:00:17.000Z</CreatedAt>
      <DateCanceled>2015-11-24T02:00:17.000Z</DateCanceled>

      <Id>13ffa24b-515d-43f8-94bd-4d928fb96c21</Id>

      <Naked>FALSE</Naked>
      <Name>Untitled</Name>
      <OriginalSizeInBytes>0</OriginalSizeInBytes>

      <Priority>URGENT</Priority>

      <Rechunked/>

      <RequestType>GET</RequestType>
      <Truncated>FALSE</Truncated>

      <UserId>fe0d943b-224d-48a2-b2d8-59bf5c738665</UserId>

   </CanceledJob>
</Data>

GET COMPLETED JOB

Description
Get information about the specified completed job.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/completed_job/{job UUID or other unique

identifier}/

To determine the UUID for a job, see Get Completed Jobs on page 208.
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Responses

Response Elements
<Data>

   <BucketId>{string}</BucketId>

   <CachedSizeInBytes>{64-bit integer}</CachedSizeInBytes>

   <ChunkClientProcessingOrderGuarantee>

      IN_ORDER|NONE

   </ChunkClientProcessingOrderGuarantee>
   <CompletedSizeInBytes>{64-bit integer}</CompletedSizeInBytes>

   <CreatedAt>YYYY-MM-DDThh:mm:ss.xxxZ</CreatedAt>

   <DateCompleted>YYYY-MM-DDThh:mm:ss.xxxZ</DateCompleted>

   <ErrorMessage>{string}</ErrorMessage>

   <Id>{string}</Id>

   <Naked>TRUE|FALSE</Naked>
   <Name>{string}</Name>

   <OriginalSizeInBytes>{64-bit integer}</OriginalSizeInBytes>

   <Priority>

      CRITICAL|URGENT|HIGH|NORMAL|LOW|BACKGROUND

   </Priority>
   <Rechunked>{YYYY-MM-DDThh:mm:ss.xxxZ}</Rechunked>

   <RequestType>GET|PUT|VERIFY</RequestType>

   <Truncated>TRUE|FALSE</Truncated>

   <UserId>{string}</UserId>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

BucketId The UUID of the bucket that is acted on by the job request.

CachedSizeInBytes The amount of data that has been transferred to the cache for this job. For
RequestType=PUT, this is the amount of data successfully transferred to
the BlackPearl gateway from the client. For RequestType=GET, this the
amount of data either in cache originally, or loaded into cache from the
permanent data store. For RequestType=VERIFY, this the amount of
data loaded into cache from the permanent data store.
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Parameter Description

ChunkClient
ProcessingOrder
Guarantee

Whether the job chunks are guaranteed to be processed in order. Values:
IN_ORDER, NONE

CompletedSizeIn
Bytes

The amount of data that is completely processed for this job. For
RequestType=PUT, this indicates the amount of data written to all
permanent data stores. For RequestType=GET, this indicates the amount
of data that has been read successfully by the client. For
RequestType=VERIFY, this indicates the amount of data for which the
CRC has been verified.

CreatedAt The date and time the job was created in the format YYYY-MM-
DDThh:mm:ss.xxxZ.

DateCompleted The date and time the job was completed in the format YYYY-MM-
DDThh:mm:ss.xxxZ.

ErrorMessage A description of the error.

Id The UUID for the job.

Naked Whether the job was created as the result of a native S3 command (TRUE)
or a Create Bulk GET/PUT/VERIFY job command (FALSE). Values: TRUE,
FALSE

Name The name assigned to the job for tracking.

OriginalSizeInBytes The full size of the job.

Priority The priority for processing this job. The job priority determines the
assigned resources and processing order. Values: CRITICAL, URGENT,
HIGH, NORMAL, LOW, BACKGROUND

Rechunked The date and time, in the format YYYY-MM-DDThh:mm:ss.xxxZ, when a
chunk of a GET or VERIFY job had to be re-chunked to target other media
due to the original target becoming unavailable or corrupt. If this attribute
is null, then the job was not rechunked.

RequestType Type of job request. Values: GET, PUT, VERIFY
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Parameter Description

Truncated Whether the job was truncated (made smaller) from its original definition.
A job is truncated when a PUT job is canceled and objects that haven't
been entirely uploaded to cache are deleted from the job so that the job
can complete without any further transmission of data from the client. Or,
a job is truncated if, when processing a GET or VERIFY job, the BlackPearl
gateway determines that some of the blobs cannot be retrieved (for
example, all media containing a blob has been ejected), in which case the
gateway truncates the parts of the job that it cannot GET or VERIFY.
Values: TRUE, FALSE

UserId The UUID for the user who initiated the job.

Example

Sample Request
This request gets information about the completed job with the UUID bfa6dda7-891a-482a-
be20-a863e7fa217d.
GET http://blackpearl-hostname/_rest_/completed_job/bfa6dda7-891a-482a-be20-

a863e7fa217d/ HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>

   <Aggregating>FALSE</Aggregating>

   <BucketId>368a7443-1c85-4c90-94f2-dc788ab80f84</BucketId>

   <CachedSizeInBytes>0</CachedSizeInBytes>

   <ChunkClientProcessingOrderGuarantee>

      IN_ORDER
   </ChunkClientProcessingOrderGuarantee>

   <CompletedSizeInBytes>0</CompletedSizeInBytes>

   <CreatedAt>2016-05-19T00:48:11.000Z</CreatedAt>

   <DateCompleted>2016-05-19T00:48:11.000Z</DateCompleted>

   <ErrorMessage/>
   <Id>bfa6dda7-891a-482a-be20-a863e7fa217d</Id>

   <MinimizeSpanningAcrossMedia>

      FALSE

   </MinimizeSpanningAcrossMedia>

   <Naked>FALSE</Naked>

   <Name>Untitled</Name>
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   <OriginalSizeInBytes>0</OriginalSizeInBytes>

   <Priority>URGENT</Priority>

   <Rechunked/>

   <RequestType>PUT</RequestType>

   <Truncated>FALSE</Truncated>

   <UserId>23eefce6-041d-46bb-b3ad-55ffddafa579</UserId>

</Data>

GET COMPLETED JOBS

Description
Get a list of all completed jobs within the last 5,000 jobs. Use parameters to return a subset of
the jobs.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/completed_job/[?bucket_id={string}][&chunk_

client_processing_order_guarantee=NONE|IN_ORDER][&last_page][&name={string}][&page_

length={32-bit integer}][&page_offset={32-bit integer}][&page_start_marker={string}]

[&priority=CRITICAL|URGENT|HIGH|NORMAL|LOW|BACKGROUND][&rechunked={date}][&request_

type=PUT|GET|VERIFY][&truncated=TRUE|FALSE][&user_id={string}]

Request Parameters

Parameter Description Required

bucket_id 1 The UUID, name, or other unique identifier for the bucket on
which the job is operating.

no

chunk_client_
processing_
order_
guarantee

Specifies whether the job chunks must be processed in order.
Setting a value of NONE will achieve maximum performance, but
requires the client to get chunks as they become available, even if
they become available out of order.
Values: IN_ORDER, NONE
Default: Configured in the data policy for the bucket.

no

1) Parameter values can use wild cards (see Wild Card Syntax on page 30).
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Parameter Description Required

last_page If included, only the last page of results is returned. no

name 1 The name assigned to the job. no

page_length The maximum number of objects to list. The default is all items
after page_offset.

no

page_offset The starting point for the first object to list. The default is 0. no

page_start_
marker

The UUID or other unique attribute for the item just before the
first item to list.
Notes:
• Specifying both page_offset and page_start_marker
causes an error.

• If neither page_offset, nor page_start_marker are
specified, the page_offset default is used.

no

priority The priority for processing this job. The job priority determines the
assigned resources and processing order.
Values: CRITICAL, URGENT, HIGH, NORMAL, LOW, BACKGROUND

no

rechunked The date and time when a chunk of a GET or VERIFY job had to
be re-chunked to target other media due to the original target
becoming unavailable or corrupt in the format YYYY-MM-
DDThh:mm:ss.xxxZ or as the number of seconds that have
elapsed since January 1, 1970 at 00:00:00 GM.

no

request_type Type of job request. Values: GET, PUT, VERIFY no

truncated Whether the job was truncated (made smaller) from its original
definition. A job is truncated when a PUT job is canceled and
objects that haven't been entirely uploaded to cache are deleted
from the job so that the job can complete without any further
transmission of data from the client. Or, a job is truncated if, when
processing a GET or VERIFY job, the BlackPearl gateway
determines that some of the blobs cannot be retrieved (for
example, all media containing a blob has been ejected), in which
case the gateway truncates the parts of the job that it cannot GET
or VERIFY. Values: TRUE, FALSE

no

user_id 1 The UUID, username, or other unique attribute for the user who
initiated the job.

no

1) Parameter values can use wild cards (see Wild Card Syntax on page 30).

April 2023 DS3 API Reference-Spectra BlackPearl Nearline Gateway
- 209 -



Chapter 7 - Job Operations Get Completed Jobs

Responses

Response Elements
<Data>

   <CompletedJob>

      <BucketId>{string}</BucketId>

      <CachedSizeInBytes>{64-bit integer}</CachedSizeInBytes>

      <ChunkClientProcessingOrderGuarantee>

         IN_ORDER|NONE

      </ChunkClientProcessingOrderGuarantee>

      <CompletedSizeInBytes>

{64-bit integer}

      </CompletedSizeInBytes>

      <CreatedAt>{YYYY-MM-DDThh:mm:ss.xxxZ}</CreatedAt>

      <DateCompleted>{YYYY-MM-DDThh:mm:ss.xxxZ}</DateCanceled>
      <ErrorMessage>{string}</ErrorMessage>

      <Id>{string}</Id>

      <Naked>TRUE|FALSE</Naked>

      <Name>{string}</Name>

      <OriginalSizeInBytes>{64-bit integer}</OriginalSizeInBytes>

      <Priority>

         CRITICAL|URGENT|HIGH|NORMAL|LOW|BACKGROUND

      </Priority>

      <Rechunked>{YYYY-MM-DDThh:mm:ss.xxxZ}</Rechunked>

      <RequestType>GET|PUT|VERIFY</RequestType>

      <Truncated>TRUE|FALSE</Truncated>

      <UserId>{string}</UserId>

   </CompletedJob>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

CompletedJob The container for information about a single job.

BucketId The UUID of the bucket that is acted on by the job request.
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Parameter Description

CachedSizeInBytes The amount of data that has been transferred to the cache for this job. For
RequestType=PUT, this is the amount of data successfully transferred to
the BlackPearl gateway from the client. For RequestType=GET, this the
amount of data either in cache originally, or loaded into cache from the
permanent data store. For RequestType=VERIFY, this the amount of
data loaded into cache from the permanent data store.

ChunkClient
ProcessingOrder
Guarantee

Specifies whether the job chunks will be processed in order. Values: IN_
ORDER, NONE

CompletedSizeIn
Bytes

The amount of data that is completely processed for this job. For
RequestType=PUT, this indicates the amount of data written to all
permanent data stores. For RequestType=GET, this indicates the amount
of data that has been read successfully by the client. For
RequestType=VERIFY, this indicates the amount of data for which the
CRC has been verified.

CreatedAt The date and time the job was created in the format YYYY-MM-
DDThh:mm:ss.xxxZ.

DateCompleted The date and time the job completed in the format YYYY-MM-
DDThh:mm:ss.xxxZ.

ErrorMessage A description of the error.

Id The UUID for the job.

Naked Whether the job was created as the result of a native S3 command (TRUE)
or a Create Bulk GET/PUT/VERIFY job command (FALSE). Values: TRUE,
FALSE

Name The name assigned to the job for tracking.

OriginalSizeInBytes The full size of the job.

Priority The priority for processing this job. The job priority determines the
assigned resources and processing order. Values: CRITICAL, URGENT,
HIGH, NORMAL, LOW, BACKGROUND

Rechunked The date and time when a chunk of a GET or VERIFY job had to be re-
chunked to target other media due to the original target becoming
unavailable or corrupt. If this attribute is null, then the job was not
rechunked.
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Parameter Description

RequestType Type of job request. Values: GET, PUT, VERIFY

Truncated Whether the job was truncated (made smaller) from its original definition.
A job is truncated when a PUT job is canceled and objects that haven't
been entirely uploaded to cache are deleted from the job so that the job
can complete without any further transmission of data from the client. Or,
a job is truncated if, when processing a GET or VERIFY job, the BlackPearl
gateway determines that some of the blobs cannot be retrieved (for
example, all media containing a blob has been ejected), in which case the
gateway truncates the parts of the job that it cannot GET or VERIFY.
Values: TRUE, FALSE

UserId The UUID for the user who initiated the job.

Example

Sample Request
This request gets a list of all completed jobs on the BlackPearl gateway.
GET http://blackpearl-hostname/_rest_/completed_job/ HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>

   <CompletedJob>

      <BucketId>12c10166-979f-4477-ad3a-e1b514257886</BucketId>

      <CachedSizeInBytes>0</CachedSizeInBytes>

      <ChunkClientProcessingOrderGuarantee>

         IN_ORDER

      </ChunkClientProcessingOrderGuarantee>

      <CompletedSizeInBytes>0</CompletedSizeInBytes>
      <CreatedAt>2015-11-24T02:00:17.000Z</CreatedAt>

      <DateCompleted>2015-11-24T02:00:17.000Z</DateCompleted>

      <ErrorMessage/>

      <Id>721bcf0b-75b4-4830-ac3b-135819832f55</Id>

      <Naked>FALSE</Naked>

      <Name>Untitled</Name>
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      <OriginalSizeInBytes>0</OriginalSizeInBytes>

      <Priority>URGENT</Priority>

      <Rechunked/>

      <RequestType>PUT</RequestType>

      <Truncated>FALSE</Truncated>

      <UserId>800b9b7b-8a56-4657-85b3-ec225139e133</UserId>

   </CompletedJob>

</Data>

GET JOB

Description
Get information about a specified job. Jobs that completed or were canceled are automatically
cleared after 30 days.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/job/{job UUID or other unique identifier}/

To determine the UUID for a job, see Get Jobs on page 229.

Responses

Response Elements
<MasterObjectList

   Aggregating="TRUE|FALSE"

   BucketName="{string}"

   CachedSizeInBytes="{64-bit integer}"

   ChunkClientProcessingOrderGuarantee="IN_ORDER|NONE"

   CompletedSizeInBytes="{64-bit integer}"

   EntirelyInCache="TRUE|FALSE"

   JobId="{string}"

   Naked="TRUE|FALSE"
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   Name="{string}"

   OriginalSizeInBytes="{64-bit integer}"

   Priority="CRITICAL|URGENT|HIGH|NORMAL|LOW|BACKGROUND"

   RequestType="GET|PUT|VERIFY"

   StartDate="YYYY-MM-DDThh:mm:ss.xxxZ"

   Status="IN_PROGRESS|COMPLETED|CANCELED"

   UserId="{string}"

   UserName="{string}">
   <Nodes>

      <Node EndPoint="{string}" Id="{string}"/>

   </Nodes>
   <Objects

      ChunkId="{string}"

      ChunkNumber="{32-bit integer}">

      <Object Id="{string}" InCache="TRUE|FALSE"

         Latest="TRUE|FALSE" Length="{64-bit integer}"

         Name="{string}" Offset="{64-bit integer}"
         VersionId="{string}"/>

      ...

   </Objects>

   ...

</MasterObjectList>

where the response elements are defined as follows:

Parameter Description

MasterObjectList The container for the response.

Aggregating Whether the job can have additional PUTs or GETs appended to it. Jobs
aggregate if created with the aggregating request parameter set to
TRUE, or if created by the BlackPearl gateway in response to Amazon S3
PUT and GET requests. Values: TRUE, FALSE

BucketName The name of the bucket that is acted on by the job request.

CachedSizeInBytes The amount of data that has been transferred to the cache for this job. For
RequestType=PUT, this is the amount of data successfully transferred to
the BlackPearl gateway from the client. For RequestType=GET, this the
amount of data either in cache originally, or loaded into cache from the
permanent data store. For RequestType=VERIFY, this the amount of
data loaded into cache from the permanent data store.

ChunkClient
ProcessingOrder
Guarantee

Specifies whether the job chunks will be processed in order. Values: IN_
ORDER, NONE
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Parameter Description

CompletedSizeIn
Bytes

The amount of data that is completely processed for this job. For
RequestType=PUT, this indicates the amount of data written to all
permanent data stores. For RequestType=GET, this indicates the amount
of data that has been read successfully by the client. For
RequestType=VERIFY, this indicates the amount of data for which the
CRC has been verified.

EntirelyInCache 1 Whether all objects in the job are in the BlackPearl cache.
Values: TRUE, FALSE

JobId The UUID for the job.

Naked Whether the job was created as the result of a native S3 command (TRUE)
or a Create Bulk GET/PUT/VERIFY job command (FALSE). Values: TRUE,
FALSE

Name The name assigned to the job for tracking.

OriginalSizeInBytes The full size of the job.

Priority The priority for processing this job. The job priority determines the
assigned resources and processing order. Values: CRITICAL, URGENT,
HIGH, NORMAL, LOW, BACKGROUND

RequestType Type of job request. Values: GET, PUT, VERIFY

StartDate The date and time the job was started in the format YYYY-MM-
DDThh:mm:ss.xxxZ.

Status The current status of the job.
Values:
• IN_PROGRESS — The job is currently running.
• COMPLETED — The job completed.
• CANCELED — The job was canceled by the user or automatically due to
internal timeouts.

UserId The UUID for the user who initiated the job.

UserName The username of the user who initiated the job.

Nodes A container for information about all BlackPearl nodes.

1) Not always included for GET jobs.
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Parameter Description

Node A container for information about a single BlackPearl node.

EndPoint The IP address or DNS name of the BlackPearl node.

Id The UUID for the node.

Objects Container for information about the objects in one chunk, yet to be
processed.

ChunkId The UUID for the job chunk.

ChunkNumber The position of the chunk within the job.

Object The container for information about a single object.

Id The UUID for the object.

InCache Indicates if the object is currently in cache on the BlackPearl gateway.
Values: TRUE, FALSE

Latest Whether this version of the object is the latest.
Values: TRUE, FALSE

Length The length in bytes of the object.

Name The name of the object.

Offset The offset in bytes from the start of the object.

VersionId The UUID of the version of the object.

Example

Sample Request
This request GETs the parameters for the job with the UUID 7761fe8b-0bdc-4ce0-839e-
4b1fa3c50cf4.
GET http://blackpearl-hostname/_rest_/job/7761fe8b-0bdc-4ce0-839e-4b1fa3c50cf4/

HTTP/1.1
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Sample Response
HTTP/1.1 200 OK

<MasterObjectList

   Aggregating="FALSE"

   BucketName="bucket_name"

   CachedSizeInBytes="0"

   ChunkClientProcessingOrderGuarantee="IN_ORDER"

   CompletedSizeInBytes="0"
   EntirelyInCache="FALSE"

   JobId="b5604de7-904e-4577-987b-4b65c24096e6"

   Naked="FALSE"

   Name="Untitled"

   OriginalSizeInBytes="0" Priority="URGENT" RequestType="PUT"
   StartDate="2015-10-07T22:33:27.000Z" Status="IN_PROGRESS"

   UserId="4c8fc543-e33b-494c-adfb-870747296bd0"

   UserName="user_name">

   <Nodes>

      <Node EndPoint="blackpearl-hostname"

      Id="b145fe8d-7019-4beb-b2b7-76d3994516be"/>

   </Nodes>
   <Objects ChunkId="a846352f-1936-4a63-b8a5-17f497847795"

      ChunkNumber="1">

      <Object Id="1209c59e-6845-47f3-a373-acca107b1621"

         InCache="FALSE" Latest="TRUE" Length="10" Name="o1"

         Offset="0"

         VersionId="536d118c-d58c-4a6e-9fb5-5bd299b76808"/>

   </Objects>

</MasterObjectList>

GET JOB CHUNK

Description
Get the objects from the specified job chunk. It is more common to use GET Object
operations. See Get Object on page 48.
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Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/job_chunk/{job_chunk_id}/

To determine the UUID for a job chunk, see Create Bulk GET on page 165.

Responses

Response Elements
<Objects

   ChunkId="{string}"

   ChunkNumber="{32-bit integer}"

   NodeId="{string}">

   <Object

      Id="{string}"

      InCache="TRUE|FALSE"

      Latest="TRUE|FALSE"

      Length="{64-bit integer}"

      Name="{string}"

      Offset="{64-bit integer}"

      VersionId="{string}"/>

</Objects>

where the response elements are defined as follows:

Parameter Description

Objects The container for the response.

ChunkId The UUID for the job chunk.

ChunkNumber The position of the chunk within the job.

NodeId The UUID for the node.

Object The container for information about a single object.

Id The UUID for the object.

InCache Indicates if the object is currently in cache on the BlackPearl gateway. Values:
TRUE, FALSE
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Parameter Description

Latest Whether this version of the object is the latest.
Values: TRUE, FALSE

Length The length in bytes of the object.

Name The name of the object.

Offset The offset in bytes from the start of the object.

VersionId The UUID of the version of the object.

Example

Sample Request
This request does a GET for all objects in the job chunk with the UUID f086d875-055c-45c6-
acf9-7741058d95a3.
GET http://blackpearl-hostname/_rest_/_rest_/job_chunk/f086d875-055c-45c6-acf9-

7741058d95a3/ HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Objects

   ChunkId="f086d875-055c-45c6-acf9-7741058d95a3"

   ChunkNumber="1"

   NodeId="2e2a83ff-ecc6-44f5-9e92-f8206f01db11">

   <Object

      Id="30030d45-85ea-49ca-a2f7-6cce05452632"

      InCache="FALSE"

      Latest="TRUE"

      Length="1024"

      Name="T950.tif"

      Offset="0"

      VersionId="536d118c-d58c-4a6e-9fb5-5bd299b76808"/>

</Objects>
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GET JOB CHUNK INFORMATION

Description
Get information about the specified job chunk.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/job_chunk_dao/{job_chunk_id}/

To determine the UUID for a job chunk, see Create Bulk GET on page 165.

Responses

Response Elements
<Data>

   <BlobStoreState>COMPLETED|IN_PROGRESS|PENDING</BlobStoreState>

   <ChunkNumber>{32-bit integer}</ChunkNumber>

   <Id>{string}</Id>

   <JobCreationDate/>

   <JobId>{string}</JobId>

   <NodeId>{string}</NodeId>

   <PendingTargetCommit>TRUE|FALSE</PendingTargetCommit>

   <ReadFromDs3TargetId>{string}</ReadFromDs3TargetId>

   <ReadFromPoolId>{string}</ReadFromPoolId>

   <ReadFromTapeId>{string}</ReadFromTapeId>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

BlobStoreState The processing state of the object part.
Values:
COMPLETED — The chunk has been completely read/written by the data
store.
IN_PROGRESS — The chunk is being read/written by the data store.
PENDING — The data store has not begun processing the chunk yet.
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Parameter Description

ChunkNumber The position of the chunk within the job.

Id The UUID for the job chunk.

JobCreationDate The date and time the job was created in the format YYYY-MM-
DDThh:mm:ss.xxxZ.

NodeId The UUID for the node.

PendingTarget
Commit

Whether both of the following are true:
• The job chunk is part of a PUT job.
• The BlackPearl gateway has completed all local and replicated copies
required, but the replication target(s) have not completed their local and
replicated copies.

Values: TRUE, FALSE

ReadFromDs3
TargetId

The UUID of the BlackPearl replication target from which the gateway plans
to read or verify the chunk.

ReadFromPoolId The UUID of the disk pool from which the gateway plans to read or verify
the chunk.

ReadFromTapeId The UUID of the tape from which the gateway plans to read or verify the
chunk.

Name The name of the object.

Example

Sample Request
This request gets information about the job chunk with the UUID 483beee5-1064-4b5b-896d-
e499e7cb2f02.
GET http://blackpearl-hostname/_rest_/_rest_/job_chunk_dao/483beee5-1064-4b5b-896d-

e499e7cb2f02/ HTTP/1.1
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Sample Response
HTTP/1.1 200 OK

<Data>

   <BlobStoreState>PENDING</BlobStoreState>

   <ChunkNumber>1</ChunkNumber>

   <Id>483beee5-1064-4b5b-896d-e499e7cb2f02</Id>

   <JobCreationDate/>

   <JobId>0eef20e6-963d-4312-b674-91e740c844b1</JobId>

   <NodeId>9e29cee4-0e8b-4cf5-9dfc-6c9627dcfac9</NodeId>

   <PendingTargetCommit>FALSE</PendingTargetCommit>

   <ReadFromDs3TargetId/>

   <ReadFromPoolId/>

   <ReadFromTapeId/>

</Data>

GET JOB CHUNKS READY FOR PROCESSING

Description
Get a list of all job chunks for a given job that are ready for client processing.

For PUT jobs, this command allocates a working window of job chunks, if possible, and
return a list of job chunks ready for uploading. Any chunk returned is fully allocated,
meaning that you do not have to handle HTTP 307 retries on subsequent PUTs for the
chunks. Retries adversely impact BlackPearl gateway performance and require you to
provide the object data stream for every PUT retry.

For GET jobs, this command responds with a list of job chunks loaded in cache and ready for
download.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/job_chunk/?job={string}[&job_chunk={string}]

[&preferred_number_of_chunks={32-bit integer}]
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Request Parameters

Parameter Description Required

job The UUID or a unique attribute for the job for which you want
job chunks listed. See Get Jobs on page 229.

yes

job_chunk The UUID or a unique attribute for the job chunk. no

preferred_
number_of_
chunks

The maximum number of chunks to return. The default is 3. no

Responses

Response Elements
<MasterObjectList

   Aggregating="TRUE|FALSE"

   BucketName="{string}"

   CachedSizeInBytes="{64-bit integer}"

   ChunkClientProcessingOrderGuarantee="IN_ORDER|NONE"

   CompletedSizeInBytes="{64-bit integer}"

   EntirelyInCache="TRUE|FALSE"
   JobId="{string}"

   Naked="TRUE|FALSE"

   Name="{string}"

   OriginalSizeInBytes="{64-bit integer}"

   Priority="CRITICAL|URGENT|HIGH|NORMAL|LOW|BACKGROUND"
   RequestType="GET|PUT|VERIFY"
   StartDate="{YYYY-MM-DDThh:mm:ss.xxxZ}"
   Status="IN_PROGRESS|COMPLETED|CANCELED"

   UserId="{string}"

   UserName="{string}">

   <Nodes>

      <Node

         EndPoint="{string}" Id="{string}"/>

      ...

   </Nodes>
   <Objects

      ChunkId="{string}"

      ChunkNumber="{32-bit integer}">
      NodeId="{string}"

April 2023 DS3 API Reference-Spectra BlackPearl Nearline Gateway
- 223 -



Chapter 7 - Job Operations Get Job Chunks Ready for Processing

      <Object

         Id="{string}"

         InCache="TRUE|FALSE"

         Latest="TRUE|FALSE"

         Length="{64-bit integer}"

         Name="{string}"

         Offset="{64-bit integer}"

         VersionId="{string}"/>

      ...

   </Objects>

   ...

</MasterObjectList>

where the response elements are defined as follows:

Parameter Description

MasterObjectList The container for the response.

Aggregating Whether the job can have additional PUTs or GETs appended to it. Jobs
aggregate if created with the aggregating request parameter set to
TRUE, or if created by the BlackPearl gateway in response to Amazon S3
PUT and GET requests. Values: TRUE, FALSE

BucketName The name of the bucket that is acted on by the job request.

CachedSizeInBytes The amount of data that has been transferred to the cache for this job. For
RequestType=PUT, this is the amount of data successfully transferred to
the BlackPearl gateway from the client. For RequestType=GET, this the
amount of data either in cache originally, or loaded into cache from the
permanent data store. For RequestType=VERIFY, this the amount of
data loaded into cache from the permanent data store.

ChunkClient
ProcessingOrder
Guarantee

Specifies whether the job chunks will be processed in order. Values: IN_
ORDER, NONE

CompletedSizeIn
Bytes

The amount of data that has been transferred to the cache for this job. For
RequestType=PUT, this is the amount of data successfully transferred to
the BlackPearl gateway from the client. For RequestType=GET, this the
amount of data either in cache originally, or loaded into cache from the
permanent data store. For RequestType=VERIFY, this the amount of
data loaded into cache from the permanent data store.

EntirelyInCache Whether all objects in the job are in the BlackPearl cache.
Values: TRUE, FALSE
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Parameter Description

JobId The UUID for the job.

Naked Whether the job was created as the result of a native S3 command (TRUE)
or a Create Bulk GET/PUT/VERIFY job command (FALSE). Values: TRUE,
FALSE

Name The name assigned to the job for tracking.

OriginalSizeInBytes The full size of the job.

Priority The priority for processing this job. The job priority determines the
assigned resources and processing order. Values: CRITICAL, URGENT,
HIGH, NORMAL, LOW, BACKGROUND

RequestType Type of job request. Values: GET, PUT, VERIFY

StartDate The date and time the job was started in the format YYYY-MM-
DDThh:mm:ss.xxxZ.

Status The current status of the job.
Values:
• IN_PROGRESS — The job is currently running.
• COMPLETED — The job completed.
• CANCELED — The job was canceled by the user or automatically due to
internal timeouts.

UserId The UUID for the user who initiated the job.

UserName The username of the user who initiated the job.

Nodes A container for information about all BlackPearl nodes.

Node A container for information about a single BlackPearl node.

EndPoint The IP address or DNS name of the BlackPearl node.

Id The UUID for the node.

Objects Container for information about the objects in one chunk.

ChunkId The UUID for the job chunk.

ChunkNumber The position of the chunk within the job.

Object The container for information about a single object.
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Parameter Description

NodeId The UUID for the node.

Id The UUID for the object.

InCache Indicates if the object is currently in cache on the BlackPearl gateway.
Values: TRUE, FALSE

Latest Whether this version of the object is the latest.
Values: TRUE, FALSE

Length The length in bytes of the object.

Name The name of the object.

Offset The offset in bytes from the start of the object.

VersionId The UUID of the version of the object.

Example

Sample Request
This request GETs a list of all job chunks ready to process for the job with the UUID
63c605c4-8f8f-47c8-87ec-5735fbd53218.
GET http://blackpearl-hostname/_rest_/job_chunk?job=63c605c4-8f8f-47c8-87ec-

5735fbd53218/ HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<MasterObjectList

   Aggregating="FALSE"

   BucketName="bucket_name"

   CachedSizeInBytes="0"
   ChunkClientProcessingOrderGuarantee="IN_ORDER"

   CompletedSizeInBytes="0"

   EntirelyInCache="FALSE"

   JobId="63c605c4-8f8f-47c8-87ec-5735fbd53218"
   Naked="FALSE"

   Name="Untitled"

   OriginalSizeInBytes="0"

   Priority="URGENT"

   RequestType="PUT"
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   StartDate="2015-08-10T22:58:42.000Z"

   Status="IN_PROGRESS"

   UserId="3b478ebf-6076-4b01-a763-f35cadee8e77"

   UserName="user_name">

   <Nodes>

      <Node EndPoint="blackpearl-hostname"

      Id="329cd2ee-1e3c-482c-8d8f-b3c85562f05c"/>

   </Nodes>
   <Objects ChunkId="7a8fd827-072b-43be-9e28-821fca542a5f"

      ChunkNumber="1"

      NodeId="329cd2ee-1e3c-482c-8d8f-b3c85562f05c">

      <Object Id="7bd98e85-9b46-4f99-88e1-4bb3f3d7b55d"

         InCache="FALSE" Latest="TRUE" Length="1000"

         Name="o1" Offset="0"

         VersionId="536d118c-d58c-4a6e-9fb5-5bd299b76808"/>

   </Objects>

</MasterObjectList>

GET JOB TO REPLICATE

Description
Returns an XML payload that represents a job that a client wants to replicate to another
BlackPearl gateway. This payload is intended to be forwarded to another BlackPearl gateway
to replicate the job using Replicate PUT Job on page 245.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/job/{job UUID or unique

identifier}/?replicate

To determine the UUID for a job, see Get Jobs on page 229.

Request Parameters

Parameter Description Required

replicate Included to indicate a replicate operation. yes
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Responses

Response Elements
Returns an XML payload to replicate a job. This payload is used as a request payload for a
Replicate PUT Job (see page 245).

Example

Sample Request
This request gets information for replicating the job with the UUID 104c5557-a600-4b23-b838-
24c1e0d8a38a.
GET http://blackpearl-hostname/_rest_/job/104c5557-a600-4b23-b838-

24c1e0d8a38a/?replicate HTTP/1.1

Sample Response
HTTP/1.1 200 OK

{"blobs":

[{"byteOffset":0,

      "checksum":null,

      "checksumType":null,

      "id":"38403a46-79d3-4a94-aa0d-6262399eb43a",

      "length":10,

      "objectId":"5ba8892e-84d6-4886-b68d-00ff72aaf9bc"}],
   "chunks":

[{"chunkNumber":1,

         "entries":

[{"blobId":"38403a46-79d3-4a94-aa0d-6262399eb43a",

            "chunkId":"f40ccd1b-7a4a-417d-a928-5ff79f68ceeb",

            "id":"d1b4660e-5e68-4265-bf7e-22ec6915bb56",

            "jobId":"104c5557-a600-4b23-b838-24c1e0d8a38a",

            "orderIndex":1}],

      "id":"f40ccd1b-7a4a-417d-a928-5ff79f68ceeb"}],
   "id":"104c5557-a600-4b23-b838-24c1e0d8a38a",
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   "objects":

[{"bucketId":"8def70a9-0fcb-490d-ad9b-5538838463f6",

      "creationDate":null,

      "id":"5ba8892e-84d6-4886-b68d-00ff72aaf9bc",

      "latest":TRUE,

      "name":"o1",

      "type":"DATA",

      "version":1}]}

GET JOBS

Description
Get a list of all jobs currently running. Use the full_details parameter to include jobs
completed or canceled in the last 30 days, up to a maximum of 5,000 jobs. Use the bucket
parameter to return only the jobs involving the specified bucket.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/job/[?bucket_id={string}][&full_details]

Request Parameters

Parameter Description Required

bucket_id 1 The UUID, name, or other unique identifier for the bucket on which
the job is operating.

no

full_details If included, the response includes information about jobs completed
or canceled in the last 30 days.

no

1) Parameter values can use wild cards (see Wild Card Syntax on page 30).
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Responses

Response Elements
<Jobs>

   <Job

      Aggregating="TRUE|FALSE"

      BucketName="{string}"

      CachedSizeInBytes="{64-bit integer}"

      ChunkClientProcessingOrderGuarantee="IN_ORDER|NONE"

      CompletedSizeInBytes="{64-bit integer}"

      EntirelyInCache="TRUE|FALSE"

      JobId="{string}"
      Naked="TRUE|FALSE"

      Name="{string}"

      OriginalSizeInBytes="{64-bit integer}"

      Priority="CRITICAL|URGENT|HIGH|NORMAL|LOW|BACKGROUND"

      RequestType="GET|PUT|VERIFY"

      StartDate="{YYYY-MM-DDThh:mm:ss.xxxZ}"
      Status="CANCELED|COMPLETED|IN_PROGRESS"

      UserId="{string}"

      UserName="{string}">
      <Nodes>

         <Node EndPoint="{string}" Id="{string}"/>

      </Nodes>

   </Job>
   ...

</Jobs>

where the response elements are defined as follows:

Parameter Description

Jobs The container for the response.

Job The container for information about a single job.

Aggregating Whether the job can have additional PUTs or GETs appended to it. Jobs
aggregate if created with the aggregating request parameter set to
TRUE, or if created by the BlackPearl gateway in response to Amazon S3
PUT and GET requests. Values: TRUE, FALSE

BucketName The name of the bucket that is acted on by the job request.
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Parameter Description

CachedSizeInBytes The amount of data that has been transferred to the cache for this job. For
RequestType=PUT, this is the amount of data successfully transferred to
the BlackPearl gateway from the client. For RequestType=GET, this the
amount of data either in cache originally, or loaded into cache from the
permanent data store. For RequestType=VERIFY, this the amount of
data loaded into cache from the permanent data store.

ChunkClient
ProcessingOrder
Guarantee

Specifies whether the job chunks will be processed in order. Values: IN_
ORDER, NONE

CompletedSizeIn
Bytes

The amount of data that is completely processed for this job. For
RequestType=PUT, this indicates the amount of data written to all
permanent data stores. For RequestType=GET, this indicates the amount
of data that has been read successfully by the client. For
RequestType=VERIFY, this indicates the amount of data for which the
CRC has been verified.

EntirelyInCache 1 Whether all objects in the job are in the BlackPearl cache.
Values: TRUE, FALSE

JobId The UUID for the job.

Naked Whether the job was created as the result of a native S3 command (TRUE)
or a Create Bulk GET/PUT/VERIFY job command (FALSE). Values: TRUE,
FALSE

Name The name assigned to the job for tracking.

OriginalSizeInBytes The full size of the job.

Priority The priority for processing this job. The job priority determines the
assigned resources and processing order. Values: CRITICAL, URGENT,
HIGH, NORMAL, LOW, BACKGROUND

RequestType Type of job request. Values: GET, PUT, VERIFY

StartDate The date and time the job was started in the format YYYY-MM-
DDThh:mm:ss.xxxZ.

1) Not always included for GET jobs.
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Parameter Description

Status The current status of the job.
Values:
• IN_PROGRESS — The job is currently running.
• COMPLETED — The job completed.
• CANCELED — The job was canceled by the user or automatically due to
internal timeouts.

UserId The UUID for the user who initiated the job.

UserName The username of the user who initiated the job.

Nodes A container for information about all BlackPearl nodes.

Node A container for information about a single BlackPearl node.

EndPoint The IP address or DNS name of the BlackPearl node.

Id The UUID for the node.

Example

Sample Request
This request gets a list of all jobs currently running on the BlackPearl gateway.
GET http://blackpearl-hostname/_rest_/job/ HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Jobs>

   <Job

      Aggregating="FALSE"

      BucketName="bucket_name"

      CachedSizeInBytes="0"

      ChunkClientProcessingOrderGuarantee="IN_ORDER"

      CompletedSizeInBytes="0"

      EntirelyInCache="FALSE"
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      JobId="1615f0cf-afee-44e5-9185-640912e4595a"

      Naked="FALSE"

      Name="Untitled"

      OriginalSizeInBytes="0"

      Priority="URGENT"

      RequestType="GET"

      StartDate="2014-10-02T11:40:11.000Z"

      Status="IN_PROGRESS"

      UserId="91b0c685-a728-4d59-b504-2e53f29a5e70"
      UserName="user_name"

      WriteOptimization="CAPACITY">

      <Nodes>

         <Node

            EndPoint="blackpearl-hostname"

            Id="08faa8c4-ae11-4c6a-bc02-8986e674b175"/>

      </Nodes>

   </Job>

   ...

</Jobs>

MODIFY ACTIVE JOB

Description
Modify the priority or the start date of a job that is in process. Executing this request also
resets the heartbeat for the job, so that it does not timeout.

Notes:

• If an optional request parameter is not included, the previous setting is retained.

• This command is an alias for Modify Job on page 239.

Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/active_job/{job UUID or unique identifier}/

[?created_at={date}][&dead_job_cleanup_allowed=TRUE|FALSE][&name={string}]

[&priority=URGENT|HIGH|NORMAL|LOW][&protected=TRUE|FALSE]

To determine the UUID for a job, see Get Active Jobs on page 190.
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Request Parameters

Parameter Description Required

created_at The date to set as the StartDate in the format YYYY-MM-
DDThh:mm:ss.xxxZ or as the number of seconds that have elapsed
since January 1, 1970 at 00:00:00 GM.

no

dead_job_
cleanup_
allowed

Whether or not a job can be canceled or truncated automatically
after 24 hours of inactivity. Values: TRUE (default), FALSE.

no

name 1 A name to assign to the job for tracking. no

priority The priority for processing this job. The job priority determines the
assigned resources and processing order. Jobs with priority
URGENT can use up all of the resources and prevent other jobs from
making progress. Use this priority sparingly.
Values: URGENT, HIGH, NORMAL, LOW
Default: The previously specified priority.

no

protected The protection setting for the job. Protected jobs cannot be canceled.
Values: TRUE, FALSE (default).

no

Responses

Response Elements
<MasterObjectList

   Aggregating="TRUE|FALSE"

   BucketName="{string}"

   CachedSizeInBytes="{64-bit integer}"

   ChunkClientProcessingOrderGuarantee="IN_ORDER|NONE"

   CompletedSizeInBytes="{64-bit integer}"
   DeadJobCleanupAllowed="TRUE|FALSE"
   EntirelyInCache="TRUE|FALSE"

   JobId="{string}"

   Naked="TRUE|FALSE"

   Name="{string}"
   OriginalSizeInBytes="{64-bit integer}"

   Priority="CRITICAL|URGENT|HIGH|NORMAL|LOW|BACKGROUND"
   Protected="TRUE|FALSE"
   RequestType="GET|PUT|VERIFY"

1) Parameter values can use wild cards (see Wild Card Syntax on page 30).
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   StartDate="{YYYY-MM-DDThh:mm:ss.xxxZ}"
   Status="IN_PROGRESS|COMPLETED|CANCELED"

   UserId="{string}"

   UserName="{string}">

   <Nodes>

      <Node

         EndPoint="{string}" Id="{string}"/>

      ...

   </Nodes>
   <Objects

      ChunkId="{string}"

      ChunkNumber="{32-bit integer}">

      <Object

         Id="{string}"

         InCache="TRUE|FALSE"
         Latest="TRUE|FALSE"

         Length="{64-bit integer}"

         Name="{string}"

         Offset="{64-bit integer}"

         VersionID="{string}"/>
      </Object>

      ...

   </Objects>

</MasterObjectList>

where the response elements are defined as follows:

Parameter Description

MasterObjectList The container for the response.

Aggregating Whether the job can have additional PUTs or GETs appended to it.
Jobs aggregate if created with the aggregating request parameter
set to TRUE, or if created by the BlackPearl gateway in response to
Amazon S3 PUT and GET requests. Values: TRUE, FALSE

BucketName The name of the bucket that is acted on by the job request.

CachedSizeInBytes The amount of data that has been transferred to the cache for this
job. For RequestType=PUT, this is the amount of data successfully
transferred to the BlackPearl gateway from the client. For
RequestType=GET, this the amount of data either in cache
originally, or loaded into cache from the permanent data store. For
RequestType=VERIFY, this the amount of data loaded into cache
from the permanent data store.
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Parameter Description

ChunkClient
ProcessingOrder
Guarantee

Specifies whether the job chunks will be processed in order. Values:
IN_ORDER, NONE

CompletedSizeIn
Bytes

The amount of data that is completely processed for this job. For
RequestType=PUT, this indicates the amount of data written to all
permanent data stores. For RequestType=GET, this indicates the
amount of data that has been read successfully by the client. For
RequestType=VERIFY, this indicates the amount of data for which
the CRC has been verified.

DeadJobCleanupAllowed Whether or not a job can be canceled or truncated automatically
after 24 hours of inactivity. Values: TRUE (default), FALSE.

EntirelyInCache 1 Whether all objects in the job are in the BlackPearl cache.
Values: TRUE, FALSE

JobId The UUID for the job.

Naked Whether the job was created as the result of a native S3 command
(TRUE) or a Create Bulk GET/PUT/VERIFY job command (FALSE).
Values: TRUE, FALSE

Name The name assigned to the job for tracking.

OriginalSizeInBytes The full size of the job.

Priority The priority for processing this job. The job priority determines the
assigned resources and processing order. Values: CRITICAL,
URGENT, HIGH, NORMAL, LOW, BACKGROUND

Protected The protection setting for the job. Protected jobs cannot be canceled.
Values: TRUE, FALSE (default).

RequestType Type of job request. Values: GET, PUT, VERIFY

StartDate The date and time the job was started in the format YYYY-MM-
DDThh:mm:ss.xxxZ.

1) Not always included for GET jobs.
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Parameter Description

Status The current status of the job.
Values:
• IN_PROGRESS — The job is currently running.
• COMPLETED — The job completed.
• CANCELED — The job was canceled by the user or automatically
due to internal timeouts.

UserId The UUID for the user who initiated the job.

UserName The username of the user who initiated the job.

Nodes A container for information about all BlackPearl nodes.

Node A container for information about a single BlackPearl node.

EndPoint The IP address or DNS name of the BlackPearl node.

Id The UUID for the node.

Objects Container for information about the objects in one chunk.

ChunkId The UUID for the job chunk.

ChunkNumber The position of the chunk within the job.

Object The container for information about a single object.

Id The UUID for the object.

InCache Indicates if the object is currently in cache on the BlackPearl
gateway. Values: TRUE, FALSE

Latest Whether this version of the object is the latest.
Values: TRUE, FALSE

Length The length in bytes of the object.

Name The name of the object.

Offset The offset in bytes from the start of the object.

VersionID The UUID of the version of the object.

Id The UUID for the object.
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Example

Sample Request
This request modifies the priority of the job with the UUID 0123edab-a4ec-4472-927e-
c4df0ac9416b to urgent.
PUT http://blackpearl-hostname/_rest_/job/0123edab-a4ec-4472-927e-

c4df0ac9416b/?priority=URGENT HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<MasterObjectList

   Aggregating="FALSE"

   BucketName="bucket_name"

   CachedSizeInBytes="0"

   ChunkClientProcessingOrderGuarantee="IN_ORDER"

   CompletedSizeInBytes="0"
   DeadJobCleanupAllowed="FALSE"
   EntirelyInCache="FALSE"
   JobId="0123edab-a4ec-4472-927e-c4df0ac9416b"

   Naked="FALSE"

   Name="Untitled"

   OriginalSizeInBytes="12345"

   Priority="URGENT"
   Protected="TRUE"
   RequestType="PUT"

   StartDate="2014-10-02T11:40:18.000Z"

   UserId="0e48e86a-54ca-4078-af35-40138da7b1a6"

   UserName="user_name"
   WriteOptimization="CAPACITY">

   <Nodes>

      <Node

         EndPoint="blackpearl-hostname"

         Id="ee05bc5f-3a0e-41c3-992d-9ea99ce7552e"/>

   </Nodes>
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   <Objects

      ChunkId="d4b8a15a-d635-4854-b746-751edafe5c88"

      ChunkNumber="1">

      <Object

         Id="70f80a64-4da9-42e2-bd0f-ee67cf496bbe" InCache="FALSE"

         Latest="TRUE" Length="12345" Name="object_name"

         Offset="0"

         VersionId="536d118c-d58c-4a6e-9fb5-5bd299b76808"/>

      </Object>

   </Objects>

</MasterObjectList>

MODIFY JOB

Description
Modify the priority or the start date of a job that is in process. Executing this request also
resets the heartbeat for the job, so that it does not timeout.

Notes:

• If an optional request parameter is not included, the previous setting is retained.

• This command is an alias for Modify Active Job on page 233

Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/job/{job UUID or unique identifier}/

[?created_at={date}][&dead_job_cleanup_allowed=TRUE|FALSE][&name={string}]

[&priority=URGENT|HIGH|NORMAL|LOW][&protected=TRUE|FALSE]

To determine the UUID for a job, see Get Jobs on page 229.

Request Parameters

Parameter Description Required

created_at The date to set as the StartDate in the format YYYY-MM-
DDThh:mm:ss.xxxZ or as the number of seconds that have elapsed
since January 1, 1970 at 00:00:00 GM.

no
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Parameter Description Required

dead_job_
cleanup_
allowed

Whether or not a job can be canceled or truncated automatically
after 24 hours of inactivity. Values: TRUE (default), FALSE.

no

name 1 A name to assign to the job for tracking. no

priority The priority for processing this job. The job priority determines the
assigned resources and processing order. Jobs with priority
URGENT can use up all of the resources and prevent other jobs from
making progress. Use this priority sparingly.
Values: URGENT, HIGH, NORMAL, LOW
Default: The previously specified priority.

no

protected The protection setting for the job. Protected jobs cannot be canceled.
Values: TRUE, FALSE (default).

no

Responses

Response Elements
<MasterObjectList

   Aggregating="TRUE|FALSE"

   BucketName="{string}"

   CachedSizeInBytes="{64-bit integer}"

   ChunkClientProcessingOrderGuarantee="IN_ORDER|NONE"

   CompletedSizeInBytes="{64-bit integer}"
   DeadJobCleanupAllowed="TRUE|FALSE"
   EntirelyInCache="TRUE|FALSE"

   JobId="{string}"

   Naked="TRUE|FALSE"

   Name="{string}"
   OriginalSizeInBytes="{64-bit integer}"

   Priority="CRITICAL|URGENT|HIGH|NORMAL|LOW|BACKGROUND"
   Protected="TRUE|FALSE"
   RequestType="GET|PUT|VERIFY"
   StartDate="{YYYY-MM-DDThh:mm:ss.xxxZ}"
   Status="IN_PROGRESS|COMPLETED|CANCELED"

   UserId="{string}"

   UserName="{string}">

1) Parameter values can use wild cards (see Wild Card Syntax on page 30).
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   <Nodes>

      <Node

         EndPoint="{string}" Id="{string}"/>

      ...

   </Nodes>
   <Objects

      ChunkId="{string}"

      ChunkNumber="{32-bit integer}">
      <Object

         Id="{string}"

         InCache="TRUE|FALSE"
         Latest="TRUE|FALSE"

         Length="{64-bit integer}"

         Name="{string}"

         Offset="{64-bit integer}"

         VersionID="{string}"/>

      </Object>

      ...

   </Objects>

</MasterObjectList>

where the response elements are defined as follows:

Parameter Description

MasterObjectList The container for the response.

Aggregating Whether the job can have additional PUTs or GETs appended to it.
Jobs aggregate if created with the aggregating request parameter
set to TRUE, or if created by the BlackPearl gateway in response to
Amazon S3 PUT and GET requests. Values: TRUE, FALSE

BucketName The name of the bucket that is acted on by the job request.

CachedSizeInBytes The amount of data that has been transferred to the cache for this
job. For RequestType=PUT, this is the amount of data successfully
transferred to the BlackPearl gateway from the client. For
RequestType=GET, this the amount of data either in cache
originally, or loaded into cache from the permanent data store. For
RequestType=VERIFY, this the amount of data loaded into cache
from the permanent data store.

ChunkClient
ProcessingOrder
Guarantee

Specifies whether the job chunks will be processed in order. Values:
IN_ORDER, NONE

April 2023 DS3 API Reference-Spectra BlackPearl Nearline Gateway
- 241 -



Chapter 7 - Job Operations Modify Job

Parameter Description

CompletedSizeIn
Bytes

The amount of data that is completely processed for this job. For
RequestType=PUT, this indicates the amount of data written to all
permanent data stores. For RequestType=GET, this indicates the
amount of data that has been read successfully by the client. For
RequestType=VERIFY, this indicates the amount of data for which
the CRC has been verified.

DeadJobCleanupAllowed Whether or not a job can be canceled or truncated automatically
after 24 hours of inactivity. Values: TRUE (default), FALSE.

EntirelyInCache 1 Whether all objects in the job are in the BlackPearl cache.
Values: TRUE, FALSE

JobId The UUID for the job.

Naked Whether the job was created as the result of a native S3 command
(TRUE) or a Create Bulk GET/PUT/VERIFY job command (FALSE).
Values: TRUE, FALSE

Name The name assigned to the job for tracking.

OriginalSizeInBytes The full size of the job.

Priority The priority for processing this job. The job priority determines the
assigned resources and processing order. Values: CRITICAL,
URGENT, HIGH, NORMAL, LOW, BACKGROUND

Protected The protection setting for the job. Protected jobs cannot be canceled.
Values: TRUE, FALSE (default).

RequestType Type of job request. Values: GET, PUT, VERIFY

StartDate The date and time the job was started in the format YYYY-MM-
DDThh:mm:ss.xxxZ.

Status The current status of the job.
Values:
• IN_PROGRESS — The job is currently running.
• COMPLETED — The job completed.
• CANCELED — The job was canceled by the user or automatically
due to internal timeouts.

1) Not always included for GET jobs.
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Parameter Description

UserId The UUID for the user who initiated the job.

UserName The username of the user who initiated the job.

Nodes A container for information about all BlackPearl nodes.

Node A container for information about a single BlackPearl node.

EndPoint The IP address or DNS name of the BlackPearl node.

Id The UUID for the node.

Objects Container for information about the objects in one chunk.

ChunkId The UUID for the job chunk.

ChunkNumber The position of the chunk within the job.

Object The container for information about a single object.

Id The UUID for the object.

InCache Indicates if the object is currently in cache on the BlackPearl
gateway. Values: TRUE, FALSE

Latest Whether this version of the object is the latest.
Values: TRUE, FALSE

Length The length in bytes of the object.

Name The name of the object.

Offset The offset in bytes from the start of the object.

VersionID The UUID of the version of the object.

Id The UUID for the object.

Example

Sample Request
This request modifies the priority of the job with the UUID 0123edab-a4ec-4472-927e-
c4df0ac9416b to urgent.
PUT http://blackpearl-hostname/_rest_/job/0123edab-a4ec-4472-927e-

c4df0ac9416b/?priority=URGENT HTTP/1.1
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Sample Response
HTTP/1.1 200 OK

<MasterObjectList

   Aggregating="FALSE"

   BucketName="bucket_name"

   CachedSizeInBytes="0"

   ChunkClientProcessingOrderGuarantee="IN_ORDER"
   CompletedSizeInBytes="0"
   DeadJobCleanupAllowed="FALSE"
   EntirelyInCache="FALSE"

   JobId="0123edab-a4ec-4472-927e-c4df0ac9416b"

   Naked="FALSE"

   Name="Untitled"

   OriginalSizeInBytes="12345"
   Priority="URGENT"
   Protected="TRUE"
   RequestType="PUT"

   StartDate="2014-10-02T11:40:18.000Z"

   UserId="0e48e86a-54ca-4078-af35-40138da7b1a6"

   UserName="user_name"
   WriteOptimization="CAPACITY">

   <Nodes>

      <Node

         EndPoint="blackpearl-hostname"

         Id="ee05bc5f-3a0e-41c3-992d-9ea99ce7552e"/>

   </Nodes>
   <Objects

      ChunkId="d4b8a15a-d635-4854-b746-751edafe5c88"

      ChunkNumber="1">

      <Object

         Id="70f80a64-4da9-42e2-bd0f-ee67cf496bbe"

         InCache="FALSE"

         Latest="TRUE"

         Length="12345"

         Name="object_name"

         Offset="0"

         VersionId="536d118c-d58c-4a6e-9fb5-5bd299b76808"/>

      </Object>

   </Objects>

</MasterObjectList>
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REPLICATE PUT JOB

Description
Replicates a job from another BlackPearl gateway to this BlackPearl gateway, ensuring that
the objects are recognized as identical across the gateways on which replication is performed.
Clients must provide the response payload returned by Modify Active Job on page 233 on the
source BlackPearl gateway as the request payload for the Replicate PUT Job on the target
gateway.

Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/bucket/{UUID, name, or other unique attribute

for the bucket}/?operation=START_BULK_PUT &replicate

[&priority=URGENT|HIGH|NORMAL|LOW]

To determine the UUID for a bucket, see Get Buckets - DS3 on page 76.

Request Parameters

Parameter Description Required

operation The operation to perform. For this request, the operation is to start a
bulk PUT job. Value: START_BULK_PUT

yes

replicate Included to indicate a replicate operation. yes

priority The priority for processing this job. The job priority determines the
assigned resources and processing order. Jobs with Priority
URGENT can use up all of the resources and prevent other jobs from
making progress. Use this priority sparingly.
Values: URGENT, HIGH, NORMAL, LOW
Default: Configured in the data policy for the bucket.

no

Request Elements
An XML payload, the response from Modify Active Job on page 233 run on the source
BlackPearl gateway, must be sent as the request payload.
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Responses

Response Elements
<MasterObjectList

   Aggregating="TRUE|FALSE"

   BucketName="{string}"

   CachedSizeInBytes="{64-bit integer}"

   ChunkClientProcessingOrderGuarantee="IN_ORDER|NONE"

   CompletedSizeInBytes="{64-bit integer}"

   EntirelyInCache="TRUE|FALSE"
   JobId="{string}"

   Naked="TRUE|FALSE"

   Name="{string}"

   OriginalSizeInBytes="{64-bit integer}"

   Priority="CRITICAL|URGENT|HIGH|NORMAL|LOW|BACKGROUND"

   RequestType="PUT"

   StartDate="YYYY-MM-DDThh:mm:ss.xxxZ"

   Status="IN_PROGRESS|COMPLETED|CANCELED"

   UserId="{string}"
   UserName="{string}">
   <Nodes>

      <Node EndPoint="{string}" Id="{string}"/>

   </Nodes>

   <Objects

      ChunkId="{string}"

      ChunkNumber="{32-bit integer}">

      <Object Id="{string}" InCache="TRUE|FALSE"

         Latest="TRUE|FALSE" Length="{64-bit integer}"

         Name="{string}" Offset="{64-bit integer}"

         VersionID="{string}"/>

      ...

   </Objects>

   ...

</MasterObjectList>

where the response elements are defined as follows:

Parameter Description

MasterObjectList The container for the response.
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Parameter Description

Aggregating Whether the job can have additional PUTs or GETs appended to it. Jobs
aggregate if created with the aggregating request parameter set to
TRUE, or if created by the BlackPearl gateway in response to Amazon S3
PUT and GET requests. Values: TRUE, FALSE

BucketName The name of the bucket that is acted on by the job request.

CachedSizeInBytes The amount of data that has been transferred to the cache for this job. For
RequestType=PUT, this is the amount of data successfully transferred to
the BlackPearl gateway from the client.

ChunkClient
ProcessingOrder
Guarantee

Specifies whether the job chunks will be processed in order. Values: IN_
ORDER, NONE

CompletedSizeIn
Bytes

The amount of data that is completely processed for this job. For
RequestType=PUT, this indicates the amount of data written to all
permanent data stores.

EntirelyInCache Whether all objects in the job are in the BlackPearl cache.
Values: TRUE, FALSE

JobId The UUID for the job.

Naked Whether the job was created as the result of a native S3 command (TRUE)
or a Create Bulk GET/PUT/VERIFY job command (FALSE). Values: TRUE,
FALSE

Name The name assigned to the job for tracking.

OriginalSizeInBytes The full size of the job.

Priority The priority for processing this job. The job priority determines the
assigned resources and processing order. Values: CRITICAL, URGENT,
HIGH, NORMAL, LOW, BACKGROUND

RequestType Type of job request. Values: PUT

StartDate The date and time the job was started in the format YYYY-MM-
DDThh:mm:ss.xxxZ.
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Parameter Description

Status The current status of the job.
Values:
• IN_PROGRESS — The job is currently running.
• COMPLETED — The job completed.
• CANCELED — The job was canceled by the user or automatically due to
internal timeouts.

UserId The UUID for the user who initiated the job.

UserName The username of the user who initiated the job.

Nodes A container for information about all BlackPearl nodes.

Node A container for information about a single BlackPearl node.

EndPoint The IP address or DNS name of the BlackPearl node.

Id The UUID for the node.

Objects Container for information about the objects in one chunk.

ChunkId The UUID for the job chunk.

ChunkNumber The position of the chunk within the job.

Object The container for information about a single object.

Id The UUID for the object.

InCache Indicates if the object is currently in cache on the BlackPearl gateway.
Values: TRUE, FALSE

Latest Whether this version of the object is the latest.
Values: TRUE, FALSE

Length The length in bytes of the object.

Name The name of the object.

Offset The offset in bytes from the start of the object.

VersionId The UUID of the version of the object.
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Example

Sample Request
This request sent to “blackpearl-hostname2” with the response from the example for Get Job
to Replicate on page 179, creates a bulk PUT job on “blackpearl-hostname2” identical to the
job on the BlackPearl gateway on which Get Job to Replicate ran.
PUT http://blackpearl-hostname2/_rest_/bucket/bucket1/?operation=start_bulk_

put&replicate HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<MasterObjectList

   Aggregating="FALSE"

   BucketName="existing_bucket"

   CachedSizeInBytes="0"

   ChunkClientProcessingOrderGuarantee="IN_ORDER"

   CompletedSizeInBytes="0"

   EntirelyInCache="FALSE"
   JobId="cce39f77-7570-48e1-92de-235a5b282c1d"

   Naked="FALSE"

   Name="Untitled"

   OriginalSizeInBytes="10"

   Priority="NORMAL"

   RequestType="PUT"
   StartDate="2016-01-21T18:54:21.000Z"

   Status="IN_PROGRESS"

   UserId="d0bf86e8-7bba-4507-a0f0-2698fb8fccfa"

   UserName="test_user">
   <Nodes>

      <Node EndPoint="blackpearl-hostname"

      Id="a651430c-22aa-468b-8b4b-42b50627faf3"/>

   </Nodes>

   <Objects

      ChunkId="4294b5c2-b4ae-46db-8aca-858805a7a116"

      ChunkNumber="1">

      <Object Id="58fa3a04-7711-49b8-aaba-93b91eb93145"

         InCache="FALSE" Latest="TRUE" Length="10"

         Name="o1" Offset="0"

         VersionId="536d118c-d58c-4a6e-9fb5-5bd299b76808"/>

   </Objects>

</MasterObjectList>
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STAGE OBJECTS

Description
Create a job to stage objects into a temporary pool, if available, or the cache.

IMPORTANT The BlackPearl gateway processes a maximum of 1,000 concurrent active jobs.

Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/bucket/{bucket UUID or

name}/?operation=START_BULK_STAGE[&name={string}][&priority=URGENT|HIGH|NORMAL|LOW]

Request Parameters

Parameter Description Required

operation The operation to perform. For this request, the operation is to start a
bulk stage. Value: START_BULK_STAGE

yes

name A name to assign to the job for tracking. no

priority The priority for processing this job. The job priority determines the
assigned resources and processing order. Jobs with Priority
URGENT can use up all of the resources and prevent other jobs from
making progress. Use this priority sparingly.
Values: URGENT, HIGH, NORMAL, LOW
Default: Configured in the data policy for the bucket.

no

Request Elements
An XML payload, formatted as follows, must be sent to describe the staging job to create:
<Objects

   <Object Name="{string}" Length="{64-bit integer}"

      Offset="{64-bit integer}" Version_Id="{string}"/>

   ...

</Objects>
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where the parameters are defined as follows:

Parameter Description Required

Objects A container for the list of objects. yes

Object The container for information about one object. yes

Name The name of an object to GET. All objects in the list must be in the
same bucket.

yes

Length The length in bytes to get. no

Offset The offset in bytes from the start of the object to start the get. no

Version_Id The UUID for the version of the object. no

Responses

Response Elements
<MasterObjectList

   Aggregating="TRUE|FALSE"

   BucketName="{string}"

   CachedSizeInBytes="{64-bit integer}"

   ChunkClientProcessingOrderGuarantee="IN_ORDER|NONE"

   CompletedSizeInBytes="{64-bit integer}"

   EntirelyInCache="TRUE|FALSE"
   JobId="{string}"

   Naked="TRUE|FALSE"

   Name="{string}"

   OriginalSizeInBytes="{64-bit integer}"

   Priority="CRITICAL|URGENT|HIGH|NORMAL|LOW|BACKGROUND"
   RequestType="GET"

   StartDate="YYYY-MM-DDThh:mm:ss.xxxZ"

   Status="IN_PROGRESS|COMPLETED|CANCELED"

   UserId="{string}"

   UserName="{string}">
   <Nodes>

      <Node EndPoint="{string}" Id="{string}"/>

   </Nodes>
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   <Objects

      ChunkId="{string}"

      ChunkNumber="{32-bit integer}">

      <Object Id="{string}" InCache="TRUE|FALSE"

         Latest="TRUE|FALSE" Length="{64-bit integer}"

         Name="{string} "Offset="{64-bit integer}"

         VersionId="{string}"/>

      ...

   </Objects>

   ...

</MasterObjectList>

where the response elements are defined as follows:

Parameter Description

MasterObjectList The BlackPearl gateway container for the response.

Aggregating Whether the job can have additional PUTs or GETs appended to it. Jobs
aggregate if created with the aggregating request parameter set to
TRUE, or if created by the BlackPearl gatewayBlackPearl gateway in
response to Amazon S3 PUT and GET requests. Values: TRUE, FALSE

BucketName The name of the bucket that is acted on by the job request.

CachedSizeInBytes The amount of data that has been transferred to the cache for this job. For
RequestType=GET, this is the amount of data either in cache originally,
or loaded into cache from the permanent data store.

ChunkClient
ProcessingOrder
Guarantee

Specifies whether the job chunks will be processed in order. Values: IN_
ORDER, NONE

CompletedSizeIn
Bytes

The amount of data that is completely processed for this job. For
RequestType=GET, this indicates the amount of data that has been read
successfully by the client.

EntirelyInCache Whether all objects in the job are in the BlackPearl cache.
Values: TRUE, FALSE

JobId The UUID for the job.

Naked Whether the job was created as the result of a native S3 command (TRUE)
or a Create Bulk GET/PUT/VERIFY job command (FALSE). Values: TRUE,
FALSE

Name The name assigned to the job for tracking.
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Parameter Description

OriginalSizeInBytes The full size of the job.

Priority The priority for processing this job. The job priority determines the
assigned resources and processing order.
Values: CRITICAL, URGENT, HIGH, NORMAL, LOW, BACKGROUND

RequestType Type of job request. Values: GET

StartDate The date and time the job was started in the format YYYY-MM-
DDThh:mm:ss.xxxZ.

Status The current status of the job.
Values:
• IN_PROGRESS — The job is currently running.
• COMPLETED — The job completed.
• CANCELED — The job was canceled by the user or automatically due to
internal timeouts.

UserId The UUID for the user who initiated the job.

UserName The username of the user who initiated the job.

Nodes A container for information about all BlackPearl nodes.

Node A container for information about a single BlackPearl node.

EndPoint The IP address or DNS name of the BlackPearl node.

Id The UUID for the node.

Objects Container for information about the objects in one chunk.

ChunkId The UUID for the job chunk.

ChunkNumber The position of the chunk within the job.

Object The container for information about a single object.

Id The UUID for the object.

InCache Indicates if the object is currently in cache on the BlackPearl gateway.
Values: TRUE, FALSE

Latest Whether this version of the object is the latest.
Values: TRUE, FALSE
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Parameter Description

Length The length in bytes of the object.

Name The name of the object.

Offset The offset in bytes from the start of the object.

VersionId The UUID for the version of the object.

Example

Error Response
If one or more objects requested only exist on tapes outside of the library, then the following
response is provided:
<Error>

   <Code>CONFLICT</Code>

   <HttpErrorCode>409</HttpErrorCode>

   <Message>

     RPC DataPlanner.createGetJob&lt;60821823&gt; FAILED:

     Some of the data requested is offline (e.g. ejected, offline,

     or quiesced) and must first be brought online. Online:

[TEST079L7]

   </Message>

   <Resource>/_rest_/bucket/eject</Resource>

   <ResourceId>40727470</ResourceId>

</Error>

Import and online the tape with the requested barcode. In the example above, the required
tape is TEST079L7.

Example

Sample Request
This request creates a staging job for one object in the bucket “bucket1”.
PUT http://blackpearl-hostname/_rest_/bucket/bucket1/?operation=start_bulk_

stage&name="StageJob" HTTP/1.1
<Objects

   <Object Name="o1" Length="10" Offset="10" Version_Id="1"/>

   ...

</Objects>
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Sample Response
HTTP/1.1 200 OK

<MasterObjectList

   Aggregating="FALSE"

   BucketName="bucket1"

   CachedSizeInBytes="0"

   ChunkClientProcessingOrderGuarantee="IN_ORDER"

   CompletedSizeInBytes="0"

   EntirelyInCache="FALSE"
   JobId="78dba377-a02a-4c15-b2a1-412514342f17"

   Naked="FALSE"

   Name="StageJob"

   OriginalSizeInBytes="0"

   Priority="NORMAL"

   RequestType="STAGE"

   StartDate="2018-1-07T22:33:17.000Z"

   Status="IN_PROGRESS"

   UserId="a6a04b3d-960a-4799-9c88-6801f5cf5449"

   UserName="user_name">
   <Nodes>

      <Node EndPoint="blackpearl-hostname"

      Id="aed40ca0-5289-49ca-9cd9-cf5a7559a1db"/>

   </Nodes>
   <Objects

      ChunkId="a909e72e-a96a-4c3e-95a3-f3472e14ae17"

      ChunkNumber="1">

      <Object Id="2ee4f397-c169-4a59-96cc-a07280412f43"

         InCache="FALSE" Latest="TRUE" Length="10"

         Name="o1" Offset="10"

         VersionId="536d118c-d58c-4a6e-9fb5-5bd299b76808"/>

   </Objects>

</MasterObjectList>
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TRUNCATE ACTIVE JOB

Description
Cancel the specified job that is in progress. Any objects in the job that were written in their
entirety to physical data stores are retained. Any objects in the job that were received in their
entirety in cache are retained. The BlackPearl gateway does not expect any more objects from
the job.

Note: This command is an alias for Truncate Job on page 258.

Requests

Syntax
DELETE http[s]://{datapathDNSname}/_rest_/active_job/{job_id}/

To determine the UUID for a job, see Get Active Jobs on page 190.

Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 403: Forbidden (user does not have permission to cancel the job)
• 404: Not Found

Example

Sample Request
This request truncates the job with the UUID d79c9e54-0c4f-4e82-8e99-218b03ab02cb.
DELETE http://blackpearl-hostname/_rest_/active_job/d79c9e54-0c4f-4e82-8e99-

218b03ab02cb/ HTTP/1.1

Sample Response
HTTP/1.1 204 No Content
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TRUNCATE ACTIVE JOBS

Description
Cancel all jobs that are in progress. Any objects in the jobs that were written in their entirety
to physical data stores are retained. Any objects in the jobs that were received in their entirety
in cache are retained. The BlackPearl gateway does not expect any more objects from the jobs.
Use parameters to cancel a subset of the jobs.

Note: This command is an alias for Truncate Jobs on page 259.

Requests

Syntax
DELETE http[s]://{datapathDNSname}/_rest_/active_job/[?bucket_id={string}][&request_

type=PUT|GET|VERIFY]

Request Parameters

Parameter Description Required

bucket_id 1 The UUID, name, or other unique identifier for the bucket on which
the job is operating.

no

request_type Type of job request. Values: GET, PUT, VERIFY no

Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 403: Forbidden (user does not have permission to cancel the jobs)

1) Parameter values can use wild cards (see Wild Card Syntax on page 30).
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Example

Sample Request
This request truncates all jobs in progress.
DELETE http://blackpearl-hostname/_rest_/active_job/ HTTP/1.1

Sample Response
HTTP/1.1 204 No Content

TRUNCATE JOB

Description
Cancel the specified job that is in progress. Any objects in the job that were written in their
entirety to physical data stores are retained. Any objects in the job that were received in their
entirety in cache are retained. The BlackPearl gateway does not expect any more objects from
the job.

Note: This command is an alias for Cancel Active Job on page 152.

Requests

Syntax
DELETE http[s]://{datapathDNSname}/_rest_/job/{job_id}/

To determine the UUID for a job, see Get Jobs on page 229.

Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 403: Forbidden (user does not have permission to cancel the job)
• 404: Not Found
• 409: Error
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Example

Sample Request
This request truncates the job with the UUID 77bd575b-35c7-4586-b0c3-15bd5023c9d7.
DELETE http://blackpearl-hostname/_rest_/job/77bd575b-35c7-4586-b0c3-15bd5023c9d7/

HTTP/1.1

Sample Response
HTTP/1.1 204 No Content

TRUNCATE JOBS

Description
Cancel all jobs that are in progress. Any objects in the jobs that were written in their entirety
to physical data stores are retained. Any objects in the jobs that were received in their entirety
in cache are retained. The BlackPearl gateway does not expect any more objects from the jobs.
Use parameters to cancel a subset of the jobs.

Note: This command is an alias for Cancel Active Jobs on page 154.

Requests

Syntax
DELETE http[s]://{datapathDNSname}/_rest_/job/[?bucket_id={string}][&request_

type=PUT|GET|VERIFY]

Request Parameters

Parameter Description Required

bucket_id 1 The UUID, name, or other unique identifier for the bucket on which
the job is operating.

no

request_type Type of job request. Values: GET, PUT, VERIFY no

1) Parameter values can use wild cards (see Wild Card Syntax on page 30).
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Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 403: Forbidden (user does not have permission to cancel the jobs)

Example

Sample Request
This request truncates all jobs in progress.
DELETE http://blackpearl-hostname/_rest_/job/ HTTP/1.1

Sample Response
HTTP/1.1 204 No Content

VERIFY THAT IT IS SAFE TO CREATE A PUT JOB

Description
Determines if the specified user can safely create a PUT job for the specified bucket at this
time. It is not safe to create a PUT job if either of the following are true:

• There is at least one storage domain that cannot write because all of its members are
quiesced, offline, in an error state, or otherwise unavailable.

• There are system failures that are likely to prevent data from being written.

Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/bucket/{bucket name, UUID, or other unique

attribute}/?operation=VERIFY_SAFE_TO_START_BULK_PUT
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Request Parameters

Parameter Description Required

operation The operation to perform. For this request, the operation is to verify
that it is safe to start bulk PUT.
Value: VERIFY_SAFE_TO_START_BULK_PUT

yes

Responses

Response Elements
The operation returns status only.

Notable status codes:

• 200: OK
• 404: Not Found
• 409: Conflict

Example

Sample Request
This request verifies whether it is safe for the current user to start a PUT job to the bucket
named ‘bucket1’.
PUT http://blackpearl-hostname/_rest_/bucket/bucket1/?operation=VERIFY_SAFE_TO_

START_BULK_PUT HTTP/1.1

Sample Response
HTTP/1.1 200 OK
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VOLUME C - ACCESS CONTROL
OPERATIONS

This section describes operations that controls with users and groups can access which
buckets and data policies.

• Access Control List Operations on page 263

• Group Operations on page 290

• User Operations on page 308
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OPERATIONS

This section describes operations working with Access Control Lists (ACLs). ACLs grant a
specified permission to a specified group or user. Bucket ACLs grant permission to list
objects, read objects, write objects, or delete objects in the bucket, modify or delete jobs, or do
anything that the bucket owner can do (permission to do all other operations). Data policy
ACLs grant permission to use the specified data policy.

Create Bucket ACL for a Group 264

Create Bucket ACL for a User 266

Create Data Policy ACL for a Group 268

Create Data Policy ACL for a User 270

Create Global Bucket ACL for a Group 272

Create Global Bucket ACL for a User 274

Create Global Data Policy ACL for a Group 276

Create Global Data Policy ACL for a User 277

Delete Bucket ACL 279

Delete Data Policy ACL 280

Get Bucket ACL 281

Get Bucket ACLs 283

Get Data Policy ACL 285

Get Data Policy ACLs 287
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CREATE BUCKET ACL FOR A GROUP

Description
Create an ACL for a bucket, granting the specified permission to the specified group.

Notes:

• Only administrators and users with OWNER access to the bucket are allowed to
create an ACL for it.

• A single operation can only grant one permission. To grant multiple
permissions, submit the request multiple times with different permissions
specified.

Requests

Syntax
POST http[s]://{datapathDNSname}/_rest_/bucket_acl/?bucket_id={string}&group_id=

{string}&permission=LIST|READ|WRITE|DELETE|JOB|OWNER

Request Parameters 

Parameter Description Required

bucket_id The UUID, name, or other unique attribute for the bucket. yes

group_id The UUID, name, or other unique attribute for the group to which
you want to grant the specified permission.

yes
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Parameter Description Required

permission The type of permission to grant to each user that is a member of the
group.
• LIST — The users in the group can see the bucket in a get buckets
request and can list the objects in a bucket. The users can also
perform any type of bucket or object get that does not involve
returning the actual data for an object.

• READ — The users can get objects and create GET jobs.
• WRITE — The users can put objects and create PUT jobs.
• DELETE — The users can delete objects, but cannot delete the
bucket.

• JOB — The group members can modify or cancel jobs that they
did not create. The users can also see the details of jobs they did
not create. Note that all users can view all jobs, but by default,
only the initiator of the job can see the full details of a job.

• OWNER — The users receives full access to the bucket, including
all permissions listed above, and also receives permission to
modify bucket ACLs for that bucket.

Values: LIST, READ, WRITE, DELETE, JOB, OWNER

yes

Responses

Response Elements
<Data>

   <BucketId>{string}</BucketId>

   <GroupId>{string}</GroupId>

   <Id>{string}</Id>
   <Permission>LIST|READ|WRITE|DELETE|JOB|OWNER</Permission>
   <UserId>{string}</UserId>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

BucketId The UUID for the bucket.

GroupId The UUID for the group granted permission.

Id The UUID for the ACL.
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Parameter Description

Permission The permission granted by this ACL. See permission on page 265, above, for a
description.
Values: LIST, READ, WRITE, DELETE, JOB, OWNER

UserId Always null for this operation.

Example

Sample Request
This request creates an ACL for the group with the UUID 241e5aa4-e821-4a72-a8d7-
bd4ee3ad80bb to be able to list objects in the bucket with the name “bucket1”.
POST http[s]://blackpearl-hostname/_rest_/bucket_acl/?bucket_id=bucket1&group_

id=241e5aa4-e821-4a72-a8d7-bd4ee3ad80bb&permission=list HTTP/1.1

Sample Response
HTTP/1.1 201 CREATED

<Data>

   <BucketId>49c78eaf-bd36-4d31-8561-cae9857954f4</BucketId>

   <GroupId>241e5aa4-e821-4a72-a8d7-bd4ee3ad80bb</GroupId>

   <Id>371c7ca9-a776-4b6a-810f-a1d8e074a915</Id>
   <Permission>LIST</Permission>
   <UserId/>

</Data>

CREATE BUCKET ACL FOR A USER

Description
Create an ACL for a bucket, granting the specified permission to the specified user.

Notes:

• Only administrators and users with OWNER access to the bucket are allowed to
create an ACL for it.

• A single operation can only grant one permission. To grant multiple
permissions, submit the request multiple times with different permissions
specified.
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Requests

Syntax
POST http[s]://{datapathDNSname}/_rest_/bucket_acl/?bucket_id=

{string}&permission=LIST|READ|WRITE|DELETE|JOB|OWNER&user_id={string}

Request Parameters 

Parameter Description Required

bucket_id The UUID, name, or other unique attribute for the bucket. yes

permission The type of permission to grant. See permission on page 265 for a
description.
Values: LIST, READ, WRITE, DELETE, JOB, OWNER

yes

user_id The UUID, username, or other unique attribute for the user to
whom you want to grant the specified permission.

yes

Responses

Response Elements
<Data>

   <BucketId>{string}</BucketId>

   <GroupId>{string}</GroupId>

   <Id>{string}</Id>
   <Permission>LIST|READ|WRITE|DELETE|JOB|OWNER</Permission>
   <UserId>{string}</UserId>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

BucketId The UUID for the bucket.

GroupId Always null for this operation.

Id The UUID for the ACL.
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Parameter Description

Permission The permission granted by this ACL. See permission on page 265 for a
description.
Values: LIST, READ, WRITE, DELETE, JOB, OWNER

UserId The UUID for the user granted permission.

Example

Sample Request
This request creates an ACL for the user with the UUID bc2b161c-e7fb-4f08-bddd-
65bb3cb56ebc to be able to list objects in the bucket with the name “bucket2”.
POST http[s]://blackpearl-hostname/_rest_/bucket_acl/?bucket_id=bucket2&user_

id=bc2b161c-e7fb-4f08-bddd-65bb3cb56ebc&permission=list HTTP/1.1

Sample Response
HTTP/1.1 201 CREATED

<Data>

   <BucketId>c76ab540-9ef6-4665-bd81-af0cce744ef6</BucketId>

   <GroupId/>

   <Id>d476fe78-d76b-40d6-ad64-1d2c130425d3</Id>
   <Permission>LIST</Permission>
   <UserId>bc2b161c-e7fb-4f08-bddd-65bb3cb56ebc</UserId>

</Data>

CREATE DATA POLICY ACL FOR A GROUP

Description
Create an ACL for a data policy, granting the specified group access to use the data policy.

Notes:

• Only administrators are allowed to create a data policy ACL.

• Users that do not have data policy ACL access to any data policies cannot create
a bucket.
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Requests

Syntax
POST http[s]://{datapathDNSname}/_rest_/data_policy_acl/?data_policy_id=

{string}&group_id={string}

Request Parameters 

Parameter Description Required

data_policy_
id

The UUID, name, or other unique attribute for the data policy. yes

group_id The UUID, name, or other unique attribute for the group to which
you want to grant access to use the data policy.

yes

Responses

Response Elements
<Data>

   <DataPolicyId>{string}</DataPolicyId>

   <GroupId>{string}</GroupId>

   <Id>{string}</Id>
   <UserId>{string}</UserId>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

DataPolicyId The UUID for the data policy.

GroupId The UUID for the group granted access.

Id The UUID for the ACL.

UserId Always null for this operation.
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Example

Sample Request
This request creates an ACL for the group with the UUID f98d5bc9-e4ab-4abc-94fd-
87ea7619c5b6 to be able to use the data policy with the name “dp1”.
POST http[s]://blackpearl-hostname/_rest_/data_policy_acl/?data_policy_id=dp1&group_

id=f98d5bc9-e4ab-4abc-94fd-87ea7619c5b6 HTTP/1.1

Sample Response
HTTP/1.1 201 CREATED

<Data>

   <DataPolicyId>

      6ede1b61-6113-4904-acef-82e0c27efd58

   </DataPolicyId>

   <GroupId>f98d5bc9-e4ab-4abc-94fd-87ea7619c5b6</GroupId>

   <Id>d17f7f75-678f-4c06-9ba9-469ad424b0c1</Id>
   <UserId/>

</Data>

CREATE DATA POLICY ACL FOR A USER

Description
Create an ACL for a data policy, granting the specified user access to use the data policy.

Notes:

• Only administrators are allowed to create a data policy ACL.

• Users that do not have data policy ACL access to any data policies cannot create
a bucket.

• By default, the BlackPearl gateway creates a global data policy ACL for the
“everyone” group, granting every user access to use every data policy.

Requests

Syntax
POST http[s]://{datapathDNSname}/_rest_/data_policy_acl/?data_policy_id=

{string}&user_id={string}
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Request Parameters 

Parameter Description Required

data_policy_
id

The UUID, name, or other unique attribute for the data policy. yes

user_id The UUID, username, or other unique attribute for the user to
whom you want to grant access to use the data policy.

yes

Responses

Response Elements
<Data>

   <DataPolicyId>{string}</DataPolicyId>

   <GroupId>{string}</GroupId>

   <Id>{string}</Id>
   <UserId>{string}</UserId>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

DataPolicyId The UUID for the data policy.

GroupId Always null for this operation.

Id The UUID for the ACL.

UserId The UUID for the user granted access.

Example

Sample Request
This request creates an ACL for the user with the username user1 to be able to use the data
policy with the name “dp1”.
POST http[s]://blackpearl-hostname/_rest_/data_policy_acl/?data_policy_id=dp1&user_

id=user1 HTTP/1.1
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Sample Response
HTTP/1.1 201 CREATED

<Data>

   <DataPolicyId>

      6ede1b61-6113-4904-acef-82e0c27efd58

   </DataPolicyId>

   <GroupId/>

   <Id>5e5812aa-74f0-4e82-879e-d0adcbacdee5</Id>
   <UserId>c3407618-ff6c-4f5f-8aab-1b17d6881612</UserId>

</Data>

CREATE GLOBAL BUCKET ACL FOR A GROUP

Description
Create an ACL for all buckets, including those already created and those that will be created,
granting the specified permission to the specified group.

Note: Only administrators are allowed to create a global bucket ACL.

Requests

Syntax
POST http[s]://{datapathDNSname}/_rest_/bucket_acl/?group_id=

{string}&permission=LIST|READ|WRITE|DELETE|JOB|OWNER

Request Parameters 

Parameter Description Required

group_id The UUID, name, or other unique attribute for the group to which
you want to grant the specified permission.

yes

permission The type of permission to grant. See permission on page 265 for a
description.
Values: LIST, READ, WRITE, DELETE, JOB, OWNER

yes
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Responses

Response Elements
<Data>

   <BucketId>{string}</BucketId>

   <GroupId>{string}</GroupId>

   <Id>{string}</Id>
   <Permission>LIST|READ|WRITE|DELETE|JOB|OWNER</Permission>
   <UserId>{string}</UserId>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

BucketId Always null for this operation.

GroupId The UUID for the group granted permission.

Id The UUID for the ACL.

Permission The permission granted by this ACL. See permission on page 265 for a
description.
Values: LIST, READ, WRITE, DELETE, JOB, OWNER

UserId Always null for this operation.

Example

Sample Request
This request creates an ACL for the group with the UUID 1afdf1e6-2f60-4765-89b1-
bf8c09d7b8a8 to be able to list objects in all buckets.
POST http[s]://blackpearl-hostname/_rest_/bucket_acl/?permission=list&group_

id=1afdf1e6-2f60-4765-89b1-bf8c09d7b8a8 HTTP/1.1
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Sample Response
HTTP/1.1 201 CREATED

<Data>

   <BucketId/>

   <GroupId>1afdf1e6-2f60-4765-89b1-bf8c09d7b8a8</GroupId>

   <Id>dca36600-5b3b-405e-a368-e631e78a338d</Id>
   <Permission>LIST</Permission>
   <UserId/>

</Data>

CREATE GLOBAL BUCKET ACL FOR A USER

Description
Create an ACL for all buckets, including those already created and those that will be created,
granting the specified permission to the specified user.

Note: Only administrators are allowed to create a global bucket ACL.

Requests

Syntax
POST http[s]://{datapathDNSname}/_rest_/bucket_

acl/?permission=LIST|READ|WRITE|DELETE|JOB|OWNER&user_id={string}

Request Parameters 

Parameter Description Required

permission The type of permission to grant. See permission on page 265 for a
description.
Values: LIST, READ, WRITE, DELETE, JOB, OWNER

yes

user_id The UUID, username, or other unique attribute for the user to
whom you want to grant the specified permission.

yes
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Responses

Response Elements
<Data>

   <BucketId>{string}</BucketId>

   <GroupId>{string}</GroupId>

   <Id>{string}</Id>
   <Permission>LIST|READ|WRITE|DELETE|JOB|OWNER</Permission>
   <UserId>{string}</UserId>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

BucketId Always null for this operation.

GroupId Always null for this operation.

Id The UUID for the ACL.

Permission The permission granted by this ACL. See permission on page 265 for a
description.
Values: LIST, READ, WRITE, DELETE, JOB, OWNER

UserId The UUID for the user granted permission.

Example

Sample Request
This request creates an ACL for the user with the UUID ceb405c4-aa4e-4b1d-9e93-
312c40901671 to be able to list objects in all buckets.
POST http[s]://blackpearl-hostname/_rest_/bucket_acl/?permission=list&user_

id=ceb405c4-aa4e-4b1d-9e93-312c40901671 HTTP/1.1
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Sample Response
HTTP/1.1 201 CREATED

<Data>

   <BucketId/>

   <GroupId/>

   <Id>72475859-6b28-46f8-b105-068cd87347b3</Id>
   <Permission>LIST</Permission>
   <UserId>ceb405c4-aa4e-4b1d-9e93-312c40901671</UserId>

</Data>

CREATE GLOBAL DATA POLICY ACL FOR A GROUP

Create an ACL for all data policies, including those already created and those that will be
created, granting the specified group access to use any data policy.

Note: Only administrators are allowed to create a global data policy ACL.

Requests

Syntax
POST http[s]://{datapathDNSname}/_rest_/data_policy_acl/?group_id={string}

Request Parameters 

Parameter Description Required

group_id The UUID, name, or other unique attribute for the group to which
you want to grant permission to use all data policies.

yes

Responses

Response Elements
<Data>

   <DataPolicyId>{string}</DataPolicyId>

   <GroupId>{string}</GroupId>

   <Id>{string}</Id>
   <UserId>{string}</UserId>

</Data>
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where the response elements are defined as follows:

Parameter Description

Data The container for the response.

DataPolicyId Always null for this operation.

GroupId The UUID for the group granted access.

Id The UUID for the ACL.

UserId Always null for this operation.

Example

Sample Request
This request creates an ACL for the group with the UUID 29090054-ecfb-4d64-8e68-
87194b8a1c35 to be able to use any data policy.
POST http[s]://blackpearl-hostname/_rest_/data_policy_acl/?group_id=29090054-ecfb-

4d64-8e68-87194b8a1c35 HTTP/1.1

Sample Response
HTTP/1.1 201 CREATED

<Data>

   <DataPolicyId/>

   <GroupId>29090054-ecfb-4d64-8e68-87194b8a1c35</GroupId>

   <Id>dbb1643e-081e-4f32-b26f-ba5dd80d77c4</Id>
   </UserId>

</Data>

CREATE GLOBAL DATA POLICY ACL FOR A USER

Create an ACL for all data policies, including those already created and those that will be
created, granting the specified user access to use any data policy.

Note: Only administrators are allowed to create a global data policy ACL.
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Requests

Syntax
POST http[s]://{datapathDNSname}/_rest_/data_policy_acl/?user_id={string}

Request Parameters 

Parameter Description Required

user_id The UUID, username, or other unique attribute for the user to
whom you want to grant permission to use all data policies.

yes

Responses

Response Elements
<Data>

   <DataPolicyId>{string}</DataPolicyId>

   <GroupId>{string}</GroupId>

   <Id>{string}</Id>
   <UserId>{string}</UserId>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

DataPolicyId Always null for this operation.

GroupId Always null for this operation.

Id The UUID for the ACL.

UserId The UUID for the user granted access.
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Example

Sample Request
This request creates an ACL for the user with the UUID 817e7fd2-6516-48fa-be69-
4b07667543bc to be able to use any data policy.
POST http[s]://blackpearl-hostname/_rest_/data_policy_acl/?user_id=817e7fd2-6516-

48fa-be69-4b07667543bc HTTP/1.1

Sample Response
HTTP/1.1 201 CREATED

<Data>

   <DataPolicyId/>

   <GroupId/>

   <Id>0e61eb85-8715-46c0-9c6b-ec3d3e26203c</Id>
   <UserId>817e7fd2-6516-48fa-be69-4b07667543bc</UserId>

</Data>

DELETE BUCKET ACL
Deletes the specified bucket ACL.

Notes:

• If the ACL being deleted is global (applies across all buckets), the operation is
only allowed for administrators.

• If the ACL being deleted is specific to a bucket, the operation is allowed for the
bucket owners and administrators.

Requests

Syntax
DELETE http[s]://{datapathDNSname}/_rest_/bucket_acl/{ACL UUID or other unique

attribute}/

To determine the UUID for an ACL, see Get Bucket ACLs on page 283.
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Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 403: Access Denied
• 404: Not Found

Example

Sample Request
This request deletes the bucket ACL with the UUID d5854e48-7226-4c06-ab11-15489e917176.
DELETE http://blackpearl-hostname/_rest_/bucket_acl/d5854e48-7226-4c06-ab11-

15489e917176/ HTTP/1.1

Sample Response
HTTP/1.1 204 No Content

DELETE DATA POLICY ACL
Deletes the specified data policy ACL.

Note: Only administrators are allowed to delete a data policy ACL.

Requests

Syntax
DELETE http[s]://{datapathDNSname}/_rest_/data_policy_acl/{ACL UUID or other unique

attribute}/

To determine the UUID for an ACL, see Get Data Policy ACLs on page 287.
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Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 403: Access Denied
• 404: Not Found

Example

Sample Request
This request deletes the data policy ACL with the UUID 0448f895-aeb2-446f-a20d-
b056a451b3b2.
DELETE http://blackpearl-hostname/_rest_/data_policy_acl/0448f895-aeb2-446f-a20d-

b056a451b3b2/ HTTP/1.1

Sample Response
HTTP/1.1 204 No Content

GET BUCKET ACL
Get information about the specified bucket ACL.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/bucket_acl/{ACL UUID or other unique

attribute}/

To determine the UUID for an ACL, see Get Bucket ACLs on page 283.
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Responses

Response Elements
<Data>

   <BucketId>{string}</BucketId>

   <GroupId>{string}</GroupId>

   <Id>{string}</Id>
   <Permission>LIST|READ|WRITE|DELETE|JOB|OWNER</Permission>
   <UserId>{string}</UserId>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

BucketId The UUID for the bucket.

GroupId The UUID for the group granted permission.

Id The UUID for the ACL.

Permission The permission granted by this ACL. See permission on page 265 for a
description.
Values: LIST, READ, WRITE, DELETE, JOB, OWNER

UserId The UUID of the user granted permission.

Example

Sample Request
This request gets information about the bucket ACL with UUID 48b0b0fe-0554-4b96-929c-
37c842c80e55.
GET http[s]://blackpearl-hostname/_rest_/bucket_acl/48b0b0fe-0554-4b96-929c-

37c842c80e55/ HTTP/1.1
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Sample Response
HTTP/1.1 200 OK

<Data>

   <BucketId>29116f1d-fd37-4d8b-9501-448f51d8eb81</BucketId>

   <GroupId/>

   <Id>48b0b0fe-0554-4b96-929c-37c842c80e55</Id>
   <Permission>OWNER</Permission>
   <UserId>a8040c5d-9066-438e-8451-2ea26ca27115</UserId>

</Data>

GET BUCKET ACLS

Get information about all bucket ACLs for the specified bucket. Use parameters as selection
criteria to return a subset of the list.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/bucket_acl/?bucket_id={string}[&group_id=

{string}][&last_page][&page_length={32-bit integer}][&page_offset={32-bit integer}]

[&page_start_marker={string}][&permission=LIST|READ|WRITE|DELETE|JOB|OWNER][&user_

id={string}]

Request Parameters

Parameter Description Required

bucket_id The UUID, name, or other unique attribute for the bucket. no

group_id 1 The UUID, name, or other unique attribute for the group. no

last_page If included, only the last page of results is returned. no

page_length The maximum number of ACLs to list.
Default: all items after page_offset.

no

page_offset The starting point for the first ACL to list. Default: 0. no

1) Parameter values can use wild cards (see Wild Card Syntax on page 30).
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Parameter Description Required

page_start_
marker

The UUID or other unique attribute for the item just before the first
item to list.
Notes:
• Specifying both page_offset and page_start_marker
causes an error.

• If neither page_offset, nor page_start_marker are
specified, the page_offset default is used.

no

permission The permission granted by the ACL. See permission on page 265
for a description.
Values: LIST, READ, WRITE, DELETE, JOB, OWNER

no

user_id 1 The UUID, username, or other unique attribute for the user. no

Responses

Response Elements
<Data>

   <BucketAcl>

      <BucketId>{string}</BucketId>

      <GroupId>{string}</GroupId>

      <Id>{string}</Id>
      <Permission>LIST|READ|WRITE|DELETE|JOB|OWNER</Permission>
      <UserId>{string}</UserId>
   <BucketAcl>

   ...

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

BucketAcl The container for information about one ACL.

BucketId The UUID for the bucket.

GroupId The UUID for the group granted permission.

Id The UUID for the ACL.
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Parameter Description

Permission The permission granted by this ACL. See permission on page 265 for a
description.
Values: LIST, READ, WRITE, DELETE, JOB, OWNER

UserId The UUID of the user granted permission.

Example

Sample Request
This request gets information about the ACLs for the bucket with the name “bucket1”.
GET http[s]://blackpearl-hostname/_rest_/bucket_acl/?bucket_id=bucket1 HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>

   <BucketAcl>

      <BucketId>a4752f84-f206-4273-bee3-ede8e279e292</BucketId>

      <GroupId/>

      <Id>11d71c40-629e-478a-bfae-514e83a154f2</Id>
      <Permission>OWNER</Permission>
      <UserId>9adea849-42ae-4d94-ad86-85a113a63991</UserId>

   </BucketAcl>

</Data>

GET DATA POLICY ACL
Get information about the specified data policy ACL.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/data_policy_acl/{ACL UUID or other unique

attribute}/

To determine the UUID for an ACL, see Get Data Policy ACLs on page 287.
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Responses

Response Elements
<Data>

   <DataPolicyId>{string}</DataPolicyId>

   <GroupId>{string}</GroupId>

   <Id>{string}</Id>
   <UserId>{string}</UserId>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

DataPolicyId The UUID for the data policy.

GroupId The UUID for the group granted access.

Id The UUID for the ACL.

UserId The UUID of the user granted access.

Example

Sample Request
This request gets information about the data policy ACL with UUID 92f4dfa7-98b7-43d2-95af-
a42a92d2372e.
GET http[s]://blackpearl-hostname/_rest_/data_policy_acl/92f4dfa7-98b7-43d2-95af-

a42a92d2372e/ HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>

   <DataPolicyAcl>92f4dfa7-98b7-43d2-95af-a42a92d2372e</DataPolicyAcl>

   <GroupId>cd8bf7f2-5da4-46f6-a1ba-fdf2ede6e9ec</GroupId>

   <Id>92f4dfa7-98b7-43d2-95af-a42a92d2372e</Id>
   <UserId/>

</Data>
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GET DATA POLICY ACLS

Get information about all data policy ACLs. Use parameters as selection criteria to return a
subset of the list.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/data_policy_acl/[?data_policy_id={string}]

[&group_id={string}][&last_page][&page_length={32-bit integer}][&page_offset=

{32-bit integer}][&page_start_marker={string}][&user_id={string}]

Request Parameters

Parameter Description Required

data_policy_
id

The UUID, name, or other unique attribute for the data policy. yes

group_id 1 The UUID, name, or other unique attribute for the group. no

last_page If included, only the last page of results is returned. no

page_length The maximum number of ACLs to list.
Default: all items after page_offset.

no

page_offset The starting point for the first ACL to list. Default: 0. no

page_start_
marker

The UUID or other unique attribute for the item just before the first
item to list.
Notes:
• Specifying both page_offset and page_start_marker causes
an error.

• If neither page_offset, nor page_start_marker are
specified, the page_offset default is used.

no

user_id 1 The UUID, username, or other unique attribute for the user. no

1) Parameter values can use wild cards (see Wild Card Syntax on page 30).
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Responses

Response Elements
<Data>

   <DataPolicyAcl>

      <DataPolicyId>{string}</DataPolicyId>

      <GroupId>{string}</GroupId>

      <Id>{string}</Id>
      <UserId>{string}</UserId>

   </DataPolicyAcl>

   ...

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

DataPolicyAcl The container for information about one ACL.

DataPolicyId The UUID for the data policy.

GroupId The UUID for the group granted access.

Id The UUID for the ACL.

UserId The UUID of the user granted access.

Example

Sample Request
This request gets information about the ACLs for all data policies.
GET http[s]://blackpearl-hostname/_rest_/data_policy_acl/ HTTP/1.1
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Sample Response
HTTP/1.1 200 OK

<Data>

   <DataPolicyAcl>

      <DataPolicyId>

         2ae695d0-ed75-48fc-bd96-520d8a7ebea3

      </DataPolicyId>

      <GroupId>718246b3-862d-4d9e-9164-8d33c56462a1</GroupId>

      <Id>47f1af11-a54e-42c3-a898-8c5666ead291</Id>
      <UserId/>

   </DataPolicyAcl>

</Data>
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Groups are used for defining access. They are created by adding users and other groups as
members. The BlackPearl gateway has built in groups named Administrators, Everyone, and
Tape Admins.

Add Group as Group Member 290

Add User as Group Member 292

Create Group 294

Delete Group 295

Delete Group Member 296

Get Group Member 297

Get Group Members 299

Get Group 301

Get Groups 303

Modify Group 305

Verify Group Membership 306

ADD GROUP AS GROUP MEMBER

Description
Adds the specified group (member_group_id) as a member of the specified group (group_
id).

Requests

Syntax
POST http[s]://{datapathDNSname}/_rest_/group_member/?group_id={string}&member_

group_id={string}
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Request Parameters 

Parameter Description Required

group_id The UUID, name, or other unique attribute of the group to which a
member is being added. To determine the UUID for a group, see
Get Groups on page 303.

yes

member_
group_id

The UUID, name, or other unique attribute of the group to be
added. To determine the UUID for a group, see Get Groups on
page 303.

yes

Responses

Response Elements
<Data>

   <GroupId>{string}</GroupId>

   <Id>{string}</Id>

   <MemberGroupId>{string}</MemberGroupId>

   <MemberUserId/>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

GroupId The UUID for the group to which the other group was
added.

Id The UUID for the membership of the sub-group in the
group.

MemberGroupId The UUID for the group that was added.

MemberUserId Always null for this operation.
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Example

Sample Request
This request adds a group with the UUID 9b98baac-06d9-4913-a4df-7aed0ab1cf31 as a
member to the group named “Administrators”.
POST http[s]://blackpearl-hostname/_rest_/group_member/?group_

id=Administrators&member_group_id=9b98baac-06d9-4913-a4df-7aed0ab1cf31 HTTP/1.1

Sample Response
HTTP/1.1 201 CREATED

<Data>

   <GroupId>886f1f87-cdf1-40fc-8484-6e6c908c1f3b</GroupId>

   <Id>e01af5f6-4780-41ec-aeb5-a13201d0876f</Id>

   <MemberGroupId>

      9b98baac-06d9-4913-a4df-7aed0ab1cf31

   </MemberGroupId>

   <MemberUserId/>

</Data>

ADD USER AS GROUP MEMBER

Description
Add the specified user as a member of the specified group.

Requests

Syntax
POST http[s]://{datapathDNSname}/_rest_/group_member/?group_id={string}&member_user_

id={string}
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Request Parameters 

Parameter Description Required

group_id The UUID, name, or other unique attribute of the group to which a
member is being added. To determine the UUID for a group, see
Get Groups on page 303.

yes

member_
user_id

User UUID, name, or other unique attribute of the user to be added.
To determine the UUID for a user, see Get Users on page 313.

yes

Responses

Response Elements
<Data>

   <GroupId>{string}</GroupId>

   <Id>{string}</Id>

   <MemberGroupId/>{string}</MemberGroupId>

   <MemberUserId>{string}</MemberUserId>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

GroupId The UUID for the group to which the user was added.

Id The UUID for the membership of the user in the group.

MemberGroupId Always null for this operation.

MemberUserId The UUID for the user added to the group.

Example

Sample Request
This request adds the user “MJ” to the group named “Accounting”.
POST http[s]://blackpearl-hostname/_rest_/group_member/?group_id=Accounting&member_

user_id=MJ HTTP/1.1
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Sample Response
HTTP/1.1 201 CREATED

<Data>

   <GroupId>3962c577-5ddb-466f-bb56-a0c7e3019c81</GroupId>

   <Id>96dd02c6-4690-435f-8a7a-a9754b772b6d</Id>

   <MemberGroupId/>

   <MemberUserId>

      2aea0681-e80b-4d9d-9119-d6653a00cbed

   </MemberUserId>

</Data>

CREATE GROUP

Description
Create a group.

Requests

Syntax
POST http[s]://{datapathDNSname}/_rest_/group/?name={string}

Request Parameters 

Parameter Description Required

name The name for the group. yes

Responses

Response Elements
<Data>

   <BuiltIn>TRUE|FALSE</BuiltIn>

   <Id>{string}</Id>

   <Name>{string}</Name>

</Data>
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where the response elements are defined as follows:

Parameter Description

Data The container for the response.

BuiltIn Whether the group is a standard group automatically available on the BlackPearl
gateway. Always FALSE for this request.

Id The UUID for the group.

Name The name of the group.

Example

Sample Request
This request creates a group with the name “Accounting”.
POST http://blackpearl-hostname/_rest_/group/?name=Accounting HTTP/1.1

Sample Response
HTTP/1.1 200 OK
<Data>

   <BuiltIn>FALSE</BuiltIn>

   <Id>3962c577-5ddb-466f-bb56-a0c7e3019c81</Id>

   <Name>Accounting</Name>

</Data>

DELETE GROUP

Description
Deletes the specified group.

Note: You cannot delete built in groups.
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Requests

Syntax
DELETE http[s]://{datapathDNSname}/_rest_/group/{group UUID, name, or other unique

attribute}/

To determine the UUID for a group, see Get Groups on page 303.

Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 403: Access Denied
• 404: Not Found

Example

Sample Request
This request deletes the group with the name “Accounting”.
DELETE http[s]://blackpearl-hostname/_rest_/group/Accounting/ HTTP/1.1

Sample Response
HTTP/1.1 204 No Content

DELETE GROUP MEMBER

Description
Deletes the group member (sub-group or user) from a group.

Note: You cannot delete group members automatically added to built in groups.
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Requests

Syntax
DELETE http[s]://{datapathDNSname}/_rest_/group_member/{group member UUID or other

unique attribute}/

To determine the UUID for a group member, see Get Group Members on page 299.

Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 403: Access Denied
• 404: Not Found

Example

Sample Request
This request deletes the group member with the UUID e81bbe7a-faea-4d3b-ba5c-
60aa603f8c4a.
DELETE http[s]://blackpearl-hostname/_rest_/group_member/e81bbe7a-faea-4d3b-ba5c-

60aa603f8c4a/ HTTP/1.1

Sample Response
HTTP/1.1 204 No Content

GET GROUP MEMBER

Description
Get information about the specified group membership (either a user member or a group
member).
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Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/group_member/{group membership UUID or other

unique attribute}/

To determine the UUID for a group member, see Get Group Members on page 299.

Responses

Response Elements
<Data>

   <GroupId>{string}</GroupId>

   <Id>{string}</Id>

   <MemberGroupId>{string}</MemberGroupId>

   <MemberUserId>{string}</MemberUserId>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

GroupId The UUID for the group.

Id The UUID for the membership of the sub-group or user in the group.

MemberGroupId The UUID for the sub-group included in the group.

MemberUserId The UUID for the user included in the group.

Example

Sample Request
This request gets information about the group member with the UUID fd71ae41-42e2-4f15-
96e2-ef802060434e.
GET http://blackpearl-hostname/_rest_/group_member/fd71ae41-42e2-4f15-96e2-

ef802060434eb/ HTTP/1.1
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Sample Response
HTTP/1.1 200 OK

<Data>

   <GroupId>b3fa774c-ac2e-44a4-b1b5-4cfa3a3ec209</GroupId>

   <Id>fd71ae41-42e2-4f15-96e2-ef802060434e</Id>

   <MemberGroupId>

      663fd04e-4d46-4b6e-bbaa-9bcf31b94f90

   </MemberGroupId>

   <MemberUserId/>

</Data>

GET GROUP MEMBERS

Description
Get information about group members for all groups. Use parameters as selection criteria to
return a subset of the list.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/group_member/[?group_id={string}][&last_page]

[&member_group_id={string}][&member_user_id={string}][&page_length={32-bit integer}]

[&page_offset={32-bit integer}][&page_start_marker={string}]

Request Parameters 

Parameter Description Required

group_id The group UUID, name, or other unique attribute. no

last_page If included, only the last page of results is returned. no

member_
group_id

The UUID or other unique attribute of a group that is a member of
another group. To determine the UUID for a group, see Get Groups
on page 303.

no

member_
user_id

User UUID or other unique attribute of a user within a group. To
determine the UUID for a user, see Get Users on page 313.

no
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Parameter Description Required

page_length The maximum number of group members to list.
Default: all items after page_offset.

no

page_offset The starting point for the first group member to list. Default: 0. no

page_start_
marker

The UUID or other unique attribute for the item just before the first
item to list.
Notes:
• Specifying both page_offset and page_start_marker causes
an error.

• If neither page_offset, nor page_start_marker are
specified, the page_offset default is used.

no

Responses

Response Elements
<Data>

   <GroupMember>

      <GroupId>{string}</GroupId>

      <Id>{string}</Id>

      <MemberGroupId>{string}</MemberGroupId>

      <MemberUserId>{string}</MemberUserId>

   </GroupMember>

   ...

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

GroupMember The container for information about one group member.

GroupId The UUID for the group.

Id The UUID for the group membership.

MemberGroupId The UUID for the sub-group included in the larger group.

MemberUserId The UUID for the user included in the group.
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Example

Sample Request
This request gets information about all group members on the BlackPearl gateway.
GET http://blackpearl-hostname/_rest_/group_member/ HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>

   <GroupMember>

      <GroupId>4a4efdf7-1540-4b79-b015-feb6ee6cb238</GroupId>

      <Id>3a81721c-ed32-4525-9f71-ab2c55f81942</Id>

      <MemberGroupId>

         94dedcfb-7520-4b11-8215-325bc27a2d9f

      </MemberGroupId>

      <MemberUserId/>

   </GroupMember>

   <GroupMember>

      <GroupId>4a4efdf7-1540-4b79-b015-feb6ee6cb238</GroupId>

      <Id>d9f2e9c1-5b66-4dd9-88ce-0216f5ffdc3a</Id>

      <MemberGroupId/>

      <MemberUserId>

         8f885fe0-87c7-427e-a82b-ad33df9d5a15

      </MemberUserId>

   </GroupMember>

   ...

</Data>

GET GROUP

Description
Get information about the specified group.
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Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/group/{group UUID, name, or other unique

attribute}/

To determine the UUID for a group, see Get Groups on page 303.

Responses

Response Elements
<Data>

   <BuiltIn>TRUE|FALSE</BuiltIn>

   <Id>{string}</Id>

   <Name>{string}</Name>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

BuiltIn Whether the group is a standard group automatically available on the BlackPearl
gateway.

Id The UUID for the group.

Name The name of the group.

Example

Sample Request
This request gets information about the group with the name “group1”.
GET http://blackpearl-hostname/_rest_/group/group1/ HTTP/1.1
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Sample Response
HTTP/1.1 200 OK

<Data>

   <BuiltIn>FALSE</BuiltIn>

   <Id>d8932062-3f22-4cd5-b296-b6d5d3558889</Id>

   <Name>group1</Name>

</Data>

GET GROUPS

Description
Get information about all groups. Use parameters as selection criteria to return a subset of the
list.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/group/[?built_in=TRUE|FALSE][&last_page]

[&name={string}][&page_length={32-bit integer}][&page_offset={32-bit integer}]

[&page_start_marker={string}]

Request Parameters 

Parameter Description Required

built_in Whether the group is a standard group automatically available on
the BlackPearl gateway.

no

last_page If included, only the last page of results is returned. no

name The name of the group. no

page_length The maximum number of groups to list.
Default: all items after page_offset.

no

page_offset The starting point for the first group to list.
Default: 0.

no
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Parameter Description Required

page_start_
marker

The UUID or other unique attribute for the item just before the first
item to list.
Notes:
• Specifying both page_offset and page_start_marker causes
an error.

• If neither page_offset, nor page_start_marker are specified,
the page_offset default is used.

no

Responses

Response Elements
<Data>

   <Group>

      <BuiltIn>TRUE|FALSE</BuiltIn>

      <Id>{string}</Id>

      <Name>{string}</Name>

   </Group>

   ...

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

Group The container for information about one group.

BuiltIn Whether the group is a standard group automatically available on the BlackPearl
gateway.

Id The UUID for the group.

Name The name of the group.

Example

Sample Request
This request gets information about all groups on the BlackPearl gateway.
GET http://blackpearl-hostname/_rest_/group/ HTTP/1.1
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Sample Response
HTTP/1.1 200 OK

<Data>

   <Group>

      <BuiltIn>TRUE</BuiltIn>

      <Id>50993790-d245-41cf-bbde-f3aa5d9f717c</Id>

      <Name>Administrators</Name>

   </Group>

   <Group>

      <BuiltIn>FALSE</BuiltIn>

      <Id>dd73394b-fae6-4a35-b1f3-cfe8fd71ee2d</Id>

      <Name>group1</Name>

   </Group>

</Data>

MODIFY GROUP

Description
Modify the name of a group.

Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/group/{group UUID, name, or other unique

attribute}/?name={string}

To determine the UUID for a group, see Get Groups on page 303.

Request Parameters 

Parameter Description Required

name The new name for the group. yes
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Responses

Response Elements
<Data>

   <BuiltIn>TRUE|FALSE</BuiltIn>

   <Id>{string}</Id>

   <Name>{string}</Name>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

BuiltIn Whether the group is a standard group automatically available on the BlackPearl
gateway.

Id The UUID for the group.

Name The name of the group.

Example

Sample Request
This request modifies the name of the group from “group1” to “Accounting”.
PUT http://blackpearl-hostname/_rest_/group/group1/?name=Accounting HTTP/1.1

Sample Response
HTTP/1.1 200 OK
<Data>

   <BuiltIn>FALSE</BuiltIn>

   <Id>f587c38f-69bc-463a-a094-bd31ad2e94ae</Id>

   <Name>Accounting</Name>

</Data>

VERIFY GROUP MEMBERSHIP

Description
Verifies that the specified user is a member of the specified group.
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Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/group/{group UUID or other unique

attribute}/?operation=VERIFY[&user_id={string}]

To determine the UUID for a group member, see Get Group Members on page 299.

Request Parameters

Parameter Description Required

operation The operation to perform. For this request, the operation is to verify
membership. Value: VERIFY

yes

user_id User UUID, name, or other unique attribute of the user to be whose
membership is being verified. To determine the UUID for a user, see
Get Users on page 313.
Note: If the user_id parameter is not included, the membership of
the user performing the request is verified.

no

Responses

Response Elements
The operation returns status only.

Notable status codes:

• 200: OK
• 204: No Content (the user is not recognized as a member)

Example

Sample Request
This request verifies that the user named “user1” is a member of the group Administrators.
PUT http[s]://blackpearl-hostname/_rest_/group/?operation=VERIFY&user_Id=user1

HTTP/1.1

Sample Response
HTTP/1.1 200 OK
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This chapter describes operations for working with users.

Delegate Create User 308

Delegate Delete User 310

Get User 311

Get Users 313

Modify User 316

Regenerate Secret Key 318

DELEGATE CREATE USER

Description
Delegates a create user request to the management path. Users can only be created and
deleted using the management path. This command sends the create user request to the
management path.

Requests

Syntax
POST http[s]://{datapathDNSname}/_rest_/user_internal/?name={string}[&default_data_

policy_id={string}][&max_buckets={32-bit integer}][&id={string}][&secret_key=

{string}]

To determine the UUID for a user, see Get Users on page 313.

Request Parameters 

Parameter Description Required

name The username for the user.
Note: The username cannot contain capital letters or spaces.

yes
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Parameter Description Required

default_
data_
policy_id

The UUID, name, or other unique attribute for the default data
policy used if no data policy is specified when the user creates a
bucket.

no

max_buckets The maximum number of buckets that the user can create. The
default is 10000.

no

id The UUID to assign to the new user. no

secret_key The S3 secret key to assign to the new user. no

Responses

Response Elements
<Data>

   <AuthId>{string}</AuthId>

   <DefaultDataPolicyId>{string}</DefaultDatePolicyId>

   <Id>{string}</Id>

   <MaxBuckets>{32-bit integer}</MaxBuckets>

   <Name>{string}</Name>

   <SecretKey>{string}</SecretKey>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

AuthId The S3 access ID assigned to the user.

DefaultDataPolicyId The default data policy used if no data policy is specified when this user
creates a bucket.

Id The UUID for the user.

MaxBuckets The maximum number of buckets that the user can create.

Name The username of the user.

SecretKey The S3 secret key assigned to the user.
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Example

Sample Request
This request creates the user with the username “user1”.
POST http://blackpearl-hostname/_rest_/user_internal/?name=user1 HTTP/1.1

Sample Response
HTTP/1.1 200 OK
<Data>

   <AuthId>c381Y3RyYQ==</AuthId>

   <DefaultDataPolicyId/>

   <Id>b136c431-a59e-413e-b03f-23f7b841ac25</Id>

   <MaxBuckets>10000</MaxBuckets>

   <Name>user1</Name>

   <SecretKey>grHkEdE5</SecretKey>

</Data>

DELEGATE DELETE USER

Description
Delegates a delete user request to the management path. Users can only be created and
deleted using the management path. This command sends the delete user request to the
management path.

Requests

Syntax
DELETE http[s]://{datapathDNSname}/_rest_/user_internal/{user UUID, name, or other

unique attribute}/

To determine the UUID for a user, see Get Users on page 313.
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Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 403: Access Denied
• 404: Not Found

Example

Sample Request
This request deletes the user with the username “user1”.
DELETE http[s]://blackpearl-hostname/_rest_/user_internal/user1/ HTTP/1.1

Sample Response
HTTP/1.1 204 No Content

GET USER

Description
Get information about the specified user.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/user/{user UUID, name, or other unique

attribute}/

To determine the UUID for a user, see Get Users on page 313.
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Responses

Response Elements
<Data>

   <AuthId>{string}</AuthId>

   <DefaultDataPolicyId>{string}</DefaultDatePolicyId>

   <Id>{string}</Id>

   <MaxBuckets>{32-bit integer}</MaxBuckets>

   <Name>{string}</Name>

   <SecretKey>{string}</SecretKey>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

AuthId The S3 access ID assigned to the user.

DefaultDataPolicyId The default data policy used if no data policy is specified when this user
creates a bucket.

Id The UUID for the user.

MaxBuckets The maximum number of buckets that the user can create.

Name The username of the user.

SecretKey The S3 secret key assigned to the user.

Example

Sample Request
This request gets information about the user with the name “user1”.
GET http://blackpearl-hostname/_rest_/user/user1/ HTTP/1.1
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Sample Response
HTTP/1.1 200 OK

<Data>

   <AuthId>c381Y3RyYQ==</AuthId>

   <DefaultDataPolicyId/>

   <Id>b136c431-a59e-413e-b03f-23f7b841ac25</Id>

   <MaxBuckets>10000</MaxBuckets>

   <Name>user1</Name>

   <SecretKey>grHkEdE5</SecretKey>

</Data>

GET USERS

Description
Get information about all users. Use parameters as selection criteria to return a subset of the
list.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/user/[?auth_id={string}][&default_data_

policy_id={string}][&last_page][&name={string}][&page_length={32-bit integer}]

[&page_offset={32-bit integer}][&page_start_marker={string}]

Request Parameters 

Parameter Description Required

auth_id The S3 access ID assigned to the user. no

default_data_
policy_id

The default data policy used if no data policy is specified when
the user creates a bucket.

no

last_page If included, only the last page of results is returned. no

name The username of the user. no

page_length The maximum number of users to list.
Default: all items after page_offset.

no
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Parameter Description Required

page_offset The starting point for the first user to list.
Default: 0.

no

page_start_
marker

The UUID or other unique attribute for the item just before the
first item to list.
Notes:
• Specifying both page_offset and page_start_marker
causes an error.

• If neither page_offset, nor page_start_marker are
specified, the page_offset default is used.

no

Responses

Response Elements
<Data>

   <User>

      <AuthId>{string}</AuthId>

      <DefaultDataPolicyId>{string}</DefaultDatePolicyId>

      <Id>{string}</Id>

      <MaxBuckets>{32-bit integer}</MaxBuckets>

      <Name>{string}</Name>

      <SecretKey>{string}</SecretKey>

   </User>

   ...

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

User The container for information about one user.

AuthId The S3 access ID assigned to the user.

DefaultDataPolicyId The UUID for the default data policy used if no data policy is specified
when this user creates a bucket.

Id The UUID for the user.
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Parameter Description

MaxBuckets The maximum number of buckets that the user can create.

Name The username of the user.

SecretKey The S3 secret key assigned to the user.

Example

Sample Request
This request gets information about all users on the BlackPearl gateway.
GET http://blackpearl-hostname/_rest_/user/ HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>

   <User>

      <AuthId>c381Y3RyYQ==</AuthId>

      <DefaultDataPolicyId/>

      <Id>b136c431-a59e-413e-b03f-23f7b841ac25</Id>

      <MaxBuckets>10000</MaxBuckets>

      <Name>user1</Name>

      <SecretKey>grHkEdE5</SecretKey>

   </User>
   <User>

      <AuthId>bMV3dxN1cg==</AuthId>

      <DefaultDataPolicyId/>

      <Id>b136c431-a59e-413e-b03f-23f7b841ac25</Id>

      <MaxBuckets>10000</MaxBuckets>

      <Name>user2</Name>

      <SecretKey>GTfLU3pE</SecretKey>

   </User>
</Data>
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MODIFY USER

Description
Modify the name or default data policy for a user.

Note: If an optional request parameter is not included, the previous setting is retained.

Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/user/{user UUID, name, or other unique

attribute}/[?default_data_policy_id={string}][&max_buckets={32-bit integer}][&name=

{string}][&secret_key={string}]

To determine the UUID for a user, see Get Users on page 313.

Request Parameters 

Parameter Description Required

default_
data_
policy_id

The UUID, name, or other unique attribute for the default data
policy used if no data policy is specified when this user creates a
bucket.

no

max_buckets The maximum number of buckets that the user can create. no

name The new username for the user. no

secret_key The S3 secret key to assign to the user. no
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Responses

Response Elements
<Data>

   <AuthId>{string}</AuthId>

   <DefaultDataPolicyId>{string}</DefaultDatePolicyId>

   <Id>{string}</Id>
   <MaxBuckets>{32-bit integer}</MaxBuckets>

   <Name>{string}</Name>

   <SecretKey>{string}</SecretKey>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

AuthId The S3 access ID assigned to the user.

DefaultDataPolicyId The default data policy used if no data policy is specified when this user
creates a bucket.

Id The UUID for the user.

MaxBuckets The maximum number of buckets that the user can create.

Name The username of the user.

SecretKey The S3 secret key assigned to the user.

Example

Sample Request
This request modifies the user with the username “user1” to use the default data policy
“Accounting”.
PUT http://blackpearl-hostname/_rest_/user/user1/?default_data_policy_id=Accounting

HTTP/1.1
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Sample Response
HTTP/1.1 200 OK
<Data>

   <AuthId>c381Y3RyYQ==</AuthId>

   <DefaultDataPolicyId>

      0b6ef313-09d3-4a40-b43e-f4cb01b352ad

   </DefaultDataPolicyId>

   <Id>b136c431-a59e-413e-b03f-23f7b841ac25</Id>

   <MaxBuckets>10000</MaxBuckets>

   <Name>user1</Name>

   <SecretKey>grHkEdE5</SecretKey>

</Data>

REGENERATE SECRET KEY

Description
Regenerate the S3 secret key for the specified user.

Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/user/{user UUID, name, or other unique

attribute}/?operation=REGENERATE_SECRET_KEY

To determine the UUID for a user, see Get Users on page 313.

Request Parameters 

Parameter Description Required

operation The operation to perform. For this request, the operation is to
regenerate the S3 secret key.
Value: REGENERATE_SECRET_KEY

yes
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Responses

Response Elements
<Data>

   <AuthId>{string}</AuthId>

   <DefaultDataPolicyId>{string}</DefaultDatePolicyId>

   <Id>{string}</Id>

   <MaxBuckets>{32-bit integer}</MaxBuckets>

   <Name>{string}</Name>

   <SecretKey>{string}</SecretKey>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

AuthId The S3 access ID assigned to the user.

DefaultDataPolicyId The default data policy used if no data policy is specified when this user
creates a bucket.

Id The UUID for the user.

MaxBuckets The maximum number of buckets that the user can create.

Name The username of the user.

SecretKey The new S3 secret key assigned to the user.

Example

Sample Request
This request regenerates the secret key for the user with the username “user1”.
PUT http://blackpearl-hostname/_rest_/user/user1/?operation=REGENERATE_SECRET_KEY

HTTP/1.1
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Sample Response
HTTP/1.1 200 OK
<Data>

   <AuthId>c381Y3RyYQ==</AuthId>

   <DefaultDataPolicyId>

      0b6ef313-09d3-4a40-b43e-f4cb01b352ad

   </DefaultDataPolicyId>

   <Id>b136c431-a59e-413e-b03f-23f7b841ac25</Id>

   <MaxBuckets>10000</MaxBuckets>

   <Name>user1</Name>

   <SecretKey>d7pJBeAN</SecretKey>

</Data>
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VOLUME D - ADVANCED BUCKET
MANAGEMENT OPERATIONS

This section describes operations that control where data is stored and for how long.

• Data Policy Operations on page 322

• Replication Target Operations on page 398

• Storage Domain Operations on page 540
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A data policy defines data integrity policies, default job attributes, and persistence and
replication rules, which define where the BlackPearl gateway writes data and how long it
retains data.

A bucket must specify exactly one data policy to use. Multiple buckets can use the same data
policy. See Create Bucket - DS3 on page 70 and Create Bucket (Put Bucket) on page 34 for
more information about assigning a data policy to a bucket.

Create Data Persistence Rule 323

Create Data Policy 326

Create Amazon S3 Data Replication Rule 333

Create Azure Data Replication Rule 337

Create DS3 Data Replication Rule 340

Delete Data Persistence Rule 342

Delete Data Policy 343

Delete Amazon S3 Data Replication Rule 344

Delete Azure Data Replication Rule 345

Delete DS3 Data Replication Rule 346

Get Data Persistence Rule 347

Get Data Persistence Rules 350

Get Data Policies 353

Get Data Policy 358

Get Amazon S3 Data Replication Rule 361

Get Amazon S3 Data Replication Rules 364

Get Azure Data Replication Rule 367

Get Azure Data Replication Rules 370

Get DS3 Data Replication Rule 373

Get DS3 Data Replication Rules 375

Modify Data Persistence Rule 378

Modify Data Policy 381

Modify Amazon S3 Data Replication Rule 388

Modify Azure Data Replication Rule 391
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Modify DS3 Data Replication Rule 394

CREATE DATA PERSISTENCE RULE

Description
Create a data persistence rule for a data policy. Each data policy must have one or more
permanent persistence rules. Each persistence rule targets a specified storage domain. The
BlackPearl gateway writes data to every storage domain for which there is currently a
persistence rule with type PERMANENT or TEMPORARY.

Different persistence rules cannot specify the same storage domain multiple times in the same
data policy. Persistence rules can specify the same storage domain across different data
policies.

You must create the data policy and storage domain before creating the persistence rule. See
Create Data Policy on page 326 and Create Storage Domain on page 545.

Note: If you add a temporary persistence rule to a data policy already applied to a
bucket, the BlackPearl gateway does not necessarily copy the data to the specified
storage domain even if there is existing data within the rule's retention period.

Requests

Syntax
POST http[s]://{datapathDNSname}/_rest_/data_persistence_rule/?data_policy_id=

{string}&isolation_level=STANDARD|BUCKET_ISOLATED&storage_domain_id=

{string}&type=PERMANENT|TEMPORARY[&minimum_days_to_retain={unsigned 32-bit integer}]

Request Parameters 

Parameter Description Required

data_policy_
id

Data policy name, UUID, or other unique attribute. yes
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Parameter Description Required

isolation_
level

The level of physical isolation required for the data retention.
The STANDARD isolation level provides the best capacity
utilization and overall performance.
Notes:
• BUCKET_ISOLATED allocates an entire tape or pool to a bucket
when needed. Allocating an entire pool to a bucket may use
up resources quickly and is not recommended.

• The isolation level can always be reduced to STANDARD, but
can never be increased to BUCKET_ISOLATED once the data
policy is in use by at least one bucket.

Values:
• STANDARD — Data is isolated according to the standard
Storage Domain isolation requirements.

• BUCKET_ISOLATED — Data from different buckets cannot be
mixed on the same physical storage media.

yes

storage_
domain_id

Storage domain UUID or other unique attribute. yes

type The type of persistence rule.
Values:
• PERMANENT — A copy of the data is placed in the specified
storage domain initially and maintained there permanently.

• TEMPORARY — A copy of the data is placed in the specified
storage domain initially and maintained there at least until the
specified retention period expires.

Note: This value is not allowed for a persistence rule targeting a
storage domain with a tape partition member.

yes

minimum_
days_to_
retain

The minimum number of days the data should be retained
based on a TEMPORARY persistence rule.
Note: The minimum_days_to_retain for a persistence rule
targeting a storage domain with a NEARLINE pool (Deep
Storage) storage domain member must be 90 days or greater.

required if
type is
TEMPORARY
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Responses

Response Elements
<Data>

   <DataPolicyId>{string}</DataPolicyId>

   <Id>{string}</Id>

   <IsolationLevel>STANDARD|BUCKET_ISOLATED</IsolationLevel>

   <MinimumDaysToRetain>{32-bit integer}</MinimumDaysToRetain>

   <State>NORMAL|INCLUSION_IN_PROGRESS</State>

   <StorageDomainId>{string}</StorageDomainId>

   <Type>PERMANENT|TEMPORARY</Type>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

DataPolicyId The UUID for the data policy.

Id The UUID for the persistence rule.

IsolationLevel The level of physical isolation required for the data retention. Values:
STANDARD, BUCKET_ISOLATED
See isolation_level on page 324 for descriptions.

MinimumDaysTo
Retain

The minimum number of days the data should be retained based on a
TEMPORARY persistence rule.

State The state of the persistence rule.
Values:
NORMAL — The persistence rule is in a normal, included state.
INCLUSION_IN_PROGRESS — The persistence rule is being applied and data
copying is required before the persistence rule is in a normal, fully included
state.

StorageDomainId The UUID for the storage domain.

Type The type of persistence rule.
Values: PERMANENT, TEMPORARY. See type on page 324 for descriptions.
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Example

Sample Request
This request creates a permanent persistence rule with standard isolation level for the data
policy with the UUID 044854c9-7557-4136-a374-dddf7c29e370, using the storage domain with
the UUID 8ed43978-846a-44c9-8e14-f34179e33a33.
POST http[s]://blackpearl-hostname/_rest_/data_persistence_rule/?data_policy_

id=044854c9-7557-4136-a374-dddf7c29e370&isolation_level=STANDARD&storage_domain_

id=8ed43978-846a-44c9-8e14-f34179e33a33&type=PERMANENT HTTP/1.1

Sample Response
HTTP/1.1 201 CREATED

<Data>

   <DataPolicyId>

      044854c9-7557-4136-a374-dddf7c29e370

   </DataPolicyId>

   <Id>d8716fda-c2e5-44c6-8bea-713bb147e5e0</Id>

   <IsolationLevel>STANDARD</IsolationLevel>

   <MinimumDaysToRetain/>

   <State>NORMAL</State>

   <StorageDomainId>

      8ed43978-846a-44c9-8e14-f34179e33a33

   </StorageDomainId>

   <Type>PERMANENT</Type>

</Data>

CREATE DATA POLICY

Description
Create a data policy.
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Requests

Syntax
POST http[s]://{datapathDNSname}/_rest_/data_policy/?name={string}[&always_force_

put_job_creation=TRUE|FALSE][&always_minimize_spanning_across_media=TRUE|FALSE]

[&blobbing_enabled=TRUE|FALSE][&checksum_type=CRC_32|CRC_32C|MD5|SHA_256|SHA_512]

[&default_blob_size={64-bit integer}][&default_get_job_

priority=URGENT|HIGH|NORMAL|LOW][&default_put_job_priority=URGENT|HIGH|NORMAL|LOW]

[&default_verify_after_write=TRUE|FALSE][&default_verify_job_

priority=URGENT|HIGH|NORMAL|LOW][&end_to_end_crc_required=TRUE|FALSE][&max_versions_

to_keep={32-bit integer}][&rebuild_priority=URGENT|HIGH|NORMAL|LOW]

[&versioning=NONE|KEEP_LATEST|KEEP_MULTIPLE_VERSIONS]

Request Parameters 

Parameter Description Required

name The name for the data policy. yes

always_
minimize_
spanning_
across_media

Whether all PUT jobs created using this data policy are configured
to minimize spanning across tape media. Minimizing spanning
across media is useful when you plan to eject tapes and it is likely
that you will retrieve all objects from the PUT job in a single GET
job. With this setting, you may only need to import one ejected
tape, rather than many tapes, when servicing a GET job.
Notes:
• This setting only applies to tape partitions.
• For jobs less than or equal to 1 TB in size, there is an absolute
guarantee that the data from the job will never span across
multiple tapes. For larger jobs, spanning is minimized, but not
completely prevented. You can further reduce the probability of
spanning across media by using the CAPACITY write optimization
for the storage domains.

• Minimizing spanning across media may reduce capacity
utilization and performance.

Values: TRUE, FALSE (default)

no
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Parameter Description Required

always_
force_put_
job_creation

Whether all PUT jobs created for this data policy are created even if
one or more replication targets the BlackPearl gateway must PUT to
are unavailable, or if there are global issues that would likely
prevent the completion of the job.
Note: Using this parameter is discouraged, and using it for jobs on
both the source and target BlackPearl gateways at the same time is
extremely discouraged. Running jobs on both gateways when they
are not able to communicate with each other can create replication
conflicts that must be manually resolved.
Values: TRUE, FALSE (default)

no

blobbing_
enabled

Whether or not to enable blobbing. If enabled, an object can be
broken up into multiple blobs (binary large objects). If disabled, an
object must always have exactly one blob. Blobbing must be
enabled to handle objects larger than 1 TB, to use multi-part
upload, or to break up an object into multiple blobs. Disabling
blobbing guarantees that an object never spans multiple media (for
example, tapes), since a blob cannot span multiple media.
Values: TRUE (default), FALSE

no

checksum_
type

Specifies the type of checksum used to verify data integrity for data
in any bucket using this data policy, and the type of checksum
required for end-to-end CRC, if specified.
Values: CRC_32, CRC_32C, MD5 (default), SHA_256, SHA_512
Notes:
• CRC_32, MD5, and SHA-512 perform the best for their
corresponding cryptographic strengths on the BlackPearl
gateway.

• Using SHA-256 or SHA-512 will reduce single stream
performance and may reduce throughput capabilities of the
BlackPearl gateway.

no

default_
blob_size

Specifies the maximum blob size used when creating bulk PUT
jobs. Blob sizes less than 5 MB are strongly discouraged. Blob sizes
less than 50 MB are discouraged. The maximum blob size is 1 TB.
Default: 100 GB

no

default_get_
job_ priority

Specifies the default GET job priority for the data policy. The job
priority determines the resources assigned and the processing
order. Jobs with priority URGENT can use up all of the resources
and prevent other jobs from making progress. Use this priority
sparingly.
Values: URGENT, HIGH (default), NORMAL, LOW

no
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Parameter Description Required

default_put_
job_ priority

Specifies the default PUT job priority for the data policy. The job
priority determines the resources assigned and the processing
order. Jobs with priority URGENT can use up all of the resources
and prevent other jobs from making progress. Use this priority
sparingly.
Values: URGENT, HIGH, NORMAL (default), LOW

no

default_
verify_
after_write

Whether data is verified by default after it is written.
Values: TRUE, FALSE

no

default_
verify_job_
priority

Specifies the default verify job priority for the data policy. The job
priority determines the resources assigned and the processing
order. Jobs with priority URGENT can use up all of the resources
and prevent other jobs from making progress. Use this priority
sparingly. Verify jobs can be interrupted every 30 minutes if a job
with a higher priority is received.
Values: URGENT, HIGH, NORMAL, LOW (default)

no

end_to_end_
crc_
required

Whether or not clients are required to compute and send an end-to-
end CRC. Values: TRUE, FALSE (default)

no

max_
versions_to_
keep

The number of versions of an object to keep if versioning=KEEP_
MULTIPLE_VERSIONS.
The default is 1000.

no

rebuild_
priority

Specifies the rebuild priority for the data policy. The rebuild
priority determines the relative priority compared to other jobs
being processed.
Values: URGENT, HIGH, NORMAL, LOW (default)

no
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Parameter Description Required

versioning The mode of versioning used by the data policy.
Values:
• NONE (default) — Only one version of an object may exist at any
time. Attempts to write another object of the same name fail.

• KEEP_LATEST — Only one version of the data is available at a
time. When a new version of an object is written, the old version
is retained until the new version is fully written in compliance
with the data policy, and then the old version is deleted.

• KEEP_MULTIPLE_VERSIONS —Multiple versions of the object, up
to the number specified by max_versions_to_ keep are retained.

Notes:
• KEEP_LATEST versioning cannot be used for a data policy which
uses a storage domain with ltfs_file_naming=OBJECT_NAME
(see ltfs_file_naming on page 548).

• KEEP_LATEST requires that the PUT job for the earlier version of
the object complete before the PUT of the latest version of the
object with the same name in order for the PUT to succeed.

CAUTION If the PUT of the earlier version is not complete before the
PUT of the latest version, the BlackPearl gateway believes the latest
version to be the same object as the earlier version and rejects it, so
only the earlier version is retained.

no

Responses

Response Elements
<Data>

   <AlwaysForcePutJobCreation>

      TRUE|FALSE

   </AlwaysForcePutJobCreation>

   <AlwaysMinimizeSpanningAcrossMedia>

      TRUE|FALSE

   </AlwaysMinimizeSpanningAcrossMedia>
   <BlobbingEnabled>TRUE|FALSE</BlobbingEnabled>

   <ChecksumType>

      CRC_32|CRC_32C|MD5|SHA_256|SHA_512

   </ChecksumType>

   <CreationDate>YYYY-MM-DDThh:mm:ss.xxxZ</CreationDate>
   <DefaultBlobSize>{64-bit integer}</DefaultBlobSize>
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   <DefaultGetJobPriority>

      CRITICAL|URGENT|HIGH|NORMAL|LOW|BACKGROUND

   </DefaultGetJobPriority>

   <DefaultPutJobPriority>

      CRITICAL|URGENT|HIGH|NORMAL|LOW|BACKGROUND

   </DefaultPutJobPriority>
   <DefaultVerifyAfterWrite>TRUE|FALSE</DefaultVerifyAfterWrite>

   <DefaultVerifyJobPriority>

      CRITICAL|URGENT|HIGH|NORMAL|LOW|BACKGROUND

   </DefaultVerifyJobPriority>

   <EndToEndCrcRequired>TRUE|FALSE</EndToEndCrcRequired>

   <Id>{string}</Id>
   <MaxVersionsToKeep>{32-bit integer}</MaxVersionsToKeep>

   <Name>{string}</Name>

   <RebuildPriority>

      CRITICAL|URGENT|HIGH|NORMAL|LOW|BACKGROUND

   </RebuildPriority>

   <Versioning>

      NONE|KEEP_LATEST|KEEP_MULTIPLE_VERSIONS

   </Versioning>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

AlwaysForcePutJobCreation Whether all PUT jobs created for this data policy are created
even if one or more storage domains and/or replication targets
the BlackPearl gateway must PUT to is unavailable, or if there
are global issues that would likely prevent the completion of the
job.
Values: TRUE, FALSE

AlwaysMinimize
SpanningAcross Media

Whether all PUT jobs created for this data policy are created to
minimize spanning across media.
Values: TRUE, FALSE. See always_minimize_ spanning_across_
media on page 327.

BlobbingEnabled Whether or not blobbing is enabled.

ChecksumType Type of checksum used to verify data integrity for any
operations involving this data policy.
Values: CRC_32, CRC_32C, MD5, SHA_256, SHA_512
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Parameter Description

CreationDate The date and time the data policy was created in the format
YYYY-MM-DDThh:mm:ss.xxxZ.

DefaultBlobSize The default preferred maximum blob size.

DefaultGetJob
Priority

The default GET job priority for the data policy. The job priority
determines the resources assigned and the processing order.
Values: CRITICAL, URGENT, HIGH, NORMAL, LOW, BACKGROUND

DefaultPutJob
Priority

The default PUT job priority for the data policy. The job priority
determines the resources assigned and the processing order.
Values: CRITICAL, URGENT, HIGH, NORMAL, LOW, BACKGROUND

DefaultVerifyAfterWrite Whether data is verified by default after it is written.
Values: TRUE, FALSE

DefaultVerifyJob
Priority

The default verify job priority for the data policy. The job priority
determines the resources assigned and the processing order.
Values: CRITICAL, URGENT, HIGH, NORMAL, LOW, BACKGROUND

EndToEndCrc
Required

Whether or not clients are required to compute and send an end-
to-end CRC. Values: TRUE, FALSE

Id The UUID for the data policy.

MaxVersionsTo Keep The number of versions of an object to keep if versioning=KEEP_
MULTIPLE_VERSIONS.

Name The name of the data policy.

RebuildPriority The rebuild priority for the data policy. The rebuild priority
determines the relative priority compared to other jobs being
processed.
Values: CRITICAL, URGENT, HIGH, NORMAL, LOW, BACKGROUND

Versioning The mode of versioning used by the data policy.
Values: NONE, KEEP_LATEST, KEEP_MULTIPLE_VERSIONS See
versioning on page 330.

Example

Sample Request
This request creates a data policy with the name “policy1” that uses all data policy defaults.
POST http://blackpearl-hostname/_rest_/data_policy/?name=policy1 HTTP/1.1
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Sample Response
HTTP/1.1 200 OK
<Data>

   <AlwaysForcePutJobCreation>FALSE</AlwaysForcePutJobCreation>

   <AlwaysMinimizeSpanningAcrossMedia>

      FALSE

   </AlwaysMinimizeSpanningAcrossMedia>

   <BlobbingEnabled>TRUE</BlobbingEnabled>

   <ChecksumType>MD5</ChecksumType>

   <CreationDate>2015-07-29 16:26:12.305</CreationDate>

   <DefaultBlobSize/>

   <DefaultGetJobPriority>HIGH</DefaultGetJobPriority>

   <DefaultPutJobPriority>NORMAL</DefaultPutJobPriority>

   <DefaultVerifyJobPriority>LOW</DefaultVerifyJobPriority>

   <EndToEndCrcRequired>FALSE</EndToEndCrcRequired>

   <Id>f7eced2d-9080-4722-b866-e8c21271bef9</Id>

   <MaxVersionsToKeep>1000</MaxVersionsToKeep>

   <Name>policy1</Name>

   <RebuildPriority>LOW</RebuildPriority>

   <Versioning>NONE</Versioning>

</Data>

CREATE AMAZON S3 DATA REPLICATION RULE

Description
Create an Amazon S3 data replication rule for a data policy. Each Amazon S3 replication rule
targets a specified AWS S3 instance (or a cloud provider instance that exposes an AWS S3
API) remote to the local BlackPearl gateway.

You cannot specify the same AWS S3 instance multiple times in different replication rules
applied to the same data policy. You can reference the same AWS S3 instance across different
data policies.

You must create the data policy and register the target AWS S3 instance before creating the
replication rule. See Create Data Policy on page 326 and Register Amazon S3 Target on
page 440.
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Requests

Syntax
POST http[s]://{datapathDNSname}/_rest_/s3_data_replication_rule/?data_policy_id=

{string}&target_id={string}&type=PERMANENT [&initial_data_

placement=STANDARD|REDUCED_REDUNDANCY|STANDARD_IA|GLACIER|DEEP_ARCHIVE][&max_blob_

part_size_in_bytes={64-bit integer}][&replicate_deletes=TRUE|FALSE]

Request Parameters 

Parameter Description Required

data_policy_
id

Data policy name, UUID, or other unique attribute. yes

target_id Amazon S3 instance name, UUID, or other unique attribute. yes

type The type of replication rule to create.
Value: PERMANENT
Note: Replication rules can be modified to have a type of RETIRED,
but cannot be created as RETIRED.

yes

initial_data_
placement

The storage class for any blobs transferred to the Amazon S3
instance. Values:
• Standard - Provides high availability and performance for
frequently accessed data.

• Reduced Redundancy - Used for cheaper but less reliable storage.
Not recommended for most scenarios.

• Standard IA - (default) - Provides fast access to less frequently
accessed data.

• Glacier - Provides secure, long-term archive for rarely accessed
data.

• Deep Archive - Provides low-cost, durable, and secure long-term
storage for large amounts of data that do not require quick
retrieval.

no

max_blob_
part_
size_in_
bytes

Specifies the maximum blob part size used when creating bulk PUT
jobs. The maximum blob part size is 1 TB. Larger blob part sizes
make public cloud workflows simpler, but may make it more
difficult or impossible to reliably transmit blobs. Less reliable
network connections to the public cloud require smaller blob part
sizes.
Values: Min: 100MB, Max: 1TB, Default: 1GB

no
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Parameter Description Required

replicate_
deletes

Whether objects deleted from buckets are also deleted from the
replication target.
Values:
TRUE (default) — Any delete received locally always replicates on
the Azure target. If the local BlackPearl gateway cannot
communicate with the target, the delete fails.
FALSE— Any deletes received locally do not replicate to the target.

no

Responses

Response Elements
<Data>

   <DataPolicyId>{string}</DataPolicyId>

   <Id>{string}</Id>
   <InitialDataPlacement>

     STANDARD|REDUCED_REDUNDANCY|STANDARD_IA|GLACIER|DEEP_ARCHIVE

   </InitialDataPlacement>
   <MaxBlobPartSizeInBytes>

{64-bit integer}

   </MaxBlobPartSizeInBytes>

   <ReplicateDeletes>TRUE|FALSE</ReplicateDeletes>

   <State>NORMAL|INCLUSION_IN_PROGRESS</State>
   <TargetId>{string}</TargetId>

   <Type>PERMANENT</Type>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

DataPolicyId The UUID for the data policy.

Id The UUID for the Amazon S3 data replication rule.

InitialData
Placement

The storage class for any blobs transferred to the Amazon S3 instance.
Values: Standard, Reduced Redundancy, Standard IA, Glacier, Deep Archive.
See initial_data_placement on page 334 for definitions.

Max Blob Size In
Bytes

The maximum blob size used when creating bulk PUT jobs.
Default: 100 GB
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Parameter Description

ReplicateDeletes Whether objects deleted from local buckets are also deleted from the
replication target.
Values: TRUE, FALSE

State The state of the persistence rule.
Values:
NORMAL — The persistence rule is in a normal, included state.
INCLUSION_IN_PROGRESS — The persistence rule is being applied and data
copying is required before the persistence rule is in a normal, fully included
state.

TargetId The UUID for the target Amazon S3 instance.

Type The type of replication rule.
Values: PERMANENT

Example

Sample Request
This request creates a permanent data replication rule for the data policy named
“financedatapolicy” for the Amazon S3 instance with the target ID
“AWS-S3target1”.
POST http[s]://blackpearl-hostname/_rest_/s3_data_replication_rule/?data_policy_

id=financedatapolicy &target_id=AWS-S3target1&type=PERMANENT HTTP/1.1

Sample Response
HTTP/1.1 201 CREATED
<Data>
   <DataPolicyId>
     5d6fc2b5-169f-4863-8d7f-14e93dec01ec
   </DataPolicyId>
   <Id>dcba2d02-4f2c-4c9a-9b72-9c92fb9da36f</Id>
   <InitialDataPlacement>STANDARD_IA</InitialDataPlacement>
   <MaxBlobPartSizeInBytes>1073741824</MaxBlobPartSizeInBytes>

   <ReplicateDeletes>true</ReplicateDeletes>

   <State>NORMAL</State>

   <TargetId>a0d900bc-60d3-45ec-b6de-023d61a517c0</TargetId>

   <Type>PERMANENT</Type>

</Data>
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CREATE AZURE DATA REPLICATION RULE

Description
Create an Azure data replication rule for a data policy. An Azure data replication rule targets
a specified Microsoft Azure cloud platform.

You cannot specify the same Azure target multiple times in different replication rules applied
to the same data policy. You can reference the same Azure target across different data
policies.

You must create the data policy and register the Azure target before creating the replication
rule. See Create Data Policy on page 326 and Register DS3 Target on page 531.

Requests

Syntax
POST http[s]://{datapathDNSname}/_rest_/azure_data_replication_rule/?data_policy_id=

{string} &target_id={string}&type=PERMANENT [&max_blob_part_size_in_bytes={64-bit

integer}][&replicate_deletes=TRUE|FALSE]

Request Parameters 

Parameter Description Required

data_policy_
id

Data policy name, UUID, or other unique attribute. yes

target_id Azure target name, UUID, or other unique attribute. yes

type The type of replication rule to create.
Value: PERMANENT
Note: Replication rules can be modified to have a type of RETIRED,
but cannot be created as RETIRED.

yes

max_blob_
part_
size_in_
bytes

Specifies the maximum blob part size used when creating bulk PUT
jobs.
The maximum blob part size is 1 TB. Larger blob part sizes make
public cloud workflows simpler, but may make it more difficult or
impossible to reliably transmit blobs. Less reliable network
connections to the public cloud require smaller blob part sizes.
Values: Min: 100MB, Max: 1TB, Default: 1GB

no
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Parameter Description Required

replicate_
deletes

Whether objects deleted from buckets are also deleted from the
replication target.
Values:
TRUE (default) — Any delete received locally always replicates on
the Azure target. If the local BlackPearl gateway cannot
communicate with one or more targets, the delete fails.
FALSE— Any deletes received locally do not replicate to the target.

no

Responses

Response Elements
<Data>

   <DataPolicyId>{string}</DataPolicyId>

   <Id>{string}</Id>
   <MaxBlobPartSizeInBytes>

{64-bit integer}

   </MaxBlobPartSizeInBytes>
   <ReplicateDeletes>TRUE|FALSE</ReplicateDeletes>

   <State>NORMAL|INCLUSION_IN_PROGRESS</State>
   <TargetId>{string}</TargetId>

   <Type>PERMANENT</Type>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

DataPolicyId The UUID for the data policy.

Id The UUID for the Azure data replication rule.

Max Blob Size In
Bytes

The maximum blob size used when creating bulk PUT jobs.
Default: 100 GB

ReplicateDeletes Whether objects deleted from local buckets are also deleted from the
replication target.
Values: TRUE, FALSE
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Parameter Description

State The state of the persistence rule.
Values:
NORMAL — The persistence rule is in a normal, included state.
INCLUSION_IN_PROGRESS — The persistence rule is being applied and data
copying is required before the persistence rule is in a normal, fully included
state.

TargetId The UUID for the Azure target.

Type The type of replication rule.
Values: PERMANENT

Example

Sample Request
This request creates a permanent Azure data replication rule for the data policy named
“datapolicy1” for the Azure target with the name “azuretarget1”.
POST http://blackpearl-hostname/_rest_/azure_data_replication_rule/?data_policy_

id=datapolicy1&target_id=azuretarget1&type=PERMANENT HTTP/1.1

Sample Response
HTTP/1.1 200 OK
<Data>

   <DataPolicyId>

     5d6fc2b5-169f-4863-8d7f-

   </DataPolicyId>
   <Id>dcba2d02-4f2c-4c9a-9b72-9c92fb9da36f</Id>
   <MaxBlobPartSizeInBytes>

     b1c814cc-71e4-55fb-c7da-142c52b644b1

   </MaxBlobPartSizeInBytes>
   <ReplicateDeletes>TRUE</ReplicateDeletes>
   <State>NORMAL</State>

   <TargetId>a0d900bc-60d3-45ec-b6de-023d61a517c0</TargetId>

   <Type>PERMANENT</Type>

</Data>
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CREATE DS3 DATA REPLICATION RULE

Description
Create a DS3 data replication rule for a data policy. Each DS3 replication rule targets a
specified BlackPearl target.

You cannot specify the same BlackPearl target multiple times in different replication rules
applied to the same data policy. You can reference the same BlackPearl target across different
data policies.

You must create the data policy and register the BlackPearl target before creating the
replication rule. See Create Data Policy on page 326 and Register DS3 Target on page 531.

Requests

Syntax
POST http[s]://{datapathDNSname}/_rest_/ds3_data_replication_rule/?data_policy_id=

{string}&target_id={string}&type=PERMANENT[&target_data_policy={string}][&replicate_

deletes=TRUE|FALSE]

Request Parameters 

Parameter Description Required

data_policy_
id

Data policy name, UUID, or other unique attribute. yes

target_id BlackPearl target name, UUID, or other unique attribute. yes

type The type of replication rule to create.
Value: PERMANENT
Note: Replication rules can be modified to have a type of RETIRED,
but cannot be created as RETIRED.

yes

replicate_
deletes

Whether objects deleted from buckets are also deleted from the
replication target.
Values:
TRUE (default) — Any delete received locally always replicates on
the Azure target. If the local BlackPearl gateway cannot
communicate with one or more targets, the delete fails.
FALSE— Any deletes received locally do not replicate to the target.

no
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Parameter Description Required

target_data_
policy

The BlackPearl target data policy name, UUID, or other unique
attribute.

no

Responses

Response Elements
<Data>

   <DataPolicyId>{string}</DataPolicyId>

   <Id>{string}</Id>

   <ReplicateDeletes>TRUE|FALSE</ReplicateDeletes>
   <State>NORMAL|INCLUSION_IN_PROGRESS</State>
   <TargetDataPolicy>{string}</TargetDataPolicy>
   <TargetId>{string}</TargetId>

   <Type>PERMANENT</Type>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

DataPolicyId The UUID for the data policy.

Id The UUID for the DS3 data replication rule.

ReplicateDeletes Whether objects deleted from local buckets are also deleted from the
replication target.
Values: TRUE, FALSE

State The state of the persistence rule. Value:
NORMAL — The persistence rule is in a normal, included state.
INCLUSION_IN_PROGRESS — The persistence rule is being applied and data
copying is required before the persistence rule is in a normal, fully included
state.

TargetDataPolicy The UUID for the data policy on the BlackPearl target.

TargetId The UUID for the BlackPearl target.

Type The type of replication rule.
Values: PERMANENT
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Example

Sample Request
This request creates a permanent data replication rule for the data policy named “ds3policy1”
for the BlackPearl target with the name “ds3target1” using the default data policy for the
target.
POST http://blackpearl-hostname/_rest_/ds3_data_replication_rule/?data_policy_

id=ds3policy1&target_id=ds3target1&type=PERMANENT HTTP/1.1

Sample Response
HTTP/1.1 200 OK
<Data>

   <DataPolicyId>

      a1e39fc5-a752-4740-b9f0-4ae5c3b97e81

   </DataPolicyId>

   <Id>2b44efc8-02f9-48b0-bd4d-5e8033333e18</Id>

   <ReplicateDeletes>TRUE</ReplicateDeletes>
   <State>NORMAL</State>
   <TargetDataPolicy>

     3a24ffb7-15f7-33c1-fd3d-6d812513f10

   </TargetDataPolicy>

   <TargetId>sfqc4721-6370-2122-949e-92515e7a320f</TargetId>

   <Type>PERMANENT</Type>

</Data>

DELETE DATA PERSISTENCE RULE

Description
Delete the specified data persistence rule from a data policy.

Note: You cannot delete a data persistence rule if it is the last permanent data persistence
rule for a data policy that does not require a rebuild due to degradation.
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Requests

Syntax
DELETE http[s]://{datapathDNSname}/_rest_/data_persistence_rule/{data persistence

rule UUID or other unique attribute}/

To determine the UUID for a data persistence rule, see Get Data Persistence Rules on
page 350.

Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 403: Access Denied
• 404: Not Found

Example

Sample Request
This request deletes the data persistence rule with the UUID fd1691f8-e8c5-43e9-aef7-
4b8c4b21a0b5.
DELETE http[s]://blackpearl-hostname/_rest_/data_persistence_rule/fd1691f8-e8c5-

43e9-aef7-4b8c4b21a0b5/ HTTP/1.1

Sample Response
HTTP/1.1 204 No Content

DELETE DATA POLICY

Description
Delete the specified data policy.

Note: You cannot delete a data policy if a bucket is using it.
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Syntax
DELETE http[s]://{datapathDNSname}/_rest_/data_policy/{data policy UUID, name, or

other unique attribute}/

To determine the UUID for a data policy, see Get Data Policies on page 353.

Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 403: Access Denied
• 404: Not Found

Example

Sample Request
This request deletes the data policy with the name “policy1”.
DELETE http[s]://blackpearl-hostname/_rest_/data_policy/policy1/ HTTP/1.1

Sample Response
HTTP/1.1 204 No Content

DELETE AMAZON S3 DATA REPLICATION RULE

Description
Delete the specified Amazon S3 data replication rule from a data policy.
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Requests

Syntax
DELETE http[s]://{datapathDNSname}/_rest_/s3_data_replication_rule/{data persistence

rule UUID or other unique attribute}/

To determine the UUID for an Amazon S3 data replication rule, see Get Amazon S3 Data
Replication Rules on page 364.

Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 403: Access Denied
• 404: Not Found

Example

Sample Request
This request deletes the Amazon S3 data replication rule with the UUID 2b44efc8-02f9-48b0-
bd4d-5e8033333e18.
DELETE http[s]://blackpearl-hostname/_rest_/s3_data_replication_rule/2b44efc8-02f9-

48b0-bd4d-5e8033333e18 HTTP/1.1

Sample Response
HTTP/1.1 204 No Content

DELETE AZURE DATA REPLICATION RULE

Description
Delete the specified Azure data replication rule from a data policy.
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Requests

Syntax
DELETE http[s]://{datapathDNSname}/_rest_/azure_data_replication_rule/{data

persistence rule UUID or other unique attribute}/

To determine the UUID for an Azure data replication rule, see Get Azure Data Replication
Rules on page 370.

Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 403: Access Denied
• 404: Not Found

Example

Sample Request
This request deletes the Azure data replication rule with the UUID 2b44efc8-02f9-48b0-bd4d-
5e8033333e18.
DELETE http[s]://blackpearl-hostname/_rest_/azure_data_replication_rule/2b44efc8-

02f9-48b0-bd4d-5e8033333e18/ HTTP/1.1

Sample Response
HTTP/1.1 204 No Content

DELETE DS3 DATA REPLICATION RULE

Description
Delete the specified DS3 data replication rule from a data policy.
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Requests

Syntax
DELETE http[s]://{datapathDNSname}/_rest_/ds3_data_replication_rule/{data

persistence rule UUID or other unique attribute}/

To determine the UUID for a DS3 data replication rule, see Get DS3 Data Replication Rules
on page 375.

Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 403: Access Denied
• 404: Not Found

Example

Sample Request
This request deletes the DS3 data replication rule with the UUID 2b44efc8-02f9-48b0-bd4d-
5e8033333e18.
DELETE http[s]://blackpearl-hostname/_rest_/ds3_data_replication_rule/2b44efc8-02f9-

48b0-bd4d-5e8033333e18/ HTTP/1.1

Sample Response
HTTP/1.1 204 No Content

GET DATA PERSISTENCE RULE

Description
Get information about the specified data persistence rule.
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Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/data_persistence_rule/{data persistence rule

UUID or other unique attribute}/

To determine the UUID for a data persistence rule, see Get Data Persistence Rules on
page 350.

Responses

Response Elements
<Data>

   <DataPolicyId>{string}</DataPolicyId>

   <Id>{string}</Id>

   <IsolationLevel>

      STANDARD|BUCKET_ISOLATED

   </IsolationLevel>

   <MinimumDaysToRetain>{32-bit integer}</MinimumDaysToRetain>

   <State>NORMAL|INCLUSION_IN_PROGRESS</State>

   <StorageDomainId>{string}</StorageDomainId>

   <Type>PERMANENT|TEMPORARY|RETIRED</Type>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

DataPolicyId The UUID for the data policy.

Id The UUID for the persistence rule.

IsolationLevel The level of physical isolation required for the data retention. Values:
STANDARD, BUCKET_ISOLATED
See isolation_level on page 324 for descriptions.

MinimumDaysTo
Retain

The minimum number of days the data should be retained based on a
TEMPORARY persistence rule.
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Parameter Description

State The state of the persistence rule.
Values:
NORMAL — The persistence rule is in a normal, included state.
INCLUSION_IN_PROGRESS — The persistence rule is being applied and data
copying is required before the persistence rule is in a normal, fully included
state.

StorageDomainId The UUID for the storage domain.

Type The type of persistence rule.
Values:
• PERMANENT — A copy of the data is placed in the specified storage
domain initially and maintained there permanently.

• RETIRED — A copy of already-written data is maintained, but the rule is
not applied to new data.

• TEMPORARY — A copy of the data is placed in the specified storage
domain initially and maintained there at least until the specified retention
period expires.

Example

Sample Request
This request gets information about the data persistence rule with the UUID f300563a-80c1-
4d30-93f4-946928989712.
GET http://blackpearl-hostname/_rest_/data_persistence_rule/f300563a-80c1-4d30-93f4-

946928989712/ HTTP/1.1
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Sample Response
HTTP/1.1 200 OK

<Data>

   <DataPolicyId>

      955ed961-eaa1-4e36-a88c-4b066366ec78

   </DataPolicyId>

   <Id>f300563a-80c1-4d30-93f4-946928989712</Id>

   <IsolationLevel>STANDARD</IsolationLevel>

   <MinimumDaysToRetain/>

   <State>NORMAL</State>

   <StorageDomainId>

      eedfd905-42cb-4460-9963-5fba10625707

   </StorageDomainId>

   <Type>PERMANENT</Type>

</Data>

GET DATA PERSISTENCE RULES

Description
Get information about all data persistence rules. Use parameters as selection criteria to return
a subset of the list.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/data_persistence_rule/[?data_policy_id=

{string}][&isolation_level=STANDARD|BUCKET_ISOLATED][&last_page][&page_length=

{32-bit integer}][&page_offset={32-bit integer}][&page_start_marker={string}]

[&state=NORMAL|INCLUSION_IN_PROGRESS][&storage_domain_id={string}]

[&type=PERMANENT|TEMPORARY|RETIRED]

Request Parameters 

Parameter Description Required

data_policy_
id

Data policy UUID or other unique attribute. no
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Parameter Description Required

isolation_
level

The level of physical isolation required for the data retention.
Values: STANDARD, BUCKET_ISOLATED
See isolation_level on page 324 for descriptions.

no

last_page If included, only the last page of results is returned. no

page_length The maximum number of data persistence rules to list.
Default: all items after page_offset.

no

page_offset The starting point for the first data persistence rule to list. Default:
0.

no

page_start_
marker

The UUID or other unique attribute for the item just before the first
item to list.
Notes:
• Specifying both page_offset and page_start_marker causes
an error.

• If neither page_offset, nor page_start_marker are specified,
the page_offset default is used.

no

state The state of the persistence rule.
Values:
NORMAL — The persistence rule is in a normal, included state.
INCLUSION_IN_PROGRESS — The persistence rule is being applied
and data copying is required before the persistence rule is in a
normal, fully included state.

no

storage_
domain_id

Storage domain UUID or other unique attribute. no

type The type of persistence rule.
Values: PERMANENT, RETIRED, TEMPORARY. See Type on page 349
for descriptions.

yes
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Responses

Response Elements
<Data>

   <DataPersistenceRule>

      <DataPolicyId>{string}</DataPolicyId>

      <Id>{string}</Id>

      <IsolationLevel>STANDARD|BUCKET_ISOLATED</IsolationLevel>

      <MinimumDaysToRetain>{32-bit integer}</MinimumDaysToRetain>

      <State>NORMAL|INCLUSION_IN_PROGRESS</State>

      <StorageDomainId>{string}</StorageDomainId>

      <Type>PERMANENT|TEMPORARY|RETIRED</Type>

   </DataPersistenceRule>

   ...

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

DataPersistence
Rule

The container for information about one data persistence rule.

DataPolicyId The UUID for the data policy.

Id The UUID for the persistence rule.

IsolationLevel The level of physical isolation required for the data retention. Values:
STANDARD, BUCKET_ISOLATED
See isolation_level on page 324 for descriptions.

MinimumDaysTo
Retain

The minimum number of days the data should be retained based on a
TEMPORARY persistence rule.

State The state of the persistence rule.
Values:
NORMAL — The persistence rule is in a normal, included state.
INCLUSION_IN_PROGRESS — The persistence rule is being applied and data
copying is required before the persistence rule is in a normal, fully included
state.

StorageDomainId The UUID for the storage domain.

April 2023 DS3 API Reference-Spectra BlackPearl Nearline Gateway
- 352 -



Chapter 11 - Data Policy Operations Get Data Policies

Parameter Description

Type The type of persistence rule.
Values: PERMANENT, TEMPORARY, RETIRED. See Type on page 349 for
descriptions.

Example

Sample Request
This request gets information about all data persistence rules on the BlackPearl gateway.
GET http://blackpearl-hostname/_rest_/data_persistence_rule/ HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>

   <DataPersistenceRule>

      <DataPolicyId>

         b1b60034-046d-4006-8fb0-dc73188d1d66

      </DataPolicyId>

      <Id>b67587bb-d7a9-4f7a-85e1-f7010760053a</Id>

      <IsolationLevel>STANDARD</IsolationLevel>

      <MinimumDaysToRetain/>

      <State>NORMAL</State>

      <StorageDomainId>

         b843e63a-e718-4350-a8e7-56600b91547a

      </StorageDomainId>

      <Type>PERMANENT</Type>
   </DataPersistenceRule>
   ...

</Data>

GET DATA POLICIES

Description
Get information about all data policies. Use parameters as selection criteria to return a subset
of the list.
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Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/data_policy/[?always_force_put_job_

creation=TRUE|FALSE][&always_minimize_spanning_across_media=TRUE|FALSE][&checksum_

type=CRC_32|CRC_32C|MD5|SHA_256|SHA_512][&end_to_end_crc_required=TRUE|FALSE][&last_

page][&name={string}][&page_length={32-bit integer}][&page_offset={32-bit integer}]

[&page_start_marker={string}]

Request Parameters 

Parameter Description Required

always_
force_put_
job_creation

Whether all PUT jobs created for this data policy are created even if
one or more storage domains and/or replication targets the
BlackPearl gateway must PUT to is unavailable, or if there are
global issues that would likely prevent the completion of the job.
Values: TRUE, FALSE

no

always_
minimize_
spanning_
across_media

Whether all PUT jobs created using this data policy are configured
to minimize spanning across tape media. Values: TRUE, FALSE. See
always_minimize_ spanning_across_media on page 327.

no

checksum_
type

The type of checksum used to verify data integrity for any
operations involving this data policy and the type of checksum
required for end-to-end CRC, if specified.
Values: CRC_32, CRC_32C, MD5, SHA_256, SHA_512

no

end_to_end_
crc_
required

Whether or not clients are required to compute and send an end-to-
end CRC. Values: TRUE, FALSE

no

last_page If included, only the last page of results is returned. no

name 1 The name for the data policy. no

page_length The maximum number of data policies to list.
Default: all items after page_offset.

no

page_offset The starting point for the first data policy to list.
Default: 0.

no

1) Parameter values can use wild cards (see Wild Card Syntax on page 30).
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Parameter Description Required

page_start_
marker

The UUID or other unique attribute for the item just before the first
item to list.
Notes:
• Specifying both page_offset and page_start_marker
causes an error.

• If neither page_offset, nor page_start_marker are
specified, the page_offset default is used.

no

Responses

Response Elements
<Data>

   <DataPolicy>

      <AlwaysForcePutJobCreation>

         TRUE|FALSE

      </AlwaysForcePutJobCreation>

      <AlwaysMinimizeSpanningAcrossMedia>

         TRUE|FALSE

      </AlwaysMinimizeSpanningAcrossMedia>
      <BlobbingEnabled>TRUE</BlobbingEnabled>

      <ChecksumType>

         CRC_32|CRC_32C|MD5|SHA_256|SHA_512

      </ChecksumType>
      <CreationDate>YYYY-MM-DDThh:mm:ss.xxxZ</CreationDate>

      <DefaultBlobSize>{64-bit integer}</DefaultBlobSize>

      <DefaultGetJobPriority>

         CRITICAL|URGENT|HIGH|NORMAL|LOW|BACKGROUND

      </DefaultGetJobPriority>
      <DefaultPutJobPriority>

         CRITICAL|URGENT|HIGH|NORMAL|LOW|BACKGROUND

      </DefaultPutJobPriority>
      <DefaultVerifyAfterWrite>

         TRUE|FALSE

      </DefaultVerifyAfterWrite>
      <DefaultVerifyJobPriority>

         CRITICAL|URGENT|HIGH|NORMAL|LOW|BACKGROUND

      </DefaultVerifyJobPriority>
      <EndToEndCrcRequired>TRUE|FALSE</EndToEndCrcRequired>

      <Id>{string}</Id>

      <MaxVersionsToKeep>{32-bit integer}</MaxVersionsToKeep>

      <Name>{string}</Name>
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      <RebuildPriority>

         CRITICAL|URGENT|HIGH|NORMAL|LOW|BACKGROUND

      </RebuildPriority>

      <Versioning>NONE|KEEP_LAST</Versioning>
   </DataPolicy>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

DataPolicy The container for information about one data policy.

AlwaysForcePutJobCreation Whether all PUT jobs created for this data policy are created
even if one or more storage domains and/or replication targets
the BlackPearl gateway must PUT to is unavailable, or if there
are global issues that would likely prevent the completion of the
job.
Values: TRUE, FALSE

AlwaysMinimize
SpanningAcross Media

Whether all PUT jobs created for this data policy are created to
minimize spanning across media.
Values: TRUE, FALSE. See always_minimize_ spanning_across_
media on page 327.

BlobbingEnabled Whether or not blobbing is enabled.

ChecksumType Type of checksum used to verify data integrity for any
operations involving this data policy.
Values: CRC_32, CRC_32C, MD5, SHA_256, SHA_512

CreationDate The date and time the data policy was created in the format
YYYY-MM-DDThh:mm:ss.xxxZ.

DefaultBlobSize The maximum blob size.

DefaultGetJob
Priority

The default GET job priority for the data policy. The job priority
determines the resources assigned and the processing order.
Values: CRITICAL, URGENT, HIGH, NORMAL, LOW, BACKGROUND

DefaultPutJob
Priority

The default PUT job priority for the data policy. The job priority
determines the resources assigned and the processing order.
Values: CRITICAL, URGENT, HIGH, NORMAL, LOW, BACKGROUND
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Parameter Description

DefaultVerifyAfterWrite Whether data is verified by default after it is written.
Values: TRUE, FALSE

DefaultVerifyJob
Priority

The default verify job priority for the data policy. The job priority
determines the resources assigned and the processing order.
Values: CRITICAL, URGENT, HIGH, NORMAL, LOW, BACKGROUND

EndToEndCrc
Required

Whether or not clients are required to compute and send an end-
to-end CRC. Values: TRUE, FALSE

Id The UUID for the data policy.

MaxVersionsTo Keep The number of versions of an object to keep if versioning=KEEP_
MULTIPLE_VERSIONS.

Name The name of the data policy.

RebuildPriority The rebuild priority for the data policy. The rebuild priority
determines the relative priority compared to other jobs being
processed.
Values: CRITICAL, URGENT, HIGH, NORMAL, LOW, BACKGROUND

Versioning The mode of versioning used by the data policy.
Values: NONE, KEEP_LATEST, KEEP_MULTIPLE_VERSIONS see
versioning on page 330.

Example

Sample Request
This request gets information about all data policies on the BlackPearl gateway.
GET http://blackpearl-hostname/_rest_/data_policy/ HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>

   <DataPolicy>

      <AlwaysForcePutJobCreation>FALSE</AlwaysForcePutJobCreation>

      <AlwaysMinimizeSpanningAcrossMedia>

         FALSE

      </AlwaysMinimizeSpanningAcrossMedia>

      <BlobbingEnabled>TRUE</BlobbingEnabled>

      <ChecksumType>MD5</ChecksumType>
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      <CreationDate>2015-07-29 16:26:12.768</CreationDate>

      <DefaultBlobSize/>

      <DefaultGetJobPriority>HIGH</DefaultGetJobPriority>

      <DefaultPutJobPriority>NORMAL</DefaultPutJobPriority>

      <DefaultVerifyJobPriority>LOW</DefaultVerifyJobPriority>

      <EndToEndCrcRequired>FALSE</EndToEndCrcRequired>

      <Id>43d40cce-bb94-4b73-a504-8811f37d8012</Id>
      <MaxVersionsToKeep>1000</MaxVersionsToKeep>

      <Name>policy1</Name>

      <RebuildPriority>LOW</RebuildPriority>

      <Versioning>NONE</Versioning>

   </DataPolicy>

   ...

</Data>

GET DATA POLICY

Description
Get information about the specified data policy.

Requests
Syntax
GET http[s]://{datapathDNSname}/_rest_/data_policy/{data policy UUID, name, or other

unique attribute}/

To determine the UUID for a data policy, see Get Data Policies on page 353.

Responses
Response Elements
<Data>

   <AlwaysForcePutJobCreation>

      TRUE|FALSE

   </AlwaysForcePutJobCreation>

   <AlwaysMinimizeSpanningAcrossMedia>

      TRUE|FALSE

   </AlwaysMinimizeSpanningAcrossMedia>
   <BlobbingEnabled>TRUE</BlobbingEnabled>

   <ChecksumType>

      CRC_32|CRC_32C|MD5|SHA_256|SHA_512

   </ChecksumType>
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   <CreationDate>YYYY-MM-DDThh:mm:ss.xxxZ</CreationDate>

   <DefaultBlobSize>{64-bit integer}</DefaultBlobSize>

   <DefaultGetJobPriority>

      CRITICAL|URGENT|HIGH|NORMAL|LOW|BACKGROUND

   </DefaultGetJobPriority>
   <DefaultPutJobPriority>

      CRITICAL|URGENT|HIGH|NORMAL|LOW|BACKGROUND

   </DefaultPutJobPriority>

   <DefaultVerifyJobPriority>

      CRITICAL|URGENT|HIGH|NORMAL|LOW|BACKGROUND

   </DefaultVerifyJobPriority>
   <DefaultVerifyAfterWrite>TRUE|FALSE</DefaultVerifyAfterWrite>

   <EndToEndCrcRequired>TRUE|FALSE</EndToEndCrcRequired>

   <Id>{string}</Id>

   <MaxVersionsToKeep>{32-bit integer}</MaxVersionsToKeep>
   <Name>{string}</Name>
   <RebuildPriority>

      CRITICAL|URGENT|HIGH|NORMAL|LOW|BACKGROUND

   </RebuildPriority>
   <Versioning>NONE|KEEP_LAST</Versioning>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

AlwaysForcePutJobCreation Whether all PUT jobs created for this data policy are created
even if one or more storage domains and/or replication targets
the BlackPearl gateway must PUT to is unavailable, or if there
are global issues that would likely prevent the completion of the
job.
Values: TRUE, FALSE

AlwaysMinimize
SpanningAcross Media

Whether all PUT jobs created for this data policy are created to
minimize spanning across media.
Values: TRUE, FALSE. See always_minimize_ spanning_across_
media on page 327.

BlobbingEnabled Whether or not blobbing is enabled.

ChecksumType Type of checksum used to verify data integrity for any
operations involving this data policy.
Values: CRC_32, CRC_32C, MD5, SHA_256, SHA_512
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Parameter Description

CreationDate The date and time the data policy was created in the format
YYYY-MM-DDThh:mm:ss.xxxZ.

DefaultBlobSize The maximum blob size.

DefaultGetJob
Priority

The default GET job priority for the data policy. The job priority
determines the resources assigned and the processing order.
Values: CRITICAL, URGENT, HIGH, NORMAL, LOW, BACKGROUND

DefaultPutJob
Priority

The default PUT job priority for the data policy. The job priority
determines the resources assigned and the processing order.
Values: CRITICAL, URGENT, HIGH, NORMAL, LOW, BACKGROUND

DefaultVerifyAfterWrite Whether data is verified by default after it is written.
Values: TRUE, FALSE

DefaultVerifyJob
Priority

The default verify job priority for the data policy. The job priority
determines the resources assigned and the processing order.
Values: CRITICAL, URGENT, HIGH, NORMAL, LOW, BACKGROUND

EndToEndCrc
Required

Whether or not clients are required to compute and send an end-
to-end CRC. Values: TRUE, FALSE

Id The UUID for the data policy.

MaxVersionsTo Keep The number of versions of an object to keep if versioning=KEEP_
MULTIPLE_VERSIONS.

Name The name of the data policy.

RebuildPriority The rebuild priority for the data policy. The rebuild priority
determines the relative priority compared to other jobs being
processed.
Values: CRITICAL, URGENT, HIGH, NORMAL, LOW, BACKGROUND

Versioning The mode of versioning used by the data policy.
Values: NONE, KEEP_LATEST, KEEP_MULTIPLE_VERSIONS see
versioning on page 330.

Example

Sample Request
This request gets information about the data policy with the name “policy1”.
GET http://blackpearl-hostname/_rest_/data_policy/policy1/ HTTP/1.1
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Sample Response
HTTP/1.1 200 OK

<Data>

   <AlwaysForcePutJobCreation>FALSE</AlwaysForcePutJobCreation>

   <AlwaysMinimizeSpanningAcrossMedia>

      FALSE

   </AlwaysMinimizeSpanningAcrossMedia>
   <BlobbingEnabled>TRUE</BlobbingEnabled>

   <ChecksumType>MD5</ChecksumType>

   <CreationDate>2015-07-29 16:26:12.852</CreationDate>

   <DefaultBlobSize/>

   <DefaultGetJobPriority>HIGH</DefaultGetJobPriority>

   <DefaultPutJobPriority>NORMAL</DefaultPutJobPriority>
   <DefaultVerifyAfterWrite>TRUE</DefaultVerifyAfterWrite>

   <DefaultVerifyJobPriority>LOW</DefaultVerifyJobPriority>

   <EndToEndCrcRequired>FALSE</EndToEndCrcRequired>

   <Id>9f7418e5-67e6-47f7-8653-dec602c66eeb</Id>

   <MaxVersionsToKeep>1000</MaxVersionsToKeep>
   <Name>policy1</Name>

   <RebuildPriority>LOW</RebuildPriority>

   <Versioning>NONE</Versioning>

</Data>

GET AMAZON S3 DATA REPLICATION RULE

Description
Get information about the specified data replication rule.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/s3_data_replication_rule/{data replication

rule UUID or other unique attribute}/

To determine the UUID for an Amazon S3 data replication rule, see Get Amazon S3 Data
Replication Rules on page 364.
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Responses

Response Elements
<Data>

   <DataPolicyId>{string}</DataPolicyId>

   <Id>{string}</Id>
   <InitialDataPlacement>

     STANDARD|REDUCED_REDUNDANCY|STANDARD_IA|GLACIER|DEEP_ARCHIVE

   </InitialDataPlacement>
   <MaxBlobPartSizeInBytes>

{64-bit integer}

   </MaxBlobPartSizeInBytes>

   <ReplicateDeletes>TRUE|FALSE</ReplicateDeletes>

   <State>NORMAL|INCLUSION_IN_PROGRESS</State>
   <TargetId>{string}</TargetId>

   <Type>PERMANENT|RETIRED</Type>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

DataPolicyId The UUID for the data policy.

Id The UUID for the Amazon S3 data replication rule.

InitialDataPlacement The storage class for any blobs transferred to the Amazon S3 instance.
Values: Standard, Reduced Redundancy, Standard IA, Glacier, Deep
Archive. See initial_data_placement on page 334 for definitions.

Max Blob Size In Bytes The maximum blob size used when creating bulk PUT jobs.
Default: 100 GB

ReplicateDeletes Whether objects deleted from local buckets are also deleted from the
replication target.
Values: TRUE, FALSE
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Parameter Description

State The state of the persistence rule.
Values:
NORMAL — The persistence rule is in a normal, included state.
INCLUSION_IN_PROGRESS — The persistence rule is being applied and
data copying is required before the persistence rule is in a normal, fully
included state.

TargetId The UUID for the target Amazon S3 instance.

Type The type of replication rule. Values: PERMANENT

Example

Sample Request
This request gets information about the Amazon S3 data replication rule with the UUID
28b7a84f-347b-4937-8c1d-0b697a6f04de.
GET http://blackpearl-hostname/_rest_/s3_data_replication_rule/28b7a84f-347b-4937-

8c1d-0b697a6f04de/ HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>

   <DataPolicyId>

      1f65b24e-6a55-4c32-ba0f-e02b82e59b88

   </DataPolicyId>

   <Id>28b7a84f-347b-4937-8c1d-0b697a6f04de</Id>
   <InitialDataPlacement>STANDARD</InitialDataPlacement>
   <MaxBlobPartSizeInBytes>
     b1c814cc-71e4-55fb-c7da-142c52b644b1

   </MaxBlobPartSizeInBytes>

   <ReplicateDeletes>TRUE</ReplicateDeletes>

   <State>NORMAL</State>
   <TargetId>1c81d05d-48d9-4c5e-9035-b9f5351cf311</TargetId>

   <Type>PERMANENT</Type>

</Data>
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GET AMAZON S3 DATA REPLICATION RULES

Description
Get information about all Amazon S3 replication rules. Use parameters as selection criteria to
return a subset of the list.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/s3_data_replication_rule/[?data_policy_id=

{string}][&initial_data_placement=STANDARD|REDUCED_REDUNDANCY|STANDARD_

IA|GLACIER|DEEP_ARCHIVE][&last_page] [&page_length={32-bit integer}][&page_offset=

{32-bit integer}][&page_start_marker={string}][&replicate_deletes=TRUE|FALSE]

[&state=NORMAL][&target_id={string}][&type=PERMANENT|RETIRED]

Request Parameters 

Parameter Description Required

data_policy_
id

Data policy UUID or other unique attribute. no

initial_data_
placement

The storage class for any blobs transferred to the Amazon S3
instance. Values:
Values: Standard, Reduced Redundancy, Standard IA, Glacier, Deep
Archive. See initial_data_placement on page 334 for definitions.

no

last_page If included, only the last page of results is returned. no

page_length The maximum number of Amazon S3 replication rules to list.
Default: all items after page_offset.

no

page_offset The starting point for the first Amazon S3 replication rule to list.
Default: 0.

no
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Parameter Description Required

page_start_
marker

The UUID or other unique attribute for the item just before the first
item to list.
Notes:
• Specifying both page_offset and page_start_marker causes
an error.

• If neither page_offset, nor page_start_marker are
specified, the page_offset default is used.

no

replicate_
deletes

Whether objects deleted from local buckets are also deleted from the
replication target.
Values: TRUE, FALSE

no

state The state of the replication rule.
Values: NORMAL — The Amazon S3 replication rule is in a normal,
included state.

no

target_id The Amazon S3 target UUID or other unique attribute. no

type The type of Azure replication rule.
Values: PERMANENT, RETIRED. See Type on page 396 for
descriptions.

no

Responses

Response Elements
<Data>
   <S3DataReplicationRule>
     <DataPolicyId>{string}</DataPolicyId>
     <Id>{string}</Id>
     <InitialDataPlacement>
        STANDARD|REDUCED_REDUNDANCY|STANDARD_IA|GLACIER|DEEP_ARCHIVE

     </InitialDataPlacement>
     <MaxBlobPartSizeInBytes>{string}</MaxBlobPartSizeInBytes>
     <ReplicateDeletes>TRUE|FALSE</ReplicateDeletes

     <State>NORMAL|INCLUSION_IN_PROGRESS</State>
     <TargetId>{string}</TargetId>

     <Type>PERMANENT</Type>

   </S3DataReplicationRule>

</Data>
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where the response elements are defined as follows:

Parameter Description

Data The container for the response.

S3ReplicationRule The container for information about one Amazon S3 replication rule.

DataPolicyId The UUID for the data policy.

Id The UUID for the Amazon S3 replication rule.

InitialDataPlacement The storage class for any blobs transferred to the Amazon S3 instance.
Values: Standard, Reduced Redundancy, Standard IA, Glacier, Deep
Archive. See initial_data_placement on page 334 for definitions.

ReplicateDeletes Whether objects deleted from local buckets are also deleted from the
replication target.
Values: TRUE, FALSE

State The state of the persistence rule.
Values:
NORMAL — The persistence rule is in a normal, included state.
INCLUSION_IN_PROGRESS — The persistence rule is being applied and
data copying is required before the persistence rule is in a normal, fully
included state.

TargetId The UUID for the Amazon S3 target.

Type The type of Amazon S3 replication rule.
Values: PERMANENT, RETIRED. See Type on page 396 for descriptions.

Example

Sample Request
This request gets information about all Amazon S3 data replication rules on the BlackPearl
gateway.
GET http://blackpearl-hostname/_rest_/s3_data_replication_rule/HTTP/1.1
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Sample Response
HTTP/1.1 200 OK

<Data>

   <S3DataReplicationRule>

     <DataPolicyId>

       d8945332-11f2-47d0-8ca8-dafe204d2d1e

     </DataPolicyId>

     <Id>8ac0c6fd-de37-4936-8862-caa0f1844735</Id>
     <InitialDataPlacement>STANDARD_IA</InitialDataPlacement>
     <MaxBlobPartSizeInBytes>1073741824</MaxBlobPartSizeInBytes>
     <ReplicateDeletes>TRUE</ReplicateDeletes

     <State>NORMAL</State>
     <TargetId>1dad5f1e-d55b-415a-a8ab-9bc387e1eb33</TargetId>
     <Type>PERMANENT</Type>
   </S3DataReplicationRule>
   <S3DataReplicationRule>
     <DataPolicyId>
        9f7418e5-67e6-47f7-8653-dec602c66eeb

     </DataPolicyId>
     <Id>1c81d05d-48d9-4c5e-9035-b9f5351cf311</Id>
     <InitialDataPlacement>STANDARD_IA</InitialDataPlacement>
     <MaxBlobPartSizeInBytes>1073741824</MaxBlobPartSizeInBytes>
     <State>NORMAL</State>
     <TargetId>d86f4876-46d9-432c-843c-a6dd12355e7e</TargetId>
     <Type>PERMANENT</Type>
   </S3DataReplicationRule>
</Data>

GET AZURE DATA REPLICATION RULE

Description
Get information about the specified Azure data replication rule.
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Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/azure_data_replication_rule/{data replication

rule UUID or other unique attribute}/

To determine the UUID for an Azure data replication rule, see Get Azure Data Replication
Rules on page 370.

Responses

Response Elements
<Data>

   <DataPolicyId>{string}</DataPolicyId>

   <Id>{string}</Id>
   <MaxBlobPartSizeInBytes>

{64-bit integer}

   </MaxBlobPartSizeInBytes>

   <ReplicateDeletes>TRUE|FALSE</ReplicateDeletes

   <State>NORMAL|INCLUSION_IN_PROGRESS</State>
   <TargetId>{string}</TargetId>

   <Type>PERMANENT|RETIRED</Type>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

DataPolicyId The UUID for the data policy.

Id The UUID for the Azure data replication rule.

Max Blob Size In
Bytes

The maximum blob size used when creating bulk PUT jobs.
Default: 100 GB

ReplicateDeletes Whether objects deleted from local buckets are also deleted from the
replication target.
Values: TRUE, FALSE
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Parameter Description

State The state of the persistence rule.
Values:
NORMAL — The persistence rule is in a normal, included state.
INCLUSION_IN_PROGRESS — The persistence rule is being applied and data
copying is required before the persistence rule is in a normal, fully included
state.

TargetId The UUID for the Azure target.

Type The type of replication rule.
Values: PERMANENT

Example

Sample Request
This request gets information about the Azure data replication rule with the UUID 28b7a84f-
347b-4937-8c1d-0b697a6f04de.
GET http://blackpearl-hostname/_rest_/azure data_replication_rule/28b7a84f-347b-

4937-8c1d-0b697a6f04de/ HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>

   <DataPolicyId>

     bd42cb6b-875e-4d02-8109-8ee349453111

   </DataPolicyId>

   <Id>86536861-9067-404b-8472-bcadf5a9fe1b</Id>
   <MaxBlobPartSizeInBytes>

     1073741824</MaxBlobPartSizeInBytes>

   <ReplicateDeletes>TRUE</ReplicateDeletes
   <State>NORMAL</State>

   <TargetId>46438485-c87e-4ab9-94ec-00fa12571869</TargetId>

   <Type>PERMANENT</Type>

</Data>
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GET AZURE DATA REPLICATION RULES

Description
Get information about all Azure replication rules. Use parameters as selection criteria to
return a subset of the list.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/azure_data_replication_rule/[?data_policy_id=

{string}][&last_page][&page_length={32-bit integer}][&page_offset={32-bit integer}]

[&page_start_marker={string}][&replicate_deletes=TRUE|FALSE][&state=NORMAL][&target_

id={string}][&type=PERMANENT|RETIRED]

Request Parameters 

Parameter Description Required

data_policy_
id

Data policy UUID or other unique attribute. no

last_page If included, only the last page of results is returned. no

page_length The maximum number of Azure replication rules to list.
Default: all items after page_offset.

no

page_offset The starting point for the first Azure replication rule to list. Default:
0.

no

page_start_
marker

The UUID or other unique attribute for the item just before the first
item to list.
Notes:
• Specifying both page_offset and page_start_marker causes
an error.

• If neither page_offset, nor page_start_marker are specified,
the page_offset default is used.

no

replicate_
deletes

Whether objects deleted from local buckets are also deleted from the
replication target.
Values: TRUE, FALSE

no
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Parameter Description Required

state The state of the replication rule.
Values: NORMAL — The Azure replication rule is in a normal,
included state.

no

target_id The Azure target UUID or other unique attribute. no

type The type of Azure replication rule.
Values: PERMANENT, RETIRED. See Type on page 396 for
descriptions.

no

Responses

Response Elements
<Data>
   <AzureDataReplicationRule>
     <DataPolicyId>{string}</DataPolicyId>
     <Id>{string}</Id>
     <MaxBlobPartSizeInBytes>{string}</MaxBlobPartSizeInBytes>
     <ReplicateDeletes>TRUE|FALSE</ReplicateDeletes

     <State>NORMAL|INCLUSION_IN_PROGRESS</State>
     <TargetId>{string}</TargetId>
     <Type>PERMANENT</Type>
   </AzureDataReplicationRule>
</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

AzureReplication
Rule

The container for information about one Azure replication rule.

DataPolicyId The UUID for the data policy.

Id The UUID for the Azure replication rule.

ReplicateDeletes Whether objects deleted from local buckets are also deleted from the
replication target.
Values: TRUE, FALSE
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Parameter Description

State The state of the persistence rule.
Values:
NORMAL — The persistence rule is in a normal, included state.
INCLUSION_IN_PROGRESS — The persistence rule is being applied and data
copying is required before the persistence rule is in a normal, fully included
state.

TargetId The UUID for the Azure target.

Type The type of replication rule.
Values: PERMANENT, RETIRED. See Type on page 396 for descriptions.

Example

Sample Request
This request gets information about all Azure data replication rules on the BlackPearl
gateway.
GET http://blackpearl-hostname/_rest_/azure_data_replication_rule/HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>
   <AzureDataReplicationRule>
     <DataPolicyId>
       d8945332-11f2-47d0-8ca8-dafe204d2d1e
     </DataPolicyId>
     <Id>8ac0c6fd-de37-4936-8862-caa0f1844735</Id>
     <MaxBlobPartSizeInBytes>1073741824</MaxBlobPartSizeInBytes>
     <ReplicateDeletes>TRUE</ReplicateDeletes

     <State>NORMAL</State>
     <TargetId>1dad5f1e-d55b-415a-a8ab-9bc387e1eb33</TargetId>
     <Type>PERMANENT</Type>
   </AzureDataReplicationRule>
   <AzureDataReplicationRule>
     <DataPolicyId>
        9f7418e5-67e6-47f7-8653-dec602c66eeb

     </DataPolicyId>
     <Id>485634bd-d9fc-478e-8bbf-3e1cf65a94b6</Id>
     <MaxBlobPartSizeInBytes>1073741824</MaxBlobPartSizeInBytes>
     <ReplicateDeletes>TRUE</ReplicateDeletes

     <State>NORMAL</State>
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     <TargetId>d86f4876-46d9-432c-843c-a6dd12355e7e</TargetId>
     <Type>PERMANENT</Type>
   </AzureDataReplicationRule>
</Data>

GET DS3 DATA REPLICATION RULE

Description
Get information about the specified DS3 replication rule.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/ds3_data_replication_rule/{data replication

rule UUID or other unique attribute}/

To determine the UUID for a DS3 data replication rule, see Get DS3 Data Replication Rules
on page 375.

Responses

Response Elements
<Data>

   <DataPolicyId>{string}</DataPolicyId>

   <Id>{string}</Id>

   <ReplicateDeletes>TRUE|FALSE</ReplicateDeletes>
   <State>NORMAL|INCLUSION_IN_PROGRESS</State>
   <TargetDataPolicy>{string}</TargetDataPolicy>
   <TargetId>{string}</TargetId>

   <Type>PERMANENT</Type>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.
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Parameter Description

DataPolicyId The UUID for the data policy.

Id The UUID for the DS3 data replication rule.

ReplicateDeletes Whether objects deleted from local buckets are also deleted from the
replication target.
Values: TRUE, FALSE

State The state of the persistence rule.
Values:
NORMAL — The persistence rule is in a normal, included state.
INCLUSION_IN_PROGRESS — The persistence rule is being applied and data
copying is required before the persistence rule is in a normal, fully included
state.

TargetDataPolicy The UUID for the data policy on the BlackPearl target.

TargetId The UUID for the BlackPearl target.

Type The type of replication rule.
Values: PERMANENT

Example

Sample Request
This request gets information about the DS3 replication rule with the UUID 28b7a84f-347b-
4937-8c1d-0b697a6f04de.
GET http://blackpearl-hostname/_rest_/ds3_data_replication_rule/28b7a84f-347b-4937-

8c1d-0b697a6f04de/ HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>

   <DataPolicyId>

   9dc1146c-44c8-46ec-8e9c-4d2507badfc2

   </DataPolicyId>

   <Id>d6083a44-dd10-4b03-9115-5ea2150f8bd1</Id>

   <ReplicateDeletes>TRUE</ReplicateDeletes>
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   <State>NORMAL</State>

   <TargetDataPolicy/>

   <TargetId>b76837a2-4a13-40cb-a964-59967b787a73</TargetId>

   <Type>PERMANENT</Type>

</Data>

GET DS3 DATA REPLICATION RULES

Description
Get information about all DS3 replication rules. Use parameters as selection criteria to return
a subset of the list.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/ds3_data_replication_rule/[?data_policy_id=

{string}][&last_page][&page_length={32-bit integer}][&page_offset={32-bit integer}]

[&page_start_marker={string}][&replicate_deletes=TRUE|FALSE] [&state=NORMAL]

[&target_id={string}][&type=PERMANENT|RETIRED]

Request Parameters 

Parameter Description Required

data_policy_
id

Data policy UUID or other unique attribute. no

last_page If included, only the last page of results is returned. no

page_length The maximum number of DS3 replication rules to list.
Default: all items after page_offset.

no

page_offset The starting point for the first DS3 replication rule to list. Default: 0. no
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Parameter Description Required

page_start_
marker

The UUID or other unique attribute for the item just before the first
item to list.
Notes:
• Specifying both page_offset and page_start_marker causes
an error.

• If neither page_offset, nor page_start_marker are specified,
the page_offset default is used.

no

replicate_
deletes

Whether objects deleted from local buckets are also deleted from the
replication target.
Values: TRUE, FALSE

no

state The state of the replication rule.
Values: NORMAL — The Azure replication rule is in a normal,
included state.

no

target_id The DS3 target UUID or other unique attribute. no

type The type of DS3 replication rule.
Values: PERMANENT, RETIRED. See Type on page 396 for
descriptions.

no

Responses

Response Elements
<Data>
   <Ds3DataReplicationRule>
      <DataPolicyId>{string}</DataPolicyId>
      <Id>{string}</Id>

      <ReplicateDeletes>TRUE|FALSE</ReplicateDeletes>
      <State>NORMAL|INCLUSION_IN_PROGRESS</State>
      <TargetDataPolicy>{string}</TargetDataPolicy/>
      <TargetId>{string}</TargetId>
      <Type>PERMANENT</Type>
   </Ds3DataReplicationRule>
...
</Data>
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where the response elements are defined as follows:

Parameter Description

Data The container for the response.

Ds3Replication Rule The container for information about one DS3 replication rule.

DataPolicyId The UUID for the data policy.

Id The UUID for the Azure replication rule.

ReplicateDeletes Whether objects deleted from local buckets are also deleted from the
replication target.
Values: TRUE, FALSE

State The state of the persistence rule.
Values:
NORMAL — The persistence rule is in a normal, included state.
INCLUSION_IN_PROGRESS — The persistence rule is being applied and data
copying is required before the persistence rule is in a normal, fully included
state.

TargetDataPolicy The UUID for the data policy on the BlackPearl target.

TargetId The UUID for the BlackPearl target.

Type The type of replication rule.
Values: PERMANENT, RETIRED. See Type on page 396 for descriptions.

Example

Sample Request
This request gets information about all DS3 data replication rules on the BlackPearl gateway.
GET http://blackpearl-hostname/_rest_/ds3_data_replication_rule/HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>
   <Ds3DataReplicationRule>
      <DataPolicyId>
         d8945332-11f2-47d0-8ca8-dafe204d2d1e
      </DataPolicyId>
      <Id>8ac0c6fd-de37-4936-8862-caa0f1844735</Id>
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      <ReplicateDeletes>TRUE</ReplicateDeletes>
      <State>NORMAL</State>
      <TargetDataPolicy/>
      <TargetId>1dad5f1e-d55b-415a-a8ab-9bc387e1eb33</TargetId>
      <Type>PERMANENT</Type>
   </Ds3DataReplicationRule>
   <Ds3DataReplicationRule>
      <DataPolicyId>
         9f7418e5-67e6-47f7-8653-dec602c66eeb

      </DataPolicyId>
      <Id>485634bd-d9fc-478e-8bbf-3e1cf65a94b6</Id>
      <ReplicateDeletes>TRUE</ReplicateDeletes>
      <MaxBlobPartSizeInBytes>1073741824</MaxBlobPartSizeInBytes>
      <State>NORMAL</State>
      <TargetDataPolicy/>
      <TargetId>d86f4876-46d9-432c-843c-a6dd12355e7e</TargetId>
      <Type>PERMANENT</Type>
   </Ds3DataReplicationRule>
</Data>

MODIFY DATA PERSISTENCE RULE

Description
Modify a data persistence rule for a data policy.

Notes:

• If you modify a retired persistence rule to temporary, and you already applied
the data policy to a bucket, the BlackPearl gateway does not necessarily copy
the data in the bucket to the specified storage domain even if there is existing
data within the rule's retention period.

• If the modify command does not include an optional request parameter, the
persistence rules retains the previous setting.

Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/data_persistence_rule/ {data persistence rule

UUID or other unique}/[?isolation_level=STANDARD|BUCKET_ISOLATED][&minimum_days_to_

retain={32-bit integer}][&type=PERMANENT|TEMPORARY|RETIRED]
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Request Parameters 

Parameter Description Required

isolation_
level

The level of physical isolation required for the data retention.
The STANDARD isolation level provides the best capacity
utilization and overall performance.
Note: The isolation level can always be reduced to STANDARD,
but can never be increased to BUCKET_ISOLATED once the data
policy is in use by at least one bucket.
Note:
Values: STANDARD, BUCKET_ISOLATED.
See isolation_level on page 324 for descriptions.

no

minimum_
days_to_
retain

The minimum number of days the data should be retained
based on a TEMPORARY persistence rule.
Note: The minimum_days_to_retain for a persistence rule
targeting a storage domain with a NEARLINE pool (Deep
Storage) storage domain member must be 90 days or greater.

required if
type is being
changed to
TEMPORARY

type The type of persistence rule.
Notes:
• The TEMPORARY value is not allowed for a persistence rule
targeting a storage domain with a tape partition member.

• A data persistence rule with type PERMANENT cannot be
modified to type RETIRED or TEMPORARY if it is the last
PERMANENT persistence rule for an in use storage domain.

Values: PERMANENT, RETIRED, TEMPORARY. See Type on
page 349 for descriptions.

no

Responses

Response Elements
<Data>

   <DataPolicyId>{string}</DataPolicyId>

   <Id>{string}</Id>

   <IsolationLevel>STANDARD|BUCKET_ISOLATED</IsolationLevel>

   <MinimumDaysToRetain>{32-bit integer}</MinimumDaysToRetain>

   <State>NORMAL|INCLUSION_IN_PROGRESS</State>

   <StorageDomainId>{string}</StorageDomainId>

   <Type>PERMANENT|TEMPORARY|RETIRED</Type>

</Data>
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where the response elements are defined as follows:

Parameter Description

Data The container for the response.

DataPolicyId The UUID for the data policy.

Id The UUID for the persistence rule.

IsolationLevel The level of physical isolation required for the data retention. Values:
STANDARD, BUCKET_ISOLATED.
See isolation_level on page 324 for descriptions.

MinimumDaysTo
Retain

The minimum number of days the data should be retained based on a
TEMPORARY persistence rule.

State The state of the persistence rule.
Values:
NORMAL — The persistence rule is in a normal, included state.
INCLUSION_IN_PROGRESS — The persistence rule is being applied and data
copying is required before the persistence rule is in a normal, fully included
state.

StorageDomainId The UUID for the storage domain.

Type The type of persistence rule.
Values: PERMANENT, TEMPORARY, RETIRED. See Type on page 349 for
descriptions.

Example

Sample Request
This request modifies a persistence rule to use standard isolation.
PUT http[s]://blackpearl-hostname/_rest_/data_persistence_rule/d8716fda-c2e5-44c6-

8bea-713bb147e5e0/?isolation_level=STANDARD HTTP/1.1
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Sample Response
HTTP/1.1 200 OK

<Data>

   <DataPolicyId>

      044854c9-7557-4136-a374-dddf7c29e370

   </DataPolicyId>

   <Id>d8716fda-c2e5-44c6-8bea-713bb147e5e0</Id>

   <IsolationLevel>STANDARD</IsolationLevel>

   <MinimumDaysToRetain/>

   <State>NORMAL</State>

   <StorageDomainId>

      8ed43978-846a-44c9-8e14-f34179e33a33

   </StorageDomainId>

   <Type>PERMANENT</Type>

</Data>

MODIFY DATA POLICY

Description
Modify a data policy.

Notes:

• If the data policy is already in use, you cannot modify some parameters. If the
command requests prohibited modifications, the BlackPearl gateway returns an
error message.

• If the modify command does not include an optional request parameter, the
data policy retains the previous setting.
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Requests

Syntax
POST http[s]://{datapathDNSname}/_rest_/data_policy/{data policy UUID, name, or

other unique attribute}/[?always_force_put_job_creation=TRUE|FALSE][&always_

minimize_spanning_across_media=TRUE|FALSE][&blobbing_enabled=TRUE|FALSE][&checksum_

type=CRC_32|CRC_32C|MD5|SHA_256|SHA_512][&default_blob_size={64-bit integer}]

[&default_get_job_priority=URGENT|HIGH|NORMAL|LOW][&default_put_job_

priority=URGENT|HIGH|NORMAL|LOW][&default_verify_after_write=TRUE|FALSE][&default_

verify_job_priority=URGENT|HIGH|NORMAL|LOW][&end_to_end_crc_required=TRUE|FALSE]

[&max_versions_to_keep={32-bit integer}][&name={string}][&rebuild_

priority=URGENT|HIGH|NORMAL|LOW][&versioning=NONE|KEEP_LATEST|KEEP_MULTIPLE_

VERSIONS]

Request Parameters 

Parameter Description Required

always_
force_put_
job_creation

Whether all PUT jobs created for this data policy are created even if
one or more storage domains and/or replication targets the
BlackPearl gateway must PUT to is unavailable, or if there are
global issues that would likely prevent the completion of the job.
Values: TRUE, FALSE (default)

no

always_
minimize_
spanning_
across_media

Whether all PUT jobs created using this data policy are configured
to minimize spanning across tape media. Minimizing spanning
across media is useful when you plan to eject tapes and it is likely
that you will retrieve all objects from the PUT job in a single GET
job. With this setting, you may only need to import one ejected
tape, rather than many tapes, when servicing a GET job.
Notes:
• This setting only applies to tape partitions.
• For jobs less than or equal to 1 TB in size, there is an absolute
guarantee that the data from the job will never span across
multiple tapes. For larger jobs, spanning is minimized, but not
completely prevented. You can further reduce the probability of
spanning across media by using the CAPACITY write optimization
for the storage domains.

• Minimizing spanning across media may reduce capacity
utilization and performance.

Values: TRUE, FALSE

no
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Parameter Description Required

blobbing_
enabled

Whether or not to enable blobbing. If enabled, an object can be
broken up into multiple blobs (binary large objects). If disabled, an
object must always have exactly one blob. Blobbing must be
enabled to handle objects larger than 1 TB, to use multi-part
upload, or to break up an object into multiple blobs. Disabling
blobbing guarantees that an object never spans multiple media (for
example, tapes), since a blob cannot span multiple media. Values:
TRUE, FALSE

no

checksum_
type

Specifies the type of checksum used to verify data integrity for data
in any bucket using this data policy, and the type of checksum
required for end-to-end CRC, if specified.
Note: If the data policy is already in use by a bucket, the
checksum_type cannot be changed.
Values: CRC_32, CRC_32C, MD5, SHA_256, SHA_512
Notes:
• CRC_32, MD5, and SHA-512 perform the best for their
corresponding cryptographic strengths on the BlackPearl
gateway.

• Using SHA-256 or SHA-512 will reduce single stream
performance and may reduce throughput capabilities of the
BlackPearl gateway.

no

default_
blob_size

The maximum blob size. Blob sizes less than 5 MB are strongly
discouraged. Blob sizes less than 50 MB are discouraged. The
maximum blob size is 1 TB.

no

default_get_
job_ priority

Specifies the default GET job priority for the data policy. The job
priority determines the resources assigned and the processing
order. Jobs with priority URGENT can use up all of the resources
and prevent other jobs from making progress. Use this priority
sparingly.
Values: URGENT, HIGH, NORMAL, LOW

no

default_put_
job_ priority

Specifies the default PUT job priority for the data policy. The job
priority determines the resources assigned and the processing
order. Jobs with priority URGENT can use up all of the resources
and prevent other jobs from making progress. Use this priority
sparingly.
Values: URGENT, HIGH, NORMAL, LOW

no
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Parameter Description Required

default_
verify_
after_write

Whether data is verified by default after it is written.
Values: TRUE, FALSE

no

default_
verify_job_
priority

Specifies the default verify job priority for the data policy. The job
priority determines the resources assigned and the processing
order. Jobs with priority URGENT can use up all of the resources
and prevent other jobs from making progress. Use this priority
sparingly. Verify jobs can be interrupted every 30 minutes if a job
with a higher priority is received.
Values: URGENT, HIGH, NORMAL, LOW

no

end_to_end_
crc_
required

Whether or not clients are required to compute and send an end-to-
end CRC. Values: TRUE, FALSE

no

max_
versions_to_
keep

The number of versions of an object to keep if versioning=KEEP_
MULTIPLE_VERSIONS.

no

name The name for the data policy. no

rebuild_
priority

Specifies the rebuild priority for the data policy. The rebuild
priority determines the relative priority compared to other jobs
being processed.
Values: URGENT, HIGH, NORMAL, LOW

no
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Parameter Description Required

versioning The mode of versioning used by the data policy.
Values:
• NONE (default) — Only one version of an object may exist at any
time. Attempts to write another object of the same name fail.

• KEEP_LATEST — Only one version of the data is available at a
time. When a new version of an object is written, the old version
is retained until the new version is fully written in compliance
with the data policy, and then the old version is deleted.

• KEEP_MULTIPLE_VERSIONS —Multiple versions of the object, up
to the number specified by max_versions_to_ keep on page 329
are retained.

Notes:
• KEEP_LATEST versioning cannot be used for a data policy which
uses a storage domain with ltfs_file_naming=OBJECT_NAME
(see ltfs_file_naming on page 548).

• KEEP_LATEST requires that the PUT job for the earlier version of
the object complete before the PUT of the latest version of the
object with the same name in order for the PUT to succeed.

CAUTION If the PUT of the earlier version is not complete before the
PUT of the latest version, the BlackPearl gateway believes the latest
version to be the same object as the earlier version and rejects it, so
only the earlier version is retained.

no

Responses

Response Elements
<Data>

   <AlwaysForcePutJobCreation>

      TRUE|FALSE

   </AlwaysForcePutJobCreation>

   <AlwaysMinimizeSpanningAcrossMedia>

      TRUE|FALSE

   </AlwaysMinimizeSpanningAcrossMedia>
   <BlobbingEnabled>TRUE|FALSE</BlobbingEnabled>

   <ChecksumType>

      CRC_32|CRC_32C|MD5|SHA_256|SHA_512

   </ChecksumType>

   <CreationDate>YYYY-MM-DDThh:mm:ss.xxxZ</CreationDate>

   <DefaultBlobSize>{64-bit integer}</DefaultBlobSize>
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   <DefaultGetJobPriority>

      CRITICAL|URGENT|HIGH|NORMAL|LOW|BACKGROUND

   </DefaultGetJobPriority>

   <DefaultPutJobPriority>

      CRITICAL|URGENT|HIGH|NORMAL|LOW|BACKGROUND

   </DefaultPutJobPriority>
   <DefaultVerifyAfterWrite>TRUE|FALSE</DefaultVerifyAfterWrite>

   <DefaultVerifyJobPriority>

      CRITICAL|URGENT|HIGH|NORMAL|LOW|BACKGROUND

   </DefaultVerifyJobPriority>

   <EndToEndCrcRequired>TRUE|FALSE</EndToEndCrcRequired>

   <Id>{string}</Id>

   <MaxVersionsToKeep>{32-bit integer}</MaxVersionsToKeep>
   <Name>{string}</Name>

   <RebuildPriority>

      CRITICAL|URGENT|HIGH|NORMAL|LOW|BACKGROUND

   </RebuildPriority>

   <Versioning>NONE|KEEP_LAST</Versioning>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

AlwaysForcePutJobCreation Whether all PUT jobs created for this data policy are created
even if one or more storage domains and/or replication targets
the BlackPearl gateway must PUT to is unavailable, or if there
are global issues that would likely prevent the completion of the
job.
Values: TRUE, FALSE

AlwaysMinimize
SpanningAcross Media

Whether all PUT jobs created for this data policy are created to
minimize spanning across media.
Values: TRUE, FALSE. See always_minimize_ spanning_across_
media on page 327.

BlobbingEnabled Whether or not blobbing is enabled.

ChecksumType Type of checksum used to verify data integrity for any
operations involving this bucket unless the operation specifies a
different type of checksum.
Values: CRC_32, CRC_32C, MD5, SHA_256, SHA_512
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Parameter Description

CreationDate The date and time the data policy was created in the format
YYYY-MM-DDThh:mm:ss.xxxZ.

DefaultBlobSize The maximum blob size.

DefaultGetJob
Priority

The default GET job priority for the data policy. The job priority
determines the resources assigned and the processing order.
Values: CRITICAL, URGENT, HIGH, NORMAL, LOW, BACKGROUND

DefaultPutJob
Priority

The default PUT job priority for the data policy. The job priority
determines the resources assigned and the processing order.
Values: CRITICAL, URGENT, HIGH, NORMAL, LOW, BACKGROUND

DefaultVerifyAfterWrite Whether data is verified by default after it is written.
Values: TRUE, FALSE

DefaultVerifyJob
Priority

The default verify job priority for the data policy. The job priority
determines the resources assigned and the processing order.
Values: CRITICAL, URGENT, HIGH, NORMAL, LOW, BACKGROUND

EndToEndCrc
Required

Whether or not clients are required to compute and send an end-
to-end CRC. Values: TRUE, FALSE

Id The UUID for the data policy.

MaxVersionsTo
Keep

The number of versions of an object to keep if versioning=KEEP_
MULTIPLE_VERSIONS.

Name The name of the data policy.

RebuildPriority The rebuild priority for the data policy. The rebuild priority
determines the relative priority compared to other jobs being
processed.
Values: CRITICAL, URGENT, HIGH, NORMAL, LOW, BACKGROUND

Versioning The mode of versioning used by the data policy.
Values: NONE, KEEP_LATEST, KEEP_MULTIPLE_VERSIONS see
versioning on page 330.

Example

Sample Request
This request renames the data policy “policy1” to “newname”.
POST http://blackpearl-hostname/_rest_/data_policy/policy1/?name=newname HTTP/1.1
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Sample Response
HTTP/1.1 200 OK
<Data>

   <AlwaysForcePutJobCreation>FALSE</AlwaysForcePutJobCreation>

   <AlwaysMinimizeSpanningAcrossMedia>

      FALSE

   </AlwaysMinimizeSpanningAcrossMedia>

   <BlobbingEnabled>TRUE</BlobbingEnabled>

   <ChecksumType>MD5</ChecksumType>

   <CreationDate>2015-07-29 16:26:12.305</CreationDate>

   <DefaultBlobSize>332</DefaultBlobSize>

   <DefaultGetJobPriority>HIGH</DefaultGetJobPriority>

   <DefaultPutJobPriority>NORMAL</DefaultPutJobPriority>

   <DefaultVerifyJobPriority>LOW</DefaultVerifyJobPriority>

   <EndToEndCrcRequired>FALSE</EndToEndCrcRequired>

   <Id>4492e1db-35d7-416c-875d-8e1654b5b1ee</Id>

   <MaxVersionsToKeep>1000</MaxVersionsToKeep>

   <Name>newname</Name>

   <RebuildPriority>LOW</RebuildPriority>

   <Versioning>NONE</Versioning>

</Data>

MODIFY AMAZON S3 DATA REPLICATION RULE

Description
Modify an Amazon S3 data replication rule for a data policy.

Note: If the modify command does not include an optional request parameter, the
replication rule retains the previous setting.

Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/s3_data_replication_rule/{data replication

rule UUID or other unique attribute}/[?initial_data_placement=STANDARD|REDUCED_

REDUNDANCY|STANDARD_IA|GLACIER|DEEP_ARCHIVE][&max_blob_part_size_in_bytes={64-bit

integer}][replicate_deletes=TRUE|FALSE][&type=PERMANENT|RETIRED]
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Request Parameters 

Parameter Description Required

initial_data_
placement

The storage class for any blobs transferred to the Amazon S3
instance. Values:
• Standard - Provides high availability and performance for
frequently accessed data.

• Reduced Redundancy - Used for cheaper but less reliable storage.
Not recommended for most scenarios.

• Standard IA - (default) - Provides fast access to less frequently
accessed data.

• Glacier - Provides secure, long-term archive for rarely accessed
data.

no

max_blob_
part_
size_in_
bytes

Specifies the maximum blob part size used when creating bulk PUT
jobs.
The maximum blob part size is 1 TB. Larger blob part sizes make
public cloud workflows simpler, but may make it more difficult or
impossible to reliably transmit blobs. Less reliable network
connections to the public cloud require smaller blob part sizes.
Values: Min: 100MB, Max: 1TB, Default: 1GB

no

replicate_
deletes

Whether objects deleted from buckets are also deleted from the
replication target.
Values:
TRUE (default) — Any delete received locally always replicates on
the Azure target. If the local BlackPearl gateway cannot
communicate with one or more targets, the delete fails.
FALSE— Any deletes received locally do not replicate to the target.

no

type The type of replication rule.
Values:
• PERMANENT — A copy of the data is replicated to the target.
• RETIRED — A copy of already replicated data is maintained, but
the rule is not applied to new data.

no

Responses

Response Elements
<Data>

   <DataPolicyId>{string}</DataPolicyId>

   <Id>{string}</Id>
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   <InitialDataPlacement>

     STANDARD|REDUCED_REDUNDANCY|STANDARD_IA|GLACIER|DEEP_GLACIER

   </InitialDataPlacement>
   <MaxBlobPartSizeInBytes>

{64-bit integer}

   </MaxBlobPartSizeInBytes>

   <ReplicateDeletes>TRUE|FALSE</ReplicateDeletes>

   <State>NORMAL|INCLUSION_IN_PROGRESS</State>
   <TargetId>{string}</TargetId>

   <Type>PERMANENT|RETIRED</Type>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

DataPolicyId The UUID for the data policy.

Id The UUID for the Amazon S3 replication rule.

InitialDataPlacement The storage class for any blobs transferred to the Amazon S3 instance.
Values: Standard, Reduced Redundancy, Standard IA, Glacier, Deep
Archive. See initial_data_placement on page 334 for definitions.

MaxBlobSizeIn Bytes The maximum blob size used when creating bulk PUT jobs.
Default: 100 GB

ReplicateDeletes Whether objects deleted from local buckets are also deleted from the
replication target.
Values: TRUE, FALSE

State The state of the persistence rule.
Values:
NORMAL — The persistence rule is in a normal, included state.
INCLUSION_IN_PROGRESS — The persistence rule is being applied and
data copying is required before the persistence rule is in a normal, fully
included state.

TargetId The UUID for the Amazon S3 target.

Type The type of replication rule.
Values:
• PERMANENT — A copy of the data is replicated to the target.
• RETIRED — A copy of already replicated data is maintained, but the
rule is not applied to new data.
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Example

Sample Request
This request retires the Amazon S3 replication rule with the UUID 4735bc7b-011b-49d8-84f9-
b4bbac95d128.
POST http://blackpearl-hostname/_rest_/s3_data_replication_rule/4735bc7b-011b-49d8-

84f9-b4bbac95d128/?type=RETIRED HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>

   <DataPolicyId>

      a3fbb966-0fe7-4202-bb58-029d6b4896ae

   </DataPolicyId>

   <Id>4735bc7b-011b-49d8-84f9-b4bbac95d128</Id>

   <InitialDataPlacement>STANDARD_IA</InitialDataPlacement>

   <MaxBlobPartSizeInBytes>1073741824</MaxBlobPartSizeInBytes>

   <ReplicateDeletes>TRUE</ReplicateDeletes>

   <State>NORMAL</State>

   <TargetId>5aa8dab6-4d27-4c01-a4eb-b003fade6012</TargetId>

   <Type>RETIRED</Type>

</Data>

MODIFY AZURE DATA REPLICATION RULE

Description
Modify an Azure data replication rule for a data policy.

Note: If the modify command does not include an optional request parameter, the
replication rules retains the previous setting.

Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/azure_data_replication_rule/{data replication

rule UUID or other unique attribute}/[?max_blob_part_size_in_bytes={64-bit integer}]

[replicate_deletes=TRUE|FALSE][&type=PERMANENT|RETIRED]

April 2023 DS3 API Reference-Spectra BlackPearl Nearline Gateway
- 391 -



Chapter 11 - Data Policy Operations Modify Azure Data Replication Rule

Request Parameters 

Parameter Description Required

max_blob_
part_
size_in_
bytes

Specifies the maximum blob part size used when creating bulk PUT
jobs.
The maximum blob part size is 1 TB. Larger blob part sizes make
public cloud workflows simpler, but may make it more difficult or
impossible to reliably transmit blobs. Less reliable network
connections to the public cloud require smaller blob part sizes.
Values: Min: 100MB, Max: 1TB, Default: 1GB

no

replicate_
deletes

Whether objects deleted from buckets are also deleted from the
replication target.
Values:
TRUE (default) — Any delete received locally always replicates on
the Azure target. If the local BlackPearl gateway cannot
communicate with one or more targets, the delete fails.
FALSE— Any deletes received locally do not replicate to the target.

no

type The type of replication rule.
Values:
• PERMANENT — A copy of the data is replicated to the target.
• RETIRED — A copy of already replicated data is maintained, but
the rule is not applied to new data.

no

Responses

Response Elements
<Data>

   <DataPolicyId>{string}</DataPolicyId>

   <Id>{string}</Id>
   <MaxBlobPartSizeInBytes>

{64-bit integer}

   </MaxBlobPartSizeInBytes>

   <ReplicateDeletes>TRUE|FALSE</ReplicateDeletes>

   <State>NORMAL|INCLUSION_IN_PROGRESS</State>
   <TargetDataPolicy>{string}</TargetDataPolicy>
   <TargetId>{string}</TargetId>

   <Type>PERMANENT|RETIRED</Type>

</Data>
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where the response elements are defined as follows:

Parameter Description

Data The container for the response.

DataPolicyId The UUID for the data policy.

MaxBlobSizeIn
Bytes

The maximum blob size used when creating bulk PUT jobs.
Default: 100 GB

Id The UUID for the DS3 replication rule.

ReplicateDeletes Whether objects deleted from local buckets are also deleted from the
replication target.
Values: TRUE, FALSE

State The state of the persistence rule.
Values:
NORMAL — The persistence rule is in a normal, included state.
INCLUSION_IN_PROGRESS — The persistence rule is being applied and data
copying is required before the persistence rule is in a normal, fully included
state.

TargetDataPolicy The UUID for the data policy on the BlackPearl target.

TargetId The UUID for the BlackPearl target.

Type The type of replication rule.
Values:
Values:
• PERMANENT — A copy of the data is replicated to the target.
• RETIRED — A copy of already replicated data is maintained, but the rule
is not applied to new data.

Example

Sample Request
This request retires the Azure replication rule with the UUID 34dde4ff-8603-4c44-b0e9-
39150f9cc3ad.
POST http://blackpearl-hostname/_rest_/azure_data_replication_rule/34dde4ff-8603-

4c44-b0e9-39150f9cc3ad/?type=RETIRED HTTP/1.1
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Sample Response
HTTP/1.1 200 OK

<Data>

   <DataPolicyId>

      88832b42-731e-4a82-be8d-3d787117ca7d

   </DataPolicyId>
   <MaxBlobPartSizeInBytes>
     48321fc3-821f-5b73-fc3a-4a877241fb6a

   </MaxBlobPartSizeInBytes>

   <Id>34dde4ff-8603-4c44-b0e9-39150f9cc3ad</Id>

   <ReplicateDeletes>TRUE</ReplicateDeletes>

   <State>NORMAL</State>
   <TargetDataPolicy/>

   <TargetId>e4858769-57e0-4f34-a2d0-3f7ad57aa80f</TargetId>

   <Type>RETIRED</Type>

</Data>

MODIFY DS3 DATA REPLICATION RULE

Description
Modify a DS3 data replication rule for a data policy.

Note: If the modify command does not include an optional request parameter, the
replication rules retains the previous setting.

Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/ds3_data_replication_rule/{data replication

rule UUID or other unique attribute}/[?replicate_deletes=TRUE|FALSE][&target_data_

policy={text}][&type=PERMANENT|RETIRED]
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Request Parameters 

Parameter Description Required

replicate_
deletes

Whether objects deleted from buckets are also deleted from the
replication target.
Values:
TRUE (default) — Any delete received locally always replicates on
the Azure target. If the local BlackPearl gateway cannot
communicate with one or more targets, the delete fails.
FALSE— Any deletes received locally do not replicate to the target.

no

target_data_
policy

The BlackPearl target data policy name, UUID, or other unique
attribute.

no

type The type of replication rule.
Values:
• PERMANENT — A copy of the data is replicated to the target.
• RETIRED — A copy of already replicated data is maintained, but
the rule is not applied to new data.

no

Responses

Response Elements
<Data>

   <DataPolicyId>{string}</DataPolicyId>

   <Id>{string}</Id>

   <ReplicateDeletes>TRUE|FALSE</ReplicateDeletes>

   <State>NORMAL|INCLUSION_IN_PROGRESS</State>
   <TargetDataPolicy>{string}</TargetDataPolicy>
   <TargetId>{string}</TargetId>

   <Type>PERMANENT|RETIRED</Type>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

DataPolicyId The UUID for the data policy.

Id The UUID for the DS3 replication rule.
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Parameter Description

ReplicateDeletes Whether objects deleted from local buckets are also deleted from the
replication target.
Values: TRUE, FALSE

State The state of the persistence rule.
Values:
NORMAL — The persistence rule is in a normal, included state.
INCLUSION_IN_PROGRESS — The persistence rule is being applied and data
copying is required before the persistence rule is in a normal, fully included
state.

TargetDataPolicy The UUID for the data policy on the BlackPearl target.

TargetId The UUID for the BlackPearl target.

Type The type of replication rule.
Values:
Values:
• PERMANENT — A copy of the data is replicated to the target.
• RETIRED — A copy of already replicated data is maintained, but the rule
is not applied to new data.

Example

Sample Request
This request retires the DS3 replication rule with the UUID 34dde4ff-8603-4c44-b0e9-
39150f9cc3ad.
POST http://blackpearl-hostname/_rest_/ds3_data_replication_rule/34dde4ff-8603-4c44-

b0e9-39150f9cc3ad/?type=RETIRED HTTP/1.1
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Sample Response
HTTP/1.1 200 OK

<Data>

   <DataPolicyId>

      88832b42-731e-4a82-be8d-3d787117ca7d

   </DataPolicyId>

   <Id>34dde4ff-8603-4c44-b0e9-39150f9cc3ad</Id>

   <ReplicateDeletes>TRUE</ReplicateDeletes>

   <State>NORMAL</State>
   <TargetDataPolicy/>

   <TargetId>e4858769-57e0-4f34-a2d0-3f7ad57aa80f</TargetId>

   <Type>RETIRED</Type>

</Data>

April 2023 DS3 API Reference-Spectra BlackPearl Nearline Gateway
- 397 -
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OPERATIONS

This chapter describes replication rules and data policies that define how data is replicated to
a target. A replication target is a remote BlackPearl gateway or cloud service. The currently
supported replication targets are Microsoft Azure targets, DS3 (BlackPearl) targets, and
Amazon S3 targets.

General Replication Target Commands 398

Amazon S3 Replication Target Commands 400

Azure Replication Target Commands 452

DS3 Replication Target Commands 495

GENERAL REPLICATION TARGET COMMANDS

Force Target Environment Refresh 398

FORCE TARGET ENVIRONMENT REFRESH

Description
Forces the target environment to refresh (verify access and connectivity for each target)
immediately, updating each replication target's state.

Note: The target environment is updated automatically based on a polling interval, so
manual refreshes are not typically necessary.

Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/target_environment/

- 398 -



Chapter 12 - Replication Target Operations Force Target Environment Refresh

Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 500: Internal Error

Example

Sample Request
This request refreshes the target environment.
PUT http://blackpearl-hostname/_rest_/target_environment/ HTTP/1.1

Sample Response
HTTP/1.1 204 No Content
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AMAZON S3 REPLICATION TARGET COMMANDS

Create Amazon S3 Target Bucket Name 400

Create Amazon S3 Target Read Preference 402

Delete Amazon S3 Target 405

Delete Amazon S3 Target Bucket Name 406

Delete Amazon S3 Target Failure 407

Delete Amazon S3 Target Read Preference 408

Get Amazon S3 Target 409

Get Amazon S3 Target Bucket Names 413

Get Amazon S3 Target Failures 416

Get Amazon S3 Target Read Preference 418

Get Amazon S3 Target Read Preferences 420

Get Amazon S3 Targets 422

Get Blobs on Amazon S3 Target 428

Import Amazon S3 Target 430

Modify All Amazon S3 Targets 432

Modify Amazon S3 Target 433

Register Amazon S3 Target 440

Verify Amazon S3 Target 447

CREATE AMAZON S3 TARGET BUCKET NAME

Description
Defines a custom bucket name mapping between the BlackPearl bucket and an Amazon S3
target bucket.
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Requests

Syntax
POST http[s]://{datapathDNSname}/_rest_/s3_target_bucket_name/?bucket_id=

{string}&name={string}&target_id={string}

Request Parameters 

Parameter Description Required

bucket_id The BlackPearl bucket UUID, name, or other unique attribute. yes

name The name for the new bucket in the Amazon S3 target. yes

target_id The Amazon S3 target UUID, name, or other unique attribute. yes

Responses

Response Elements
<Data>

   <BucketId>{string}</BucketId>

   <Id>{string}</Id>

   <Name>{string}</Name>

   <TargetId>{string}</TargetId>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

BucketId The UUID for the bucket.

Id The UUID for the bucket mapping.

Name The name of the Amazon S3 bucket.

TargetId The UUID for the Amazon S3 replication target.
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Example

Sample Request
This request maps the BlackPearl bucket named bucket1 to an Amazon S3 bucket named
bucketname .
POST http[s]://blackpearl-hostname/_rest_/s3_target_bucket_name/?bucket_

id=bucket1&name=bucketname&target_id=26bbc55a-417a-49a9-90f5-dbc3920cb0fc HTTP/1.1

Sample Response
HTTP/1.1 201 CREATED

<Data>

   <BucketId>b9c3e3ec-a316-4532-bf82-d5e07141df64</BucketId>

   <Id>67c60982-aa75-4378-ad48-187f66a3917c</Id>

   <Name>bucketname</Name>

   <TargetId>26bbc55a-417a-49a9-90f5-dbc3920cb0fc</TargetId>

</Data>

CREATE AMAZON S3 TARGET READ PREFERENCE

Description
Create an Amazon S3 target read preference for a particular bucket, overriding the default
defined in the Amazon S3 target configuration.

Requests

Syntax
POST http[s]://{datapathDNSname}/_rest_/s3_target_read_preference/?bucket_id=

{string}&read_preference=LAST_RESORT|AFTER_ONLINE_POOL|AFTER_NEARLINE_POOL|AFTER_

NON_EJECTABLE_TAPE|MINIMUM_LATENCY|NEVER&target_id={string}

Request Parameters 

Parameter Description Required

bucket_id Bucket UUID, name, or other unique attribute. yes
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Parameter Description Required

read_
preference

When it is preferable to read from the Amazon S3 target rather than
the replication source.
Values:
• LAST_RESORT — The target is only used to service a read request
if it cannot be serviced locally. This setting should be used in
most circumstances.

• AFTER_ONLINE_POOL — If data is not available locally on cache
or online pool, the target is used to read the data if possible.

• AFTER_NEARLINE_POOL — If data is not available locally on
cache, online pool, or nearline pool, the target is used to read the
data if possible.

• AFTER_NON_EJECTABLE_TAPE — If data is not available locally
on cache, online pool, nearline pool, or non-ejectable tape, the
target is used to read the data if possible.

• MINIMUM_LATENCY — The source BlackPearl gateway
dynamically determines the read preference based on whether
the requested data resides in a pool or on tape. If, for example,
the source has the data on tape, but the target has the data on
pool, the source uses the target to service the request. If however,
the source and target both have the data on pool, the source is
used to service the request. Use this when

1. the cost of the network link to the target is very inexpensive,
2.minimizing latency of servicing GET and VERIFY jobs is critical,

and
3. the network throughput to the target is much higher than the

tape backend throughput (for example, if the network link to
the target is 1 Gb/s, but the tape backend consists of 8 LTO-7
drives, it is very possible that it is faster to service requests
locally, even though we must go to tape, since the pipe to the
tape backend far exceeds that to the target).

• NEVER — The target is never allowed to service a read request.
You may want to use this setting when the cost of the network
link to the target is very high, or if for data integrity verification
purposes, the administrator wants to ensure that all GET and
VERIFY requests are serviced locally.

yes

target_id The Amazon S3 target UUID, name, or other unique attribute. yes
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Responses

Response Elements
<Data>

   <BucketId>{string}</BucketId>

   <Id>{string}</Id>

   <ReadPreference>

      MINIMUM_LATENCY|AFTER_ONLINE_POOL|AFTER_NEARLINE_POOL

      |AFTER_NON_EJECTABLE_TAPE|LAST_RESORT|NEVER

   </ReadPreference>

   <TargetId>{string}</TargetId>

</Data>

where the response elements are defined as follows:

Parameter Description

BucketId The container for the response.

Id The UUID for the read preference.

ReadPreference When it is preferable to read from the Amazon S3 target rather than the
replication source.
Values: MINIMUM_LATENCY, AFTER_ONLINE_POOL, AFTER_NEARLINE_POOL,
AFTER_NON_EJECTABLE_TAPE, LAST_RESORT, NEVER. See read_preference
on page 403.

TargetId The UUID for the replication target.

Example

Sample Request
This request overrides the read preference for the Amazon S3 target with the UUID 26bbc55a-
417a-49a9-90f5-dbc3920cb0fc to set the read preference for ‘bucket1’ to MINIMUM_LATENCY.
POST http[s]://blackpearl-hostname/_rest_/s3_target_read_preference/?bucket_

id=bucket1 &read_preference=MINIMUM_LATENCY&target_id=26bbc55a-417a-49a9-90f5-

dbc3920cb0fc HTTP/1.1
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Sample Response
HTTP/1.1 201 CREATED

<Data>

   <BucketId>502e2d43-fe83-491e-985c-5f4d8d2108c3</BucketId>

   <Id>4b90e88b-63ec-4784-96a3-8408e74ad3ec</Id>

   <ReadPreference>MINIMUM_LATENCY</ReadPreference>

   <TargetId>26bbc55a-417a-49a9-90f5-dbc3920cb0fc</TargetId>

</Data>

DELETE AMAZON S3 TARGET

Description
Delete the specified Amazon S3 replication target.

Requests

Syntax
DELETE http[s]://{datapathDNSname}/_rest_/s3_target/{Amazon S3 target UUID, name, or

other unique attribute}/

To determine the UUID for an Amazon S3 target, see Get Amazon S3 Targets on page 422.

Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 403: Access Denied
• 404: Not Found
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Example

Sample Request
This request deletes the Amazon S3 replication target with the name ‘s3target’.
DELETE http[s]://blackpearl-hostname/_rest_/s3_target/s3target/ HTTP/1.1

Sample Response
HTTP/1.1 204 No Content

DELETE AMAZON S3 TARGET BUCKET NAME

Description
Deletes a custom bucket name mapping between a BlackPearl bucket and an Amazon S3
target bucket.

Note: The bucket on the Amazon S3 target is not deleted.

Requests

Syntax
DELETE http[s]://{datapathDNSname}/_rest_/s3_target_bucket_name/{Amazon S3 bucket

name, UUID, or other unique identifier or attribute}/

To determine the UUID for an Amazon S3 bucket, see Get Amazon S3 Target Bucket Names
on page 413.

Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 403: Access Denied
• 404: Not Found
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Example

Sample Request
This request deletes the custom mapping of a bucket on a BlackPearl source to an Amazon S3
bucket.
DELETE http[s]://blackpearl-hostname/_rest_/s3_target_bucket_name/s3bucket/ HTTP/1.1

Sample Response
HTTP/1.1 204 No Content

DELETE AMAZON S3 TARGET FAILURE

Description
Delete the specified Amazon S3 replication target failure.

Requests

Syntax
DELETE http[s]://{datapathDNSname}/_rest_/s3_target_failure/{Amazon S3 target

failure UUID or other unique attribute}/

To determine the UUID for an Amazon S3 target failure, see Get Amazon S3 Target Failures
on page 416.

Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 403: Access Denied
• 404: Not Found
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Example

Sample Request
This request deletes the Amazon S3 target failure with the UUID df53ea38-a582-4c04-99ef-
e5d8071fe188.
DELETE http[s]://blackpearl-hostname/_rest_/s3_target_failure/df53ea38-a582-4c04-

99ef-e5d8071fe188/ HTTP/1.1

Sample Response
HTTP/1.1 204 No Content

DELETE AMAZON S3 TARGET READ PREFERENCE

Description
Delete the specified Amazon S3 replication target read preference.

Requests

Syntax
DELETE http[s]://{datapathDNSname}/_rest_/s3_target_read_preference/{Amazon S3

target read preference UUID}/

To determine the UUID for an Amazon S3 target read preference, see Get Amazon S3 Target
Read Preferences on page 420.

Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 403: Access Denied
• 404: Not Found
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Example

Sample Request
This request deletes the Amazon S3 target read preference with the UUID d196873b-e79a-
4824-8f03-99fd98883ab8.
DELETE http[s]://blackpearl-hostname/_rest_/s3_target_read_preference/d196873b-e79a-

4824-8f03-99fd98883ab8/ HTTP/1.1

Sample Response
HTTP/1.1 204 No Content

GET AMAZON S3 TARGET

Description
Get information about the specified Amazon S3 target.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/s3_target/{Amazon S3 target instance UUID,

name, or other unique attribute}/

To determine the UUID for an Amazon S3 target, see Get Amazon S3 Targets on page 422.

Responses

Response Elements
<Data>
   <AccessKey>{string}</AccessKey>
   <AutoVerifyFrequencyInDays>

{integer}

   </AutoVerifyFrequencyInDays>
   <CloudBucketPrefix>{string}</CloudBucketPrefix>
   <CloudBucketSuffix>{string}</CloudBucketSuffix>
   <DataPathEndPoint>{string}</DataPathEndPoint>
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   <DefaultReadPreference>

      MINIMUM_LATENCY|AFTER_ONLINE_POOL|AFTER_NEARLINE_POOL

      |AFTER_NON_EJECTABLE_TAPE|LAST_RESORT|NEVER

   </DefaultReadPreference>
   <Https>TRUE|FALSE</Https>
   <Id>{string}</Id>
   <LastFullyVerified>

{YYYY-MM-DDThh:mm:ss.xxxZ}
   </LastFullyVerified>
   <Name>{string}</Name>
   <NamingMode>BLACK_PEARL|AWS_S3</NamingMode>
   <OfflineDataStagingWindowInTb>

{integer}
   </OfflineDataStagingWindowInTb>
   <ProxyDomain>{string}</ProxyDomain>
   <ProxyHost>{string}</ProxyHost>
   <ProxyPassword>{string}</ProxyPassword>
   <ProxyPort>{64-bit integer}</ProxyPort>
   <ProxyUsername>{string}</ProxyUsername>
   <Quiesced>NO|PENDING|YES</Quiesced>
   <Region>

      US_EAST_1|US_EAST_2|US_WEST_1|US_WEST_2|EU_WEST_1|

      EU_WEST_2|EU_CENTRAL_1|AP_SOUTH_1|AP_SOUTHEAST_1|

      AP_SOUTHEAST_2|AP_NORTHEAST_1|AP_NORTHEAST_2|SA_EAST_1|

      CN_NORTH_1|GOV_CLOUD|CA_CENTRAL_1

   </Region>
   <SecretKey>{string}</SecretKey>
   <StagedDataExpirationInDays>

{integer}
   </StagedDataExpirationInDays>
   <State>ONLINE|OFFLINE|LIMITED_ACCESS</State>
</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

AccessKey The S3 Access Key of the user for the Amazon S3 account.
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Parameter Description

AutoVerify
FrequencyInDays

The frequency at which a full verify of the data on the target
is scheduled. If null, no full verify is scheduled. It is useful to
schedule auto verify when the target is a storage domain in a
data policy using replicate deletes. The verify ensures that
deletes replicate in a timely manner.

CloudBucketPrefix The Amazon S3 target bucket prefix.
Bucket names on the BlackPearl gateway must be unique
within the BlackPearl gateway, but bucket names in Amazon
S3 must be unique across the world. To permit friendlier,
shorter local bucket names on the BlackPearl gateway while
avoiding naming conflicts with Amazon S3, the BlackPearl
gateway optionally adds the defined Cloud Bucket Prefix to
the BlackPearl bucket name when it replicates the bucket.

CloudBucketSuffix The Amazon S3 target bucket suffix.
Bucket names on the BlackPearl gateway must be unique
within the BlackPearl gateway, but bucket names in Amazon
S3 must be unique across the world. To permit friendlier,
shorter local bucket names on the BlackPearl gateway while
avoiding naming conflicts with Amazon S3, the BlackPearl
gateway optionally adds the defined Cloud Bucket Suffix to
the BlackPearl bucket name when it replicates the bucket.

DataPathEndpoint The IPv4 address or DNS name for the data path of the AWS
cloud service.

DefaultRead Preference When it is preferable to read from the Amazon S3 target
rather than the replication source.
Values: MINIMUM_LATENCY, AFTER_ONLINE_POOL, AFTER_
NEARLINE_POOL, AFTER_NON_EJECTABLE_TAPE, LAST_
RESORT, NEVER. See read_preference on page 455.

Https Whether the BlackPearl gateway uses the HTTPS protocol to
setup and replicate data to the target.
Values: TRUE, FALSE.

Id The UUID for the Amazon S3 target instance.

LastFullyVerified The date and time data on the target was last fully verified in
the format YYYY-MM-DDThh:mm:ss.xxxZ.

Name The name for the Amazon S3 target.
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Parameter Description

NamingMode Whether files written to the target use BlackPearl (file
UUIDs) or Amazon S3 (file names) naming conventions.
Values: BLACK_PEARL, AWS_S3

OfflineDataStagingWindowInTb The maximum size, in TB, of the window available for
staging data that is offline (in Glacier) so that it can be read.

ProxyDomain The domain name for the proxy server.

ProxyHost The host name or IP address for the proxy server to which
the BlackPearl gateway connects.

ProxyPassword The password used when connecting through the proxy
server.

ProxyPort The proxy server port through which the BlackPearl gateway
connects.

ProxyUsername The username used when connecting through the proxy
server.

Quiesced Whether the Amazon S3 target is in a temporarily inactive
state. Values: NO, PENDING, YES

Region The world region where the Amazon S3 target is physically
located. Values: US_EAST_1, US_EAST_2, US_WEST_1, US_
WEST_2, EU_WEST_1, EU_WEST_2, EU_CENTRAL_1, AP_
SOUTH_1, AP_SOUTHEAST_1, AP_SOUTHEAST_2, AP_
NORTHEAST_1, AP_NORTHEAST_2, SA_EAST_1, CN_NORTH_
1, GOV_CLOUD, CA_CENTRAL_1

SecretKey The secret key associated with the AccessKey.

StagedData
ExpirationInDays

The number of days before the pre-staged copy of data can
expire. If the BlackPearl gateway does not retrieve all of the
data before the copy expires, it has to go through the process
of pre-staging it again, incurring additional delays and costs.

State The state of the Amazon S3 target.
Values: ONLINE, OFFLINE, LIMITED_ACCESS
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Example

Sample Request
This request gets information about the Amazon S3 target with the name ‘S3Target’.
GET http[s]://blackpearl-hostname/_rest_/s3_target/S3Target/ HTTP/1.1

Sample Response
HTTP/1.1 200 OK
<Data>
   <AccessKey>Nf36Pd1f</AccessKey>
   <AutoVerifyFrequencyInDays/>
   <CloudBucketPrefix/>
   <CloudBucketSuffix/>
   <DataPathEndPoint/>
   <DefaultReadPreference>LAST_RESORT</DefaultReadPreference>
   <Https>TRUE</Https>
   <Id>8fa1e732-0b9d-4f5e-b502-a6107d28f300</Id>
   <LastFullyVerified/>
   <Name>S3Target</Name>
   <NamingMode>BLACK_PEARL</NamingMode>
   <OfflineDataStagingWindowInTb>1</OfflineDataStagingWindowInTb>
   <ProxyDomain/>
   <ProxyHost/>
   <ProxyPassword/>
   <ProxyPort/>
   <ProxyUsername/>
   <Quiesced>NO</Quiesced>
   <Region>US_WEST_2</Region>
   <SecretKey>Z42st5R</SecretKey>
   <StagedDataExpirationInDays>30</StagedDataExpirationInDays>
   <State>ONLINE</State>
</Data>

GET AMAZON S3 TARGET BUCKET NAMES

Description
Gets all Amazon S3 bucket name mappings between the local BlackPearl buckets and their
Amazon S3 target buckets.
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Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/s3_targetbucket_name/[?bucket_id={string}]

[&last_page][&name={string}][&page_length={32-bit integer}][&page_offset=

{32-bit integer}][&page_start_marker={string}][&target_id={string}]

Responses

Request Parameters 

Parameter Description Required

bucket_id Bucket UUID, name, or other unique attribute. no

last_page If included, only the last page of results is returned. no

name The name of the bucket on the Amazon S3 target. no

page_length The maximum number of Amazon S3 target buckets to list. Default:
all items after page_offset.

no

page_offset The starting point for the first Amazon S3 target bucket to list.
Default: 0.

no

page_start_
marker

The UUID or other unique attribute for the item just before the first
item to list.
Notes:
• Specifying both page_offset and page_start_marker causes
an error.

• If neither page_offset, nor page_start_marker are specified,
the page_offset default is used.

no

target_id Amazon S3 target UUID, name, or other unique attribute. no

Responses

Response Elements
<Data>
   <S3TargetBucketName>
      <BucketId>{string}</BucketId>
      <Id>{string}</Id>
      <Name>{string}/Name>
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      <TargetId>{string}</TargetId>

   </S3TargetBucketName>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

S3TargetBucket
Name

The name of the bucket on the Amazon S3 target,

BucketId The UUID for the bucket.

Id The UUID for the bucket mapping.

Name The name of the Amazon S3 bucket.

TargetId The UUID for the Amazon S3 replication target.

Example

Sample Request
This request gets a list of all buckets on the Amazon S3 target.
GET http://blackpearl-hostname/_rest_/s3_target_bucket_name/ HTTP/1.1

Sample Response
<Data>
   <S3TargetBucketName>
      <BucketId>220e62e0-c869-479c-a729-7f02316d6317</BucketId>
      <Id>9c3c3732-fab1-4a9c-88da-1fb6c0a6ff3f</Id>
      <Name>custombucketname</Name>
      <TargetId>c14ce94a-9c99-4f19-8373-5000b72313f0</TargetId>
   </S3TargetBucketName>
   <S3TargetBucketName>
      <BucketId>220e62e0-c869-479c-a729-7f02316d6317</BucketId>
      <Id>b7524215-aaac-4286-9098-12a3066567b9</Id>
      <Name>custombucketname</Name>
      <TargetId>d5c4ce07-dba9-4b2c-89c1-605d2dd6a4c0</TargetId>
   </S3TargetBucketName>
</Data>
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GET AMAZON S3 TARGET FAILURES

Description
Get information about all Amazon S3 target failures. Use parameters as selection criteria to
return a subset of the list.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/s3_target_failure/[?error_message={string}]

[&last_page][&page_length={32-bit integer}][&page_offset={32-bit integer}][&page_

start_marker={string}][&target_id={string}][&type=IMPORT_FAILED|IMPORT_

INCOMPLETE|NOT_ONLINE|READ_FAILED|READ_INITIATE_FAILED|VERIFY_COMPLETE|VERIFY_

FAILED|WRITE_FAILED|WRITE_INITIATE_FAILED]

Request Parameters 

Parameter Description Required

error_
message

The text of the error message. no

last_page If included, only the last page of results is returned. no

page_length The maximum number of Amazon S3 target failures to list. Default:
all items after page_offset.

no

page_offset The starting point for the first Amazon S3 target failure to list.
Default: 0.

no

page_start_
marker

The UUID or other unique attribute for the item just before the first
item to list.
Notes:
• Specifying both page_offset and page_start_marker causes
an error.

• If neither page_offset, nor page_start_marker are specified,
the page_offset default is used.

no
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Parameter Description Required

target_id Amazon S3 target UUID, name, or other unique attribute. To
determine the UUID for an Amazon S3 target, see Get Amazon S3
Targets on page 422.

no

type The type of error message.
Values: Values: IMPORT_FAILED, IMPORT_INCOMPLETE, NOT_
ONLINE, READ_FAILED, READ_INITIATE_FAILED, VERIFY_COMPLETE,
VERIFY_FAILED, WRITE_FAILED, WRITE_INITIATE_FAILED

no

Responses

Response Elements
<Data>

   <S3TargetFailure>

      <Date>YYYY-MM-DDThh:mm:ss.xxxZ</Date>

      <ErrorMessage>{string}</ErrorMessage>

      <Id>{string}</Id>

      <TargetId>{string}</TargetId>

      <Type>

         IMPORT_FAILED|IMPORT_INCOMPLETE|NOT_ONLINE|READ_FAILED|

         READ_INITIATE_FAILED|VERIFY_COMPLETE|VERIFY_FAILED|

         WRITE_FAILED|WRITE_INITIATE_FAILED

      </Type>

   </S3TargetFailure>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

S3TargetFailure The container for information about one Amazon S3 target failure.

Date The date and time the error occurred in the format
YYYY-MM-DDThh:mm:ss.xxxZ

ErrorMessage A description of the error.

Id The UUID for the error message.
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Parameter Description

TargetId The UUID for the Amazon S3 target that had the failure.

Type The type of error message.

Example

Sample Request
This request gets information about all Amazon S3 target failures.
GET http://blackpearl-hostname/_rest_/s3_target_failure/ HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>

   <S3TargetFailure>

   <Date>2016-05-17T14:18:01.000Z</Date>

   <ErrorMessage>{error text}</ErrorMessage>

   <Id>df53ea38-a582-4c04-99ef-e5d8071fe188</Id>

   <TargetId>aa584aa1-f2dd-4064-8db3-f6f07810dc89</TargetId>

   <Type>NOT_ONLINE</Type>

   </S3TargetFailure>

</Data>

GET AMAZON S3 TARGET READ PREFERENCE

Description
Get the specified Amazon S3 target default read preference.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/s3_target_read_preference/{Amazon S3 target

read preference UUID or other unique attribute}/

To determine the UUID for the Amazon S3 target read preference, see Get Amazon S3 Target
Read Preferences on page 420.
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Responses

Response Elements
<Data>

   <BucketId>{string}</BucketId>

   <Id>{string}</Id>

   <ReadPreference>

      MINIMUM_LATENCY|AFTER_ONLINE_POOL|AFTER_NEARLINE_POOL

      |AFTER_NON_EJECTABLE_TAPE|LAST_RESORT|NEVER

   </ReadPreference>

   <TargetId>{string}</TargetId>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

BucketId The UUID for the bucket.

Id The UUID for the read preference.

ReadPreference When it is preferable to read from the Amazon S3 target rather than the
replication source.
Values: MINIMUM_LATENCY, AFTER_ONLINE_POOL, AFTER_NEARLINE_POOL,
AFTER_NON_EJECTABLE_TAPE, LAST_RESORT, NEVER. See read_preference
on page 455.

TargetId The UUID for the replication target.

Example

Sample Request
This request gets information about the read preference for the Amazon S3 target with the
5cbf1b35-0d06-43f5-aef8-c31e6af14f17.
GET http://blackpearl-hostname/_rest_/s3_target_read_preference/5cbf1b35-0d06-43f5-

aef8-c31e6af14f17/ HTTP/1.1

April 2023 DS3 API Reference-Spectra BlackPearl Nearline Gateway
- 419 -



Chapter 12 - Replication Target Operations Get Amazon S3 Target Read Preferences

Sample Response
HTTP/1.1 200 OK

<Data>

   <BucketId>b0a6249d-d096-4c05-a428-548f65214fb8</BucketId>

   <Id>6e91318c-8a1a-4b1a-85b4-077c901554bb</Id>

   <ReadPreference>MINIMUM_LATENCY</ReadPreference>

   <TargetId>5cbf1b35-0d06-43f5-aef8-c31e6af14f17</TargetId>

</Data>

GET AMAZON S3 TARGET READ PREFERENCES

Description
Get information about the default read preference for all Amazon S3 targets. Use parameters
as selection criteria to return a subset of the list.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/s3_target_read_preference/[?bucket_id=

{string}][&last_page][&page_length={32-bit integer}][&page_offset={32-bit integer}]

[&page_start_marker={string}][&read_preference=MINIMUM_LATENCY|AFTER_ONLINE_

POOL|AFTER_NEARLINE_POOL|AFTER_NON_EJECTABLE_TAPE|LAST_RESORT|NEVER][&target_id=

{string}]

Request Parameters 

Parameter Description Required

bucket_id The bucket name, UUID, or other unique attribute. no

last_page If included, only the last page of results is returned. no

page_length The maximum number of Amazon S3 target read preferences to list.
Default: all items after page_offset.

no

page_offset The starting point for the first Amazon S3 target read preferences to
list.
Default: 0.

no
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Parameter Description Required

page_start_
marker

The UUID or other unique attribute for the item just before the first
item to list.
Notes:
• Specifying both page_offset and page_start_marker causes
an error.

• If neither page_offset, nor page_start_marker are
specified, the page_offset default is used.

no

read_
preference

When it is preferable to read from the Amazon S3 target rather than
the replication source.
Values: MINIMUM_LATENCY, AFTER_ONLINE_POOL, AFTER_
NEARLINE_POOL, AFTER_NON_EJECTABLE_TAPE, LAST_RESORT,
NEVER. See read_preference on page 403.

no

target_id The UUID, name, or other unique attribute for the replication
target.

no

Responses

Response Elements
<Data>

   <S3TargetReadPreference>

      <BucketId>{string}</BucketId>

      <Id>{string}</Id>

      <ReadPreference>

         MINIMUM_LATENCY|AFTER_ONLINE_POOL|AFTER_NEARLINE_POOL

         |AFTER_NON_EJECTABLE_TAPE|LAST_RESORT|NEVER

      </ReadPreference>

      <TargetId>{string}</TargetId>

   </S3TargetReadPreference>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

S3TargetRead
Preference

The container for information about the read preference for one Amazon S3
target.
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Parameter Description

BucketId The UUID for the bucket.

Id The UUID for the read preference.

ReadPreference When it is preferable to read from the Amazon S3 target rather than the
replication source.
Values: MINIMUM_LATENCY, AFTER_ONLINE_POOL, AFTER_NEARLINE_POOL,
AFTER_NON_EJECTABLE_TAPE, LAST_RESORT, NEVER. See read_preference
on page 403.

TargetId The UUID for the replication target.

Example

Sample Request
This request gets information about the read preference for each Amazon S3 target registered
to the source.
GET http://blackpearl-hostname/_rest_/s3_target_read_preference/ HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>

   <S3TargetReadPreference>

      <BucketId>306e0f35-aadd-4152-90eb-7fcf42df7a15</BucketId>

      <Id>8d0aae6a-2d72-486c-9142-f0542662776f</Id>

      <ReadPreference>MINIMUM_LATENCY</ReadPreference>

      <TargetId>3e0cd533-f062-4504-8063-c59c4e478549</TargetId>

   </S3TargetReadPreference>

</Data>

GET AMAZON S3 TARGETS

Description
Get information about all registered Amazon S3 targets. Use parameters as selection criteria
to return a subset of the list.
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Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/s3_target/[?access_key={string}][&data_path_

end_point={string}][&default_read_preference=MINIMUM_LATENCY|AFTER_ONLINE_

POOL|AFTER_NEARLINE_POOL|AFTER_NON_EJECTABLE_TAPE|LAST_RESORT|NEVER]

[&https=TRUE|FALSE][&last_page][&name={string}][&naming_mode=BLACK_PEARL|AWS_S3]

[&page_length={32-bit integer}][&page_offset={32-bit integer}][&page_start_marker=

{string}][&permit_going_out_of_sync=TRUE|FALSE][&quiesced=NO|PENDING|YES]

[&region=US_EAST_1|US_EAST_2|US_WEST_1|US_WEST_2|EU_WEST_1|EU_WEST_2|EU_CENTRAL_

1|AP_SOUTH_1|AP_SOUTHEAST_1|AP_SOUTHEAST_2|AP_NORTHEAST_1|AP_NORTHEAST_2|SA_EAST_

1|CN_NORTH_1|GOV_CLOUD|CA_CENTRAL_1][&state=ONLINE|LIMITED_ACCESS|OFFLINE]

Request Parameters 

Parameter Description Required

access_key The access key of user for the Amazon S3 account. no

data_path_
end_ point

The IPv4 address or DNS name for the data path of the Amazon S3
target.

no

default_
read_
preference

When it is preferable to read from the Amazon S3 target rather than
the replication source.
Values: MINIMUM_LATENCY, AFTER_ONLINE_POOL, AFTER_
NEARLINE_POOL, AFTER_NON_EJECTABLE_TAPE, LAST_RESORT,
NEVER. See read_preference on page 455.

no

https Whether the BlackPearl gateway uses the HTTPS protocol to setup
and replicate data to the target.
Values: TRUE, FALSE

no

last_page If included, only the last page of results is returned. no

name The name for the Amazon S3 target. no

naming_
mode

Whether files written to the target use BlackPearl (file UUIDs) or
Amazon S3 (file names) naming conventions.
Values: BLACK_PEARL, AWS_S3

no

page_length The maximum number of Amazon S3 targets to list.
Default: all items after page_offset.

no
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Parameter Description Required

page_offset The starting point for the first Amazon S3 target to list.
Default: 0.

no

page_start_
marker

The UUID or other unique attribute for the item just before the first
item to list.
Notes:
• Specifying both page_offset and page_start_marker causes
an error.

• If neither page_offset, nor page_start_marker are
specified, the page_offset default is used.

no

permit_
going_out_
of_sync

Whether a target is allowed to be out of sync with the source. See
permit_going_out_of_sync on page 442.
Note: This parameter is deprecated.

no

quiesced Whether the Amazon S3 target is in a temporarily inactive state.
Values: NO, PENDING, YES

no

region The world region where the Amazon S3 target is physically located.
Values: US_EAST_1, US_EAST_2, US_WEST_1, US_WEST_2, EU_
WEST_1, EU_WEST_2, EU_CENTRAL_1, AP_SOUTH_1, AP_
SOUTHEAST_1, AP_SOUTHEAST_2, AP_NORTHEAST_1, AP_
NORTHEAST_2, SA_EAST_1, CN_NORTH_1, GOV_CLOUD, CA_
CENTRAL_1

no

state The state of the Amazon S3 target.
Values: ONLINE, OFFLINE, LIMITED_ACCESS

no

Responses

Response Elements
<Data>
   <S3Target>
      <AccessKey>{string}</AccessKey>
      <AutoVerifyFrequencyInDays>

{integer}

      </AutoVerifyFrequencyInDays>
      <CloudBucketPrefix>{string}</CloudBucketPrefix>
      <CloudBucketSuffix>{string}</CloudBucketSuffix>
      <DataPathEndPoint>{string}</DataPathEndPoint>
      <DefaultReadPreference>

        MINIMUM_LATENCY|AFTER_ONLINE_POOL|AFTER_NEARLINE_POOL

        |AFTER_NON_EJECTABLE_TAPE|LAST_RESORT|NEVER

      </DefaultReadPreference>
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      <Https>TRUE|FALSE</Https>
      <Id>{string}</Id>
      <LastFullyVerified>{string}</LastFullyVerified>
      <Name>{string}</Name>
      <NamingMode>BLACK_PEARL|AWS_S3</NamingMode>
      <OfflineDataStagingWindowInTb>

{64-bit integer}
      </OfflineDataStagingWindowInTb>
      <PermitGoingOutOfSync>TRUE|FALSE</PermitGoingOutOfSync>
      <ProxyDomain>{string}</ProxyDomain>
      <ProxyHost>{string}</ProxyHost>
      <ProxyPassword>{string}</ProxyPassword>
      <ProxyPort>{64-bit integer}</ProxyPort>
      <ProxyUsername>{string}</ProxyUsername>
      <Quiesced>NO|PENDING|YES</Quiesced>
      <Region>

         US_EAST_1|US_EAST_2|US_WEST_1|US_WEST_2|EU_WEST_1|

         EU_WEST_2|EU_CENTRAL_1|AP_SOUTH_1|AP_SOUTHEAST_1|

         AP_SOUTHEAST_2|AP_NORTHEAST_1|AP_NORTHEAST_2|SA_EAST_1|

         CN_NORTH_1|GOV_CLOUD|CA_CENTRAL_1

      </Region>
      <SecretKey>{string}</SecretKey>
      <StagedDataExpirationInDays>

{64-bit integer}
      </StagedDataExpirationInDays>
      <State>ONLINE|OFFLINE|LIMITED_ACCESS</State>
   </S3Target>
</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

AccessKey The S3 Access Key of the user for the Amazon S3 account.

AutoVerify
FrequencyInDays

The frequency at which a full verify of the data on the target
is scheduled. If null, no full verify is scheduled. It is useful to
schedule auto verify when the target is a storage domain in a
data policy using replicate deletes. The verify ensures that
deletes replicate in a timely manner.
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Parameter Description

CloudBucketPrefix The Amazon S3 target bucket prefix.
Bucket names on the BlackPearl gateway must be unique
within the BlackPearl gateway, but bucket names in Amazon
S3 must be unique across the world. To permit friendlier,
shorter local bucket names on the BlackPearl gateway while
avoiding naming conflicts with Amazon S3, the BlackPearl
gateway optionally adds the defined Cloud Bucket Prefix to
the BlackPearl bucket name when it replicates the bucket.

CloudBucketSuffix The Amazon S3 target bucket suffix.
Bucket names on the BlackPearl gateway must be unique
within the BlackPearl gateway, but bucket names in Amazon
S3 must be unique across the world. To permit friendlier,
shorter local bucket names on the BlackPearl gateway while
avoiding naming conflicts with Amazon S3, the BlackPearl
gateway optionally adds the defined Cloud Bucket Suffix to
the BlackPearl bucket name when it replicates the bucket.

DataPathEndpoint The IPv4 address or DNS name for the data path of the AWS
cloud service.

DefaultRead Preference When it is preferable to read from the Amazon S3 target
rather than the replication source.
Values: MINIMUM_LATENCY, AFTER_ONLINE_POOL, AFTER_
NEARLINE_POOL, AFTER_NON_EJECTABLE_TAPE, LAST_
RESORT, NEVER. See read_preference on page 455.

Https Whether the BlackPearl gateway uses the HTTPS protocol to
setup and replicate data to the target.
Values: TRUE, FALSE.

Id The UUID for the Amazon S3 target instance.

LastFullyVerified The date and time data on the target was last fully verified in
the format YYYY-MM-DDThh:mm:ss.xxxZ.

Name The name for the Amazon S3 target.

NamingMode Whether files written to the target use BlackPearl (file
UUIDs) or Amazon S3 (file names) naming conventions.
Values: BLACK_PEARL, AWS_S3

OfflineDataStagingWindowInTb The maximum size, in TB, of the window available for
staging data that is offline (in Glacier) so that it can be read.
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Parameter Description

PermitGoingOutOfSync Whether a target is allowed to be out of sync with the source.
See permit_going_out_of_sync on page 442.
Note: This parameter is deprecated.

ProxyDomain The domain name for the proxy server.

ProxyHost The host name or IP address for the proxy server
which the BlackPearl gateway connects.

ProxyPassword The password used when connecting through the proxy
server.

ProxyPort The proxy server port through which the BlackPearl gateway
connects.

ProxyUsername The username used when connecting through the proxy
server.

Quiesced Whether the Amazon S3 target is in a temporarily inactive
state. Values: NO, PENDING, YES

Region The world region where the Amazon S3 target is physically
located. Values: US_EAST_1, US_EAST_2, US_WEST_1, US_
WEST_2, EU_WEST_1, EU_WEST_2, EU_CENTRAL_1, AP_
SOUTH_1, AP_SOUTHEAST_1, AP_SOUTHEAST_2, AP_
NORTHEAST_1, AP_NORTHEAST_2, SA_EAST_1, CN_NORTH_
1, GOV_CLOUD, CA_CENTRAL_1

SecretKey The secret key associated with the AccessKey.

StagedData
ExpirationInDays

The number of days before the pre-staged copy of data can
expire. If the BlackPearl gateway does not retrieve all of the
data before the copy expires, it has to go through the process
of pre-staging it again, incurring additional delays and costs.

State The state of the Amazon S3 target.
Values: ONLINE, OFFLINE, LIMITED_ACCESS

Example

Sample Request
This request gets information about all Amazon S3 targets registered to the source BlackPearl
gateway.
GET http[s]://blackpearl-hostname/_rest_/s3_target/ HTTP/1.1
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Sample Response
HTTP/1.1 200 OK

<Data>

   <S3Target>

     <AccessKey>5sLpd33z</AccessKey>
     <AutoVerifyFrequencyInDays/>
     <CloudBucketPrefix/>
     <CloudBucketSuffix/>
     <DataPathEndPoint/>
     <DefaultReadPreference>LAST_RESORT</DefaultReadPreference>
     <Https>TRUE</Https>
     <Id>7a50b0f1-f78d-49a8-bd15-898bdd02a756</Id>
     <LastFullyVerified/>
     <Name>S3Target-32c68e61-07e3-4093-a906-14796239e37d</Name>
     <NamingMode>BLACK_PEARL</NamingMode>
     <OfflineDataStagingWindowInTb>
        1
     </OfflineDataStagingWindowInTb>
     <PermitGoingOutOfSync>FALSE</PermitGoingOutOfSync>
     <ProxyDomain/>
     <ProxyHost/>
     <ProxyPassword/>
     <ProxyPort/>
     <ProxyUsername/>
     <Quiesced>NO</Quiesced>
     <Region>US_WEST_2</Region>
     <SecretKey>7dm2wWn</SecretKey>
     <StagedDataExpirationInDays>30</StagedDataExpirationInDays>
     <State>ONLINE</State>

   </S3Target>

</Data>

GET BLOBS ON AMAZON S3 TARGET

Description
Get the object pieces on the specified Amazon S3 target.
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Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/s3_target/{Amazon S3 target instance UUID,

name, or other unique attribute}/?operation=GET_PHYSICAL_PLACEMENT/

To determine the UUID for an Amazon S3 target, see Get Amazon S3 Targets on page 422.

Request Parameters

Parameter Description Required

operation The operation to perform on the Amazon S3 target. For this
command, the operation is Get Physical Placement.

yes

Responses

Response Elements
<Data>

   <Object Bucket="{string}" Id="{string}" Latest="TRUE|FALSE"

   Length="{64-bit integer}" Name="{string}"

   Offset="{64-bit integer}" VersionId="{string}"/>

   ...

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

Object The container for the information about one object.

Bucket The name of the bucket containing the object.

Id The UUID for the object.

Latest Whether or not the object is the latest version of the file.
Values: TRUE, FALSE

Length The length in bytes of the of object.
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Parameter Description

Name The name of the object.

Offset The object in bytes from the start of the object.

VersionId The UUID of the version of the object.

Example

Sample Request
This request gets a list of all blobs on the Amazon S3 target.
GET http://blackpearl-hostname/_rest_/s3_target/7a50b0f1-f78d-49a8-bd15-

898bdd02a756/?operation=GET_PHYSICAL_PLACEMENT HTTP/1.1

Sample Response
<Data>

   <Object Bucket="default_bucket_name" Id="1c4fc33b-f997-43f8-

   bdb9-9bb5e748c7b8" Latest="TRUE" Length="10" Name="obj1"

   Offset="0" VersionId="aaaf1e07-f0b0-4454-b6f3-b58380b8a14a"/>

   <Object Bucket="default_bucket_name" Id="46d7d57d-f4ae-4406-

   bb1b-a850b9a22ecc" Latest="TRUE" Length="10" Name="obj2"

   Offset="0" VersionId="6f04d542-78cb-4778-aa64-05a0335823ad"/>

</Data>

IMPORT AMAZON S3 TARGET

Description
Imports a copy of the objects in the specified bucket on the specified Amazon S3 target to the
local BlackPearl gateway.

Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/s3_target/{unique identifier or

attribute}/?operation=import &cloud_bucket_name={string}][&data_policy_id={unique

identifier or attribute}][&priority={CRITICAL|URGENT|HIGH|NORMAL|LOW|BACKGROUND}]

[&user_id={unique identifier or attribute}]
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Request Parameters

Parameter Description Required

operation The operation to perform. For this request, the operation is import.
Value: IMPORT

yes

cloud_
bucket
_name

The name or UUID of the bucket on the Amazon S3 target to
transfer to the BlackPearl gateway.

yes

data_policy_
id

The UUID, name, or other unique attribute for the data policy to
associate with objects on the Amazon S3 target that do not already
exist on the BlackPearl gateway.
Note: If a bucket with the name cloud_bucket_name, does not already
exist on the BlackPearl gateway, then data_policy_id and user_
id are required.

no

priority The priority for processing the import. The priority determines
the resources assigned and the processing order. Imports can be
interrupted every 30 minutes if a job with a higher priority is
received.
Values: URGENT, HIGH, NORMAL, LOW

no

user_id The UUID, name, or other unique attribute for the user to associate
with any buckets on the Azure target that do not already exist on
the BlackPearl gateway.
Note: If a bucket with the name cloud_bucket_name, does not already
exist on the BlackPearl gateway, then data_policy_id and user_
id are required.

no

Responses
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 500: Internal Error
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Example

Sample Request
This command imports the objects in the bucket named “Accounting” from the specified
Amazon S3 target.
PUT http://blackpearl-hostname/_rest_/s3_target/dd9505ed-ca71-43c0-8715-

e3a4699244d6/?operation=IMPORT&cloudBucketName=Accounting HTTP/1.1

Sample Response
HTTP/1.1 204 No Content

MODIFY ALL AMAZON S3 TARGETS

Description
Sets all Amazon S3 targets to a quiesced (YES), unquiesced (NO), or pending quiesce
(PENDING) state. It is not possible to change the state directly from NO to YES.

Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/s3_target/?quiesced=NO|PENDING

Request Parameters

Parameter Description Required

quiesced Whether to put all the Amazon S3 targets into a temporarily
inactive state (PENDING) or return all Amazon S3 targets to an
active state (NO).

yes

Responses
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 404: Not Found
• 409: Conflict
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Example

Sample Request
This request modifies the quiesced state of all Amazon S3 targets to NO.
PUT http://blackpearl-hostname/_rest_/s3_target/?quiesced=NO HTTP/1.1

Sample Response
HTTP/1.1 204 No Content

MODIFY AMAZON S3 TARGET

Description
Modify an Amazon S3 target.

Notes:

• If an optional request parameter is not included, the previous setting is retained.

• It is not possible to change the quiesced state directly from NO to YES.

Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/s3_target/{BlackPearl target instance UUID,

name, or other unique attribute}/
[?access_key={string}][&auto_verify_frequency_in_days={64-bit integer}][&cloud_

bucket_prefix={string}][&cloud_bucket_suffix={string}][&data_path_end_point=

{string}][&default_read_preference=MINIMUM_LATENCY|AFTER_ONLINE_POOL|AFTER_NEARLINE_

POOL|AFTER_NON_EJECTABLE_TAPE|LAST_RESORT|NEVER][&https=TRUE|FALSE[&name={string}]

[&naming_mode=BLACK_PEARL|AWS_S3][&offline_data_staging_window_in_tb={64-bit

integer}][&permit_going_out_of_sync=TRUE|FALSE][&proxy_domain={string}][&proxy_host=

{string}][&proxy_password={string}][&proxy_port={string}][&proxy_username={string}]

[&quiesced=NO|PENDING][&region=US_EAST_1|US_EAST_2|US_WEST_1|US_WEST_2|EU_WEST_1|EU_

WEST_2|EU_CENTRAL_1|AP_SOUTH_1|AP_SOUTHEAST_1|AP_SOUTHEAST_2|AP_NORTHEAST_1|AP_

NORTHEAST_2|SA_EAST_1|CN_NORTH_1|GOV_CLOUD|CA_CENTRAL_1][&secret_key={string}]

[&staged_data_expiration_in_days={string}]

To determine the UUID for an Amazon S3 target instance, see Get Amazon S3 Targets on
page 422.
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Request Parameters 

Parameter Description Required

access_key The S3 Access Key of the user for the Amazon S3 account. no

auto_verify_
frequency_in_
days

The frequency at which a full verify of the data on the target is
scheduled. If null, no full verify is scheduled. It is useful to
schedule auto verify when the target is a storage domain in a data
policy using replicate deletes. The verify ensures that deletes
replicate in a timely manner.

no

cloud_
bucket_
prefix

The Amazon S3 target bucket prefix. The prefix must adhere to the
Amazon S3 naming requirements.
Bucket names on the BlackPearl gateway must be unique within
the gateway, but bucket names in Amazon S3 must be unique
across the world. To permit friendlier, shorter local bucket names
on the BlackPearl gateway while avoiding naming conflicts with
Amazon S3, the BlackPearl gateway optionally adds the defined
Cloud Bucket Prefix to the BlackPearl bucket name when it
replicates the bucket.

no

cloud_
bucket_
suffix

The Amazon S3 target bucket suffix. The suffix must adhere to the
Amazon S3 naming requirements.
Bucket names on the BlackPearl gateway must be unique within
the gateway, but bucket names in Amazon S3 must be unique
across the world. To permit friendlier, shorter local bucket names
on the BlackPearl gateway while avoiding naming conflicts with
Amazon S3, the BlackPearl gateway optionally adds the defined
Cloud Bucket Suffix to the BlackPearl bucket name when it
replicates the bucket.

no

data_path_
end_
point

The IPv4 address or DNS name for the data path of the AWS cloud
service.

no

default_read_
preference

When it is preferable to read from the Amazon S3 target rather
than the replication source.
Values: MINIMUM_LATENCY, AFTER_ONLINE_POOL, AFTER_
NEARLINE_POOL, AFTER_NON_EJECTABLE_TAPE, LAST_RESORT,
NEVER. See read_preference on page 455.

no

https Whether the BlackPearl gateway uses the HTTPS protocol to setup
and replicate data to the target.
Values: TRUE, FALSE.

no

name The name for the Amazon S3 target. no
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Parameter Description Required

naming_
mode

Whether files written to the target use BlackPearl (file UUIDs) or
Amazon S3 (file names) naming conventions.
Values: BLACK_PEARL, AWS_S3
Note: You cannot change the naming_mode of a target that already
has associated buckets.

no

offline_data_
staging_
window_
in_tb

The maximum size, in TB, of the window available for staging data
that is offline (in Glacier) so that it can be read.

no

permit_
going_out_
of_sync

Whether a target is allowed to be out of sync with the source. By
default, if the data policy specifies that the BlackPearl gateway
must replicate local actions, actions that the gateway cannot
replicate fail. You can temporarily set this parameter to TRUE in
order to operate in full capacity locally while one or more targets is
down for a prolonged period of time. Values: TRUE, FALSE
Note: This parameter is deprecated.

no

proxy_
domain

The domain name for the proxy server. no

proxy_host The host name or IP address for the proxy server
which the BlackPearl gateway connects.

no

proxy_
password

The password used when connecting through the proxy server. no

proxy_port The proxy server port through which the BlackPearl gateway
connects.

no

proxy_
username

The username used when connecting through the proxy server. no

quiesced Request that the gateway prepare the target to go into an inactive
state (PENDING) or return the target to an active state (NO).
state. Values: NO, PENDING

no

region The world region where the Amazon S3 target is physically
located. Values: US_EAST_1, US_EAST_2, US_WEST_1, US_WEST_2,
EU_WEST_1, EU_WEST_2, EU_CENTRAL_1, AP_SOUTH_1, AP_
SOUTHEAST_1, AP_SOUTHEAST_2, AP_NORTHEAST_1, AP_
NORTHEAST_2, SA_EAST_1, CN_NORTH_1, GOV_CLOUD, CA_
CENTRAL_1

no
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Parameter Description Required

secret_key The secret key associated with the AccessKey. no

staged_data_
expiration_
in_days

The number of days before the pre-staged copy of data can expire.
If the BlackPearl gateway does not retrieve all of the data before
the copy expires, it has to go through the process of pre-staging it
again, incurring additional delays and costs.

no

Responses

Response Elements
<Data>
   <AccessKey>{string}</AccessKey>
   <AutoVerifyFrequencyInDays>{string}</AutoVerifyFrequencyInDays>
   <CloudBucketPrefix>{string}</CloudBucketPrefix>
   <CloudBucketSuffix>{string}</CloudBucketSuffix>
   <DataPathEndPoint>{string}</DataPathEndPoint>
   <DefaultReadPreference>

      MINIMUM_LATENCY|AFTER_ONLINE_POOL|AFTER_NEARLINE_POOL

      |AFTER_NON_EJECTABLE_TAPE|LAST_RESORT|NEVER

   </DefaultReadPreference>
   <Https>TRUE|FALSE</Https>
   <Id>{string}</Id>
   <LastFullyVerified>{string}</LastFullyVerified>
   <Name>{string}</Name>

   <NamingMode>BLACK_PEARL|AWS_S3</NamingMode>
   <OfflineDataStagingWindowInTb>

{64-bit integer}
   </OfflineDataStagingWindowInTb>
   <PermitGoingOutOfSync>TRUE|FALSE</PermitGoingOutOfSync>
   <ProxyDomain>{string}</ProxyDomain>
   <ProxyHost>{string}</ProxyHost>
   <ProxyPassword>{string}</ProxyPassword>
   <ProxyPort>{64-bit integer}</ProxyPort>
   <ProxyUsername>{string}</ProxyUsername>
   <Quiesced>NO|PENDING|YES</Quiesced>
   <Region>

      US_EAST_1|US_EAST_2|US_WEST_1|US_WEST_2|EU_WEST_1|

      EU_WEST_2|EU_CENTRAL_1|AP_SOUTH_1|AP_SOUTHEAST_1|

      AP_SOUTHEAST_2|AP_NORTHEAST_1|AP_NORTHEAST_2|SA_EAST_1|

      CN_NORTH_1|GOV_CLOUD|CA_CENTRAL_1

   </Region>
   <SecretKey>{string}</SecretKey>
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   <StagedDataExpirationInDays>
{64-bit integer}

   </StagedDataExpirationInDays>
   <State>ONLINE|OFFLINE|LIMITED_ACCESS</State>
</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

AccessKey The S3 Access Key of the user for the Amazon S3 account.

AutoVerify
FrequencyInDays

The frequency at which a full verify of the data on the target
is scheduled. If null, no full verify is scheduled. It is useful to
schedule auto verify when the target is a storage domain in a
data policy using replicate deletes. The verify ensures that
deletes replicate in a timely manner.

CloudBucketPrefix The Amazon S3 target bucket prefix.
Bucket names on the BlackPearl gateway must be unique
within the gateway, but bucket names in Amazon S3 must be
unique across the world. To permit friendlier, shorter local
bucket names on the BlackPearl gateway while avoiding
naming conflicts with Amazon S3, the BlackPearl gateway
optionally adds the defined Cloud Bucket Prefix to the
BlackPearl bucket name when it replicates the bucket.

CloudBucketSuffix The Amazon S3 target bucket suffix.
Bucket names on the BlackPearl gateway must be unique
within the gateway, but bucket names in Amazon S3 must be
unique across the world. To permit friendlier, shorter local
bucket names on the BlackPearl gateway while avoiding
naming conflicts with Amazon S3, the BlackPearl gateway
optionally adds the defined Cloud Bucket Suffix to the
BlackPearl bucket name when it replicates the bucket.

DataPathEndpoint The IPv4 address or DNS name for the data path of the AWS
cloud service.

DefaultRead Preference When it is preferable to read from the Amazon S3 target
rather than the replication source.
Values: MINIMUM_LATENCY, AFTER_ONLINE_POOL, AFTER_
NEARLINE_POOL, AFTER_NON_EJECTABLE_TAPE, LAST_
RESORT, NEVER. See read_preference on page 455.
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Parameter Description

Https Whether the BlackPearl gateway uses the HTTPS protocol to
setup and replicate data to the target.
Values: TRUE, FALSE.

Id The UUID for the Amazon S3 target instance.

LastFullyVerified The date and time data on the target was last fully verified in
the format YYYY-MM-DDThh:mm:ss.xxxZ.

Name The name for the Amazon S3 target.

NamingMode Whether files written to the target use BlackPearl (file
UUIDs) or Amazon S3 (file names) naming conventions.
Values: BLACK_PEARL, AWS_S3

OfflineDataStagingWindowInTb The maximum size, in TB, of the window available for
staging data that is offline (in Glacier) so that it can be read.

PermitGoingOutOfSync Whether a target is allowed to be out of sync with the source.
See permit_going_out_of_sync on page 442.
Note: This parameter is deprecated.

ProxyDomain The domain name for the proxy server.

ProxyHost The host name or IP address for the proxy server
which the BlackPearl gateway connects.

ProxyPassword The password used when connecting through the proxy
server.

ProxyPort The proxy server port through which the BlackPearl gateway
connects.

ProxyUsername The username used when connecting through the proxy
server.

Quiesced Whether the Amazon S3 target is in a temporarily inactive
state. Values: NO, PENDING, YES

Region The world region where the Amazon S3 target is physically
located. Values: US_EAST_1, US_EAST_2, US_WEST_1, US_
WEST_2, EU_WEST_1, EU_WEST_2, EU_CENTRAL_1, AP_
SOUTH_1, AP_SOUTHEAST_1, AP_SOUTHEAST_2, AP_
NORTHEAST_1, AP_NORTHEAST_2, SA_EAST_1, CN_NORTH_
1, GOV_CLOUD, CA_CENTRAL_1
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Parameter Description

SecretKey The secret key associated with the AccessKey.

StagedData
ExpirationInDays

The number of days before the pre-staged copy of data can
expire. If the BlackPearl gateway does not retrieve all of the
data before the copy expires, it has to go through the process
of pre-staging it again, incurring additional delays and costs.

State The state of the Amazon S3 target.
Values: ONLINE, OFFLINE, LIMITED_ACCESS

Example

Sample Request
This request modifies the Amazon S3 target named ‘TargetS3’ to set the automatic data verify
frequency to 365 days.

PUT http[s]://blackpearl-hostname/_rest_/s3_

target/TargetS3/?autoVerifyFrequencyInDays=365 HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>
   <AccessKey>KbC74x9s</AccessKey>
   <AutoVerifyFrequencyInDays>365</AutoVerifyFrequencyInDays>
   <CloudBucketPrefix/>
   <CloudBucketSuffix/>
   <DataPathEndPoint/>
   <DefaultReadPreference>LAST_RESORT</DefaultReadPreference>
   <Https>TRUE</Https>
   <Id>a9a8afe0-a426-4f80-8c25-d768a6494129</Id>
   <LastFullyVerified/>
   <Name>TargetS3</Name>
   <NamingMode>BLACK_PEARL</NamingMode>
   <OfflineDataStagingWindowInTb>1</OfflineDataStagingWindowInTb>
   <PermitGoingOutOfSync>FALSE</PermitGoingOutOfSync>
   <ProxyDomain/>
   <ProxyHost/>
   <ProxyPassword/>
   <ProxyPort/>
   <ProxyUsername/>
   <Quiesced>NO</Quiesced>
   <Region>US_WEST_2</Region>
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   <SecretKey>m3u8nW5/SecretKey>
   <StagedDataExpirationInDays>30</StagedDataExpirationInDays>
   <State>ONLINE</State>
</Data>

REGISTER AMAZON S3 TARGET

Description
Connect to and register the specified Amazon S3 target as a replication target for the
BlackPearl gateway.

Notes:

• Only Amazon Web Services (AWS) S3 is qualified as an Amazon S3 target.
Other S3 services have not been tested.

• You must include either a data_path_endpoint or a region. If you include both a
Data Path End Point and a Region, the BlackPearl gateway uses the Data Path
End Point and ignores the Region.

• You cannot use the same Data Path End Point or Region, and Access Key for
multiple Amazon S3 targets as this could cause data conflicts.

Requests

Syntax
POST http[s]://{datapathDNSname}/_rest_/s3_target/?access_key={string}&name=

{string}&secret_key={string}[&auto_verification_frequency_in_days={32-bit integer}]

[&cloud_bucket_prefix={string}][&cloud_bucket_suffix={string}][&data_path_end_point=

{string}][&default_read_preference=MINIMUM_LATENCY|AFTER_ONLINE_POOL|AFTER_NEARLINE_

POOL|AFTER_NON_EJECTABLE_TAPE|LAST_RESORT|NEVER][&https=TRUE|FALSE][&naming_

mode=BLACK_PEARL|AWS_S3][&offline_data_staging_window_in_tb={64-bit integer}]

[&permit_going_out_of_sync=TRUE|FALSE][&proxy_domain={string}][&proxy_host={string}]

[&proxy_password={string}][&proxy_port={string}][&proxy_username={string}]

[&region=US_EAST_1|US_EAST_2|US_WEST_1|US_WEST_2|EU_WEST_1|EU_WEST_2|EU_CENTRAL_

1|AP_SOUTH_1|AP_SOUTHEAST_1|AP_SOUTHEAST_2|AP_NORTHEAST_1|AP_NORTHEAST_2|SA_EAST_

1|CN_NORTH_1|GOV_CLOUD|CA_CENTRAL_1][&secret_key={string}][&staged_data_expiration_

in_days={string}]
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Request Parameters 

Parameter Description Required

access_key The S3 Access Key of the user for the Amazon S3 account. yes

name The name for the Amazon S3 target. yes

secret_key The secret key associated with the AccessKey. yes

auto_verify_
frequency_in_
days

The frequency at which a full verify of the data on the target is
scheduled. If null (default), no full verify is scheduled. It is useful
to schedule auto verify when the target is a storage domain in a
data policy using replicate deletes. The verify ensures that deletes
replicate in a timely manner.

no

cloud_
bucket_
prefix

The Amazon S3 target bucket prefix. The prefix must adhere to the
Amazon S3 naming requirements.
Bucket names on the BlackPearl gateway must be unique within
the gateway, but bucket names in Amazon S3 must be unique
across the world. To permit friendlier, shorter local bucket names
on the BlackPearl gateway while avoiding naming conflicts with
Amazon S3, the BlackPearl gateway optionally adds the defined
Cloud Bucket Prefix to the BlackPearl bucket name when it
replicates the bucket.

no

cloud_
bucket_
suffix

The Amazon S3 target bucket suffix. The suffix must adhere to the
Amazon S3 naming requirements.
Bucket names on the BlackPearl gateway must be unique within
the gateway, but bucket names in Amazon S3 must be unique
across the world. To permit friendlier, shorter local bucket names
on the BlackPearl gateway while avoiding naming conflicts with
Amazon S3, the BlackPearl gateway optionally adds the defined
Cloud Bucket Suffix to the BlackPearl bucket name when it
replicates the bucket.

no

data_path_
end_
point

The IPv4 address or DNS name for the data path of the AWS cloud
service.

no

default_read_
preference

When it is preferable to read from the Amazon S3 target rather
than the replication source.
Values: MINIMUM_LATENCY, AFTER_ONLINE_POOL, AFTER_
NEARLINE_POOL, AFTER_NON_EJECTABLE_TAPE, LAST_RESORT,
NEVER. See read_preference on page 455.

no
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Parameter Description Required

https Whether the BlackPearl gateway uses the HTTPS protocol to setup
and replicate data to the target.
Values: TRUE (default), FALSE .

no

naming_
mode

Whether files written to the target use BlackPearl (file UUIDs) or
Amazon S3 (file names) naming conventions.
Values: BLACK_PEARL (default), AWS_S3

no

offline_data_
staging_
window_
in_tb

The maximum size, in TB, of the window available for staging data
that is offline (in Glacier) so that it can be read.

no

permit_
going_out_
of_sync

Whether a target is allowed to be out of sync with the source. By
default, if the data policy specifies that the BlackPearl gateway
must replicate local actions, actions that the gateway cannot
replicate fail. You can temporarily set this parameter to TRUE in
order to operate in full capacity locally while one or more targets is
down for a prolonged period of time. Values: TRUE, FALSE
(default)
Note: This parameter is deprecated.

no

proxy_
domain

The domain name for the proxy server. no

proxy_host The host name or IP address for the proxy server
which the BlackPearl gateway connects.

no

proxy_
password

The password used when connecting through the proxy server. no

proxy_port The proxy server port through which the BlackPearl gateway
connects.

no

proxy_
username

The username used when connecting through the proxy server. no

region The world region where the Amazon S3 target is physically
located. Values: US_EAST_1, US_EAST_2, US_WEST_1, US_WEST_2,
EU_WEST_1, EU_WEST_2, EU_CENTRAL_1, AP_SOUTH_1, AP_
SOUTHEAST_1, AP_SOUTHEAST_2, AP_NORTHEAST_1, AP_
NORTHEAST_2, SA_EAST_1, CN_NORTH_1, GOV_CLOUD, CA_
CENTRAL_1

no
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Parameter Description Required

staged_data_
expiration_
in_days

The number of days before the pre-staged copy of data can expire.
If the BlackPearl gateway does not retrieve all of the data before
the copy expires, it has to go through the process of pre-staging it
again, incurring additional delays and costs.

no

Responses

Response Elements
<Data>
   <AccessKey>{string}</AccessKey>
   <AutoVerifyFrequencyInDays>{string}</AutoVerifyFrequencyInDays>
   <CloudBucketPrefix>{string}</CloudBucketPrefix>
   <CloudBucketSuffix>{string}</CloudBucketSuffix>
   <DataPathEndPoint>{string}</DataPathEndPoint>
   <DefaultReadPreference>

      MINIMUM_LATENCY|AFTER_ONLINE_POOL|AFTER_NEARLINE_POOL

      |AFTER_NON_EJECTABLE_TAPE|LAST_RESORT|NEVER

   </DefaultReadPreference>
   <Https>TRUE|FALSE</Https>
   <Id>{string}</Id>
   <LastFullyVerified>{string}</LastFullyVerified>
   <Name>{string}</Name>
   <NamingMode>BLACK_PEARL|AWS_S3</NamingMode>
   <OfflineDataStagingWindowInTb>

{64-bit integer}
   </OfflineDataStagingWindowInTb>
   <PermitGoingOutOfSync>TRUE|FALSE</PermitGoingOutOfSync>
   <ProxyDomain>{string}</ProxyDomain>
   <ProxyHost>{string}</ProxyHost>
   <ProxyPassword>{string}</ProxyPassword>
   <ProxyPort>{64-bit integer}</ProxyPort>
   <ProxyUsername>{string}</ProxyUsername>
   <Quiesced>NO|PENDING|YES</Quiesced>
   <Region>

      US_EAST_1|US_EAST_2|US_WEST_1|US_WEST_2|EU_WEST_1|

      EU_WEST_2|EU_CENTRAL_1|AP_SOUTH_1|AP_SOUTHEAST_1|

      AP_SOUTHEAST_2|AP_NORTHEAST_1|AP_NORTHEAST_2|SA_EAST_1|

      CN_NORTH_1|GOV_CLOUD|CA_CENTRAL_1

   </Region>
   <SecretKey>{string}</SecretKey>

April 2023 DS3 API Reference-Spectra BlackPearl Nearline Gateway
- 443 -



Chapter 12 - Replication Target Operations Register Amazon S3 Target

   <StagedDataExpirationInDays>

{64-bit integer}

   </StagedDataExpirationInDays>
   <State>ONLINE|OFFLINE|LIMITED_ACCESS</State>
</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

AccessKey The S3 Access Key of the user for the Amazon S3 account.

AutoVerify
FrequencyInDays

The frequency at which a full verify of the data on the target
is scheduled. If null, no full verify is scheduled. It is useful to
schedule auto verify when the target is a storage domain in a
data policy using replicate deletes. The verify ensures that
deletes replicate in a timely manner.

CloudBucketPrefix The Amazon S3 target bucket prefix.
Bucket names on the BlackPearl gateway must be unique
within the gateway, but bucket names in Amazon S3 must be
unique across the world. To permit friendlier, shorter local
bucket names on the BlackPearl gateway while avoiding
naming conflicts with Amazon S3, the BlackPearl gateway
optionally adds the defined Cloud Bucket Prefix to the
BlackPearl bucket name when it replicates the bucket.

CloudBucketSuffix The Amazon S3 target bucket suffix.
Bucket names on the BlackPearl gateway must be unique
within the gateway, but bucket names in Amazon S3 must be
unique across the world. To permit friendlier, shorter local
bucket names on the BlackPearl gateway while avoiding
naming conflicts with Amazon S3, the BlackPearl gateway
optionally adds the defined Cloud Bucket Suffix to the
BlackPearl bucket name when it replicates the bucket.

DataPathEndpoint The IPv4 address or DNS name for the data path of the AWS
cloud service.

DefaultRead Preference When it is preferable to read from the Amazon S3 target
rather than the replication source.
Values: MINIMUM_LATENCY, AFTER_ONLINE_POOL, AFTER_
NEARLINE_POOL, AFTER_NON_EJECTABLE_TAPE, LAST_
RESORT, NEVER. See read_preference on page 455.
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Parameter Description

Https Whether the BlackPearl gateway uses the HTTPS protocol to
setup and replicate data to the target.
Values: TRUE, FALSE.

Id The UUID for the Amazon S3 target instance.

LastFullyVerified The date and time data on the target was last fully verified in
the format YYYY-MM-DDThh:mm:ss.xxxZ.

Name The name for the Amazon S3 target.

NamingMode Whether files written to the target use BlackPearl (file
UUIDs) or Amazon S3 (file names) naming conventions.
Values: BLACK_PEARL, AWS_S3

OfflineDataStagingWindowInTb The maximum size, in TB, of the window available for
staging data that is offline (in Glacier) so that it can be read.

PermitGoingOutOfSync Whether a target is allowed to be out of sync with the source.
See permit_going_out_of_sync on page 442.
Note: This parameter is deprecated.

ProxyDomain The domain name for the proxy server.

ProxyHost The host name or IP address for the proxy server
which the BlackPearl gateway connects.

ProxyPassword The password used when connecting through the proxy
server.

ProxyPort The proxy server port through which the BlackPearl gateway
connects.

ProxyUsername The username used when connecting through the proxy
server.

Quiesced Whether the Amazon S3 target is in a temporarily inactive
state. Values: NO, PENDING, YES

Region The world region where the Amazon S3 target is physically
located. Values: US_EAST_1, US_EAST_2, US_WEST_1, US_
WEST_2, EU_WEST_1, EU_WEST_2, EU_CENTRAL_1, AP_
SOUTH_1, AP_SOUTHEAST_1, AP_SOUTHEAST_2, AP_
NORTHEAST_1, AP_NORTHEAST_2, SA_EAST_1, CN_NORTH_
1, GOV_CLOUD, CA_CENTRAL_1
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Parameter Description

SecretKey The secret key associated with the AccessKey.

StagedData
ExpirationInDays

The number of days before the pre-staged copy of data can
expire. If the BlackPearl gateway does not retrieve all of the
data before the copy expires, it has to go through the process
of pre-staging it again, incurring additional delays and costs.

State The state of the Amazon S3 target.
Values: ONLINE, OFFLINE, LIMITED_ACCESS

Example

Sample Request
This request registers an Amazon S3 target with the data path end point ‘DataPath’, the S3
Access Key ‘c381Y3RyYQ==’, the S3 Secret Key ‘d7pJBeAN’, and the name ‘TargetS3’ as a
replication target for the BlackPearl gateway.
POST http[s]://blackpearl-hostname/_rest_/s3_target/?admin_auth_

id=c381Y3RyYQ==&admin_secret_key=d7pJBeAN &data_path_end_

point=DataPath&name=TargetS3 HTTP/1.1

Sample Response
HTTP/1.1 201 CREATED

<Data>
   <AccessKey>c381Y3RyYQ==</AccessKey>
   <AutoVerifyFrequencyInDays/>
   <CloudBucketPrefix/>
   <CloudBucketSuffix/>
   <DataPathEndPoint>DataPath</DataPathEndPoint>
   <DefaultReadPreference>MINIMUM_LATENCY</DefaultReadPreference>
   <Https>TRUE</Https>
   <Id>771c3371-8276-45ce-a21c-a3bfd1ca5caa</Id>
   <LastFullyVerified/>
   <Name>TargetS3</Name>
   <NamingMode>BLACK_PEARL</NamingMode>
   <OfflineDataStagingWindowInTb>64</OfflineDataStagingWindowInTb>
   <PermitGoingOutOfSync>FALSE</PermitGoingOutOfSync>
   <ProxyDomain/>
   <ProxyHost/>
   <ProxyPassword/>
   <ProxyPort/>
   <ProxyUsername/>
   <Quiesced>NO</Quiesced>
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   <Region>US_WEST_2</Region>
   <SecretKey>d7pJBeAN</SecretKey>
   <StagedDataExpirationInDays>30</StagedDataExpirationInDays>
   <State>ONLINE</State>
</Data>

VERIFY AMAZON S3 TARGET

Description
Verifies connectivity to the Amazon S3 target and that the Administrator credentials are
correct. If full_details is specified, the operation verifies that all data expected to reside
on the target does in fact reside there.

Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/s3_target/{Amazon S3 target instance UUID,

name, or other unique attribute}/?operation=VERIFY[&full_details]

To determine the UUID for an Amazon S3 target instance, see Get Amazon S3 Targets on
page 422.

Request Parameters 

Parameter Description Required

operation The operation to perform. For this request, the operation is verify.
Value: VERIFY

yes

full_details If included, the operation verifies that all data expected to reside on
the target does in fact reside there.

no

Responses

Response Elements
<Data>
   <S3Target>
      <AccessKey>{string}</AccessKey>
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      <AutoVerifyFrequencyInDays>

{integer}

      </AutoVerifyFrequencyInDays>
      <CloudBucketPrefix>{string}</CloudBucketPrefix>
      <CloudBucketSuffix>{string}</CloudBucketSuffix>
      <DataPathEndPoint>{string}</DataPathEndPoint>
      <DefaultReadPreference>

        MINIMUM_LATENCY|AFTER_ONLINE_POOL|AFTER_NEARLINE_POOL

        |AFTER_NON_EJECTABLE_TAPE|LAST_RESORT|NEVER

      </DefaultReadPreference>
      <Https>TRUE|FALSE</Https>
      <Id>{string}</Id>
      <LastFullyVerified>{string}</LastFullyVerified>
      <Name>{string}</Name>
      <NamingMode>BLACK_PEARL|AWS_S3</NamingMode>
      <OfflineDataStagingWindowInTb>

{64-bit integer}
      </OfflineDataStagingWindowInTb>
      <PermitGoingOutOfSync>TRUE|FALSE</PermitGoingOutOfSync>
      <ProxyDomain>{string}</ProxyDomain>
      <ProxyHost>{string}</ProxyHost>
      <ProxyPassword>{string}</ProxyPassword>
      <ProxyPort>{64-bit integer}</ProxyPort>
      <ProxyUsername>{string}</ProxyUsername>
      <Quiesced>NO|PENDING|YES</Quiesced>
      <Region>

         US_EAST_1|US_EAST_2|US_WEST_1|US_WEST_2|EU_WEST_1|

         EU_WEST_2|EU_CENTRAL_1|AP_SOUTH_1|AP_SOUTHEAST_1|

         AP_SOUTHEAST_2|AP_NORTHEAST_1|AP_NORTHEAST_2|SA_EAST_1|

         CN_NORTH_1|GOV_CLOUD|CA_CENTRAL_1

      </Region>
      <SecretKey>{string}</SecretKey>
      <StagedDataExpirationInDays>

{64-bit integer}
      </StagedDataExpirationInDays>
      <State>ONLINE|OFFLINE|LIMITED_ACCESS</State>
   </S3Target>
</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.
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Parameter Description

AccessKey The S3 Access Key of the user for the Amazon S3 account.

AutoVerify
FrequencyInDays

The frequency at which a full verify of the data on the target
is scheduled. If null, no full verify is scheduled. It is useful to
schedule auto verify when the target is a storage domain in a
data policy using replicate deletes. The verify ensures that
deletes replicate in a timely manner.

CloudBucketPrefix The Amazon S3 target bucket prefix.
Bucket names on the BlackPearl gateway must be unique
within the gateway, but bucket names in Amazon S3 must be
unique across the world. To permit friendlier, shorter local
bucket names on the BlackPearl gateway while avoiding
naming conflicts with Amazon S3, the BlackPearl gateway
optionally adds the defined Cloud Bucket Prefix to the
BlackPearl bucket name when it replicates the bucket.

CloudBucketSuffix The Amazon S3 target bucket suffix.
Bucket names on the BlackPearl gateway must be unique
within the gateway, but bucket names in Amazon S3 must be
unique across the world. To permit friendlier, shorter local
bucket names on the BlackPearl gateway while avoiding
naming conflicts with Amazon S3, the BlackPearl gateway
optionally adds the defined Cloud Bucket Suffix to the
BlackPearl bucket name when it replicates the bucket.

DataPathEndpoint The IPv4 address or DNS name for the data path of the AWS
cloud service.

DefaultRead Preference When it is preferable to read from the Amazon S3 target
rather than the replication source.
Values: MINIMUM_LATENCY, AFTER_ONLINE_POOL, AFTER_
NEARLINE_POOL, AFTER_NON_EJECTABLE_TAPE, LAST_
RESORT, NEVER. See read_preference on page 455.

Https Whether the BlackPearl gateway uses the HTTPS protocol to
setup and replicate data to the target.
Values: TRUE, FALSE.

Id The UUID for the Amazon S3 target instance.

LastFullyVerified The date and time data on the target was last fully verified in
the format YYYY-MM-DDThh:mm:ss.xxxZ.
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Parameter Description

Name The name for the Amazon S3 target.

NamingMode Whether files written to the target use BlackPearl (file
UUIDs) or Amazon S3 (file names) naming conventions.
Values: BLACK_PEARL, AWS_S3

OfflineDataStagingWindowInTb The maximum size, in TB, of the window available for
staging data that is offline (in Glacier) so that it can be read.

PermitGoingOutOfSync Whether a target is allowed to be out of sync with the source.
See permit_going_out_of_sync on page 442.
Note: This parameter is deprecated.

ProxyDomain The domain name for the proxy server.

ProxyHost The host name or IP address for the proxy server
which the BlackPearl gateway connects.

ProxyPassword The password used when connecting through the proxy
server.

ProxyPort The proxy server port through which the BlackPearl gateway
connects.

ProxyUsername The username used when connecting through the proxy
server.

Quiesced Whether the Amazon S3 target is in a temporarily inactive
state. Values: Values: NO, PENDING, YES

Region The world region where the Amazon S3 target is physically
located. Values: US_EAST_1, US_EAST_2, US_WEST_1, US_
WEST_2, EU_WEST_1, EU_WEST_2, EU_CENTRAL_1, AP_
SOUTH_1, AP_SOUTHEAST_1, AP_SOUTHEAST_2, AP_
NORTHEAST_1, AP_NORTHEAST_2, SA_EAST_1, CN_NORTH_
1, GOV_CLOUD, CA_CENTRAL_1

SecretKey The secret key associated with the AccessKey.

StagedData
ExpirationInDays

The number of days before the pre-staged copy of data can
expire. If the BlackPearl gateway does not retrieve all of the
data before the copy expires, it has to go through the process
of pre-staging it again, incurring additional delays and costs.

State The state of the Amazon S3 target.
Values: ONLINE, OFFLINE, LIMITED_ACCESS
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Example

Sample Request
This request confirms connectivity to the Amazon S3 target and verifies the credentials of the
administrator.
PUT http[s]://blackpearl-hostname/_rest_/s3_target/S3Target/?operation=VERIFY

HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>
   <AccessKey>83hB3Pz1</AccessKey>
   <AutoVerifyFrequencyInDays/>
   <CloudBucketPrefix/>
   <CloudBucketSuffix/>
   <DataPathEndPoint/>
   <DefaultReadPreference>LAST_RESORT</DefaultReadPreference>
   <Https>TRUE</Https>
   <Id>02d48638-b6b9-4566-af83-8f76a934d744</Id>
   <LastFullyVerified/>
   <Name>testtp</Name>
   <NamingMode>BLACK_PEARL</NamingMode>
   <OfflineDataStagingWindowInTb>1</OfflineDataStagingWindowInTb>
   <PermitGoingOutOfSync>FALSE</PermitGoingOutOfSync>
   <ProxyDomain/>
   <ProxyHost/>
   <ProxyPassword/>
   <ProxyPort/>
   <ProxyUsername/>
   <Quiesced>NO</Quiesced>
   <Region>US_WEST_2</Region>
   <SecretKey>PlN770a</SecretKey>
   <StagedDataExpirationInDays>30</StagedDataExpirationInDays>
   <State>ONLINE</State>
</Data>
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AZURE REPLICATION TARGET COMMANDS

Create Azure Target Bucket Name 452

Create Azure Target Read Preference 454

Delete Azure Target 457

Delete Azure Target Bucket Name 458

Delete Azure Target Failure 459

Delete Azure Target Read Preference 460

Get Azure Target 461

Get Azure Target Bucket Names 464

Get Azure Target Failures 466

Get Azure Target Read Preference 469

Get Azure Target Read Preferences 470

Get Azure Targets 473

Get Blobs on Azure Target 478

Import Azure Target 479

Modify All Azure Targets 481

Modify Azure Target 482

Register Azure Target 487

Verify Azure Target 491

CREATE AZURE TARGET BUCKET NAME

Description
Defines a custom bucket name mapping between a BlackPearl bucket and an Azure target
blob storage container.
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Requests

Syntax
POST http[s]://{datapathDNSname}/_rest_/azure_target_bucket_name/?bucket_id=

{string}&name={string}&target_id={string}

Request Parameters 

Parameter Description Required

bucket_id The BlackPearl bucket UUID, name, or other unique attribute. yes

name The name for the new blob storage container in Azure. yes

target_id The Azure target UUID, name, or other unique attribute. yes

Responses

Response Elements
<Data>

   <BucketId>{string}</BucketId>

   <Id>{string}</Id>

   <Name>{string}</Name>

   <TargetId>{string}</TargetId>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

BucketId The UUID for the bucket.

Id The UUID for the bucket mapping.

Name The name of the Azure blob storage container.

TargetId The UUID for the Azure replication target.
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Example

Sample Request
This request maps the BlackPearl bucket named ‘bucket1’ to an Azure blob storage container
named ‘bucketname’.
POST http[s]://blackpearl-hostname/_rest_/azure_target_bucket_name/?bucket_

id=bucket1&name=bucketname &target_id=26bbc55a-417a-49a9-90f5-dbc3920cb0fc HTTP/1.1

Sample Response
HTTP/1.1 201 CREATED

<Data>

   <BucketId>b9c3e3ec-a316-4532-bf82-d5e07141df64</BucketId>

   <Id>67c60982-aa75-4378-ad48-187f66a3917c</Id>

   <Name>bucketname</Name>

   <TargetId>26bbc55a-417a-49a9-90f5-dbc3920cb0fc</TargetId>

</Data>

CREATE AZURE TARGET READ PREFERENCE

Description
Create an Azure target read preference for a particular bucket, overriding the default defined
in the Azure target configuration.

Requests

Syntax
POST http[s]://{datapathDNSname}/_rest_/azure_target_read_preference/?bucket_id=

{string}&read_preference=LAST_RESORT|AFTER_ONLINE_POOL|AFTER_NEARLINE_POOL|AFTER_

NON_EJECTABLE_TAPE|MINIMUM_LATENCY|NEVER&target_id={string}

Request Parameters 

Parameter Description Required

bucket_id Bucket UUID, name, or other unique attribute. yes
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Parameter Description Required

read_
preference

When it is preferable to read from the Azure target rather than the
replication source.
Values:
• LAST_RESORT — The target is only used to service a read request
if it cannot be serviced locally. This setting should be used in
most circumstances.

• AFTER_ONLINE_POOL — If data is not available locally on cache
or online pool, the target is used to read the data if possible.

• AFTER_NEARLINE_POOL — If data is not available locally on
cache, online pool, or nearline pool, the target is used to read the
data if possible.

• AFTER_NON_EJECTABLE_TAPE — If data is not available locally
on cache, online pool, nearline pool, or non-ejectable tape, the
target is used to read the data if possible.

• MINIMUM_LATENCY — The source BlackPearl gateway reads the
data from the data partition with the least latency no matter
whether it is connected to the source gateway or the target. Use
this when

1. the cost of the network link to the target is very inexpensive,
2.minimizing latency of servicing GET and VERIFY jobs is critical,

and
3. the network throughput to the target is much higher than the

tape backend throughput (for example, if the network link to
the target is 1 Gb/s, but the tape backend consists of 8 LTO-7
drives, it is very possible that it is faster to service requests
locally, even though we must go to tape, since the pipe to the
tape backend far exceeds that to the target).

• NEVER — The target is never allowed to service a read request.
You may want to use this setting when the cost of the network
link to the target is very high, or if for data integrity verification
purposes, the administrator wants to ensure that all GET and
VERIFY requests are serviced locally.

yes

target_id BlackPearl target UUID, name, or other unique attribute. yes
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Responses

Response Elements
<Data>

   <BucketId>{string}</BucketId>

   <Id>{string}</Id>

   <ReadPreference>

      MINIMUM_LATENCY|AFTER_ONLINE_POOL|AFTER_NEARLINE_POOL

      |AFTER_NON_EJECTABLE_TAPE|LAST_RESORT|NEVER

   </ReadPreference>

   <TargetId>{string}</TargetId>

</Data>

where the response elements are defined as follows:

Parameter Description

BucketId The container for the response.

Id The UUID for the read preference.

ReadPreference When it is preferable to read from the Azure target rather than the replication
source.
Values: MINIMUM_LATENCY, AFTER_ONLINE_POOL, AFTER_NEARLINE_POOL,
AFTER_NON_EJECTABLE_TAPE, LAST_RESORT, NEVER. See read_preference
on page 455.

TargetId The UUID for the replication target.

Example

Sample Request
This request overrides the read preference for the Azure target with the UUID 26bbc55a-417a-
49a9-90f5-dbc3920cb0fc to set the read preference for ‘bucket1’ to MINIMUM_LATENCY.
POST http[s]://blackpearl-hostname/_rest_/azure_target_read_preference/?bucket_

id=bucket1 &read_preference=MINIMUM_LATENCY&target_id=26bbc55a-417a-49a9-90f5-

dbc3920cb0fc HTTP/1.1
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Sample Response
HTTP/1.1 201 CREATED

<Data>

   <BucketId>502e2d43-fe83-491e-985c-5f4d8d2108c3</BucketId>

   <Id>4b90e88b-63ec-4784-96a3-8408e74ad3ec</Id>

   <ReadPreference>MINIMUM_LATENCY</ReadPreference>

   <TargetId>26bbc55a-417a-49a9-90f5-dbc3920cb0fc</TargetId>

</Data>

DELETE AZURE TARGET

Description
Delete the specified Azure replication target.

Requests

Syntax
DELETE http[s]://{datapathDNSname}/_rest_/azure_target/{Azure target UUID, name, or

other unique attribute}/

To determine the UUID for an Azure target, see Get Azure Targets on page 473.

Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 403: Access Denied
• 404: Not Found
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Example

Sample Request
This request deletes the Azure replication target with the name ‘azuretarget’.
DELETE http[s]://blackpearl-hostname/_rest_/azure_target/azuretarget/ HTTP/1.1

Sample Response
HTTP/1.1 204 No Content

DELETE AZURE TARGET BUCKET NAME

Description
Deletes a custom bucket name mapping between a BlackPearl bucket and an Azure target
blob storage container.

Note: The blob storage container on the Azure target is not deleted.

Requests

Syntax
DELETE http[s]://{datapathDNSname}/_rest_/azure_target_bucket_name/{Azure bucket

name, UUID, or other unique identifier or attribute}/

To determine the UUID for an Azure blob storage container (bucket), see Get Azure Target
Bucket Names on page 464.

Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 403: Access Denied
• 404: Not Found
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Example

Sample Request
This request deletes the custom mapping of a bucket on a BlackPearl source to an Azure blob
storage container.
DELETE http[s]://blackpearl-hostname/_rest_/azure_target_bucket_name/azurebucket/

HTTP/1.1

Sample Response
HTTP/1.1 204 No Content

DELETE AZURE TARGET FAILURE

Description
Delete the specified Azure replication target failure.

Requests

Syntax
DELETE http[s]://{datapathDNSname}/_rest_/azure_target_failure/{Azure target failure

UUID or other unique attribute}/

To determine the UUID for an Azure target failure, see Get Azure Target Failures on
page 466.

Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 403: Access Denied
• 404: Not Found

April 2023 DS3 API Reference-Spectra BlackPearl Nearline Gateway
- 459 -



Chapter 12 - Replication Target Operations Delete Azure Target Read Preference

Example

Sample Request
This request deletes the Azure target failure with the UUID df53ea38-a582-4c04-99ef-
e5d8071fe188.
DELETE http[s]://blackpearl-hostname/_rest_/azure_target_failure/df53ea38-a582-4c04-

99ef-e5d8071fe188/ HTTP/1.1

Sample Response
HTTP/1.1 204 No Content

DELETE AZURE TARGET READ PREFERENCE

Description
Delete the specified Azure replication target read preference.

Requests

Syntax
DELETE http[s]://{datapathDNSname}/_rest_/azure_target_read_preference/{Azure target

read preference UUID}/

To determine the UUID for an Azure target read preference, see Get Azure Target Read
Preference on page 469.

Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 403: Access Denied
• 404: Not Found
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Example

Sample Request
This request deletes the Azure target read preference with the UUID d196873b-e79a-4824-
8f03-99fd98883ab8.
DELETE http[s]://blackpearl-hostname/_rest_/azure_target_read_preference/d196873b-

e79a-4824-8f03-99fd98883ab8/ HTTP/1.1

Sample Response
HTTP/1.1 204 No Content

GET AZURE TARGET

Description
Get information about the specified Azure target.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/azure_target/{Azure target instance UUID,

name, or other unique attribute}/

To determine the UUID for an Azure target, see Get Azure Targets on page 473.

Responses

Response Elements
<Data>
   <AccountKey>{string}</AccountKey>
   <AccountName>{string}</AccountName>
   <AutoVerifyFrequencyInDays>

{integer}

   </AutoVerifyFrequencyInDays>
   <CloudBucketPrefix>{string}</CloudBucketPrefix>
   <CloudBucketSuffix>{string}</CloudBucketSuffix>

April 2023 DS3 API Reference-Spectra BlackPearl Nearline Gateway
- 461 -



Chapter 12 - Replication Target Operations Get Azure Target

   <DefaultReadPreference>

      MINIMUM_LATENCY|AFTER_ONLINE_POOL|AFTER_NEARLINE_POOL

      |AFTER_NON_EJECTABLE_TAPE|LAST_RESORT|NEVER

   </DefaultReadPreference>
   <Https>TRUE|FALSE</Https>
   <Id>{string}</Id>
   <LastFullyVerified>

{YYYY-MM-DDThh:mm:ss.xxxZ}
   </LastFullyVerified>
   <Name>{string}</Name>
   <PermitGoingOutOfSync>TRUE|FALSE</PermitGoingOutOfSync>
   <Quiesced>NO|PENDING|YES</Quiesced>
   <State>ONLINE|OFFLINE|LIMITED_ACCESS</State>
</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

AccountKey The account key associated with the account name below.

AccountName The account name for the Microsoft Azure account in the in the
Account Name field.
Note: You can not use the same Account Name for multiple Microsoft
Azure targets.

AutoVerify
FrequencyInDays

The frequency at which a full verify of the data on the target is
scheduled. If null, no full verify is scheduled. It is useful to schedule
auto verify when the target is a storage domain in a data policy using
replicate deletes. The verify ensures that deletes replicate in a timely
manner.

CloudBucketPrefix The Azure target bucket (blob storage container) prefix.
Bucket names on the BlackPearl gateway must be unique within the
BlackPearl gateway, but bucket names in Microsoft Azure must be
unique across the world. To permit friendlier, shorter local bucket
names on the BlackPearl gateway while avoiding naming conflicts
with Azure, the BlackPearl gateway optionally adds the defined
Cloud Bucket Prefix to the BlackPearl bucket name when it replicates
the bucket.
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Parameter Description

CloudBucketSuffix The Azure target bucket (blob storage container) suffix.
Bucket names on the BlackPearl gateway must be unique within the
BlackPearl gateway, but bucket names in Microsoft Azure must be
unique across the world. To permit friendlier, shorter local bucket
names on the BlackPearl gateway while avoiding naming conflicts
with Azure, the BlackPearl gateway optionally adds the defined
Cloud Bucket Suffix to the BlackPearl bucket name when it replicates
the bucket.

DefaultRead Preference When it is preferable to read from the Azure target rather than the
replication source.
Values: MINIMUM_LATENCY, AFTER_ONLINE_POOL, AFTER_
NEARLINE_POOL, AFTER_NON_EJECTABLE_TAPE, LAST_RESORT,
NEVER. See read_preference on page 455.

Https Whether the BlackPearl gateway uses the HTTPS protocol to setup
and replicate data to the target.
Values: TRUE, FALSE.

Id The UUID for the Azure target instance.

LastFullyVerified The date and time the target was last fully verified in the format
YYYY-MM-DDThh:mm:ss.xxxZ.

Name The name for the Azure target.

PermitGoingOutOfSync Whether a target is allowed to be out of sync with the source. See
permit_going_out_of_sync on page 488.
Note: This parameter is deprecated.

Quiesced Whether the Azure target is in a temporarily inactive state. Values:
NO, PENDING, YES

State The state of the Azure target.
Values: ONLINE, OFFLINE, LIMITED_ACCESS

Example

Sample Request
This request gets information about the Azure target with the name ‘TargetAzure’.
GET http[s]://blackpearl-hostname/_rest_/azure_target/TargetAzure/ HTTP/1.1
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Sample Response
HTTP/1.1 200 OK
<Data>

   <AccountKey>Pq1N85c4a</AccountKey>
   <AccountName>BackupAdmin</AccountName>
   <AutoVerifyFrequencyInDays/>
   <CloudBucketPrefix/>
   <CloudBucketSuffix/>
   <DefaultReadPreference>LAST_RESORT</DefaultReadPreference>
   <Https>TRUE</Https>
   <Id>8ea4b134-8a51-463d-9fd8-1948d19f6a7b</Id>
   <LastFullyVerified/>
   <Name>TargetAzure</Name>
   <PermitGoingOutOfSync>FALSE</PermitGoingOutOfSync>
   <Quiesced>NO</Quiesced>
   <State>ONLINE</State>

<Data>

GET AZURE TARGET BUCKET NAMES

Description
Gets all Azure bucket name mappings between the local BlackPearl buckets and their Azure
target blob storage containers.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/azure_targetbucket_name/[?bucket_id={string}]

[&last_page][&name={string}][&page_length={32-bit integer}][&page_offset=

{32-bit integer}][&page_start_marker={string}][&target_id={string}]

Responses

Request Parameters 

Parameter Description Required

bucket_id Bucket UUID, name, or other unique attribute. no
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Parameter Description Required

last_page If included, only the last page of results is returned. no

name The name of the bucket on the Azure target. no

page_length The maximum number of Azure target buckets to list. Default: all
items after page_offset.

no

page_offset The starting point for the first Azure target bucket to list. Default: 0. no

page_start_
marker

The UUID or other unique attribute for the item just before the first
item to list.
Notes:
• Specifying both page_offset and page_start_marker causes
an error.

• If neither page_offset, nor page_start_marker are specified,
the page_offset default is used.

no

target_id Azure target UUID, name, or other unique attribute. no

Responses

Response Elements
<Data>
   <AzureTargetBucketName>
      <BucketId>{string}</BucketId>
      <Id>{string}</Id>
      <Name>{string}/Name>
      <TargetId>{string}</TargetId>

   </AzureTargetBucketName>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

BucketId The UUID for the bucket.

Id The UUID for the bucket mapping.

Name The name of the Azure blob storage container.

TargetId The UUID for the Azure replication target.
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Example

Sample Request
This request gets a list of all buckets on the Azure target.
GET http://blackpearl-hostname/_rest_/azure_target_bucket_name/ HTTP/1.1

Sample Response
<Data>
   <AzureTargetBucketName>
      <BucketId>220e62e0-c869-479c-a729-7f02316d6317</BucketId>
      <Id>9c3c3732-fab1-4a9c-88da-1fb6c0a6ff3f</Id>
      <Name>custombucketname</Name>
      <TargetId>c14ce94a-9c99-4f19-8373-5000b72313f0</TargetId>
   </AzureTargetBucketName>
   <AzureTargetBucketName>
      <BucketId>220e62e0-c869-479c-a729-7f02316d6317</BucketId>
      <Id>b7524215-aaac-4286-9098-12a3066567b9</Id>
      <Name>custombucketname</Name>
      <TargetId>d5c4ce07-dba9-4b2c-89c1-605d2dd6a4c0</TargetId>
   </AzureTargetBucketName>
</Data>

GET AZURE TARGET FAILURES

Description
Get information about all Azure target failures. Use parameters as selection criteria to return
a subset of the list.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/azure_target_failure/[?error_message=

{string}][&last_page][&page_length={32-bit integer}][&page_offset={32-bit integer}]

[&page_start_marker={string}][&target_id={string}][&type=IMPORT_FAILED|IMPORT_

INCOMPLETE|NOT_ONLINE|READ_FAILED|READ_INITIATE_FAILED|VERIFY_COMPLETE|VERIFY_

FAILED|WRITE_FAILED|WRITE_INITIATE_FAILED]
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Request Parameters 

Parameter Description Required

error_
message

The text of the error message. no

last_page If included, only the last page of results is returned. no

page_length The maximum number of Azure target failures to list. Default: all
items after page_offset.

no

page_offset The starting point for the first Azure target failure to list. Default: 0. no

page_start_
marker

The UUID or other unique attribute for the item just before the first
item to list.
Notes:
• Specifying both page_offset and page_start_marker causes
an error.

• If neither page_offset, nor page_start_marker are specified,
the page_offset default is used.

no

target_id Azure target UUID, name, or other unique attribute. To determine
the UUID for an Azure target, see Get Azure Targets on page 473.

no

type The type of error message.
Values: IMPORT_FAILED, IMPORT_INCOMPLETE, NOT_ONLINE,
READ_FAILED, READ_INITIATE_FAILED, VERIFY_COMPLETE, VERIFY_
FAILED, WRITE_FAILED, WRITE_INITIATE_FAILED

no

Responses

Response Elements
<Data>

   <AzureTargetFailure>

      <Date>YYYY-MM-DDThh:mm:ss.xxxZ</Date>

      <ErrorMessage>{string}</ErrorMessage>

      <Id>{string}</Id>

      <TargetId>{string}</TargetId>

      <Type>

         IMPORT_FAILED|IMPORT_INCOMPLETE|NOT_ONLINE|

         READ_FAILED|READ_INITIATE_FAILED|VERIFY_COMPLETE|
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         VERIFY_FAILED|WRITE_FAILED|WRITE_INITIATE_FAILED

      </Type>

   </AzureTargetFailure>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

AzureTargetFailure The container for information about one Azure target failure.

Date The date and time the error occurred in the format
YYYY-MM-DDThh:mm:ss.xxxZ

ErrorMessage A description of the error.

Id The UUID for the error message.

TargetId The UUID for the Azure target that had the failure.

Type The type of error message.

Example

Sample Request
This request gets information about all Azure target failures.
GET http://blackpearl-hostname/_rest_/azure_target_failure/ HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>

   <AzureTargetFailure>

   <Date>2016-05-17T14:18:01.000Z</Date>

   <ErrorMessage>{error text}</ErrorMessage>

   <Id>df53ea38-a582-4c04-99ef-e5d8071fe188</Id>

   <TargetId>aa584aa1-f2dd-4064-8db3-f6f07810dc89</TargetId>

   <Type>NOT_ONLINE</Type>

   </AzureTargetFailure>

</Data>
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GET AZURE TARGET READ PREFERENCE

Description
Get the specified Azure target default read preference.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/azure_target_read_preference/{Azure target

read preference UUID or other unique attribute}/

To determine the UUID for the Azure target read preference, see Get Azure Target Read
Preferences on page 470.

Responses

Response Elements
<Data>

   <BucketId>{string}</BucketId>

   <Id>{string}</Id>

   <ReadPreference>

      MINIMUM_LATENCY|AFTER_ONLINE_POOL|AFTER_NEARLINE_POOL

      |AFTER_NON_EJECTABLE_TAPE|LAST_RESORT|NEVER

   </ReadPreference>

   <TargetId>{string}</TargetId>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

BucketId The UUID for the bucket.

Id The UUID for the read preference.
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Parameter Description

ReadPreference When it is preferable to read from the Azure target rather than the replication
source.
Values: MINIMUM_LATENCY, AFTER_ONLINE_POOL, AFTER_NEARLINE_POOL,
AFTER_NON_EJECTABLE_TAPE, LAST_RESORT, NEVER. See read_preference
on page 455.

TargetId The UUID for the replication target.

Example

Sample Request
This request gets information about the read preference for the Azure target with the
5cbf1b35-0d06-43f5-aef8-c31e6af14f17.
GET http://blackpearl-hostname/_rest_/azure_target_read_preference/5cbf1b35-0d06-

43f5-aef8-c31e6af14f17/ HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>

   <BucketId>b0a6249d-d096-4c05-a428-548f65214fb8</BucketId>

   <Id>6e91318c-8a1a-4b1a-85b4-077c901554bb</Id>

   <ReadPreference>MINIMUM_LATENCY</ReadPreference>

   <TargetId>5cbf1b35-0d06-43f5-aef8-c31e6af14f17</TargetId>

</Data>

GET AZURE TARGET READ PREFERENCES

Description
Get information about the default read preference for all Azure targets. Use parameters as
selection criteria to return a subset of the list.
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Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/azure_target_read_preference/[?bucket_id=

{string}][&last_page][&page_length={32-bit integer}][&page_offset={32-bit integer}]

[&page_start_marker={string}][&read_preference=MINIMUM_LATENCY|AFTER_ONLINE_

POOL|AFTER_NEARLINE_POOL|AFTER_NON_EJECTABLE_TAPE|LAST_RESORT|NEVER][&target_id=

{string}]

Request Parameters 

Parameter Description Required

bucket_id The bucket name, UUID, or other unique attribute. no

last_page If included, only the last page of results is returned. no

page_length The maximum number of Azure target read preferences to list.
Default: all items after page_offset.

no

page_offset The starting point for the first Azure target read preferences to list.
Default: 0.

no

page_start_
marker

The UUID or other unique attribute for the item just before the first
item to list.
Notes:
• Specifying both page_offset and page_start_marker causes
an error.

• If neither page_offset, nor page_start_marker are
specified, the page_offset default is used.

no

read_
preference

When it is preferable to read from the Azure target rather than the
replication source.
Values: MINIMUM_LATENCY, AFTER_ONLINE_POOL, AFTER_
NEARLINE_POOL, AFTER_NON_EJECTABLE_TAPE, LAST_RESORT,
NEVER. See read_preference on page 455.

no

target_id The UUID, name, or other unique attribute for the replication
target.

no
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Responses

Response Elements
<Data>

   <AzureTargetReadPreference>

      <BucketId>{string}</BucketId>

      <Id>{string}</Id>

      <ReadPreference>

         MINIMUM_LATENCY|AFTER_ONLINE_POOL|AFTER_NEARLINE_POOL

         |AFTER_NON_EJECTABLE_TAPE|LAST_RESORT|NEVER

      </ReadPreference>

      <TargetId>{string}</TargetId>

   </AzureTargetReadPreference>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

AzureTargetRead
Preference

The container for information about the read preference for one Azure
target.

BucketId The UUID for the bucket.

Id The UUID for the read preference.

ReadPreference When it is preferable to read from the Azure target rather than the
replication source.
Values: MINIMUM_LATENCY, AFTER_ONLINE_POOL, AFTER_NEARLINE_
POOL, AFTER_NON_EJECTABLE_TAPE, LAST_RESORT, NEVER. See read_
preference on page 455.

TargetId The UUID for the replication target.

Example

Sample Request
This request gets information about the read preference for each Azure target registered to
the source.
GET http://blackpearl-hostname/_rest_/azure_target_read_preference/ HTTP/1.1
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Sample Response
HTTP/1.1 200 OK

<Data>

   <AzureTargetReadPreference>

      <BucketId>306e0f35-aadd-4152-90eb-7fcf42df7a15</BucketId>

      <Id>8d0aae6a-2d72-486c-9142-f0542662776f</Id>

      <ReadPreference>MINIMUM_LATENCY</ReadPreference>

      <TargetId>3e0cd533-f062-4504-8063-c59c4e478549</TargetId>

   </AzureTargetReadPreference>

</Data>

GET AZURE TARGETS

Description
Get information about all registered Azure targets. Use parameters as selection criteria to
return a subset of the list.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/azure_target/[?account_name={string}

[&default_read_preference=MINIMUM_LATENCY|AFTER_ONLINE_POOL|AFTER_NEARLINE_

POOL|AFTER_NON_EJECTABLE_TAPE|LAST_RESORT|NEVER][&https=TRUE|FALSE][&last_page]

[&name={string}][&page_length={32-bit integer}][&page_offset={32-bit integer}]

[&page_start_marker={string}][&permit_going_out_of_sync=TRUE|FALSE]

[&quiesced=NO|PENDING|YES][&state=ONLINE|LIMITED_ACCESS|OFFLINE]

Request Parameters 

Parameter Description Required

account_
name

Enter the account name for the Azure account in the in the Account
Name field.
Note: You can not use the same Account Name for multiple Azure
targets.

no
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Parameter Description Required

default_
read_
preference

When it is preferable to read from the Azure target rather than the
replication source.
Values: MINIMUM_LATENCY, AFTER_ONLINE_POOL, AFTER_
NEARLINE_POOL, AFTER_NON_EJECTABLE_TAPE, LAST_RESORT,
NEVER. See read_preference on page 455.

no

https Whether the BlackPearl gateway uses the HTTPS protocol to setup
and replicate data to the target.
Values: TRUE, FALSE.

no

last_page If included, only the last page of results is returned. no

name The name for the Azure target. no

page_length The maximum number of Azure targets to list.
Default: all items after page_offset.

no

page_offset The starting point for the first Azure targets to list.
Default: 0.

no

page_start_
marker

The UUID or other unique attribute for the item just before the first
item to list.
Notes:
• Specifying both page_offset and page_start_marker causes
an error.

• If neither page_offset, nor page_start_marker are
specified, the page_offset default is used.

no

permit_
going_out_
of_sync

Whether a target is allowed to be out of sync with the source. See
permit_going_out_of_sync on page 488.
Note: This parameter is deprecated.

no

quiesced Whether the Azure target is in a temporarily inactive state. Values:
NO, PENDING, YES

no

state The state of the Azure target.
Values: ONLINE, OFFLINE, LIMITED_ACCESS

no

Responses
<Data>
   <AzureTarget>

     <AccountKey>{string}</AccountKey>
     <AccountName>{string}</AccountName>
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     <AutoVerifyFrequencyInDays>

{integer}

     </AutoVerifyFrequencyInDays>
     <CloudBucketPrefix>{string}</CloudBucketPrefix>

     <CloudBucketSuffix>{string}</CloudBucketSuffix>

     <DefaultReadPreference>

        MINIMUM_LATENCY|AFTER_ONLINE_POOL|AFTER_NEARLINE_POOL

        |AFTER_NON_EJECTABLE_TAPE|LAST_RESORT|NEVER

     </DefaultReadPreference>
     <Https>TRUE|FALSE</Https>

     <Id>{string}</Id>
     <LastFullyVerified/>

     <Name>{string}</Name>

     <PermitGoingOutOfSync>TRUE|FALSE</PermitGoingOutOfSync>
     <Quiesced>NO|PENDING|YES</Quiesced>

     <State>ONLINE|OFFLINE|LIMITED_ACCESS</State>
   </AzureTarget>
...

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

AzureTarget The container for a single Azure Target.

AccountKey The account key associated with the account name below.

AccountName The account name for the Microsoft Azure account in the in the
Account Name field.
Note: You can not use the same Account Name for multiple Microsoft
Azure targets.

AutoVerify
FrequencyInDays

The frequency at which a full verify of the data on the target is
scheduled. If null, no full verify is scheduled. It is useful to schedule
auto verify when the target is a storage domain in a data policy using
replicate deletes. The verify ensures that deletes replicate in a timely
manner.
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Parameter Description

CloudBucketPrefix The Azure target bucket (blob storage container) prefix.
Bucket names on the BlackPearl gateway must be unique within the
BlackPearl gateway, but bucket names in Microsoft Azure must be
unique across the world. To permit friendlier, shorter local bucket
names on the BlackPearl gateway while avoiding naming conflicts
with Azure, the BlackPearl gateway optionally adds the defined
Cloud Bucket Prefix to the BlackPearl bucket name when it replicates
the bucket.

CloudBucketSuffix The Azure target bucket (blob storage container) suffix.
Bucket names on the BlackPearl gateway must be unique within the
BlackPearl gateway, but bucket names in Microsoft Azure must be
unique across the world. To permit friendlier, shorter local bucket
names on the BlackPearl gateway while avoiding naming conflicts
with Azure, the BlackPearl gateway optionally adds the defined
Cloud Bucket Suffix to the BlackPearl bucket name when it replicates
the bucket.

DefaultRead Preference When it is preferable to read from the Azure target rather than the
replication source.
Values: MINIMUM_LATENCY, AFTER_ONLINE_POOL, AFTER_
NEARLINE_POOL, AFTER_NON_EJECTABLE_TAPE, LAST_RESORT,
NEVER. See read_preference on page 455.

Https Whether the BlackPearl gateway uses the HTTPS protocol to setup
and replicate data to the target.
Values: TRUE, FALSE.

Id The UUID for the Azure target instance.

LastFullyVerified The date and time the target was last fully verified in the format
YYYY-MM-DDThh:mm:ss.xxxZ.

Name The name for the Azure target.

PermitGoingOutOfSync Whether a target is allowed to be out of sync with the source. See
permit_going_out_of_sync on page 488.
Note: This parameter is deprecated.

Quiesced Whether the Azure target is in a temporarily inactive state. Values:
NO, PENDING, YES

State The state of the Azure target.
Values: ONLINE, OFFLINE, LIMITED_ACCESS
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Example

Sample Request
This request gets information about all Azure targets registered to the source BlackPearl
gateway.
GET http[s]://blackpearl-hostname/_rest_/azure_target/ HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>
   <AzureTarget>
     <AccountKey>Pq1N85c4a</AccountKey>
     <AccountName>BackupAdmin</AccountName>
     <AutoVerifyFrequencyInDays/>
     <CloudBucketPrefix/>
     <CloudBucketSuffix/>
     <DefaultReadPreference>LAST_RESORT</DefaultReadPreference>
     <Https>TRUE</Https>
     <Id>8ea4b134-8a51-463d-9fd8-1948d19f6a7b</Id>
     <LastFullyVerified/>
     <Name>Azure-ef4b345d-64c7-4582-95ab-d25845f97531</Name>
     <PermitGoingOutOfSync>FALSE</PermitGoingOutOfSync>
     <Quiesced>NO</Quiesced>
     <State>ONLINE</State>
   </AzureTarget>
   <AzureTarget>
     <AccountKey>Qllpsd52</AccountKey>
     <AccountName>BackupAdmin</AccountName>
     <AutoVerifyFrequencyInDays/>
     <CloudBucketPrefix/>
     <CloudBucketSuffix/>
     <DefaultReadPreference>LAST_RESORT</DefaultReadPreference>
     <Https>TRUE</Https>
     <Id>7b27f5bf-5ae7-4ce9-92e2-fd98092b2088</Id>
     <LastFullyVerified/>
     <Name>Azure-fda1b44d-0d30-47af-a0ff-25d7e6ac0dbd</Name>
     <PermitGoingOutOfSync>FALSE</PermitGoingOutOfSync>
     <Quiesced>NO</Quiesced>
     <State>ONLINE</State>
   </AzureTarget>
</Data>
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GET BLOBS ON AZURE TARGET

Description
Get the object pieces on the specified Azure target.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/azure_target/{Azure S3 target instance UUID,

name, or other unique attribute}/?operation=GET_PHYSICAL_PLACEMENT/

To determine the UUID for an Azure target, see Get Azure Targets on page 473.

Request Parameters

Parameter Description Required

operation The operation to perform on the Azure target. For this command,
the operation is Get_Physical_Placement.

yes

Responses

Response Elements
<Data>

   <Object Bucket="{string}" Id="{string}" Latest="TRUE|FALSE"

   Length="{64-bit integer}" Name="{string}"

   Offset="{64-bit integer}" VersionId="{string}"/>

   <Object Bucket="{string}" Id="{string}" Latest="TRUE|FALSE"

   Length="{64-bit integer}" Name="{string}"

   Offset="{64-bit integer}" VersionId="{string}"/>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

Object The container for the information about one object.
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Parameter Description

Bucket The name of the bucket containing the object.

Id The UUID for the object.

Latest Whether or not the object is the latest version of the file.
Values: TRUE, FALSE

Length The length in bytes of the of object.

Name The name of the object.

Offset The object in bytes from the start of the object.

VersionId The UUID of the version of the object.

Example

Sample Request
This request gets a list of all blobs on the Azure target.
GET http://blackpearl-hostname/_rest_/azure_target/7b27f5bf-5ae7-4ce9-92e2-

fd98092b2088/?operation=GET_PHYSICAL_PLACEMENT HTTP/1.1

Sample Response
<Data>

   <Object Bucket="default_bucket_name" Id="1c4fc33b-f997-43f8-

   bdb9-9bb5e748c7b8" Latest="TRUE" Length="10" Name="obj1"

   Offset="0" VersionId="8fd2c30c-c9bb-447a-81a7-8f8f43917446"/>

   <Object Bucket="default_bucket_name" Id="46d7d57d-f4ae-4406-

   bb1b-a850b9a22ecc" Latest="TRUE" Length="10" Name="obj2"

   Offset="0" VersionId="fa6a0b92-85c2-44f3-8d21-541c437bda9d"/>

</Data>

IMPORT AZURE TARGET

Description
Imports a copy of the objects in the specified bucket on the specified Azure target to the local
BlackPearl gateway.
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Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/azure_target/{unique identifier or

attribute}/?operation=import &cloud_bucket_name={string}[&data_policy_id={unique

identifier or attribute}][&priority={CRITICAL|URGENT|HIGH|NORMAL|LOW|BACKGROUND}]

[&user_id={unique identifier or attribute}]

Request Parameters

Parameter Description Required

operation The operation to perform. For this request, the operation is import.
Value: IMPORT

yes

cloud_
bucket
_name

The name or UUID of the bucket on the Azure target to transfer to
the BlackPearl gateway.

yes

data_policy_
id

The UUID, name, or other unique attribute for the data policy to
associate with objects on the Azure target that do not already exist
on the BlackPearl gateway.
Note: If a bucket with the name cloud_bucket_name, does not already
exist on the BlackPearl gateway, then data_policy_id and user_id
are required.

no

priority The priority for processing the import. The priority determines
the resources assigned and the processing order. Imports can be
interrupted every 30 minutes if a job with a higher priority is
received.
Values: URGENT, HIGH, NORMAL, LOW

no

user_id The UUID, name, or other unique attribute for the user to associate
with any buckets on the Azure target that do not already exist on
the BlackPearl gateway.
Note: If a bucket with the name cloud_bucket_name, does not already
exist on the BlackPearl gateway, then data_policy_id and user_id
are required.

no
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Responses
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 500: Internal Error

Example

Sample Request
This command imports the objects in the bucket named “Images” from the specified Azure
target.
PUT http://blackpearl-hostname/_rest_/azure_target/f30df4ae-78df-42b4-

96a35d11c15e3cf9/?operation=IMPORT&cloudBucketName=Images HTTP/1.1

Sample Response
HTTP/1.1 204 No Content

MODIFY ALL AZURE TARGETS

Description
Sets all Azure targets to unquiesced (NO), or pending quiesce (PENDING) state. The gateway
changes the state from pending quiesce (PENDING) to quiesced (YES).

Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/azure_target/?quiesced=NO|PENDING

Request Parameters

Parameter Description Required

quiesced Request that the gateway prepare all Azure targets to go into an
inactive state (PENDING) or return all Azure targets to an active
state (NO). Values: NO, PENDING

yes
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Responses
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 404: Not Found
• 409: Conflict

Example

Sample Request
This request modifies the quiesced state of all Azure targets to NO.
PUT http://blackpearl-hostname/_rest_/azure_target/?quiesced=NO HTTP/1.1

Sample Response
HTTP/1.1 204 No Content

MODIFY AZURE TARGET

Description
Modify an Azure target.

Notes:

• If an optional request parameter is not included, the previous setting is retained.

• It is not possible to change the quiesced state directly from NO to YES.

Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/azure_target/{BlackPearl target instance

UUID, name, or other unique attribute}/[?account_key={string}][&account_name=

{string}][&auto_verify_freqency_in_days={integer}][&cloud_bucket_prefix={string}]

[&cloud_bucket_suffix={string}][&default_read_preference=MINIMUM_LATENCY|AFTER_

ONLINE_POOL|AFTER_NEARLINE_POOL|AFTER_NON_EJECTABLE_TAPE|LAST_RESORT|NEVER]

[&https=TRUE|FALSE][&name={string}][&permit_going_out_of_sync=TRUE|FALSE]

[&quiesced=NO|PENDING]
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To determine the UUID for an Azure target instance, see Get Azure Targets on page 473.

Request Parameters 

Parameter Description Required

account_key Enter the account key associated with the account name below. no

account_
name

Enter the account name for the Azure account in the in the Account
Name field.
Note: You can not use the same Account Name for multiple Azure
targets.

no

auto_verify_
frequency_
in_days

The frequency at which a full verify of the data on the target is
scheduled. If null, no full verify is scheduled. It is useful to
schedule auto verify when the target is a storage domain in a data
policy using replicate deletes. The verify ensures that deletes
replicate in a timely manner.

no

cloud_
bucket_
prefix

The Azure target bucket (blob storage container) prefix. The prefix
must adhere to the Azure naming requirements.
Bucket names on the BlackPearl gateway must be unique within
the gateway, but bucket names in Microsoft Azure must be unique
across the world. To permit friendlier, shorter local bucket names
on the BlackPearl gateway while avoiding naming conflicts with
Azure, the BlackPearl gateway optionally adds the defined Cloud
Bucket Prefix to the BlackPearl bucket name when it replicates the
bucket.

no

cloud_
bucket_
suffix

The Azure target bucket (blob storage container) suffix. The suffix
must adhere to the Azure naming requirements.
Bucket names on the BlackPearl gateway must be unique within
the gateway, but bucket names in Microsoft Azure must be unique
across the world. To permit friendlier, shorter local bucket names
on the BlackPearl gateway while avoiding naming conflicts with
Azure, the BlackPearl gateway optionally adds the defined Cloud
Bucket Suffix to the BlackPearl bucket name when it replicates the
bucket.

no

default_read_
preference

When it is preferable to read from the Azure target rather than the
replication source.
Values: MINIMUM_LATENCY, AFTER_ONLINE_POOL, AFTER_
NEARLINE_POOL, AFTER_NON_EJECTABLE_TAPE, LAST_RESORT,
NEVER. See read_preference on page 455.

no
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Parameter Description Required

https Whether the BlackPearl gateway uses the HTTPS protocol to setup
and replicate data to the target.
Values: TRUE, FALSE.

no

name The name for the Azure target. no

permit_
going_out_
of_sync

Whether a target is allowed to be out of sync with the source. By
default, if the data policy specifies that the BlackPearl gateway
must replicate local actions, actions that the gateway cannot
replicate fail. You can temporarily set this parameter to TRUE in
order to operate in full capacity locally while one or more targets is
down for a prolonged period of time.
Note: This parameter is deprecated.

no

quiesced Request that the gateway prepare the target to go into an inactive
state (PENDING) or return the target to an active state (NO).
Values: NO, PENDING

no

Responses

Response Elements
<Data>
   <AccountKey>{string}</AccountKey>
   <AccountName>{string}</AccountName>
   <AutoVerifyFrequencyInDays>

{integer}

   </AutoVerifyFrequencyInDays>
   <CloudBucketPrefix>{string}</CloudBucketPrefix>
   <CloudBucketSuffix>{string}</CloudBucketSuffix>
   <DefaultReadPreference>
     MINIMUM_LATENCY|AFTER_ONLINE_POOL|AFTER_NEARLINE_POOL|

     AFTER_NON_EJECTABLE_TAPE|LAST_RESORT|NEVER
   </DefaultReadPreference>
   <Https>TRUE|FALSE</Https>
   <Id>{string}</Id>
   <LastFullyVerified>YYYY-MM-DDThh:mm:ss.xxxZ</LastFullyVerified>
   <Name>{string}</Name>
   <PermitGoingOutOfSync>TRUE|FALSE</PermitGoingOutOfSync>
   <Quiesced>NO|PENDING|YES</Quiesced>
   <State>ONLINE|OFFLINE</State>
</Data>
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where the response elements are defined as follows:

Parameter Description

Data The container for the response.

AccountKey The account key associated with the account name below.

AccountName The account name for the Microsoft Azure account in the in the
Account Name field.
Note: You can not use the same Account Name for multiple Microsoft
Azure targets.

AutoVerify
FrequencyInDays

The frequency at which a full verify of the data on the target is
scheduled. If null, no full verify is scheduled. It is useful to schedule
auto verify when the target is a storage domain in a data policy using
replicate deletes. The verify ensures that deletes replicate in a timely
manner.

CloudBucketPrefix The Azure target bucket (blob storage container) prefix.
Bucket names on the BlackPearl gateway must be unique within the
gateway, but bucket names in Microsoft Azure must be unique across
the world. To permit friendlier, shorter local bucket names on the
BlackPearl gateway while avoiding naming conflicts with Azure, the
BlackPearl gateway optionally adds the defined Cloud Bucket Prefix
to the BlackPearl bucket name when it replicates the bucket.

CloudBucketSuffix The Azure target bucket (blob storage container) suffix.
Bucket names on the BlackPearl gateway must be unique within the
gateway, but bucket names in Microsoft Azure must be unique across
the world. To permit friendlier, shorter local bucket names on the
BlackPearl gateway while avoiding naming conflicts with Azure, the
BlackPearl gateway optionally adds the defined Cloud Bucket Suffix
to the BlackPearl bucket name when it replicates the bucket.

DefaultRead Preference When it is preferable to read from the Azure target rather than the
replication source.
Values: MINIMUM_LATENCY, AFTER_ONLINE_POOL, AFTER_
NEARLINE_POOL, AFTER_NON_EJECTABLE_TAPE, LAST_RESORT,
NEVER. See read_preference on page 455.

Https Whether the BlackPearl gateway uses the HTTPS protocol to setup
and replicate data to the target.
Values: TRUE, FALSE.

Id The UUID for the Azure target instance.
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Parameter Description

LastFullyVerified The date and time the target was last fully verified in the format
YYYY-MM-DDThh:mm:ss.xxxZ.

Name The name for the Azure target.

PermitGoingOutOfSync Whether a target is allowed to be out of sync with the source. See
permit_going_out_of_sync on page 488.
Note: This parameter is deprecated.

Quiesced Whether the Azure target is in a temporarily inactive state. Values:
NO, PENDING, YES

State The state of the Azure target.
Values: ONLINE, OFFLINE, LIMITED_ACCESS

Example

Sample Request
This request modifies the Azure target named ‘TargetAzure’ to have the default read
preference MINIMUM_LATENCY.

PUT http[s]://blackpearl-hostname/_rest_/azure_target/TargetAzure/?default_read_

preference=MINIMUM_LATENCY HTTP/1.1

Sample Response
HTTP/1.1 200 OK
<Data>

   <AccountKey>c3b1YtRyYQ1z</AccountKey>

   <AccountName>BackupAdmin</AccountName>

   <AutoVerifyFrequencyInDays>365</AutoVerifyFrequencyInDays>

   <CloudBucketPrefix/>

   <CloudBucketSuffix/>

   <DefaultReadPreference>MINIMUM_LATENCY</DefaultReadPreference>

   <Https>TRUE</Https>

   <Id>4e5626a0-6733-4625-9ff2-3f89183b3474</Id>

   <LastFullyVerified/>

   <Name>TargetAzure</Name>

   <PermitGoingOutOfSync>FALSE</PermitGoingOutOfSync>

   <Quiesced>NO</Quiesced>

   <State>ONLINE</State>
</Data>
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REGISTER AZURE TARGET

Description
Connect to and register the specified Azure target as a replication target for the BlackPearl
gateway.

Requests

Syntax
POST http[s]://{datapathDNSname}/_rest_/azure_target/?account_key={string}&account_

name={string}&name={string}[&auto_verify_freqency_in_days={integer}][&cloud_bucket_

prefix={string}][&cloud_bucket_suffix={string}][&default_read_preference=MINIMUM_

LATENCY|AFTER_ONLINE_POOL|AFTER_NEARLINE_POOL|AFTER_NON_EJECTABLE_TAPE|LAST_

RESORT|NEVER][&https={string}][&permit_going_out_of_sync=TRUE|FALSE]

Request Parameters 

Parameter Description Required

account_key Enter the account key associated with the account name below. yes

account_
name

Enter the account name for the Azure account in the in the Account
Name field.
Note: You can not use the same Account Name for multiple Azure
targets.

yes

name The name for the Azure target. yes

auto_verify_
frequency_
in_days

The frequency at which a full verify of the data on the target is
scheduled. If null (default), no full verify is scheduled. It is useful
to schedule auto verify when the target is a storage domain in a
data policy using replicate deletes. The verify ensures that deletes
replicate in a timely manner.

no
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Parameter Description Required

cloud_
bucket_
prefix

The Azure target bucket (blob storage container) prefix. The prefix
must adhere to the Azure naming requirements.
Bucket names on the BlackPearl gateway must be unique within
the gateway, but bucket names in Microsoft Azure must be unique
across the world. To permit friendlier, shorter local bucket names
on the BlackPearl gateway while avoiding naming conflicts with
Azure, the BlackPearl gateway optionally adds the defined Cloud
Bucket Prefix to the BlackPearl bucket name when it replicates the
bucket.

no

cloud_
bucket_
suffix

The Azure target bucket (blob storage container) suffix. The suffix
must adhere to the Azure naming requirements.
Bucket names on the BlackPearl gateway must be unique within
the gateway, but bucket names in Microsoft Azure must be unique
across the world. To permit friendlier, shorter local bucket names
on the BlackPearl gateway while avoiding naming conflicts with
Azure, the BlackPearl gateway optionally adds the defined Cloud
Bucket Suffix to the BlackPearl bucket name when it replicates the
bucket.

no

default_read_
preference

When it is preferable to read from the Azure target rather than the
replication source.
Values: MINIMUM_LATENCY, AFTER_ONLINE_POOL, AFTER_
NEARLINE_POOL, AFTER_NON_EJECTABLE_TAPE, LAST_RESORT,
NEVER. See read_preference on page 455.

no

https Whether the BlackPearl gateway uses the HTTPS protocol to setup
and replicate data to the target.
Values: TRUE (default), FALSE.

no

permit_
going_out_
of_sync

Whether a target is allowed to be out of sync with the source. By
default, if the data policy specifies that the BlackPearl gateway
must replicate local actions, actions that the gateway cannot
replicate fail. You can temporarily set this parameter to TRUE in
order to operate in full capacity locally while one or more targets is
down for a prolonged period of time. Values: TRUE, FALSE (default)
Note: This parameter is deprecated.

no

Responses

Response Elements
<Data>

   <AccountKey>{string}</AccountKey>
   <AccountName>{string}</AccountName>
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   <AutoVerifyFrequencyInDays>{string}</AutoVerifyFrequencyInDays>
   <CloudBucketPrefix>{string}</CloudBucketPrefix>
   <CloudBucketSuffix>{string}</CloudBucketSuffix>

   <DefaultReadPreference>

      MINIMUM_LATENCY|AFTER_ONLINE_POOL|AFTER_NEARLINE_POOL

      |AFTER_NON_EJECTABLE_TAPE|LAST_RESORT|NEVER

   </DefaultReadPreference>
   <Https>TRUE|FALSE</Https>

   <Id>{string}</Id>
   <LastFullyVerified/>

   <Name>{string}</Name>

   <PermitGoingOutOfSync>TRUE|FALSE</PermitGoingOutOfSync>
   <Quiesced>NO|PENDING|YES</Quiesced>

   <State>ONLINE|OFFLINE|LIMITED_ACCESS</State>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

AccountKey The account key associated with the account name below.

AccountName The account name for the Microsoft Azure account in the in the
Account Name field.
Note: You can not use the same Account Name for multiple Microsoft
Azure targets.

AutoVerify
FrequencyInDays

The frequency at which a full verify of the data on the target is
scheduled. If null, no full verify is scheduled. It is useful to schedule
auto verify when the target is a storage domain in a data policy using
replicate deletes. The verify ensures that deletes replicate in a timely
manner.

CloudBucketPrefix The Azure target bucket (blob storage container) prefix.
Bucket names on the BlackPearl gateway must be unique within the
gateway, but bucket names in Microsoft Azure must be unique across
the world. To permit friendlier, shorter local bucket names on the
BlackPearl gateway while avoiding naming conflicts with Azure, the
BlackPearl gateway optionally adds the defined Cloud Bucket Prefix
to the BlackPearl bucket name when it replicates the bucket.
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Parameter Description

CloudBucketSuffix The Azure target bucket (blob storage container) suffix.
Bucket names on the BlackPearl gateway must be unique within the
gateway, but bucket names in Microsoft Azure must be unique across
the world. To permit friendlier, shorter local bucket names on the
BlackPearl gateway while avoiding naming conflicts with Azure, the
BlackPearl gateway optionally adds the defined Cloud Bucket Suffix
to the BlackPearl bucket name when it replicates the bucket.

DefaultRead Preference When it is preferable to read from the Azure target rather than the
replication source.
Values: MINIMUM_LATENCY, AFTER_ONLINE_POOL, AFTER_
NEARLINE_POOL, AFTER_NON_EJECTABLE_TAPE, LAST_RESORT,
NEVER. See read_preference on page 455.

Https Whether the BlackPearl gateway uses the HTTPS protocol to setup
and replicate data to the target.
Values: TRUE , FALSE.

Id The UUID for the Azure target instance.

LastFullyVerified The date and time the target was last fully verified in the format
YYYY-MM-DDThh:mm:ss.xxxZ.

Name The name for the Azure target.

PermitGoingOutOfSync Whether a target is allowed to be out of sync with the source. See
permit_going_out_of_sync on page 488.
Note: This parameter is deprecated.

Quiesced Whether the Azure target is in a temporarily inactive state. Values:
NO, PENDING, YES

State The state of the Azure target.
Values: ONLINE, OFFLINE, LIMITED_ACCESS

Example

Sample Request
This request registers an Azure target with the Administrator S3 Access Id ‘BackupAdmin’,
the Administrator S3 Secret Key ‘d7pJBeAN’, and the name ‘TargetAzure’ to use a default
read preference of MINIMUM_LATENCY as a replication target for the BlackPearl gateway.
POST http[s]://blackpearl-hostname/_rest_/azure_target/?account_

name=Backupdmin&account_key=d7pJBeAN&name=TargetAzure&default_read_

preference=MINIMUM_LATENCY HTTP/1.1
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Sample Response
HTTP/1.1 201 CREATED

<Data>
   <AccountKey>d7pJBeAN</AccountKey>
   <AccountName>BackupAdmin</AccountName>
   <AutoVerifyFrequencyInDays/>
   <CloudBucketPrefix/>
   <CloudBucketSuffix/>
   <DefaultReadPreference>MINIMUM_LATENCY</DefaultReadPreference>
   <Https>TRUE</Https>
   <Id>3918b938-05e2-482b-b010-bdb24e2283f7</Id>
   <LastFullyVerified/>
   <Name>TargetAzure</Name>
   <PermitGoingOutOfSync>FALSE</PermitGoingOutOfSync>
   <Quiesced>NO</Quiesced>
   <State>ONLINE</State>
</Data>

VERIFY AZURE TARGET

Description
Verifies connectivity to the Azure target and that the Administrator credentials are correct. If
full_details is specified, the operation verifies that all data expected to reside on the
target does in fact reside there.

Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/azure_target/{Azure target instance UUID,

name, or other unique attribute}/?operation=VERIFY[&full_details]

To determine the UUID for an Azure target instance, see Get Azure Targets on page 473.
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Request Parameters 

Parameter Description Required

operation The operation to perform. For this request, the operation is verify.
Value: VERIFY

yes

full_details If included, the operation verifies that all data expected to reside on
the target does in fact reside there.

no

Responses

Response Elements
<Data>

   <AccountKey>{string}</AccountKey>
   <AccountName>{string}</AccountName>
   <AutoVerifyFrequencyInDays>{string}</AutoVerifyFrequencyInDays>
   <CloudBucketPrefix>{string}</CloudBucketPrefix>
   <CloudBucketSuffix>{string}</CloudBucketSuffix>

   <DefaultReadPreference>

      MINIMUM_LATENCY|AFTER_ONLINE_POOL|AFTER_NEARLINE_POOL

      |AFTER_NON_EJECTABLE_TAPE|LAST_RESORT|NEVER

   </DefaultReadPreference>
   <Https>TRUE|FALSE</Https>

   <Id>{string}</Id>
   <LastFullyVerified>{string}</LastFullyVerified>

   <Name>{string}</Name>

   <PermitGoingOutOfSync>TRUE|FALSE</PermitGoingOutOfSync>
   <Quiesced>NO|PENDING|YES</Quiesced>

   <State>ONLINE|OFFLINE|LIMITED_ACCESS</State>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

AccountKey The account key associated with the account name below.
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Parameter Description

Account
Name

The account name for the Microsoft Azure account in the in the
Account Name field.
Note: You can not use the same Account Name for multiple Microsoft
Azure targets.

AutoVerify
FrequencyInDays

The frequency at which a full verify of the data on the target is
scheduled. If null, no full verify is scheduled. It is useful to schedule
auto verify when the target is a storage domain in a data policy using
replicate deletes. The verify ensures that deletes replicate in a timely
manner.

CloudBucketPrefix The Azure target bucket (blob storage container) prefix.
Bucket names on the BlackPearl gateway must be unique within the
gateway, but bucket names in Microsoft Azure must be unique across
the world. To permit friendlier, shorter local bucket names on the
BlackPearl gateway while avoiding naming conflicts with Azure, the
BlackPearl gateway optionally adds the defined Cloud Bucket Prefix
to the BlackPearl bucket name when it replicates the bucket.

CloudBucketSuffix The Azure target bucket (blob storage container) suffix.
Bucket names on the BlackPearl gateway must be unique within the
gateway, but bucket names in Microsoft Azure must be unique across
the world. To permit friendlier, shorter local bucket names on the
BlackPearl gateway while avoiding naming conflicts with Azure, the
BlackPearl gateway optionally adds the defined Cloud Bucket Suffix
to the BlackPearl bucket name when it replicates the bucket.

DefaultRead Preference When it is preferable to read from the Azure target rather than the
replication source.
Values: MINIMUM_LATENCY, AFTER_ONLINE_POOL, AFTER_
NEARLINE_POOL, AFTER_NON_EJECTABLE_TAPE, LAST_RESORT,
NEVER. See read_preference on page 455.

Https Whether the BlackPearl gateway uses the HTTPS protocol to setup
and replicate data to the target.
Values: TRUE, FALSE.

Id The UUID for the Azure target instance.

LastFullyVerified The date and time the target was last fully verified in the format
YYYY-MM-DDThh:mm:ss.xxxZ.

Name The name for the Azure target.
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Parameter Description

PermitGoingOutOfSync Whether a target is allowed to be out of sync with the source. See
permit_going_out_of_sync on page 488.
Note: This parameter is deprecated.

Quiesced Whether the Azure target is in a temporarily inactive state. Values:
NO, PENDING, YES

State The state of the Azure target.
Values: ONLINE, OFFLINE, LIMITED_ACCESS

Example

Sample Request
This request confirms connectivity to the Azure target and verifies the credentials of the
administrator.
PUT http[s]://blackpearl-hostname/_rest_/azure_target/AzureTarget/?operation=VERIFY

HTTP/1.1

Sample Response
HTTP/1.1 201 CREATED
<Data>
   <AccountKey>Qb420x1</AccountKey>
   <AccountName>BackupAdmin</AccountName>
   <AutoVerifyFrequencyInDays/>
   <CloudBucketPrefix/>
   <DefaultReadPreference>MINIMUM_LATENCY</DefaultReadPreference>
   <Https>TRUE</Https>
   <Id>91e7b12f-112a-4d27-b4b1-b81cd861dd30</Id>
   <LastFullyVerified/>
   <Name>AzureTarget</Name>
   <PermitGoingOutOfSync>FALSE</PermitGoingOutOfSync>
   <Quiesced>NO</Quiesced>
   <State>ONLINE</State>
</Data>
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DS3 REPLICATION TARGET COMMANDS

Create DS3 Target Read Preference 496

Delete DS3 Target 499

Delete DS3 Target Failure 500
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CREATE DS3 TARGET READ PREFERENCE

Description
Create a DS3 target read preference for a particular bucket, overriding the default defined in
the DS3 target configuration.

Requests

Syntax
POST http[s]://{datapathDNSname}/_rest_/ds3_target_read_preference/?bucket_id=

{string} &read_preference=LAST_RESORT|AFTER_ONLINE_POOL|AFTER_NEARLINE_POOL|AFTER_

NON_EJECTABLE_TAPE|MINIMUM_LATENCY|NEVER&target_id={string}

Request Parameters 

Parameter Description Required

bucket_id Bucket UUID, name, or other unique attribute. yes
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Parameter Description Required

read_
preference

When it is preferable to read from the DS3 target rather than the
replication source.
Values:
• LAST_RESORT — The target is only used to service a read request
if it cannot be serviced locally. This setting should be used in
most circumstances.

• AFTER_ONLINE_POOL — If data is not available locally on cache
or online pool, the target is used to read the data if possible.

• AFTER_NEARLINE_POOL — If data is not available locally on
cache, online pool, or nearline pool, the target is used to read the
data if possible.

• AFTER_NON_EJECTABLE_TAPE — If data is not available locally
on cache, online pool, nearline pool, or non-ejectable tape, the
target is used to read the data if possible.

• MINIMUM_LATENCY — The source BlackPearl gateway
dynamically determines the read preference based on whether
the requested data resides in a pool or on tape. If, for example,
the source has the data on tape, but the target has the data on
pool, the source uses the target to service the request. If however,
the source and target both have the data on pool, the source is
used to service the request. Use this when

1. the cost of the network link to the target is very inexpensive,
2.minimizing latency of servicing GET and VERIFY jobs is critical,

and
3. the network throughput to the target is much higher than the

tape backend throughput (for example, if the network link to
the target is 1 Gb/s, but the tape backend consists of 8 LTO-7
drives, it is very possible that it is faster to service requests
locally, even though we must go to tape, since the pipe to the
tape backend far exceeds that to the target).

• NEVER — The target is never allowed to service a read request.
You may want to use this setting when the cost of the network
link to the target is very high, or if for data integrity verification
purposes, the administrator wants to ensure that all GET and
VERIFY requests are serviced locally.

yes

target_id BlackPearl target UUID, name, or other unique attribute. yes
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Responses

Response Elements
<Data>

   <BucketId>{string}</BucketId>

   <Id>{string}</Id>

   <ReadPreference>

      MINIMUM_LATENCY|AFTER_ONLINE_POOL|AFTER_NEARLINE_POOL

      |AFTER_NON_EJECTABLE_TAPE|LAST_RESORT|NEVER

   </ReadPreference>

   <TargetId>{string}</TargetId>

</Data>

where the response elements are defined as follows:

Parameter Description

BucketId The container for the response.

Id The UUID for the read preference.

ReadPreference When it is preferable to read from the DS3 target rather than the replication
source.
Values: MINIMUM_LATENCY, AFTER_ONLINE_POOL, AFTER_NEARLINE_POOL,
AFTER_NON_EJECTABLE_TAPE, LAST_RESORT, NEVER. See read_preference
on page 497.

TargetId The UUID for the replication target.

Example

Sample Request
This request overrides the read preference for the DS3 target with the UUID 26bbc55a-417a-
49a9-90f5-dbc3920cb0fc to set the read preference for ‘bucket1’ to MINIMUM_LATENCY.
POST http[s]://blackpearl-hostname/_rest_/ds3_target_read_preference/?bucket_

id=bucket1 &read_preference=MINIMUM_LATENCY&target_id=26bbc55a-417a-49a9-90f5-

dbc3920cb0fc HTTP/1.1
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Sample Response
HTTP/1.1 201 CREATED

<Data>

   <BucketId>502e2d43-fe83-491e-985c-5f4d8d2108c3</BucketId>

   <Id>4b90e88b-63ec-4784-96a3-8408e74ad3ec</Id>

   <ReadPreference>MINIMUM_LATENCY</ReadPreference>

   <TargetId>26bbc55a-417a-49a9-90f5-dbc3920cb0fc</TargetId>

</Data>

DELETE DS3 TARGET

Description
Delete the specified DS3 replication target.

Requests

Syntax
DELETE http[s]://{datapathDNSname}/_rest_/ds3_target/{DS3 target UUID, name, or

other unique attribute}/

To determine the UUID for a DS3 target, see Get DS3 Targets on page 516.

Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 403: Access Denied
• 404: Not Found
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Example

Sample Request
This request deletes the DS3 replication target with the name ‘ds3target’.
DELETE http[s]://blackpearl-hostname/_rest_/ds3_target/ds3target/ HTTP/1.1

Sample Response
HTTP/1.1 204 No Content

DELETE DS3 TARGET FAILURE

Description
Delete the specified DS3 replication target failure.

Requests

Syntax
DELETE http[s]://{datapathDNSname}/_rest_/ds3_target_failure/{DS3 target failure

UUID or other unique attribute}/

To determine the UUID for a DS3 target failure, see Get DS3 Target Failures on page 509.

Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 403: Access Denied
• 404: Not Found
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Example

Sample Request
This request deletes the DS3 target failure with the UUID df53ea38-a582-4c04-99ef-
e5d8071fe188.
DELETE http[s]://blackpearl-hostname/_rest_/ds3_target_failure/df53ea38-a582-4c04-

99ef-e5d8071fe188/ HTTP/1.1

Sample Response
HTTP/1.1 204 No Content

DELETE DS3 TARGET READ PREFERENCE

Description
Delete the specified DS3 replication target read preference.

Requests

Syntax
DELETE http[s]://{datapathDNSname}/_rest_/ds3_target_read_preference/{DS3 target

read preference UUID}/

To determine the UUID for a DS3 target read preference, see Get DS3 Target Read Preference
on page 511.

Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 403: Access Denied
• 404: Not Found
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Example

Sample Request
This request deletes the DS3 target read preference with the UUID d196873b-e79a-4824-8f03-
99fd98883ab8.
DELETE http[s]://blackpearl-hostname/_rest_/ds3_target_read_preference/d196873b-

e79a-4824-8f03-99fd98883ab8/ HTTP/1.1

Sample Response
HTTP/1.1 204 No Content

GET DS3 TARGET

Description
Get information about the specified DS3 target.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/ds3_target/{DS3 target instance UUID, name,

or other unique attribute}/

To determine the UUID for a DS3 target, see Get DS3 Targets on page 516.
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Responses

Response Elements
<Data>

   <AccessControlReplication>

      NONE|USERS

   </AccessControlReplication>

   <AdminAuthId>{string}</AdminAuthId>

   <AdminSecretKey>{string}</AdminSecretKey>

   <DataPathEndPoint>{string}</DataPathEndPoint>

   <DataPathHttps>TRUE|FALSE</DataPathHttps>

   <DataPathPort>{16-bit integer}</DataPathPort>

   <DataPathProxy>{string}</DataPathProxy>

   <DataPathVerifyCertificate>

      TRUE|FALSE

   </DataPathVerifyCertificate>

   <DefaultReadPreference>

      MINIMUM_LATENCY|AFTER_ONLINE_POOL|AFTER_NEARLINE_POOL

      |AFTER_NON_EJECTABLE_TAPE|LAST_RESORT|NEVER

   </DefaultReadPreference>

   <Id>{string}</Id>

   <Name>{string}</Name>

   <PermitGoingOutOfSync>TRUE|FALSE</PermitGoingOutOfSync>

   <Quiesced>NO|PENDING|YES</Quiesced>

   <ReplicatedUserDefaultDataPolicy>

{string}

   </ReplicatedUserDefaultDataPolicy>

   <State>ONLINE|OFFLINE</State>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

AccessControl Replication The access control that is replicated to the DS3 target.
Values:
• NONE — No access control is replicated.
• USERS — The source BlackPearl gateway replicates its users and
passwords to the target gateway.

AdminAuthId The S3 access ID assigned to an Administrator.
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Parameter Description

AdminSecretKey The S3 secret key for the account matching the given AdminAuthId.

DataPathEndPoint The IPv4 address or DNS name for the data path of the DS3 target.

DataPathHttps Whether the source BlackPearl gateway uses the HTTPS protocol to
setup and replicate data to the target gateway. Values: TRUE, FALSE

DataPathPort The value of the port on which the target BlackPearl gateway’s
Amazon S3 server is running. If null, the parameter defaults to port
80 for HTTP connections and port 443 for HTTPS connections.

DataPathProxy The proxy server for the source BlackPearl gateway to use to connect
to the target gateway.

DataPathVerify Certificate Whether the data path certificate is verified. When
DataPathVerifyCertificate and DataPathHttps are both TRUE, the
source BlackPearl gateway fully validates the target gateway’s
certificate. If the certificate is not trusted or problematic in anyway, it
is not honored.
Values: TRUE, FALSE

DefaultRead Preference When it is preferable to read from the DS3 target rather than the
replication source.
Values: MINIMUM_LATENCY, AFTER_ONLINE_POOL, AFTER_
NEARLINE_POOL, AFTER_NON_EJECTABLE_TAPE, LAST_RESORT,
NEVER. See read_preference on page 497.

Id The UUID for the DS3 target instance.

Name The name for the DS3 target.

PermitGoingOutOfSync Whether a target is allowed to be out of sync with the source. See
permit_going_out_of_sync on page 533.

Quiesced Whether the DS3 target is in a temporarily inactive state. Values: NO,
PENDING, YES

ReplicatedUser
DefaultDataPolicy

The data policy the target applies as the default data policy for any
users replicated to the target.

State The state of the DS3 target.
Values: ONLINE, OFFLINE, LIMITED_ACCESS
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Example

Sample Request
This request gets information about the DS3 target with the name ‘TargetDS3’.
GET http[s]://blackpearl-hostname/_rest_/ds3_target/TargetDS3/ HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>

   <AccessControlReplication>NONE</AccessControlReplication>

   <AdminAuthId>c381Y3RyYQ==</AdminAuthId>

   <AdminSecretKey>d7pJBeAN</AdminSecretKey>

   <DataPathEndPoint>192.168.4.8</DataPathEndPoint>

   <DataPathHttps>TRUE</DataPathHttps>

   <DataPathPort/>

   <DataPathProxy/>

   <DataPathVerifyCertificate>TRUE</DataPathVerifyCertificate>

   <DefaultReadPreference>MINIMUM_LATENCY</DefaultReadPreference>

   <Id>c927287a-90eb-428e-88ae-faedc3749e17</Id>

   <Name>TargetDS3</Name>

   <PermitGoingOutOfSync>FALSE</PermitGoingOutOfSync>

   <Quiesced>NO</Quiesced>

   <ReplicatedUserDefaultDataPolicy/>

   <State>ONLINE</State>

</Data>

GET DS3 TARGET DATA POLICIES

Description
Get all data policies for the specified DS3 target.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/ds3_target_data_policies/{DS3 target UUID,

name, or other unique attribute}/

To determine the UUID for a DS3 target, see Get DS3 Targets on page 516.
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Responses

Response Elements
<Data>

   <DataPolicy>

      <AlwaysForcePutJobCreation>

         TRUE|FALSE

      </AlwaysForcePutJobCreation>

      <AlwaysMinimizeSpanningAcrossMedia>

         TRUE|FALSE

      </AlwaysMinimizeSpanningAcrossMedia>

      <BlobbingEnabled>TRUE</BlobbingEnabled>

      <ChecksumType>

         CRC_32|CRC_32C|MD5|SHA_256|SHA_512

      </ChecksumType>
      <CreationDate>YYYY-MM-DDThh:mm:ss.xxxZ</CreationDate>

      <DefaultBlobSize>{64-bit integer}</DefaultBlobSize>

      <DefaultGetJobPriority>

         CRITICAL|URGENT|HIGH|NORMAL|LOW|BACKGROUND

      </DefaultGetJobPriority>

      <DefaultPutJobPriority>

         CRITICAL|URGENT|HIGH|NORMAL|LOW|BACKGROUND

      </DefaultPutJobPriority>
      <DefaultVerifyAfterWrite>

         TRUE|FALSE

      </DefaultVerifyAfterWrite>

      <DefaultVerifyJobPriority>

         CRITICAL|URGENT|HIGH|NORMAL|LOW|BACKGROUND

      </DefaultVerifyJobPriority>
      <EndToEndCrcRequired>TRUE|FALSE</EndToEndCrcRequired>

      <Id>{string}</Id>

      <MaxVersionsToKeep>{32-bit integer}</MaxVersionsToKeep>

      <Name>{string}</Name>

      <RebuildPriority>

         CRITICAL|URGENT|HIGH|NORMAL|LOW|BACKGROUND

      </RebuildPriority>

      <Versioning>

         NONE|KEEP_LATEST|KEEP_MULTIPLE_VERSIONS

      </Versioning>
   </DataPolicy>
   ...

</Data>

April 2023 DS3 API Reference-Spectra BlackPearl Nearline Gateway
- 506 -



Chapter 12 - Replication Target Operations Get DS3 Target Data Policies

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

DataPolicy The container for information about one data policy.

AlwaysForcePutJobCreation Whether all PUT jobs created for this data policy are created
even if one or more storage domains and/or replication targets
the BlackPearl gateway must PUT to is unavailable, or if there
are global issues that would likely prevent the completion of the
job.
Values: TRUE, FALSE

AlwaysMinimize
SpanningAcross Media

Whether all PUT jobs created for this data policy are created to
minimize spanning across media.
Values: TRUE, FALSE. See always_minimize_ spanning_across_
media on page 327.

BlobbingEnabled Whether or not blobbing is enabled.

ChecksumType Type of checksum used to verify data integrity for any
operations involving this data policy.
Values: CRC_32, CRC_32C, MD5, SHA_256, SHA_512

CreationDate The date and time the data policy was created in the format
YYYY-MM-DDThh:mm:ss.xxxZ.

DefaultBlobSize The maximum blob size.

DefaultGetJob
Priority

The default GET job priority for the data policy. The job priority
determines the resources assigned and the processing order.
Values: CRITICAL, URGENT, HIGH, NORMAL, LOW, BACKGROUND

DefaultVerifyAfterWrite Whether data is verified by default after it is written.
Values: TRUE, FALSE

DefaultPutJob
Priority

The default PUT job priority for the data policy. The job priority
determines the resources assigned and the processing order.
Values: CRITICAL, URGENT, HIGH, NORMAL, LOW, BACKGROUND

DefaultVerifyJob
Priority

The default verify job priority for the data policy. The job priority
determines the resources assigned and the processing order.
Values: CRITICAL, URGENT, HIGH, NORMAL, LOW, BACKGROUND

EndToEndCrc
Required

Whether or not clients are required to compute and send an end-
to-end CRC. Values: TRUE, FALSE
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Parameter Description

Id The UUID for the data policy.

MaxVersionsTo Keep The number of versions of an object to keep if versioning=KEEP_
MULTIPLE_VERSIONS.

Name The name of the data policy.

RebuildPriority The rebuild priority for the data policy. The rebuild priority
determines the relative priority compared to other jobs being
processed.
Values: CRITICAL, URGENT, HIGH, NORMAL, LOW, BACKGROUND

Versioning The mode of versioning used by the data policy.
Values: NONE, KEEP_LATEST, KEEP_MULTIPLE_VERSIONS see
versioning on page 330.

Example

Sample Request
This request gets information about all data policies on the target named ‘target1’.
GET http://blackpearl-hostname/_rest_/ds3_target_data_policies/target1/ HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>

   <DataPolicy>

      <AlwaysForcePutJobCreation>FALSE</AlwaysForcePutJobCreation>

      <AlwaysMinimizeSpanningAcrossMedia>

         FALSE

      </AlwaysMinimizeSpanningAcrossMedia>

      <BlobbingEnabled>TRUE</BlobbingEnabled>

      <ChecksumType>MD5</ChecksumType>

      <CreationDate>2015-07-29 16:26:12.768</CreationDate>

      <DefaultBlobSize/>

      <DefaultGetJobPriority>HIGH</DefaultGetJobPriority>

      <DefaultPutJobPriority>NORMAL</DefaultPutJobPriority>
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      <DefaultVerifyAfterWrite>FALSE</DefaultVerifyAfterWrite>

      <DefaultVerifyJobPriority>LOW</DefaultVerifyJobPriority>

      <EndToEndCrcRequired>FALSE</EndToEndCrcRequired>

      <Id>43d40cce-bb94-4b73-a504-8811f37d8012</Id>

      <MaxVersionsToKeep>1000</MaxVersionsToKeep>

      <Name>policy1</Name>

      <RebuildPriority>LOW</RebuildPriority>

      <Versioning>NONE</Versioning>

   </DataPolicy>

   ...

</Data>

GET DS3 TARGET FAILURES

Description
Get information about all DS3 target failures. Use parameters as selection criteria to return a
subset of the list.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/ds3_target_failure/[?error_message={string}]

[&last_page][&page_length={32-bit integer}][&page_offset={32-bit integer}][&page_

start_marker={string}][&target_id={string}][&type=IMPORT_FAILED|IMPORT_

INCOMPLETE|NOT_ONLINE|READ_FAILED|READ_INITIATE_FAILED|VERIFY_COMPLETE|VERIFY_

FAILED|WRITE_FAILED|WRITE_INITIATE_FAILED]

Request Parameters 

Parameter Description Required

error_
message

The text of the error message. no

last_page If included, only the last page of results is returned. no

page_length The maximum number of DS3 target failures to list. Default: all
items after page_offset.

no
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Parameter Description Required

page_offset The starting point for the first DS3 target failure to list. Default: 0. no

page_start_
marker

The UUID or other unique attribute for the item just before the first
item to list.
Notes:
• Specifying both page_offset and page_start_marker causes
an error.

• If neither page_offset, nor page_start_marker are specified,
the page_offset default is used.

no

target_id DS3 target UUID, name, or other unique attribute. To determine the
UUID for a DS3 target, see Get DS3 Targets on page 516.

no

type The type of error message.
Values: Values: IMPORT_FAILED, IMPORT_INCOMPLETE, NOT_
ONLINE, READ_FAILED, READ_INITIATE_FAILED, VERIFY_COMPLETE,
VERIFY_FAILED, WRITE_FAILED, WRITE_INITIATE_FAILED

no

Responses

Response Elements
<Data>

   <Ds3TargetFailure>

      <Date>YYYY-MM-DDThh:mm:ss.xxxZ</Date>

      <ErrorMessage>{string}</ErrorMessage>

      <Id>{string}</Id>

      <TargetId>{string}</TargetId>

      <Type>

         IMPORT_FAILED|IMPORT_INCOMPLETE|NOT_ONLINE|READ_FAILED|

         READ_INITIATE_FAILED|VERIFY_COMPLETE|
         VERIFY_FAILED|WRITE_FAILED|WRITE_INITIATE_FAILED

      </Type>

   </Ds3TargetFailure>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.
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Parameter Description

Ds3TargetFailure The container for information about one DS3 target failure.

Date The date and time the error occurred in the format
YYYY-MM-DDThh:mm:ss.xxxZ

ErrorMessage A description of the error.

Id The UUID for the error message.

TargetId The UUID for the DS3 target that had the failure.

Type The type of error message.

Example

Sample Request
This request gets information about all DS3 target failures.
GET http://blackpearl-hostname/_rest_/ds3_target_failure/ HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>

   <Ds3TargetFailure>

   <Date>2016-05-17T14:18:01.000Z</Date>

   <ErrorMessage>{error text}</ErrorMessage>

   <Id>df53ea38-a582-4c04-99ef-e5d8071fe188</Id>

   <TargetId>aa584aa1-f2dd-4064-8db3-f6f07810dc89</TargetId>

   <Type>NOT_ONLINE</Type>

   </Ds3TargetFailure>

</Data>

GET DS3 TARGET READ PREFERENCE

Description
Get the specified DS3 target default read preference.
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Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/ds3_target_read_preference/{DS3 target read

preference UUID or other unique attribute}/

To determine the UUID for the DS3 target read preference, see Get DS3 Target Read
Preferences on page 513.

Responses

Response Elements
<Data>

   <BucketId>{string}</BucketId>

   <Id>{string}</Id>

   <ReadPreference>

      MINIMUM_LATENCY|AFTER_ONLINE_POOL|AFTER_NEARLINE_POOL

      |AFTER_NON_EJECTABLE_TAPE|LAST_RESORT|NEVER

   </ReadPreference>

   <TargetId>{string}</TargetId>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

BucketId The UUID for the bucket.

Id The UUID for the read preference.

ReadPreference When it is preferable to read from the DS3 target rather than the replication
source.
Values: MINIMUM_LATENCY, AFTER_ONLINE_POOL, AFTER_NEARLINE_POOL,
AFTER_NON_EJECTABLE_TAPE, LAST_RESORT, NEVER. See read_preference
on page 455.

TargetId The UUID for the replication target.
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Example

Sample Request
This request gets information about the read preference for the DS3 target with the 5cbf1b35-
0d06-43f5-aef8-c31e6af14f17.
GET http://blackpearl-hostname/_rest_/ds3_target_read_preference/5cbf1b35-0d06-43f5-

aef8-c31e6af14f17/ HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>

   <BucketId>b0a6249d-d096-4c05-a428-548f65214fb8</BucketId>

   <Id>6e91318c-8a1a-4b1a-85b4-077c901554bb</Id>

   <ReadPreference>MINIMUM_LATENCY</ReadPreference>

   <TargetId>5cbf1b35-0d06-43f5-aef8-c31e6af14f17</TargetId>

</Data>

GET DS3 TARGET READ PREFERENCES

Description
Get information about the default read preference for all DS3 targets. Use parameters as
selection criteria to return a subset of the list.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/ds3_target_read_preference/[?bucket_id=

{string}][&last_page][&page_length={32-bit integer}][&page_offset={32-bit integer}]

[&page_start_marker={string}][&read_preference=MINIMUM_LATENCY|AFTER_ONLINE_

POOL|AFTER_NEARLINE_POOL|AFTER_NON_EJECTABLE_TAPE|LAST_RESORT|NEVER][&target_id=

{string}]
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Request Parameters 

Parameter Description Required

bucket_id The bucket name, UUID, or other unique attribute. no

last_page If included, only the last page of results is returned. no

page_length The maximum number of DS3 target read preferences to list.
Default: all items after page_offset.

no

page_offset The starting point for the first DS3 target read preference to list.
Default: 0.

no

page_start_
marker

The UUID or other unique attribute for the item just before the first
item to list.
Notes:
• Specifying both page_offset and page_start_marker causes
an error.

• If neither page_offset, nor page_start_marker are
specified, the page_offset default is used.

no

read_
preference

When it is preferable to read from the DS3 target rather than the
replication source.
Values: MINIMUM_LATENCY, AFTER_ONLINE_POOL, AFTER_
NEARLINE_POOL, AFTER_NON_EJECTABLE_TAPE, LAST_RESORT,
NEVER. See read_preference on page 455.

no

target_id The UUID, name, or other unique attribute for the replication
target.

no
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Responses

Response Elements
<Data>

   <Ds3TargetReadPreference>

      <BucketId>{string}</BucketId>

      <Id>{string}</Id>

      <ReadPreference>

         MINIMUM_LATENCY|AFTER_ONLINE_POOL|AFTER_NEARLINE_POOL

         |AFTER_NON_EJECTABLE_TAPE|LAST_RESORT|NEVER

      </ReadPreference>

      <TargetId>{string}</TargetId>

   </Ds3TargetReadPreference>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

Ds3TargetRead
Preference

The container for information about the read preference for one DS3 target.

BucketId The UUID for the bucket.

Id The UUID for the read preference.

ReadPreference When it is preferable to read from the DS3 target rather than the replication
source.
Values: MINIMUM_LATENCY, AFTER_ONLINE_POOL, AFTER_NEARLINE_POOL,
AFTER_NON_EJECTABLE_TAPE, LAST_RESORT, NEVER. See read_preference
on page 455.

TargetId The UUID for the replication target.

Example

Sample Request
This request gets information about the read preference for each DS3 target registered to the
source.
GET http://blackpearl-hostname/_rest_/ds3_target_read_preference/ HTTP/1.1
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Sample Response
HTTP/1.1 200 OK

<Data>

   <Ds3TargetReadPreference>

      <BucketId>306e0f35-aadd-4152-90eb-7fcf42df7a15</BucketId>

      <Id>8d0aae6a-2d72-486c-9142-f0542662776f</Id>

      <ReadPreference>MINIMUM_LATENCY</ReadPreference>

      <TargetId>3e0cd533-f062-4504-8063-c59c4e478549</TargetId>

   </Ds3TargetReadPreference>

   </Data>

GET DS3 TARGETS

Description
Get information about all registered DS3 targets. Use parameters as selection criteria to return
a subset of the list.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/ds3_target/[?admin_auth_id={string}][&data_

path_end_point={string}][&data_path_https=TRUE|FALSE][&data_path_port=

{32-bit integer}][&data_path_proxy={string}][&data_path_verify_

certificate=TRUE|FALSE][&default_read_preference=MINIMUM_LATENCY|AFTER_ONLINE_

POOL|AFTER_NEARLINE_POOL|AFTER_NON_EJECTABLE_TAPE|LAST_RESORT|NEVER][&last_page]

[&name={string}][&page_length={32-bit integer}][&page_offset={32-bit integer}]

[&page_start_marker={string}][&permit_going_out_of_sync=TRUE|FALSE]

[&quiesced=NO|PENDING|YES][&state=ONLINE|LIMITED_ACCESS|OFFLINE]

Request Parameters 

Parameter Description Required

admin_auth_
id

The DS3 access ID assigned to an Administrator. no
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Parameter Description Required

data_path_
end_ point

The IPv4 address or DNS name for the data path of the DS3 target. no

data_path_
https

Whether the source BlackPearl gateway uses the HTTPS protocol to
setup and replicate data to the target gateway. Values: TRUE, FALSE

no

data_path_
port

The value of the port on which the target BlackPearl gateway’s DS3
server is running.

no

data_path_
proxy

The proxy server for the source BlackPearl gateway to use to
connect to the target gateway.

no

data_path_
verify_
certificate

Whether the data path certificate is verified. When
DataPathVerifyCertificate and DataPathHttps are both TRUE, the
source BlackPearl gateway fully validates the target gateway’s
certificate. If the certificate is not trusted or problematic in anyway,
it is not honored.
Values: TRUE, FALSE

no

default_
read_
preference

When it is preferable to read from the DS3 target rather than the
replication source.
Values: MINIMUM_LATENCY, AFTER_ONLINE_POOL, AFTER_
NEARLINE_POOL, AFTER_NON_EJECTABLE_TAPE, LAST_RESORT,
NEVER. See read_preference on page 403.

no

last_page If included, only the last page of results is returned. no

name The name for the DS3 target. no

page_length The maximum number of DS3 targets to list.
Default: all items after page_offset.

no

page_offset The starting point for the first DS3 target to list.
Default: 0.

no

page_start_
marker

The UUID or other unique attribute for the item just before the first
item to list.
Notes:
• Specifying both page_offset and page_start_marker causes
an error.

• If neither page_offset, nor page_start_marker are
specified, the page_offset default is used.

no
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Parameter Description Required

permit_
going_out_
of_sync

Whether a target is allowed to be out of sync with the source. See
permit_going_out_of_sync on page 533.

no

quiesced Whether the DS3 target is in a temporarily inactive state. Values:
NO, PENDING, YES

no

state The state of the DS3 target.
Values: ONLINE, OFFLINE, LIMITED_ACCESS

no

Responses

Response Elements
<Data>

   <Ds3Target>

      <AccessControlReplication>

         NONE|USERS

      </AccessControlReplication>

      <AdminAuthId>{string}</AdminAuthId>

      <AdminSecretKey>{string}</AdminSecretKey>
      <DataPathEndPoint>{string}</DataPathEndPoint>

      <DataPathHttps>TRUE|FALSE</DataPathHttps>

      <DataPathPort>{16-bit integer}</DataPathPort>

      <DataPathProxy>{string}</DataPathProxy>
      <DataPathVerifyCertificate>

         TRUE|FALSE

      </DataPathVerifyCertificate>

      <DefaultReadPreference>

         MINIMUM_LATENCY|AFTER_ONLINE_POOL|AFTER_NEARLINE_POOL

         |AFTER_NON_EJECTABLE_TAPE|LAST_RESORT|NEVER

      </DefaultReadPreference>
      <Id>{string}</Id>

      <Name>{string}</Name>

      <PermitGoingOutOfSync>TRUE|FALSE</PermitGoingOutOfSync>

      <Quiesced>NO|PENDING|YES</Quiesced>

      <ReplicatedUserDefaultDataPolicy>

{string}

      </ReplicatedUserDefaultDataPolicy>
      <State>ONLINE|OFFLINE</State>

   </Ds3Target>

</Data>
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where the response elements are defined as follows:

Parameter Description

Data The container for the response.

Ds3Target The container for information about one DS3 target.

AccessControl Replication The access control that is replicated to the DS3 target.
Values:
NONE — No access control is replicated.
USERS — The source BlackPearl gateway replicates its users and
passwords to the target gateway.

AdminAuthId The S3 access ID assigned to an Administrator.

AdminSecretKey The S3 secret key for the account matching the given AdminAuthId.

DataPathEndPoint The IPv4 address or DNS name for the data path of the DS3 target.

DataPathHttps Whether the source BlackPearl gateway uses the HTTPS protocol to
setup and replicate data to the target gateway. Values: TRUE, FALSE

DataPathPort The value of the port on which the target BlackPearl gateway’s S3
server is running. If null, the parameter defaults to port 80 for HTTP
connections and port 443 for HTTPS connections.

DataPathProxy The proxy server for the source BlackPearl gateway to use to connect
to the target gateway.

DataPathVerify Certificate Whether the data path certificate is verified. When
DataPathVerifyCertificate and DataPathHttps are both TRUE, the
source BlackPearl gateway fully validates the target gateway’s
certificate. If the certificate is not trusted or problematic in anyway, it
is not honored.
Values: TRUE, FALSE

DefaultRead Preference When it is preferable to read from the DS3 target rather than the
replication source.
Values: MINIMUM_LATENCY, AFTER_ONLINE_POOL, AFTER_
NEARLINE_POOL, AFTER_NON_EJECTABLE_TAPE, LAST_RESORT,
NEVER. See read_preference on page 455.

Id The UUID for the DS3 target instance.

Name The name for the DS3 target.

PermitGoingOutOfSync Whether a target is allowed to be out of sync with the source. See
permit_going_out_of_sync on page 533.

April 2023 DS3 API Reference-Spectra BlackPearl Nearline Gateway
- 519 -



Chapter 12 - Replication Target Operations Get DS3 Targets

Parameter Description

Quiesced Whether the DS3 target is in a temporarily inactive state. Values: NO,
PENDING, YES

ReplicatedUser
DefaultDataPolicy

The data policy the target applies as the default data policy for any
users replicated to the target.

State The state of the DS3 target.
Values: ONLINE, OFFLINE, LIMITED_ACCESS

Example

Sample Request
This request gets information about all DS3 targets registered to the source BlackPearl
gateway.
GET http[s]://blackpearl-hostname/_rest_/ds3_target/ HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>

   <Ds3Target>

      <AccessControlReplication>NONE</AccessControlReplication>

      <AdminAuthId>c381Y3RyYQ==</AdminAuthId>

      <AdminSecretKey>d7pJBeAN</AdminSecretKey>

      <DataPathEndPoint>192.168.15.16</DataPathEndPoint>

      <DataPathHttps>TRUE</DataPathHttps>

      <DataPathPort/>

      <DataPathProxy/>

      <DataPathVerifyCertificate>TRUE</DataPathVerifyCertificate>

      <DefaultReadPreference>LAST_RESORT</DefaultReadPreference>

      <Id>c927287a-90eb-428e-88ae-faedc3749e17</Id>

      <Name>TargetBP</Name>

      <PermitGoingOutOfSync>FALSE</PermitGoingOutOfSync>

      <Quiesced>NO</Quiesced>

      <ReplicatedUserDefaultDataPolicy/>

      <State>ONLINE</State>

   </Ds3Target>

</Data>

April 2023 DS3 API Reference-Spectra BlackPearl Nearline Gateway
- 520 -



Chapter 12 - Replication Target Operations Get Blobs on DS3 Target

GET BLOBS ON DS3 TARGET

Description
Get the object pieces on the specified DS3 target.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/ds3_target/{DS3 target read preference UUID

or other unique attribute}/?operation=GET_PHYSICAL_PLACEMENT

To determine the UUID for the DS3 target read preference, see Get DS3 Target Read
Preferences on page 513.

Request Parameters

Parameter Description Required

operation The operation to perform on the DS3 target. For this command, the
operation is Get_Physical_Placement.

yes

Responses

Response Elements
<Data>

   <Object Bucket="{string}" Id="{string}" Latest="TRUE|FALSE"

   Length="{64-bit integer}" Name="{string}"

   Offset="{64-bit integer}" VersionId="{string}"/>

...

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

Object The container for the information about one object.
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Parameter Description

Bucket The name of the bucket containing the object.

Id The UUID for the object.

Latest Whether or not the object is the latest version of the file.
Values: TRUE, FALSE

Length The length in bytes of the of object.

Name The name of the object.

Offset The object in bytes from the start of the object.

VersionId The UUID of the version of the object.

Example

Sample Request
This request gets a list of all blobs on the DS3 target.
GET http://blackpearl-hostname/_rest_/ds3_target/c927287a-90eb-428e-88ae-

faedc3749e17/?operation=GET_PHYSICAL_PLACEMENT HTTP/1.1

Sample Response
<Data>

   <Object Bucket="default_bucket_name" Id="1c4fc33b-f997-43f8-

   bdb9-9bb5e748c7b8" Latest="TRUE" Length="10" Name="obj1"

   Offset="0" VersionId="fa6a0b92-85c2-44f3-8d21-541c437bda9d"/>

   <Object Bucket="default_bucket_name" Id="46d7d57d-f4ae-4406-

   bb1b-a850b9a22ecc" Latest="TRUE" Length="10" Name="obj2"

   Offset="0" VersionId="274da5c4-b94a-47ae-80c0-e6b8e1be55a0"/>

</Data>

MODIFY ALL DS3 TARGETS

Description
Sets all DS3 targets to unquiesced (NO), or pending quiesce (PENDING) state. The gateway
changes the state from pending quiesce (PENDING) to quiesced (YES).
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Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/ds3_target/?quiesced=NO|PENDING

Request Parameters

Parameter Description Required

quiesced Request that the gateway prepare all DS3 targets to go into an
inactive state (PENDING) or return all DS3 targets to an active state
(NO).

yes

Responses
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 404: Not Found
• 409: Conflict

Example

Sample Request
This request modifies the quiesced state of all DS3 targets to NO.
PUT http://blackpearl-hostname/_rest_/ds3_target/?quiesced=NO HTTP/1.1

Sample Response
HTTP/1.1 204 No Content
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MODIFY DS3 TARGET

Description
Modify a DS3 target.

Notes:

• If an optional request parameter is not included, the previous setting is retained.

• It is not possible to change the quiesced state directly from NO to YES.

Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/ds3_target/{BlackPearl target instance UUID,

name, or other unique attribute}/[?access_control_replication=NONE|USERS][admin_

auth_id={string][&admin_secret_key={string}][&data_path_end_point={string}][&data_

path_https=TRUE|FALSE][&data_path_port={32-bit integer}][&data_path_proxy={string}]

[&data_path_verify_certificate=TRUE|FALSE][&default_read_preference=MINIMUM_

LATENCY|AFTER_ONLINE_POOL|AFTER_NEARLINE_POOL|AFTER_NON_EJECTABLE_TAPE|LAST_

RESORT|NEVER][&name={string}][&permit_going_out_of_sync=TRUE|FALSE]

[&quiesced=NO|PENDING][&replicated_user_default_data_policy={string}]

To determine the UUID for a DS3 target instance, see Get DS3 Targets on page 516.

Request Parameters 

Parameter Description Required

access_
control_
replication

The access control that is replicated to the DS3 target.
Values:
• NONE — No access control is replicated.
• USERS — The source BlackPearl gateway replicates its users and
passwords to the target gateway.

no

admin_auth_
id

The S3 access ID assigned to an Administrator. no

admin_
secret_key

The S3 secret key for the account matching the given admin_auth_
id.

no
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Parameter Description Required

data_path_
end_ point

The IPv4 address or DNS name for the data path of the DS3 target. no

data_path_
https

Whether the source BlackPearl gateway uses the HTTPS protocol to
setup and replicate data to the target gateway. Values: TRUE, FALSE

no

data_path_
port

The value of the port on which the target BlackPearl gateway’s DS3
server is running. If null, the parameter defaults to port 80 for
HTTP connections and port 443 for HTTPS connections.

no

data_path_
proxy

The proxy server for the source BlackPearl gateway to use to
connect to the target gateway.

no

data_path_
verify_
certificate

Whether the data path certificate is verified. When
DataPathVerifyCertificate and DataPathHttps are both TRUE, the
source BlackPearl gateway fully validates the target gateway’s
certificate. If the certificate is not trusted or problematic in anyway,
it is not honored. Do not set this to TRUE if the target gateway is
using the default self-signed SSL certificate.
Values: TRUE, FALSE

no

default_read_
preference

When it is preferable to read from the DS3 target rather than the
replication source.
Values: MINIMUM_LATENCY, AFTER_ONLINE_POOL, AFTER_
NEARLINE_POOL, AFTER_NON_EJECTABLE_TAPE, LAST_RESORT,
NEVER. See read_preference on page 497.

no

name The name for the DS3 target. no

permit_
going_out_
of_sync

Whether a target is allowed to be out of sync with the source. By
default, if the data policy specifies that the BlackPearl gateway
must replicate local actions, actions that the gateway cannot
replicate fail. You can temporarily set this parameter to TRUE in
order to operate in full capacity locally while one or more targets is
down for a prolonged period of time. Values: TRUE, FALSE

no

quiesced Request that the gateway prepare the target to go into an inactive
state (PENDING) or return the target to an active state (NO).
Values: NO, PENDING

no

replicated_
user_
default_data_
policy

The data policy the target applies as the default data policy for any
users replicated to the target.

no
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Responses

Response Elements
<Data>

   <AccessControlReplication>

      NONE|USERS

   </AccessControlReplication>

   <AdminAuthId>{string}</AdminAuthId>

   <AdminSecretKey>{string}</AdminSecretKey>

   <DataPathEndPoint>{string}</DataPathEndPoint>

   <DataPathHttps>TRUE|FALSE</DataPathHttps>

   <DataPathPort>{16-bit integer}</DataPathPort>

   <DataPathProxy>{string}</DataPathProxy>

   <DataPathVerifyCertificate>

      TRUE|FALSE

   </DataPathVerifyCertificate>

   <DefaultReadPreference>

      MINIMUM_LATENCY|AFTER_ONLINE_POOL|AFTER_NEARLINE_POOL

      |AFTER_NON_EJECTABLE_TAPE|LAST_RESORT|NEVER

   </DefaultReadPreference>

   <Id>{string}</Id>

   <Name>{string}</Name>

   <PermitGoingOutOfSync>TRUE|FALSE</PermitGoingOutOfSync>

   <Quiesced>NO|PENDING|YES</Quiesced>

   <ReplicatedUserDefaultDataPolicy>

{string}

   </ReplicatedUserDefaultDataPolicy>

   <State>ONLINE|OFFLINE|LIMITED_ACCESS</State>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

AccessControl Replication The access control that is replicated to the DS3 target.
Values:
• NONE — No access control is replicated.
• USERS — The source BlackPearl gateway replicates its users and
passwords to the target gateway.

AdminAuthId The S3 access ID assigned to an Administrator.
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Parameter Description

AdminSecretKey The S3 secret key for the account matching the given AdminAuthId.

DataPathEndPoint The IPv4 address or DNS name for the data path of the DS3 target.

DataPathHttps Whether the source BlackPearl gateway uses the HTTPS protocol to
setup and replicate data to the target gateway. Values: TRUE, FALSE

DataPathPort The value of the port on which the target BlackPearl gateway’s S3
server is running. If null, the parameter defaults to port 80 for HTTP
connections and port 443 for HTTPS connections.

DataPathProxy The proxy server for the source BlackPearl gateway to use to connect
to the target gateway.

DataPathVerify Certificate Whether the data path certificate is verified. When
DataPathVerifyCertificate and DataPathHttps are both TRUE, the
source BlackPearl gateway fully validates the target gateway’s
certificate. If the certificate is not trusted or problematic in anyway, it
is not honored.
Values: TRUE, FALSE

DefaultRead Preference When it is preferable to read from the DS3 target rather than the
replication source.
Values: MINIMUM_LATENCY, AFTER_ONLINE_POOL, AFTER_
NEARLINE_POOL, AFTER_NON_EJECTABLE_TAPE, LAST_RESORT,
NEVER. See read_preference on page 455.

Id The UUID for the DS3 target instance.
Note: If a DS3 target has its instance identifier reset after it is
registered on other BlackPearl gateways, the replication link is forever
invalid and must be deleted and re-created.

Name The name for the DS3 target.

PermitGoingOutOfSync Whether a target is allowed to be out of sync with the source. See
permit_going_out_of_sync on page 533.

Quiesced Whether the DS3 target is in a temporarily inactive state. Values: NO,
PENDING, YES

ReplicatedUser
DefaultDataPolicy

The data policy the target applies as the default data policy for any
users replicated to the target.

State The state of the DS3 target.
Values: ONLINE, OFFLINE, LIMITED_ACCESS
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Example

Sample Request
This request modifies the DS3 target named ‘TargetDS3’ to have the default read preference
MINIMUM_LATENCY.

PUT http[s]://blackpearl-hostname/_rest_/ds3_target/TargetDS3/?default_read_

preference=MINIMUM_LATENCY HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>

   <AccessControlReplication>NONE</AccessControlReplication>

   <AdminAuthId>c381Y3RyYQ==</AdminAuthId>

   <AdminSecretKey>d7pJBeAN</AdminSecretKey>

   <DataPathEndPoint>192.168.4.8</DataPathEndPoint>

   <DataPathHttps>TRUE</DataPathHttps>

   <DataPathPort/>

   <DataPathProxy/>

   <DataPathVerifyCertificate>TRUE</DataPathVerifyCertificate>

   <DefaultReadPreference>MINIMUM_LATENCY</DefaultReadPreference>

   <Id>c927287a-90eb-428e-88ae-faedc3749e17</Id>

   <Name>TargetBP</Name>

   <PermitGoingOutOfSync>FALSE</PermitGoingOutOfSync>

   <Quiesced>NO</Quiesced>

   <ReplicatedUserDefaultDataPolicy/>

   <State>ONLINE</State>

</Data>

PAIR BACK REGISTERED DS3 TARGET

Description
Pairs back the DS3 target with the replication source such that the source points to the DS3
target and the DS3 target points to the source (enabling bidirectional replication). Use
optional parameters to modify the registration settings for the pair back.

Note: If the name parameter is not included, name is set to the BlackPearl gateway’s serial
number. If any other optional request parameter is not included, the setting used to
register the original DS3 target is used.
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Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/ds3_target/{DS3 target instance UUID, name,

or other unique attribute}/?operation=PAIR_BACK[&access_control_

replication=NONE|USERS][admin_auth_id={string][&admin_secret_key={string}][&data_

path_end_point={string}][&data_path_https=TRUE|FALSE][&data_path_port=

{32-bit integer}][&data_path_proxy={string}][&data_path_verify_

certificate=TRUE|FALSE][&default_read_preference=MINIMUM_LATENCY|AFTER_ONLINE_

POOL|AFTER_NEARLINE_POOL|AFTER_NON_EJECTABLE_TAPE|LAST_RESORT|NEVER][&name={string}]

[&permit_going_out_of_sync=TRUE|FALSE][&replicated_user_default_data_policy=

{string}]

To determine the UUID for a DS3 target instance, see Get DS3 Targets on page 516.

Request Parameters 

Parameter Description Required

operation The operation to perform. For this request, the operation is pair
back. Value: PAIR_BACK

yes

access_
control_
replication

The access control that is replicated to the DS3 target.
Values:
• NONE — No access control is replicated.
• USERS — The source BlackPearl gateway replicates its users and
passwords to the target gateway.

no

admin_auth_
id

The S3 access ID assigned to an Administrator. no

admin_
secret_key

The S3 secret key for the account matching the given admin_auth_
id.

no

data_path_
end_ point

The IPv4 address or DNS name for the data path of the DS3 target. no

data_path_
https

Whether the source BlackPearl gateway uses the HTTPS protocol to
setup and replicate data to the target gateway. Values: TRUE, FALSE

no

data_path_
port

The value of the port on which the DS3 target’s S3 server is
running. If null, the parameter defaults to port 80 for HTTP
connections and port 443 for HTTPS connections.

no
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Parameter Description Required

data_path_
proxy

The proxy server for the source BlackPearl gateway to use to
connect to the target gateway.

no

data_path_
verify_
certificate

Whether the data path certificate is verified. When
DataPathVerifyCertificate and DataPathHttps are both TRUE, the
source BlackPearl gateway fully validates the target gateway’s
certificate. If the certificate is not trusted or problematic in anyway,
it is not honored. Do not set this to TRUE if the target gateway is
using the default self-signed SSL certificate.
Values: TRUE, FALSE

no

default_read_
preference

When it is preferable to read from the DS3 target rather than the
replication source.
Values: MINIMUM_LATENCY, AFTER_ONLINE_POOL, AFTER_
NEARLINE_POOL, AFTER_NON_EJECTABLE_TAPE, LAST_RESORT,
NEVER. See read_preference on page 497.

no

name The name for the DS3 target.
Default: system serial number.

no

permit_
going_out_
of_sync

Whether a target is allowed to be out of sync with the source. By
default, if the data policy specifies that the BlackPearl gateway
must replicate local actions, actions that the gateway cannot
replicate fail. You can temporarily set this parameter to TRUE in
order to operate in full capacity locally while one or more targets is
down for a prolonged period of time. Values: TRUE, FALSE

no

replicated_
user_
default_data_
policy

The data policy the target applies as the default data policy for any
users replicated to the target.

no

Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 403: Access Denied
• 404: Not Found
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Example

Sample Request
This request pairs back the DS3 target named ‘DS3Target’ using all of the same registration
parameters.
PUT http[s]://blackpearl-hostname/_rest_/ds3_target/DS3Target/?operation=PAIR_BACK

HTTP/1.1

Sample Response
HTTP/1.1 204 No Content

REGISTER DS3 TARGET

Description
Connect to and register the specified DS3 target as a replication target for the BlackPearl
gateway.

Note: If a DS3 target has its instance identifier reset (see Reset Instance Identifier on
page 1133) after it is registered on other BlackPearl gateways, the replication link is
invalid and must be deleted and re-created.

Requests

Syntax
POST http[s]://{datapathDNSname}/_rest_/ds3_target/?admin_auth_id={string}&admin_

secret_key={string}&data_path_end_point={string}&name={string}[&access_control_

replication=NONE|USERS][&data_path_https=TRUE|FALSE][&data_path_port=

{32-bit integer}][&data_path_proxy={string}][&data_path_verify_

certificate=TRUE|FALSE][&default_read_preference=MINIMUM_LATENCY|AFTER_ONLINE_

POOL|AFTER_NEARLINE_POOL|AFTER_NON_EJECTABLE_TAPE|LAST_RESORT|NEVER][&permit_going_

out_of_sync=TRUE|FALSE][&replicated_user_default_data_policy={string}]
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Request Parameters 

Parameter Description Required

admin_auth_
id

The S3 access ID assigned to an Administrator. yes

admin_
secret_key

The S3 secret key for the account matching the given admin_auth_
id.

yes

data_path_
end_ point

The IPv4 address or DNS name for the data path of the DS3 target. yes

name The name for the DS3 target. yes

access_
control_
replication

The access control that is replicated to the DS3 target.
Values:
• NONE (default) — No access control is replicated.
• USERS — The source BlackPearl gateway replicates its users and
passwords to the target gateway.

no

data_path_
https

Whether the source BlackPearl gateway uses the HTTPS protocol to
setup and replicate data to the target gateway. Values: TRUE
(default), FALSE

no

data_path_
port

The value of the port on which the DS3 target’s S3 server is
running. If null, the parameter defaults to port 80 for HTTP
connections and port 443 for HTTPS connections.

no

data_path_
proxy

The proxy server for the source BlackPearl gateway to use to
connect to the target gateway.

no

data_path_
verify_
certificate

Whether the data path certificate is verified. When
DataPathVerifyCertificate and DataPathHttps are both TRUE, the
source BlackPearl gateway fully validates the target gateway’s
certificate. If the certificate is not trusted or problematic in anyway,
it is not honored. Do not set this to TRUE if the target gateway is
using the default self-signed SSL certificate.
Values: TRUE (default), FALSE

no

default_read_
preference

When it is preferable to read from the DS3 target rather than the
replication source.
Values: MINIMUM_LATENCY, AFTER_ONLINE_POOL, AFTER_
NEARLINE_POOL, AFTER_NON_EJECTABLE_TAPE, LAST_RESORT,
NEVER. See read_preference on page 455.

no
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Parameter Description Required

permit_
going_out_
of_sync

Whether a target is allowed to be out of sync with the source. By
default, if the data policy specifies that the BlackPearl gateway
must replicate local actions, actions that the gateway cannot
replicate fail. You can temporarily set this parameter to TRUE in
order to operate in full capacity locally while one or more targets is
down for a prolonged period of time. Values: TRUE, FALSE
(default)

no

replicated_
user_
default_data_
policy

The data policy the target applies as the default data policy for any
users replicated to the target.
Default: no default data policy.

no

Responses

Response Elements
<Data>

   <AccessControlReplication>

      NONE|USERS

   </AccessControlReplication>

   <AdminAuthId>{string}</AdminAuthId>
   <AdminSecretKey>{string}</AdminSecretKey>

   <DataPathEndPoint>{string}</DataPathEndPoint>

   <DataPathHttps>TRUE|FALSE</DataPathHttps>

   <DataPathPort>{16-bit integer}</DataPathPort>

   <DataPathProxy>{string}</DataPathProxy>
   <DataPathVerifyCertificate>

      TRUE|FALSE

   </DataPathVerifyCertificate>

   <DefaultReadPreference>

      MINIMUM_LATENCY|AFTER_ONLINE_POOL|AFTER_NEARLINE_POOL

      |AFTER_NON_EJECTABLE_TAPE|LAST_RESORT|NEVER

   </DefaultReadPreference>
   <Id>{string}</Id>

   <Name>{string}</Name>

   <PermitGoingOutOfSync>TRUE|FALSE</PermitGoingOutOfSync>

   <Quiesced>NO|PENDING|YES</Quiesced>
   <ReplicatedUserDefaultDataPolicy>

{string}

   </ReplicatedUserDefaultDataPolicy>

   <State>ONLINE|OFFLINE|LIMITED_ACCESS</State>

</Data>
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where the response elements are defined as follows:

Parameter Description

Data The container for the response.

AccessControl Replication The access control that is replicated to the DS3 target.
Values:
• NONE — No access control is replicated.
• USERS — The source BlackPearl gateway replicates its users and
passwords to the target gateway.

AdminAuthId The S3 access ID assigned to an Administrator.

AdminSecretKey The S3 secret key for the account matching the given AdminAuthId.

DataPathEndPoint The IPv4 address or DNS name for the data path of the DS3 target.

DataPathHttps Whether the source BlackPearl gateway uses the HTTPS protocol to
setup and replicate data to the target gateway. Values: TRUE, FALSE

DataPathPort The value of the port on which the DS3 target’s S3 server is running.
If null, the parameter defaults to port 80 for HTTP connections and
port 443 for HTTPS connections.

DataPathProxy The proxy server for the source BlackPearl gateway to use to connect
to the target gateway.

DataPathVerify Certificate Whether the data path certificate is verified. When
DataPathVerifyCertificate and DataPathHttps are both TRUE, the
source BlackPearl gateway fully validates the target gateway’s
certificate. If the certificate is not trusted or problematic in anyway, it
is not honored.
Values: TRUE, FALSE

DefaultRead Preference When it is preferable to read from the DS3 target rather than the
replication source.
Values: MINIMUM_LATENCY, AFTER_ONLINE_POOL, AFTER_
NEARLINE_POOL, AFTER_NON_EJECTABLE_TAPE, LAST_RESORT,
NEVER. See read_preference on page 455.

Id The UUID for the DS3 target instance.
Note: If a DS3 target has its instance identifier reset after it is
registered on other BlackPearl gateways, the replication link is forever
invalid and must be deleted and re-created.

Name The name for the DS3 target.
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Parameter Description

PermitGoingOutOfSync Whether a target is allowed to be out of sync with the source. See
permit_going_out_of_sync on page 533.

Quiesced Whether the DS3 target is in a temporarily inactive state. Values: NO,
PENDING, YES

ReplicatedUser
DefaultDataPolicy

The data policy the target applies as the default data policy for any
users replicated to the target.

State The state of the DS3 target.
Values: ONLINE, OFFLINE, LIMITED_ACCESS

Example

Sample Request
This request registers a DS3 target with the data path end point ‘DataPath’, the Administrator
S3 Access Id ‘c381Y3RyYQ==’, the Administrator S3 Secret Key ‘d7pJBeAN’, and the name
‘TargetDS3’ as a replication target for the BlackPearl gateway.
POST http[s]://blackpearl-hostname/_rest_/ds3_target/?admin_auth_

id=c381Y3RyYQ==&admin_secret_key=d7pJBeAN&data_path_end_

point=DataPath&name=TargetDS3 HTTP/1.1

Sample Response
HTTP/1.1 201 CREATED

<Data>

   <AccessControlReplication>NONE</AccessControlReplication>

   <AdminAuthId>c381Y3RyYQ==</AdminAuthId>

   <AdminSecretKey>d7pJBeAN</AdminSecretKey>

   <DataPathEndPoint>192.168.15.16</DataPathEndPoint>

   <DataPathHttps>TRUE</DataPathHttps>

   <DataPathPort/>

   <DataPathProxy/>

   <DataPathVerifyCertificate>TRUE</DataPathVerifyCertificate>

   <DefaultReadPreference>MINIMUM_LATENCY</DefaultReadPreference>

   <Id>c927287a-90eb-428e-88ae-faedc3749e17</Id>

   <Name>TargetBP</Name>

   <PermitGoingOutOfSync>FALSE</PermitGoingOutOfSync>

   <Quiesced>NO</Quiesced>

   <ReplicatedUserDefaultDataPolicy/>

   <State>ONLINE</State>

</Data>

April 2023 DS3 API Reference-Spectra BlackPearl Nearline Gateway
- 535 -



Chapter 12 - Replication Target Operations Verify DS3 Target

VERIFY DS3 TARGET

Description
Verifies connectivity to the DS3 target and that the Administrator credentials are correct. If
full_details is specified, the operation verifies that all data expected to reside on the
target does in fact reside there.

Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/ds3_target/{BlackPearl target instance UUID,

name, or other unique attribute}/?operation=VERIFY[&full_details]

To determine the UUID for a DS3 target instance, see Get DS3 Targets on page 516.

Request Parameters 

Parameter Description Required

operation The operation to perform. For this request, the operation is verify.
Value: VERIFY

yes

full_details If included, the operation verifies that all data expected to reside on
the target does in fact reside there.

no

Responses

Response Elements
<Data>

   <AccessControlReplication>

      NONE|USERS

   </AccessControlReplication>

   <AdminAuthId>{string}</AdminAuthId>
   <AdminSecretKey>{string}</AdminSecretKey>

   <DataPathEndPoint>{string}</DataPathEndPoint>

   <DataPathHttps>TRUE|FALSE</DataPathHttps>

   <DataPathPort>{16-bit integer}</DataPathPort>

   <DataPathProxy>{string}</DataPathProxy>
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   <DataPathVerifyCertificate>

      TRUE|FALSE

   </DataPathVerifyCertificate>

   <DefaultReadPreference>

      MINIMUM_LATENCY|AFTER_ONLINE_POOL|AFTER_NEARLINE_POOL

      |AFTER_NON_EJECTABLE_TAPE|LAST_RESORT|NEVER

   </DefaultReadPreference>

   <Id>{string}</Id>

   <Name>{string}</Name>

   <PermitGoingOutOfSync>TRUE|FALSE</PermitGoingOutOfSync>

   <Quiesced>NO|PENDING|YES</Quiesced>
   <ReplicatedUserDefaultDataPolicy>

{string}

   </ReplicatedUserDefaultDataPolicy>

   <State>ONLINE|OFFLINE|LIMITED_ACCESS</State>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

AccessControl Replication The access control that is replicated to the DS3 target.
Values:
• NONE — No access control is replicated.
• USERS — The source BlackPearl gateway replicates its users and
passwords to the target gateway.

AdminAuthId The S3 access ID assigned to an Administrator.

AdminSecretKey The S3 secret key for the account matching the given AdminAuthId.

DataPathEndPoint The IPv4 address or DNS name for the data path of the DS3 target.

DataPathHttps Whether the source BlackPearl gateway uses the HTTPS protocol to
setup and replicate data to the target gateway. Values: TRUE, FALSE

DataPathPort The value of the port on which the DS3 target’s S3 server is running.
If null, the parameter defaults to port 80 for HTTP connections and
port 443 for HTTPS connections.

DataPathProxy The proxy server for the source BlackPearl gateway to use to connect
to the DS3 target.
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Parameter Description

DataPathVerify Certificate Whether the data path certificate is verified. When
DataPathVerifyCertificate and DataPathHttps are both TRUE, the
source BlackPearl gateway fully validates the target gateway’s
certificate. If the certificate is not trusted or problematic in anyway, it
is not honored.
Values: TRUE, FALSE

DefaultRead Preference When it is preferable to read from the DS3 target rather than the
replication source.
Values: MINIMUM_LATENCY, AFTER_ONLINE_POOL, AFTER_
NEARLINE_POOL, AFTER_NON_EJECTABLE_TAPE, LAST_RESORT,
NEVER. See read_preference on page 455.

Id The UUID for the DS3 target instance.
Note: If a DS3 target has its instance identifier reset after it is
registered on other BlackPearl gateways, the replication link is forever
invalid and must be deleted and re-created.

Name The name for the DS3 target.

PermitGoingOutOfSync Whether a target is allowed to be out of sync with the source. See
permit_going_out_of_sync on page 533.

Quiesced Whether the DS3 target is in a temporarily inactive state. Values: NO,
PENDING, YES

ReplicatedUser
DefaultDataPolicy

The data policy the target applies as the default data policy for any
users replicated to the target.

State The state of the DS3 target.
Values: ONLINE, OFFLINE, LIMITED_ACCESS

Example

Sample Request
This request confirms connectivity to the DS3 target and verifies the credentials of the
administrator.
PUT http[s]://blackpearl-hostname/_rest_/ds3_target/DS3Target/?operation=VERIFY

HTTP/1.1
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Sample Response
HTTP/1.1 200 OK

<Data>

   <AccessControlReplication>NONE</AccessControlReplication>

   <AdminAuthId>c381Y3RyYQ==</AdminAuthId>

   <AdminSecretKey>d7pJBeAN</AdminSecretKey>

   <DataPathEndPoint>192.168.108.108</DataPathEndPoint>

   <DataPathHttps>TRUE</DataPathHttps>

   <DataPathPort/>

   <DataPathProxy/>

   <DataPathVerifyCertificate>TRUE</DataPathVerifyCertificate>

   <DefaultReadPreference>MINIMUM_LATENCY</DefaultReadPreference>

   <Id>c927287a-90eb-428e-88ae-faedc3749e17</Id>

   <Name>DS3Target</Name>

   <PermitGoingOutOfSync>FALSE</PermitGoingOutOfSync>

   <Quiesced>NO</Quiesced>

   <ReplicatedUserDefaultDataPolicy/>

   <State>ONLINE</State>

</Data>
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CHAPTER 13 - STORAGE DOMAIN
OPERATIONS

A storage domain is a named collection of member data partitions and, when applicable,
media type combinations. Storage domains define the possible places where data sent to the
Spectra BlackPearl Nearline Gateway can be stored. Data persistence rules and data policies
further define where and for how long specific data is stored.

Entire data partition/media type combinations are members of storage domains. When
additional capacity is required, a single zpool or tape is allocated out of the members to fulfill
the capacity requirement.

Convert a Storage Domain to a BlackPearl Target 541
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Create Storage Domain 545

Create Tape Storage Domain Member 553

Delete Storage Domain 556

Delete Storage Domain Failure 557

Delete Storage Domain Member 558

Get Storage Domain 559
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Modify Storage Domain 578
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CONVERT A STORAGE DOMAIN TO A BLACKPEARL TARGET

Description
Convert a storage domain to a BlackPearl target so that permanent persistence rules become
permanent replication rules. This is used if data is initially written to multiple tape storage
domains on different tape libraries connected to one BlackPearl gateway, and then one of the
tape libraries is physically transferred to another site and connected a to different BlackPearl
gateway. At least one permanent persistence rule must remain after the conversion.

Note: Once a storage domain is converted to a BlackPearl target, it cannot be converted
back to a storage domain.

The process is as follows:

1. Discontinue data transfer operations to the original BlackPearl gateway.

2. Wait for all jobs to complete. (Confirm using Get Active Jobs on page 190.)

3. Make a database backup on the original BlackPearl gateway. See “Database Backup &
Restore” in the BlackPearl User Guide.

4. Move the tape library to its new physical location and connect it to the second BlackPearl
gateway (“BlackPearl #2”).

5. Power on BlackPearl #2.

6. Restore the database backup from Step 3 onto BlackPearl #2.

CAUTION
Restoring the database from BlackPearl #1 to BlackPearl #2 deletes all of the data on
BlackPearl #2. Only do this if BlackPearl #2 is newly installed and does not contain
data.

7. Reset the instance id on BlackPearl #2. Restoring the database backup also restores the
instance id so that BlackPearl #2 has the same id as BlackPearl #1. The instance id must be
unique, so you need to reset the instance id for BlackPearl #2. See Reset Instance Identifier
on page 1133.

8. Register BlackPearl #2 as a target on the original BlackPearl gateway (optionally, using
pair-back) (See Register DS3 Target on page 531 and Pair Back Registered DS3 Target on
page 528.)

9. Issue this command to convert the now-remote storage domain to a BlackPearl target on
each BlackPearl gateway.

10.Unquiesce and activate each BlackPearl gateway. It does not matter which is done first.
See Modify Azure Target on page 482.

April 2023 DS3 API Reference-Spectra BlackPearl Nearline Gateway
- 541 -

https://support.spectralogic.com/documentation/user-guides/blackpearl-user-guide.pdf


Chapter 13 - Storage Domain Operations Convert a Storage Domain to a BlackPearl Target

Converting a storage domain to a BlackPearl target does the following.

1. The storage domain no longer exists on either BlackPearl gateway.

2. Any blobs stored in the tapes, pools, etc. for that storage domain are updated to be stored
on the replication target.

3. Any permanent persistence rules targeting the storage domain are converted to
permanent replication rules targeting the BlackPearl target.

4. Any temporary or retired persistence rules targeting the storage domain are deleted.

Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/storage_domain/{storage domain UUID, name, or

other unique attribute}/?convert_to_ds3_target={string}/

To determine the UUID for a storage domain, see Get Storage Domains on page 573.

Request Parameters

Parameter Description Required

convert_to_
ds3_
target

BlackPearl target UUID, name, or other unique attribute.
Note: To determine the UUID for a BlackPearl target, see Get DS3
Targets on page 516.

yes

Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 403: Access Denied
• 404: Not Found
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Example

Sample Request
This request converts the storage domain with the name sd1 to a BlackPearl target with the
UUID f36cb73e-d4e6-4cc4-9ac1-5f666e99eb3e.
PUT http[s]://blackpearl-hostname/_rest_/storage_domain/sd1/?convert_to_ds3_

target=f36cb73e-d4e6-4cc4-9ac1-5f666e99eb3e HTTP/1.1

Sample Response
HTTP/1.1 204 No Content

CREATE POOL STORAGE DOMAIN MEMBER

Description
Adds the specified pool partition as a member of the specified storage domain.

Requests

Syntax
POST http[s]://{datapathDNSname}/_rest_/storage_domain_member/?pool_partition_id=

{string}&storage_domain_id={string}[&write_preference=HIGH|NORMAL|LOW|NEVER_SELECT]

Request Parameters 

Parameter Description Required

pool_
partition_id

Pool partition UUID, name, or other unique attribute. To determine
the UUID for a pool partition, see Get Pool Partitions on page 633.

yes

storage_
domain_id

Storage domain UUID, name, or other unique attribute. To
determine the UUID for a storage domain, see Get Storage Domains
on page 573.

yes

write_
preference

Determines the preferred usage of the pool partition when
additional capacity is needed. The BlackPearl gateway uses a
partition with HIGH write_preference before a partition with a
NORMAL write_preference, and so on. Use NEVER_SELECT to
indicate that the partition is read-only.
Values: HIGH, NORMAL (default), LOW, NEVER_SELECT

no
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Responses

Response Elements
<Data>

   <AutoCompactionThreshold>

{32-bit integer}

   </AutoCompactionThreshold>

   <Id>{string}</Id>

   <PoolPartitionId>{string}</PoolPartitionId>

   <State>NORMAL|EXCLUSION_IN_PROGRESS</State>

   <StorageDomainId>{string}</StorageDomainId>

   <TapePartitionId>{string}</TapePartitionId>
   <TapeType/>

   <WritePreference>

      HIGH|NORMAL|LOW|NEVER_SELECT

   </WritePreference>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

AutoCompaction
Threshold

This does not apply for pools.

Id The UUID for the pool storage domain member.

PoolPartitionId The UUID for the pool partition.

State The state of the pool partition member. Values:
• NORMAL — The storage domain member is included normally.
• EXCLUSION_IN_PROGRESS — The storage domain member is in the
process of being excluded (data that resides on it is being copied to other
storage domain members).

StorageDomainId The UUID for the storage domain to which the pool partition member was
assigned.

TapePartitionId Always null for this operation.

TapeType Always null for this operation.
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Parameter Description

WritePreference The preferred usage of the pool partition when additional capacity is
needed. The BlackPearl gateway uses a partition with HIGH write_
preference before a partition with a NORMAL write_preference, and
so on. A value of NEVER_SELECT indicates that the partition is read-only.
Values: HIGH, NORMAL, LOW, NEVER_SELECT

Example

Sample Request
This request creates a pool storage domain member for the pool partition with the UUID
a541c709-cceb-4d86-a23c-1998858ae854 in the storage domain with the UUID 9b186102-c116-
496f-a6a3-fb392c0060b6.
POST http[s]://blackpearl-hostname/_rest_/storage_domain_member/?pool_partition_

id=a541c709-cceb-4d86-a23c-1998858ae854&storage_domain_id=9b186102-c116-496f-a6a3-

fb392c0060b} HTTP/1.1

Sample Response
HTTP/1.1 201 CREATED

<Data>

   <Id>c2d066b1-2563-4db9-a452-f681d57110c6</Id>

   <PoolPartitionId>

      a541c709-cceb-4d86-a23c-1998858ae854

   </PoolPartitionId>

   <State>NORMAL</State>

   <StorageDomainId>

      9b186102-c116-496f-a6a3-fb392c0060b6

   </StorageDomainId>

   <TapePartitionId/>

   <TapeType/>

   <WritePreference>HIGH</WritePreference>

</Data>

CREATE STORAGE DOMAIN

Description
Create a storage domain.
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Requests

Syntax
POST http[s]://{datapathDNSname}/_rest_/storage_domain/?name={string}[&auto_eject_

media_full_threshold={64-bit integer}][&auto_eject_upon_cron={string}][&auto_eject_

upon_job_cancellation=TRUE|FALSE][&auto_eject_upon_job_completion=TRUE|FALSE][&auto_

eject_upon_media_full=TRUE|FALSE][&ltfs_file_naming=OBJECT_NAME|OBJECT_ID][&max_

tape_fragmentation_percent={32-bit integer}][&maximum_auto_verification_frequency_

in_days={32-bit integer}][&media_ejection_allowed=TRUE|FALSE][&secure_media_

allocation=TRUE|FALSE][&verify_prior_to_auto_

eject=CRITICAL|URGENT|HIGH|NORMAL|LOW|BACKGROUND][&write_

optimization=CAPACITY|PERFORMANCE]

Request Parameters 

Parameter Description Required

name The name for the storage domain. yes

auto_eject_
media_full_
threshold

The minimum available capacity (in bytes) at which media is
not considered full and eligible for auto-eject. If not
configured, the auto-eject threshold is computed based on the
preferred chunk size.

no

auto_eject_upon_
cron

A CRON expression to indicate when to auto eject tape
cartridges. If set, a CRON job is created based on the CRON
string specified. Once the CRON job is executed, all tape
cartridges assigned to the storage domain, not already pending
ejection are queued for ejection.
Note: This parameter is only valid if media_ejection_
allowed=TRUE.

no

auto_eject_upon_
job_cancellation

Determines whether all media assigned to the storage domain,
not already pending ejection, is queued for ejection whenever a
job is canceled.
Note: This parameter is only valid if media_ejection_
allowed=TRUE.

Values: TRUE, FALSE (default)

no
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Parameter Description Required

auto_eject_upon_
job_completion

Determines whether all media assigned to the storage domain,
not already pending ejection, is queued for ejection whenever a
job completes.
Note: This parameter is only valid if media_ejection_
allowed=TRUE.

Values: TRUE, FALSE (default)

no

auto_eject_upon_
media_full

Determines whether all media assigned to the storage domain,
not already pending ejection, is queued for ejection whenever
the media cannot fit the amount of data specified by auto_
eject_media_full_threshold.
Note: This parameter is only valid if media_ejection_
allowed=TRUE.

Values: TRUE, FALSE (default)

no
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Parameter Description Required

ltfs_file_naming Determines the LTFS file naming mode used on tapes in the
storage domain. Values:
• Object Name — LTFS file names use the format {bucket
name}/{object name}, for example bucket1/video1.mov. Object
names must comply with LTFS file naming rules. If the tapes
are ejected from the BlackPearl gateway and loaded into a
non-BlackPearl tape partition, the file names match the
object names.

Notes:
• The colon character (:) is not allowed in LTFS file names
and therefore not allowed in BlackPearl object names.
The slash character (/) is also technically not allowed in
LTFS file names; however, the BlackPearl software can
accommodate a slash in the object name and translates it
as a directory in the LTFS file system (for example
directory1/directory2/video1.mov).

• Spectra Logic does not recommend the following
characters in LTFS file names or BlackPearl object names
for reasons of cross-platform compatibility: control
characters such as carriage return (CR) and line feed
(LF), double quotation mark (“), asterisk (*), question
mark (?), less than sign (<), greater than sign (>),
backslash (\), forward slash (/) vertical line (|).

• Object ID — LTFS file names use the format {bucket name}/
{object id}, for example bucket1/1fc6f09c-dd72-41ea-8043-
0491ab8a6d82. Object names do not need to comply with
LTFS file naming rules. The BlackPearl gateway saves object
names as LTFS extended attributes allowing any third party
application to reconstruct all the data including the object
names.

no

max_tape_
fragmentation_
percent

Obsolete parameter. no

maximum_auto_
verification_
frequency_in_
days

The number of days since the last data modification before an
unverified piece of media is scheduled for auto verification.
Default: null (data will never be verified)

no
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Parameter Description Required

media_ejection_
allowed

Whether the storage domain or a piece of media assigned to
the storage domain, can be ejected from the BlackPearl
gateway without generating a failure.
Values: TRUE (default), FALSE

no

secure_media_
allocation

Whether media must remain within the storage domain.
Note: secure_media_allocation should only be set to
TRUE when, for compliance purposes, the user must be certain
which media ever contained any data for the storage domain
(usually, to physically destroy the media once the data is no
longer needed), or to force rotating through media when new
backups are created and old backups are deleted.
Values:
• TRUE — Media assigned to the storage domain can only be
reclaimed for use within the same storage domain.

• FALSE (default) — Media assigned to a storage domain can
be reclaimed into the general pool if all data on the media is
deleted.

no

verify_prior_to_
auto_eject

The priority for verifying tapes being ejected automatically due
to any of the auto-eject triggers. The priority is null if
verification is not required prior to ejection. The priority
determines the resources assigned and the processing order.
Values: CRITICAL, URGENT, HIGH, NORMAL, LOW,
BACKGROUND

no

write_
optimization

Specifies whether job chunks are written as quickly as possible
or across as few pieces of media as possible. For example, when
PERFORMANCE mode is set for a tape partition, job chunks are
written as quickly as possible, using all tape drive resources,
even if that means that more tapes are allocated to the storage
domain than are necessary to write the data.
It is better to use CAPACITY mode if the tapes will be ejected
after the job completes or if the storage domain is written to
very rarely and capacity in the library is of concern.
PERFORMANCE mode is recommended for tape partitions in all
other cases.
Storage domains for pool partitions should generally have a
CAPACITY write optimization because pools are very fast and
under less contention. It is rare for a pool storage domain to
benefit from PERFORMANCE mode.
Values: CAPACITY (default), PERFORMANCE

no
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Responses

Response Elements
<Data>

   <AutoEjectMediaFullThreshold>

{64-bit integer}

   </AutoEjectMediaFullThreshold>

   <AutoEjectUponCron>{string}</AutoEjectUponCron>

   <AutoEjectUponJobCancellation>

      TRUE|FALSE

   </AutoEjectUponJobCancellation>

   <AutoEjectUponJobCompletion>

      TRUE|FALSE

   </AutoEjectUponJobCompletion>

   <AutoEjectUponMediaFull>

      TRUE|FALSE

   </AutoEjectUponMediaFull>

   <Id>{string}</Id>

   <LtfsFileNaming>OBJECT_ID|OBJECT_NAME</LtfsFileNaming>

   <MaxTapeFragmentationPercent>

{32-bit integer}

   </MaxTapeFragmentationPercent>

   <MaximumAutoVerificationFrequencyInDays>

{32-bit integer}

   </MaximumAutoVerificationFrequencyInDays>
   <MediaEjectionAllowed>

      TRUE|FALSE

   </MediaEjectionAllowed>
   <Name>{string}</Name>

   <SecureMediaAllocation>TRUE|FALSE</SecureMediaAllocation>
   <VerifyPriorToAutoEject>

      CRITICAL|URGENT|HIGH|NORMAL|LOW|BACKGROUND

   </VerifyPriorToAutoEject>

   <WriteOptimization>CAPACITY|PERFORMANCE</WriteOptimization>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.
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Parameter Description

AutoEjectMedia FullThreshold The minimum available capacity (in bytes) at which media is
not considered full and eligible for auto-eject.

AutoEjectUpon Cron The CRON expression that indicate when to auto eject tape
cartridges. If set, a CRON job is created based on the CRON
string specified. Once the CRON job is executed, all tape
cartridges assigned to the storage domain, not already
pending ejection are queued for ejection.

AutoEjectUponJobCancellation Whether all media assigned to the storage domain, not
already pending ejection, is queued for ejection whenever a
job is canceled.
Values: TRUE, FALSE

AutoEjectUponJobCompletion Whether all media assigned to the storage domain, not
already pending ejection, is queued for ejection whenever a
job completes.
Values: TRUE, FALSE

AutoEjectUpon MediaFull Determines whether all media assigned to the storage domain,
not already pending ejection, is queued for ejection whenever
the media cannot fit the amount of data specified by
AutoEjectMediaFullThreshold.
Values: TRUE, FALSE

Id The UUID for the storage domain.

LtfsFileNaming The LTFS file naming mode used on tapes in the storage
domain. Values: OBJECT_ID, OBJECT_NAME. See ltfs_file_
naming on page 548 for descriptions.

MaxTape Fragmentation Percent Obsolete parameter.

MaximumAuto Verification
FrequencyInDays

The number of days since the last verification when a piece of
unchanged media is not considered for verification.

Name The name of the storage domain.

April 2023 DS3 API Reference-Spectra BlackPearl Nearline Gateway
- 551 -



Chapter 13 - Storage Domain Operations Create Storage Domain

Parameter Description

SecureMedia Allocation Whether media must remain within the storage domain.
Values:
• TRUE — Media assigned to the storage domain can only be
reclaimed for use within the same storage domain.

• FALSE — Media assigned to a storage domain can be
reclaimed into the general pool if all data on the media is
deleted.

VerifyPriorToAuto Eject The priority for verifying tapes being ejected automatically
due to any of the auto-eject triggers. The priority is null if
verification is not required prior to ejection. The priority
determines the resources assigned and the processing order.
Values: CRITICAL, URGENT, HIGH, NORMAL, LOW,
BACKGROUND

WriteOptimization Whether job chunks are written as quickly as possible
(PERFORMANCE) or across as few pieces of media as possible
(CAPACITY). Values: CAPACITY, PERFORMANCE

Example
Sample Request
This request creates a storage domain with the name “sd1” that uses all storage domain
defaults.
POST http://blackpearl-hostname/_rest_/storage_domain/?name=sd1 HTTP/1.1

Sample Response
HTTP/1.1 200 OK
<Data>

   <AutoEjectMediaFullThreshold/>

   <AutoEjectUponCron/>

   <AutoEjectUponJobCancellation>

      FALSE

   </AutoEjectUponJobCancellation>
   <AutoEjectUponJobCompletion>FALSE</AutoEjectUponJobCompletion>

   <AutoEjectUponMediaFull>FALSE</AutoEjectUponMediaFull>

   <Id>3d306463-8fbc-4bb5-9d0d-98c2cb9e8aa2</Id>

   <LtfsFileNaming>OBJECT_ID</LtfsFileNaming>

   <MaxTapeFragmentationPercent/>
   <MaximumAutoVerificationFrequencyInDays>

      365

   </MaximumAutoVerificationFrequencyInDays>
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   <MediaEjectionAllowed>TRUE</MediaEjectionAllowed>
   <Name>sd1</Name>

   <SecureMediaAllocation>FALSE</SecureMediaAllocation>

   </VerifyPriorToAutoEject>

   <WriteOptimization>CAPACITY</WriteOptimization>

</Data>

CREATE TAPE STORAGE DOMAIN MEMBER

Description
Adds the specified tape partition as a member of the specified storage domain.

Requests

Syntax
POST http[s]://{datapathDNSname}/_rest_/storage_domain_member/?storage_domain_id=

{string}&tape_partition_id={string}&tape_type=LTO5|LTO6|LTO7|LTO8|LTOM8|LTO9|LTO_

CLEANING_TAPE|TS_JC|TS_JD|TS_JE|TS_JK|TS_JL|TS_JM|TS_JV|TS_JY|TS_JZ|TS_CLEANING_

TAPE|UNKNOWN|FORBIDDEN[&auto_compaction_threshold={32-bit integer}][&write_

preference=HIGH|NORMAL|LOW|NEVER_SELECT]

Request Parameters 

Parameter Description Required

storage_
domain_id

Storage domain UUID, name, or other unique attribute. To
determine the UUID for a storage domain, see Get Storage
Domains on page 573.

yes

tape_partition_
id

Tape partition UUID, name, or other unique attribute. To
determine the UUID for a tape partition, see Get Tape Partitions
on page 765.

yes

tape_type The tape media type.
Values: LTO5, LTO6, LTO7, LTO8, LTOM8, LTO9, LTO_CLEANING_
TAPE, TS_JC, TS_JD, TS_JE, TS_JK, TS_JL, TS_JM, TS_JV, TS_JY,
TS_JZ, TS_CLEANING_TAPE, UNKNOWN, FORBIDDEN

yes
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Parameter Description Required

auto_
compaction_
threshold

The percentage of a tape with deleted objects at which auto
compaction is triggered. The default is 95. The minimum is 10.

no

write_
preference

Determines the preferred usage of the tape partition when
additional capacity is needed. The BlackPearl gateway uses a
partition with HIGH write_preference before a partition with
a NORMAL write_preference, and so on. Use NEVER_SELECT
to indicate that the partition is read-only.
Values: HIGH, NORMAL (default), LOW, NEVER_SELECT

no

Responses

Response Elements
<Data>

   <AutoCompactionThreshold>

{32-bit integer}

   </AutoCompactionThreshold>

   <Id>{string}</Id>

   <PoolPartitionId/>

   <State>NORMAL|EXCLUSION_IN_PROGRESS</State>
   <StorageDomainId>{string}</StorageDomainId>

   <TapePartitionId>{string}</TapePartitionId>

   <TapeType>

      LTO5|LTO6|LTO7|LTO8|LTOM8|LTO9|LTO_CLEANING_TAPE|TS_JC|TS_JD|

      TS_JE|TS_JK|TS_JL|TS_JM|TS_JV|TS_JY|TS_JZ|TS_CLEANING_TAPE

      |UNKNOWN|FORBIDDEN

   </TapeType>
   <WritePreference>

      HIGH|NORMAL|LOW|NEVER_SELECT

   </WritePreference>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.
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Parameter Description

AutoCompaction
Threshold

The percentage of a tape with deleted objects at which auto compaction is
triggered.

Id The UUID for the tape storage domain member.

PoolPartitionId Always null for this operation.

State The state of the tape partition member. Values:
• NORMAL — The storage domain member is included normally.
• EXCLUSION_IN_PROGRESS — The storage domain member is in the
process of being excluded (data that resides on it is being copied to other
storage domain members).

StorageDomainId The UUID for the storage domain to which the tape partition member was
assigned.

TapePartitionId The UUID for the tape partition.

TapeType The type of tape used by this tape storage domain member.
Values: LTO5, LTO6, LTO7, LTO8, LTOM8, LTO9, LTO_CLEANING_TAPE, TS_
JC, TS_JD, TS_JE, TS_JK, TS_JL, TS_JM, TS_JV, TS_JY, TS_JZ, TS_CLEANING_
TAPE, UNKNOWN, FORBIDDEN

WritePreference The preferred usage of the tape partition when additional capacity is
needed. The BlackPearl gateway uses a partition with HIGH write_
preference before a partition with a NORMAL write_preference, and
so on. A value of NEVER_SELECT indicates that the partition is read-only.
Values: HIGH, NORMAL, LOW, NEVER_SELECT

Example

Sample Request
This request creates a tape storage domain member for the tape partition with the UUID
8fff1c7e-8a3e-4e00-8b16-8585b130300f, using LTO-5 tape cartridges, in the storage domain
with the UUID a3f0888c-9d0c-455c-ae8c-050970c2dab9.
POST http[s]://blackpearl-hostname/_rest_/storage_domain_member/?storage_domain_

id=a3f0888c-9d0c-455c-ae8c-050970c2dab9&tape_partition_id=8fff1c7e-8a3e-4e00-8b16-

8585b130300f&tape_type=LTO5 HTTP/1.1
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Sample Response
HTTP/1.1 201 CREATED

<Data>

   <Id>d9a2f5c6-19b8-4818-9b89-495190a4b0f3</Id>

   <PoolPartitionId/>

   <State>NORMAL</State>

   <StorageDomainId>

      a3f0888c-9d0c-455c-ae8c-050970c2dab9

   </StorageDomainId>

   <TapePartitionId>

      8fff1c7e-8a3e-4e00-8b16-8585b130300f

   </TapePartitionId>

   <TapeType>LTO5</TapeType>

   <WritePreference>HIGH</WritePreference>

</Data>

DELETE STORAGE DOMAIN

Description
Deletes the specified storage domain. All media assigned to the storage domain are
reclaimed.

Note: A storage domain cannot be deleted if there are any persistence rules referring to it,
or if the storage domain is being used by a data policy.

Requests

Syntax
DELETE http[s]://{datapathDNSname}/_rest_/storage_domain/{storage domain UUID, name,

or other unique attribute}/

To determine the UUID for a storage domain, see Get Storage Domains on page 573.

April 2023 DS3 API Reference-Spectra BlackPearl Nearline Gateway
- 556 -



Chapter 13 - Storage Domain Operations Delete Storage Domain Failure

Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 403: Access Denied
• 404: Not Found

Example

Sample Request
This request deletes the storage domain with the name “sd1”.
DELETE http[s]://blackpearl-hostname/_rest_/storage_domain/sd1/ HTTP/1.1

Sample Response
HTTP/1.1 204 No Content

DELETE STORAGE DOMAIN FAILURE

Description
Deletes the specified storage domain failure.

Requests

Syntax
DELETE http[s]://{datapathDNSname}/_rest_/storage_domain_failure/{storage domain

failure UUID or other unique attribute}/

To determine the UUID for a storage domain failure, see Get Storage Domain Failures on
page 563.
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Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 403: Access Denied
• 404: Not Found

Example

Sample Request
This request deletes the storage domain failure with the UUID c6e057a9-b060-4367-b2be-
7516eb4bffb4.
DELETE http[s]://blackpearl-hostname/_rest_/storage_domain_failure/c6e057a9-b060-

4367-b2be-7516eb4bffb4/ HTTP/1.1

Sample Response
HTTP/1.1 204 No Content

DELETE STORAGE DOMAIN MEMBER

Description
Deletes the specified storage domain member.

Note: You can delete storage domain members if any of the following are true:

• One or more resource (a tape or pool) is allocated to the storage domain
member.

• The storage domain member is the last remaining storage domain member with
a write_preference other than NEVER_SELECT, assigned to a storage domain
in use by a persistence rule.

April 2023 DS3 API Reference-Spectra BlackPearl Nearline Gateway
- 558 -



Chapter 13 - Storage Domain Operations Get Storage Domain

Requests

Syntax
DELETE http[s]://{datapathDNSname}/_rest_/storage_domain_member/{storage domain

member UUID or other unique attribute}/

To determine the UUID for a storage domain member, see Get Storage Domain Members on
page 569.

Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 403: Access Denied
• 404: Not Found

Example

Sample Request
This request deletes the storage domain member with the UUID 6aaf58ad-c3f9-4f8a-aefa-
11fd91640b7b.
DELETE http[s]://blackpearl-hostname/_rest_/storage_domain_member/6aaf58ad-c3f9-

4f8a-aefa-11fd91640b7b/ HTTP/1.1

Sample Response
HTTP/1.1 204 No Content

GET STORAGE DOMAIN

Description
Get information about the specified storage domain.
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Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/storage_domain/{storage domain UUID, name, or

other unique attribute}/

To determine the UUID for a storage domain, see Get Storage Domains on page 573.

Responses

Response Elements
<Data>

   <AutoEjectMediaFullThreshold>

{64-bit integer}

   </AutoEjectMediaFullThreshold>

   <AutoEjectUponCron>{string}</AutoEjectUponCron>
   <AutoEjectUponJobCancellation>

      TRUE|FALSE

   </AutoEjectUponJobCancellation>

   <AutoEjectUponJobCompletion>

      TRUE|FALSE

   </AutoEjectUponJobCompletion>
   <AutoEjectUponMediaFull>

      TRUE|FALSE

   </AutoEjectUponMediaFull>

   <Id>{string}</Id>

   <LtfsFileNaming>OBJECT_ID|OBJECT_NAME</LtfsFileNaming>

   <MaxTapeFragmentationPercent>

{32-bit integer}

   </MaxTapeFragmentationPercent>
   <MaximumAutoVerificationFrequencyInDays>

{32-bit integer}

   </MaximumAutoVerificationFrequencyInDays>

   <MediaEjectionAllowed>

      TRUE|FALSE

   </MediaEjectionAllowed>
   <Name>{string}</Name>
   <SecureMediaAllocation>TRUE|FALSE</SecureMediaAllocation>
   <VerifyPriorToAutoEject>

      CRITICAL|URGENT|HIGH|NORMAL|LOW|BACKGROUND

   </VerifyPriorToAutoEject>

   <WriteOptimization>CAPACITY|PERFORMANCE</WriteOptimization>

</Data>
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where the response elements are defined as follows:

Parameter Description

Data The container for the response.

AutoEjectMedia FullThreshold The minimum available capacity (in bytes) at which media is
not considered full and eligible for auto-eject.

AutoEjectUpon Cron The CRON expression that indicate when to auto eject tape
cartridges. If set, a CRON job is created based on the CRON
string specified. Once the CRON job is executed, all tape
cartridges assigned to the storage domain, not already
pending ejection are queued for ejection.

AutoEjectUponJobCancellation Whether all media assigned to the storage domain, not
already pending ejection, is queued for ejection whenever a
job is canceled.
Values: TRUE, FALSE

AutoEjectUponJobCompletion Whether all media assigned to the storage domain, not
already pending ejection, is queued for ejection whenever a
job completes.
Values: TRUE, FALSE

AutoEjectUpon MediaFull Whether all media assigned to the storage domain, not
already pending ejection, is queued for ejection whenever the
media cannot fit the amount of data specified by
AutoEjectMediaFullThreshold.
Values: TRUE, FALSE

Id The UUID for the storage domain.

LtfsFileNaming The LTFS file naming mode used on tapes in the storage
domain. Values: OBJECT_ID, OBJECT_NAME. See ltfs_file_
naming on page 548 for descriptions.

MaxTape Fragmentation Percent Obsolete parameter.

MaximumAuto Verification
FrequencyInDays

The number of days since the last verification when a piece of
unchanged media is not considered for verification.
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Parameter Description

SecureMedia Allocation Whether media must remain within the storage domain.
Values:
• TRUE — Media assigned to the storage domain can only be
reclaimed for use within the same storage domain.

• FALSE — Media assigned to a storage domain can be
reclaimed into the general pool if all data on the media is
deleted.

VerifyPriorToAuto Eject The priority for verifying tapes being ejected automatically
due to any of the auto-eject triggers. The priority is null if
verification is not required prior to ejection. The priority
determines the resources assigned and the processing order.
Values: CRITICAL, URGENT, HIGH, NORMAL, LOW,
BACKGROUND

WriteOptimization Whether job chunks are written as quickly as possible
(PERFORMANCE) or across as few pieces of media as possible
(CAPACITY).
Values: CAPACITY, PERFORMANCE

Example

Sample Request
This request gets information about the storage domain with the name “sd1”.
GET http://blackpearl-hostname/_rest_/storage_domain/sd1/ HTTP/1.1
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Sample Response
HTTP/1.1 200 OK

<Data>

   <AutoEjectMediaFullThreshold/>

   <AutoEjectUponCron/>

   <AutoEjectUponJobCancellation>

      FALSE

   </AutoEjectUponJobCancellation>

   <AutoEjectUponJobCompletion>FALSE</AutoEjectUponJobCompletion>

   <AutoEjectUponMediaFull>FALSE</AutoEjectUponMediaFull>

   <Id>30313cfa-f8b2-4093-830c-3c8d06db6f6b</Id>

   <LtfsFileNaming>OBJECT_ID</LtfsFileNaming>

   <MaxTapeFragmentationPercent/>

   <MaximumAutoVerificationFrequencyInDays>

      365

   </MaximumAutoVerificationFrequencyInDays>

   <MediaEjectionAllowed>TRUE</MediaEjectionAllowed>

   <Name>sd1</Name>
   <SecureMediaAllocation>FALSE</SecureMediaAllocation>

   <VerifyPriorToAutoEject/>

   <WriteOptimization>CAPACITY</WriteOptimization>

</Data>

GET STORAGE DOMAIN FAILURES

Description
Get information about all storage domain failures, such as not having enough media to
allocate to the storage domain to complete a PUT job. Use parameters as selection criteria to
return a subset of the list.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/storage_domain_failure/[?error_message=

{string}][&last_page][&page_length={32-bit integer}][&page_offset={32-bit integer}]

[&page_start_marker={string}][&storage_domain_id={string}][&type=ILLEGAL_EJECTION_

OCCURRED|LAST_FREE_MEDIA_ALLOCATED|MEMBER_BECAME_READ_ONLY|WRITES_STALLED_DUE_TO_NO_

FREE_MEDIA_REMAINING]

April 2023 DS3 API Reference-Spectra BlackPearl Nearline Gateway
- 563 -



Chapter 13 - Storage Domain Operations Get Storage Domain Failures

Request Parameters 

Parameter Description Required

error_
message

The text of the error message. no

last_page If included, only the last page of results is returned. no

page_length The maximum number of storage domain failures to list.
Default: all items after page_offset.

no

page_offset The starting point for the first storage domain failure to list. Default:
0.

no

page_start_
marker

The UUID or other unique attribute for the item just before the first
item to list.
Notes:
• Specifying both page_offset and page_start_marker causes
an error.

• If neither page_offset, nor page_start_marker are specified,
the page_offset default is used.

no

storage_
domain_id

Storage domain UUID, name, or other unique attribute. To
determine the UUID for a storage domain, see Get Storage Domains
on page 573.

no

type The type of tape error message.
Values: ILLEGAL_EJECTION_OCCURRED, LAST_FREE_MEDIA_
ALLOCATED, MEMBER_BECAME_READ_ONLY, WRITES_STALLED_
DUE_TO_NO_FREE_MEDIA_REMAINING

no
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Responses

Response Elements
<Data>

   <StorageDomainFailure>

      <Date>YYYY-MM-DDThh:mm:ss.xxxZ</Date>

      <ErrorMessage>{string}</ErrorMessage>

      <Id>{string}</Id>

      <StorageDomainId>{string}</StorageDomainId>

      <Type>

         ILLEGAL_EJECTION_OCCURRED|LAST_FREE_MEDIA_ALLOCATED|

         MEMBER_BECAME_READ_ONLY|

         WRITES_STALLED_DUE_TO_NO_FREE_MEDIA_REMAINING

      </Type>

   </StorageDomainFailure>

   ...

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

StorageDomain
Failure

The container for information about one storage domain failure.

Date The date and time the error occurred in the format
YYYY-MM-DDThh:mm:ss.xxxZ

ErrorMessage A description of the error.

Id The UUID for the error message.

StorageDomainId The UUID for the storage domain that had the failure.

Type The type of tape error message.
Values: ILLEGAL_EJECTION_OCCURRED, LAST_FREE_MEDIA_ALLOCATED,
MEMBER_BECAME_READ_ONLY, WRITES_STALLED_DUE_TO_NO_FREE_
MEDIA_REMAINING
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Example

Sample Request
This request gets information about all storage domain failures.
GET http://blackpearl-hostname/_rest_/storage_domain_failure/ HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>

   <StorageDomainFailure>

   <Date>2016-05-17T14:18:01.000Z</Date>

   <ErrorMessage>{error text}</ErrorMessage>

   <Id>4b4aebcd-a5e7-4157-8de1-7598f01b9ed9</Id>

   <StorageDomainId>

      d479e099-6cf7-4f92-9add-1122b7467769

   </StorageDomainId>

   <Type>ILLEGAL_EJECTION_OCCURRED</Type>

   </StorageDomainFailure>

   ...

</Data>

GET STORAGE DOMAIN MEMBER

Description
Get information about the specified storage domain member.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/storage_domain_member/{storage domain member

UUID or other unique attribute}/

To determine the UUID for a storage domain member, see Get Storage Domain Members on
page 569.
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Responses

Response Elements
<Data>

   <AutoCompactionThreshold>

{32-bit integer}

   </AutoCompactionThreshold>

   <Id>{string}</Id>

   <PoolPartitionId>{string}</PoolPartitionId>

   <State>NORMAL|EXCLUSION_IN_PROGRESS</State>

   <StorageDomainId>{string}</StorageDomainId>

   <TapePartitionId>{string}</TapePartitionId>

   <TapeType>

      LTO5|LTO6|LTO7|LTO8|LTOM8|LTO9|LTO_CLEANING_TAPE|TS_JC|TS_JD|

      TS_JE|TS_JK|TS_JL|TS_JM|TS_JV|TS_JY|TS_JZ|TS_CLEANING_TAPE

      |UNKNOWN|FORBIDDEN

   </TapeType>

   <WritePreference>

      HIGH|NORMAL|LOW|NEVER_SELECT

   </WritePreference>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

AutoCompaction
Threshold

The percentage of a tape with deleted objects at which auto compaction is
triggered.

Id The UUID for the storage domain member.

PoolPartitionId The UUID for the pool partition.

State The state of the pool partition member. Values:
• NORMAL — The storage domain member is included normally.
• EXCLUSION_IN_PROGRESS — The storage domain member is in the
process of being excluded (data that resides on it is being copied to other
storage domain members).

StorageDomainId The UUID for the storage domain to which the pool partition or tape
partition is a member.
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Parameter Description

TapePartitionId The UUID for the tape partition.

TapeType The type of tape used by this tape storage domain member.
Values: LTO5, LTO6, LTO7, LTO8, LTOM8, LTO9, LTO_CLEANING_TAPE, TS_
JC, TS_JD, TS_JE, TS_JK, TS_JL, TS_JM, TS_JV, TS_JY, TS_JZ, TS_CLEANING_
TAPE, UNKNOWN, FORBIDDEN

WritePreference The preferred usage of the pool partition when additional capacity is
needed. The BlackPearl gateway uses a partition with HIGH write_
preference before a partition with a NORMAL write_preference, and
so on. A value of NEVER_SELECT indicates that the partition is read-only.
Values: HIGH, NORMAL, LOW, NEVER_SELECT

Example

Sample Request
This request gets information about the pool partition storage domain member with the
UUID 447a0e5c-ce75-43b4-ac43-a0f47bd9581b.
GET http://blackpearl-hostname/_rest_/storage_domain_member/447a0e5c-ce75-43b4-ac43-

a0f47bd9581b/ HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>
   <AutoCompactionThreshold>20</AutoCompactionThreshold>

   <Id>447a0e5c-ce75-43b4-ac43-a0f47bd9581b</Id>

   <PoolPartitionId>

      70effe58-0fdc-43a8-8d3e-9a3ef438388e

   </PoolPartitionId>

   <State>NORMAL</State>

   <StorageDomainId>

      b52ce963-aa09-4b21-b104-7be3060fdbb1

   </StorageDomainId>

   <TapePartitionId/>

   <TapeType/>

   <WritePreference>NORMAL</WritePreference>

</Data>
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GET STORAGE DOMAIN MEMBERS

Description
Get information about all storage domain members. Use parameters as selection criteria to
return a subset of the list.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/storage_domain_member/[?last_page][&page_

length={32-bit integer}][&page_offset={32-bit integer}][&page_start_marker={string}]

[&pool_partition_id={string}][&state={NORMAL|EXCLUSION_IN_PROGRESS}][&storage_

domain_id={string}][&tape_partition_id={string}][&tape_

type=LTO5|LTO6|LTO7|LTO8|LTOM8|LTO9|LTO_CLEANING_TAPE|TS_JC|TS_JD|TS_JE|TS_JK|TS_

JL|TS_JM|TS_JV|TS_JY|TS_JZ|TS_CLEANING_TAPE|UNKNOWN|FORBIDDEN][&write_

preference=HIGH|NORMAL|LOW|NEVER_SELECT]

Request Parameters 

Parameter Description Required

last_page If included, only the last page of results is returned. no

page_length The maximum number of storage domain members to list.
Default: all items after page_offset.

no

page_offset The starting point for the first storage domain member to list.
Default: 0.

no

page_start_
marker

The UUID or other unique attribute for the item just before the first
item to list.
Notes:
• Specifying both page_offset and page_start_marker causes
an error.

• If neither page_offset, nor page_start_marker are
specified, the page_offset default is used.

no

pool_
partition_id

The UUID for the pool partition assigned as a member. no
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Parameter Description Required

state The state of the storage domain member. Values:
• NORMAL — List storage domain members in Normal state.
• EXCLUSION_IN_PROGRESS — List storage domain members in
the process of being excluded (data that resides on it is being
copied to other storage domain members).

no

storage_
domain_id

The UUID for the storage domain to which the storage domain
member is assigned.

no

tape_
partition_id

Tape partition UUID, name, or other unique attribute. no

tape_type The tape media type.
Values: LTO5, LTO6, LTO7, LTO8, LTOM8, LTO9, LTO_CLEANING_
TAPE, TS_JC, TS_JD, TS_JE, TS_JK, TS_JL, TS_JM, TS_JV, TS_JY, TS_
JZ, TS_CLEANING_TAPE, UNKNOWN, FORBIDDEN

no

write_
preference

The preferred usage of the tape partition when additional capacity
is needed. The BlackPearl gateway uses a partition with HIGH
write_preference before a partition with a NORMAL write_
preference, and so on. A value of NEVER_SELECT indicates that
the partition is read-only.
Values: HIGH, NORMAL, LOW, NEVER_SELECT

no

Responses

Response Elements
<Data>

   <StorageDomainMember>

      <Id>{string}</Id>

      <PoolPartitionId>{string}</PoolPartitionId>

      <State>NORMAL|EXCLUSION_IN_PROGRESS</State>

      <StorageDomainId>{string}</StorageDomainId>

      <TapePartitionId>{string}</TapePartitionId>
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      <TapeType>

         LTO5|LTO6|LTO7|LTO8|LTOM8|LTO9|LTO_CLEANING_TAPE|TS_JC

         |TS_JD|TS_JE|TS_JK|TS_JL|TS_JM|TS_JV|TS_JY|TS_JZ|

         TS_CLEANING_TAPE|UNKNOWN|FORBIDDEN

      </TapeType>

      <WritePreference>

         HIGH|NORMAL|LOW|NEVER_SELECT

      </WritePreference>

   </StorageDomainMember>

   ...

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

AutoCompaction
Threshold

The percentage of a tape with deleted objects at which auto compaction is
triggered.

StorageDomain
Member

The container for information about one storage domain member.

Id The UUID for the storage domain member.

PoolPartitionId The UUID for the pool partition.

StorageDomainId The UUID for the storage domain to which the pool partition or tape
partition is a member.

State The state of the pool partition member. Values:
• NORMAL — The storage domain member is included normally.
• EXCLUSION_IN_PROGRESS — The storage domain member is in the
process of being excluded (data that resides on it is being copied to other
storage domain members).

TapePartitionId The UUID for the tape partition.

TapeType The type of tape used by this tape storage domain member.
Values: LTO5, LTO6, LTO7, LTO8, LTOM8, LTO9, LTO_CLEANING_TAPE, TS_
JC, TS_JD, TS_JE, TS_JK, TS_JL, TS_JM, TS_JV, TS_JY, TS_JZ, TS_CLEANING_
TAPE, UNKNOWN, FORBIDDEN
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Parameter Description

WritePreference The preferred usage of the pool partition when additional capacity is
needed. The BlackPearl gateway uses a partition with HIGH write_
preference before a partition with a NORMAL write_preference, and
so on. A value of NEVER_SELECT indicates that the partition is read-only.
Values: HIGH, NORMAL, LOW, NEVER_SELECT

Example

Sample Request
This request gets information about all storage domain members on the BlackPearl gateway.
GET http://blackpearl-hostname/_rest_/storage_domain_member/ HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>

   <StorageDomainMember>

      <AutoCompactionThreshold>20</AutoCompactionThreshold>

      <Id>c3e680ac-8426-4424-bdcc-e5a6b0d66638</Id>

      <PoolPartitionId>

         f58631f4-db97-4686-850f-5db17d509625

      </PoolPartitionId>
      <State>NORMAL</State>

      <StorageDomainId>

         aca7aecf-5bf6-4b03-bb7d-996df3963f39

      </StorageDomainId>

      <TapePartitionId/>

      <TapeType/>

      <WritePreference>NORMAL</WritePreference>

   </StorageDomainMember>
   <StorageDomainMember>

      <AutoCompactionThreshold>20</AutoCompactionThreshold>

      <Id>d9a2f5c6-19b8-4818-9b89-495190a4b0f3</Id>

      <PoolPartitionId/>

      <State>NORMAL</State>

      <StorageDomainId>

         a3f0888c-9d0c-455c-ae8c-050970c2dab9

      </StorageDomainId>
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      <TapePartitionId>

         8fff1c7e-8a3e-4e00-8b16-8585b130300f

      </TapePartitionId>

      <TapeType>LTO5</TapeType>

      <WritePreference>HIGH</WritePreference>

   </StorageDomainMember>

</Data>

GET STORAGE DOMAINS

Description
Get information about all storage domains. Use parameters as selection criteria to return a
subset of the list.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/storage_domain/[?auto_eject_upon_cron=

{string}][&auto_eject_upon_job_cancellation=TRUE|FALSE][&auto_eject_upon_job_

completion=TRUE|FALSE][&auto_eject_upon_media_full=TRUE|FALSE][&last_page][&media_

ejection_allowed=TRUE|FALSE][&name={string}][&page_length={32-bit integer}][&page_

offset={32-bit integer}][&page_start_marker={string}][&secure_media_

allocation=TRUE|FALSE][&write_optimization=CAPACITY|PERFOMRANCE]

Request Parameters 

Parameter Description Required

auto_eject_
upon_ cron

A CRON expression to indicate when to auto eject tape
cartridges.

no

auto_eject_
upon_ job_
cancellation

Whether all media assigned to the storage domain, not already
pending ejection, is queued for ejection whenever a job is
canceled.
Values: TRUE, FALSE (default)

no
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Parameter Description Required

auto_eject_
upon_ job_
completion

Whether all media assigned to the storage domain, not already
pending ejection, is queued for ejection whenever a job completes.
Values: TRUE, FALSE (default)

no

auto_eject_
upon_media_
full

Whether all media assigned to the storage domain, not already
pending ejection, is queued for ejection whenever the media
cannot fit the amount of data specified by auto_eject_media_
full_threshold.
Values: TRUE, FALSE (default)

no

last_page If included, only the last page of results is returned. no

media_
ejection_
allowed

Whether the storage domain or a piece of media assigned to the
storage domain, can be ejected from the BlackPearl gateway
without generating a failure.
Values: TRUE (default), FALSE

no

name The name for the storage domain. no

page_length The maximum number of storage domains to list.
Default: all items after page_offset.

no

page_offset The starting point for the first storage domain to list.
Default: 0.

no

page_start_
marker

The UUID or other unique attribute for the item just before the
first item to list.
Notes:
• Specifying both page_offset and page_start_marker
causes an error.

• If neither page_offset, nor page_start_marker are
specified, the page_offset default is used.

no

secure_media_
allocation

Whether media must remain within the storage domain.
Values:
• TRUE — Media assigned to the storage domain can only be
reclaimed for use within the same storage domain.

• FALSE (default) — Media assigned to a storage domain can be
reclaimed into the general pool if all data on the media is
deleted.

no
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Parameter Description Required

write_
optimization

Whether job chunks are written as quickly as possible or across as
few pieces of media as possible. For example, when
PERFORMANCE mode is set for a tape partition, job chunks are
written as quickly as possible, using all tape drive resources, even
if that means that more tapes are allocated to the storage domain
than are necessary to write the data.
Values: CAPACITY (default), PERFORMANCE

no

Responses

Response Elements
<Data>

   <StorageDomain>

      <AutoEjectMediaFullThreshold>

{64-bit integer}

      </AutoEjectMediaFullThreshold>

      <AutoEjectUponCron>{string}</AutoEjectUponCron>

      <AutoEjectUponJobCancellation>

         TRUE|FALSE

      </AutoEjectUponJobCancellation>
      <AutoEjectUponJobCompletion>

         TRUE|FALSE

      </AutoEjectUponJobCompletion>

      <AutoEjectUponMediaFull>

         TRUE|FALSE

      </AutoEjectUponMediaFull>
      <Id>{string}</Id>

      <LtfsFileNaming>OBJECT_ID|OBJECT_NAME</LtfsFileNaming>
      <MaxTapeFragmentationPercent>

{32-bit integer}

      </MaxTapeFragmentationPercent>
      <MaximumAutoVerificationFrequencyInDays>

{32-bit integer}

      </MaximumAutoVerificationFrequencyInDays>

      <MediaEjectionAllowed>

         TRUE|FALSE

      </MediaEjectionAllowed>

      <Name>{string}</Name>
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      <SecureMediaAllocation>TRUE|FALSE</SecureMediaAllocation>

      <VerifyPriorToAutoEject>

         CRITICAL|URGENT|HIGH|NORMAL|LOW|BACKGROUND

      </VerifyPriorToAutoEject>

      <WriteOptimization>CAPACITY|PERFORMANCE</WriteOptimization>

   </StorageDomain>

   ...

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

StorageDomain The container for information about one storage domain.

AutoEjectMedia FullThreshold The minimum available capacity (in bytes) at which media is
not considered full and eligible for auto-eject.

AutoEjectUpon Cron The CRON expression that indicate when to auto eject tape
cartridges. If set, a CRON job is created based on the CRON
string specified. Once the CRON job is executed, all tape
cartridges assigned to the storage domain, not already
pending ejection are queued for ejection.

AutoEjectUponJobCancellation Whether all media assigned to the storage domain, not
already pending ejection, is queued for ejection whenever a
job is canceled.
Values: TRUE, FALSE

AutoEjectUponJobCompletion Whether all media assigned to the storage domain, not
already pending ejection, is queued for ejection whenever a
job completes.
Values: TRUE, FALSE

AutoEjectUpon MediaFull Whether all media assigned to the storage domain, not
already pending ejection, is queued for ejection whenever the
media cannot fit the amount of data specified by
AutoEjectMediaFullThreshold.
Values: TRUE, FALSE

Id The UUID for the storage domain.

LtfsFileNaming The LTFS file naming mode used on tapes in the storage
domain. Values: OBJECT_ID, OBJECT_NAME. See ltfs_file_
naming on page 548 for descriptions.
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Parameter Description

MaxTape Fragmentation Percent Obsolete parameter.

MaximumAuto Verification
FrequencyInDays

The number of days since the last verification when a piece of
unchanged media is not considered for verification.

Name The name of the storage domain.

SecureMedia Allocation Whether media must remain within the storage domain.
Values:
• TRUE — Media assigned to the storage domain can only be
reclaimed for use within the same storage domain.

• FALSE — Media assigned to a storage domain can be
reclaimed into the general pool if all data on the media is
deleted.

VerifyPriorToAuto Eject The priority for verifying tapes being ejected automatically
due to any of the auto-eject triggers. The priority is null if
verification is not required prior to ejection. The priority
determines the resources assigned and the processing order.
Values: CRITICAL, URGENT, HIGH, NORMAL, LOW,
BACKGROUND

WriteOptimization Whether job chunks are written as quickly as possible
(PERFORMANCE) or across as few pieces of media as possible
(CAPACITY).
Values: CAPACITY, PERFORMANCE

Example

Sample Request
This request gets information about all storage domains on the BlackPearl gateway.
GET http://blackpearl-hostname/_rest_/storage_domain/ HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>

   <StorageDomain>

      <AutoEjectMediaFullThreshold/>

      <AutoEjectUponCron/>

      <AutoEjectUponJobCancellation>

         FALSE

      </AutoEjectUponJobCancellation>
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      <AutoEjectUponJobCompletion>

         FALSE

      </AutoEjectUponJobCompletion>

      <AutoEjectUponMediaFull>FALSE</AutoEjectUponMediaFull>

      <Id>b5ef719c-a455-4527-a7b6-6a4780c3f67f</Id>

      <LtfsFileNaming>OBJECT_ID</LtfsFileNaming>

      <MaxTapeFragmentationPercent/>
      <MaximumAutoVerificationFrequencyInDays/>

      <MediaEjectionAllowed>TRUE</MediaEjectionAllowed>

      <Name>sd1</Name>

      <SecureMediaAllocation>FALSE</SecureMediaAllocation>

      </VerifyPriorToAutoEject>

      <WriteOptimization>CAPACITY</WriteOptimization>

   </StorageDomain>

   ...

</Data>

MODIFY STORAGE DOMAIN

Description
Modify a storage domain.

Note: If an optional request parameter is not included, the previous setting is retained.

Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/storage_domain/{storage domain UUID, name, or

other unique attribute}/[?auto_eject_media_full_threshold={64-bit integer}][&auto_

eject_upon_cron={string}][&auto_eject_upon_job_cancellation=TRUE|FALSE][&auto_eject_

upon_job_completion=TRUE|FALSE][&auto_eject_upon_media_full=TRUE|FALSE][&ltfs_file_

naming=OBJECT_NAME|OBJECT_ID][&max_tape_fragmentation_percent={32-bit integer}]

[&maximum_auto_verification_frequency_in_days={32-bit integer}][&media_ejection_

allowed=TRUE|FALSE][&name={string}][&secure_media_allocation=TRUE|FALSE][&verify_

prior_to_auto_eject=CRITICAL|URGENT|HIGH|NORMAL|LOW|BACKGROUND][&write_

optimization=CAPACITY|PERFORMANCE]

To determine the UUID for a storage domain, see Get Storage Domains on page 573.
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Request Parameters

Parameter Description Required

auto_eject_
media_full_
threshold

The minimum available capacity (in bytes) at which media is
not considered full and eligible for auto-eject. If not
configured, the auto-eject threshold is computed based on the
preferred chunk size.

no

auto_eject_upon_
cron

A CRON expression to indicate when to auto eject media. If
set, a CRON job will be created based on the CRON string
specified. Once the CRON job is executed, all media assigned
to the storage domain not already pending ejection is queued
for ejection.
Note: This parameter is only valid if media_ejection_
allowed=TRUE.

no

auto_eject_upon_
job_cancellation

Determines whether all media assigned to the storage domain,
not already pending ejection, is queued for ejection whenever a
job is canceled.
Note: This parameter is only valid if media_ejection_
allowed=TRUE.

Values: TRUE, FALSE

no

auto_eject_upon_
job_completion

Determines whether all media assigned to the storage domain,
not already pending ejection, is queued for ejection whenever a
job completes.
Note: This parameter is only valid if media_ejection_
allowed=TRUE.

Values: TRUE, FALSE

no

auto_eject_upon_
media_full

Determines whether all media assigned to the storage domain,
not already pending ejection, is queued for ejection whenever
the media cannot fit the amount of data specified by auto_
eject_media_full_threshold.
Note: This parameter is only valid if media_ejection_
allowed=TRUE.

Values: TRUE, FALSE

no
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Parameter Description Required

ltfs_file_naming Determines the LTFS file naming mode used on tapes in the
storage domain. Values:
• Object Name — LTFS file names use the format {bucket
name}/{object name}, for example bucket1/video1.mov. Object
names must comply with LTFS file naming rules. If the tapes
are ejected from the BlackPearl gateway and loaded into a
non-BlackPearl tape partition, the file names match the
object names.

Notes:
• The colon character (:) is not allowed in LTFS file names
and therefore not allowed in BlackPearl object names.
The slash character (/) is also technically not allowed in
LTFS file names; however, the BlackPearl software can
accommodate a slash in the object name and translates it
as a directory in the LTFS file system (for example,
directory1/directory2/video1.mov).

• Spectra Logic does not recommend the following
characters in LTFS file names or BlackPearl object names
for reasons of cross-platform compatibility: control
characters such as carriage return (CR) and line feed
(LF), double quotation mark (“), asterisk (*), question
mark (?), less than sign (<), greater than sign (>),
backslash (\), forward slash (/) vertical line (|).

• Object ID — LTFS file names use the format {bucket name}/
{object id}, for example bucket1/1fc6f09c-dd72-41ea-8043-
0491ab8a6d82. Object names do not need to comply with
LTFS file naming rules. The BlackPearl gateway saves object
names as LTFS extended attributes allowing any third party
application to reconstruct all the data including the object
names.

no

max_tape_
fragmentation_
percent

Not currently used. no

maximum_auto_
verification_
frequency_in_
days

The number of days since the last verification when a piece of
unchanged media is not considered for verification.

no
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Parameter Description Required

media_ejection_
allowed

Whether the storage domain or a piece of media assigned to
the storage domain, can be ejected from the BlackPearl
gateway without generating a failure.
Values: TRUE, FALSE

no

name The name for the storage domain. no

secure_media_
allocation

Whether media must remain within the storage domain.
Note: secure_media_allocation should only be set to
TRUE when, for compliance purposes, the user must be certain
which media ever contained any data for the storage domain
(usually, to physically destroy the media once the data is no
longer needed), or to force rotating through media when new
backups are created and old backups are deleted.
Values:
• TRUE — Media assigned to the storage domain can only be
reclaimed for use within the same storage domain.

• FALSE (default) — Media assigned to a storage domain can
be reclaimed into the general pool if all data on the media is
deleted.

no

verify_prior_to_
auto_eject

The priority for verifying tapes being ejected automatically due
to any of the auto-eject triggers. The priority is null if
verification is not required prior to ejection. The priority
determines the resources assigned and the processing order.
Values: CRITICAL, URGENT, HIGH, NORMAL, LOW,
BACKGROUND

no

write_
optimization

Specifies whether job chunks are written as quickly as possible
or across as few pieces of media as possible. For example, when
PERFORMANCE mode is set for a tape partition, job chunks are
written as quickly as possible, using all tape drive resources,
even if that means that more tapes are allocated to the storage
domain than are necessary to write the data.
It is better to use CAPACITY mode if the tapes will be ejected
after the job completes or if the storage domain is written to
very rarely and capacity in the library is of concern.
PERFORMANCE mode is recommended in all other cases.
Values: CAPACITY, PERFORMANCE

no
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Responses

Response Elements
<Data>

   <AutoEjectMediaFullThreshold>

{64-bit integer}

   </AutoEjectMediaFullThreshold>

   <AutoEjectUponCron>{string}</AutoEjectUponCron>

   <AutoEjectUponJobCancellation>

      TRUE|FALSE

   </AutoEjectUponJobCancellation>
   <AutoEjectUponJobCompletion>

      TRUE|FALSE

   </AutoEjectUponJobCompletion>

   <AutoEjectUponMediaFull>

      TRUE|FALSE

   </AutoEjectUponMediaFull>

   <Id>{string}</Id>
   <LtfsFileNaming>OBJECT_ID|OBJECT_NAME</LtfsFileNaming>

   <MaxTapeFragmentationPercent>

{32-bit integer}

   </MaxTapeFragmentationPercent>

   <MaximumAutoVerificationFrequencyInDays>

{32-bit integer}

   </MaximumAutoVerificationFrequencyInDays>
   <MediaEjectionAllowed>

      TRUE|FALSE

   </MediaEjectionAllowed>

   <Name>{string}</Name>
   <SecureMediaAllocation>TRUE|FALSE</SecureMediaAllocation>

   <VerifyPriorToAutoEject>

      CRITICAL|URGENT|HIGH|NORMAL|LOW|BACKGROUND

   </VerifyPriorToAutoEject>

   <WriteOptimization>CAPACITY|PERFORMANCE</WriteOptimization>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.
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Parameter Description

AutoEjectMedia FullThreshold The minimum available capacity (in bytes) at which media is
not considered full and eligible for auto-eject.

AutoEjectUpon Cron The CRON expression that indicate when to auto eject tape
cartridges. If set, a CRON job is created based on the CRON
string specified. Once the CRON job is executed, all tape
cartridges assigned to the storage domain, not already
pending ejection are queued for ejection.

AutoEjectUponJobCancellation Whether all media assigned to the storage domain, not
already pending ejection, is queued for ejection whenever a
job is canceled.
Values: TRUE, FALSE

AutoEjectUponJobCompletion Whether all media assigned to the storage domain, not
already pending ejection, is queued for ejection whenever a
job completes.
Values: TRUE, FALSE

AutoEjectUpon MediaFull Whether all media assigned to the storage domain, not
already pending ejection, is queued for ejection whenever the
media cannot fit the amount of data specified by
AutoEjectMediaFullThreshold.
Values: TRUE, FALSE

Id The UUID for the storage domain.

LtfsFileNaming The LTFS file naming mode used on tapes in the storage
domain. Values: OBJECT_ID, OBJECT_NAME. See ltfs_file_
naming on page 548 for descriptions.

MaxTape Fragmentation Percent Obsolete parameter.

MaximumAuto Verification
FrequencyInDays

The number of days since the last verification when a piece of
unchanged media is not considered for verification.

Name The name of the storage domain.
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Parameter Description

SecureMedia Allocation Whether media must remain within the storage domain.
Values:
• TRUE — Media assigned to the storage domain can only be
reclaimed for use within the same storage domain.

• FALSE — Media assigned to a storage domain can be
reclaimed into the general pool if all data on the media is
deleted.

VerifyPriorToAuto Eject The priority for verifying tapes being ejected automatically
due to any of the auto-eject triggers. The priority is null if
verification is not required prior to ejection. The priority
determines the resources assigned and the processing order.
Values: CRITICAL, URGENT, HIGH, NORMAL, LOW,
BACKGROUND

WriteOptimization Whether job chunks are written as quickly as possible
(PERFORMANCE) or across as few pieces of media as possible
(CAPACITY).
Values: CAPACITY, PERFORMANCE

Example

Sample Request
This request modifies the storage domain with the name “sd1” to make
mediaEjectionAllowed=FALSE.
PUT http://blackpearl-hostname/_rest_/storage_domain/sd1/?mediaEjectionAllowed=FALSE

HTTP/1.1

Sample Response
HTTP/1.1 200 OK
<Data>

   <AutoEjectMediaFullThreshold/>

   <AutoEjectUponCron/>

   <AutoEjectUponJobCancellation>

      FALSE

   </AutoEjectUponJobCancellation>

   <AutoEjectUponJobCompletion>FALSE</AutoEjectUponJobCompletion>
   <AutoEjectUponMediaFull>FALSE</AutoEjectUponMediaFull>

   <Id>02e1db8f-db6f-4dd9-9c79-9ac1dd4aa3de</Id>

   <MaxTapeFragmentationPercent/>
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   <MaximumAutoVerificationFrequencyInDays>

      365

   </MaximumAutoVerificationFrequencyInDays>

   <MediaEjectionAllowed>FALSE</MediaEjectionAllowed>

   <Name>sd1</Name>

   <SecureMediaAllocation>FALSE</SecureMediaAllocation>

   </VerifyPriorToAutoEject>

   <WriteOptimization>CAPACITY</WriteOptimization>

</Data>

MODIFY STORAGE DOMAIN MEMBER

Description
Modify a storage domain member.

Note: If an optional request parameter is not included, the previous setting is retained.

Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/storage_domain_member/{storage domain member

UUID or other unique attribute}/[?auto_compaction_threshold={32-bit integer}]

[&state={NORMAL|EXCLUSION_IN_PROGRESS}][&write_preference=HIGH|NORMAL|LOW|NEVER_

SELECT]

To determine the UUID for a storage domain member, see Get Storage Domain Members on
page 569.

Request Parameters 

Parameter Description Required

auto_
compaction_
threshold

The percentage of a tape with deleted objects at which auto
compaction is triggered. The minimum is 10.

no
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Parameter Description Required

state The state of the storage domain member. Values:
• NORMAL — The storage domain member is included normally.
• EXCLUSION_IN_PROGRESS — Start the process of excluding the
storage domain member. Data that resides on it will be copied
to other storage domain members.

no

write_
preference

Determines the preferred usage of the tape partition when
additional capacity is needed. The BlackPearl gateway uses a
partition with HIGH write_preference before a partition with
a NORMAL write_preference, and so on. Use NEVER_SELECT
to indicate that the partition is read-only.
Note: The write_preference cannot be changed to NEVER_
SELECT if the storage domain is in use and there are no other
storage domain members assigned that have a higher write_
preference.
Values: HIGH, NORMAL, LOW, NEVER_SELECT

no

Responses

Response Elements
<Data>

   <AutoCompactionThreshold>

{32-bit integer}

   </AutoCompactionThreshold>

   <Id>{string}</Id>

   <PoolPartitionId>{string}</PoolPartitionId>

   <State>NORMAL|EXCLUSION_IN_PROGRESS</State>
   <StorageDomainId>{string}</StorageDomainId>

   <TapePartitionId>{string}</TapePartitionId>

   <TapeType>

      LTO5|LTO6|LTO7|LTO8|LTOM8|LTO9|LTO_CLEANING_TAPE|TS_JC|TS_JD|

      TS_JE|TS_JK|TS_JL|TS_JM|TS_JV|TS_JY|TS_JZ|TS_CLEANING_TAPE

      |UNKNOWN|FORBIDDEN

   </TapeType>
   <WritePreference>

      HIGH|NORMAL|LOW|NEVER_SELECT

   </WritePreference>

</Data>
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where the response elements are defined as follows:

Parameter Description

Data The container for the response.

AutoCompaction
Threshold

The percentage of a tape with deleted objects at which auto compaction is
triggered.

Id The UUID for the storage domain member.

PoolPartitionId The UUID for the pool partition.

State The state of the storage domain member. Values:
• NORMAL — The storage domain member is included normally.
• EXCLUSION_IN_PROGRESS — The storage domain member is in the
process of being excluded (data that resides on it is being copied to other
storage domain members).

StorageDomainId The UUID for the storage domain assigned the tape partition member.

TapePartitionId The UUID for the tape partition.

TapeType The type of tape used by this tape storage domain member.
Values: LTO5, LTO6, LTO7, LTO8, LTOM8, LTO9, LTO_CLEANING_TAPE, TS_
JC, TS_JD, TS_JE, TS_JK, TS_JL, TS_JM, TS_JV, TS_JY, TS_JZ, TS_CLEANING_
TAPE, UNKNOWN, FORBIDDEN

WritePreference The preferred usage of the tape partition when additional capacity is
needed. The BlackPearl gateway uses a partition with HIGH write_
preference before a partition with a NORMAL write_preference, and
so on. A value of NEVER_SELECT indicates that the partition is read-only.
Values: HIGH, NORMAL, LOW, NEVER_SELECT

Example

Sample Request
This request modifies the pool partition storage domain membership with UUID 4d5a08b9-
cf15-4f8a-a004-73f907071c86 to have write_preference=HIGH.
PUT http[s]://blackpearl-hostname/_rest_/storage_domain_member/4d5a08b9-cf15-4f8a-

a004-73f907071c86/?write_preference=HIGH HTTP/1.1
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Sample Response
HTTP/1.1 201 CREATED

<Data>

   <AutoCompactionThreshold>20</AutoCompactionThreshold>

   <Id>4d5a08b9-cf15-4f8a-a004-73f907071c86</Id>

   <PoolPartitionId>

      c9c12aee-2029-462a-b291-1c76426b3567

   </PoolPartitionId>
   <State>NORMAL</State>

   <StorageDomainId>

      aa3078cf-7e01-4e23-854a-648d04e7ae26

   </StorageDomainId>
   <TapePartitionId/>

   <TapeType/>

   <WritePreference>HIGH</WritePreference>

</Data>
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VOLUME E - HARDWARE OPERATIONS
This section describes operations that pertaining to the backend hardware.

• Node Operations on page 590

• Pool Operations on page 597

• Tape Library and Component Operations on page 658
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This chapter provides detailed information about operations you can perform on nodes. For
DS3, the nodes are individual BlackPearl gateways.

Get Node 590

Get Nodes 592

Modify Node 594

GET NODE

Description
Get information about the specified node (BlackPearl gateway).

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/node/{node UUID or other unique identifier}/

To determine the UUID for a node, see Get Nodes on page 592.

Responses

Response Elements
<Data>

   <DataPathHttpPort>{16-bit integer}</DataPathHttpPort>

   <DataPathHttpsPort>{16-bit integer}</DataPathHttpsPort>

   <DataPathIpAddress>{string}</DataPathIpAddress>

   <DnsName>{string}</DnsName>

   <Id>{string}</Id>

   <LastHeartbeat>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastHeartbeat>

   <Name>{string}</Name>

   <SerialNumber>{string}</SerialNumber>

</Data>
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where the response elements are defined as follows:

Parameter Description

Data A container for the response.

DataPathHttpPort The port used for HTTP. If not present in the response, then HTTP access
is not configured.

DataPathHttpsPort The port used for HTTPS. If not present in the response, then HTTPS
access is not configured.

DataPathIpAddress The IPv4 address for the BlackPearl data path.

DnsName The domain name for the BlackPearl gateway.

Id The UUID for the BlackPearl gateway.

LastHeartbeat The date and time that the gateway last sent a heartbeat in the format
YYYY-MM-DDThh:mm:ss.xxxZ.

Name The name for the BlackPearl gateway.

SerialNumber The serial number for the BlackPearl gateway.

Example

Sample Request
This request gets information about the node with the name EngineeringBP.
GET http://blackpearl-hostname/_rest_/node/EngineeringBP/ HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>

   <DataPathHttpPort/>

   <DataPathHttpsPort>443</DataPathHttpsPort>

   <DataPathIpAddress>10.1.16.1</DataPathIpAddress>

   <DnsName/>

   <Id>48db59bd-cd5d-481a-93a7-15caa0a8ab43</Id>

   <LastHeartbeat>2015-10-13 14:42:54.378</LastHeartbeat>

   <Name>EngineeringBP</Name>

   <SerialNumber>5003048001fff43f</SerialNumber>

</Data>
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GET NODES

Description
Gets information about all nodes in a single BlackPearl gateway instance or name space.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/node/[?last_page][&page_length=

{32-bit integer}][&page_offset={32-bit integer}][&page_start_marker={string}]

Request Parameters

Parameter Description Required

last_page If included, only the last page of results is returned. no

page_length The maximum number of nodes to list.
Default: all items after page_offset.

no

page_offset The starting point for the first node to list. Default: 0. no

page_start_
marker

The UUID or other unique attribute for the item just before the first
item to list.
Notes:
• Specifying both page_offset and page_start_marker causes
an error.

• If neither page_offset, nor page_start_marker are specified,
the page_offset default is used.

no
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Responses

Response Elements
<Data>

   <Node>

      <DataPathHttpPort>{16-bit integer}</DataPathHttpPort>

      <DataPathHttpsPort>{16-bit integer}</DataPathHttpsPort>

      <DataPathIpAddress>{string}</DataPathIpAddress>

      <DnsName>{string}</DnsName>

      <Id>{string}</Id>

      <LastHeartbeat>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastHeartbeat>

      <Name>{string}</Name>

      <SerialNumber>{string}</SerialNumber>

   </Node>

   ...

</Data>

where the response elements are defined as follows:

Parameter Description

Data A container for the response.

Node A container for information about one node.

DataPathHttpPort The port used for HTTP. If not present in the response, then HTTP access
is not configured.

DataPathHttpsPort The port used for HTTPS. If not present in the response, then HTTPS
access is not configured.

DataPathIpAddress The IPv4 address for the BlackPearl data path.

DnsName The domain name for the BlackPearl gateway.

Id The UUID for the BlackPearl gateway.

LastHeartbeat The date and time that the gateway last sent a heartbeat in the format
YYYY-MM-DDThh:mm:ss.xxxZ.

Name The name for the BlackPearl gateway.

SerialNumber The serial number for the BlackPearl gateway.
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Example

Sample Request
This request lists information about all nodes.
GET http://blackpearl-hostname/_rest_/node/ HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>

   <Node>

      <DataPathHttpPort/>

      <DataPathHttpsPort>443</DataPathHttpsPort>

      <DataPathIpAddress>10.1.16.1</DataPathIpAddress>

      <DnsName/>

      <Id>48db59bd-cd5d-481a-93a7-15caa0a8ab43</Id>

      <LastHeartbeat>2015-10-13 14:42:54.378</LastHeartbeat>

      <Name>EngineeringBP</Name>

      <SerialNumber>5003048001fff43f</SerialNumber>

   </Node>

   ...

</Data>

MODIFY NODE

Description
Modify the node name or domain name for a specified node.

Note: If an optional request parameter is not included, the previous setting is retained.

Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/node/{node UUID or other unique attribute}/

[?dns_name={string}][&name={string}]]

To determine the UUID for a node, see Get Nodes on page 592.
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Request Parameters

Parameter Description Required

dns_name The new domain name for the node.
Notes:
• If a domain name isn't configured for a node, its data path IP
address is used when the TCP/IP address of the node must be
given to a client.

• If a domain name is configured for a node, the domain name (or
IP address) is used, regardless of whether the data path IP
address changes after the domain name is configured.

• Configuring a DNS name is necessary whenever the data path IP
of the BlackPearl gateway is not the IP address that should be
used by clients who want to communicate with it (for example, if
a network address translation has been installed between clients
and the BlackPearl gateway).

no

name The new name for the node. no

Responses

Response Elements
<Data>

   <DataPathHttpPort>{16-bit integer}</DataPathHttpPort>

   <DataPathHttpsPort>{16-bit integer}</DataPathHttpsPort>

   <DataPathIpAddress>{string}</DataPathIpAddress>

   <DnsName>{string}</DnsName>

   <Id>{string}</Id>

   <LastHeartbeat>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastHeartbeat>

   <Name>{string}</Name>

   <SerialNumber>{string}</SerialNumber>

</Data>

where the response elements are defined as follows:

Parameter Description

Data A container for the response.

DataPathHttpPort The port used for HTTP. If not present in the response, then HTTP access
is not configured.
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Parameter Description

DataPathHttpsPort The port used for HTTPS. If not present in the response, then HTTPS
access is not configured.

DataPathIpAddress The IPv4 address for the BlackPearl data path.

DnsName The domain name for the BlackPearl gateway.

Id The UUID for the BlackPearl gateway.

LastHeartbeat The date and time that the gateway last sent a heartbeat in the format
YYYY-MM-DDThh:mm:ss.xxxZ.

Name The name for the BlackPearl gateway.

SerialNumber The serial number for the BlackPearl gateway.

Example

Sample Request
This request changes the name of the node with UUID 48db59bd-cd5d-481a-93a7-
15caa0a8ab43 to ProductionBP.
GET http://blackpearl-hostname/_rest_/node/48db59bd-cd5d-481a-93a7-

15caa0a8ab43/?name=ProductionBP HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>

   <DataPathHttpPort/>

   <DataPathHttpsPort>443</DataPathHttpsPort>

   <DataPathIpAddress>10.1.16.1</DataPathIpAddress>

   <DnsName/>

   <Id>48db59bd-cd5d-481a-93a7-15caa0a8ab43</Id>

   <LastHeartbeat>2015-10-13 14:42:54.378</LastHeartbeat>

   <Name>ProductionBP</Name>

   <SerialNumber>5003048001fff43f</SerialNumber>

</Data>
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This chapter provides detailed information about operations you can perform on pools and
pool partitions. A pool is a set of physical drives grouped together to create a single virtual
drive. A pool partition is a named collection of zero or more pools. A data partition (pool
partition or tape partition (see Tape Library and Component Operations on page 658) must
be added to a storage domains (see Storage Domain Operations on page 540) before it can be
used by the BlackPearl gateway.

Cancel Import of Pool 598

Cancel Import of Pools 602

Cancel Verify Pool 603

Cancel Verify On All Pools 606

Compact Pool 607

Compact Pools 611

Create Pool Partition 612

Deallocate Pool 614

Delete Permanently Lost Pool 615

Delete Pool Failure 616

Delete Pool Partition 617

Force Pool Environment Refresh 618

Format Foreign Pool 619

Format Foreign Pools 622

Get Object Parts on Pool 623

Get Pool 625

Get Pool Failures 628

Get Pool Partition 631

Get Pool Partitions 633

Get Pools 635

Import Pool 639

Import Pools 644

Modify Pool 646

Modify Pool Partition 649
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Modify Pools 651

Verify Pool 652

Verify Pools 656

CANCEL IMPORT OF POOL

Description
Cancels a pending pool import for the specified pool. If the import is in process, it cannot be
canceled.

Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/pool/{pool UUID or other unique

attribute}/?operation=CANCEL_IMPORT

To determine the UUID for a pool, see Get Pools on page 635.

Request Parameters

Parameter Description Required

operation The operation to perform. For this request, the operation is cancel
import. Value: CANCEL_IMPORT

yes
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Responses

Response Elements
<Data>

   <AssignedToStorageDomain>TRUE|FALSE</AssignedToStorageDomain>

   <AvailableCapacity>{64-bit integer}</AvailableCapacity>

   <BucketId>{string}</BucketId>

   <Guid>{string}</Guid>

   <Health>OK|DEGRADED</Health>

   <Id>{string}</Id>

   <LastAccessed>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastAccessed>

   <LastModified>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastModified>

   <LastVerified>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastVerified>

   <Mountpoint>/{string}</Mountpoint>

   <Name>{string}</Name>

   <PartitionId>{string}</PartitionId>

   <PoweredOn>TRUE|FALSE</PoweredOn>
   <Quiesced>NO|PENDING|YES</Quiesced>

   <ReservedCapacity>{64-bit integer}</ReservedCapacity>

   <State>

      NORMAL|FOREIGN|IMPORT_IN_PROGRESS|IMPORT_PENDING|LOST

   </State>
   <StorageDomainMemberId>{string}</StorageDomainMemberId>

   <TotalCapacity>{64-bit integer}</TotalCapacity>

   <Type>NEARLINE|ONLINE</Type>

   <UsedCapacity>{64-bit integer}</UsedCapacity>

</Data>

where the response elements are defined as follows:

Parameter Description

Data A container for the response.

AssignedToStorageDomain Whether the pool is currently assigned to a storage domain.
Values: TRUE, FALSE

AvailableCapacity The amount of unused capacity on the pool in bytes.

BucketId The UUID for the bucket to which the pool is assigned.

Guid The ZFS identifier for the pool.
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Parameter Description

Health Whether the pool is in good health or degraded.
Values: OK, DEGRADED

Id The UUID for the pool.

LastAccessed The last date and time the pool was accessed in the format
YYYY-MM-DDThh:mm:ss.xxxZ.

LastModified The last date and time an object in the pool was modified in the
format YYYY-MM-DDThh:mm:ss.xxxZ.

LastVerified The last date and time the checksum of the data was verified in
the format YYYY-MM-DDThh:mm:ss.xxxZ.

MountPoint The logical directory used by the BlackPearl gateway to access the
pool.

Name The name for the pool.

PartitionId The UUID of the pool partition.

PoweredOn Whether the pool is powered on. Values: TRUE, FALSE

Quiesced Whether the pool is in a temporarily inactive state. Values: NO,
PENDING, YES

ReservedCapacity The capacity reserved to ensure pool performance.

State The status of the pool. Values:
• NORMAL — The pool is ready for use.
• FOREIGN — A pool from another BlackPearl gateway. This data
must be copied into a bucket on this BlackPearl gateway before
it is accessible.

• IMPORT_IN_PROGRESS — A FOREIGN pool is in the process of
being imported into a bucket on this BlackPearl gateway.

• IMPORT_PENDING— A FOREIGN pool is waiting to be imported
into a bucket on this BlackPearl gateway.

• LOST — The pool was removed without first exporting it from a
bucket.

StorageDomain
MemberId

The UUID for the storage domain member.

TotalCapacity The total capacity of the pool including used, reserved and
available capacity.
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Parameter Description

Type The type of pool.
Values: NEARLINE (Deep Storage), ONLINE (High Performance)

UsedCapacity The amount of used capacity on the pool in bytes.

Example

Sample Request
This request cancels the pending pool import of the pool with the UUID 4a79a678-e187-44b3-
b137-aaa86683f228.
PUT http://blackpearl-hostname/_rest_/pool/4a79a678-e187-44b3-b137-

aaa86683f228/?operation=CANCEL_IMPORT HTTP/1.1

Sample Response
<Data>

   <AssignedToStorageDomain>FALSE</AssignedToStorageDomain>

   <AvailableCapacity>10000</AvailableCapacity>

   <BucketId/>

   <Guid>b9f05ae1-94f1-4d4d-ad4a-a89da2c41332</Guid>

   <Health>OK</Health>

   <Id>4a79a678-e187-44b3-b137-aaa86683f228</Id>

   <LastAccessed/>

   <LastModified/>

   <LastVerified/>

   <Mountpoint>/mountpoint-0</Mountpoint>

   <Name>pool0</Name>

   <PartitionId/>

   <PoweredOn>TRUE</PoweredOn>

   <Quiesced>NO</Quiesced>

   <ReservedCapacity>0</ReservedCapacity>

   <State>NORMAL</State>

   <StorageDomainMemberId/>

   <TotalCapacity>30000</TotalCapacity>

   <Type>NEARLINE</Type>

   <UsedCapacity>20000</UsedCapacity>

</Data>
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CANCEL IMPORT OF POOLS

Description
Cancel all pending pool imports. Pool imports that are in process are not canceled.

Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/pool/?operation=CANCEL_IMPORT

Request Parameters

Parameter Description Required

operation The operation to perform. For this request, the operation is cancel
import. Value: CANCEL_IMPORT

yes

Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 500: Internal Error

Example

Sample Request
This request cancels all pending pool imports.
PUT http://blackpearl-hostname/_rest_/pool/?operation=CANCEL_IMPORT HTTP/1.1

Sample Response
HTTP/1.1 204 No Content
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CANCEL VERIFY POOL

Description
Cancel a pending pool verification. You cannot cancel a pool verification that is in process.

Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/pool/{pool UUID or other unique

attribute}/?operation=CANCEL_VERIFY

To determine the UUID for a pool, see Get Pools on page 635.

Request Parameters

Parameter Description Required

operation The operation to perform. For this request, the operation is cancel
pool verification. Value: CANCEL_VERIFY

yes

Responses

Response Elements
<Data>
   <AssignedToStorageDomain>TRUE|FALSE</AssignedToStorageDomain>

   <AvailableCapacity>{64-bit integer}</AvailableCapacity>

   <BucketId>{string}</BucketId>

   <Guid>{string}</Guid>

   <Health>OK|DEGRADED</Health>

   <Id>{string}</Id>

   <LastAccessed>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastAccessed>

   <LastModified>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastModified>

   <LastVerified>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastVerified>

   <Mountpoint>/{string}</Mountpoint>
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   <Name>{string}</Name>

   <PartitionId>{string}</PartitionId>

   <PoweredOn>TRUE|FALSE</PoweredOn>

   <Quiesced>NO|PENDING|YES</Quiesced>

   <ReservedCapacity>{64-bit integer}</ReservedCapacity>

   <State>

      NORMAL|FOREIGN|IMPORT_IN_PROGRESS|IMPORT_PENDING|LOST

   </State>
   <StorageDomainMemberId>{string}</StorageDomainMemberId>

   <TotalCapacity>{64-bit integer}</TotalCapacity>

   <Type>NEARLINE|ONLINE</Type>

   <UsedCapacity>{64-bit integer}</UsedCapacity>
</Data>

where the response elements are defined as follows:

Parameter Description

Data A container for the response.

AssignedToStorageDomain Whether the pool is currently assigned to a storage domain.
Values: TRUE, FALSE

AvailableCapacity The amount of unused capacity on the pool in bytes.

BucketId The UUID for the bucket to which the pool is assigned.

Guid The ZFS identifier for the pool.

Health Whether the pool is in good health or degraded.
Values: OK, DEGRADED

Id The UUID for the pool.

LastAccessed The last date and time the pool was accessed in the format
YYYY-MM-DDThh:mm:ss.xxxZ.

LastModified The last date and time an object in the pool was modified in the
format YYYY-MM-DDThh:mm:ss.xxxZ.

LastVerified The last date and time the checksum of the data was verified in
the format YYYY-MM-DDThh:mm:ss.xxxZ.

MountPoint The logical directory used by the BlackPearl gateway to access the
pool.

Name The name for the pool.
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Parameter Description

PartitionId The UUID of the pool partition.

PoweredOn Whether the pool is powered on. Values: TRUE, FALSE

Quiesced Whether the pool is in a temporarily inactive state. Values: NO,
PENDING, YES

ReservedCapacity The capacity reserved to ensure pool performance.

State The status of the pool. Values: BLANK, NORMAL, FOREIGN,
IMPORT_IN_PROGRESS, IMPORT_PENDING, LOST. State on
page 600.

StorageDomain
MemberId

The UUID for the storage domain member.

TotalCapacity The total capacity of the pool including used, reserved, and
available capacity.

Type The type of pool.
Values: NEARLINE (Deep Storage), ONLINE (High Performance)

UsedCapacity The amount of used capacity on the pool in bytes.

Example

Sample Request
This request cancels the verification of the pool with the UUID 8b14538f-abc9-41f0-8be0-
bf124718f9d5.
PUT http://blackpearl-hostname/_rest_/pool/8b14538f-abc9-41f0-8be0-

bf124718f9d5/?operation=CANCEL_VERIFY HTTP/1.1

Sample Response
HTTP/1.1 200 OK
<Data>
   <AssignedToStorageDomain>FALSE</AssignedToStorageDomain>
   <AvailableCapacity>10000</AvailableCapacity>
   <BucketId/>
   <Guid>d740c8f5-3609-49c0-93c2-db0bd4645525</Guid>
   <Health>OK</Health>
   <Id>8b14538f-abc9-41f0-8be0-bf124718f9d5</Id>
   <LastAccessed/>
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   <LastModified/>
   <LastVerified/>
   <Mountpoint>/mountpoint-0</Mountpoint>
   <Name>pool0</Name>
   <PartitionId/>
   <PoweredOn>TRUE</PoweredOn>
   <Quiesced>NO</Quiesced>
   <ReservedCapacity>0</ReservedCapacity>
   <State>NORMAL</State>
   <StorageDomainMemberId/>
   <TotalCapacity>0</TotalCapacity>
   <Type>NEARLINE</Type>
   <UsedCapacity>20000</UsedCapacity>
</Data>

CANCEL VERIFY ON ALL POOLS

Description
Cancel all pending pool verifications. You cannot cancel a pool verification that is in process.

Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/pool/?operation=CANCEL_VERIFY

Request Parameters

Parameter Description Required

operation The operation to perform. For this request, the operation is cancel
pool verification. Value: CANCEL_VERIFY

yes
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Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 500: Internal Error

Example

Sample Request
This request cancels all pending pool verifications.
PUT http://blackpearl-hostname/_rest_/pool/?operation=CANCEL_VERIFY HTTP/1.1

Sample Response
HTTP/1.1 204 No Content

COMPACT POOL

Description
Pool compaction is periodically done automatically in the background. If the pool does not
contain data, it is reclaimed in its entirety and unassigned from its current storage domain.
This makes the pool available for allocation to any storage domain. If the pool cannot be
reclaimed in its entirety, its usage level is checked, and data that is eligible for deletion is
deleted as necessary to compact the pool so that it has space for new data.

Use this request to force a compaction to be scheduled immediately for a specified pool,
without having to wait for the automatic, periodic scheduling.

Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/pool/{pool UUID or other unique

attribute}/?operation=COMPACT[&priority=URGENT|HIGH|NORMAL|LOW]
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To determine the UUID for a pool, see Get Pools on page 635.

Request Parameters

Parameter Description Required

operation The operation to perform. For this request, the operation is to
compact the pool. Value: COMPACT

yes

priority The priority for processing this task. This determines the resources
assigned and the processing order.
Values: URGENT, HIGH, NORMAL, LOW

no

Responses

Response Elements
<Data>

   <AssignedToStorageDomain>TRUE|FALSE</AssignedToStorageDomain>

   <AvailableCapacity>{64-bit integer}</AvailableCapacity>

   <BucketId>{string}</BucketId>

   <Guid>{string}</Guid>

   <Health>OK|DEGRADED</Health>

   <Id>{string}</Id>

   <LastAccessed>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastAccessed>

   <LastModified>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastModified>

   <LastVerified>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastVerified>

   <Mountpoint>/{string}</Mountpoint>

   <Name>{string}</Name>

   <PartitionId>{string}</PartitionId>

   <PoweredOn>TRUE|FALSE</PoweredOn>

   <Quiesced>NO|PENDING|YES</Quiesced>

   <ReservedCapacity>{64-bit integer}</ReservedCapacity>

   <State>

      NORMAL|FOREIGN|IMPORT_IN_PROGRESS|IMPORT_PENDING|LOST

   </State>
   <StorageDomainMemberId>{string}</StorageDomainMemberId>

   <TotalCapacity>{64-bit integer}</TotalCapacity>

   <Type>NEARLINE|ONLINE</Type>

   <UsedCapacity>{64-bit integer}</UsedCapacity>

</Data>
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where the response elements are defined as follows:

Parameter Description

Data A container for the response.

AssignedToStorageDomain Whether the pool is currently assigned to a storage domain.
Values: TRUE, FALSE

AvailableCapacity The amount of unused capacity on the pool in bytes.

BucketId The UUID for the bucket to which the pool is assigned.

Health Whether the pool is in good health or degraded.
Values: OK, DEGRADED

Id The UUID for the pool.

LastAccessed The last date and time the pool was accessed in the format
YYYY-MM-DDThh:mm:ss.xxxZ.

LastModified The last date and time an object in the pool was modified in the
format YYYY-MM-DDThh:mm:ss.xxxZ.

LastVerified The last date and time the checksum of the data was verified in
the format YYYY-MM-DDThh:mm:ss.xxxZ.

MountPoint The logical directory used by the BlackPearl gateway to access the
pool.

Name The name for the pool.

PartitionId The UUID of the pool partition.

PoweredOn Whether the pool is powered on. Values: TRUE, FALSE

Quiesced Whether the pool is in a temporarily inactive state. Values: NO,
PENDING, YES

ReservedCapacity The capacity reserved for overhead.

State The status of the pool. Values: BLANK, NORMAL, FOREIGN,
IMPORT_IN_PROGRESS, IMPORT_PENDING, LOST. State on
page 600.

StorageDomain
MemberId

The UUID for the storage domain member.
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Parameter Description

TotalCapacity The total capacity of the pool including used, reserved and
available capacity.

Type The type of pool.
Values: NEARLINE (Deep Storage), ONLINE (High Performance)

UsedCapacity The amount of used capacity on the pool in bytes.

Example

Sample Request
This request compacts the pool with the UUID 77f3f144-be85-48ad-abd8-8e0f2d09f713.
PUT http://blackpearl-hostname/_rest_/pool/77f3f144-be85-48ad-abd8-

8e0f2d09f713/?operation=COMPACT HTTP/1.1

Sample Response
<Data>

   <AssignedToStorageDomain>FALSE</AssignedToStorageDomain>

   <AvailableCapacity>10000</AvailableCapacity>

   <BucketId/>

   <Guid>9a80574a-2a08-480e-98a6-ff0fa809987a</Guid>

   <Health>OK</Health>

   <Id>77f3f144-be85-48ad-abd8-8e0f2d09f713</Id>
   <LastAccessed/>

   <LastModified/>

   <LastVerified/>

   <Mountpoint>/mountpoint-0</Mountpoint>

   <Name>pool0</Name>
   <PartitionId/>

   <PoweredOn>TRUE</PoweredOn>

   <Quiesced>NO</Quiesced>

   <ReservedCapacity>0</ReservedCapacity>

   <State>NORMAL</State>
   <StorageDomainMemberId/>

   <TotalCapacity>30000</TotalCapacity>

   <Type>NEARLINE</Type>

   <UsedCapacity>20000</UsedCapacity>

</Data>
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COMPACT POOLS

Description
Pool compaction is periodically done automatically in the background. If the pool does not
contain data, it is reclaimed in its entirety and unassigned from its current storage domain.
This makes the pool available for allocation to any storage domain. If the pool cannot be
reclaimed in its entirety, its usage level is checked, and data that is eligible for deletion is
deleted as necessary to compact the pool so that it has space for new data.

Use this request to force a compaction to be scheduled immediately for all eligible pools,
without having to wait for the automatic, periodic scheduling.

Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/pool/?operation=COMPACT

[&priority=URGENT|HIGH|NORMAL|LOW]

Request Parameters

Parameter Description Required

operation The operation to perform. For this request, the operation is to
compact the pool. Value: COMPACT

yes

priority The priority for processing this task. This determines the resources
assigned and the processing order.
Values: URGENT, HIGH, NORMAL, LOW

Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
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Example

Sample Request
This request compacts all pools on the BlackPearl gateway.
PUT http[s]://blackpearl-hostname/_rest_/pool/?operation=COMPACT HTTP/1.1

Sample Response
HTTP/1.1 204 No Content

CREATE POOL PARTITION

Description
Create a pool partition. A pool partition may contain any number of pools and may be added
as a member of a storage domain.

Requests

Syntax
POST http[s]://{datapathDNSname}/_rest_/pool_partition/?name=

{string}&type=NEARLINE|ONLINE

Request Parameters 

Parameter Description Required

name The name for the pool partition. yes

type The type of pool partition to create.
Values: NEARLINE (Deep Storage), ONLINE (High Performance)

yes
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Responses

Response Elements
<Data>

   <Id>{string}</Id>

   <Name>{string}</Name>
   <Type>NEARLINE|ONLINE</Type>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

Id The UUID for the partition.

Name The name of the partition.

Type The type of pool.
Values: NEARLINE (Deep Storage), ONLINE (High Performance)

Example

Sample Request
This request creates nearline pool partition with the name ‘Nearline_Pool’.
POST http[s]://blackpearl-hostname/_rest_/pool_partition/?name=Nearline_

Pool&type=NEARLINE HTTP/1.1

Sample Response
HTTP/1.1 201 Created
<Data>

   <Id>31cd01db-97ae-43c7-bad1-ed7b14be3af4</Id>

   <Name>somename</Name>

   <Type>NEARLINE</Type>

</Data>
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DEALLOCATE POOL

Description
Deallocates the specified pool, which contains no data.

Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/pool/{unique identifier or

attribute}/?operation=DEALLOCATE

To determine the UUID for a pool, see Get Pools on page 635.

Request Parameters

Parameter Description Required

operation The operation to perform. For this request, the operation is to
deallocate a pool.
Value: DEALLOCATE

yes

Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 404: Not Found
• 409: Conflict (pool is not empty)

Example

Sample Request
This request deallocates the pool with the UUID 6f1db92a-05db-4e6d-9bd2-648a69a75cfe.
PUT http://blackpearl-hostname/_rest_/pool/6f1db92a-05db-4e6d-9bd2-

648a69a75cfe/?operation=DEALLOCATE HTTP/1.1
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Sample Response
HTTP/1.1 204 No Content

DELETE PERMANENTLY LOST POOL

Description
Deletes the specified pool which has been permanently lost from the BlackPearl database.
Any data lost as a result is marked degraded to trigger a rebuild.

Requests

Syntax
DELETE http[s]://{datapathDNSname}/_rest_/pool/{pool UUID or other unique

attribute}/

To determine the UUID for a pool, see Get Pools on page 635.

Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 404: Not Found

Example

Sample Request
This request deletes the pool with the UUID 66750ad9-9c20-402d-8703-e429070490a6.
DELETE http://blackpearl-hostname/_rest_/pool/66750ad9-9c20-402d-8703-e429070490a6/

HTTP/1.1

Sample Response
HTTP/1.1 204 No Content
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DELETE POOL FAILURE

Description
Deletes the specified pool failure.

Requests

Syntax
DELETE http[s]://{datapathDNSname}/_rest_/pool_failure/{pool failure UUID or other

unique attribute}/

To determine the UUID for a pool failure, see Get Pool Failures on page 628.

Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 404: Not Found

Example

Sample Request
This request deletes the pool failure with the UUID 8b865b58-2816-4d4d-8c7b-64189bf7ca37.
DELETE http://blackpearl-hostname/_rest_/pool_failure/8b865b58-2816-4d4d-8c7b-

64189bf7ca37/ HTTP/1.1

Sample Response
HTTP/1.1 204 No Content
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DELETE POOL PARTITION

Description
Deletes the specified pool partition. A pool partition can only be deleted if it contains no
members.

Requests

Syntax
DELETE http[s]://{datapathDNSname}/_rest_/pool_partition/{pool partition UUID or

other unique attribute}/

To determine the UUID for a pool partition, see Get Pool Partitions on page 633.

Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 404: Not Found

Example

Sample Request
This request deletes the pool partition with the name ‘pool_partition_1’.
DELETE http://blackpearl-hostname/_rest_/pool_partition/pool_partition_1/ HTTP/1.1

Sample Response
HTTP/1.1 204 No Content
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FORCE POOL ENVIRONMENT REFRESH

Description
Forces the pool environment to be refreshed at the earliest possibility. The pool environment
is updated automatically based on pool environment change events. This request is not
needed under normal circumstances.

Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/pool_environment/

Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 500: Internal Error

Example

Sample Request
This request refreshes the pool environment.
PUT http://blackpearl-hostname/_rest_/pool_environment/ HTTP/1.1

Sample Response
HTTP/1.1 204 No Content
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FORMAT FOREIGN POOL

Description
Format the specified foreign pools, permanently deleting all data on it and taking ownership
of it for this BlackPearl gateway.

Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/pool/{pool UUID or other unique

attribute}/?operation=FORMAT

To determine the UUID for a pool, see Get Pools on page 635.

Request Parameters

Parameter Description Required

operation The operation to perform. For this request, the operation is format
pool. Value: FORMAT

yes

Responses

Response Elements
<Data>

   <AssignedToStorageDomain>TRUE|FALSE</AssignedToStorageDomain>

   <AvailableCapacity>{64-bit integer}</AvailableCapacity>

   <BucketId>{string}</BucketId>

   <Guid>{string}</Guid>

   <Health>OK|DEGRADED</Health>

   <Id>{string}</Id>
   <LastAccessed>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastAccessed>

   <LastModified>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastModified>

   <LastVerified>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastVerified>

   <Mountpoint>/{string}</Mountpoint>

   <Name>{string}</Name>
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   <PartitionId>{string}</PartitionId>

   <PoweredOn>TRUE|FALSE</PoweredOn>

   <Quiesced>NO|PENDING|YES</Quiesced>

   <ReservedCapacity>{64-bit integer}</ReservedCapacity>
   <State>

      NORMAL|FOREIGN|IMPORT_IN_PROGRESS|IMPORT_PENDING|LOST

   </State>

   <StorageDomainMemberId>{string}</StorageDomainMemberId>

   <TotalCapacity>{64-bit integer}</TotalCapacity>

   <Type>NEARLINE|ONLINE</Type>

   <UsedCapacity>{64-bit integer}</UsedCapacity>

</Data>

where the response elements are defined as follows:

Parameter Description

Data A container for the response.

AssignedToStorageDomain Whether the pool is currently assigned to a storage domain.
Values: TRUE, FALSE

AvailableCapacity The amount of unused capacity on the pool in bytes.

BucketId The UUID for the bucket to which the pool is assigned.

Guid The ZFS identifier for the pool.

Health Whether the pool is in good health or degraded.
Values: OK, DEGRADED

Id The UUID for the pool.

LastAccessed The last date and time the pool was accessed in the format
YYYY-MM-DDThh:mm:ss.xxxZ.

LastModified The last date and time an object in the pool was modified in the
format YYYY-MM-DDThh:mm:ss.xxxZ.

LastVerified The last date and time the checksum of the data was verified in
the format YYYY-MM-DDThh:mm:ss.xxxZ.

MountPoint The logical directory used by the BlackPearl gateway to access the
pool.

Name The name for the pool.
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Parameter Description

PartitionId The UUID of the pool partition.

PoweredOn Whether the pool is powered on. Values: TRUE, FALSE

Quiesced Whether the pool is in a temporarily inactive state. Values: NO,
PENDING, YES

ReservedCapacity The capacity reserved to ensure pool performance.

State The status of the pool. Values: BLANK, NORMAL, FOREIGN,
IMPORT_IN_PROGRESS, IMPORT_PENDING, LOST. State on
page 600.

StorageDomain
MemberId

The UUID for the storage domain member.

TotalCapacity The total capacity of the pool including used, reserved and
available capacity.

Type The type of pool.
Values: NEARLINE (Deep Storage), ONLINE (High Performance)

UsedCapacity The amount of used capacity on the pool in bytes.

Example

Sample Request
This request cancels the pending pool import of the pool with the UUID 426934bb-85ea-41e5-
96b5-e56a3f7858e6.
PUT http://blackpearl-hostname/_rest_/pool/426934bb-85ea-41e5-96b5-

e56a3f7858e6/?operation=FORMAT HTTP/1.1

Sample Response
<Data>

   <AssignedToStorageDomain>FALSE</AssignedToStorageDomain>

   <AvailableCapacity>10000</AvailableCapacity>

   <BucketId/>

   <Guid>4cb55978-2f13-426b-82db-ac0f37d462bd</Guid>
   <Health>OK</Health>

   <Id>426934bb-85ea-41e5-96b5-e56a3f7858e6</Id>

   <LastAccessed/>

   <LastModified/>
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   <LastVerified/>
   <Mountpoint>/mountpoint-0</Mountpoint>

   <Name>pool0</Name>

   <PartitionId/>

   <PoweredOn>TRUE</PoweredOn>

   <Quiesced>NO</Quiesced>
   <ReservedCapacity>0</ReservedCapacity>

   <State>NORMAL</State>

   <StorageDomainMemberId/>

   <TotalCapacity>30000</TotalCapacity>

   <Type>NEARLINE</Type>

   <UsedCapacity>20000</UsedCapacity>

</Data>

FORMAT FOREIGN POOLS

Description
Format all foreign pools, permanently deleting all data on them and taking ownership of
them for this BlackPearl gateway.

Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/pool/?operation=FORMAT

Request Parameters

Parameter Description Required

operation The operation to perform. For this request, the operation is format
pool. Value: FORMAT

yes
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Responses

Response Elements
The operation returns status only.

Notable status code:

• 204: No Content (success)

Example

Sample Request
This request formats all foreign pools.
PUT http://blackpearl-hostname/_rest_/pool/?operation=FORMAT HTTP/1.1

Sample Response
HTTP/1.1 204 No Content

GET OBJECT PARTS ON POOL

Description
Get the list of object pieces on the specified pool.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/pool/{pool UUID or other unique

attribute}/?operation=GET_PHYSICAL_PLACEMENT

Request Parameters

Parameter Description Required

operation The operation to perform on the Amazon S3 target. For this
command, the operation is Get Physical Placement.

yes
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Responses

Response Elements
<Data>

   <Object Bucket="{string}" Id="{string}" Latest="TRUE|FALSE"

      Length="{64-bit integer}" Name="{string}"

      Offset="{64-bit integer}" VersionId="{string}">
   ...

</Data>

where the response elements are defined as follows:

Parameter Description

Data A container for the response.

Object The container for information about one object.

Bucket The name of the bucket containing the object.

Id The UUID for the object.

Latest Whether this version of the object is the latest.
Values: TRUE, FALSE

Length The length in bytes of the object.

Name The name of the object.

Offset The offset in bytes from the start of the object.

VersionId The UUID of the version of the object.

Example

Sample Request
This request returns a list of all object parts in the pool with the UUID 11cb7946-9f4d-49a0-
96a9-2dfd687298ca.
GET http://blackpearl-hostname/_rest_/pool/11cb7946-9f4d-49a0-96a9-

2dfd687298ca/?operation=GET_PHYSICAL_PLACEMENT HTTP/1.1
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Sample Response
HTTP/1.1 200 OK

<Data>

   <Object Bucket="bucket_name"

      Id="6c1807af-c34c-418c-a055-13717e058952" Latest="TRUE"

      Length="10" Name="o1" Offset="0"

      VersionId="274da5c4-b94a-47ae-80c0-e6b8e1be55a0"/>

   <Object Bucket="bucket_name"

      Id="f9d2fb04-7e93-41c6-9ee7-24d26f3ac753" Latest="TRUE"

      Length="10" Name="o2" Offset="0"

      VersionId="fa6a0b92-85c2-44f3-8d21-541c437bda9d/>

</Data>

GET POOL

Description
Get information about the specified pool.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/pool/{pool UUID or other unique attribute}/

To determine the UUID for a pool, see Get Pools on page 635.
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Responses

Response Elements
<Data>

   <AssignedToStorageDomain>TRUE|FALSE</AssignedToStorageDomain>

   <AvailableCapacity>{64-bit integer}</AvailableCapacity>

   <BucketId>{string}</BucketId>

   <Guid>{string}</Guid>

   <Health>OK|DEGRADED</Health>

   <Id>{string}</Id>

   <LastAccessed>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastAccessed>

   <LastModified>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastModified>

   <LastVerified>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastVerified>

   <Mountpoint>/{string}</Mountpoint>

   <Name>{string}</Name>

   <PartitionId>{string}</PartitionId>

   <PoweredOn>TRUE|FALSE</PoweredOn>

   <Quiesced>NO|PENDING|YES</Quiesced>

   <ReservedCapacity>{64-bit integer}</ReservedCapacity>

   <State>

      NORMAL|FOREIGN|IMPORT_IN_PROGRESS|IMPORT_PENDING|LOST

   </State>
   <StorageDomainMemberId>{string}</StorageDomainMemberId>

   <TotalCapacity>{64-bit integer}</TotalCapacity>

   <Type>NEARLINE|ONLINE</Type>

   <UsedCapacity>{64-bit integer}</UsedCapacity>

</Data>

where the response elements are defined as follows:

Parameter Description

Data A container for the response.

AssignedToStorageDomain Whether the pool is currently assigned to a storage domain.
Values: TRUE, FALSE

AvailableCapacity The amount of unused capacity on the pool in bytes.

BucketId The UUID for the bucket to which the pool is assigned.

Guid The ZFS identifier for the pool.
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Parameter Description

Health Whether the pool is in good health or degraded.
Values: OK, DEGRADED

Id The UUID for the pool.

LastAccessed The last date and time the pool was accessed in the format
YYYY-MM-DDThh:mm:ss.xxxZ.

LastModified The last date and time an object in the pool was modified in the
format YYYY-MM-DDThh:mm:ss.xxxZ.

LastVerified The last date and time the checksum of the data was verified in
the format YYYY-MM-DDThh:mm:ss.xxxZ.

MountPoint The logical directory used by the BlackPearl gateway to access the
pool.

Name The name for the pool.

PartitionId The UUID of the pool partition.

PoweredOn Whether the pool is powered on. Values: TRUE, FALSE

Quiesced Whether the pool is in a temporarily inactive state. Values: NO,
PENDING, YES

ReservedCapacity The capacity reserved to ensure pool performance.

State The status of the pool. Values: BLANK, NORMAL, FOREIGN,
IMPORT_IN_PROGRESS, IMPORT_PENDING, LOST. State on
page 600.

StorageDomain
MemberId

The UUID for the storage domain member.

TotalCapacity The total capacity of the pool including used, reserved and
available capacity.

Type The type of pool.
Values: NEARLINE (Deep Storage), ONLINE (High Performance)

UsedCapacity The amount of used capacity on the pool in bytes.
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Example

Sample Request
This request retrieves information about the pool with the UUID a480b50c-da32-4dad-8a6b-
1923e46783ce.
GET http://blackpearl-hostname/_rest_/pool/a480b50c-da32-4dad-8a6b-1923e46783ce/

HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>
   <AssignedToStorageDomain>FALSE</AssignedToStorageDomain>

   <AvailableCapacity>10000</AvailableCapacity>

   <BucketId/>

   <Guid>83d36686-e454-4c21-98ff-83a723918ef6</Guid>

   <Health>OK</Health>

   <Id>a480b50c-da32-4dad-8a6b-1923e46783ce</Id>

   <LastAccessed/>

   <LastModified/>

   <LastVerified/>

   <Mountpoint>/mountpoint-0</Mountpoint>

   <Name>pool0</Name>

   <PartitionId/>

   <PoweredOn>TRUE</PoweredOn>

   <Quiesced>NO</Quiesced>

   <ReservedCapacity>0</ReservedCapacity>

   <State>NORMAL</State>

   <StorageDomainMemberId/>

   <TotalCapacity>30000</TotalCapacity>

   <Type>NEARLINE</Type>

   <UsedCapacity>20000</UsedCapacity>

</Data>

GET POOL FAILURES

Description
Get a list of all pool failures. Use parameters as selection criteria to return a subset of the list.
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Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/pool_failure/[?error_message={string}][&last_

page][&page_length={32-bit integer}][&page_offset={32-bit integer}][&page_start_

marker={string}][&pool_id={string}][&type=BLOB_READ_FAILED|DATA_CHECKPOINT_

FAILURE|DATA_CHECKPOINT_MISSING|FORMAT_FAILED|IMPORT_FAILED|IMPORT_

INCLOMPLETE|IMPORT_FAILED_DUE_TO_DATA_INTEGRITY|IMPORT_FAILED_DUE_TO_TAKE_OWNERSHIP_

FAILURE|INSPECT_FAILED|QUIESCED|READ_FAILED|VERIFY_FAILED|WRITE_FAILED]

Request Parameters

Parameter Description Required

error_
message 1

The description of an error. no

last_page If included, only the last page of results is returned. no

page_length The maximum number of failures to list. The default is all items
after page_offset.

no

page_offset The starting point for the first failure to list. The default is 0. no

page_start_
marker

The UUID or other unique attribute for the item just before the first
item to list.
Notes:
• Specifying both page_offset and page_start_marker causes
an error.

• If neither page_offset, nor page_start_marker are specified,
the page_offset default is used.

no

pool_id The UUID or other unique attribute for the error pool. no

type The type of error message.
Values: BLOB_READ_FAILED, DATA_CHECKPOINT_FAILURE, DATA_
CHECKPOINT_MISSING, FORMAT_FAILED, IMPORT_FAILED,
IMPORT_FAILED_DUE_TO_DATA_INTEGRITY, IMPORT_FAILED_DUE_
TO_TAKE_OWNERSHIP_FAILURE, IMPORT_INCLOMPLETE, INSPECT_
FAILED, QUIESCED, READ_FAILED, VERIFY_FAILED, WRITE_FAILED

no

1) Parameter values can use wild cards (see Wild Card Syntax on page 30).
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Responses

Response Elements
<Data>

   <PoolFailure>

      <Date>{YYYY-MM-DDThh:mm:ss.xxxZ}</Date>

      <ErrorMessage>{string}</ErrorMessage>

      <Id>{string}</Id>

      <PoolId>{string}</PoolId>

      <Type>

         BLOB_READ_FAILED|DATA_CHECKPOINT_FAILURE|

         DATA_CHECKPOINT_MISSING|FORMAT_FAILED|IMPORT_FAILED|

         IMPORT_FAILED_DUE_TO_DATA_INTEGRITY|

         IMPORT_FAILED_DUE_TO_TAKE_OWNERSHIP_FAILURE|

         IMPORT_INCOMPLETE|INSPECT_FAILED|QUIESCED|READ_FAILED|

         VERIFY_FAILED|WRITE_FAILED

      </Type>

   </PoolFailure>

   ...

</Data>

where the response elements are defined as follows:

Parameter Description

Data A container for the response.

PoolFailure A container for information about a single pool failure.

Date The date and time the error occurred in the format
YYYY-MM-DDThh:mm:ss.xxxZ.

ErrorMessage A description of the error.

Id The UUID for the error message.

PoolId The UUID for the pool.

Type The type of pool error message.
Values: BLOB_READ_FAILED, DATA_CHECKPOINT_FAILURE, DATA_
CHECKPOINT_MISSING, FORMAT_FAILED, IMPORT_FAILED, IMPORT_FAILED_
DUE_TO_DATA_INTEGRITY, IMPORT_FAILED_DUE_TO_TAKE_OWNERSHIP_
FAILURE, IMPORT_INCOMPLETE, INSPECT_FAILED, QUIESCED, READ_FAILED,
VERIFY_FAILED, WRITE_FAILED
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Example

Sample Request
This request retrieves a list of all pool failures.
GET http://blackpearl-hostname/_rest_/pool_failure/ HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>

   <PoolFailure>

      <Date>2015-08-28 12:39:50.307</Date>

      <ErrorMessage>

         Could not read object from pool.

      </ErrorMessage>

      <Id>6a702949-9408-43a1-b743-aa410256f109</Id>

      <PoolId>650da9c3-5a7a-41e0-b8c0-b7219e70cce4</PoolId>

      <Type>BLOB_READ_FAILED</Type>

   </PoolFailure>

</Data>

GET POOL PARTITION

Description
Get information about the specified pool partition.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/pool_partition/{pool_partition_id or other

unique attribute}/

To determine the UUID for a pool partition, see Get Pool Partitions on page 633.
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Responses

Response Elements
<Data>

   <Id>{string}</Id>

   <Name>{string}</Name>
   <Type>NEARLINE|ONLINE</Type>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

Id The UUID for the partition.

Name The name of the partition.

Type The type of pool.
Values: NEARLINE (Deep Storage), ONLINE (High Performance)

Example

Sample Request
This request retrieves information about the pool partition with the UUID c0130c36-a55b-
4570-a490-3b8041bfb886.
GET http://blackpearl-hostname/_rest_/pool_partition/c0130c36-a55b-4570-a490-

3b8041bfb886/ HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>

   <Id>c0130c36-a55b-4570-a490-3b8041bfb886</Id>

   <Name>dp1</Name>

   <Type>NEARLINE</Type>

</Data>
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GET POOL PARTITIONS

Description
Get a list of all pool partitions. Use parameters as selection criteria to return a subset of the
list.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/pool_partition/[?last_page][&name={string}]

[&page_length={32-bit integer}][&page_offset={32-bit integer}][&page_start_marker=

{string}][&type=NEARLINE|ONLINE]

Request Parameters

Parameter Description Required

last_page If included, only the last page of results is returned. no

name 1 The name of the partition. no

page_length The maximum number of pool partitions to list. The default is all
items after page_offset.

no

page_offset The starting point for the first pool partition to list. The default is 0. no

page_start_
marker

The UUID or other unique attribute for the item just before the first
item to list.
Notes:
• Specifying both page_offset and page_start_marker causes
an error.

• If neither page_offset, nor page_start_marker are specified,
the page_offset default is used.

no

type The type of pool.
Values: NEARLINE (Deep Storage), ONLINE (High Performance)

no

1) Parameter values can use wild cards (see Wild Card Syntax on page 30).
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Responses

Response Elements
<Data>

   <PoolPartition>

      <Id>{string}</Id>

      <Name>{string}</Name>
      <Type>NEARLINE|ONLINE</Type>

   </PoolPartition>

   ...

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

PoolPartition The container for information about a single pool partition.

Id The UUID for the partition.

Name The name of the partition.

Type The type of pool.
Values: NEARLINE (Deep Storage), ONLINE (High Performance)

Example

Sample Request
This request retrieves a list of pool partitions.
GET http://blackpearl-hostname/_rest_/pool_partition/ HTTP/1.1
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Sample Response
HTTP/1.1 200 OK

<Data>

   <PoolPartition>

      <Id>0a55e7c9-b538-46a6-a649-b61056c27500</Id>

      <Name>dp1</Name>

      <Type>NEARLINE</Type>

   </PoolPartition>

   <PoolPartition>

      <Id>6d9fd192-ca48-43e0-8d5b-14a169be028e</Id>

      <Name>dp2</Name>

      <Type>NEARLINE</Type>

   </PoolPartition>

   ...

</Data>

GET POOLS

Description
Get a list of all pools. Use parameters as selection criteria to return a subset of the list.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/pool/[?assigned_to_storage_domain=TRUE|FALSE]

[&bucket_id={string}][&health=OK|DEGRADED][&last_page][&name={string}][&page_length=

{32-bit integer}][&page_offset={32-bit integer}][&page_start_marker={string}]

[&partition_id={string}][&powered_on=TRUE|FALSE][&state=NORMAL|FOREIGN|IMPORT_IN_

PROGRESS|IMPORT_PENDING|LOST][&storage_domain_member_id={string}]

[&type=NEARLINE|ONLINE]

Request Parameters

Parameter Description Required

assigned_to_
storage_
domain

Whether the pool is currently assigned to a storage domain.
Values: TRUE, FALSE

no

April 2023 DS3 API Reference-Spectra BlackPearl Nearline Gateway
- 635 -



Chapter 15 - Pool Operations Get Pools

Parameter Description Required

bucket_id The UUID for the bucket to which the pool is assigned. no

guid The ZFS identifier for the pool. no

health Whether the pool is in good health or degraded.
Values: OK, DEGRADED

no

last_page If included, only the last page of results is returned. no

last_verified The last date and time the checksum of the data was verified in
the format YYYY-MM-DDThh:mm:ss.xxxZ.

no

name 1 The name assigned to the pool. no

page_length The maximum number of pools to list. The default is all items
after page_offset.

no

page_offset The starting point for the first pool to list. The default is 0. no

page_start_
marker

The UUID or other unique attribute for the item just before the
first item to list.
Notes:
• Specifying both page_offset and page_start_marker
causes an error.

• If neither page_offset, nor page_start_marker are
specified, the page_offset default is used.

no

partition_id The UUID for the partition. no

powered_on Whether the pool is powered on. This is always TRUE for pools
with type=ONLINE. Values: TRUE, FALSE

no

state The status of the pool. Values: BLANK, NORMAL, FOREIGN,
IMPORT_IN_PROGRESS, IMPORT_PENDING, LOST. State on
page 600.

no

storage_
domain_
member_id

The UUID for the storage domain member. See Get Storage
Domain Members on page 569.

no

type The type of pool.
Values: NEARLINE (Deep Storage), ONLINE (High Performance)

no

1) Parameter values can use wild cards (see Wild Card Syntax on page 30).
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Responses

Response Elements
<Data>
   <Pool>

      <AssignedToStorageDomain>

         TRUE|FALSE

      </AssignedToStorageDomain>

      <AvailableCapacity>{64-bit integer}</AvailableCapacity>

      <BucketId>{string}</BucketId>

      <Guid>{string}</Guid>

      <Health>OK|DEGRADED</Health>

      <Id>{string}</Id>

      <LastAccessed>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastAccessed>

      <LastModified>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastModified>

      <LastVerified>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastVerified>

      <Mountpoint>/{string}</Mountpoint>

      <Name>{string}</Name>
      <PartitionId>{string}</PartitionId>

      <PoweredOn>TRUE|FALSE</PoweredOn>

      <Quiesced>NO|PENDING|YES</Quiesced>

      <ReservedCapacity>{64-bit integer}</ReservedCapacity>
      <State>

         NORMAL|FOREIGN|IMPORT_IN_PROGRESS|IMPORT_PENDING|LOST

      </State>
      <StorageDomainMemberId>{string}</StorageDomainMemberId>

      <TotalCapacity>{64-bit integer}</TotalCapacity>

      <Type>NEARLINE|ONLINE</Type>

      <UsedCapacity>{64-bit integer}</UsedCapacity>

   </Pool>

   ...

</Data>

where the response elements are defined as follows:

Parameter Description

Data A container for the response.

AssignedToStorageDomain Whether the pool is currently assigned to a storage domain.
Values: TRUE, FALSE
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Parameter Description

AvailableCapacity The amount of unused capacity on the pool in bytes.

BucketId The UUID for the bucket to which the pool is assigned.

Guid The ZFS identifier for the pool.

Health Whether the pool is in good health or degraded.
Values: OK, DEGRADED

Id The UUID for the pool.

LastAccessed The last date and time the pool was accessed in the format
YYYY-MM-DDThh:mm:ss.xxxZ.

LastModified The last date and time an object in the pool was modified in the
format YYYY-MM-DDThh:mm:ss.xxxZ.

LastVerified The last date and time the checksum of the data was verified in
the format YYYY-MM-DDThh:mm:ss.xxxZ.

MountPoint The logical directory used by the BlackPearl gateway to access the
pool.

Name The name for the pool.

PartitionId The UUID of the pool partition.

PoweredOn Whether the pool is powered on. Values: TRUE, FALSE

Quiesced Whether the pool is in a temporarily inactive state. Values: NO,
PENDING, YES

ReservedCapacity The capacity reserved to ensure pool performance.

State The status of the pool. Values: BLANK, NORMAL, FOREIGN,
IMPORT_IN_PROGRESS, IMPORT_PENDING, LOST. State on
page 600.

StorageDomain
MemberId

The UUID for the storage domain member.

TotalCapacity The total capacity of the pool including used, reserved and
available capacity.

Type The type of pool.
Values: NEARLINE (Deep Storage), ONLINE (High Performance)

UsedCapacity The amount of used capacity on the pool in bytes.
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Example

Sample Request
This request retrieves information about all pools associated with the BlackPearl gateway.
GET http://blackpearl-hostname/_rest_/pool/ HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>

   <Pool>

      <AssignedToStorageDomain>FALSE</AssignedToStorageDomain>

      <AvailableCapacity>10000</AvailableCapacity>

      <BucketId/>

      <Guid>6a0a51b0-8318-4945-a67a-c890c0ab92de</Guid>

      <Health>OK</Health>

      <Id>a124e769-be69-4ae5-8846-9a58f40d28f1</Id>

      <LastAccessed/>

      <LastModified/>

      <LastVerified/>

      <Mountpoint>/mountpoint-0</Mountpoint>

      <Name>pool0</Name>

      <PartitionId/>

      <PoweredOn>TRUE</PoweredOn>

      <Quiesced>NO</Quiesced>

      <ReservedCapacity>0</ReservedCapacity>

      <State>NORMAL</State>

      <StorageDomainMemberId/>

      <TotalCapacity>30000</TotalCapacity>

      <Type>NEARLINE</Type>

      <UsedCapacity>20000</UsedCapacity>

   </Pool>

   ...

</Data>

IMPORT POOL

Description
Import the specified pool for use by the BlackPearl gateway.
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Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/pool/{pool UUID or unique

attribute}/?operation=IMPORT[&data_policy_id={string}]

[&priority=URGENT|HIGH|NORMAL|LOW|BACKGROUND][&storage_domain_id={string}][&user_id=

{string}][&verify_data_after_import=CRITICAL|URGENT|HIGH|NORMAL|LOW|BACKGROUND]

[&verify_data_prior_to_import=TRUE|FALSE]

To determine the UUID for a pool, see Get Pools on page 635.

Request Parameters

Parameter Description Required

operation The operation to perform. For this request, the operation is import.
Value: IMPORT

yes

data_policy_
id

The UUID, name, or other unique attribute for the data policy to
associate with any buckets on the pool that do not already exist on
the BlackPearl gateway.
Note: If there are new buckets on the pool, the data_policy_id is
required.

no

priority The priority for processing the import. The priority determines
the resources assigned and the processing order. Imports can be
interrupted every 30 minutes if a job with a higher priority is
received.
Values: URGENT, HIGH, NORMAL, LOW

no

storage_
domain_id

The UUID, name, or other unique attribute for the storage
domain to associate with the data on the pool.
Note: If there are new buckets on the pool and this parameter is not
specified, the BlackPearl gateway attempts to determine the most
logical storage domain in which to add the pool.

no

user_id The UUID, name, or other unique attribute for the user to associate
with any buckets on the pool that do not already exist on the
BlackPearl gateway.
Note: If there are new buckets on the pool, the user_id is required.

no

verify_data_
after_
import

The priority for verifying the data after import. This determines the
resources assigned and the processing order.
Values: URGENT, HIGH, NORMAL, LOW

no
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Parameter Description Required

verify_data_
before_
import

Whether the data must be verified before the pool is imported.
Values: TRUE, FALSE
Note: It is recommended to verify data prior to import whenever it
is possible that the pool being imported contains objects with the
same name as objects already in the bucket. Without verifying data
prior to import, it is possible for the existing object to be replaced
with the one being imported, even if the one being imported is
partially corrupt and cannot be read.

no

Responses

Response Elements
<Data>

   <AssignedToStorageDomain>TRUE|FALSE</AssignedToStorageDomain>

   <AvailableCapacity>{64-bit integer}</AvailableCapacity>

   <BucketId>{string}</BucketId>

   <Guid>{string}</Guid>

   <Health>OK|DEGRADED</Health>
   <Id>{string}</Id>

   <LastAccessed>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastAccessed>

   <LastModified>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastModified>

   <LastVerified>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastVerified>

   <Mountpoint>/{string}</Mountpoint>

   <Name>{string}</Name>

   <PartitionId>{string}</PartitionId>
   <PoweredOn>TRUE|FALSE</PoweredOn>

   <Quiesced>NO|PENDING|YES</Quiesced>

   <ReservedCapacity>{64-bit integer}</ReservedCapacity>

   <State>

      NORMAL|FOREIGN|IMPORT_IN_PROGRESS|IMPORT_PENDING|LOST

   </State>
   <StorageDomainMemberId>{string}</StorageDomainMemberId>

   <TotalCapacity>{64-bit integer}</TotalCapacity>

   <Type>NEARLINE|ONLINE</Type>

   <UsedCapacity>{64-bit integer}</UsedCapacity>

</Data>
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where the response elements are defined as follows:

Parameter Description

Data A container for the response.

AssignedToStorageDomain Whether the pool is currently assigned to a storage domain.
Values: TRUE, FALSE

AvailableCapacity The amount of unused capacity on the pool in bytes.

BucketId The UUID for the bucket to which the pool is assigned.

Guid The ZFS identifier for the pool.

Health Whether the pool is in good health or degraded.
Values: OK, DEGRADED

Id The UUID for the pool.

LastAccessed The last date and time the pool was accessed in the format
YYYY-MM-DDThh:mm:ss.xxxZ.

LastModified The last date and time an object in the pool was modified in the
format YYYY-MM-DDThh:mm:ss.xxxZ.

LastVerified The last date and time the checksum of the data was verified in
the format YYYY-MM-DDThh:mm:ss.xxxZ.

MountPoint The logical directory used by the BlackPearl gateway to access the
pool.

Name The name for the pool.

PartitionId The UUID of the pool partition.

PoweredOn Whether the pool is powered on. Values: TRUE, FALSE

Quiesced Whether the pool is in a temporarily inactive state. Values: NO,
PENDING, YES

ReservedCapacity The capacity reserved to ensure pool performance.

State The status of the pool. Values: BLANK, NORMAL, FOREIGN,
IMPORT_IN_PROGRESS, IMPORT_PENDING, LOST. State on
page 600.

StorageDomainMemberId The UUID for the storage domain member.
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Parameter Description

TotalCapacity The total capacity of the pool including used, reserved and
available capacity.

Type The type of pool.
Values: NEARLINE (Deep Storage), ONLINE (High Performance)

UsedCapacity The amount of used capacity on the pool in bytes.

Example

Sample Request
This request imports the pool with the UUID ea6719df-4d61-4462-89c5-51d6bf44f47d using
the data policy ‘dp1’ and the user ‘abc’.
PUT http://blackpearl-hostname/_rest_/pool/ea6719df-4d61-4462-89c5-

51d6bf44f47d/?operation=IMPORT&data_policy_id=dp1&user_id=abc HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>

   <AssignedToStorageDomain>FALSE</AssignedToStorageDomain>

   <AvailableCapacity>10000</AvailableCapacity>

   <BucketId/>

   <Guid>1cad0b5a-e271-4b70-aca9-a8c614779b18</Guid>

   <Health>OK</Health>

   <Id>ea6719df-4d61-4462-89c5-51d6bf44f47d</Id>
   <LastAccessed/>

   <LastModified/>

   <LastVerified/>

   <Mountpoint>/mountpoint-0</Mountpoint>

   <Name>pool0</Name>

   <PartitionId/>

   <PoweredOn>TRUE</PoweredOn>
   <Quiesced>NO</Quiesced>

   <ReservedCapacity>0</ReservedCapacity>

   <State>NORMAL</State>

   <StorageDomainMemberId/>
   <TotalCapacity>30000</TotalCapacity>

   <Type>NEARLINE</Type>

   <UsedCapacity>20000</UsedCapacity>

</Data>
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IMPORT POOLS

Description
Import all foreign pools to make them available to the current BlackPearl gateway.

Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/pool/?operation=IMPORT[&data_policy_id=

{string}][&priority=URGENT|HIGH|NORMAL|LOW|BACKGROUND][&storage_domain_id={string}]

[&user_id={string}][&verify_data_after_

import=CRITICAL|URGENT|HIGH|NORMAL|LOW|BACKGROUND][&verify_data_prior_to_

import=TRUE|FALSE]

Request Parameters

Parameter Description Required

operation The operation to perform. For this request, the operation is import.
Value: IMPORT

yes

data_policy_
id

The UUID, name, or other unique attribute for the data policy to
associate with any buckets on the pool that do not already exist on
the BlackPearl gateway.
Note: If there are new buckets on the pool, the data_policy_id is
required.

no

priority The priority for processing the import. The priority determines
the resources assigned and the processing order. Imports can be
interrupted every 30 minutes if a job with a higher priority is
received.
Values: URGENT, HIGH, NORMAL, LOW

no

storage_
domain_id

The UUID, name, or other unique attribute for the storage
domain to associate with the data on the pool.
Note: If there are new buckets on the pool and this parameter is not
specified, the BlackPearl gateway attempts to determine the most
logical storage domain in which to add the pool.

no
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Parameter Description Required

user_id The UUID, name, or other unique attribute for the user to associate
with any buckets on the pool that do not already exist on the
BlackPearl gateway.
Note: If there are new buckets on the pool, the user_id is required.

no

verify_data_
after_
import

The priority for verifying the data after import. This determines the
resources assigned and the processing order.
Values: URGENT, HIGH, NORMAL, LOW

no

verify_data_
before_
import

Whether the data must be verified before the pool is imported.
Values: TRUE, FALSE
Note: It is recommended to verify data prior to import whenever it
is possible that the pool being imported contains objects with the
same name as objects already in the bucket. Without verifying data
prior to import, it is possible for the existing object to be replaced
with the one being imported, even if the one being imported is
partially corrupt and cannot be read.

no

Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 500: Internal Error

Example

Sample Request
This request imports all foreign pools using data policy ‘dp1’ and user ‘user1’.
PUT http://blackpearl-hostname/_rest_/pool/?operation=IMPORT&data_policy_

id=dp1&user_id=user1 HTTP/1.1

Sample Response
HTTP/1.1 204 No Content
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MODIFY POOL

Description
Modify the partition assignment of the specified pool or the quiesced state.

Notes:

• If an optional request parameter is not included, the previous setting is retained.

• It is not possible to change the quiesced state directly from NO to YES.

Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/pool/{pool UUID or other unique attribute}/

[?partition_id={string}][&quiesced=NO|PENDING]

To determine the UUID for a pool, see Get Pools on page 635.

Request Parameters

Parameter Description Required

partition_id The UUID, name, or other unique attribute for the pool partition to
which to assign the pool.

no

quiesced Request that the gateway prepare the pool to go into an inactive
state (PENDING) or return the pool to an active state (NO).
Values: NO, PENDING

no
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Responses

Response Elements
<Data>

   <AssignedToStorageDomain>TRUE|FALSE</AssignedToStorageDomain>

   <AvailableCapacity>{64-bit integer}</AvailableCapacity>

   <BucketId>{string}</BucketId>

   <Guid>{string}</Guid>

   <Health>OK|DEGRADED</Health>

   <Id>{string}</Id>

   <LastAccessed>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastAccessed>

   <LastModified>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastModified>

   <LastVerified>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastVerified>

   <Mountpoint>/{string}</Mountpoint>

   <Name>{string}</Name>

   <PartitionId>{string}</PartitionId>
   <PoweredOn>TRUE|FALSE</PoweredOn>

   <Quiesced>NO|PENDING|YES</Quiesced>
   <ReservedCapacity>{64-bit integer}</ReservedCapacity>

   <State>

      NORMAL|FOREIGN|IMPORT_IN_PROGRESS|IMPORT_PENDING|LOST

   </State>
   <StorageDomainMemberId>{string}</StorageDomainMemberId>

   <TotalCapacity>{64-bit integer}</TotalCapacity>

   <Type>NEARLINE|ONLINE</Type>

   <UsedCapacity>{64-bit integer}</UsedCapacity>

</Data>

where the response elements are defined as follows:

Parameter Description

Data A container for the response.

AssignedToStorageDomain Whether the pool is currently assigned to a storage domain.
Values: TRUE, FALSE

AvailableCapacity The amount of unused capacity on the pool in bytes.

BucketId The UUID for the bucket to which the pool is assigned.

Guid The ZFS identifier for the pool.
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Parameter Description

Health Whether the pool is in good health or degraded.
Values: OK, DEGRADED

Id The UUID for the pool.

LastAccessed The last date and time the pool was accessed in the format
YYYY-MM-DDThh:mm:ss.xxxZ.

LastModified The last date and time an object in the pool was modified in the
format YYYY-MM-DDThh:mm:ss.xxxZ.

LastVerified The last date and time the checksum of the data was verified in
the format YYYY-MM-DDThh:mm:ss.xxxZ.

MountPoint The logical directory used by the BlackPearl gateway to access the
pool.

Name The name for the pool.

PartitionId The UUID of the pool partition.

PoweredOn Whether the pool is powered on. Values: TRUE, FALSE

Quiesced Whether the pool is in a temporarily inactive state. Values: NO,
PENDING, YES

ReservedCapacity The capacity reserved to ensure pool performance.

State The status of the pool. Values: BLANK, NORMAL, FOREIGN,
IMPORT_IN_PROGRESS, IMPORT_PENDING, LOST. State on
page 600.

StorageDomain
MemberId

The UUID for the storage domain member.

TotalCapacity The total capacity of the pool including used, reserved and
available capacity.

Type The type of pool.
Values: NEARLINE (Deep Storage), ONLINE (High Performance)

UsedCapacity The amount of used capacity on the pool in bytes.
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Example

Sample Request
This request changes the partition the pool with the UUID c62cf569-5ff7-45cc-bad3-
e2a6bd44760a is assigned to “Partition1”.
PUT http://blackpearl-hostname/_rest_/pool/c62cf569-5ff7-45cc-bad3-

e2a6bd44760a/?partition_id=Partition1 HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>

   <AssignedToStorageDomain>FALSE</AssignedToStorageDomain>

   <AvailableCapacity>10000</AvailableCapacity>

   <BucketId/>

   <Guid>c8c478ea-7d5e-48d0-97fb-42ed1983cfbd</Guid>

   <Health>OK</Health>

   <Id>c62cf569-5ff7-45cc-bad3-e2a6bd44760a</Id>

   <LastAccessed/>

   <LastModified/>

   <LastVerified/>

   <Mountpoint>/mountpoint-0</Mountpoint>

   <Name>pool0</Name>

   <PartitionId>ba807ff5-ed78-444e-badf-41d5c497e0b5</PartitionId>

   <PoweredOn>TRUE</PoweredOn>

   <Quiesced>NO</Quiesced>

   <ReservedCapacity>0</ReservedCapacity>

   <State>NORMAL</State>

   <StorageDomainMemberId/>

   <TotalCapacity>30000</TotalCapacity>

   <Type>NEARLINE</Type>

   <UsedCapacity>20000</UsedCapacity>

</Data>

MODIFY POOL PARTITION

Description
Modify the name of the specified pool partition.

April 2023 DS3 API Reference-Spectra BlackPearl Nearline Gateway
- 649 -



Chapter 15 - Pool Operations Modify Pool Partition

Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/pool_partition/{pool_partition_id}/[?name=

{string}]

To determine the UUID for a pool partition, see Get Pool Partitions on page 633.

Request Parameters

Parameter Description Required

name The new name to assign to the pool partition. no

Responses

Response Elements
<Data>

   <Id>{string}</Id>

   <Name>{string}</Name>

   <Type>NEARLINE|ONLINE</State>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

Id The UUID for the partition.

Name The name of the partition.

Type The type of pool.
Values: NEARLINE (Deep Storage), ONLINE (High Performance)
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Example

Sample Request
This request changes the name of the pool partition from ‘p1’ to ‘MoviePartition’.
PUT http://blackpearl-hostname/_rest_/pool_partition/p1/?name=MoviePartition

HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>

   <Id>2c6e4f83-c3d6-4a7b-bc1c-069e6ac7670f</Id>

   <Name>MoviePartition</Name>

   <Type>NEARLINE</Type>

</Data>

MODIFY POOLS

Description
Sets all pools to unquiesced (NO), or pending quiesce (PENDING) state. The gateway changes
the state from pending quiesce (PENDING) to quiesced (YES).

Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/pool/?quiesced=NO|PENDING

Request Parameters

Parameter Description Required

quiesced Request that the gateway prepare all pools to go into an inactive
state (PENDING) or return all pools to an active state (NO). Values:
NO, PENDING

yes
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Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 409: Conflict (illegal transition)

Example

Sample Request
This request moves all pools out of the quiesced state.
PUT http://blackpearl-hostname/_rest_/pool/?quiesced=NO HTTP/1.1

Sample Response
HTTP/1.1 204 No Content

VERIFY POOL

Description
Verifies the data in one pool. Pool verification is periodically done automatically in the
background.

Use this request to force a verification to be scheduled immediately for the specified pool,
without having to wait for the automatic, periodic scheduling.

Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/pool/{pool UUID or other unique

attribute}/?operation=VERIFY[&priority=URGENT|HIGH|NORMAL|LOW]

To determine the UUID for a pool, see Get Pools on page 635.
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Request Parameters

Parameter Description Required

operation The operation to perform. For this request, the operation is to verify
a pool. Value: VERIFY

yes

priority The priority for processing this task. This determines the resources
assigned and the processing order. Verify jobs can be interrupted
every 30 minutes if a job with a higher priority is received.
Values: URGENT, HIGH, NORMAL, LOW

no

Responses

Response Elements
<Data>

   <AssignedToStorageDomain>TRUE|FALSE</AssignedToStorageDomain>

   <AvailableCapacity>{64-bit integer}</AvailableCapacity>

   <BucketId>{string}</BucketId>

   <Guid>{string}</Guid>

   <Health>OK|DEGRADED</Health>

   <Id>{string}</Id>

   <LastAccessed>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastAccessed>

   <LastModified>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastModified>

   <LastVerified>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastVerified>
   <Mountpoint>/{string}</Mountpoint>

   <Name>{string}</Name>

   <PartitionId>{string}</PartitionId>
   <PoweredOn>TRUE|FALSE</PoweredOn>

   <Quiesced>NO|PENDING|YES</Quiesced>

   <ReservedCapacity>{64-bit integer}</ReservedCapacity>

   <State>

      NORMAL|FOREIGN|IMPORT_IN_PROGRESS|IMPORT_PENDING|LOST

   </State>
   <StorageDomainMemberId>{string}</StorageDomainMemberId>

   <TotalCapacity>{64-bit integer}</TotalCapacity>

   <Type>NEARLINE|ONLINE</Type>

   <UsedCapacity>{64-bit integer}</UsedCapacity>

</Data>
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where the response elements are defined as follows:

Parameter Description

Data A container for the response.

AssignedToStorageDomain Whether the pool is currently assigned to a storage domain.
Values: TRUE, FALSE

AvailableCapacity The amount of unused capacity on the pool in bytes.

BucketId The UUID for the bucket to which the pool is assigned.

Health Whether the pool is in good health or degraded.
Values: OK, DEGRADED

Id The UUID for the pool.

LastAccessed The last date and time the pool was accessed in the format
YYYY-MM-DDThh:mm:ss.xxxZ.

LastModified The last date and time an object in the pool was modified in the
format YYYY-MM-DDThh:mm:ss.xxxZ.

LastVerified The last date and time the checksum of the data was verified in
the format YYYY-MM-DDThh:mm:ss.xxxZ.

MountPoint The logical directory used by the BlackPearl gateway to access the
pool.

Name The name for the pool.

PartitionId The UUID of the pool partition.

PoweredOn Whether the pool is powered on. Values: TRUE, FALSE

Quiesced Whether the pool is in a temporarily inactive state. Values: NO,
PENDING, YES

ReservedCapacity The capacity reserved to ensure pool performance.

State The status of the pool. Values: BLANK, NORMAL, FOREIGN,
IMPORT_IN_PROGRESS, IMPORT_PENDING, LOST. State on
page 600.

StorageDomain
MemberId

The UUID for the storage domain member.
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Parameter Description

TotalCapacity The total capacity of the pool including used, reserved and
available capacity.

Type The type of pool.
Values: NEARLINE (Deep Storage), ONLINE (High Performance)

UsedCapacity The amount of used capacity on the pool in bytes.

Example

Sample Request
This request verifies the pool with the UUID fd286064-f6d0-4a0a-be4b-5e0dd9a5972f.
PUT http://blackpearl-hostname/_rest_/pool/fd286064-f6d0-4a0a-be4b-

5e0dd9a5972f/?operation=VERIFY HTTP/1.1

Sample Response
<Data>

   <AssignedToStorageDomain>FALSE</AssignedToStorageDomain>

   <AvailableCapacity>10000</AvailableCapacity>

   <BucketId/>

   <Guid>5bfa9aca-264c-4b0e-87bd-8be9bab71d3d</Guid>

   <Health>OK</Health>

   <Id>fd286064-f6d0-4a0a-be4b-5e0dd9a5972f</Id>

   <LastAccessed/>

   <LastModified/>

   <LastVerified/>

   <Mountpoint>/mountpoint-0</Mountpoint>

   <Name>pool0</Name>

   <PartitionId/>

   <PoweredOn>TRUE</PoweredOn>

   <Quiesced>NO</Quiesced>

   <ReservedCapacity>0</ReservedCapacity>

   <State>NORMAL</State>

   <StorageDomainMemberId/>

   <TotalCapacity>30000</TotalCapacity>

   <Type>NEARLINE</Type>

   <UsedCapacity>20000</UsedCapacity>

</Data>
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VERIFY POOLS

Description
Verifies the data in all pools. Pool verification is periodically done automatically in the
background.

Use this request to force a verification to be scheduled immediately for all eligible pools,
without having to wait for the automatic, periodic scheduling.

Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/pool/?operation=VERIFY

[&priority=URGENT|HIGH|NORMAL|LOW]

Request Parameters

Parameter Description Required

operation The operation to perform. For this request, the operation is to verify
all pools. Value: VERIFY

yes

priority The priority for processing this task. This determines the resources
assigned and the processing order. Verify jobs can be interrupted
every 30 minutes if a job with a higher priority is received.
Values: URGENT, HIGH, NORMAL, LOW

no

Responses

Response Elements
The operation returns status only.

Notable status code:

• 204: No Content (success)
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Example

Sample Request
This request verifies all pools on the BlackPearl gateway.
PUT http[s]://blackpearl-hostname/_rest_/pool/?operation=VERIFY HTTP/1.1

Sample Response
HTTP/1.1 204 No Content
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CHAPTER 16 - TAPE LIBRARY AND
COMPONENT OPERATIONS

This chapter provides detailed information about operations you can perform on tapes, tape
libraries, tape drives, and tape partitions.

Cancel Eject of Tape 660

Cancel Eject of Tapes 667

Cancel Format of Tape 669

Cancel Format of Tapes 674

Cancel Import of Foreign Tape 675

Cancel Import of Foreign Tapes 681

Cancel Online of Tape 682

Cancel Online of Tapes 687

Cancel Test Tape Drive 689

Cancel Verify of Tape 692

Cancel Verify of Tapes 697

Clean Tape Drive 698

Create Tape Density Directive 701

Create a Drive Dump 704

Delete Permanently Lost Tape 707

Delete Tape Density Directive 708

Delete Tape Drive 709

Delete Tape Failure 710

Delete Tape Partition 711

Delete Tape Partition Failure 712

Eject Tape 713

Eject Tapes 718

Eject Storage Domain 719

Eject Storage Domain Blobs 720

Force Tape Environment Refresh 722
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Format Tape 723

Format Tapes 730

Get Physical Placement for Object Parts on Tape 731

Get Tape 733

Get Tape Density Directive 739

Get Tape Density Directives 740

Get Tape Drive 743

Get Tape Drives 746

Get Tape Failures 750

Get Tape Libraries 754

Get Tape Library 756

Get Tape Partition 758

Get Tape Partition Failures 762

Get Tape Partitions 765

Get Tapes 770

Import All BlackPearl Foreign Tapes 779

Import All LTFS Foreign Tapes 781

Import BlackPearl Foreign Tape 783

Import LTFS Foreign Tape 789

Inspect Tape 795

Inspect Tapes 800

Mark Tape for Compaction 802

Modify Tape 807

Modify Tape Drive 812

Sample Response 815

Modify Tape Partition 816

Modify Tape Partitions 820

Online Tape 821

Online Tapes 826

Test Tape Drive 828
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Verify Tape 831

Verify Tapes 836

CANCEL EJECT OF TAPE

Description
Cancels a pending tape eject on the specified tape. If the eject is in process, it cannot be
canceled.

Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/tape/{tape UUID or

barcode}/?operation=CANCEL_EJECT

To determine the UUID for a tape, see Get Tapes on page 770.

Request Parameters

Parameter Description Required

operation The operation to perform. For this request, the operation is cancel
eject. Value: CANCEL_EJECT

yes

April 2023 DS3 API Reference-Spectra BlackPearl Nearline Gateway
- 660 -



Chapter 16 - Tape Library and Component Operations Cancel Eject of Tape

Responses

Response Elements
<Data>

   <AssignedToStorageDomain>TRUE|FALSE</AssignedToStorageDomain>

   <AvailableRawCapacity>{64-bit integer}</AvailableRawCapacity>

   <BarCode>{string}</BarCode>

   <BucketId>{string}</BucketId>

   <DescriptionForIdentification>

{string}

   </DescriptionForIdentification>

   <EjectDate>{YYYY-MM-DDThh:mm:ss.xxxZ}</EjectDate>

   <EjectLabel>{string}</EjectLabel>

   <EjectLocation>{string}</EjectLocation>

   <EjectPending>{YYYY-MM-DDThh:mm:ss.xxxZ}</EjectPending>

   <FullOfData>TRUE|FALSE</FullOfData>

   <Id>{string}</Id>
   <LastAccessed>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastAccessed>

   <LastCheckpoint>{string}</LastCheckpoint>

   <LastModified>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastModified>

   <LastVerified>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastVerified>
   <PartiallyVerifiedEndOfTape>

{YYYY-MM-DDThh:mm:ss.xxxZ}

   </PartiallyVerifiedEndOfTape>

   <PartitionId>{string}</PartitionId>

   <PreviousState>

      NORMAL|AUTO_COMPACTION_IN_PROGRESS|BAD|BAR_CODE_MISSING|

      CANNOT_FORMAT_DUE_TO_WRITE_PROTECTION|

      DATA_CHECKPOINT_FAILURE|

      DATA_CHECKPOINT_FAILURE_DUE_TO_READ_ONLY|

      DATA_CHECKPOINT_MISSING|EJECT_FROM_EE_PENDING|

      EJECT_TO_EE_IN_PROGRESS|EJECTED|FOREIGN|FORMAT_IN_PROGRESS|

      FORMAT_PENDING|IMPORT_IN_PROGRESS|IMPORT_PENDING|

      INCOMPATIBLE|LOST|LTFS_WITH_FOREIGN_DATA|OFFLINE|

      ONLINE_IN_PROGRESS|ONLINE_PENDING|PENDING_INSPECTION|

      RAW_IMPORT_IN_PROGRESS|RAW_IMPORT_PENDING|

      SERIAL_NUMBER_MISMATCH|UNKNOWN

   </PreviousState>
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   <Role>NORMAL|TEST</Role>

   <SerialNumber>{string}</SerialNumber>

   <State>

      NORMAL|AUTO_COMPACTION_IN_PROGRESS|BAD|BAR_CODE_MISSING|

      CANNOT_FORMAT_DUE_TO_WRITE_PROTECTION|

      DATA_CHECKPOINT_FAILURE|

      DATA_CHECKPOINT_FAILURE_DUE_TO_READ_ONLY|

      DATA_CHECKPOINT_MISSING|EJECT_FROM_EE_PENDING|

      EJECT_TO_EE_IN_PROGRESS|EJECTED|FOREIGN|FORMAT_IN_PROGRESS|

      FORMAT_PENDING|IMPORT_IN_PROGRESS|IMPORT_PENDING|

      INCOMPATIBLE|LOST|LTFS_WITH_FOREIGN_DATA|OFFLINE|

      ONLINE_IN_PROGRESS|ONLINE_PENDING|PENDING_INSPECTION|

      RAW_IMPORT_IN_PROGRESS|RAW_IMPORT_PENDING|

      SERIAL_NUMBER_MISMATCH|UNKNOWN

   </State>

   <StorageDomainMemberId>{string}</StorageDomainMemberId>

   <TakeOwnershipPending>TRUE|FALSE</TakeOwnershipPending>

   <TotalRawCapacity>{64-bit integer}</TotalRawCapacity>

   <Type>

      LTO5|LTO6|LTO7|LTO8|LTOM8|LTO9|LTO_CLEANING_TAPE|TS_JC|TS_JD|

      TS_JE|TS_JK|TS_JL|TS_JM|TS_JV|TS_JY|TS_JZ|TS_CLEANING_TAPE

      |UNKNOWN|FORBIDDEN

   </Type>
   <VerifyPending>

      CRITICAL|URGENT|HIGH|NORMAL|LOW|BACKGROUND

   </VerifyPending>

   <WriteProtected>TRUE|FALSE</WriteProtected>

</Data>

where the response elements are defined as follows:

Parameter Description

Data A container for the response.

AssignedToStorage
Domain

Whether the tape is currently assigned to a storage domain. Values: TRUE,
FALSE

AvailableRaw
Capacity

The amount of unused raw capacity on the tape in bytes.

BarCode The barcode on the label of the tape cartridge.

BucketId The UUID for the bucket to which the tape is assigned.
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Parameter Description

DescriptionFor
Identification

The LTFS Volume ID and name, if applicable. This is only provided if the
BlackPearl gateway cannot identify the tape.

EjectDate The date and time that the BlackPearl gateway discovered that the tape
was ejected, in the format YYYY-MM-DDThh:mm:ss.xxxZ. If the
parameter is empty, the tape has not been ejected.

EjectLabel The user-entered information to assist in the handling of the tape.

EjectLocation The user-entered information to describe where the ejected tape can be
located.

EjectPending The date and time that the tape was put in the queue to be ejected in the
format YYYY-MM-DDThh:mm:ss.xxxZ. If the parameter is empty, the
tape has not been queued for eject or the eject is no longer cancelable.

FullOfData Whether the tape is completely full of data.
Values: TRUE, FALSE

Id The UUID for the tape.

LastAccessed The last date and time the tape was loaded into a tape drive in the format
YYYY-MM-DDThh:mm:ss.xxxZ.

LastCheckpoint An identifier, internal to the BlackPearl gateway, for verifying the
application integrity of the tape.

LastModified The last date and time the tape was modified in the format YYYY-MM-
DDThh:mm:ss.xxxZ.

LastVerified The last date and time the checksum of the data was verified in the
format YYYY-MM-DDThh:mm:ss.xxxZ.

PartiallyVerified
EndOfTape

The last date and time the BlackPearl gateway verified the data on a
specified percentage of the tape capacity before the EOD marker in the
format
YYYY-MM-DDThh:mm:ss.xxxZ.

PartitionId The UUID for the partition to which the tape belongs.

PreviousState The previous status of the tape. See State on page 664.

Role The role assigned to the tape. Values: Normal, Test

SerialNumber The manufacturer-assigned serial number for the tape.
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Parameter Description

State The status of the tape. Values:
• NORMAL — The tape is ready for use.
• AUTO_COMPACTION_IN_PROGRESS — The tape is in the process of
having unused tape space, due to deleted objects that still reside on a
tape, reclaimed.

• BAD — The tape has been identified as bad due to I/O errors or too
many write cycles.

• BAR_CODE_MISSING — The barcode for the tape is unknown or
missing.

• CANNOT_FORMAT_DUE_TO_WRITE_PROTECTION — The tape is write-
protected and cannot be formatted.

• DATA_CHECKPOINT_FAILURE — The tape should have data on it that is
recognizable to the BlackPearl gateway, but the gateway could not
verify that the data on the tape is at the correct checkpoint or there was
an error rolling back to a checkpoint.

• DATA_CHECKPOINT_FAILURE_DUE_TO_READ_ONLY — The tape should
have data on it that is recognizable to the BlackPearl gateway, but the
gateway could not verify that the data on the tape is at the correct
checkpoint or there was an error rolling back to a checkpoint because
the tape is read only.

• DATA_CHECKPOINT_MISSING — The tape should have data on it that is
recognizable to the BlackPearl gateway, but the checkpoint containing
the data could not be found on the tape.

• EJECT_FROM_EE_PENDING — The tape is in the Entry/Exit (E/E) pool
waiting to be physically ejected.
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Parameter Description

State
(continued)

• EJECT_TO_EE_IN_PROGRESS — The tape is currently being moved to
the E/E pool.

• EJECTED — The tape was ejected from the library and is not physically
present.

• FOREIGN — A tape from another BlackPearl gateway. This data must be
copied into a bucket on this gateway before it is accessible.

• FORMAT_IN_PROGRESS — The tape is currently being formatted.
• FORMAT_PENDING — A format was requested for the tape but has not
yet started.

• IMPORT_IN_PROGRESS — A FOREIGN tape is in the process of being
imported into a bucket.

• IMPORT_PENDING — A FOREIGN tape is queued to be imported into a
bucket.

• INCOMPATIBLE — The tape type is not supported by the BlackPearl
gateway.

• LOST — The tape was removed from the tape library without first
exporting it from a bucket.

• LTFS_WITH_FOREIGN_DATA — An LTFS formatted tape not associated
with a BlackPearl gateway. This data must be copied into a bucket on
this gateway using a raw import before it is accessible.

• OFFLINE — The tape is in the E/E pool and requires user confirmation
to move it to the storage pool and make it online.

• ONLINE_IN_PROGRESS — The tape is in the process of being moved
from the E/E pool to the storage pool. When complete, its state will
change to PENDING_INSPECTION.

• ONLINE_PENDING — The tape was OFFLINE and received user
confirmation to bring it online, but this action has not yet begun.

• PENDING_INSPECTION — The tape has not yet been inspected.
• RAW_IMPORT_IN_PROGRESS — The data on an LTFS formatted tape
not associated with a BlackPearl gateway is being imported into the
BlackPearl gateway.

• RAW_IMPORT_PENDING — An LTFS formatted tape not associated with
a BlackPearl gateway is queued to have the data it contains imported
into the BlackPearl gateway.

• SERIAL_NUMBER_MISMATCH — The tape serial number does not match
the one stored in the BlackPearl gateway.

• UNKNOWN — The tape contains unknown data or is otherwise
unavailable to the BlackPearl gateway.

StorageDomain
MemberId

The UUID for the storage domain member.
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Parameter Description

TakeOwnership
Pending

Whether a tape from another BlackPearl gateway is waiting for the
current gateway to complete taking ownership.
Values:
• TRUE — The foreign tape was imported when WriteProtected was

TRUE, preventing the tape from being claimed by the current gateway.
• FALSE — The tape was imported successfully.

TotalRawCapacity The total raw capacity of the tape in bytes.

Type The tape format and generation of the tape cartridge.
Values: LTO5, LTO6, LTO7, LTO8, LTOM8, LTO9, LTO_CLEANING_TAPE,
TS_JC, TS_JD, TS_JE, TS_JK, TS_JL, TS_JM, TS_JV, TS_JY, TS_JZ, TS_
CLEANING_TAPE, UNKNOWN, FORBIDDEN

VerifyPending The priority for the verify requested, or null if a verify has not been
requested. The priority determines the resources assigned and the
processing order.
Values: CRITICAL, URGENT, HIGH, NORMAL, LOW, BACKGROUND

WriteProtected Whether the tape is write protected. Values: TRUE, FALSE

Example

Sample Request
This request cancels the pending tape eject of the tape with the UUID 1c3fe1dc-95b7-4152-
a286-951d0af2a27e.
PUT http://blackpearl-hostname/_rest_/tape/1c3fe1dc-95b7-4152-a286-

951d0af2a27e/?operation=CANCEL_EJECT HTTP/1.1
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Sample Response
<Data>

   <AssignedToStorageDomain>FALSE</AssignedToStorageDomain>

   <AvailableRawCapacity>2408088338432</AvailableRawCapacity>

   <BarCode>018675L6</BarCode>

   <BucketId>0acaac0a-55f9-4d6b-b410-4179d4696f37</BucketId>

   <DescriptionForIdentification/>

   <EjectDate/>

   <EjectLabel/>

   <EjectLocation/>

   <EjectPending/>

   <FullOfData>FALSE</FullOfData>

   <Id>1c3fe1dc-95b7-4152-a286-951d0af2a27e</Id>

   <LastAccessed/>

   <LastCheckpoint/>

   <LastModified/>

   <LastVerified/>
   <PartiallyVerifiedEndOfTape/>

   <PartitionId>bd91171d-7738-4aea-b319-7abce892a7b1</PartitionId>

   <PreviousState/>
   <Role>normal</Role>

   <SerialNumber>HP-AE1WRUY90E</SerialNumber>

   <State>PENDING_INSPECTION</State>

   <StorageDomainMemberId/>

   <TakeOwnershipPending>FALSE</TakeOwnershipPending>

   <TotalRawCapacity>2408088338432</TotalRawCapacity>

   <Type>LTO6</Type>

   <VerifyPending/>

   <WriteProtected>FALSE</WriteProtected>

</Data>

CANCEL EJECT OF TAPES

Description
Cancel all pending tape ejects. Ejects that are in process are not canceled.
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Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/tape/?operation=CANCEL_EJECT

Request Parameters

Parameter Description Required

operation The operation to perform. For this request, the operation is cancel
eject. Value: CANCEL_EJECT

yes

Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 207: Multi-Status (with list of errors)

Example

Sample Request
This request cancels all pending tape ejects.
PUT http://blackpearl-hostname/_rest_/tape/?operation=CANCEL_EJECT HTTP/1.1

Sample Response
HTTP/1.1 204 No Content
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CANCEL FORMAT OF TAPE

Description
Cancel a pending format on the specified tape. If the format has already begun, it cannot be
canceled.

Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/tape/{tape UUID or

barcode}/?operation=CANCEL_FORMAT

To determine the UUID for a tape, see Get Tapes on page 770.

Request Parameters

Parameter Description Required

operation The operation to perform. For this request, the operation is cancel
format. Value: CANCEL_FORMAT

yes
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Responses

Response Elements
<Data>

   <AssignedToStorageDomain>TRUE|FALSE</AssignedToStorageDomain>

   <AvailableRawCapacity>{64-bit integer}</AvailableRawCapacity>

   <BarCode>{string}</BarCode>

   <BucketId>{string}</BucketId>

   <DescriptionForIdentification>

{string}

   </DescriptionForIdentification>

   <EjectDate>{YYYY-MM-DDThh:mm:ss.xxxZ}</EjectDate>

   <EjectLabel>{string}</EjectLabel>

   <EjectLocation>{string}</EjectLocation>

   <EjectPending>{YYYY-MM-DDThh:mm:ss.xxxZ}</EjectPending>

   <FullOfData>TRUE|FALSE</FullOfData>

   <Id>{string}</Id>

   <LastAccessed>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastAccessed>

   <LastCheckpoint>{string}</LastCheckpoint>

   <LastModified>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastModified>

   <LastVerified>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastVerified>
   <PartiallyVerifiedEndOfTape>

{YYYY-MM-DDThh:mm:ss.xxxZ}

   </PartiallyVerifiedEndOfTape>

   <PartitionId>{string}</PartitionId>
   <PreviousState>

      NORMAL|AUTO_COMPACTION_IN_PROGRESS|BAD|BAR_CODE_MISSING|

      CANNOT_FORMAT_DUE_TO_WRITE_PROTECTION|

      DATA_CHECKPOINT_FAILURE|

      DATA_CHECKPOINT_FAILURE_DUE_TO_READ_ONLY|

      DATA_CHECKPOINT_MISSING|EJECT_FROM_EE_PENDING|

      EJECT_TO_EE_IN_PROGRESS|EJECTED|FOREIGN|FORMAT_IN_PROGRESS|

      FORMAT_PENDING|IMPORT_IN_PROGRESS|IMPORT_PENDING|

      INCOMPATIBLE|LOST|LTFS_WITH_FOREIGN_DATA|OFFLINE|

      ONLINE_IN_PROGRESS|ONLINE_PENDING|PENDING_INSPECTION|

      RAW_IMPORT_IN_PROGRESS|RAW_IMPORT_PENDING|

      SERIAL_NUMBER_MISMATCH|UNKNOWN

   </PreviousState>
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   <Role>NORMAL|TEST</Role>

   <SerialNumber>{string}</SerialNumber>

   <State>

      NORMAL|AUTO_COMPACTION_IN_PROGRESS|BAD|BAR_CODE_MISSING|

      CANNOT_FORMAT_DUE_TO_WRITE_PROTECTION|

      DATA_CHECKPOINT_FAILURE|

      DATA_CHECKPOINT_FAILURE_DUE_TO_READ_ONLY|

      DATA_CHECKPOINT_MISSING|EJECT_FROM_EE_PENDING|

      EJECT_TO_EE_IN_PROGRESS|EJECTED|FOREIGN|FORMAT_IN_PROGRESS|

      FORMAT_PENDING|IMPORT_IN_PROGRESS|IMPORT_PENDING|

      INCOMPATIBLE|LOST|LTFS_WITH_FOREIGN_DATA|OFFLINE|

      ONLINE_IN_PROGRESS|ONLINE_PENDING|PENDING_INSPECTION|

      RAW_IMPORT_IN_PROGRESS|RAW_IMPORT_PENDING|

      SERIAL_NUMBER_MISMATCH|UNKNOWN

   </State>

   <StorageDomainMemberId>{string}</StorageDomainMemberId>

   <TakeOwnershipPending>TRUE|FALSE</TakeOwnershipPending>

   <TotalRawCapacity>{64-bit integer}</TotalRawCapacity>

   <Type>

      LTO5|LTO6|LTO7|LTO8|LTOM8|LTO9|LTO_CLEANING_TAPE|TS_JC|TS_JD|

      TS_JE|TS_JK|TS_JL|TS_JM|TS_JV|TS_JY|TS_JZ|TS_CLEANING_TAPE

      |UNKNOWN|FORBIDDEN

   </Type>

   <VerifyPending>

      CRITICAL|URGENT|HIGH|NORMAL|LOW|BACKGROUND

   </VerifyPending>

   <WriteProtected>TRUE|FALSE</WriteProtected>

</Data>

where the response elements are defined as follows:

Parameter Description

Data A container for the response.

AssignedToStorageDomain Whether the tape is currently assigned to a storage domain.
Values: TRUE, FALSE

AvailableRaw
Capacity

The amount of unused raw capacity on the tape in bytes.

BarCode The barcode on the label of the tape cartridge.

BucketId The UUID for the bucket to which the tape is assigned.
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Parameter Description

DescriptionForIdentification The LTFS Volume ID and name, if applicable. This is only
provided if the BlackPearl gateway cannot identify the tape.

EjectDate The date and time that the BlackPearl gateway discovered that
the tape was ejected, in the format YYYY-MM-
DDThh:mm:ss.xxxZ. If the parameter is empty, the tape has not
been ejected.

EjectLabel The user-entered information to assist in the handling of the
tape.

EjectLocation The user-entered information to describe where the ejected tape
can be located.

EjectPending The date and time that the tape was put in the queue to be
ejected in the format YYYY-MM-DDThh:mm:ss.xxxZ. If the
parameter is empty, the tape has not been queued to be ejected
or the eject has started and is no longer cancelable.

FullOfData Whether the tape is completely full of data.
Values: TRUE, FALSE

Id The UUID for the tape.

LastAccessed The last date and time the tape was loaded into a tape drive in
the format YYYY-MM-DDThh:mm:ss.xxxZ.

LastCheckpoint An identifier, internal to the BlackPearl gateway, for verifying
the application integrity of the tape.

LastModified The last date and time the tape was modified in the format
YYYY-MM-DDThh:mm:ss.xxxZ.

LastVerified The last date and time the checksum of the data was verified in
the format YYYY-MM-DDThh:mm:ss.xxxZ.

PartiallyVerified
EndOfTape

The last date and time the BlackPearl gateway verified the data
on a specified percentage of the tape capacity before the EOD
marker in the format
YYYY-MM-DDThh:mm:ss.xxxZ.

PartitionId The UUID for the partition to which the tape belongs.

PreviousState The previous status of the tape. See State on page 664.
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Parameter Description

Role The role assigned to the tape. Values: Normal, Test

SerialNumber The manufacturer-assigned serial number for the tape.

State The status of the tape. See State on page 664.

StorageDomain
MemberId

The UUID for the storage domain member.

TakeOwnership Pending Whether a tape from another BlackPearl gateway is waiting for
the current gateway to complete taking ownership.
Values:
• TRUE — The foreign tape was imported when
WriteProtected was TRUE, preventing the tape from being
claimed by the current gateway.

• FALSE — The tape was imported successfully.

TotalRawCapacity The total raw capacity of the tape in bytes.

Type The tape format and generation of the tape cartridge.
Values: LTO5, LTO6, LTO7, LTO8, LTOM8, LTO9, LTO_CLEANING_
TAPE, TS_JC, TS_JD, TS_JE, TS_JK, TS_JL, TS_JM, TS_JV, TS_JY,
TS_JZ, TS_CLEANING_TAPE, UNKNOWN, FORBIDDEN

VerifyPending The priority for the verify requested, or null if a verify has not
been requested. The priority determines the resources assigned
and the processing order.
Values: CRITICAL, URGENT, HIGH, NORMAL, LOW, BACKGROUND

WriteProtected Whether the tape is write protected. Values: TRUE, FALSE

Example

Sample Request
This request cancels the pending tape format of the tape with the UUID 1c3fe1dc-95b7-4152-
a286-951d0af2a27e.
PUT http://blackpearl-hostname/_rest_/tape/1c3fe1dc-95b7-4152-a286-

951d0af2a27e/?operation=CANCEL_FORMAT HTTP/1.1
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Sample Response
HTTP/1.1 200 OK

<Data>

   <AssignedToStorageDomain>FALSE</AssignedToStorageDomain>

   <AvailableRawCapacity>2408088338432</AvailableRawCapacity>

   <BarCode>018675L6</BarCode>

   <BucketId>0acaac0a-55f9-4d6b-b410-4179d4696f37</BucketId>

   <DescriptionForIdentification/>

   <EjectDate/>

   <EjectLabel/>

   <EjectLocation/>

   <EjectPending/>

   <FullOfData>FALSE</FullOfData>

   <Id>1c3fe1dc-95b7-4152-a286-951d0af2a27e</Id>

   <LastAccessed/>

   <LastCheckpoint/>

   <LastModified/>

   <LastVerified/>

   <PartiallyVerifiedEndOfTape/>

   <PartitionId>bd91171d-7738-4aea-b319-7abce892a7b1</PartitionId>

   <PreviousState/>
   <Role>NORMAL</Role>

   <SerialNumber>HP-AE1WRUY90E</SerialNumber>

   <State>PENDING_INSPECTION</State>

   <StorageDomainMemberId/>

   <TakeOwnershipPending>FALSE</TakeOwnershipPending>

   <TotalRawCapacity>2408088338432</TotalRawCapacity>

   <Type>LTO6</Type>

   <VerifyPending/>

   <WriteProtected>FALSE</WriteProtected>

</Data>

CANCEL FORMAT OF TAPES

Description
Cancel all pending tape formats. Formats that have already begun are not canceled.
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Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/tape/?operation=CANCEL_FORMAT

Request Parameters

Parameter Description Required

operation The operation to perform. For this request, the operation is cancel
format. Value: CANCEL_FORMAT

yes

Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 207: Multi-Status (with list of errors)

Example

Sample Request
This request cancels all pending tape formats.
PUT http://blackpearl-hostname/_rest_/tape/?operation=CANCEL_FORMAT HTTP/1.1

Sample Response
HTTP/1.1 204 No Content

CANCEL IMPORT OF FOREIGN TAPE

Description
Cancels the pending import of the specified tape associated with a different BlackPearl
gateway. If the import is in process, it cannot be canceled.
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Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/tape/{tape UUID or

barcode}/?operation=CANCEL_IMPORT

To determine the UUID for a tape, see Get Tapes on page 770.

Request Parameters

Parameter Description Required

operation The operation to perform. For this request, the operation is cancel
importing. Value: CANCEL_IMPORT

yes

Responses

Response Elements
<Data>

   <AssignedToStorageDomain>TRUE|FALSE</AssignedToStorageDomain>

   <AvailableRawCapacity>{64-bit integer}</AvailableRawCapacity>

   <BarCode>{string}</BarCode>

   <BucketId>{string}</BucketId>

   <DescriptionForIdentification>

{string}

   </DescriptionForIdentification>

   <EjectDate>{YYYY-MM-DDThh:mm:ss.xxxZ}</EjectDate>

   <EjectLabel>{string}</EjectLabel>

   <EjectLocation>{string}</EjectLocation>

   <EjectPending>{YYYY-MM-DDThh:mm:ss.xxxZ}</EjectPending>

   <FullOfData>TRUE|FALSE</FullOfData>

   <Id>{string}</Id>
   <LastAccessed>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastAccessed>

   <LastCheckpoint>{string}</LastCheckpoint>

   <LastModified>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastModified>

   <LastVerified>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastVerified>
   <PartiallyVerifiedEndOfTape>

{YYYY-MM-DDThh:mm:ss.xxxZ}

   </PartiallyVerifiedEndOfTape>
   <PartitionId>{string}</PartitionId>

April 2023 DS3 API Reference-Spectra BlackPearl Nearline Gateway
- 676 -



Chapter 16 - Tape Library and Component Operations Cancel Import of Foreign Tape

   <PreviousState>

      NORMAL|AUTO_COMPACTION_IN_PROGRESS|BAD|BAR_CODE_MISSING|

      CANNOT_FORMAT_DUE_TO_WRITE_PROTECTION|

      DATA_CHECKPOINT_FAILURE|

      DATA_CHECKPOINT_FAILURE_DUE_TO_READ_ONLY|

      DATA_CHECKPOINT_MISSING|EJECT_FROM_EE_PENDING|

      EJECT_TO_EE_IN_PROGRESS|EJECTED|FOREIGN|FORMAT_IN_PROGRESS|

      FORMAT_PENDING|IMPORT_IN_PROGRESS|IMPORT_PENDING|

      INCOMPATIBLE|LOST|LTFS_WITH_FOREIGN_DATA|OFFLINE|

      ONLINE_IN_PROGRESS|ONLINE_PENDING|PENDING_INSPECTION|

      RAW_IMPORT_IN_PROGRESS|RAW_IMPORT_PENDING|

      SERIAL_NUMBER_MISMATCH|UNKNOWN

   </PreviousState>
   <Role>NORMAL|TEST</Role>
   <SerialNumber>{string}</SerialNumber>
   <State>

      NORMAL|AUTO_COMPACTION_IN_PROGRESS|BAD|BAR_CODE_MISSING|

      CANNOT_FORMAT_DUE_TO_WRITE_PROTECTION|

      DATA_CHECKPOINT_FAILURE|

      DATA_CHECKPOINT_FAILURE_DUE_TO_READ_ONLY|

      DATA_CHECKPOINT_MISSING|EJECT_FROM_EE_PENDING|

      EJECT_TO_EE_IN_PROGRESS|EJECTED|FOREIGN|FORMAT_IN_PROGRESS|

      FORMAT_PENDING|IMPORT_IN_PROGRESS|IMPORT_PENDING|

      INCOMPATIBLE|LOST|LTFS_WITH_FOREIGN_DATA|OFFLINE|

      ONLINE_IN_PROGRESS|ONLINE_PENDING|PENDING_INSPECTION|

      RAW_IMPORT_IN_PROGRESS|RAW_IMPORT_PENDING|

      SERIAL_NUMBER_MISMATCH|UNKNOWN

   </State>
   <StorageDomainMemberId>{string}</StorageDomainMemberId>

   <TakeOwnershipPending>TRUE|FALSE</TakeOwnershipPending>

   <TotalRawCapacity>{64-bit integer}</TotalRawCapacity>
   <Type>

      LTO5|LTO6|LTO7|LTO8|LTOM8|LTO9|LTO_CLEANING_TAPE|TS_JC|TS_JD|

      TS_JE|TS_JK|TS_JL|TS_JM|TS_JV|TS_JY|TS_JZ|TS_CLEANING_TAPE

      |UNKNOWN|FORBIDDEN

   </Type>
   <VerifyPending>

      CRITICAL|URGENT|HIGH|NORMAL|LOW|BACKGROUND

   </VerifyPending>

   <WriteProtected>TRUE|FALSE</WriteProtected>

</Data>
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where the response elements are defined as follows:

Parameter Description

Data A container for the response.

AssignedToStorageDomain Whether the tape is currently assigned to a storage domain.
Values: TRUE, FALSE

AvailableRaw
Capacity

The amount of unused raw capacity on the tape in bytes.

BarCode The barcode on the label of the tape cartridge.

BucketId The UUID for the bucket to which the tape is assigned.

DescriptionForIdentification The LTFS Volume ID and name, if applicable. This is only
provided if the BlackPearl gateway cannot identify the tape.

EjectDate The date and time that the BlackPearl gateway discovered that
the tape was ejected, in the format YYYY-MM-
DDThh:mm:ss.xxxZ. If the parameter is empty, the tape has not
been ejected.

EjectLabel The user-entered information to assist in the handling of the
tape.

EjectLocation The user-entered information to describe where the ejected tape
can be located.

EjectPending The date and time that the tape was put in the queue to be
ejected in the format YYYY-MM-DDThh:mm:ss.xxxZ. If the
parameter is empty, the tape has not been queued to be ejected
or the eject has started and is no longer cancelable.

FullOfData Whether the tape is completely full of data.
Values: TRUE, FALSE

Id The UUID for the tape.

LastAccessed The last date and time the tape was loaded into a tape drive in
the format YYYY-MM-DDThh:mm:ss.xxxZ.

LastCheckpoint An identifier, internal to the BlackPearl gateway, for verifying
the application integrity of the tape.

LastModified The last date and time the tape was modified in the format
YYYY-MM-DDThh:mm:ss.xxxZ.
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Parameter Description

LastVerified The last date and time the checksum of the data was verified in
the format YYYY-MM-DDThh:mm:ss.xxxZ.

PartiallyVerified
EndOfTape

The last date and time the BlackPearl gateway verified the data
on a specified percentage of the tape capacity before the EOD
marker in the format
YYYY-MM-DDThh:mm:ss.xxxZ.

PartitionId The UUID for the partition to which the tape belongs.

PreviousState The previous status of the tape. See State on page 664.

Role The role assigned to the tape. Values: Normal, Test

SerialNumber The manufacturer-assigned serial number for the tape.

State The status of the tape. See State on page 664.

StorageDomain
MemberId

The UUID for the storage domain member.

TakeOwnership Pending Whether a tape from another BlackPearl gateway is waiting for
the current gateway to complete taking ownership.
Values:
• TRUE — The foreign tape was imported when
WriteProtected was TRUE, preventing the tape from being
claimed by the current gateway.

• FALSE — The tape was imported successfully.

TotalRawCapacity The total raw capacity of the tape in bytes.

Type The tape format and generation of the tape cartridge.
Values: LTO5, LTO6, LTO7, LTO8, LTOM8, LTO9, LTO_CLEANING_
TAPE, TS_JC, TS_JD, TS_JE, TS_JK, TS_JL, TS_JM, TS_JV, TS_JY,
TS_JZ, TS_CLEANING_TAPE, UNKNOWN, FORBIDDEN

VerifyPending The priority for the verify requested, or null if a verify has not
been requested. The priority determines the resources assigned
and the processing order.
Values: CRITICAL, URGENT, HIGH, NORMAL, LOW, BACKGROUND

WriteProtected Whether the tape is write protected. Values: TRUE, FALSE
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Example

Sample Request
This request cancels the pending import of the tape with the UUID f45cfc34-b72c-4986-ba58-
53d02ed3f399.
PUT http://blackpearl-hostname/_rest_/tape/f45cfc34-b72c-4986-ba58-

53d02ed3f399/?operation=CANCEL_IMPORT HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>

   <AssignedToStorageDomain>FALSE</AssignedToStorageDomain>

   <AvailableRawCapacity>10000</AvailableRawCapacity>

   <BarCode>018665L5</BarCode>

   <BucketId/>
   <DescriptionForIdentification/>

   <EjectDate/>

   <EjectLabel/>

   <EjectLocation/>

   <EjectPending/>
   <FullOfData>FALSE</FullOfData>

   <Id>f45cfc34-b72c-4986-ba58-53d02ed3f399</Id>

   <LastAccessed/>

   <LastCheckpoint/>

   <LastModified/>
   <LastVerified/>
   <PartiallyVerifiedEndOfTape/>

   <PartitionId>6391abc1-4136-496e-a7a1-0d1994b84129</PartitionId>

   <PreviousState/>
   <Role>NORMAL</Role>

   <SerialNumber/>

   <State>PENDING_INSPECTION</State>

   <StorageDomainMemberId/>
   <TakeOwnershipPending>FALSE</TakeOwnershipPending>

   <TotalRawCapacity>1425000103936</TotalRawCapacity>

   <Type>LTO5</Type>

   <VerifyPending/>

   <WriteProtected>FALSE</WriteProtected>

</Data>
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CANCEL IMPORT OF FOREIGN TAPES

Description
Cancel all pending imports of tapes associated with other BlackPearl gateways. Imports that
have already begun cannot be canceled.

Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/tape/?operation=CANCEL_IMPORT

Request Parameters

Parameter Description Required

operation The operation to perform. For this request, the operation is cancel
importing. Value: CANCEL_IMPORT

yes

Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 207: Multi-Status (with list of errors)

Example

Sample Request
This request cancels pending imports for all foreign tapes.
GET http://blackpearl-hostname/_rest_/tape?operation=CANCEL_IMPORT HTTP/1.1

Sample Response
HTTP/1.1 204 No Content
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CANCEL ONLINE OF TAPE

Description
Cancels the onlining, or movement of the specified tape from the entry/exit pool to the
storage pool. If the move is in process, it cannot be canceled.

Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/tape/{tape UUID or

barcode}/?operation=CANCEL_ONLINE

To determine the UUID for a tape, see Get Tapes on page 770.

Request Parameters

Parameter Description Required

operation The operation to perform. For this request, the operation is cancel
onlining. Value: CANCEL_ONLINE

yes

Responses

Response Elements
<Data>

   <AssignedToStorageDomain>TRUE|FALSE</AssignedToStorageDomain>

   <AvailableRawCapacity>{64-bit integer}</AvailableRawCapacity>

   <BarCode>{string}</BarCode>

   <BucketId>{string}</BucketId>

   <DescriptionForIdentification>

{string}

   </DescriptionForIdentification>
   <EjectDate>{YYYY-MM-DDThh:mm:ss.xxxZ}</EjectDate>

   <EjectLabel>{string}</EjectLabel>

   <EjectLocation>{string}</EjectLocation>

   <EjectPending>{YYYY-MM-DDThh:mm:ss.xxxZ}</EjectPending>

   <FullOfData>TRUE|FALSE</FullOfData>

April 2023 DS3 API Reference-Spectra BlackPearl Nearline Gateway
- 682 -



Chapter 16 - Tape Library and Component Operations Cancel Online of Tape

   <Id>{string}</Id>

   <LastAccessed>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastAccessed>

   <LastCheckpoint>{string}</LastCheckpoint>

   <LastModified>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastModified>

   <LastVerified>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastVerified>
   <PartiallyVerifiedEndOfTape>

{YYYY-MM-DDThh:mm:ss.xxxZ}

   </PartiallyVerifiedEndOfTape>
   <PartitionId>{string}</PartitionId>
   <PreviousState>

      NORMAL|AUTO_COMPACTION_IN_PROGRESS|BAD|BAR_CODE_MISSING|

      CANNOT_FORMAT_DUE_TO_WRITE_PROTECTION|

      DATA_CHECKPOINT_FAILURE|

      DATA_CHECKPOINT_FAILURE_DUE_TO_READ_ONLY|

      DATA_CHECKPOINT_MISSING|EJECT_FROM_EE_PENDING|

      EJECT_TO_EE_IN_PROGRESS|EJECTED|FOREIGN|FORMAT_IN_PROGRESS|

      FORMAT_PENDING|IMPORT_IN_PROGRESS|IMPORT_PENDING|

      INCOMPATIBLE|LOST|LTFS_WITH_FOREIGN_DATA|OFFLINE|

      ONLINE_IN_PROGRESS|ONLINE_PENDING|PENDING_INSPECTION|

      RAW_IMPORT_IN_PROGRESS|RAW_IMPORT_PENDING|

      SERIAL_NUMBER_MISMATCH|UNKNOWN

   </PreviousState>
   <Role>NORMAL|TEST</Role>
   <SerialNumber>{string}</SerialNumber>

   <State>

      NORMAL|AUTO_COMPACTION_IN_PROGRESS|BAD|BAR_CODE_MISSING|

      CANNOT_FORMAT_DUE_TO_WRITE_PROTECTION|

      DATA_CHECKPOINT_FAILURE|

      DATA_CHECKPOINT_FAILURE_DUE_TO_READ_ONLY|

      DATA_CHECKPOINT_MISSING|EJECT_FROM_EE_PENDING|

      EJECT_TO_EE_IN_PROGRESS|EJECTED|FOREIGN|FORMAT_IN_PROGRESS|

      FORMAT_PENDING|IMPORT_IN_PROGRESS|IMPORT_PENDING|

      INCOMPATIBLE|LOST|LTFS_WITH_FOREIGN_DATA|OFFLINE|

      ONLINE_IN_PROGRESS|ONLINE_PENDING|PENDING_INSPECTION|

      RAW_IMPORT_IN_PROGRESS|RAW_IMPORT_PENDING|

      SERIAL_NUMBER_MISMATCH|UNKNOWN

   </State>
   <StorageDomainMemberId>{string}</StorageDomainMemberId>

   <TakeOwnershipPending>TRUE|FALSE</TakeOwnershipPending>

   <TotalRawCapacity>{64-bit integer}</TotalRawCapacity>

   <Type>

      LTO5|LTO6|LTO7|LTO8|LTOM8|LTO9|LTO_CLEANING_TAPE|TS_JC|TS_JD|

      TS_JE|TS_JK|TS_JL|TS_JM|TS_JV|TS_JY|TS_JZ|TS_CLEANING_TAPE

      |UNKNOWN|FORBIDDEN

   </Type>
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   <VerifyPending>

      CRITICAL|URGENT|HIGH|NORMAL|LOW|BACKGROUND

   </VerifyPending>

   <WriteProtected>TRUE|FALSE</WriteProtected>

</Data>

where the response elements are defined as follows:

Parameter Description

Data A container for the response.

AssignedToStorageDomain Whether the tape is currently assigned to a storage domain.
Values: TRUE, FALSE

AvailableRaw
Capacity

The amount of unused raw capacity on the tape in bytes.

BarCode The barcode on the label of the tape cartridge.

BucketId The UUID for the bucket to which the tape is assigned.

DescriptionForIdentification The LTFS Volume ID and name, if applicable. This is only
provided if the BlackPearl gateway cannot identify the tape.

EjectDate The date and time that the BlackPearl gateway discovered that
the tape was ejected, in the format YYYY-MM-
DDThh:mm:ss.xxxZ. If the parameter is empty, the tape has not
been ejected.

EjectLabel The user-entered information to assist in the handling of the
tape.

EjectLocation The user-entered information to describe where the ejected tape
can be located.

EjectPending The date and time that the tape was put in the queue to be
ejected in the format YYYY-MM-DDThh:mm:ss.xxxZ. If the
parameter is empty, the tape has not been queued to be ejected
or the eject has started and is no longer cancelable.

FullOfData Whether the tape is completely full of data.
Values: TRUE, FALSE

Id The UUID for the tape.

LastAccessed The last date and time the tape was loaded into a tape drive in
the format YYYY-MM-DDThh:mm:ss.xxxZ.
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Parameter Description

LastCheckpoint An identifier, internal to the BlackPearl gateway, for verifying
the application integrity of the tape.

LastModified The last date and time the tape was modified in the format
YYYY-MM-DDThh:mm:ss.xxxZ.

LastVerified The last date and time the checksum of the data was verified in
the format YYYY-MM-DDThh:mm:ss.xxxZ.

PartiallyVerified
EndOfTape

The last date and time the BlackPearl gateway verified the data
on a specified percentage of the tape capacity before the EOD
marker in the format
YYYY-MM-DDThh:mm:ss.xxxZ.

PartitionId The UUID for the partition to which the tape belongs.

PreviousState The previous status of the tape. See State on page 664.

Role The role assigned to the tape. Values: Normal, Test

SerialNumber The manufacturer-assigned serial number for the tape.

State The status of the tape. See State on page 664.

StorageDomain
MemberId

The UUID for the storage domain member.

TakeOwnership Pending Whether a tape from another BlackPearl gateway is waiting for
the current gateway to complete taking ownership.
Values:
• TRUE — The foreign tape was imported when
WriteProtected was TRUE, preventing the tape from being
claimed by the current gateway.

• FALSE — The tape was imported successfully.

TotalRawCapacity The total raw capacity of the tape in bytes.

Type The tape format and generation of the tape cartridge.
Values: LTO5, LTO6, LTO7, LTO8, LTOM8, LTO9, LTO_CLEANING_
TAPE, TS_JC, TS_JD, TS_JE, TS_JK, TS_JL, TS_JM, TS_JV, TS_JY,
TS_JZ, TS_CLEANING_TAPE, UNKNOWN, FORBIDDEN
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Parameter Description

VerifyPending The priority for the verify requested, or null if a verify has not
been requested. The priority determines the resources assigned
and the processing order.
Values: CRITICAL, URGENT, HIGH, NORMAL, LOW, BACKGROUND

WriteProtected Whether the tape is write protected. Values: TRUE, FALSE

Example

Sample Request
This request cancels the pending onlining of the tape with the UUID 1c3fe1dc-95b7-4152-
a286-951d0af2a27e.
PUT http://blackpearl-hostname/_rest_/tape/1c3fe1dc-95b7-4152-a286-

951d0af2a27e/?operation=CANCEL_ONLINE HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>

   <AssignedToStorageDomain>FALSE</AssignedToStorageDomain>

   <AvailableRawCapacity>2408088338432</AvailableRawCapacity>

   <BarCode>018675L6</BarCode>

   <BucketId>0acaac0a-55f9-4d6b-b410-4179d4696f37</BucketId>

   <DescriptionForIdentification/>

   <EjectDate/>

   <EjectLabel/>
   <EjectLocation/>

   <EjectPending/>

   <FullOfData>FALSE</FullOfData>

   <Id>1c3fe1dc-95b7-4152-a286-951d0af2a27e</Id>

   <LastAccessed/>

   <LastCheckpoint/>
   <LastModified/>

   <LastVerified/>
   <PartiallyVerifiedEndOfTape/>

   <PartitionId>bd91171d-7738-4aea-b319-7abce892a7b1</PartitionId>

   <PreviousState/>
   <Role>NORMAL</Role>

   <SerialNumber>HP-AE1WRUY90E</SerialNumber>

   <State>OFFLINE</State>
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   <StorageDomainMemberId/>

   <TakeOwnershipPending>FALSE</TakeOwnershipPending>

   <TotalRawCapacity>2408088338432</TotalRawCapacity>

   <Type>LTO6</Type>

   <VerifyPending/>

   <WriteProtected>FALSE</WriteProtected>

</Data>

CANCEL ONLINE OF TAPES

Description
Cancels the onlining, or movement of all tapes from the entry/exit pool to the storage pool.
Onlining that is in process cannot be canceled.

Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/tape/?operation=CANCEL_ONLINE

Request Parameters

Parameter Description Required

operation The operation to perform. For this request, the operation is cancel
onlining. Value: CANCEL_ONLINE

yes

Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 207: Multi-Status (with list of errors)

April 2023 DS3 API Reference-Spectra BlackPearl Nearline Gateway
- 687 -



Chapter 16 - Tape Library and Component Operations Cancel Online of Tapes

Example

Sample Request
This request cancels pending onlining for all tapes.
PUT http://blackpearl-hostname/_rest_/tape/?operation=CANCEL_ONLINE HTTP/1.1

Sample Response
HTTP/1.1 204 No Content
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Cancel Test Tape Drive

Description
Cancels a pending tape drive test.

Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/tape_drive/{drive UUID or other unique

attribute}/?operation=CANCEL_TEST

Request Parameters

Parameter Description Required

operation The operation to perform. For this request, the operation is to cancel
a pending tape drive test. Value: CANCEL_TEST

yes

Responses

Response Elements
<Data>
   <CleaningRequired>TRUE|FALSE</CleaningRequired>
   <ErrorMessage>{string}</ErrorMessage
   <ForceTapeRemoval>TRUE|FALSE</ForceTapeRemoval>
   <Id>{string}</Id>
   <LastCleaned>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastCleaned>
   <MaxFailedTapes>{64-bit integer}</MaxFailedTapes>
   <MfgSerialNumber>{string}</MfgSerialNumber>
   <MinimumTaskPriority>ANY|LOW|NORMAL|HIGH|URGENT</MinimumTaskPriority>
   <PartitionId>{string}</PartitionId>
   <Quiesced>NO|PENDING|YES</Quiesced>
   <ReservedTaskType>ANY|READ|WRITE|MAINTENANCE</ReservedTaskType>
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   <State>

      NORMAL|AUTO_COMPACTION_IN_PROGRESS|BAD|BAR_CODE_MISSING|

      CANNOT_FORMAT_DUE_TO_WRITE_PROTECTION|

      DATA_CHECKPOINT_FAILURE|

      DATA_CHECKPOINT_FAILURE_DUE_TO_READ_ONLY|

      DATA_CHECKPOINT_MISSING|EJECT_FROM_EE_PENDING|

      EJECT_TO_EE_IN_PROGRESS|EJECTED|FOREIGN|FORMAT_IN_PROGRESS|

      FORMAT_PENDING|IMPORT_IN_PROGRESS|IMPORT_PENDING|

      INCOMPATIBLE|LOST|LTFS_WITH_FOREIGN_DATA|OFFLINE|

      ONLINE_IN_PROGRESS|ONLINE_PENDING|PENDING_INSPECTION|

      RAW_IMPORT_IN_PROGRESS|RAW_IMPORT_PENDING|

      SERIAL_NUMBER_MISMATCH|UNKNOWN

   </State>
   <TapeId>{string}</TapeId>
   <Type>{string}</Type>

</Data>

where the response elements are defined as follows:

Parameter Description

Data A container for the response.

CleaningRequired Whether the tape drive indicates that it needs to be cleaned. Values: TRUE,
FALSE

ErrorMessage A description of any current error, if applicable.

ForceTapeRemoval Whether the tape drive is in an error state and asking that the tape in it be
forcibly removed. If required, this is performed before any other
operations.
Values: TRUE, FALSE

ID The UUID for the tape drive.

LastCleaned The last date and time the tape drive was cleaned in the format YYYY-MM-
DDThh:mm:ss.xxxZ.

MaxFailedTapes The maximum number of times a drive can fail tasks with different tapes
before it is no longer used. If set to zero, the BlackPearl gateway does not
automatically quiesce the tape drive.

MfgSerialNumber The manufacturer-assigned serial number for the tape drive.

MinimumTask
Prioirity

The minimum priority task for which the drive is reserved. Values: ANY,
LOW, NORMAL, HIGH, URGENT
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Parameter Description

PartitionId The UUID for the partition to which the drive belongs.

Quiesced Whether the tape drive is in a temporarily inactive state. Values: NO,
PENDING, YES

ReservedTaskType Whether the drive is reserved for reads only or writes only, or can be used
for reads or writes.
Values: ANY, READ, WRITE, MAINTENANCE

SerialNumber The location-based serial number for the drive while it is in the library.

State The status of the tape drive. Cancel Test Tape Drive on page 689.

TapeId The UUID for the tape in the tape drive, if present.

Type The tape format and generation of the tape drive.
Values: LTO5, LTO6, LTO7, LTO8, LTOM8, LTO9, TS1140, TS1150, TS1155,
TS1160, UNKNOWN

Example

Sample Request
This request cancels a pending tape drive test to the drive with UUID a3f6fb78-19ef-409f-
b0c1-2bd9fc69fe70.
PUT http[s]://blackpearl-hostnam/_rest_/tape_drive/a3f6fb78-19ef-409f-b0c1-

2bd9fc69fe70/?operation=cancel_test HTTP/1.1

Sample Response
<Data>
   <CleaningRequired>false</CleaningRequired>
   <ErrorMessage/>
   <ForceTapeRemoval>false</ForceTapeRemoval>
   <Id>a3f6fb78-19ef-409f-b0c1-2bd9fc69fe70</Id>
   <LastCleaned/>
   <MaxFailedTapes>3</MaxFailedTapes>
   <MfgSerialNumber/>
   <MinimumTaskPriority/>
   <PartitionId>1651288a-fd0d-43be-8cc5-1e7c6bbe55f</PartitionId>
   <Quiesced>NO</Quiesced>
   <ReservedTaskType>ANY</ReservedTaskType>
   <SerialNumber>td1</SerialNumber>
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   <State>NORMAL</State><TapeId/>
   <Type>LTO5</Type>

</Data>

CANCEL VERIFY OF TAPE

Description
Cancels a pending tape verification on the specified tape. If the verify has already begun, it
cannot be canceled.

Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/tape/{tape UUID or

barcode}/?operation=CANCEL_VERIFY

To determine the UUID for a tape, see Get Tapes on page 770.

Request Parameters

Parameter Description Required

operation The operation to perform. For this request, the operation is cancel
verify. Value: CANCEL_VERIFY

yes

Responses

Response Elements
<Data>

   <AssignedToStorageDomain>TRUE|FALSE</AssignedToStorageDomain>

   <AvailableRawCapacity>{64-bit integer}</AvailableRawCapacity>

   <BarCode>{string}</BarCode>

   <BucketId>{string}</BucketId>

   <DescriptionForIdentification>

{string}

   </DescriptionForIdentification>
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   <EjectDate>{YYYY-MM-DDThh:mm:ss.xxxZ}</EjectDate>

   <EjectLabel>{string}</EjectLabel>

   <EjectLocation>{string}</EjectLocation>

   <EjectPending>{YYYY-MM-DDThh:mm:ss.xxxZ}</EjectPending>

   <FullOfData>TRUE|FALSE</FullOfData>
   <Id>{string}</Id>

   <LastAccessed>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastAccessed>

   <LastCheckpoint>{string}</LastCheckpoint>

   <LastModified>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastModified>

   <LastVerified>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastVerified>
   <PartiallyVerifiedEndOfTape>

{YYYY-MM-DDThh:mm:ss.xxxZ}

   </PartiallyVerifiedEndOfTape>
   <PartitionId>{string}</PartitionId>
   <PreviousState>

      NORMAL|AUTO_COMPACTION_IN_PROGRESS|BAD|BAR_CODE_MISSING|

      CANNOT_FORMAT_DUE_TO_WRITE_PROTECTION|

      DATA_CHECKPOINT_FAILURE|

      DATA_CHECKPOINT_FAILURE_DUE_TO_READ_ONLY|

      DATA_CHECKPOINT_MISSING|EJECT_FROM_EE_PENDING|

      EJECT_TO_EE_IN_PROGRESS|EJECTED|FOREIGN|FORMAT_IN_PROGRESS|

      FORMAT_PENDING|IMPORT_IN_PROGRESS|IMPORT_PENDING|

      INCOMPATIBLE|LOST|LTFS_WITH_FOREIGN_DATA|OFFLINE|

      ONLINE_IN_PROGRESS|ONLINE_PENDING|PENDING_INSPECTION|

      RAW_IMPORT_IN_PROGRESS|RAW_IMPORT_PENDING|

      SERIAL_NUMBER_MISMATCH|UNKNOWN

   </PreviousState>
   <Role>NORMAL|TEST</Role>
   <SerialNumber>{string}</SerialNumber>

   <State>

      NORMAL|AUTO_COMPACTION_IN_PROGRESS|BAD|BAR_CODE_MISSING|

      CANNOT_FORMAT_DUE_TO_WRITE_PROTECTION|

      DATA_CHECKPOINT_FAILURE|

      DATA_CHECKPOINT_FAILURE_DUE_TO_READ_ONLY|

      DATA_CHECKPOINT_MISSING|EJECT_FROM_EE_PENDING|

      EJECT_TO_EE_IN_PROGRESS|EJECTED|FOREIGN|FORMAT_IN_PROGRESS|

      FORMAT_PENDING|IMPORT_IN_PROGRESS|IMPORT_PENDING|

      INCOMPATIBLE|LOST|LTFS_WITH_FOREIGN_DATA|OFFLINE|

      ONLINE_IN_PROGRESS|ONLINE_PENDING|PENDING_INSPECTION|

      RAW_IMPORT_IN_PROGRESS|RAW_IMPORT_PENDING|

      SERIAL_NUMBER_MISMATCH|UNKNOWN

   </State>
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   <StorageDomainMemberId>{string}</StorageDomainMemberId>

   <TakeOwnershipPending>TRUE|FALSE</TakeOwnershipPending>

   <TotalRawCapacity>{64-bit integer}</TotalRawCapacity>

   <Type>

      LTO5|LTO6|LTO7|LTO8|LTOM8|LTO9|LTO_CLEANING_TAPE|TS_JC|TS_JD|

      TS_JE|TS_JK|TS_JL|TS_JM|TS_JV|TS_JY|TS_JZ|TS_CLEANING_TAPE

      |UNKNOWN|FORBIDDEN

   </Type>
   <VerifyPending>

      CRITICAL|URGENT|HIGH|NORMAL|LOW|BACKGROUND

   </VerifyPending>

   <WriteProtected>TRUE|FALSE</WriteProtected>

</Data>

where the response elements are defined as follows:

Parameter Description

Data A container for the response.

AssignedToStorageDomain Whether the tape is currently assigned to a storage domain.
Values: TRUE, FALSE

AvailableRaw
Capacity

The amount of unused raw capacity on the tape in bytes.

BarCode The barcode on the label of the tape cartridge.

BucketId The UUID for the bucket to which the tape is assigned.

DescriptionForIdentification The LTFS Volume ID and name, if applicable. This is only
provided if the BlackPearl gateway cannot identify the tape.

EjectDate The date and time that the BlackPearl gateway discovered that
the tape was ejected, in the format YYYY-MM-
DDThh:mm:ss.xxxZ. If the parameter is empty, the tape has not
been ejected.

EjectLabel The user-entered information to assist in the handling of the
tape.

EjectLocation The user-entered information to describe where the ejected tape
can be located.
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Parameter Description

EjectPending The date and time that the tape was put in the queue to be
ejected in the format YYYY-MM-DDThh:mm:ss.xxxZ. If the
parameter is empty, the tape has not been queued to be ejected
or the eject has started and is no longer cancelable.

FullOfData Whether the tape is completely full of data.
Values: TRUE, FALSE

Id The UUID for the tape.

LastAccessed The last date and time the tape was loaded into a tape drive in
the format YYYY-MM-DDThh:mm:ss.xxxZ.

LastCheckpoint An identifier, internal to the BlackPearl gateway, for verifying
the application integrity of the tape.

LastModified The last date and time the tape was modified in the format
YYYY-MM-DDThh:mm:ss.xxxZ.

LastVerified The last date and time the checksum of the data was verified in
the format YYYY-MM-DDThh:mm:ss.xxxZ.

PartiallyVerified
EndOfTape

The last date and time the BlackPearl gateway verified the data
on a specified percentage of the tape capacity before the EOD
marker in the format
YYYY-MM-DDThh:mm:ss.xxxZ.

PartitionId The UUID for the partition to which the tape belongs.

PreviousState The previous status of the tape. See State on page 664.

Role The role assigned to the tape. Values: Normal, Test

SerialNumber The manufacturer-assigned serial number for the tape.

State The status of the tape. See State on page 664.

StorageDomain
MemberId

The UUID for the storage domain member.
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Parameter Description

TakeOwnership Pending Whether a tape from another BlackPearl gateway is waiting for
the current gateway to complete taking ownership.
Values:
• TRUE — The foreign tape was imported when
WriteProtected was TRUE, preventing the tape from being
claimed by the current gateway.

• FALSE — The tape was imported successfully.

TotalRawCapacity The total raw capacity of the tape in bytes.

Type The tape format and generation of the tape cartridge.
Values: LTO5, LTO6, LTO7, LTO8, LTOM8, LTO9, LTO_CLEANING_
TAPE, TS_JC, TS_JD, TS_JE, TS_JK, TS_JL, TS_JM, TS_JV, TS_JY,
TS_JZ, TS_CLEANING_TAPE, UNKNOWN, FORBIDDEN

VerifyPending The priority for the verify requested, or null if a verify has not
been requested. The priority determines the resources assigned
and the processing order.
Values: CRITICAL, URGENT, HIGH, NORMAL, LOW, BACKGROUND

WriteProtected Whether the tape is write protected. Values: TRUE, FALSE

Example

Sample Request
This request cancels the pending verify of the tape with the UUID 70a3785d-4b83-4344-89dd-
8485cc2aa6d4.
PUT http://blackpearl-hostname/_rest_/tape/70a3785d-4b83-4344-89dd-

8485cc2aa6d4/?operation=CANCEL_VERIFY HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>

   <AssignedToStorageDomain>FALSE</AssignedToStorageDomain>

   <AvailableRawCapacity>2408088338432</AvailableRawCapacity>

   <BarCode>018675L6</BarCode>

   <BucketId>0acaac0a-55f9-4d6b-b410-4179d4696f37</BucketId>

   <DescriptionForIdentification/>
   <EjectDate/>

   <EjectLabel/>

   <EjectLocation/>

   <EjectPending/>

   <FullOfData>FALSE</FullOfData>
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   <Id>70a3785d-4b83-4344-89dd-8485cc2aa6d4</Id>

   <LastAccessed/>

   <LastCheckpoint/>

   <LastModified/>

   <LastVerified/>
   <PartiallyVerifiedEndOfTape/>

   <PartitionId>bd91171d-7738-4aea-b319-7abce892a7b1</PartitionId>

   <PreviousState/>
   <Role>NORMAL</Role>

   <SerialNumber>HP-AE1WRUY90E</SerialNumber>

   <State>OFFLINE</State>

   <StorageDomainMemberId/>
   <TakeOwnershipPending>FALSE</TakeOwnershipPending>

   <TotalRawCapacity>2408088338432</TotalRawCapacity>

   <Type>LTO6</Type>

   <VerifyPending/>

   <WriteProtected>FALSE</WriteProtected>

</Data>

CANCEL VERIFY OF TAPES

Description
Cancels all pending tape verifications. Verifications that have already begun cannot be
canceled.

Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/tape/?operation=CANCEL_VERIFY

Request Parameters

Parameter Description Required

operation The operation to perform. For this request, the operation is cancel
verify. Value: CANCEL_VERIFY

yes

April 2023 DS3 API Reference-Spectra BlackPearl Nearline Gateway
- 697 -



Chapter 16 - Tape Library and Component Operations Clean Tape Drive

Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 207: Multi-Status (with list of errors)

Example

Sample Request
This request cancels pending onlining for all tapes.
PUT http://blackpearl-hostname/_rest_/tape/?operation=CANCEL_ONLINE HTTP/1.1

Sample Response
HTTP/1.1 204 No Content

CLEAN TAPE DRIVE

Description
Clean the specified tape drive.

Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/tape_drive/{tape_drive_id}/?operation=CLEAN

To determine the UUID for a tape drive, see Get Tape Drives on page 746.
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Request Parameters

Parameter Description Required

operation The operation to perform. For this request, the operation is to clean
the drive. Value: CLEAN

yes

Responses

Response Elements
<Data>

   <ErrorMessage>{string}</ErrorMessage>

   <CleaningRequired>TRUE|FALSE</CleaningRequired>

   <ForceTapeRemoval>TRUE|FALSE</ForceTapeRemoval>

   <Id>{string}</Id>

   <LastCleaned>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastCleaned>

   <MaxFailedTapes>{32-bit integer}</MaxFailedTapes>

   <MfgSerialNumber>{string}</MfgSerialNumber>

   <MinimumTaskPriority>

      ANY|LOW|NORMAL|HIGH|URGENT

   </MinimumTaskPriority>
   <PartitionId>{string}</PartitionId>

   <Quiesced>NO|PENDING|YES</Quiesced>

   <ReservedTaskType>ANY|READ|WRITE|MAINTENANCE</ReservedTaskType>

   <SerialNumber>{string}</SerialNumber>
   <State>

      ERROR|NORMAL|

      NOT_COMPATIBLE_IN_PARTITION_DUE_TO_NEWER_TAPE_DRIVES|      OFFLINE

   </State>
   <TapeId>{string}</TapeId>

   <Type>

      LTO5|LTO6|LTO7|LTO8|LTOM8|LTO9|TS1140|TS1150|TS1155|TS1160

      |UNKNOWN

   </Type>

</Data>

where the response elements are defined as follows:

Parameter Description

Data A container for the response.
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Parameter Description

CleaningRequired Whether the tape drive indicates that it needs to be cleaned. Values: TRUE,
FALSE

ErrorMessage A description of any current error, if applicable.

ForceTapeRemoval Whether the tape drive is in an error state and asking that the tape in it be
forcibly removed. If required, this is performed before any other
operations.
Values: TRUE, FALSE

ID The UUID for the tape drive.

LastCleaned The last date and time the tape drive was cleaned in the format YYYY-MM-
DDThh:mm:ss.xxxZ.

MaxFailedTapes The maximum number of times a drive can fail tasks with different tapes
before it is no longer used. If set to zero, the BlackPearl gateway does not
automatically quiesce the tape drive.

MfgSerialNumber The manufacturer-assigned serial number for the tape drive.

MinimumTask
Prioirity

The minimum priority task for which the drive is reserved. Values: ANY,
LOW, NORMAL, HIGH, URGENT

PartitionId The UUID for the partition to which the drive belongs.

Quiesced Whether the tape drive is in a temporarily inactive state. Values: NO,
PENDING, YES

ReservedTaskType Whether the drive is reserved for reads only or writes only, or can be used
for reads or writes.
Values: ANY, READ, WRITE, MAINTENANCE

SerialNumber The location-based serial number for the drive while it is in the library.

State The status of the tape drive. Values: ERROR, NORMAL, NOT_COMPATIBLE_
IN_PARTITION_DUE_TO_NEWER_TAPE_DRIVES, OFFLINE

TapeId The UUID for the tape in the tape drive, if present.

Type The tape format and generation of the tape drive.
Values: LTO5, LTO6, LTO7, LTO8, LTOM8, LTO9, TS1140, TS1150, TS1155,
TS1160, UNKNOWN
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Example

Sample Request
This request cleans the tape drive with the UUID ab9146b8-feca-4023-8c45-0d60268ad115.
PUT http://blackpearl-hostname/_rest_/tape_drive/ab9146b8-feca-4023-8c45-

0d60268ad115/?operation=CLEAN HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>

   <CleaningRequired>FALSE</CleaningRequired>

   <ErrorMessage/>

   <ForceTapeRemoval>FALSE</ForceTapeRemoval>

   <Id>ab9146b8-feca-4023-8c45-0d60268ad115</Id>

   <LastCleaned/>

   <MaxFailedTapes>3</MaxFailedTapes>

   <MfgSerialNumber>90WT008323</MfgSerialNumber>

   <MinimumTaskPriority>ANY</MinimumTaskPriority>
   <PartitionId>703a0ad2-a86d-4d2a-97c9-56c2a59a718f</PartitionId>

   <Quiesced>NO</Quiesced>

   <ReservedTaskType>ANY</ReservedTaskType>

   <SerialNumber>68001883</SerialNumber>

   <State>NORMAL</State>

   <TapeId/>

   <Type>UNKNOWN</Type>

</Data>

CREATE TAPE DENSITY DIRECTIVE

Description
Configure formatting tapes of a particular type at the specified density for the specified
partition. The density specified is the tape drive type that the tape should be compatible with.
The tape will be formatted at the highest density supported by the specified tape drive.

Note: This request is for TS11x0 data tapes only. LTO tapes can only be written at the
density that they are manufactured for, and cleaning tapes cannot be formatted.
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Requests

Syntax
POST http[s]://{datapathDNSname}/_rest_/tape_density_

directive/?density=TS1140|TS1150|TS1155|TS1160& partition_id={string}&tape_type=TS_

JC|TS_JD|TS_JE|TS_JK|TS_JL|TS_JM|TS_JV|TS_JY|TS_JZ|

Request Parameters

Parameter Description Required

density The tape drive type that the density should be formatted to match.
Values: TS1140, TS1150, TS1155, TS1160

yes

partition_id The UUID or other unique attribute for the partition. yes

tape_type The tape format and generation of the tape cartridge.
Values: TS_JC, TS_JD, TS_JE, TS_JK, TS_JL, TS_JM, TS_JV, TS_JY, TS_
JZ

yes

Responses

Response Elements
<Data>

   <Density>TS1140|TS1150|TS1155|TS1160</Density>

   <Id>{string}</Id>

   <PartitionId>{string}</PartitionId>
   <TapeType>

      TS_JC|TS_JD|TS_JE|TS_JK|TS_JL|TS_JM|TS_JV|TS_JY|TS_JZ|

      UNKNOWN|FORBIDDEN

   </TapeType>

</Data>

where the response elements are defined as follows:

Parameter Description

Data A container for the response.

Density The tape drive type that the density was formatted to match.
Values: TS1140, TS1150, TS1155, TS1160, UNKNOWN
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Parameter Description

Id The UUID for the tape density directive.

TapeType The tape format and generation of the tape cartridge.
Values: TS_JC, TS_JD, TS_JE, TS_JK, TS_JL, TS_JM, TS_JV, TS_JY, TS_JZ, UNKNOWN,
FORBIDDEN

Example

Sample Request
This request configures 3592 JK tapes used in the partition with UUID f8a7cdb9-3436-484a-
9404-212045106738 to be formatted with the density used by TS1140 technology drives.
POST http://blackpearl-hostname/_rest_/tape_density_

directive/?density=TS1140&partition_id=f8a7cdb9-3436-484a-9404-212045106738&tape_

type=TS_JK HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>

   <Density>TS1140</Density>

   <Id>78e4234f-8f3d-42d3-9ae1-817e89d993bc</Id>

   <PartitionId>f8a7cdb9-3436-484a-9404-212045106738</PartitionId>

   <TapeType>TS_JK</TapeType>

</Data>
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Create a Drive Dump

Description
Creates a drive dump for use in troubleshooting.

Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/tape_drive/{drive UUID or other unique

attribute}/?operation=DUMP

Request Parameters

Parameter Description Required

operation The operation to perform. For this request, the operation is to create
a drive dump. Value: DUMP

yes

Responses

Response Elements
<Data>
   <CleaningRequired>TRUE|FALSE</CleaningRequired>
   <ErrorMessage>{string}</ErrorMessage
   <ForceTapeRemoval>TRUE|FALSE</ForceTapeRemoval>
   <Id>{string}</Id>
   <LastCleaned>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastCleaned>
   <MaxFailedTapes>{64-bit integer}</MaxFailedTapes>
   <MfgSerialNumber>{string}</MfgSerialNumber>
   <MinimumTaskPriority>ANY|LOW|NORMAL|HIGH|URGENT</MinimumTaskPriority>
   <PartitionId>{string}</PartitionId>
   <Quiesced>NO|PENDING|YES</Quiesced>
   <ReservedTaskType>ANY|READ|WRITE|MAINTENANCE</ReservedTaskType>
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   <State>

      NORMAL|AUTO_COMPACTION_IN_PROGRESS|BAD|BAR_CODE_MISSING|

      CANNOT_FORMAT_DUE_TO_WRITE_PROTECTION|

      DATA_CHECKPOINT_FAILURE|

      DATA_CHECKPOINT_FAILURE_DUE_TO_READ_ONLY|

      DATA_CHECKPOINT_MISSING|EJECT_FROM_EE_PENDING|

      EJECT_TO_EE_IN_PROGRESS|EJECTED|FOREIGN|FORMAT_IN_PROGRESS|

      FORMAT_PENDING|IMPORT_IN_PROGRESS|IMPORT_PENDING|

      INCOMPATIBLE|LOST|LTFS_WITH_FOREIGN_DATA|OFFLINE|

      ONLINE_IN_PROGRESS|ONLINE_PENDING|PENDING_INSPECTION|

      RAW_IMPORT_IN_PROGRESS|RAW_IMPORT_PENDING|

      SERIAL_NUMBER_MISMATCH|UNKNOWN

   </State>
   <TapeId>{string}</TapeId>
   <Type>{string}</Type>

</Data>

where the response elements are defined as follows:

Parameter Description

Data A container for the response.

CleaningRequired Whether the tape drive indicates that it needs to be cleaned. Values: TRUE,
FALSE

ErrorMessage A description of any current error, if applicable.

ForceTapeRemoval Whether the tape drive is in an error state and asking that the tape in it be
forcibly removed. If required, this is performed before any other
operations.
Values: TRUE, FALSE

ID The UUID for the tape drive.

LastCleaned The last date and time the tape drive was cleaned in the format YYYY-MM-
DDThh:mm:ss.xxxZ.

MaxFailedTapes The maximum number of times a drive can fail tasks with different tapes
before it is no longer used. If set to zero, the BlackPearl gateway does not
automatically quiesce the tape drive.

MfgSerialNumber The manufacturer-assigned serial number for the tape drive.

MinimumTask
Prioirity

The minimum priority task for which the drive is reserved. Values: ANY,
LOW, NORMAL, HIGH, URGENT

April 2023 DS3 API Reference-Spectra BlackPearl Nearline Gateway
- 705 -



Chapter 16 - Tape Library and Component Operations Create a Drive Dump

Parameter Description

PartitionId The UUID for the partition to which the drive belongs.

Quiesced Whether the tape drive is in a temporarily inactive state. Values: NO,
PENDING, YES

ReservedTaskType Whether the drive is reserved for reads only or writes only, or can be used
for reads or writes.
Values: ANY, READ, WRITE, MAINTENANCE

SerialNumber The location-based serial number for the drive while it is in the library.

State The status of the tape drive. Create a Drive Dump on page 704.

TapeId The UUID for the tape in the tape drive, if present.

Type The tape format and generation of the tape drive.
Values: LTO5, LTO6, LTO7, LTO8, LTOM8, LTO9, TS1140, TS1150, TS1155,
TS1160, UNKNOWN

Example

Sample Request
This request creates a drive dump file for the drive with UUID a3f6fb78-19ef-409f-b0c1-
2bd9fc69fe70.
PUT http[s]://blackpearl-hostnam/_rest_/tape_drive/a3f6fb78-19ef-409f-b0c1-

2bd9fc69fe70/?operation=dump HTTP/1.1

Sample Response
<Data>
   <CleaningRequired>false</CleaningRequired>
   <ErrorMessage/>
   <ForceTapeRemoval>false</ForceTapeRemoval>
   <Id>a3f6fb78-19ef-409f-b0c1-2bd9fc69fe70</Id>
   <LastCleaned/>
   <MaxFailedTapes>3</MaxFailedTapes>
   <MfgSerialNumber/>
   <MinimumTaskPriority/>
   <PartitionId>1651288a-fd0d-43be-8cc5-1e7c6bbe55f</PartitionId>
   <Quiesced>NO</Quiesced>
   <ReservedTaskType>ANY</ReservedTaskType>
   <SerialNumber>td1</SerialNumber>
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   <State>NORMAL</State><TapeId/>
   <Type>LTO5</Type>

</Data>

DELETE PERMANENTLY LOST TAPE

Description
Deletes the specified tape which has been permanently lost from the BlackPearl database.
Any data lost as a result is marked degraded to trigger a rebuild.

Requests

Syntax
DELETE http[s]://{datapathDNSname}/_rest_/tape/{tape UUID, barcode, or other unique

attribute}/

To determine the UUID for a tape, see Get Tapes on page 770.

Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 404: Not Found

Example

Sample Request
This request deletes the tape with the UUID 0051aae2-1bcc-4c99-a7d3-1d1724a8b8d8.
DELETE http://blackpearl-hostname/_rest_/tape/0051aae2-1bcc-4c99-a7d3-1d1724a8b8d8/

HTTP/1.1
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Sample Response
HTTP/1.1 204 No Content

DELETE TAPE DENSITY DIRECTIVE

Description
Delete the specified tape density directive.

Note: Tape density directives only apply to TS11x0 technology data tapes.

Requests

Syntax
DELETE http[s]://{datapathDNSname}/_rest_/tape_density_directive/{tape density

directive UUID}/

To determine the UUID for a tape density directive, see Get Tape Density Directives on
page 740.

Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 404: Not Found

Example

Sample Request
This request deletes the tape density directive with the UUID a199c125-6c52-4a73-ae7d-
9f3dbab0b746.
DELETE http://blackpearl-hostname/_rest_/tape_density_directive/a199c125-6c52-4a73-

ae7d-9f3dbab0b746/ HTTP/1.1
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Sample Response
HTTP/1.1 204 No Content

DELETE TAPE DRIVE

Description
Deletes the specified offline tape drive. This request is useful when a tape drive is
permanently removed from a partition.

Requests

Syntax
DELETE http[s]://{datapathDNSname}/_rest_/tape_drive/{tape drive UUID or other

unique attribute}/

To determine the UUID for a tape drive, see Get Tape Drives on page 746.

Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 404: Not Found

Example

Sample Request
This request deletes the tape drive with the UUID 63d3dbd4-baa8-4e8f-a40d-42a6c3e3bf95.
DELETE http://blackpearl-hostname/_rest_/tape_drive/63d3dbd4-baa8-4e8f-a40d-

42a6c3e3bf95/ HTTP/1.1

Sample Response
HTTP/1.1 204 No Content
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DELETE TAPE FAILURE

Description
Deletes the specified tape failure.

Requests

Syntax
DELETE http[s]://{datapathDNSname}/_rest_/tape_failure/{tape failure UUID or other

unique attribute}/

To determine the UUID for a tape failure, see Get Tape Failures on page 750.

Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 404: Not Found

Example

Sample Request
This request deletes the tape failure with the UUID 2d4a2794-8617-4cdc-9e8f-0530fa1abbf2.
DELETE http://blackpearl-hostname/_rest_/tape_failure/2d4a2794-8617-4cdc-9e8f-

0530fa1abbf2/ HTTP/1.1

Sample Response
HTTP/1.1 204 No Content
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DELETE TAPE PARTITION

Description
Deletes the specified offline tape partition from the BlackPearl gateway configuration. Any
tapes in the partition that have data on them are disassociated from the partition. Any tapes
without data on them and all tape drives associated with the partition are deleted from the
BlackPearl gateway configuration. This request is useful if the partition should never have
been associated with the BlackPearl gateway or if the partition was deleted from the library.

Requests

Syntax
DELETE http[s]://{datapathDNSname}/_rest_/tape_partition/{tape partition UUID or

other unique attribute}/

To determine the UUID for a tape partition, see Get Tape Partition on page 758.

Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 404: Not Found

Example

Sample Request
This request deletes the tape partition with the UUID 30c442905-d0ec-4e72-b7ed-
07d520fc8b86.
DELETE http://blackpearl-hostname/_rest_/tape_partition/30c442905-d0ec-4e72-b7ed-

07d520fc8b86/ HTTP/1.1

Sample Response
HTTP/1.1 204 No Content
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DELETE TAPE PARTITION FAILURE

Description
Deletes the specified tape partition failure.

Requests

Syntax
DELETE http[s]://{datapathDNSname}/_rest_/tape_partition_failure/{tape partition

UUID or other unique attribute}/

To determine the UUID for a tape partition failure, see Get Tape Partition Failures on
page 762.

Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 404: Not Found

Example

Sample Request
This request deletes the tape partition failure for the partition with the UUID a92bd5a6-eb56-
44c8-9a08-1f896c3eab0e.
DELETE http://blackpearl-hostname/_rest_/tape_partition_failure/a92bd5a6-eb56-44c8-

9a08-1f896c3eab0e/ HTTP/1.1

Sample Response
HTTP/1.1 204 No Content
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EJECT TAPE

Description
Queue the specified tape to be ejected. If a tape is in use, it is ejected once it is no longer in
use.

Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/tape/{tape UUID or barcode}/?operation=EJECT

[&eject_label={string}][&eject_location={string}]

To determine the UUID for a tape, see Get Tapes on page 770.

Request Parameters

Parameter Description Required

operation The operation to perform. For this request, the operation is eject.
Value: EJECT

yes

eject_label Enter information to assist in the handling of the tape. no

eject_
location

Enter information to describe where the ejected tape can be located. no

Responses

Response Elements
<Data>

   <AssignedToStorageDomain>TRUE|FALSE</AssignedToStorageDomain>

   <AvailableRawCapacity>{64-bit integer}</AvailableRawCapacity>

   <BarCode>{string}</BarCode>

   <BucketId>{string}</BucketId>

   <DescriptionForIdentification>

{string}

   </DescriptionForIdentification>
   <EjectDate>{YYYY-MM-DDThh:mm:ss.xxxZ}</EjectDate>

   <EjectLabel>{string}</EjectLabel>

   <EjectLocation>{string}</EjectLocation>

   <EjectPending>{YYYY-MM-DDThh:mm:ss.xxxZ}</EjectPending>

   <FullOfData>TRUE|FALSE</FullOfData>
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   <Id>{string}</Id>
   <LastAccessed>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastAccessed>

   <LastCheckpoint>{string}</LastCheckpoint>

   <LastModified>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastModified>
   <LastVerified>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastVerified>
   <PartiallyVerifiedEndOfTape>

{YYYY-MM-DDThh:mm:ss.xxxZ}

   </PartiallyVerifiedEndOfTape>
   <PartitionId>{string}</PartitionId>
   <PreviousState>

      NORMAL|AUTO_COMPACTION_IN_PROGRESS|BAD|BAR_CODE_MISSING|

      CANNOT_FORMAT_DUE_TO_WRITE_PROTECTION|

      DATA_CHECKPOINT_FAILURE|

      DATA_CHECKPOINT_FAILURE_DUE_TO_READ_ONLY|

      DATA_CHECKPOINT_MISSING|EJECT_FROM_EE_PENDING|

      EJECT_TO_EE_IN_PROGRESS|EJECTED|FOREIGN|FORMAT_IN_PROGRESS|

      FORMAT_PENDING|IMPORT_IN_PROGRESS|IMPORT_PENDING|

      INCOMPATIBLE|LOST|LTFS_WITH_FOREIGN_DATA|OFFLINE|

      ONLINE_IN_PROGRESS|ONLINE_PENDING|PENDING_INSPECTION|

      RAW_IMPORT_IN_PROGRESS|RAW_IMPORT_PENDING|

      SERIAL_NUMBER_MISMATCH|UNKNOWN

   </PreviousState>
   <Role>NORMAL|TEST</Role>
   <SerialNumber>{string}</SerialNumber>

   <State>

      NORMAL|AUTO_COMPACTION_IN_PROGRESS|BAD|BAR_CODE_MISSING|

      CANNOT_FORMAT_DUE_TO_WRITE_PROTECTION|

      DATA_CHECKPOINT_FAILURE|

      DATA_CHECKPOINT_FAILURE_DUE_TO_READ_ONLY|

      DATA_CHECKPOINT_MISSING|EJECT_FROM_EE_PENDING|

      EJECT_TO_EE_IN_PROGRESS|EJECTED|FOREIGN|FORMAT_IN_PROGRESS|

      FORMAT_PENDING|IMPORT_IN_PROGRESS|IMPORT_PENDING|

      INCOMPATIBLE|LOST|LTFS_WITH_FOREIGN_DATA|OFFLINE|

      ONLINE_IN_PROGRESS|ONLINE_PENDING|PENDING_INSPECTION|

      RAW_IMPORT_IN_PROGRESS|RAW_IMPORT_PENDING|

      SERIAL_NUMBER_MISMATCH|UNKNOWN

   </State>
   <StorageDomainMemberId>{string}</StorageDomainMemberId>

   <TakeOwnershipPending>TRUE|FALSE</TakeOwnershipPending>

   <TotalRawCapacity>{64-bit integer}</TotalRawCapacity>

   <Type>

      LTO5|LTO6|LTO7|LTO8|LTOM8|LTO9|LTO_CLEANING_TAPE|TS_JC|TS_JD|

      TS_JE|TS_JK|TS_JL|TS_JM|TS_JV|TS_JY|TS_JZ|TS_CLEANING_TAPE

      |UNKNOWN|FORBIDDEN

   </Type>
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   <VerifyPending>

      CRITICAL|URGENT|HIGH|NORMAL|LOW|BACKGROUND

   </VerifyPending>

   <WriteProtected>TRUE|FALSE</WriteProtected>

</Data>

where the response elements are defined as follows:

Parameter Description

Data A container for the response.

AssignedToStorageDomain Whether the tape is currently assigned to a storage domain.
Values: TRUE, FALSE

AvailableRaw
Capacity

The amount of unused raw capacity on the tape in bytes.

BarCode The barcode on the label of the tape cartridge.

BucketId The UUID for the bucket to which the tape is assigned.

DescriptionFor
Identification

The LTFS Volume ID and name, if applicable. This is only provided
if the BlackPearl gateway cannot identify the tape.

EjectDate The date and time that the BlackPearl gateway discovered that the
tape was ejected, in the format YYYY-MM-DDThh:mm:ss.xxxZ. If
the parameter is empty, the tape has not been ejected.

EjectLabel The user-entered information to assist in the handling of the tape.

EjectLocation The user-entered information to describe where the ejected tape
can be located.

EjectPending The date and time that the tape was put in the queue to be ejected
in the format YYYY-MM-DDThh:mm:ss.xxxZ. If the parameter is
empty, the tape has not been queued to be ejected or the eject has
started and is no longer cancelable.

FullOfData Whether the tape is completely full of data.
Values: TRUE, FALSE

Id The UUID for the tape.

LastAccessed The last date and time the tape was loaded into a tape drive in the
format YYYY-MM-DDThh:mm:ss.xxxZ.
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Parameter Description

LastCheckpoint An identifier, internal to the BlackPearl gateway, for verifying the
application integrity of the tape.

LastModified The last date and time the tape was modified in the format YYYY-
MM-DDThh:mm:ss.xxxZ.

LastVerified The last date and time the checksum of the data was verified in
the format YYYY-MM-DDThh:mm:ss.xxxZ.

PartiallyVerified
EndOfTape

The last date and time the BlackPearl gateway verified the data on
a specified percentage of the tape capacity before the EOD marker
in the format
YYYY-MM-DDThh:mm:ss.xxxZ.

PartitionId The UUID for the partition to which the tape belongs.

PreviousState The previous status of the tape. See State on page 664.

Role The role assigned to the tape. Values: Normal, Test

SerialNumber The manufacturer-assigned serial number for the tape.

State The status of the tape. See State on page 664.

StorageDomain
MemberId

The UUID for the storage domain member.

TakeOwnership Pending Whether a tape from another BlackPearl gateway is waiting for
the current gateway to complete taking ownership.
Values:
• TRUE — The foreign tape was imported when
WriteProtected was TRUE, preventing the tape from being
claimed by the current gateway.

• FALSE — The tape was imported successfully.

TotalRawCapacity The total raw capacity of the tape in bytes.

Type The tape format and generation of the tape cartridge.
Values: LTO5, LTO6, LTO7, LTO8, LTOM8, LTO9, LTO_CLEANING_
TAPE, TS_JC, TS_JD, TS_JE, TS_JK, TS_JL, TS_JM, TS_JV, TS_JY,
TS_JZ, TS_CLEANING_TAPE, UNKNOWN, FORBIDDEN
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Parameter Description

VerifyPending The priority for the verify requested, or null if a verify has not
been requested. The priority determines the resources assigned
and the processing order.
Values: CRITICAL, URGENT, HIGH, NORMAL, LOW, BACKGROUND

WriteProtected Whether the tape is write protected. Values: TRUE, FALSE

Example

Sample Request
This request queues the tape with the UUID 1c3fe1dc-95b7-4152-a286-951d0af2a27e to be
ejected.
PUT http://blackpearl-hostname/_rest_/tape/1c3fe1dc-95b7-4152-a286-

951d0af2a27e/?operation=EJECT HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>

   <AssignedToStorageDomain>FALSE</AssignedToStorageDomain>

   <AvailableRawCapacity>2408088338432</AvailableRawCapacity>

   <BarCode>018675L6</BarCode>

   <BucketId>0acaac0a-55f9-4d6b-b410-4179d4696f37</BucketId>

   <DescriptionForIdentification/>
   <EjectDate/>

   <EjectLabel/>

   <EjectLocation/>

   <EjectPending/>
   <FullOfData>FALSE</FullOfData>

   <Id>1c3fe1dc-95b7-4152-a286-951d0af2a27e</Id>

   <LastAccessed/>

   <LastCheckpoint/>

   <LastModified/>

   <LastVerified/>
   <PartiallyVerifiedEndOfTape/>

   <PartitionId>bd91171d-7738-4aea-b319-7abce892a7b1</PartitionId>

   <PreviousState/>
   <Role>NORMAL</Role>

   <SerialNumber>HP-AE1WRUY90E</SerialNumber>

   <State>NORMAL</State>
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   <StorageDomainMemberId/>

   <TakeOwnershipPending>FALSE</TakeOwnershipPending>

   <TotalRawCapacity>2408088338432</TotalRawCapacity>

   <Type>LTO6</Type>
   <VerifyPending/>

   <WriteProtected>FALSE</WriteProtected>

</Data>

EJECT TAPES

Description
Ejects all tapes that are eligible to be ejected. Tapes are not eligible for ejection if
mediaEjectionAllowed=FALSE for the storage domain (see media_ejection_ allowed on
page 549). If a tape is in use, it is ejected once it is no longer in use.

Requests
Syntax
PUT http[s]://{datapathDNSname}/_rest_/tape/?operation=EJECT[&eject_label={string}]

[&eject_location={string}]

Request Parameters

Parameter Description Required

operation The operation to perform. For this request, the operation is eject.
Value: EJECT

yes

eject_label Enter information to assist in the handling of the tapes. no

eject_
location

Enter information to describe where the ejected tapes can be located. no

Responses
Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 207: Multi-Status (with list of errors)
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Example
Sample Request
This request queues all eligible tapes to be ejected.
PUT http://blackpearl-hostname/_rest_/tape/?operation=EJECT HTTP/1.1

Sample Response
HTTP/1.1 204 No Content

EJECT STORAGE DOMAIN

Description
Ejects all eligible tapes within the specified storage domain. Tapes are not eligible for ejection
if mediaEjectionAllowed=FALSE for the storage domain (see media_ejection_ allowed on
page 549). If a tape is being used for a job, it is ejected once it is no longer in use.

Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/tape/?operation=EJECT&storage_domain={string}

[&bucket_id={string}][&eject_label={string}][&eject_location={string}]

Request Parameters

Parameter Description Required

operation The operation to perform. For this request, the operation is eject.
Value: EJECT

yes

storage_
domain

The name, UUID, or other unique attribute for the storage domain
from which to eject tapes.

yes

bucket_id The UUID, name, or other unique attribute for a bucket from which
to eject tapes. If a bucket is specified, the tapes in the storage domain
which contain data for the specified bucket are ejected even if they
contain data for other buckets.

no

eject_label Enter information to assist in the handling of the tapes. no

eject_
location

Enter information to describe where the ejected tapes can be located. no
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Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 207: Multi-Status (with list of errors)

Example

Sample Request
This request queues all eligible tapes in the storage domain with UUID 2a48ae2c-5c0e-47c4-
a800-ec54aa4f7abc to be ejected.
PUT http://blackpearl-hostname/_rest_/tape/?operation=EJECT&storage_domain_

id=2a48ae2c-5c0e-47c4-a800-ec54aa4f7abc HTTP/1.1

Sample Response
HTTP/1.1 204 No Content

EJECT STORAGE DOMAIN BLOBS

Description
Ejects all tapes that are eligible to be ejected within the specified storage domain for the
included blob payload. Tapes are not eligible for ejection if secure_media_
allocation=true for the storage domain (see secure_media_ allocation on page 549). If a
tape is in use, it is ejected once it is no longer in use.

Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/tape/?operation=EJECT&blobs&bucket_id=

{string}&storage_domain_id={string}][&eject_label={string}][&eject_location=

{string}]
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Request Parameters

Parameter Description Required

operation The operation to perform. For this request, the operation is eject.
Value: EJECT

yes

blobs When included, the request fails if the request payload is not also
included.

yes

bucket_id The UUID, name, or other unique attribute for a bucket from which
to eject tapes. The tapes in the storage domain which contain data for
the specified bucket are ejected even if they contain data for other
buckets.

yes

storage_
domain

The name, UUID, or other unique attribute for the storage domain
from which to eject tapes.

yes

eject_label Enter information to assist in the handling of the tapes. no

eject_
location

Enter information to describe where the ejected tapes can be located. no

Request Elements
An XML payload, formatted as follows, must be sent to specify object parts to eject:
<Objects>

   <Object Name="{string}" Version_Id="{string}/>

</Objects>

where the parameters are defined as follows:

Parameter Description Required

Objects A container for the list of objects. yes

Object The container for information about one object or object part. yes

Name The name of an object to eject. All objects in the list must be in the
same bucket.

yes

Version_Id The UUID for the version of the object. no
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Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 207: Multi-Status (with list of errors)
• 400: Bad Request (request payload not included)

Example

Sample Request
This request queues all eligible tapes in the storage domain with UUID 2a48ae2c-5c0e-47c4-
a800-ec54aa4f7abc, assigned to “bucket1” and containing pieces of the object “Object1”, to be
ejected.
PUT http://blackpearl-hostname/_rest_/tape/?operation=EJECT&blobs&bucket_

id=bucket1&storage_domain_id=2a48ae2c-5c0e-47c4-a800-ec54aa4f7abc HTTP/1.1
<Objects>

   <Object Name="Object1">

</Objects>

Sample Response
HTTP/1.1 204 No Content

FORCE TAPE ENVIRONMENT REFRESH

Description
Forces the BlackPearl gateway’s information about the tape environment to refresh. The tape
environment is automatically updated based on tape environment change events. This
operation updates the tape environment even if no change in the environment was detected
since the last update.

Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/tape_environment/
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Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 500: Internal Error

Example

Sample Request
This request updates the tape environment.
PUT http://blackpearl-hostname/_rest_/tape_environment/ HTTP/1.1

Sample Response
HTTP/1.1 204 No Content

FORMAT TAPE

Description
Format the specified tape. Tapes are not eligible if they have a state of EJECTED, LOST,
EJECT_PENDING, or OFFLINE. In addition, the force parameter must be used to format a
tape that contains data written by another BlackPearl gateway, to format a tape before it is
inspected, to format a tape that has already been formatted by a BlackPearl gateway, or to
format a tape that currently has reads or writes scheduled. If the tape contains data written
by the current BlackPearl gateway, you must delete the objects and buckets before formatting
the tape even if the force parameter is included.

CAUTION Any data on the tape is lost during the format operation.

Note: The force parameter is not required to format a tape with the state UNKNOWN
(see State on page 664).
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Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/tape/{tape UUID or barcode}/?operation=FORMAT

[&force]

To determine the UUID for a tape, see Get Tapes on page 770.

Request Parameters

Parameter Description Required

operation The operation to perform. For this request, the operation is format.
Value: FORMAT

yes

force If included, the tape is formatted even if it contains data unless the
data was written by the current BlackPearl gateway.
CAUTION Any data on the tape is lost during the format operation.

no

Responses

Response Elements
<Data>

   <AssignedToStorageDomain>TRUE|FALSE</AssignedToStorageDomain>

   <AvailableRawCapacity>{64-bit integer}</AvailableRawCapacity>

   <BarCode>{string}</BarCode>

   <BucketId>{string}</BucketId>

   <DescriptionForIdentification>

{string}

   </DescriptionForIdentification>

   <EjectDate>{YYYY-MM-DDThh:mm:ss.xxxZ}</EjectDate>

   <EjectLabel>{string}</EjectLabel>

   <EjectLocation>{string}</EjectLocation>

   <EjectPending>{YYYY-MM-DDThh:mm:ss.xxxZ}</EjectPending>

   <FullOfData>TRUE|FALSE</FullOfData>

   <Id>{string}</Id>

   <LastAccessed>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastAccessed>

   <LastCheckpoint>{string}</LastCheckpoint>

   <LastModified>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastModified>

   <LastVerified>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastVerified>
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   <PartiallyVerifiedEndOfTape>

{YYYY-MM-DDThh:mm:ss.xxxZ}

   </PartiallyVerifiedEndOfTape>

   <PartitionId>{string}</PartitionId>

   <PreviousState>

      NORMAL|AUTO_COMPACTION_IN_PROGRESS|BAD|BAR_CODE_MISSING|

      CANNOT_FORMAT_DUE_TO_WRITE_PROTECTION|

      DATA_CHECKPOINT_FAILURE|

      DATA_CHECKPOINT_FAILURE_DUE_TO_READ_ONLY|

      DATA_CHECKPOINT_MISSING|EJECT_FROM_EE_PENDING|

      EJECT_TO_EE_IN_PROGRESS|EJECTED|FOREIGN|FORMAT_IN_PROGRESS|

      FORMAT_PENDING|IMPORT_IN_PROGRESS|IMPORT_PENDING|

      INCOMPATIBLE|LOST|LTFS_WITH_FOREIGN_DATA|OFFLINE|

      ONLINE_IN_PROGRESS|ONLINE_PENDING|PENDING_INSPECTION|

      RAW_IMPORT_IN_PROGRESS|RAW_IMPORT_PENDING|

      SERIAL_NUMBER_MISMATCH|UNKNOWN

   </PreviousState>
   <Role>NORMAL|TEST</Role>

   <SerialNumber>{string}</SerialNumber>

April 2023 DS3 API Reference-Spectra BlackPearl Nearline Gateway
- 725 -



Chapter 16 - Tape Library and Component Operations Format Tape

   <State>

      NORMAL|AUTO_COMPACTION_IN_PROGRESS|BAD|BAR_CODE_MISSING|

      CANNOT_FORMAT_DUE_TO_WRITE_PROTECTION|

      DATA_CHECKPOINT_FAILURE|

      DATA_CHECKPOINT_FAILURE_DUE_TO_READ_ONLY|

      DATA_CHECKPOINT_MISSING|EJECT_FROM_EE_PENDING|

      EJECT_TO_EE_IN_PROGRESS|EJECTED|FOREIGN|FORMAT_IN_PROGRESS|

      FORMAT_PENDING|IMPORT_IN_PROGRESS|IMPORT_PENDING|

      INCOMPATIBLE|LOST|LTFS_WITH_FOREIGN_DATA|OFFLINE|

      ONLINE_IN_PROGRESS|ONLINE_PENDING|PENDING_INSPECTION|

      RAW_IMPORT_IN_PROGRESS|RAW_IMPORT_PENDING|

      SERIAL_NUMBER_MISMATCH|UNKNOWN

   </State>

   <StorageDomainMemberId>{string}</StorageDomainMemberId>

   <TakeOwnershipPending>TRUE|FALSE</TakeOwnershipPending>

   <TotalRawCapacity>{64-bit integer}</TotalRawCapacity>

   <Type>

      LTO5|LTO6|LTO7|LTO8|LTOM8|LTO9|LTO_CLEANING_TAPE|TS_JC|TS_JD|

      TS_JE|TS_JK|TS_JL|TS_JM|TS_JV|TS_JY|TS_JZ|TS_CLEANING_TAPE

      |UNKNOWN|FORBIDDEN

   </Type>

   <VerifyPending>

      CRITICAL|URGENT|HIGH|NORMAL|LOW|BACKGROUND

   </VerifyPending>

   <WriteProtected>TRUE|FALSE</WriteProtected>

</Data>

where the response elements are defined as follows:

Parameter Description

Data A container for the response.

AssignedToStorageDomain Whether the tape is currently assigned to a storage domain.
Values: TRUE, FALSE

AvailableRaw
Capacity

The amount of unused raw capacity on the tape in bytes.

BarCode The barcode on the label of the tape cartridge.

BucketId The UUID for the bucket to which the tape is assigned.

DescriptionFor
Identification

The LTFS Volume ID and name, if applicable. This is only provided
if the BlackPearl gateway cannot identify the tape.
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Parameter Description

EjectDate The date and time that the BlackPearl gateway discovered that the
tape was ejected, in the format YYYY-MM-DDThh:mm:ss.xxxZ. If
the parameter is empty, the tape has not been ejected.

EjectLabel The user-entered information to assist in the handling of the tape.

EjectLocation The user-entered information to describe where the ejected tape
can be located.

EjectPending The date and time that the tape was put in the queue to be ejected
in the format YYYY-MM-DDThh:mm:ss.xxxZ. If the parameter is
empty, the tape has not been queued to be ejected or the eject has
started and is no longer cancelable.

FullOfData Whether the tape is completely full of data.
Values: TRUE, FALSE

Id The UUID for the tape.

LastAccessed The last date and time the tape was loaded into a tape drive in the
format YYYY-MM-DDThh:mm:ss.xxxZ.

LastCheckpoint An identifier, internal to the BlackPearl gateway, for verifying the
application integrity of the tape.

LastModified The last date and time the tape was modified in the format YYYY-
MM-DDThh:mm:ss.xxxZ.

LastVerified The last date and time the checksum of the data was verified in
the format YYYY-MM-DDThh:mm:ss.xxxZ.

PartiallyVerified
EndOfTape

The last date and time the BlackPearl gateway verified the data on
a specified percentage of the tape capacity before the EOD marker
in the format
YYYY-MM-DDThh:mm:ss.xxxZ.

PartitionId The UUID for the partition to which the tape belongs.

PreviousState The previous status of the tape. See State on page 664.

Role The role assigned to the tape. Values: Normal, Test

SerialNumber The manufacturer-assigned serial number for the tape.

State The status of the tape. See State on page 664.
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Parameter Description

StorageDomain
MemberId

The UUID for the storage domain member.

TakeOwnership Pending Whether a tape from another BlackPearl gateway is waiting for
the current gateway to complete taking ownership.
Values:
• TRUE — The foreign tape was imported when
WriteProtected was TRUE, preventing the tape from being
claimed by the current gateway.

• FALSE — The tape was imported successfully.

TotalRawCapacity The total raw capacity of the tape in bytes.

Type The tape format and generation of the tape cartridge.
Values: LTO5, LTO6, LTO7, LTO8, LTOM8, LTO9, LTO_CLEANING_
TAPE, TS_JC, TS_JD, TS_JE, TS_JK, TS_JL, TS_JM, TS_JV, TS_JY,
TS_JZ, TS_CLEANING_TAPE, UNKNOWN, FORBIDDEN

VerifyPending The priority for the verify requested, or null if a verify has not
been requested. The priority determines the resources assigned
and the processing order.
Values: CRITICAL, URGENT, HIGH, NORMAL, LOW, BACKGROUND

WriteProtected Whether the tape is write protected. Values: TRUE, FALSE

Example

Sample Request
This request queues the tape with the UUID 1c3fe1dc-95b7-4152-a286-951d0af2a27e to be
formatted.
PUT http://blackpearl-hostname/_rest_/tape/1c3fe1dc-95b7-4152-a286-

951d0af2a27e/?operation=FORMAT HTTP/1.1
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Sample Response
HTTP/1.1 200 OK

<Data>

   <AssignedToStorageDomain>FALSE</AssignedToStorageDomain>

   <AvailableRawCapacity>2408088338432</AvailableRawCapacity>

   <BarCode>018675L6</BarCode>

   <BucketId>0acaac0a-55f9-4d6b-b410-4179d4696f37</BucketId>

   <DescriptionForIdentification/>

   <EjectDate/>

   <EjectLabel/>

   <EjectLocation/>

   <EjectPending/>

   <FullOfData>FALSE</FullOfData>

   <Id>1c3fe1dc-95b7-4152-a286-951d0af2a27e</Id>

   <LastAccessed/>

   <LastCheckpoint/>

   <LastModified/>

   <LastVerified/>

   <PartiallyVerifiedEndOfTape/>

   <PartitionId>bd91171d-7738-4aea-b319-7abce892a7b1</PartitionId>

   <PreviousState/>
   <Role>NORMAL</Role>

   <SerialNumber>HP-AE1WRUY90E</SerialNumber>

   <StorageDomainMemberId/>

   <TakeOwnershipPending>FALSE</TakeOwnershipPending>

   <State>FORMAT_PENDING</State>

   <TotalRawCapacity>2408088338432</TotalRawCapacity>

   <Type>LTO6</Type>
   <VerifyPending/>

   <WriteProtected>FALSE</WriteProtected>

</Data>
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FORMAT TAPES

Description
Format all eligible tapes. Tapes are not eligible if they have a state of EJECTED, LOST,
EJECT_PENDING, or OFFLINE. In addition, the force parameter must be used to format a
tape that contains data written by a BlackPearl gateway, to format a tape before it is
inspected, to format a tape that has already been formatted by a BlackPearl gateway, or to
format a tape that currently has reads or writes scheduled. If a tape contains data written by
the current BlackPearl gateway, you must delete the objects and buckets before formatting
the tape even if the force parameter is included.

CAUTION Any data on the tape is lost during the format operation.

Note: The force parameter is not required to format a tape with the state UNKNOWN
(see State on page 664).

Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/tape/?operation=FORMAT [&force]

Request Parameters

Parameter Description Required

operation The operation to perform. For this request, the operation is format.
Value: FORMAT

yes

force If included, all eligible tapes are formatted even if they contain data,
unless the data was written by the current BlackPearl gateway.
CAUTION Any data on the tape media is lost during the format
operation.

no
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Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 207: Multi-Status (with list of errors)

Example

Sample Request
This request queues all unformatted tapes to be formatted.
PUT http://blackpearl-hostname/_rest_/tape/?operation=FORMAT HTTP/1.1

Sample Response
HTTP/1.1 204 No Content

GET PHYSICAL PLACEMENT FOR OBJECT PARTS ON TAPE

Description
Get the list of object parts on the specified tape. Use parameters as selection criteria to return
a subset of the list.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/tape/{tape UUID or barcode}/?operation=GET_

PHYSICAL_PLACEMENT
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Request Parameters

Parameter Description Required

operation The operation to perform. For this request, the operation is to get
physical placement.
Value: GET_PHYSICAL_PLACEMENT

yes

last_page If included, only the last page of results is returned. no

page_length The maximum number of tape drives to list. The default is all items
after page_offset.

no

page_offset The starting point for the first tape drive to list. The default is 0. no

page_start_
marker

The UUID or other unique attribute for the item just before the first
item to list.
Notes:
• Specifying both page_offset and page_start_marker causes
an error.

• If neither page_offset, nor page_start_marker are specified,
the page_offset default is used.

no

Responses

Response Elements
<Data>

   <Object Bucket="{string}" Id="{string}" Latest="TRUE|FALSE"

      Length="{64-bit integer}" Name="{string}"

      Offset="{64-bit integer}" VersionId="{string}">
   ...

</Data>

where the response elements are defined as follows:

Parameter Description

Data A container for the response.

Object The container for information about one object.

Bucket The name of the bucket containing the object.

Id The UUID for the object.
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Parameter Description

Latest Whether this version of the object is the latest.
Values: TRUE, FALSE

Length The length in bytes of the object.

Name The name of the object.

Offset The offset in bytes from the start of the object.

VersionId The UUID of the version of the object.

Example

Sample Request
This request returns a list of all object parts on the tape with the UUID 5e6d27f7-7261-4ad9-
a2f3-c89791c1f7ff'.
GET http://blackpearl-hostname/_rest_/tape/5e6d27f7-7261-4ad9-a2f3-

c89791c1f7ff/?operation=GET_PHYSICAL_PLACEMENT HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>

   <Object Bucket="bucket_name"

      Id="e846bc8d-2181-4cc5-a4aa-c09dcebb0133" Latest="true"

      Length="10 "Name="o1" Offset="0"

      VersionId="01a33693-ba75-4668-a2c9-89fa423b219f">

   <Object Bucket="bucket_name"

      Id="3cf1c091-2c1a-469d-9880-6ec3fed298fd" Latest="true"

      Length="10" Name="o2" Offset="0"

      VersionId="7ee8bd7a-b883-4100-ad2b-13440a44f200">

</Data>

GET TAPE

Description
Get information about the specified tape.
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Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/tape/{tape UUID or barcode}/

To determine the UUID for a tape, see Get Tapes on page 770.

Responses

Response Elements
<Data>

   <AssignedToStorageDomain>TRUE|FALSE</AssignedToStorageDomain>

   <AvailableRawCapacity>{64-bit integer}</AvailableRawCapacity>

   <BarCode>{string}</BarCode>

   <BucketId>{string}</BucketId>

   <DescriptionForIdentification>

{string}

   </DescriptionForIdentification>

   <EjectDate>{YYYY-MM-DDThh:mm:ss.xxxZ}</EjectDate>

   <EjectLabel>{string}</EjectLabel>

   <EjectLocation>{string}</EjectLocation>

   <EjectPending>{YYYY-MM-DDThh:mm:ss.xxxZ}</EjectPending>

   <FullOfData>TRUE|FALSE</FullOfData>

   <Id>{string}</Id>

   <LastAccessed>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastAccessed>

   <LastCheckpoint>{string}</LastCheckpoint>

   <LastModified>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastModified>

   <LastVerified>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastVerified>
   <PartiallyVerifiedEndOfTape>

{YYYY-MM-DDThh:mm:ss.xxxZ}

   </PartiallyVerifiedEndOfTape>
   <PartitionId>{string}</PartitionId>
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   <PreviousState>

      NORMAL|AUTO_COMPACTION_IN_PROGRESS|BAD|BAR_CODE_MISSING|

      CANNOT_FORMAT_DUE_TO_WRITE_PROTECTION|

      DATA_CHECKPOINT_FAILURE|

      DATA_CHECKPOINT_FAILURE_DUE_TO_READ_ONLY|

      DATA_CHECKPOINT_MISSING|EJECT_FROM_EE_PENDING|

      EJECT_TO_EE_IN_PROGRESS|EJECTED|FOREIGN|FORMAT_IN_PROGRESS|

      FORMAT_PENDING|IMPORT_IN_PROGRESS|IMPORT_PENDING|

      INCOMPATIBLE|LOST|LTFS_WITH_FOREIGN_DATA|OFFLINE|

      ONLINE_IN_PROGRESS|ONLINE_PENDING|PENDING_INSPECTION|

      RAW_IMPORT_IN_PROGRESS|RAW_IMPORT_PENDING|

      SERIAL_NUMBER_MISMATCH|UNKNOWN

   </PreviousState>
   <Role>NORMAL|TEST</Role>
   <SerialNumber>{string}</SerialNumber>

   <State>

      NORMAL|AUTO_COMPACTION_IN_PROGRESS|BAD|BAR_CODE_MISSING|

      CANNOT_FORMAT_DUE_TO_WRITE_PROTECTION|

      DATA_CHECKPOINT_FAILURE|

      DATA_CHECKPOINT_FAILURE_DUE_TO_READ_ONLY|

      DATA_CHECKPOINT_MISSING|EJECT_FROM_EE_PENDING|

      EJECT_TO_EE_IN_PROGRESS|EJECTED|FOREIGN|FORMAT_IN_PROGRESS|

      FORMAT_PENDING|IMPORT_IN_PROGRESS|IMPORT_PENDING|

      INCOMPATIBLE|LOST|LTFS_WITH_FOREIGN_DATA|OFFLINE|

      ONLINE_IN_PROGRESS|ONLINE_PENDING|PENDING_INSPECTION|

      RAW_IMPORT_IN_PROGRESS|RAW_IMPORT_PENDING|

      SERIAL_NUMBER_MISMATCH|UNKNOWN

   </State>

   <StorageDomainMemberId>{string}</StorageDomainMemberId>

   <TakeOwnershipPending>TRUE|FALSE</TakeOwnershipPending>

   <TotalRawCapacity>{64-bit integer}</TotalRawCapacity>

   <Type>

      LTO5|LTO6|LTO7|LTO8|LTOM8|LTO9|LTO_CLEANING_TAPE|TS_JC|TS_JD|

      TS_JE|TS_JK|TS_JL|TS_JM|TS_JV|TS_JY|TS_JZ|TS_CLEANING_TAPE

      |UNKNOWN|FORBIDDEN

   </Type>
   <VerifyPending>

      CRITICAL|URGENT|HIGH|NORMAL|LOW|BACKGROUND

   </VerifyPending>

   <WriteProtected>TRUE|FALSE</WriteProtected>

</Data>
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where the response elements are defined as follows:

Parameter Description

Data A container for the response.

AvailableRaw
Capacity

The amount of unused raw capacity on the tape in bytes.

BarCode The barcode on the label of the tape cartridge.

BucketId The UUID for the bucket to which the tape is assigned.

DescriptionFor
Identification

The LTFS Volume ID and name, if applicable. This is only provided if the
BlackPearl gateway cannot identify the tape.

EjectDate The date and time that the BlackPearl gateway discovered that the tape
was ejected, in the format YYYY-MM-DDThh:mm:ss.xxxZ. If the parameter
is empty, the tape has not been ejected.

EjectLabel The user-entered information to assist in the handling of the tape.

EjectLocation The user-entered information to describe where the ejected tape can be
located.

EjectPending The date and time that the tape was put in the queue to be ejected in the
format YYYY-MM-DDThh:mm:ss.xxxZ. If the parameter is empty, the tape
has not been queued to be ejected or the eject has started and is no longer
cancelable.

FullOfData Whether the tape is completely full of data.
Values: TRUE, FALSE

Id The UUID for the tape.

LastAccessed The last date and time the tape was loaded into a tape drive in the format
YYYY-MM-DDThh:mm:ss.xxxZ.

LastCheckpoint An identifier, internal to the BlackPearl gateway, for verifying the
application integrity of the tape.

LastModified The last date and time the tape was modified in the format YYYY-MM-
DDThh:mm:ss.xxxZ.

LastVerified The last date and time the checksum of the data was verified in the format
YYYY-MM-DDThh:mm:ss.xxxZ.
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Parameter Description

PartiallyVerified
EndOfTape

The last date and time the BlackPearl gateway verified the data on a
specified percentage of the tape capacity before the EOD marker in the
format
YYYY-MM-DDThh:mm:ss.xxxZ.

PartitionId The UUID for the partition to which to the tape belongs.

PreviousState The previous status of the tape. See State on page 664.

Role The role assigned to the tape. Values: Normal, Test

SerialNumber The manufacturer-assigned serial number for the tape cartridge.

State The status of the tape. See State on page 664.

StorageDomain
MemberId

The UUID for the storage domain member.

TakeOwnership
Pending

Whether a tape from another BlackPearl gateway is waiting for the current
gateway to complete taking ownership.
Values:
• TRUE — The foreign tape was imported when WriteProtected was

TRUE, preventing the tape from being claimed by the current gateway.
• FALSE — The tape was imported successfully.

TotalRawCapacity The total raw capacity of the tape in bytes.

Type The tape format and generation of the tape cartridge.
Values: LTO5, LTO6, LTO7, LTO8, LTOM8, LTO9, LTO_CLEANING_TAPE, TS_
JC, TS_JD, TS_JE, TS_JK, TS_JL, TS_JM, TS_JV, TS_JY, TS_JZ, TS_CLEANING_
TAPE, UNKNOWN, FORBIDDEN

VerifyPending The priority for the verify requested, or null if a verify has not been
requested. The priority determines the resources assigned and the
processing order.
Values: CRITICAL, URGENT, HIGH, NORMAL, LOW, BACKGROUND

WriteProtected Whether the tape is write protected. Values: TRUE, FALSE

Example

Sample Request
This request retrieves information about the tape with the UUID 0571b314-7f9d-4a9f-9e4b-
98252c7b5266.

April 2023 DS3 API Reference-Spectra BlackPearl Nearline Gateway
- 737 -



Chapter 16 - Tape Library and Component Operations Get Tape

GET http://blackpearl-hostname/_rest_/tape/0571b314-7f9d-4a9f-9e4b-98252c7b5266/

HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>

   <AssignedToStorageDomain>FALSE</AssignedToStorageDomain>

   <AvailableRawCapacity>10000</AvailableRawCapacity>

   <BarCode>018375L5</BarCode>

   <BucketId/>

   <DescriptionForIdentification/>

   <EjectDate/>

   <EjectLabel/>

   <EjectLocation/>

   <EjectPending/>

   <FullOfData>FALSE</FullOfData>

   <Id>0571b314-7f9d-4a9f-9e4b-98252c7b5266</Id>

   <LastAccessed/>

   <LastCheckpoint>

      83f811df-927b-4543-8dc8-8ca2ed002fcb:3

   </LastCheckpoint>

   <LastModified/>

   <LastVerified/>

   <PartiallyVerifiedEndOfTape/>

   <PartitionId>26ef24cd-15f7-4aa0-aead-34abed82c60b</PartitionId>

   <PreviousState/>
   <Role>NORMAL</Role>

   <SerialNumber/>

   <State>NORMAL</State>

   <StorageDomainMemberId/>

   <TakeOwnershipPending>FALSE</TakeOwnershipPending>

   <TotalRawCapacity>1425000103936</TotalRawCapacity>

   <Type>LTO5</Type>

   <VerifyPending/>

   <WriteProtected>FALSE</WriteProtected>

</Data>
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GET TAPE DENSITY DIRECTIVE

Description
Get information about the specified tape density directive.

Note: This request is for TS11x0 data tapes only. LTO tapes can only be written at the
density that they are manufactured for, and cleaning tapes cannot be formatted.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/tape_density_directive/{tape density

directive UUID or other unique attribute}/

To determine the UUID for a tape density directive, see Get Tape Density Directives on
page 740.

Responses

Response Elements
<Data>

   <Density>TS1140|TS1150|TS1155|TS1160</Density>

   <Id>{string}</Id>

   <PartitionId>{string}</PartitionId>

   <TapeType>

      TS_JC|TS_JD|TS_JE|TS_JK|TS_JL|TS_JM|TS_JV|TS_JY|TS_JZ

   </TapeType>

</Data>

where the response elements are defined as follows:

Parameter Description

Data A container for the response.

Density The tape drive type that the density was formatted to match. Values: TS1140,
TS1150, TS1155, TS1160

Id The UUID for the tape density directive.
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Parameter Description

TapeType The tape format and generation of the tape cartridge.
Values: TS_JC, TS_JD, TS_JE, TS_JK, TS_JL, TS_JM, TS_JV, TS_JY, TS_JZ

Example

Sample Request
This request gets information about the tape density directive with UUID 78e4234f-8f3d-42d3-
9ae1-817e89d993bc.
GET http://blackpearl-hostname/_rest_/tape_density_directive/78e4234f-8f3d-42d3-

9ae1-817e89d993bc/ HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>

   <Density>TS1140</Density>

   <Id>78e4234f-8f3d-42d3-9ae1-817e89d993bc</Id>

   <PartitionId>b5ae905c-c3bc-4a2c-9a1c-da93ea55042c</PartitionId>

   <TapeType>TS_JK</TapeType>

</Data>

GET TAPE DENSITY DIRECTIVES

Description
Get information about all tape density directives.

Note: This request is for TS11x0 data tapes only. LTO tapes can only be written at the
density that they are manufactured for, and cleaning tapes cannot be formatted.
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Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/tape_density_directive/

[?density=TS1140|TS1150|TS1155|TS1160][&last_page][&page_length={32-bit integer}]

[&page_offset={32-bit integer}][&page_start_marker={unique identifier or attribute}]

[&partition_id={string}][&tape_type=TS_JC|TS_JD|TS_JE|TS_JK|TS_JL|TS_JM|TS_JV|TS_

JY|TS_JZ]

Request Parameters

Parameter Description Required

density The tape drive type that the tape density was formatted to match.
Values: TS1140, TS1150, TS1155, TS1160

no

last_page If included, only the last page of results is returned. no

page_length The maximum number of tape drives to list. The default is all items
after page_offset.

no

page_offset The starting point for the first tape drive to list. The default is 0. no

page_start_
marker

The UUID or other unique attribute for the item just before the first
item to list.
Notes:
• Specifying both page_offset and page_start_marker causes
an error.

• If neither page_offset, nor page_start_marker are specified,
the page_offset default is used.

no

partition_id The UUID for the partition. no

tape_type The tape format and generation of the tape cartridge.
Values: TS_JC, TS_JD, TS_JE, TS_JK, TS_JL, TS_JM, TS_JV, TS_JY, TS_
JZ

no
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Responses

Response Elements
<Data>

   <TapeDensityDirective>

      <Density>TS1140|TS1150|TS1155|TS1160</Density>

      <Id>{string}</Id>

     <PartitionId>{string}</PartitionId>

      <TapeType>

      TS_JC|TS_JD|TS_JE|TS_JK|TS_JL|TS_JM|TS_JV|TS_JY|TS_JZ

      </TapeType>
   <TapeDensityDirective>

   ...

</Data>

where the response elements are defined as follows:

Parameter Description

Data A container for the response.

TapeDensity Directive A container for information about one tape density directive.

Density The tape drive type that the density was formatted to match.
Values: TS1140, TS1150, TS1155, TS1160

Id The UUID for the tape density directive.

TapeType The tape format and generation of the tape cartridge.
Values: TS_JC, TS_JD, TS_JE, TS_JK, TS_JL, TS_JM, TS_JV, TS_JY, TS_JZ

Example

Sample Request
This request gets information about all tape density directives.
GET http://blackpearl-hostname/_rest_/tape_density_directive/ HTTP/1.1

April 2023 DS3 API Reference-Spectra BlackPearl Nearline Gateway
- 742 -



Chapter 16 - Tape Library and Component Operations Get Tape Drive

Sample Response
HTTP/1.1 200 OK

<Data>

   <TapeDensityDirective>

      <Density>TS1140</Density>

      <Id>67d32a56-cbc4-43e1-9a1b-64afbb14e731</Id>

      <PartitionId>

         0e4ee22f-de59-4e4e-b053-15487fa194e4

      </PartitionId>

      <TapeType>TS_JC</TapeType>

   </TapeDensityDirective>

   <TapeDensityDirective>

      <Density>TS1140</Density>

      <Id>ee94c349-d421-4a27-a21a-17d1a7c1bb6c</Id>

      <PartitionId>

         b11f1a5f-30a2-41c0-8962-288d9a6f84c8

      </PartitionId>

      <TapeType>TS_JC</TapeType>

   </TapeDensityDirective>

</Data>

GET TAPE DRIVE

Description
Get information about the specified tape drive.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/tape_drive/{tape_drive_id}/

To determine the UUID for a tape drive, see Get Tape Drives on page 746.
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Responses

Response Elements
<Data>

   <CleaningRequired>TRUE|FALSE</CleaningRequired>

   <ErrorMessage>{string}</ErrorMessage>

   <ForceTapeRemoval>TRUE|FALSE</ForceTapeRemoval>

   <Id>{string}</Id>

   <LastCleaned>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastCleaned>

   <MaxFailedTapes>{32-bit integer}</MaxFailedTapes>

   <MfgSerialNumber>{string}</MfgSerialNumber>

   <MinimumTaskPriority>

      ANY|LOW|NORMAL|HIGH|URGENT

   </MinimumTaskPriority>
   <PartitionId>{string}</PartitionId>

   <Quiesced>NO|PENDING|YES</Quiesced>

   <ReservedTaskType>ANY|READ|WRITE|MAINTENANCE</ReservedTaskType>

   <SerialNumber>{string}</SerialNumber>

   <State>

      ERROR|NORMAL|

      NOT_COMPATIBLE_IN_PARTITION_DUE_TO_NEWER_TAPE_DRIVES|OFFLINE

   </State>

   <TapeId>{string}</TapeId>
   <Type>

      LTO5|LTO6|LTO7|LTO8|LTOM8|LTO9|TS1140|TS1150|TS1155|TS1160|UNKNOWN

   </Type>

</Data>

where the response elements are defined as follows:

Parameter Description

Data A container for the response.

CleaningRequired Whether the tape drive indicates that it needs to be cleaned. Values: TRUE,
FALSE

ErrorMessage A description of any current error, if applicable.

ForceTapeRemoval Whether the tape drive is in an error state and asking that the tape in it be
forcibly removed. If required, this is performed before any other
operations.
Values: TRUE, FALSE
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Parameter Description

ID The UUID for the tape drive.

LastCleaned The last date and time the tape drive was cleaned in the format YYYY-MM-
DDThh:mm:ss.xxxZ.

MaxFailedTapes The maximum number of times a drive can fail tasks with different tapes
before it is no longer used. If set to zero, the BlackPearl gateway does not
automatically quiesce the tape drive.

MfgSerialNumber The manufacturer-assigned serial number for the tape drive.

MinimumTask
Prioirity

The minimum priority task for which the drive is reserved. Values: ANY,
LOW, NORMAL, HIGH, URGENT

PartitionId The UUID for the partition to which the drive belongs.

Quiesced Whether the tape drive is in a temporarily inactive state. Values: NO,
PENDING, YES

ReservedTaskType Whether the drive is reserved for reads only or writes only, or can be used
for reads or writes.
Values: ANY, READ, WRITE, MAINTENANCE

SerialNumber The location-based serial number for the drive while it is in the library.

State The status of the tape drive. Values: ERROR, NORMAL, NOT_COMPATIBLE_
IN_PARTITION_DUE_TO_NEWER_TAPE_DRIVES, OFFLINE

TapeId The UUID for the tape in the tape drive, if present.

Type The tape format and generation of the tape drive.
Values: LTO5, LTO6, LTO7, LTO8, LTOM8, LTO9, TS1140, TS1150, TS1155,
TS1160, UNKNOWN

Example

Sample Request
This request retrieves information about the tape drive with the UUID e2b1c2f8-85be-4350-
8882-2a2e1cd8ca0e.
GET http://blackpearl-hostname/_rest_/tape_drive/e2b1c2f8-85be-4350-8882-

2a2e1cd8ca0e/ HTTP/1.1
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Sample Response
HTTP/1.1 200 OK

<Data>

   <CleaningRequired>FALSE</CleaningRequired>

   <ErrorMessage/>

   <ForceTapeRemoval>FALSE</ForceTapeRemoval>

   <Id>e2b1c2f8-85be-4350-8882-2a2e1cd8ca0e</Id>

   <LastCleaned/>

   <MaxFailedTapes>3</MaxFailedTapes>

   <MfgSerialNumber>90WT008323</MfgSerialNumber>

   <MinimumTaskPriority>ANY</MinimumTaskPriority>
   <PartitionId>720270ee-9d79-46d2-833b-6150724593a3</PartitionId>

   <Quiesced>NO</Quiesced>

   <ReservedTaskType>ANY</ReservedTaskType>

   <SerialNumber>68001883</SerialNumber>

   <State>NORMAL</State>

   <TapeId>bbaf65f9-69fe-4212-97fe-47466fe39f61</TapeId>

   <Type>LTO5</Type>

</Data>

GET TAPE DRIVES

Description
Get information about all tape drives. Use parameters as selection criteria to return a subset
of the list.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/tape_drive/[?last_page][minimum_task_

priority=ANY|LOW|NORMAL|HIGH|URGENT][&page_length={32-bit integer}][&page_offset=

{32-bit integer}][&page_start_marker={string}][&partition_id={string}][&reserved_

task_type=ANY|READ|WRITE][&serial_number={string}][&state=ERROR|NORMAL|NOT_

COMPATIBLE_IN_PARTITION_DUE_TO_NEWER_TAPE_DRIVES|OFFLINE]

[&type=LTO5|LTO6|LTO7|LTO8|LTOM8|LTO9|TS1140|TS1150|TS1155|TS1160|UNKNOWN]
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Request Parameters

Parameter Description Required

last_page If included, only the last page of results is returned. no

minimum_
task_
priority

The minimum priority task for which the drive is reserved. Values:
ANY, LOW, NORMAL, HIGH, URGENT

no

page_length The maximum number of tape drives to list. The default is all items
after page_offset.

no

page_offset The starting point for the first tape drive to list. The default is 0. no

page_start_
marker

The UUID or other unique attribute for the item just before the first
item to list.
Notes:
• Specifying both page_offset and page_start_marker causes
an error.

• If neither page_offset, nor page_start_marker are
specified, the page_offset default is used.

no

partition_id The UUID for the partition. no

reserved_
task_ type

Whether the drive is reserved for reads only or writes only, or can
be used for reads or writes.
Values: ANY, READ, WRITE

no

serial_
number 1

The manufacturer-assigned serial number for the drive. no

state The status of the tape drive. Values: ERROR, NORMAL, NOT_
COMPATIBLE_IN_PARTITION_DUE_TO_NEWER_TAPE_DRIVES,
OFFLINE

no

type The tape format and generation of the tape drive.
Values: LTO5, LTO6, LTO7, LTO8, LTO9, TS1140, TS1150, TS1155,
TS1160, UNKNOWN

no

1) Parameter values can use wild cards (see Wild Card Syntax on page 30).
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Responses

Response Elements
<Data>

   <TapeDrive>

      <CleaningRequired>TRUE|FALSE</CleaningRequired>

      <ErrorMessage>{string}</ErrorMessage>

      <ForceTapeRemoval>TRUE|FALSE</ForceTapeRemoval>

      <Id>{string}</Id>

      <LastCleaned>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastCleaned>
      <MaxFailedTapes>{32-bit integer}</MaxFailedTapes>

      <MfgSerialNumber>{string}</MfgSerialNumber>
      <MinimumTaskPriority>
         ANY|LOW|NORMAL|HIGH|URGENT

      </MinimumTaskPriority>

      <PartitionId>{string}</PartitionId>

      <Quiesced>NO|PENDING|YES</Quiesced>

      <ReservedTaskType>ANY|READ|WRITE|MAINTENANCE</ReservedTaskType>

      <SerialNumber>{string}</SerialNumber>
      <State>

         ERROR|NORMAL|

         NOT_COMPATIBLE_IN_PARTITION_DUE_TO_NEWER_TAPE_DRIVES|

         OFFLINE

      </State>
      <TapeId>{string}</TapeId>

      <Type>

         LTO5|LTO6|LTO7|LTO8|LTOM8|LTO9|TS1140|TS1150|TS1155|TS1160

         |UNKNOWN

      </Type>

   </TapeDrive>

   ...

</Data>

where the response elements are defined as follows:

Parameter Description

Data A container for the response.

TapeDrive A container for information about a single tape drive.
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Parameter Description

CleaningRequired Whether the tape drive indicates that it needs to be cleaned. Values: TRUE,
FALSE

ErrorMessage A description of the current error, if applicable.

ForceTapeRemoval Whether the tape drive is in an error state and asking that the tape in it be
forcibly removed. If required, this is performed before any other
operations.
Values: TRUE, FALSE

ID The UUID for the tape drive.

LastCleaned The last date and time the tape drive was cleaned in the format YYYY-MM-
DDThh:mm:ss.xxxZ.

MaxFailedTapes The maximum number of times a drive can fail tasks with different tapes
before it is no longer used. If set to zero, the BlackPearl gateway does not
automatically quiesce the tape drive.

MfgSerialNumber The manufacturer-assigned serial number for the tape drive.

MinimumTask
Prioirity

The minimum priority task for which the drive is reserved. Values: ANY,
LOW, NORMAL, HIGH, URGENT

PartitionId The UUID for the partition to which the drive belongs.

Quiesced Whether the tape drive is in a temporarily inactive state. Values: NO,
PENDING, YES

ReservedTaskType Whether the drive is reserved for reads only or writes only, or can be used
for reads or writes.
Values: ANY, READ, WRITE, MAINTENANCE

SerialNumber The location-based serial number for the drive while it is in the library.

State The status of the tape drive. Values: ERROR, NORMAL, NOT_COMPATIBLE_
IN_PARTITION_DUE_TO_NEWER_TAPE_DRIVES, OFFLINE

TapeId The UUID for the tape in the tape drive, if present.

Type The tape format and generation of the tape drive.
Values: LTO5, LTO6, LTO7, LTO8, LTOM8, LTO9, TS1140, TS1150, TS1155,
TS1160, UNKNOWN
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Example

Sample Request
This request retrieves information about all tape drives connected to the BlackPearl gateway.
GET http://blackpearl-hostname/_rest_/tape_drive/ HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>

   <TapeDrive>

      <CleaningRequired>FALSE</CleaningRequired>

      <ErrorMessage/>

      <ForceTapeRemoval>FALSE</ForceTapeRemoval>

      <Id>63d3dbd4-baa8-4e8f-a40d-42a6c3e3bf95</Id>

      <LastCleaned/>

      <MaxFailedTapes>3</MaxFailedTapes>

      <MfgSerialNumber>90WT008323</MfgSerialNumber>

      <MinimumTaskPriority>ANY</MinimumTaskPriority>
      <PartitionId>

         4e848fa9-6cf5-45c4-ade2-16d96377401f

      </PartitionId>

      <Quiesced>NO</Quiesced>

      <ReservedTaskType>ANY</ReservedTaskType>

      <SerialNumber>68001883</SerialNumber>

      <State>NORMAL</State>

      <TapeId>2d4a2794-8617-4cdc-9e8f-0530fa1abbf2</TapeId>

      <Type>LTO5</Type>

   </TapeDrive>

   ...

</Data>

GET TAPE FAILURES

Description
Get a list of all tape failures. Use parameters as selection criteria to return a subset of the list.
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Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/tape_failure/[?error_message={string}][&last_

page][&page_length={32-bit integer}][&page_offset={32-bit integer}][&page_start_

marker={string}][&tape_drive_id={string}][&tape_id={string}][&type=BAR_CODE_

CHANGED|BAR_CODE_DUPLICATE|BLOB_READ_FAILED|CLEANING_TAPE_EXPIRED|DATA_CHECKPOINT_

FAILURE|DATA_CHECKPOINT_FAILURE_DUE_TO_READ_ONLY|DATA_CHECKPOINT_MISSING|DELAYED_

OWNERSHIP_FAILURE|DRIVE_CLEAN_FAILED|DRIVE_CLEANED|DRIVE_TEST_FAILED|DRIVE_TEST_

FAILED_ALL_WRITES_TOO_SLOW|DRIVE_TEST_FAILED_FORWARD_WRITES_TOO_SLOW|DRIVE_TEST_

FAILED_REVERSE_WRITES_TOO_SLOW|DRIVE_TEST_SUCCEEDED|FORMAT_FAILED|GET_TAPE_

INFORMATION_FAILED|HARDWARE_ERROR|IMPORT_FAILED|IMPORT_INCOMPLETE|IMPORT_FAILED_DUE_

TO_TAKE_OWNERSHIP_FAILURE|IMPORT_FAILED_DUE_TO_DATA_INTEGRITY|INCOMPATIBLE|INSPECT_

FAILED|QUIESCING_DRIVE|READ_FAILED|REIMPORT_REQUIRED|SERIAL_NUMBER_MISMATCH|VERIFY_

FAILED|WRITE_FAILED]

Request Parameters

Parameter Description Required

error_
message 1

The description of an error. no

last_page If included, only the last page of results is returned. no

page_length The maximum number of failures to list. The default is all items
after page_offset.

no

page_offset The starting point for the first failure to list. The default is 0. no

page_start_
marker

The UUID or other unique attribute for the item just before the first
item to list.
Notes:
• Specifying both page_offset and page_start_marker causes
an error.

• If neither page_offset, nor page_start_marker are specified,
the page_offset default is used.

no

tape_drive_
id

The UUID or other unique attribute for the tape drive. no

1) Parameter values can use wild cards (see Wild Card Syntax on page 30).
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Parameter Description Required

tape_id The UUID, barcode, or other unique attribute for the tape. no

type The type of tape error message.
Values:
BAR_CODE_CHANGED, BAR_CODE_DUPLICATE, BLOB_READ_
FAILED, CLEANING_TAPE_EXPIRED, DATA_CHECKPOINT_FAILURE,
DATA_CHECKPOINT_FAILURE_DUE_TO_READ_ONLY, DATA_
CHECKPOINT_MISSING, DELAYED_OWNERSHIP_FAILURE, DRIVE_
CLEAN_FAILED, DRIVE_CLEANED|DRIVE_TEST_FAILED, DRIVE_TEST_
FAILED_ALL_WRITES_TOO_SLOW, DRIVE_TEST_FAILED_FORWARD_
WRITES_TOO_SLOW, DRIVE_TEST_FAILED_REVERSE_WRITES_TOO_
SLOW, DRIVE_TEST_SUCCEEDED, FORMAT_FAILED, GET_TAPE_
INFORMATION_FAILED, HARDWARE_ERROR, IMPORT_FAILED,
IMPORT_INCOMPLETE, IMPORT_FAILED_DUE_TO_TAKE_
OWNERSHIP_FAILURE, IMPORT_FAILED_DUE_TO_DATA_INTEGRITY,
INCOMPATIBLE, INSPECT_FAILED, QUIESCING_DRIVE, READ_FAILED,
REIMPORT_REQUIRED, SERIAL_NUMBER_MISMATCH, VERIFY_
FAILED, WRITE_FAILED

no

Responses

Response Elements
<Data>

   <TapeFailure>

      <Date>{YYYY-MM-DDThh:mm:ss.xxxZ}</Date>

      <ErrorMessage>{string}</ErrorMessage>

      <Id>{string}</Id>

      <TapeDriveId>{string}</TapeDriveId>

      <TapeId>{string}</TapeId>
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      <Type>

         BAR_CODE_CHANGED|BAR_CODE_DUPLICATE|BLOB_READ_FAILED|CLEANING_TAPE_

EXPIRED|DATA_CHECKPOINT_FAILURE|DATA_CHECKPOINT_FAILURE_DUE_TO_READ_ONLY|DATA_

CHECKPOINT_MISSING|DELAYED_OWNERSHIP_FAILURE|DRIVE_CLEAN_FAILED|DRIVE_CLEANED|DRIVE_

TEST_FAILED|DRIVE_TEST_FAILED_ALL_WRITES_TOO_SLOW|DRIVE_TEST_FAILED_FORWARD_WRITES_

TOO_SLOW|DRIVE_TEST_FAILED_REVERSE_WRITES_TOO_SLOW|DRIVE_TEST_SUCCEEDED|FORMAT_

FAILED|GET_TAPE_INFORMATION_FAILED|HARDWARE_ERROR|IMPORT_FAILED|IMPORT_

INCOMPLETE|IMPORT_FAILED_DUE_TO_TAKE_OWNERSHIP_FAILURE|IMPORT_FAILED_DUE_TO_DATA_

INTEGRITY|INCOMPATIBLE|INSPECT_FAILED|QUIESCING_DRIVE|READ_FAILED|REIMPORT_

REQUIRED|SERIAL_NUMBER_MISMATCH|VERIFY_FAILED|WRITE_FAILED

      </Type>

   </TapeFailure>

   ...

</Data>

where the response elements are defined as follows:

Parameter Description

Data A container for the response.

TapeFailure A container for information about a single tape failure.

Date The date and time the error occurred in the format
YYYY-MM-DDThh:mm:ss.xxxZ.

ErrorMessage A description of the error.

Id The UUID for the error message.

TapeDriveId The UUID for the tape drive.

TapeId The UUID for the tape.

Type The type of tape error message.

Example

Sample Request
This request retrieves a list of all tape failures.
GET http://blackpearl-hostname/_rest_/tape_failure/ HTTP/1.1
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Sample Response
HTTP/1.1 200 OK

<Data>

   <TapeFailure>

      <Date>2014-10-02 11:40:23.851</Date>

      <ErrorMessage>{Full Exception Output}</ErrorMessage>

      <Id>1e41b332-5db8-4080-87c1-d7e00b170a18</Id>

      <TapeDriveId>

         eea2ee27-05ef-4b15-b8f8-c2f897c892e6

      </TapeDriveId>

      <TapeId>1793a19b-a701-4709-98b1-3bd3f75c739b</TapeId>

      <Type>FORMAT_FAILED</Type>
   </TapeFailure>
</Data>

GET TAPE LIBRARIES

Description
Get a list of all tape libraries available to the Spectra BlackPearl Nearline Gateway. Use
parameters as selection criteria to return a subset of the list.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/tape_library/[?last_page][&management_url=

{string}][&name={string}][&page_length={32-bit integer}][&page_offset=

{32-bit integer}][&page_start_marker={string}][&serial_number={string}]

Request Parameters

Parameter Description Required

last_page If included, only the last page of results is returned. no

management_url The IP address to access the library’s BlueScale web server. no
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Parameter Description Required

name 1 The name of the library. no

page_length The maximum number of libraries to list. The default is all items
after page_offset.

no

page_offset The starting point for the first library to list. The default is 0. no

page_start_
marker

The UUID or other unique attribute for the item just before the
first item to list.
Notes:
• Specifying both page_offset and page_start_marker
causes an error.

• If neither page_offset, nor page_start_marker are
specified, the page_offset default is used.

no

serial_number 1 The serial number of the library. no

Responses

Response Elements
<Data>

   <TapeLibrary>

      <Id>{string}</Id>

      <ManagementUrl>{string}</ManagementUrl>

      <Name>{string}</Name>

      <SerialNumber>{string}</SerialNumber>

   </TapeLibrary>

   ...

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

TapeLibrary The container for information about a single library

Id The UUID for the library.

1) Parameter values can use wild cards (see Wild Card Syntax on page 30).
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Parameter Description

ManagementUrl The IP address to access the library’s BlueScale web server.

Name The name for the library.

SerialNumber The serial number for the library.

Example

Sample Request
This request retrieves a list of all tape libraries available to the BlackPearl gateway.
GET http://blackpearl-hostname/_rest_/tape_library/ HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>

   <TapeLibrary>

      <Id>836e1079-c726-4eae-aee4-0472d75bbae4</Id>

      <ManagementUrl>10.10.11.10</ManagementUrl>

      <Name>T950Library</Name>

      <SerialNumber>0918401</SerialNumber>

   </TapeLibrary>

   ...

</Data>

GET TAPE LIBRARY

Description
Get information about the specified tape library.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/tape_library/{tape library UUID, name, or

other unique attribute}/

To determine the UUID for a tape library, see Get Tape Libraries on page 754.
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Responses

Response Elements
<Data>

   <Id>{string}</Id>

   <ManagementUrl>{string}</ManagementUrl>

   <Name>{string}</Name>

   <SerialNumber>{string}</SerialNumber>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

Id The UUID for the library.

ManagementUrl The IP address to access the library’s BlueScale web server.

Name The name for the library.

SerialNumber The serial number for the library.

Example

Sample Request
This request retrieves information about the tape library with the UUID 3ca7f00b-b148-4f56-
9964-9aeefb88e879.
GET http://blackpearl-hostname/_rest_/tape_library/3ca7f00b-b148-4f56-9964-

9aeefb88e879/ HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>

   <Id>3ca7f00b-b148-4f56-9964-9aeefb88e879</Id>

   <ManagementUrl>10.10.11.10</ManagementUrl>

   <Name>T950Library</Name>

   <SerialNumber>0918401</SerialNumber>

</Data>
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GET TAPE PARTITION

Description
Get information about the specified tape partition.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/tape_partition/{tape_partition_id}/[?full_

details]

To determine the UUID for a tape partition, see Get Tape Partitions on page 765.

Request Parameters

Parameter Description Required

full_details If included, then additional information about the tape partition is
included in the response.

no

Responses

Response Elements
<Data>

   <AutoCompactionEnabled>TRUE|FALSE</AutoCompactionEnabled>

   <AutoQuiesceEnabled>TRUE|FALSE</AutoQuiesceEnabled>

   <DriveIdleTimeoutInMinutes>

{32-bit integer}

</DriveIdleTimeoutInMinutes>

   <DriveType>

      LTO5|LTO6|LTO7|LTO8|LTOM8|LTO9|TS1140|TS1150|TS1155|TS1160|UNKNOWN

   </DriveType>
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   <DriveTypes> (only if full_details is included)

      LTO5|LTO6|LTO7|LTO8|LTOM8|LTO9|TS1140|TS1150|TS1155|TS1160|UNKNOWN

   </DriveTypes>

   ...

   <ErrorMessage>{string}</ErrorMessage>

   <Id>{string}</Id>

   <ImportExportConfiguration>

      SUPPORTED|NOT_SUPPORTED

   </ImportExportConfiguration>

   <LibraryId>{string}</LibraryId>

   <MinimumReadReservedDrives>

{32-bit integer}

   </MinimumReadReservedDrives>
   <MinimumWriteReservedDrives>

{32-bit integer}

   </MinimumWriteReservedDrives>
   <Name>{string}</Name>

   <Quiesced>NO|PENDING|YES</Quiesced>
   <SerialId>{string}</SerialId>

   <SerialNumber>{string}</SerialNumber>

   <State>ONLINE|OFFLINE</State>

   <TapeTypes> (only if full_details is included)

      LTO5|LTO6|LTO7|LTO8|LTOM8|LTO9|LTO_CLEANING_TAPE|TS_JC|TS_JD|

      TS_JE|TS_JK|TS_JL|TS_JM|TS_JV|TS_JY|TS_JZ|TS_CLEANING_TAPE

      |UNKNOWN|FORBIDDEN

   </TapeTypes>

</Data>

where the response elements are defined as follows:

Parameter Description
Only
with full-
details

Data The container for the response.

AutoCompaction
Enabled

Whether auto compaction of tapes is enabled.

AutoQuiesceEnabled Whether to quiesce a tape drive after reaching the max_
failed_tapes limit (see max_failed_tapes on page 813).

DriveIdleTimeoutIn
Minutes

The number of minutes to wait while a drive is idle before
ejecting the tape and moving it back to a storage slot.
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Parameter Description
Only
with full-
details

DriveType The drive type in the partition used by the BlackPearl
gateway.
Values: LTO5, LTO6, LTO7, LTO8, LTOM8, LTO9, TS1140,
TS1150, TS1155, TS1160, UNKNOWN

DriveTypes All drive types assigned to the partition. Only one drive
type should be assigned to a partition.
Values: LTO5, LTO6, LTO7, LTO8, LTOM8, LTO9, TS1140,
TS1150, TS1155, TS1160, UNKNOWN

yes

ErrorMessage The description of any current error.

Id The UUID for the partition.

ImportExport
Configuration

Whether the import and export configuration of the tape
library is supported by the BlackPearl gateway. If a T50e or
T120 library with multiple partitions is associated with a
BlackPearl gateway, you cannot use the BlackPearl gateway
to eject the tapes because of the library’s shared eject port.
In this situation, see Spectra BlackPearl gateway User Guide for
instructions for manually ejecting tapes from the BlackPearl
gateway.
Values: SUPPORTED, NOT_SUPPORTED

LibraryId The UUID for the library.

MinimumRead
ReservedDrives

The minimum number of drives in the partition reserved for
reads.

MinimumWrite
ReservedDrives

The minimum number of drives in the partition reserved for
writes.

Name The name of the partition.

Quiesced Whether the partition is in a temporarily inactive state.
Values: NO, PENDING, YES

SerialId A unique representation of the library partition serial
number that remains the same even if the partition exporter
is replaced.

SerialNumber The serial number of the library partition.

State The status of the tape partition. Values: ONLINE, OFFLINE
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Parameter Description
Only
with full-
details

TapeTypes The tape format and generation of the tape cartridge.
Values: LTO5, LTO6, LTO7, LTO8, LTOM8, LTO9, LTO_
CLEANING_TAPE, TS_JC, TS_JD, TS_JE, TS_JK, TS_JL, TS_JM,
TS_JV, TS_JY, TS_JZ, TS_CLEANING_TAPE, UNKNOWN,
FORBIDDEN

yes

Example

Sample Request
This request retrieves information about the tape partition with the UUID 9434bc89-67a5-
41c2-a161-098972f1dd67 using full_details.
GET http://blackpearl-hostname/_rest_/tape_partition/9434bc89-67a5-41c2-a161-

098972f1dd67/?full_details HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>

   <AutoCompactionEnabled>FALSE</AutoCompactionEnabled>

   <AutoQuiesceEnabled>false</AutoQuiesceEnabled>

<DriveIdleTimeoutInMinutes>7</DriveIdleTimeoutInMinutes>

   <DriveType>TS1140</DriveTypes>

   <DriveTypes>TS1140</DriveTypes>

   <ErrorMessage/>

   <Id>9434bc89-67a5-41c2-a161-098972f1dd67</Id>

   <ImportExportConfiguration>

      SUPPORTED

   </ImportExportConfiguration>

   <LibraryId>1b71aadb-4ffc-4649-9f41-3f0cc5d01782</LibraryId>

   <MinimumReadReservedDrives>0</MinimumReadReservedDrives>

   <MinimumWriteReservedDrives>0</MinimumWriteReservedDrives>

   <Name>name-tape partition</Name>

   <Quiesced>NO</Quiesced>
   <SerialId>01000090A5000950</SerialId>

   <SerialNumber>21130090A5000950</SerialNumber>

   <State>ONLINE</State>

   <TapeTypes>LTO6</TapeTypes>

</Data>
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GET TAPE PARTITION FAILURES

Description
Get a list of all tape partition failures. Use parameters as selection criteria to return a subset
of the list.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/tape_partition_failure/[?error_message=

{string}][&last_page][&page_length={32-bit integer}][&page_offset={32-bit integer}]

[&page_start_marker={string}][&partition_id={string}][&type=AUTO_QUIESCED|CLEANING_

TAPE_REQUIRED|DUPLICATE_TAPE_BAR_CODES_DETECTED|EJECT_STALLED_DUE_TO_OFFLINE_

TAPES|MINIMUM_DRIVE_COUNT_NOT_MET|MOVE_FAILED|MOVE_FAILED_DUE_TO_PREPARE_TAPE_FOR_

REMOVAL_FAILURE|NO_USABLE_DRIVES|ONLINE_STALLED_DUE_TO_NO_STORAGE_SLOTS|TAPE_DRIVE_

IN_ERROR|TAPE_DRIVE_MISSING|TAPE_DRIVE_NOT_CLEANED|TAPE_DRIVE_QUIESCED|TAPE_DRIVE_

TYPE_MISMATCH|TAPE_EJECTION_BY_OPERATOR_REQUIRED|TAPE_MEDIA_TYPE_INCOMPATIBLE|TAPE_

REMOVAL_UNEXPECTED|TAPE_IN_INVALID_PARTITION]

Request Parameters

Parameter Description Required

error_
message 1

A description of an error. no

last_page If included, only the last page of results is returned. no

page_length The maximum number of failures to list. The default is all items
after page_offset.

no

page_offset The starting point for the first failure to list. The default is 0. no

1) Parameter values can use wild cards (see Wild Card Syntax on page 30).
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Parameter Description Required

page_start_
marker

The UUID or other unique attribute for the item just before the first
item to list.
Notes:
• Specifying both page_offset and page_start_marker causes
an error.

• If neither page_offset, nor page_start_marker are specified,
the page_offset default is used.

no

partition_id The UUID for the partition. no

type The type of tape partition error message.
Values: AUTO_QUIESCED, CLEANING_TAPE_REQUIRED, DUPLICATE_
TAPE_BAR_CODES_DETECTED, EJECT_STALLED_DUE_TO_OFFLINE_
TAPES, MINIMUM_DRIVE_COUNT_NOT_MET, MOVE_FAILED, MOVE_
FAILED_DUE_TO_PREPARE_TAPE_FOR_REMOVAL_FAILURE, NO_
USABLE_DRIVES, ONLINE_STALLED_DUE_TO_NO_STORAGE_SLOTS,
TAPE_DRIVE_IN_ERROR, TAPE_DRIVE_MISSING, TAPE_DRIVE_NOT_
CLEANED, TAPE_DRIVE_QUIESCED, TAPE_DRIVE_TYPE_MISMATCH,
TAPE_EJECTION_BY_OPERATOR_REQUIRED, TAPE_MEDIA_TYPE_
INCOMPATIBLE, TAPE_REMOVAL_UNEXPECTED, TAPE_IN_INVALID_
PARTITION

no
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Responses

Response Elements
<Data>

   <TapePartitionFailure>

      <Date>{YYYY-MM-DDThh:mm:ss.xxxZ}</Date>

      <ErrorMessage>{string}</ErrorMessage>

      <Id>{string}</Id>

      <PartitionId>{string}</PartitionId>

      <Type>

         AUTO_QUIESCED|CLEANING_TAPE_REQUIRED|DUPLICATE_TAPE_BAR_CODES_

DETECTED|EJECT_STALLED_DUE_TO_OFFLINE_TAPES|MINIMUM_DRIVE_COUNT_NOT_MET|MOVE_

FAILED|MOVE_FAILED_DUE_TO_PREPARE_TAPE_FOR_REMOVAL_FAILURE|NO_USABLE_DRIVES|ONLINE_

STALLED_DUE_TO_NO_STORAGE_SLOTS|TAPE_DRIVE_IN_ERROR|TAPE_DRIVE_MISSING|TAPE_DRIVE_

NOT_CLEANED|TAPE_DRIVE_QUIESCED|TAPE_DRIVE_TYPE_MISMATCH|TAPE_EJECTION_BY_OPERATOR_

REQUIRED|TAPE_MEDIA_TYPE_INCOMPATIBLE|TAPE_REMOVAL_UNEXPECTED|TAPE_IN_INVALID_

PARTITION

      </Type>

   </TapePartitionFailure>

   ...

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

TapePartition
Failure

The container for information for each failure.

Date The date and time the failure occurred in the format
YYYY-MM-DDThh:mm:ss.xxxZ.

ErrorMessage The full exception output for the error.

Id The UUID for the error message.

PartitionId The UUID for the partition.
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Parameter Description

Type The type of tape partition failure message.
Values: CLEANING_TAPE_REQUIRED, DUPLICATE_TAPE_BAR_CODES_
DETECTED, EJECT_STALLED_DUE_TO_OFFLINE_TAPES, MINIMUM_DRIVE_
COUNT_NOT_MET, MOVE_FAILED, MOVE_FAILED_DUE_TO_PREPARE_TAPE_
FOR_REMOVAL_FAILURE, NO_USABLE_DRIVES, ONLINE_STALLED_DUE_TO_
NO_STORAGE_SLOTS, TAPE_DRIVE_IN_ERROR, TAPE_DRIVE_MISSING, TAPE_
DRIVE_QUIESCED, TAPE_DRIVE_TYPE_MISMATCH, TAPE_EJECTION_BY_
OPERATOR_REQUIRED, TAPE_MEDIA_TYPE_INCOMPATIBLE, TAPE_REMOVAL_
UNEXPECTED, TAPE_IN_INVALID_PARTITION

Example

Sample Request
This request retrieves a list of tape partition failures.
GET http://blackpearl-hostname/_rest_/tape_partition_failure/ HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>

   <TapePartitionFailure>

      <Date>2014-10-02 11:40:10.621</Date>

      <ErrorMessage>{Full Exception Output}</ErrorMessage>

      <Id>a92bd5a6-eb56-44c8-9a08-1f896c3eab0e</Id>

      <PartitionId>

         c95f253e-d56c-4ce5-a882-46f213ac9e34

      </PartitionId>

      <Type>MOVE_FAILED</Type>

   </TapePartitionFailure>

   ...

</Data>

GET TAPE PARTITIONS

Description
Get information about all tape partitions. Use parameters as selection criteria to return a
subset of the list.
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Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/tape_partition/[?full_details][&import_

export_configuration=NOT_SUPPORTED|SUPPORTED][&last_page][&library_id={string}]

[?minimum_read_reserved_drives={32-bit integer}] [&minimum_write_reserved_drives=

{32-bit integer}][&name={string}][&page_length={32-bit integer}][&page_offset=

{32-bit integer}][&page_start_marker={string}][&quiesced=NO|PENDING|YES][&serial_

number={string}][&state=ONLINE|OFFLINE]

Request Parameters

Parameter Description Required

full_details If included, then additional information about the tape partition
is included in the response.

no

import_export_
configuration

Whether the import and export configuration of the tape library
is supported by the BlackPearl gateway. If a T50e or T120 library
with multiple partitions is associated with a BlackPearl gateway,
you cannot use the BlackPearl gateway to eject the tapes because
of the library’s shared eject port. In this situation, see Spectra
BlackPearl gateway User Guide for instructions for manually
ejecting tapes from the BlackPearl gateway.
Values: SUPPORTED, NOT_SUPPORTED

no

last_page If included, only the last page of results is returned. no

minimum_read_
reserved_drives

The minimum number of drives in the partition reserved for
reads.

no

minimum_
write_
reserved_drives

The minimum number of drives in the partition reserved for
writes.

no

name 1 The name of the partition. no

page_length The maximum number of tape partitions to list. The default is all
items after page_offset.

no

page_offset The starting point for the first tape partition to list. The default is
0.

no

1) Parameter values can use wild cards (see Wild Card Syntax on page 30).
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Parameter Description Required

page_start_
marker

The UUID or other unique attribute for the item just before the
first item to list.
Notes:
• Specifying both page_offset and page_start_marker
causes an error.

• If neither page_offset, nor page_start_marker are
specified, the page_offset default is used.

no

quiesced Whether the partition is in a temporarily inactive state. Values:
NO, PENDING, YES

no

serial_number 1 The serial number of the library partition. no

state The status of the tape partition. Values: ONLINE, OFFLINE no

Responses

Response Elements
<Data>

   <TapePartition>

      <AutoCompactionEnabled>TRUE|FALSE</AutoCompactionEnabled>

      <AutoQuiesceEnabled>TRUE|FALSE</AutoQuiesceEnabled>

      <DriveIdleTimeoutInMinutes>

{32-bit integer}

</DriveIdleTimeoutInMinutes>

      <DriveType>

         LTO5|LTO6|LTO7|LTO8|LTOM8|LTO9|TS1140|TS1150|TS1155|TS1160|UNKNOWN

      </DriveType>
      <ErrorMessage>{string}</ErrorMessage>

      <Id>{string}</Id>

      <ImportExportConfiguration>

         SUPPORTED|NOT_SUPPORTED

      </ImportExportConfiguration>
      <LibraryId>{string}</LibraryId>

      <MinimumReadReservedDrives>

{32-bit integer}

      </MinimumReadReservedDrives>

1) Parameter values can use wild cards (see Wild Card Syntax on page 30).
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      <MinimumWriteReservedDrives>

{32-bit integer}

      </MinimumWriteReservedDrives>

      <Name>{string}</Name>

      <Quiesced>NO|PENDING|YES</Quiesced>
      <SerialId>{string}</SerialId>

      <SerialNumber>{string}</SerialNumber>

      <State>ONLINE|OFFLINE</State>
      <TapeTypes> (only if full_details is included)

         LTO5|LTO6|LTO7|LTO8|LTOM8|LTO9|LTO_CLEANING_TAPE|TS_JC|

         TS_JD|TS_JE|TS_JK|TS_JL|TS_JM|TS_JV|TS_JY|TS_JZ|

         TS_CLEANING_TAPE|UNKNOWN|FORBIDDEN

      </TapeTypes>

   </TapePartition>

   ...

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

TapePartition The container for information about one tape partition.

AutoCompaction
Enabled

Whether auto compaction of tapes is enabled.

AutoQuiesceEnabled Whether to quiesce a tape drive after reaching the max_failed_tapes
limit (see max_failed_tapes on page 813).

DriveIdleTimeoutIn
Minutes

The number of minutes to wait while a drive is idle before ejecting the
tape and moving it back to a storage slot.

DriveType The drive type used by the BlackPearl gateway.
Values: LTO5, LTO6, LTO7, LTO8, LTOM8, LTO9, TS1140, TS1150,
TS1155, TS1160, UNKNOWN

ErrorMessage The description of any current error.

Id The UUID for the partition.
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Parameter Description

ImportExport
Configuration

Whether the import and export configuration of the tape library is
supported by the BlackPearl gateway. If a T50e or T120 library with
multiple partitions is associated with a BlackPearl gateway, you cannot
use the BlackPearl gateway to eject the tapes because of the library’s
shared eject port. In this situation, see Spectra BlackPearl gateway User
Guide for instructions for manually ejecting tapes from the BlackPearl
gateway.
Values: SUPPORTED, NOT_SUPPORTED

LibraryId The UUID for the library.

MinimumRead
ReservedDrives

The minimum number of drives in the partition reserved for reads.

MinimumWrite
ReservedDrives

The minimum number of drives in the partition reserved for writes.

Name The name of the partition.

Quiesced Whether the partition is in a temporarily inactive state. Values: NO,
PENDING, YES

SerialID A unique representation of the library partition serial number that
remains the same even if the partition exporter is replaced.

SerialNumber The serial number of the library partition.

State The status of the tape partition. Values: ONLINE, OFFLINE

TapeTypes 1 The tape format and generation of the tape cartridge.
Values: LTO5, LTO6, LTO7, LTO8, LTOM8, LTO9, LTO_CLEANING_TAPE,
TS_JC, TS_JD, TS_JE, TS_JK, TS_JL, TS_JM, TS_JV, TS_JY, TS_JZ, TS_
CLEANING_TAPE, UNKNOWN, FORBIDDEN

Example

Sample Request
This request retrieves a list of tape partitions.
GET http://blackpearl-hostname/_rest_/tape_partition/ HTTP/1.1

1) Only returned if full_details is included.
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Sample Response
HTTP/1.1 200 OK

<Data>

   <TapePartition>

      <AutoCompactionEnabled>false</AutoCompactionEnabled>

      <AutoQuiesceEnabled>false</AutoQuiesceEnabled>

      <DriveIdleTimeoutInMinutes>15</DriveIdleTimeoutInMinutes>

<DriveType>LTO6</DriveType>

      <ErrorMessage/>

      <Id>dce42f32-2c1b-4072-8621-c2947beaadde</Id>

      <ImportExportConfiguration>SUPPORTED</ImportExportConfiguration>

      <LibraryId>3a499d21-96f1-42b5-b3d1-fa25a1ed9bdc</LibraryId>

      <MinimumReadReservedDrives>0</MinimumReadReservedDrives>

      <MinimumWriteReservedDrives>0</MinimumWriteReservedDrives>

      <Name>name-tape partition 1</Name>

      <Quiesced>NO</Quiesced>

      <SerialNumber>tape partition 1</SerialNumber>

      <State>ONLINE</State>

   </TapePartition>

   ...

</Data>

GET TAPES

Description
Get a list of all tapes. Use parameters as selection criteria to return a subset of the list.
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Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/tape/[?assigned_to_storage=TRUE|FALSE][&bar_

code={string}][&bucket_id={string}][&eject_label={string}][&eject_location={string}]

[&full_of_data=TRUE|FALSE][&last_page][&last_verified={date}][&page_length=

{32-bit integer}][&page_offset={32-bit integer}][&page_start_marker={string}]

[&partially_verified_end_of_tape={date}][&partition_id={string}][&previous_

state=NORMAL|AUTO_COMPACTION_IN_PROGRESS|BAD|BAR_CODE_MISSING|CANNOT_FORMAT_DUE_TO_

WRITE_PROTECTION|DATA_CHECKPOINT_FAILURE|DATA_CHECKPOINT_FAILURE_DUE_TO_READ_

ONLY|DATA_CHECKPOINT_MISSING|EJECT_FROM_EE_PENDING|EJECT_TO_EE_IN_

PROGRESS|EJECTED|FOREIGN|FORMAT_IN_PROGRESS|FORMAT_PENDING|IMPORT_IN_

PROGRESS|IMPORT_PENDING|INCOMPATIBLE|LOST|LTFS_WITH_FOREIGN_DATA|OFFLINE|ONLINE_IN_

PROGRESS|ONLINE_PENDING|PENDING_INSPECTION|RAW_IMPORT_IN_PROGRESS|RAW_IMPORT_

PENDING|SERIAL_NUMBER_MISMATCH|UNKNOWN][&role=NORMAL|TEST][&serial_number={string}]

[&sort_by=ASSIGNED_TO_STORAGE_DOMAIN|AVAILABLE_RAW_CAPACITY|BAR_CODE|BUCKET_

ID|DESCRIPTION_FOR_IDENTIFICATION|EJECT_DATE|EJECT_LABEL|EJECT_LOCATION|EJECT_

PENDING|FULL_OF_DATA|ID|LAST_ACCESSED|LAST_CHECKPOINT|LAST_MODIFIED|LAST_

VERIFIED|PARTIALLY_VERIFIED_END_OF_TAPE|PARTITION_ID|PREVIOUS_STATE|SERIAL_

NUMBER|STATE|STORAGE_DOMAIN_ID|TAKE_OWNERSHIP_PENDING|TOTAL_RAW_

CAPACITY|TYPE|VERIFY_PENDING|WRITE_PROTECTED] [&state=NORMAL|AUTO_COMPACTION_IN_

PROGRESS|BAD|BAR_CODE_MISSING|CANNOT_FORMAT_DUE_TO_WRITE_PROTECTION|DATA_CHECKPOINT_

FAILURE|DATA_CHECKPOINT_FAILURE_DUE_TO_READ_ONLY|DATA_CHECKPOINT_MISSING|EJECT_FROM_

EE_PENDING|EJECT_TO_EE_IN_PROGRESS|EJECTED|FOREIGN|FORMAT_IN_PROGRESS|FORMAT_

PENDING|IMPORT_IN_PROGRESS|IMPORT_PENDING|INCOMPATIBLE|LOST|LTFS_WITH_FOREIGN_

DATA|OFFLINE|ONLINE_IN_PROGRESS|ONLINE_PENDING|PENDING_INSPECTION|RAW_IMPORT_IN_

PROGRESS|RAW_IMPORT_PENDING|SERIAL_NUMBER_MISMATCH|UNKNOWN][&storage_domain_id=

{string}][&type=LTO5|LTO6|LTO7|LTO8|LTOM8|LTO9|LTO_CLEANING_TAPE|TS_JC|TS_JD|TS_

JE|TS_JK|TS_JL|TS_JM|TS_JV|TS_JY|TS_JZ|TS_CLEANING_TAPE|UNKNOWN|FORBIDDEN][&write_

protected=TRUE|FALSE]

Request Parameters

Parameter Description Required

assigned_to_
storage_
domain

Whether the tape is currently assigned to a storage domain. Values:
TRUE, FALSE

no

available_
raw_
capacity

The amount of unused raw capacity on the tape in bytes. no
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Parameter Description Required

bar_code 1 The barcode on the label of the tape cartridge. no

bucket_id The UUID for the bucket to which the tape is assigned. no

eject_label Enter information to assist in the handling of the tape. no

eject_
location

Enter information to describe where the ejected tape can be located. no

full_of_data Whether the tape is full of data. Values: TRUE, FALSE no

last_page If included, only the last page of results is returned. no

last_verified The date and time that the BlackPearl gateway last verified the data
on a tape cartridge in the format YYYY-MM-DDThh:mm:ss.xxxZ.

no

page_length The maximum number of tapes to list. The default is all items after
page_offset.

no

page_offset The starting point for the first tapes to list. The default is 0. no

page_start_
marker

The UUID or other unique attribute for the item just before the first
item to list.
Notes:
• Specifying both page_offset and page_start_marker causes
an error.

• If neither page_offset, nor page_start_marker are specified,
the page_offset default is used.

no

partially_
verified_
end_of_tape
1

The date and time that the BlackPearl gateway verified the data on
a specified percentage of the tape capacity before the EOD marker
in the format YYYY-MM-DDThh:mm:ss.xxxZ.

no

partition_id The UUID for the partition. no

previous_
state

The previous status of the tape. See State on page 664. no

Role The role assigned to the tape. Values: Normal, Test no

serial_
number 1

The manufacturer-assigned serial number for the tape cartridge. no

1) Parameter values can use wild cards (see Wild Card Syntax on page 30).
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Parameter Description Required

sort_by The response element to use for sorting the list of tapes returned.
Values: ASSIGNED_TO_STORAGE_DOMAIN, AVAILABLE_RAW_
CAPACITY, BAR_CODE, BUCKET_ID, DESCRIPTION_FOR_
IDENTIFICATION, EJECT_DATE, EJECT_LABEL, EJECT_LOCATION,
EJECT_PENDING, FULL_OF_DATA, ID, LAST_ACCESSED, LAST_
CHECKPOINT, LAST_MODIFIED, LAST_VERIFIED, PARTIALLY_
VERIFIED_END_OF_TAPE, PARTITION_ID, PREVIOUS_STATE, SERIAL_
NUMBER, STATE, STORAGE_DOMAIN_ID, TAKE_OWNERSHIP_
PENDING, TOTAL_RAW_CAPACITY, TYPE, VERIFY_PENDING, WRITE_
PROTECTED

no

state The status of the tape. See State on page 664. no

storage_
domain_
member_id

The UUID for the storage domain member. See Get Storage Domain
Members on page 569.

no

type The tape format and generation of the tape cartridge.
Values: LTO5, LTO6, LTO7, LTO8, LTOM8, LTO9, LTO_CLEANING_
TAPE, TS_JC, TS_JD, TS_JE, TS_JK, TS_JL, TS_JM, TS_JV, TS_JY, TS_
JZ, TS_CLEANING_TAPE, UNKNOWN, FORBIDDEN

no

verify_
pending

The priority for the verify requested, or null if a verify has not been
requested. The priority determines the resources assigned and the
processing order.
Values: CRITICAL, URGENT, HIGH, NORMAL, LOW, BACKGROUND

no

write_
protected

Whether the tape is write protected. Values: TRUE, FALSE no

Responses

Response Elements
<Data>

   <Tape>

      <AssignedToStorageDomain>

         TRUE|FALSE

      </AssignedToStorageDomain>
      <AvailableRawCapacity>

{64-bit integer}

      </AvailableRawCapacity>
      <BarCode>{string}</BarCode>

      <BucketId>{string}</BucketId>
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      <DescriptionForIdentification>

{string}

      </DescriptionForIdentification>

      <EjectDate>{YYYY-MM-DDThh:mm:ss.xxxZ}</EjectDate>

      <EjectLabel>{string}</EjectLabel>

      <EjectLocation>{string}</EjectLocation>

      <EjectPending>{YYYY-MM-DDThh:mm:ss.xxxZ}</EjectPending>

      <FullOfData>TRUE|FALSE</FullOfData>

      <Id>{string}</Id>

      <LastAccessed>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastAccessed>

      <LastCheckpoint>{string}</LastCheckpoint>

      <LastModified>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastModified>

      <LastVerified>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastVerified>
      <PartiallyVerifiedEndOfTape>

{YYYY-MM-DDThh:mm:ss.xxxZ}

      </PartiallyVerifiedEndOfTape>

      <PartitionId>{string}</PartitionId>
      <PreviousState>

         NORMAL|AUTO_COMPACTION_IN_PROGRESS|BAD|BAR_CODE_MISSING|

         CANNOT_FORMAT_DUE_TO_WRITE_PROTECTION|

         DATA_CHECKPOINT_FAILURE|

         DATA_CHECKPOINT_FAILURE_DUE_TO_READ_ONLY|

         DATA_CHECKPOINT_MISSING|EJECT_FROM_EE_PENDING|

         EJECT_TO_EE_IN_PROGRESS|EJECTED|FOREIGN|

         FORMAT_IN_PROGRESS|FORMAT_PENDING|IMPORT_IN_PROGRESS|

         IMPORT_PENDING|INCOMPATIBLE|LOST|LTFS_WITH_FOREIGN_DATA|

         OFFLINE|ONLINE_IN_PROGRESS|ONLINE_PENDING|

         PENDING_INSPECTION|RAW_IMPORT_IN_PROGRESS|

         RAW_IMPORT_PENDING|SERIAL_NUMBER_MISMATCH|UNKNOWN

      </PreviousState>
      <Role>NORMAL|TEST</Role>

      <SerialNumber>{string}</SerialNumber>
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      <State>

         NORMAL|AUTO_COMPACTION_IN_PROGRESS|BAD|BAR_CODE_MISSING|

         CANNOT_FORMAT_DUE_TO_WRITE_PROTECTION|

         DATA_CHECKPOINT_FAILURE|

         DATA_CHECKPOINT_FAILURE_DUE_TO_READ_ONLY|

         DATA_CHECKPOINT_MISSING|EJECT_FROM_EE_PENDING|

         EJECT_TO_EE_IN_PROGRESS|EJECTED|FOREIGN|

         FORMAT_IN_PROGRESS|FORMAT_PENDING|IMPORT_IN_PROGRESS|

         IMPORT_PENDING|INCOMPATIBLE|LOST|LTFS_WITH_FOREIGN_DATA|

         OFFLINE|ONLINE_IN_PROGRESS|ONLINE_PENDING|

         PENDING_INSPECTION|RAW_IMPORT_IN_PROGRESS|

         RAW_IMPORT_PENDING|SERIAL_NUMBER_MISMATCH|UNKNOWN

      </State>
      <StorageDomainMemberId>{string}</StorageDomainMemberId>

      <TakeOwnershipPending>TRUE|FALSE</TakeOwnershipPending>

      <TotalRawCapacity>{64-bit integer}</TotalRawCapacity>
      <Type>

         LTO5|LTO6|LTO7|LTO8|LTOM8|LTO9|LTO_CLEANING_TAPE|TS_JC|TS_JD

         |TS_JE|TS_JK|TS_JL|TS_JM|TS_JV|TS_JY|TS_JZ|

         TS_CLEANING_TAPE|UNKNOWN|FORBIDDEN

      </Type>
      <VerifyPending>

         CRITICAL|URGENT|HIGH|NORMAL|LOW|BACKGROUND

      </VerifyPending>

      <WriteProtected>TRUE|FALSE</WriteProtected>

   </Tape>

   ...

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

Tape The container for information about a single tape.

AssignedToStorageDomain Whether the tape is currently assigned to a storage domain.
Values: TRUE, FALSE

AvailableRaw
Capacity

The amount of unused raw capacity on the tape in bytes.

BarCode The barcode on the label of the tape cartridge.
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Parameter Description

BucketId The UUID for the bucket to which the tape is assigned.

DescriptionFor
Identification

The LTFS Volume ID and name, if applicable. This is only
provided if the BlackPearl gateway cannot identify the tape.

EjectDate The date and time that the BlackPearl gateway discovered that the
tape was ejected, in the format YYYY-MM-DDThh:mm:ss.xxxZ. If
the parameter is empty, the tape has not been ejected.

EjectLabel The user-entered information to assist in the handling of the tape.

EjectLocation The user-entered information to describe where the ejected tape
can be located.

EjectPending The date and time that the tape was put in the queue to be ejected in
the format YYYY-MM-DDThh:mm:ss.xxxZ. If the parameter is
empty, the tape has not been queued to be ejected or the eject has
started and is no longer cancelable.

FullOfData Whether the tape is completely full of data.
Values: TRUE, FALSE

Id The UUID for the tape.

LastAccessed The last date and time the tape was loaded into a tape drive in the
format YYYY-MM-DDThh:mm:ss.xxxZ.

LastCheckpoint An identifier, internal to the BlackPearl gateway, for verifying the
application integrity of the tape.

LastModified The last date and time the tape was modified in the format YYYY-
MM-DDThh:mm:ss.xxxZ.

LastVerified The last date and time the checksum of the data was verified in
the format YYYY-MM-DDThh:mm:ss.xxxZ.

PartiallyVerified
EndOfTape

The last date and time the BlackPearl gateway verified the data on
a specified percentage of the tape capacity before the EOD marker
in the format
YYYY-MM-DDThh:mm:ss.xxxZ.

PartitionId The UUID for the partition to which to the tape belongs.

PreviousState The previous status of the tape. See State on page 664.

Role The role assigned to the tape. Values: Normal, Test
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Parameter Description

SerialNumber The manufacturer-assigned serial number for the tape cartridge.

State The status of the tape. See State on page 664.

StorageDomain
MemberId

The UUID for the storage domain member.

TakeOwnership Pending Whether a tape from another BlackPearl gateway is waiting for
the current gateway to complete taking ownership.
Values:
• TRUE — The foreign tape was imported when
WriteProtected was TRUE, preventing the tape from being
claimed by the current gateway.

• FALSE — The tape was imported successfully.

TotalRawCapacity The total raw capacity of the tape in bytes.

Type The tape format and generation of the tape cartridge.
Values: LTO5, LTO6, LTO7, LTO8, LTOM8, LTO9, LTO_CLEANING_
TAPE, TS_JC, TS_JD, TS_JE, TS_JK, TS_JL, TS_JM, TS_JV, TS_JY,
TS_JZ, TS_CLEANING_TAPE, UNKNOWN, FORBIDDEN

VerifyPending The priority for the verify requested, or null if a verify has not
been requested. The priority determines the resources assigned
and the processing order.
Values: CRITICAL, URGENT, HIGH, NORMAL, LOW, BACKGROUND

WriteProtected Whether the tape is write protected. Values: TRUE, FALSE

Example

Sample Request
This request retrieves information about all tapes associated with the BlackPearl gateway.
GET http://blackpearl-hostname/_rest_/tape/ HTTP/1.1
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Sample Response
HTTP/1.1 200 OK

<Data>

   <Tape>

      <AssignedToStorageDomain>FALSE</AssignedToStorageDomain>

      <AvailableRawCapacity>12385779712</AvailableRawCapacity>

      <BarCode>018675L6</BarCode>

      <BucketId>0acaac0a-55f9-4d6b-b410-4179d4696f37</BucketId>
      <DescriptionForIdentification/>

      <EjectDate/>

      <EjectLabel/>

      <EjectLocation/>

      <EjectPending/>
      <FullOfData>FALSE</FullOfData>

      <Id>d441e3f3-35d1-4081-aa91-c618b2ed7fc9</Id>

      <LastAccessed>2014-12-16 15:56:36.803</LastAccessed>

      <LastCheckpoint>

         1da169f7-b608-4e6e-93d7-6c0710842da8:25

      </LastCheckpoint>
      <LastModified>2014-12-16 15:56:36.803</LastModified>

      <LastVerified/>

      <PartiallyVerifiedEndOfTape>

         2016-12-08 17:50:22.311

      </PartiallyVerifiedEndOfTape>
      <PartitionId>

         bd91171d-7738-4aea-b319-7abce892a7b1

      </PartitionId>

      <SerialNumber>HP-AE1WRUY90E</SerialNumber>

      <State>NORMAL</State>
      <StorageDomainMemberId/>

      <TakeOwnershipPending>FALSE</TakeOwnershipPending>

      <TotalRawCapacity>2408088338432</TotalRawCapacity>
      <Type>LTO6</Type>

      <VerifyPending/>

      <WriteProtected>FALSE</WriteProtected>

   </Tape>

   ...

</Data>
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IMPORT ALL BLACKPEARL FOREIGN TAPES

Description
Imports all tapes in the library associated with a different BlackPearl gateway. If one or more
buckets being imported does not already exist, the user ID and data policy to use for any new
buckets must be specified. The storage domain to use may optionally be specified. If not
specified, the BlackPearl gateway attempts to automatically determine the most logical
storage domain in which to add the tape.

Notes:

• When importing tapes, it is possible that buckets and objects with the same
name may already exist on the current BlackPearl gateway. If so, the versioning
configured for the data policy is used. See versioning on page 330.

• To import all non-BlackPearl foreign tapes, see Import All LTFS Foreign Tapes
on page 781.

Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/tape/?operation=IMPORT[&data_policy_id=

{string}][&priority=CRITICAL|URGENT|HIGH|NORMAL|LOW|BACKGROUND][&storage_domain_id=

{string}][&user_id={string}][&verify_data_after_

import=CRITICAL|URGENT|HIGH|NORMAL|LOW|BACKGROUND][&verify_data_prior_to_

import=TRUE|FALSE]

Request Parameters

Parameter Description Required

operation The operation to perform. For this request, the operation is import.
Value: IMPORT

yes

data_policy_
id

The UUID, name, or other unique attribute for the data policy to
associate with any buckets on the tape that do not already exist on
the BlackPearl gateway.
Note: If there are new buckets on the tape, the data_policy_id is
required.

no
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Parameter Description Required

priority The priority for processing the import. The priority determines
the resources assigned and the processing order. Imports can be
interrupted every 30 minutes if a job with a higher priority is
received.
Values: URGENT, HIGH, NORMAL, LOW

no

storage_
domain_id

The UUID, name, or other unique attribute for the storage domain
to associate with the data on the tape.
Note: If this parameter is not specified, the BlackPearl gateway
attempts to determine the most logical storage domain in which to
add the tape. If the tape could be imported into multiple storage
domains, the import fails, unless the storage_domain_id is
provided.

no

user_id The UUID, name, or other unique attribute for the user to associate
with any buckets on the tape that do not already exist on the
BlackPearl gateway.
Note: If there are new buckets on the tape, the user_id is required.

no

verify_data_
after_
import

The priority for verifying the data after import. This determines the
resources assigned and the processing order.
Values: URGENT, HIGH, NORMAL, LOW

no

verify_data_
before_
import

Whether the data must be verified before the tape is imported.
Values: TRUE, FALSE
Note: It is recommended to verify data prior to import whenever it
is possible that the tapes being imported contain objects with the
same name as objects already in the bucket. Without verifying data
prior to import, it is possible for the existing object to be replaced
with the one being imported, even if the one being imported is
partially corrupt and cannot be read.

no

Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 207: Multi-Status (with list of errors)
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Example

Sample Request
This request imports all tapes in the library associated with a different BlackPearl gateway.
PUT http://blackpearl-hostname/_rest_/tape/?operation=IMPORT HTTP/1.1

Sample Response
HTTP/1.1 204 No Content

IMPORT ALL LTFS FOREIGN TAPES

Description
Imports all non-BlackPearl LTFS foreign tapes. See Import All BlackPearl Foreign Tapes on
page 779 to import BlackPearl foreign tapes.

Notes:

• No matter the specifics of the data policy associated with the bucket to which
the tape is imported, the BlackPearl gateway does not make additional copies of
the objects on the tape.

• Imported LTFS foreign tapes are made available for GET operations only after
they are imported.

Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/tape/?operation=IMPORT&bucket_id={string}

[&storage_domain_id={string}][&task_priority=URGENT|HIGH|NORMAL|LOW]

Request Parameters

Parameter Description Required

operation The operation to perform. For this request, the operation is import.
Value: IMPORT

yes
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Parameter Description Required

bucket_id The UUID for the bucket to which to assign the tape.
Note: The bucket must have a data policy including a persistence
rule for a tape storage domain.

yes

storage_
domain_id

The UUID for the storage domain into which to import the tape if
the data policy associated with the bucket has persistence rules for
more than one tape storage domain.

no

task_priority The priority for processing this task. The task_priority
determines the resources assigned and the processing order.
Values: URGENT, HIGH, NORMAL, LOW (default)

no

Responses

Response Elements
The operation returns status only. Notable status codes:

• 204: No Content (success)
• 207: Multi-Status (with list of errors)

Example

Sample Request
This request imports all non-BlackPearl LTFS tapes into the bucket named “AdminBucket”.
PUT http://blackpearl-hostname/_rest_/tape/?operation=IMPORT&bucket_id=AdminBucket

HTTP/1.1

Sample Response
HTTP/1.1 204 No Content
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IMPORT BLACKPEARL FOREIGN TAPE

Description
Import the specified tape with data from a different BlackPearl gateway. If one or more
buckets being imported does not already exist, the user ID and data policy to use for any new
buckets must be specified. The storage domain to use may optionally be specified. If not
specified, the BlackPearl gateway attempts to automatically determine the most logical
storage domain in which to add the tape.

Notes:

• When importing tapes, it is possible that buckets and objects with the same
name may already exist on the current BlackPearl gateway. If so, when an object
is imported, it may replace the existing object. If so, the versioning configured
for the data policy is used. See versioning on page 330.

• To import non-BlackPearl foreign tapes, see Import LTFS Foreign Tape on
page 789.

Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/tape/{tape UUID or barcode}/?operation=IMPORT

[&data_policy_id={string}][&priority=CRITICAL|URGENT|HIGH|NORMAL|LOW|BACKGROUND]

[&storage_domain_id={string}][&user_id={string}][&verify_data_after_

import=CRITICAL|URGENT|HIGH|NORMAL|LOW|BACKGROUND][&verify_data_prior_to_

import=TRUE|FALSE]

To determine the UUID for a tape, see Get Tapes on page 770.

Request Parameters

Parameter Description Required

operation The operation to perform. For this request, the operation is import.
Value: IMPORT

yes

data_policy_
id

The UUID, name, or other unique attribute for the data policy to
associate with any buckets on the tape that do not already exist on
the BlackPearl gateway.
Note: If there are new buckets on the tape, the data_policy_id is
required.

no
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Parameter Description Required

priority The priority for processing the import. The priority determines
the resources assigned and the processing order. Imports can be
interrupted every 30 minutes if a job with a higher priority is
received.
Values: URGENT, HIGH, NORMAL, LOW

no

storage_
domain_id

The UUID, name, or other unique attribute for the storage domain
to associate with the data on the tape.
Note: If this parameter is not specified, the BlackPearl gateway
attempts to determine the most logical storage domain in which to
add the tape. If the tape could be imported into multiple storage
domains, the import fails, unless storage_domain_id is
provided.

no

user_id The UUID, name, or other unique attribute for the user to associate
with any buckets on the tape that do not already exist on the
BlackPearl gateway.
Note: If there are new buckets on the tape, the user_id is required.

no

verify_data_
after_
import

The priority for verifying the data after import. This determines the
resources assigned and the processing order.
Values: URGENT, HIGH, NORMAL, LOW

no

verify_data_
before_
import

Whether the data must be verified before the tape is imported.
Values: TRUE, FALSE
Note: It is recommended to verify data prior to import whenever it
is possible that the tapes being imported contain objects with the
same name as objects already in the bucket. Without verifying data
prior to import, it is possible for the existing object to be replaced
with the one being imported, even if the one being imported is
partially corrupt and cannot be read.

no

Responses

Response Elements
<Data>

   <AssignedToStorageDomain>TRUE|FALSE</AssignedToStorageDomain>

   <AvailableRawCapacity>{64-bit integer}</AvailableRawCapacity>

   <BarCode>{string}</BarCode>

   <BucketId>{string}</BucketId>

   <DescriptionForIdentification>

{string}

   </DescriptionForIdentification>
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   <EjectDate>{YYYY-MM-DDThh:mm:ss.xxxZ}</EjectDate>

   <EjectLabel>{string}</EjectLabel>

   <EjectLocation>{string}</EjectLocation>

   <EjectPending>{YYYY-MM-DDThh:mm:ss.xxxZ}</EjectPending>

   <FullOfData>TRUE|FALSE</FullOfData>

   <Id>{string}</Id>

   <LastAccessed>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastAccessed>

   <LastCheckpoint>{string}</LastCheckpoint>

   <LastModified>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastModified>

   <LastVerified>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastVerified>
   <PartiallyVerifiedEndOfTape>

{YYYY-MM-DDThh:mm:ss.xxxZ}

   </PartiallyVerifiedEndOfTape>
   <PartitionId>{string}</PartitionId>
   <PreviousState>

      NORMAL|AUTO_COMPACTION_IN_PROGRESS|BAD|BAR_CODE_MISSING|

      CANNOT_FORMAT_DUE_TO_WRITE_PROTECTION|

      DATA_CHECKPOINT_FAILURE|

      DATA_CHECKPOINT_FAILURE_DUE_TO_READ_ONLY|

      DATA_CHECKPOINT_MISSING|EJECT_FROM_EE_PENDING|

      EJECT_TO_EE_IN_PROGRESS|EJECTED|FOREIGN|FORMAT_IN_PROGRESS|

      FORMAT_PENDING|IMPORT_IN_PROGRESS|IMPORT_PENDING|

      INCOMPATIBLE|LOST|LTFS_WITH_FOREIGN_DATA|OFFLINE|

      ONLINE_IN_PROGRESS|ONLINE_PENDING|PENDING_INSPECTION|

      RAW_IMPORT_IN_PROGRESS|RAW_IMPORT_PENDING|

      SERIAL_NUMBER_MISMATCH|UNKNOWN

   </PreviousState>
   <Role>NORMAL|TEST</Role>

   <SerialNumber>{string}</SerialNumber>
   <State>

      NORMAL|AUTO_COMPACTION_IN_PROGRESS|BAD|BAR_CODE_MISSING|

      CANNOT_FORMAT_DUE_TO_WRITE_PROTECTION|

      DATA_CHECKPOINT_FAILURE|

      DATA_CHECKPOINT_FAILURE_DUE_TO_READ_ONLY|

      DATA_CHECKPOINT_MISSING|EJECT_FROM_EE_PENDING|

      EJECT_TO_EE_IN_PROGRESS|EJECTED|FOREIGN|FORMAT_IN_PROGRESS|

      FORMAT_PENDING|IMPORT_IN_PROGRESS|IMPORT_PENDING|

      INCOMPATIBLE|LOST|LTFS_WITH_FOREIGN_DATA|OFFLINE|

      ONLINE_IN_PROGRESS|ONLINE_PENDING|PENDING_INSPECTION|

      RAW_IMPORT_IN_PROGRESS|RAW_IMPORT_PENDING|

      SERIAL_NUMBER_MISMATCH|UNKNOWN

   </State>

   <StorageDomainMemberId>{string}</StorageDomainMemberId>
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   <TakeOwnershipPending>TRUE|FALSE</TakeOwnershipPending>

   <TotalRawCapacity>{64-bit integer}</TotalRawCapacity>
   <Type>

      LTO5|LTO6|LTO7|LTO8|LTOM8|LTO9|LTO_CLEANING_TAPE|TS_JC|TS_JD|

      TS_JE|TS_JK|TS_JL|TS_JM|TS_JV|TS_JY|TS_JZ|TS_CLEANING_TAPE

      |UNKNOWN|FORBIDDEN

   </Type>
   <VerifyPending>

      CRITICAL|URGENT|HIGH|NORMAL|LOW|BACKGROUND

   </VerifyPending>

   <WriteProtected>TRUE|FALSE</WriteProtected>

</Data>

where the response elements are defined as follows:

Parameter Description

Data A container for the response.

AssignedToStorageDomain Whether the tape is currently assigned to a storage domain.
Values: TRUE, FALSE

AvailableRaw
Capacity

The amount of unused raw capacity on the tape in bytes.

BarCode The barcode on the label of the tape cartridge.

BucketId The UUID for the bucket to which the tape is assigned.

DescriptionFor
Identification

The LTFS Volume ID and name, if applicable. This is only provided
if the BlackPearl gateway cannot identify the tape.

EjectDate The date and time that the BlackPearl gateway discovered that the
tape was ejected, in the format YYYY-MM-DDThh:mm:ss.xxxZ. If
the parameter is empty, the tape has not been ejected.

EjectLabel The user-entered information to assist in the handling of the tape.

EjectLocation The user-entered information to describe where the ejected tape
can be located.

EjectPending The date and time that the tape was put in the queue to be ejected
in the format YYYY-MM-DDThh:mm:ss.xxxZ. If the parameter is
empty, the tape has not been queued to be ejected or the eject has
started and is no longer cancelable.
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Parameter Description

FullOfData Whether the tape is completely full of data.
Values: TRUE, FALSE

Id The UUID for the tape.

LastAccessed The last date and time the tape was loaded into a tape drive in the
format YYYY-MM-DDThh:mm:ss.xxxZ.

LastCheckpoint An identifier, internal to the BlackPearl gateway, for verifying the
application integrity of the tape.

LastModified The last date and time the tape was modified in the format YYYY-
MM-DDThh:mm:ss.xxxZ.

LastVerified The last date and time the checksum of the data was verified in
the format YYYY-MM-DDThh:mm:ss.xxxZ.

PartiallyVerified
EndOfTape

The last date and time the BlackPearl gateway verified the data on
a specified percentage of the tape capacity before the EOD marker
in the format
YYYY-MM-DDThh:mm:ss.xxxZ.

PartitionId The UUID for the partition to which the tape belongs.

PreviousState The previous status of the tape. See State on page 664.

Role The role assigned to the tape. Values: Normal, Test

SerialNumber The manufacturer-assigned serial number for the tape.

State The status of the tape. See State on page 664.

StorageDomain
MemberId

The UUID for the storage domain member.

TakeOwnership Pending Whether a tape from another BlackPearl gateway is waiting for
the current gateway to complete taking ownership.
Values:
• TRUE — The foreign tape was imported when
WriteProtected was TRUE, preventing the tape from being
claimed by the current gateway.

• FALSE — The tape was imported successfully.

TotalRawCapacity The total raw capacity of the tape in bytes.
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Parameter Description

Type The tape format and generation of the tape cartridge.
Values: LTO5, LTO6, LTO7, LTO8, LTOM8, LTO9, LTO_CLEANING_
TAPE, TS_JC, TS_JD, TS_JE, TS_JK, TS_JL, TS_JM, TS_JV, TS_JY,
TS_JZ, TS_CLEANING_TAPE, UNKNOWN, FORBIDDEN

VerifyPending The priority for the verify requested, or null if a verify has not
been requested. The priority determines the resources assigned
and the processing order.
Values: CRITICAL, URGENT, HIGH, NORMAL, LOW, BACKGROUND

WriteProtected Whether the tape is write protected. Values: TRUE, FALSE

Example

Sample Request
This request imports the tape with the UUID 1c3fe1dc-95b7-4152-a286-951d0af2a27e.
PUT http://blackpearl-hostname/_rest_/tape/1c3fe1dc-95b7-4152-a286-

951d0af2a27e/?operation=IMPORT HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>

   <AssignedToStorageDomain>FALSE</AssignedToStorageDomain>

   <AvailableRawCapacity>2408088338432</AvailableRawCapacity>

   <BarCode>018675L6</BarCode>

   <BucketId>0acaac0a-55f9-4d6b-b410-4179d4696f37</BucketId>

   <DescriptionForIdentification/>
   <EjectDate/>

   <EjectLabel/>

   <EjectLocation/>

   <EjectPending/>

   <FullOfData>FALSE</FullOfData>

   <Id>1c3fe1dc-95b7-4152-a286-951d0af2a27e</Id>
   <LastAccessed/>

   <LastCheckpoint/>

   <LastModified/>

   <LastVerified/>

   <PartiallyVerifiedEndOfTape/>

   <PartitionId>bd91171d-7738-4aea-b319-7abce892a7b1</PartitionId>
   <PreviousState/>
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   <Role>NORMAL</Role>

   <SerialNumber>HP-AE1WRUY90E</SerialNumber>

   <State>PENDING_INSPECTION</State>

   <StorageDomainMemberId/>

   <TakeOwnershipPending>FALSE</TakeOwnershipPending>
   <TotalRawCapacity>2408088338432</TotalRawCapacity>

   <Type>LTO6</Type>

   <VerifyPending/>

   <WriteProtected>FALSE</WriteProtected>

</Data>

IMPORT LTFS FOREIGN TAPE

Description
Imports a non-BlackPearl LTFS foreign tape. See Import BlackPearl Foreign Tape on page 783
to import a BlackPearl foreign tape.

Notes:

• No matter the specifics of the data policy associated with the bucket to which
the tape is imported, the BlackPearl gateway does not make additional copies of
the objects on the tape.

• Imported LTFS foreign tapes are made available for GET operations only after
they are imported.

Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/tape/{unique identifier or

attribute}/?operation=IMPORT&bucket_id={string}

[&storage_domain_id={string}]
[&task_priority=URGENT|HIGH|NORMAL|LOW]
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Request Parameters

Parameter Description Required

operation The operation to perform. For this request, the operation is import.
Value: IMPORT

yes

bucket_id The UUID for the bucket to which to assign the tape.
Note: The bucket must have a data policy including a persistence
rule for a tape storage domain.

yes

storage_
domain_id

The UUID for the storage domain into which to import the tape if
the data policy associated with the bucket has persistence rules for
more than one tape storage domain.

no

task_priority The priority for processing this task. The task_priority
determines the resources assigned and the processing order.
Values: URGENT, HIGH, NORMAL, LOW (default)

no

Responses

Response Elements
<Data>

   <AssignedToStorageDomain>TRUE|FALSE</AssignedToStorageDomain>

   <AvailableRawCapacity>{64-bit integer}</AvailableRawCapacity>

   <BarCode>{string}</BarCode>

   <BucketId>{string}</BucketId>

   <DescriptionForIdentification>

{string}

   </DescriptionForIdentification>

   <EjectDate>{YYYY-MM-DDThh:mm:ss.xxxZ}</EjectDate>

   <EjectLabel>{string}</EjectLabel>

   <EjectLocation>{string}</EjectLocation>

   <EjectPending>{YYYY-MM-DDThh:mm:ss.xxxZ}</EjectPending>
   <FullOfData>TRUE|FALSE</FullOfData>

   <Id>{string}</Id>
   <LastAccessed>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastAccessed>

   <LastCheckpoint>{string}</LastCheckpoint>
   <LastModified>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastModified>

   <LastVerified>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastVerified>
   <PartiallyVerifiedEndOfTape>

{YYYY-MM-DDThh:mm:ss.xxxZ}

   </PartiallyVerifiedEndOfTape>

   <PartitionId>{string}</PartitionId>
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   <PreviousState>

      NORMAL|AUTO_COMPACTION_IN_PROGRESS|BAD|BAR_CODE_MISSING|

      CANNOT_FORMAT_DUE_TO_WRITE_PROTECTION|

      DATA_CHECKPOINT_FAILURE|

      DATA_CHECKPOINT_FAILURE_DUE_TO_READ_ONLY|

      DATA_CHECKPOINT_MISSING|EJECT_FROM_EE_PENDING|

      EJECT_TO_EE_IN_PROGRESS|EJECTED|FOREIGN|FORMAT_IN_PROGRESS|

      FORMAT_PENDING|IMPORT_IN_PROGRESS|IMPORT_PENDING|

      INCOMPATIBLE|LOST|LTFS_WITH_FOREIGN_DATA|OFFLINE|

      ONLINE_IN_PROGRESS|ONLINE_PENDING|PENDING_INSPECTION|

      RAW_IMPORT_IN_PROGRESS|RAW_IMPORT_PENDING|

      SERIAL_NUMBER_MISMATCH|UNKNOWN

   </PreviousState>
   <Role>NORMAL|TEST</Role>
   <SerialNumber>{string}</SerialNumber>
   <State>

      NORMAL|AUTO_COMPACTION_IN_PROGRESS|BAD|BAR_CODE_MISSING|

      CANNOT_FORMAT_DUE_TO_WRITE_PROTECTION|

      DATA_CHECKPOINT_FAILURE|

      DATA_CHECKPOINT_FAILURE_DUE_TO_READ_ONLY|

      DATA_CHECKPOINT_MISSING|EJECT_FROM_EE_PENDING|

      EJECT_TO_EE_IN_PROGRESS|EJECTED|FOREIGN|FORMAT_IN_PROGRESS|

      FORMAT_PENDING|IMPORT_IN_PROGRESS|IMPORT_PENDING|

      INCOMPATIBLE|LOST|LTFS_WITH_FOREIGN_DATA|OFFLINE|

      ONLINE_IN_PROGRESS|ONLINE_PENDING|PENDING_INSPECTION|

      RAW_IMPORT_IN_PROGRESS|RAW_IMPORT_PENDING|

      SERIAL_NUMBER_MISMATCH|UNKNOWN

   </State>

   <StorageDomainMemberId>{string}</StorageDomainMemberId>

   <TakeOwnershipPending>TRUE|FALSE</TakeOwnershipPending>

   <TotalRawCapacity>{64-bit integer}</TotalRawCapacity>
   <Type>

      LTO5|LTO6|LTO7|LTO8|LTOM8|LTO9|LTO_CLEANING_TAPE|TS_JC|TS_JD|

      TS_JE|TS_JK|TS_JL|TS_JM|TS_JV|TS_JY|TS_JZ|TS_CLEANING_TAPE

      |UNKNOWN|FORBIDDEN

   </Type>

   <VerifyPending>

      CRITICAL|URGENT|HIGH|NORMAL|LOW|BACKGROUND

   </VerifyPending>

   <WriteProtected>TRUE|FALSE</WriteProtected>

</Data>

April 2023 DS3 API Reference-Spectra BlackPearl Nearline Gateway
- 791 -



Chapter 16 - Tape Library and Component Operations Import LTFS Foreign Tape

where the response elements are defined as follows:

Parameter Description

Data A container for the response.

AssignedToStorageDomain Whether the tape is currently assigned to a storage domain.
Values: TRUE, FALSE

AvailableRaw
Capacity

The amount of unused raw capacity on the tape in bytes.

BarCode The barcode on the label of the tape cartridge.

BucketId The UUID for the bucket to which the tape is assigned.

DescriptionFor
Identification

The LTFS Volume ID and name, if applicable. This is only provided
if the BlackPearl gateway cannot identify the tape.

EjectDate The date and time that the BlackPearl gateway discovered that the
tape was ejected, in the format YYYY-MM-DDThh:mm:ss.xxxZ. If
the parameter is empty, the tape has not been ejected.

EjectLabel The user-entered information to assist in the handling of the tape.

EjectLocation The user-entered information to describe where the ejected tape
can be located.

EjectPending The date and time that the tape was put in the queue to be ejected
in the format YYYY-MM-DDThh:mm:ss.xxxZ. If the parameter is
empty, the tape has not been queued to be ejected or the eject has
started and is no longer cancelable.

FullOfData Whether the tape is completely full of data.
Values: TRUE, FALSE

Id The UUID for the tape.

LastAccessed The last date and time the tape was loaded into a tape drive in the
format YYYY-MM-DDThh:mm:ss.xxxZ.

LastCheckpoint An identifier, internal to the BlackPearl gateway, for verifying the
application integrity of the tape.

LastModified The last date and time the tape was modified in the format YYYY-
MM-DDThh:mm:ss.xxxZ.

LastVerified The last date and time the checksum of the data was verified in
the format YYYY-MM-DDThh:mm:ss.xxxZ.
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Parameter Description

PartiallyVerified
EndOfTape

The last date and time the BlackPearl gateway verified the data on
a specified percentage of the tape capacity before the EOD marker
in the format
YYYY-MM-DDThh:mm:ss.xxxZ.

PartitionId The UUID for the partition to which the tape belongs.

PreviousState The previous status of the tape. See State on page 664.

Role The role assigned to the tape. Values: Normal, Test

SerialNumber The manufacturer-assigned serial number for the tape.

State The status of the tape. See State on page 664.

StorageDomain
MemberId

The UUID for the storage domain member.

TakeOwnership Pending Whether a foreign LTFS tape is waiting for ownership by the
current gateway to be completed.
Values:
• TRUE — The foreign tape was imported when
WriteProtected was TRUE, preventing the tape from being
claimed by the current gateway.

• FALSE — The tape was imported successfully.

TotalRawCapacity The total raw capacity of the tape in bytes.

Type The tape format and generation of the tape cartridge.
Values: LTO5, LTO6, LTO7, LTO8, LTOM8, LTO9, LTO_CLEANING_
TAPE, TS_JC, TS_JD, TS_JE, TS_JK, TS_JL, TS_JM, TS_JV, TS_JY,
TS_JZ, TS_CLEANING_TAPE, UNKNOWN, FORBIDDEN

VerifyPending The priority for the verify requested, or null if a verify has not
been requested. The priority determines the resources assigned
and the processing order.
Values: CRITICAL, URGENT, HIGH, NORMAL, LOW, BACKGROUND

WriteProtected Whether the tape is write protected. Values: TRUE, FALSE
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Example

Sample Request
This request imports a non-BlackPearl LTFS tape with the UUID “da8c72d7-d4c9-4cc5-94b9-
34ddeb01f5b9” into the bucket named “AdminBucket”.
PUT http://blackpearl-hostname/_rest_/tape/da8c72d7-d4c9-4cc5-94b9-

34ddeb01f5b9/?operation=IMPORT&bucket_id=AdminBucket HTTP/1.1

Sample Response
HTTP/1.1 200 OK
<Data>
   <AssignedToStorageDomain>FALSE</AssignedToStorageDomain>
   <AvailableRawCapacity>10000</AvailableRawCapacity>
   <BarCode>13b41f41-84e6-49cd-963d-afadb386d7ca</BarCode>
   <BucketId>AdminBucket</BucketId>
   <DescriptionForIdentification/>
   <EjectDate/>
   <EjectLabel/>
   <EjectLocation/>
   <EjectPending/>
   <FullOfData>FALSE</FullOfData>
   <Id>da8c72d7-d4c9-4cc5-94b9-34ddeb01f5b9</Id>
   <LastAccessed/>
   <LastCheckpoint/>
   <LastModified/>
   <LastVerified/>
   <PartiallyVerifiedEndOfTape/>
   <PartitionId>215629d1-f76c-4dbe-a342-d7c726eaf675</PartitionId>
   <PreviousState/>
   <Role>NORMAL</Role>
   <SerialNumber/>
   <State>PENDING_INSPECTION</State>
   <StorageDomainMemberId/>
   <TakeOwnershipPending>FALSE</TakeOwnershipPending>
   <TotalRawCapacity>20000</TotalRawCapacity>
   <Type>LTO5</Type>
   <VerifyPending/>
   <WriteProtected>FALSE</WriteProtected>
</Data>
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INSPECT TAPE

Description
Add the specified tape to the inspection queue if it is not already in the queue.

Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/tape/{tape UUID or

barcode}/?operation=INSPECT[task_priority=URGENT|HIGH|NORMAL|LOW]

To determine the UUID for a tape, see Get Tapes on page 770.

Request Parameters

Parameter Description Required

operation The operation to perform. For this request, the operation is inspect.
Value: INSPECT

yes

task_priority The priority for processing this task. The task_priority
determines the resources assigned and the processing order.
Values: URGENT, HIGH, NORMAL, LOW

no
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Responses

Response Elements
<Data>

   <AssignedToStorageDomain>TRUE|FALSE</AssignedToStorageDomain>

   <AvailableRawCapacity>{64-bit integer}</AvailableRawCapacity>

   <BarCode>{string}</BarCode>

   <BucketId>{string}</BucketId>

   <DescriptionForIdentification>

{string}

   </DescriptionForIdentification>

   <EjectDate>{YYYY-MM-DDThh:mm:ss.xxxZ}</EjectDate>

   <EjectLabel>{string}</EjectLabel>

   <EjectLocation>{string}</EjectLocation>

   <EjectPending>{YYYY-MM-DDThh:mm:ss.xxxZ}</EjectPending>

   <FullOfData>TRUE|FALSE</FullOfData>
   <Id>{string}</Id>

   <LastAccessed>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastAccessed>

   <LastCheckpoint>{string}</LastCheckpoint>

   <LastModified>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastModified>

   <LastVerified>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastVerified>
   <PartiallyVerifiedEndOfTape>

{YYYY-MM-DDThh:mm:ss.xxxZ}

   </PartiallyVerifiedEndOfTape>
   <PartitionId>{string}</PartitionId>

   <PreviousState>

      NORMAL|AUTO_COMPACTION_IN_PROGRESS|BAD|BAR_CODE_MISSING|

      CANNOT_FORMAT_DUE_TO_WRITE_PROTECTION|

      DATA_CHECKPOINT_FAILURE|

      DATA_CHECKPOINT_FAILURE_DUE_TO_READ_ONLY|

      DATA_CHECKPOINT_MISSING|EJECT_FROM_EE_PENDING|

      EJECT_TO_EE_IN_PROGRESS|EJECTED|FOREIGN|FORMAT_IN_PROGRESS|

      FORMAT_PENDING|IMPORT_IN_PROGRESS|IMPORT_PENDING|

      INCOMPATIBLE|LOST|LTFS_WITH_FOREIGN_DATA|OFFLINE|

      ONLINE_IN_PROGRESS|ONLINE_PENDING|PENDING_INSPECTION|

      RAW_IMPORT_IN_PROGRESS|RAW_IMPORT_PENDING|

      SERIAL_NUMBER_MISMATCH|UNKNOWN

   </PreviousState>
   <Role>NORMAL|TEST</Role>
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   <SerialNumber>{string}</SerialNumber>

   <State>

      NORMAL|AUTO_COMPACTION_IN_PROGRESS|BAD|BAR_CODE_MISSING|

      CANNOT_FORMAT_DUE_TO_WRITE_PROTECTION|

      DATA_CHECKPOINT_FAILURE|

      DATA_CHECKPOINT_FAILURE_DUE_TO_READ_ONLY|

      DATA_CHECKPOINT_MISSING|EJECT_FROM_EE_PENDING|

      EJECT_TO_EE_IN_PROGRESS|EJECTED|FOREIGN|FORMAT_IN_PROGRESS|

      FORMAT_PENDING|IMPORT_IN_PROGRESS|IMPORT_PENDING|

      INCOMPATIBLE|LOST|LTFS_WITH_FOREIGN_DATA|OFFLINE|

      ONLINE_IN_PROGRESS|ONLINE_PENDING|PENDING_INSPECTION|

      RAW_IMPORT_IN_PROGRESS|RAW_IMPORT_PENDING|

      SERIAL_NUMBER_MISMATCH|UNKNOWN

   </State>
   <StorageDomainMemberId>{string}</StorageDomainMemberId>

   <TakeOwnershipPending>TRUE|FALSE</TakeOwnershipPending>

   <TotalRawCapacity>{64-bit integer}</TotalRawCapacity>

   <Type>

      LTO5|LTO6|LTO7|LTO8|LTOM8|LTO9|LTO_CLEANING_TAPE|TS_JC|TS_JD|

      TS_JE|TS_JK|TS_JL|TS_JM|TS_JV|TS_JY|TS_JZ|TS_CLEANING_TAPE

      |UNKNOWN|FORBIDDEN

   </Type>
   <VerifyPending>

      CRITICAL|URGENT|HIGH|NORMAL|LOW|BACKGROUND

   </VerifyPending>

   <WriteProtected>TRUE|FALSE</WriteProtected>

</Data>

where the response elements are defined as follows:

Parameter Description

Data A container for the response.

AssignedToStorageDomain Whether the tape is currently assigned to a storage domain.
Values: TRUE, FALSE

AvailableRaw
Capacity

The amount of unused raw capacity on the tape in bytes.

BarCode The barcode on the label of the tape cartridge.

BucketId The UUID for the bucket to which the tape is assigned.
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Parameter Description

DescriptionFor
Identification

The LTFS Volume ID and name, if applicable. This is only provided
if the BlackPearl gateway cannot identify the tape.

EjectDate The date and time that the BlackPearl gateway discovered that the
tape was ejected, in the format YYYY-MM-DDThh:mm:ss.xxxZ. If
the parameter is empty, the tape has not been ejected.

EjectLabel The user-entered information to assist in the handling of the tape.

EjectLocation The user-entered information to describe where the ejected tape
can be located.

EjectPending The date and time that the tape was put in the queue to be ejected
in the format YYYY-MM-DDThh:mm:ss.xxxZ. If the parameter is
empty, the tape has not been queued to be ejected or the eject has
started and is no longer cancelable.

FullOfData Whether the tape is completely full of data.
Values: TRUE, FALSE

Id The UUID for the tape.

LastAccessed The last date and time the tape was loaded into a tape drive in the
format YYYY-MM-DDThh:mm:ss.xxxZ.

LastCheckpoint An identifier, internal to the BlackPearl gateway, for verifying the
application integrity of the tape.

LastModified The last date and time the tape was modified in the format YYYY-
MM-DDThh:mm:ss.xxxZ.

LastVerified The last date and time the checksum of the data was verified in
the format YYYY-MM-DDThh:mm:ss.xxxZ.

PartiallyVerified
EndOfTape

The last date and time the BlackPearl gateway verified the data on
a specified percentage of the tape capacity before the EOD marker
in the format
YYYY-MM-DDThh:mm:ss.xxxZ.

PartitionId The UUID for the partition to which the tape belongs.

PreviousState The previous status of the tape. See State on page 664.

Role The role assigned to the tape. Values: Normal, Test

SerialNumber The manufacturer-assigned serial number for the tape.
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Parameter Description

State The status of the tape. See State on page 664.

StorageDomain
MemberId

The UUID for the storage domain member.

TakeOwnership Pending Whether a tape from another BlackPearl gateway is waiting for
the current gateway to complete taking ownership.
Values:
• TRUE — The foreign tape was imported when
WriteProtected was TRUE, preventing the tape from being
claimed by the current gateway.

• FALSE — The tape was imported successfully.

TotalRawCapacity The total raw capacity of the tape in bytes.

Type The tape format and generation of the tape cartridge.
Values: LTO5, LTO6, LTO7, LTO8, LTOM8, LTO9, LTO_CLEANING_
TAPE, TS_JC, TS_JD, TS_JE, TS_JK, TS_JL, TS_JM, TS_JV, TS_JY,
TS_JZ, TS_CLEANING_TAPE, UNKNOWN, FORBIDDEN

VerifyPending The priority for the verify requested, or null if a verify has not
been requested. The priority determines the resources assigned
and the processing order.
Values: CRITICAL, URGENT, HIGH, NORMAL, LOW, BACKGROUND

WriteProtected Whether the tape is write protected. Values: TRUE, FALSE

Example

Sample Request
This request queues the tape with the UUID 1c3fe1dc-95b7-4152-a286-951d0af2a27e to be
inspected.
PUT http://blackpearl-hostname/_rest_/tape/1c3fe1dc-95b7-4152-a286-

951d0af2a27e/?operation=INSPECT HTTP/1.1
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Sample Response
HTTP/1.1 200 OK

<Data>

   <AssignedToStorageDomain>FALSE</AssignedToStorageDomain>

   <AvailableRawCapacity>2408088338432</AvailableRawCapacity>

   <BarCode>018675L6</BarCode>

   <BucketId>0acaac0a-55f9-4d6b-b410-4179d4696f37</BucketId>

   <DescriptionForIdentification/>
   <EjectDate/>

   <EjectLabel/>

   <EjectLocation/>

   <EjectPending/>

   <FullOfData>FALSE</FullOfData>

   <Id>1c3fe1dc-95b7-4152-a286-951d0af2a27e</Id>
   <LastAccessed/>

   <LastCheckpoint/>

   <LastModified/>

   <LastVerified/>

   <PartiallyVerifiedEndOfTape/>

   <PartitionId>bd91171d-7738-4aea-b319-7abce892a7b1</PartitionId>
   <PreviousState/>
   <Role>NORMAL|TEST</Role>

   <SerialNumber>HP-AE1WRUY90E</SerialNumber>

   <State>PENDING_INSPECTION</State>

   <StorageDomainMemberId/>

   <TakeOwnershipPending>FALSE</TakeOwnershipPending>
   <TotalRawCapacity>2408088338432</TotalRawCapacity>

   <Type>LTO6</Type>

   <VerifyPending/>

   <WriteProtected>FALSE</WriteProtected>

</Data>

INSPECT TAPES

Description
Add all tapes that have not already been inspected or are not already in the queue to be
inspected, to the inspection queue.
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Requests
Syntax
PUT http[s]://{datapathDNSname}/_rest_/tape/?operation=INSPECT[&task_

priority=URGENT|HIGH|NORMAL|LOW]

Request Parameters

Parameter Description Required

operation The operation to perform. For this request, the operation is inspect.
Value: INSPECT

yes

task_priority The priority for processing this task. The task_priority
determines the resources assigned and the processing order.
Values: URGENT, HIGH, NORMAL, LOW (default)

no

Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 207: Multi-Status (with list of errors)

Example
Sample Request
This request queues all tapes that have not previously been inspected to be inspected.
PUT http://blackpearl-hostname/_rest_/tape/?operation=INSPECT HTTP/1.1

Sample Response
HTTP/1.1 204 No Content
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MARK TAPE FOR COMPACTION

Description
Marks the tape for compaction and includes it in the next compaction cycle. The data on the
tape is moved to other tape(s) in its storage domain. Once the compaction job completes, the
tape is available for reuse or decommissioning.

Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/tape/{tape UUID or barcode}/?operation=MARK_

FOR_COMPACTION

To determine the UUID for a tape, see Get Tapes on page 770.

Request Parameters

Parameter Description Required

operation The operation to perform. For this request, the operation is to mark
for compaction. Value: MARK_FOR_COMPACTION

yes

Responses

Response Elements
<Data>

   <AssignedToStorageDomain>TRUE|FALSE</AssignedToStorageDomain>

   <AvailableRawCapacity>{64-bit integer}</AvailableRawCapacity>

   <BarCode>{string}</BarCode>

   <BucketId>{string}</BucketId>
   <DescriptionForIdentification>

{string}

   </DescriptionForIdentification>
   <EjectDate>{YYYY-MM-DDThh:mm:ss.xxxZ}</EjectDate>

   <EjectLabel>{string}</EjectLabel>

   <EjectLocation>{string}</EjectLocation>

   <EjectPending>{YYYY-MM-DDThh:mm:ss.xxxZ}</EjectPending>
   <FullOfData>TRUE|FALSE</FullOfData>
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   <Id>{string}</Id>
   <LastAccessed>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastAccessed>

   <LastCheckpoint>{string}</LastCheckpoint>
   <LastModified>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastModified>

   <LastVerified>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastVerified>
   <PartiallyVerifiedEndOfTape>

{YYYY-MM-DDThh:mm:ss.xxxZ}

   </PartiallyVerifiedEndOfTape>

   <PartitionId>{string}</PartitionId>
   <PreviousState>

      NORMAL|AUTO_COMPACTION_IN_PROGRESS|BAD|BAR_CODE_MISSING|

      CANNOT_FORMAT_DUE_TO_WRITE_PROTECTION|

      DATA_CHECKPOINT_FAILURE|

      DATA_CHECKPOINT_FAILURE_DUE_TO_READ_ONLY|

      DATA_CHECKPOINT_MISSING|EJECT_FROM_EE_PENDING|

      EJECT_TO_EE_IN_PROGRESS|EJECTED|FOREIGN|FORMAT_IN_PROGRESS|

      FORMAT_PENDING|IMPORT_IN_PROGRESS|IMPORT_PENDING|

      INCOMPATIBLE|LOST|LTFS_WITH_FOREIGN_DATA|OFFLINE|

      ONLINE_IN_PROGRESS|ONLINE_PENDING|PENDING_INSPECTION|

      RAW_IMPORT_IN_PROGRESS|RAW_IMPORT_PENDING|

      SERIAL_NUMBER_MISMATCH|UNKNOWN

   </PreviousState>
   <Role>NORMAL|TEST</Role>
   <SerialNumber>{string}</SerialNumber>

   <State>

      NORMAL|AUTO_COMPACTION_IN_PROGRESS|BAD|BAR_CODE_MISSING|

      CANNOT_FORMAT_DUE_TO_WRITE_PROTECTION|

      DATA_CHECKPOINT_FAILURE|

      DATA_CHECKPOINT_FAILURE_DUE_TO_READ_ONLY|

      DATA_CHECKPOINT_MISSING|EJECT_FROM_EE_PENDING|

      EJECT_TO_EE_IN_PROGRESS|EJECTED|FOREIGN|FORMAT_IN_PROGRESS|

      FORMAT_PENDING|IMPORT_IN_PROGRESS|IMPORT_PENDING|

      INCOMPATIBLE|LOST|LTFS_WITH_FOREIGN_DATA|OFFLINE|

      ONLINE_IN_PROGRESS|ONLINE_PENDING|PENDING_INSPECTION|

      RAW_IMPORT_IN_PROGRESS|RAW_IMPORT_PENDING|

      SERIAL_NUMBER_MISMATCH|UNKNOWN

   </State>
   <StorageDomainMemberId>{string}</StorageDomainMemberId>

   <TakeOwnershipPending>TRUE|FALSE</TakeOwnershipPending>

   <TotalRawCapacity>{64-bit integer}</TotalRawCapacity>

   <Type>

      LTO5|LTO6|LTO7|LTO8|LTOM8|LTO9|LTO_CLEANING_TAPE|TS_JC|TS_JD|

      TS_JE|TS_JK|TS_JL|TS_JM|TS_JV|TS_JY|TS_JZ|TS_CLEANING_TAPE

      |UNKNOWN|FORBIDDEN

   </Type>
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   <VerifyPending>

      CRITICAL|URGENT|HIGH|NORMAL|LOW|BACKGROUND

   </VerifyPending>

   <WriteProtected>TRUE|FALSE</WriteProtected>

</Data>

where the response elements are defined as follows:

Parameter Description

Data A container for the response.

AssignedToStorageDomain Whether the tape is currently assigned to a storage domain.
Values: TRUE, FALSE

AvailableRaw
Capacity

The amount of unused raw capacity on the tape in bytes.

BarCode The barcode on the label of the tape cartridge.

BucketId The UUID for the bucket to which the tape is assigned.

DescriptionFor
Identification

The LTFS Volume ID and name, if applicable. This is only
provided if the BlackPearl gateway cannot identify the tape.

EjectDate The date and time that the BlackPearl gateway discovered that the
tape was ejected, in the format YYYY-MM-DDThh:mm:ss.xxxZ. If
the parameter is empty, the tape has not been ejected.

EjectLabel The user-entered information to assist in the handling of the tape.

EjectLocation The user-entered information to describe where the ejected tape is
located.

EjectPending The date and time that the tape was put in the queue to be ejected
in the format YYYY-MM-DDThh:mm:ss.xxxZ. If the parameter is
empty, the tape has not been queued to be ejected or the eject has
started and is no longer cancelable.

FullOfData Whether the tape is completely full of data.
Values: TRUE, FALSE

Id The UUID for the tape.

LastAccessed The last date and time the tape was loaded into a tape drive in the
format YYYY-MM-DDThh:mm:ss.xxxZ.
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Parameter Description

LastCheckpoint An identifier, internal to the BlackPearl gateway, for verifying the
application integrity of the tape.

LastModified The last date and time the tape was modified in the format YYYY-
MM-DDThh:mm:ss.xxxZ.

LastVerified The last date and time the checksum of the data was verified in
the format YYYY-MM-DDThh:mm:ss.xxxZ.

PartiallyVerified
EndOfTape

The last date and time the BlackPearl gateway verified the data on
a specified percentage of the tape capacity before the EOD marker
in the format
YYYY-MM-DDThh:mm:ss.xxxZ.

PartitionId The UUID for the partition to which the tape belongs.

PreviousState The previous status of the tape. See State on page 664.

Role The role assigned to the tape. Values: Normal, Test

SerialNumber The manufacturer-assigned serial number for the tape.

State The status of the tape. See State on page 664.

StorageDomain
MemberId

The UUID for the storage domain member.

TakeOwnershipPending Whether a tape from another BlackPearl gateway is waiting for
the current gateway to complete taking ownership.
Values:
• TRUE — The foreign tape was imported when
WriteProtected was TRUE, preventing the tape from being
claimed by the current gateway.

• FALSE — The tape was imported successfully.

TotalRawCapacity The total raw capacity of the tape in bytes.

Type The tape format and generation of the tape cartridge.
Values: LTO5, LTO6, LTO7, LTO8, LTOM8, LTO9, LTO_CLEANING_
TAPE, TS_JC, TS_JD, TS_JE, TS_JK, TS_JL, TS_JM, TS_JV, TS_JY,
TS_JZ, TS_CLEANING_TAPE, UNKNOWN, FORBIDDEN
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Parameter Description

VerifyPending The priority for the verify requested, or null if a verify has not
been requested. The priority determines the resources assigned
and the processing order.
Values: CRITICAL, URGENT, HIGH, NORMAL, LOW, BACKGROUND

WriteProtected Whether the tape is write protected. Values: TRUE, FALSE

Example

Sample Request
This marks the tape with the UUID 2ba9f40b-1781-4fd5-b650-5ed66903ad2f for compaction.
PUT http://blackpearl-hostname/_rest_/tape/2ba9f40b-1781-4fd5-b650-

5ed66903ad2f/?operation=MARK_FOR_COMPACTION HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>

   <AssignedToStorageDomain>FALSE</AssignedToStorageDomain>

   <AvailableRawCapacity>10000</AvailableRawCapacity>

   <BarCode>018975L5</BarCode>

   <BucketId/>

   <DescriptionForIdentification/>
   <EjectDate/>

   <EjectLabel/>

   <EjectLocation/>

   <EjectPending/>

   <FullOfData>FALSE</FullOfData>
   <Id>2ba9f40b-1781-4fd5-b650-5ed66903ad2f</Id>

   <LastAccessed/>

   <LastCheckpoint/>

   <LastModified/>

   <LastVerified/>

   <PartiallyVerifiedEndOfTape/>
   <PartitionId>2789db6e-3c81-4e86-aec6-600b4c83e452</PartitionId>

   <PreviousState/>
   <Role>NORMAL</Role>

   <SerialNumber/>

   <State>PENDING_INSPECTION</State>

   <StorageDomainMemberId/>
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   <TakeOwnershipPending>FALSE</TakeOwnershipPending>

   <TotalRawCapacity>1425000103936</TotalRawCapacity>

   <Type>LTO5</Type>

   <VerifyPending/>

   <WriteProtected>FALSE</WriteProtected>

</Data>

MODIFY TAPE

Description
Modify the eject label, eject location, or state of the specified tape.

Note: If an optional request parameter is not included, the previous setting is retained.

Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/tape/{tape UUID or barcode}/[?eject_label=

{string}][&eject_location={string}][&role=NORMAL|TEST][&state=NORMAL|BAD|BAR_CODE_

MISSING|DATA_CHECKPOINT_MISSING|

EJECT_FROM_EE_PENDING|EJECT_TO_EE_IN_PROGRESS|EJECTED|FOREIGN|FORMAT_IN_

PROGRESS|FORMAT_PENDING|IMPORT_IN_PROGRESS|INCOMPATIBLE|PENDING_

INSPECTION|LOST|LTFS_WITH_FOREIGN_DATA|OFFLINE|ONLINE_IN_PROGRESS|ONLINE_

PENDING|SERIAL_NUMBER_MISMATCH|UNKNOWN]

To determine the UUID for a tape, see Get Tapes on page 770.

Request Parameters

Parameter Description Required

eject_label Enter information to assist in the handling of the tape. no

eject_location Enter information to describe where the ejected tape can be located. no

role The assigned role of the tape. Values: NORMAL, TEST no

state The status of the tape. See State on page 664. no
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Responses

Response Elements
<Data>

   <AssignedToStorageDomain>TRUE|FALSE</AssignedToStorageDomain>

   <AvailableRawCapacity>{64-bit integer}</AvailableRawCapacity>

   <BarCode>{string}</BarCode>

   <BucketId>{string}</BucketId>

   <DescriptionForIdentification>

{string}

   </DescriptionForIdentification>
   <EjectDate>{YYYY-MM-DDThh:mm:ss.xxxZ}</EjectDate>

   <EjectLabel>{string}</EjectLabel>
   <EjectLocation>{string}</EjectLocation>

   <EjectPending>{YYYY-MM-DDThh:mm:ss.xxxZ}</EjectPending>

   <FullOfData>TRUE|FALSE</FullOfData>

   <Id>{string}</Id>

   <LastAccessed>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastAccessed>

   <LastCheckpoint>{string}</LastCheckpoint>

   <LastModified>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastModified>

   <LastVerified>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastVerified>
   <PartiallyVerifiedEndOfTape>

{YYYY-MM-DDThh:mm:ss.xxxZ}

   </PartiallyVerifiedEndOfTape>

   <PartitionId>{string}</PartitionId>
   <PreviousState>

      NORMAL|AUTO_COMPACTION_IN_PROGRESS|BAD|BAR_CODE_MISSING|

      CANNOT_FORMAT_DUE_TO_WRITE_PROTECTION|

      DATA_CHECKPOINT_FAILURE|

      DATA_CHECKPOINT_FAILURE_DUE_TO_READ_ONLY|

      DATA_CHECKPOINT_MISSING|EJECT_FROM_EE_PENDING|

      EJECT_TO_EE_IN_PROGRESS|EJECTED|FOREIGN|FORMAT_IN_PROGRESS|

      FORMAT_PENDING|IMPORT_IN_PROGRESS|IMPORT_PENDING|

      INCOMPATIBLE|LOST|LTFS_WITH_FOREIGN_DATA|OFFLINE|

      ONLINE_IN_PROGRESS|ONLINE_PENDING|PENDING_INSPECTION|

      RAW_IMPORT_IN_PROGRESS|RAW_IMPORT_PENDING|

      SERIAL_NUMBER_MISMATCH|UNKNOWN

   </PreviousState>
   <Role>NORMAL|TEST</Role>
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   <SerialNumber>{string}</SerialNumber>

   <State>

      NORMAL|AUTO_COMPACTION_IN_PROGRESS|BAD|BAR_CODE_MISSING|

      CANNOT_FORMAT_DUE_TO_WRITE_PROTECTION|

      DATA_CHECKPOINT_FAILURE|

      DATA_CHECKPOINT_FAILURE_DUE_TO_READ_ONLY|

      DATA_CHECKPOINT_MISSING|EJECT_FROM_EE_PENDING|

      EJECT_TO_EE_IN_PROGRESS|EJECTED|FOREIGN|FORMAT_IN_PROGRESS|

      FORMAT_PENDING|IMPORT_IN_PROGRESS|IMPORT_PENDING|

      INCOMPATIBLE|LOST|LTFS_WITH_FOREIGN_DATA|OFFLINE|

      ONLINE_IN_PROGRESS|ONLINE_PENDING|PENDING_INSPECTION|

      RAW_IMPORT_IN_PROGRESS|RAW_IMPORT_PENDING|

      SERIAL_NUMBER_MISMATCH|UNKNOWN

   </State>
   <StorageDomainMemberId>{string}</StorageDomainMemberId>

   <TakeOwnershipPending>TRUE|FALSE</TakeOwnershipPending>

   <TotalRawCapacity>{64-bit integer}</TotalRawCapacity>

   <Type>

      LTO5|LTO6|LTO7|LTO8|LTOM8|LTO9|LTO_CLEANING_TAPE|TS_JC|TS_JD|

      TS_JE|TS_JK|TS_JL|TS_JM|TS_JV|TS_JY|TS_JZ|TS_CLEANING_TAPE

      |UNKNOWN|FORBIDDEN

   </Type>
   <VerifyPending>

      CRITICAL|URGENT|HIGH|NORMAL|LOW|BACKGROUND

   </VerifyPending>

   <WriteProtected>TRUE|FALSE</WriteProtected>

</Data>

where the response elements are defined as follows:

Parameter Description

Data A container for the response.

AssignedToStorageDomain Whether the tape is currently assigned to a storage domain.
Values: TRUE, FALSE

AvailableRaw
Capacity

The amount of unused raw capacity on the tape in bytes.

BarCode The barcode on the label of the tape cartridge.

BucketId The UUID for the bucket to which the tape is assigned.
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Parameter Description

DescriptionFor
Identification

The LTFS Volume ID and name, if applicable. This is only provided
if the BlackPearl gateway cannot identify the tape.

EjectDate The date and time that the BlackPearl gateway discovered that the
tape was ejected, in the format YYYY-MM-DDThh:mm:ss.xxxZ. If
the parameter is empty, the tape has not been ejected.

EjectLabel The user-entered information to assist in the handling of the tape.

EjectLocation The user-entered information to describe where the ejected tape
can be located.

EjectPending The date and time that the tape was put in the queue to be ejected
in the format YYYY-MM-DDThh:mm:ss.xxxZ. If the parameter is
empty, the tape has not been queued to be ejected or the eject has
started and is no longer cancelable.

FullOfData Whether the tape is completely full of data.
Values: TRUE, FALSE

Id The UUID for the tape.

LastAccessed The last date and time the tape was loaded into a tape drive in the
format YYYY-MM-DDThh:mm:ss.xxxZ.

LastCheckpoint An identifier, internal to the BlackPearl gateway, for verifying the
application integrity of the tape.

LastModified The last date and time the tape was modified in the format YYYY-
MM-DDThh:mm:ss.xxxZ.

LastVerified The last date and time the checksum of the data was verified in
the format YYYY-MM-DDThh:mm:ss.xxxZ.

PartiallyVerified
EndOfTape

The last date and time the BlackPearl gateway verified the data on
a specified percentage of the tape capacity before the EOD marker
in the format
YYYY-MM-DDThh:mm:ss.xxxZ.

PartitionId The UUID for the partition to which the tape belongs.

PreviousState The previous status of the tape. See State on page 664.
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Parameter Description

Role The role of the tape cartridge. Values:
• NORMAL — The tape cartridge is assigned for normal system
use.

• TEST — The tape cartridge is assigned for use in drive testing.

SerialNumber The manufacturer-assigned serial number for the tape.

State The status of the tape. See State on page 664.

StorageDomain
MemberId

The UUID for the storage domain member.

TakeOwnership Pending Whether a tape from another BlackPearl gateway is waiting for
the current gateway to complete taking ownership.
Values:
• TRUE — The foreign tape was imported when
WriteProtected was TRUE, preventing the tape from being
claimed by the current gateway.

• FALSE — The tape was imported successfully.

TotalRawCapacity The total raw capacity of the tape in bytes.

Type The tape format and generation of the tape cartridge.
Values: LTO5, LTO6, LTO7, LTO8, LTOM8, LTO9, LTO_CLEANING_
TAPE, TS_JC, TS_JD, TS_JE, TS_JK, TS_JL, TS_JM, TS_JV, TS_JY,
TS_JZ, TS_CLEANING_TAPE, UNKNOWN, FORBIDDEN

VerifyPending The priority for the verify requested, or null if a verify has not
been requested. The priority determines the resources assigned
and the processing order.
Values: CRITICAL, URGENT, HIGH, NORMAL, LOW, BACKGROUND

WriteProtected Whether the tape is write protected. Values: TRUE, FALSE

Example

Sample Request
This request modifies the state of the tape with the UUID 1c3fe1dc-95b7-4152-a286-
951d0af2a27e to lost.
PUT http[s]://blackpearl-hostname/_rest_/tape/1c3fe1dc-95b7-4152-a286-

951d0af2a27e/?state=LOST HTTP/1.1
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Sample Response
HTTP/1.1 200 OK

<Data>

   <AssignedToStorageDomain>FALSE</AssignedToStorageDomain>

   <AvailableRawCapacity>2408088338432</AvailableRawCapacity>

   <BarCode>018675L6</BarCode>

   <BucketId>0acaac0a-55f9-4d6b-b410-4179d4696f37</BucketId>

   <DescriptionForIdentification/>

   <EjectDate/>

   <EjectLabel/>
   <EjectLocation/>

   <EjectPending/>

   <FullOfData>FALSE</FullOfData>

   <Id>1c3fe1dc-95b7-4152-a286-951d0af2a27e</Id>

   <LastAccessed/>
   <LastCheckpoint/>

   <LastModified/>

   <LastVerified/>

   <PartiallyVerifiedEndOfTape/>
   <PartitionId>bd91171d-7738-4aea-b319-7abce892a7b1</PartitionId>

   <PreviousState/>
   <Role>NORMAL</Role>
   <SerialNumber>HP-AE1WRUY90E</SerialNumber>

   <State>LOST</State>
   <StorageDomainMemberId/>

   <TakeOwnershipPending>FALSE</TakeOwnershipPending>

   <TotalRawCapacity>2408088338432</TotalRawCapacity>
   <Type>LTO6</Type>

   <VerifyPending/>

   <WriteProtected>FALSE</WriteProtected>

</Data>

MODIFY TAPE DRIVE

Description
Modify whether the drive is reserved for reading or writing, modify the number of tape
failures before quiescing the drive, or set the tape drive to an unquiesced (NO) or pending
quiesce (PENDING) state. The gateway changes the state from pending quiesce (PENDING) to
quiesced (YES).

Note: If an optional request parameter is not included, the previous setting is retained.
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Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/tape_drive/{tape_drive_id}/[?[max_failed_

tapes={32-bit integer}[&minimum_task_priority=ANY|LOW|NORMAL|HIGH|URGENT]

[&quiesced=NO|PENDING][&reserved_task_type=ANY|READ|WRITE]

To determine the UUID for a tape drive, see Get Tape Drives on page 746.

Request Parameters

Parameter Description Required

max_failed_
tapes

The maximum number of times a drive can fail tasks with different
tapes before it is no longer used. The default is three. If set to zero,
the BlackPearl gateway does not automatically quiesce the tape
drive.

no

minimum_
task_
priority

The minimum priority task for which the drive is reserved. Values:
ANY, LOW, NORMAL, HIGH, URGENT
IMPORTANT Do not modify the minimum_task_priority while there
are active jobs.

no

quiesced Request that the gateway prepare the tape drive to go into an
inactive state (PENDING), or return the tape drive to an active state
(NO). Values: NO, PENDING

no

reserved_
task_ type

Whether the drive is reserved for reads only or writes only, or can
be used for reads or writes.
Values: ANY, READ, WRITE

no

Responses

Response Elements
<Data>

   <CleaningRequired>TRUE|FALSE</CleaningRequired>

   <ErrorMessage>{string}</ErrorMessage>

   <ForceTapeRemoval>TRUE|FALSE</ForceTapeRemoval>

   <Id>{string}</Id>

   <LastCleaned>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastCleaned>

   <MaxFailedTapes>{32-bit integer}</MaxFailedTapes>

   <MfgSerialNumber>{string}</MfgSerialNumber>
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   <MinimumTaskPriority>

      ANY|LOW|NORMAL|HIGH|URGENT

   </MinimumTaskPriority>
   <PartitionId>{string}</PartitionId>

   <Quiesced>NO|PENDING|YES</Quiesced>

   <ReservedTaskType>ANY|READ|WRITE|MAINTENANCE</ReservedTaskType>

   <SerialNumber>{string}</SerialNumber>

   <State>

      ERROR|NORMAL|

      NOT_COMPATIBLE_IN_PARTITION_DUE_TO_NEWER_TAPE_DRIVES|OFFLINE

   </State>

   <TapeId>{string}</TapeId>

   <Type>

      LTO5|LTO6|LTO7|LTO8|LTOM8|LTO9|TS1140|TS1150|TS1155|TS1160|UNKNOWN

   </Type>

</Data>

where the response elements are defined as follows:

Parameter Description

Data A container for the response.

CleaningRequired Whether the tape drive indicates that it needs to be cleaned. Values: TRUE,
FALSE

ErrorMessage A description of any current error, if applicable.

ForceTapeRemoval Whether the tape drive is in an error state and asking that the tape in it be
forcibly removed. If required, this is performed before any other
operations.
Values: TRUE, FALSE

ID The UUID for the tape drive.

LastCleaned The last date and time the tape drive was cleaned in the format YYYY-MM-
DDThh:mm:ss.xxxZ.

MaxFailedTapes The maximum number of times a drive can fail tasks with different tapes
before it is no longer used. If set to zero, the BlackPearl gateway does not
automatically quiesce the tape drive.

MfgSerialNumber The manufacturer-assigned serial number for the tape drive.

MinimumTask
Prioirity

The minimum priority task for which the drive is reserved. Values: ANY,
LOW, NORMAL, HIGH, URGENT
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Parameter Description

PartitionId The UUID for the partition to which the drive belongs.

Quiesced Whether the tape drive is in a temporarily inactive state. Values: NO,
PENDING, YES

ReservedTaskType Whether the drive is reserved for reads only or writes only, or can be used
for reads or writes.
Values: ANY, READ, WRITE, MAINTENANCE

SerialNumber The location-based serial number for the drive while it is in the library.

State The status of the tape drive. Values: ERROR, NORMAL, NOT_COMPATIBLE_
IN_PARTITION_DUE_TO_NEWER_TAPE_DRIVES, OFFLINE

TapeId The UUID for the tape in the tape drive, if present.

Type The tape format and generation of the tape drive.
Values: LTO5, LTO6, LTO7, LTO8, LTOM8, LTO9, TS1140, TS1150, TS1155,
TS1160, UNKNOWN

Example

Sample Request
This request reactivates the tape drive with the UUID e2b1c2f8-85be-4350-8882-2a2e1cd8ca0e.
PUT http://blackpearl-hostname/_rest_/tape_drive/e2b1c2f8-85be-4350-8882-

2a2e1cd8ca0e/?quiesced=NO HTTP/1.1

Sample Response

HTTP/1.1 200 OK

<Data>

   <CleaningRequired>FALSE</CleaningRequired>

   <ErrorMessage/>

   <ForceTapeRemoval>FALSE</ForceTapeRemoval>

   <Id>e2b1c2f8-85be-4350-8882-2a2e1cd8ca0e</Id>

   <LastCleaned/>
   <MaxFailedTapes>3</MaxFailedTapes>

   <MfgSerialNumber>90WT008323</MfgSerialNumber>

   <MinimumTaskPriority>ANY</MinimumTaskPriority>
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   <PartitionId>720270ee-9d79-46d2-833b-6150724593a3</PartitionId>

   <Quiesced>NO</Quiesced>

   <ReservedTaskType>ANY</ReservedTaskType>

   <SerialNumber>68001883</SerialNumber>

   <State>NORMAL</State>

   <TapeId>bbaf65f9-69fe-4212-97fe-47466fe39f61</TapeId>

   <Type>LTO5</Type>

</Data>

MODIFY TAPE PARTITION

Description
Modify the number of drives in the partition reserved for reading or writing, enable or
disable auto compaction, or set the tape partition to an unquiesced (NO), or pending quiesce
(PENDING) state. The BlackPearl gateway changes the state from pending quiesce (PENDING)
to quiesced (YES).

Note: If an optional request parameter is not included, the previous setting is retained.

Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/tape_partition/{tape_partition_id}/[?auto_

compaction_enabled=TRUE|FALSE][&auto_quiesce_enabled=TRUE|FALSE][&drive_idle_

timeout_in_minutes={32-bit integer}][&minimum_read_reserved_drives={32-bit integer}]

[&minimum_write_reserved_drives={32-bit integer}][&quiesced=NO|PENDING]

To determine the UUID for a tape partition, see Get Tape Partitions on page 765.

Request Parameters

Parameter Description Required

auto_
compaction_
enabled

Whether to automatically compact space from tapes that are
above a specified threshold of unused tape space due to deleted
objects that still reside on a tape.
Values: TRUE, FALSE. The default is FALSE.

no
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Parameter Description Required

auto_quiesce_
enabled

Whether to quiesce a tape drive after reaching the max_failed_
tapes limit (see max_failed_tapes on page 813). Values: TRUE,
FALSE. The default is TRUE.

no

drive_idle_
timeout_in_
minutes

The number of minutes to wait while a drive is idle before
ejecting the tape and moving it back to a storage slot. The default
is 15.

no

minimum_
read_
reserved_
drives

The minimum number of drives in the partition reserved for
reads. The default is 0.

no

minimum_
write_
reserved_
drives

The minimum number of drives in the partition reserved for
writes. The default is 0.

no

quiesced Request that the gateway prepare the tape partition to go into an
inactive state (PENDING), or return the tape partition to an active
state (NO). Values: NO, PENDING

no

Responses

Response Elements
<Data>

   <AutoCompactionEnabled>TRUE|FALSE</AutoCompactionEnabled>

   <AutoQuiesceEnabled>TRUE|FALSE</AutoQuiesceEnabled>

   <DriveIdleTimeoutInMinutes>

{32-bit integer}

</DriveIdleTimeoutInMinutes>

   <DriveType>

      LTO5|LTO6|LTO7|LTO8|LTOM8|LTO9|TS1140|TS1150|TS1155|TS1160|UNKNOWN

   </DriveType>
   <ErrorMessage>{string}</ErrorMessage>

   <Id>{string}</Id>

   <ImportExportConfiguration>

      SUPPORTED|NOT_SUPPORTED

   </ImportExportConfiguration>
   <LibraryId>{string}</LibraryId>

   <MinimumReadReservedDrives>

{32-bit integer}

   </MinimumReadReservedDrives>
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   <MinimumWriteReservedDrives>

{32-bit integer}

   </MinimumWriteReservedDrives>

   <Name>{string}</Name>

   <Quiesced>NO|PENDING|YES</Quiesced>
   <SerialId>{string}</SerialId>

   <SerialNumber>{string}</SerialNumber>

   <State>ONLINE|OFFLINE</State>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

AutoCompaction
Enabled

Whether auto compaction of tapes is enabled.

AutoQuiesceEnabled Whether to quiesce a tape drive after reaching the max_failed_tapes
limit (see max_failed_tapes on page 813).

DriveIdleTimeoutIn
Minutes

The number of minutes to wait while a drive is idle before ejecting the
tape and moving it back to a storage slot.

DriveType The type of drives assigned to the partition.
Values: LTO5, LTO6, LTO7, LTO8, LTOM8, LTO9, TS1140, TS1150,
TS1155, TS1160, UNKNOWN

ErrorMessage The description of any current error.

Id The UUID for the partition.

ImportExport
Configuration

Whether the import and export configuration of the tape library is
supported by the BlackPearl gateway. If a T50e or T120 library with
multiple partitions is associated with a BlackPearl gateway, you cannot
use the BlackPearl gateway to eject the tapes because of the library’s
shared eject port. In this situation, see Spectra BlackPearl gateway User
Guide for instructions for manually ejecting tapes from the BlackPearl
gateway.
Values: SUPPORTED, NOT_SUPPORTED

LibraryId The UUID for the library.

MinimumRead
ReservedDrives

The minimum number of drives in the partition reserved for reads.
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Parameter Description

MinimumWrite
ReservedDrives

The minimum number of drives in the partition reserved for writes.

Name The name of the partition.

Quiesced Whether the partition is in a temporarily inactive state. Values: NO,
PENDING, YES

SerialID A unique representation of the library partition serial number that
remains the same even if the partition exporter is replaced.

SerialNumber The serial number of the library partition.

State The status of the tape partition. Values: ONLINE, OFFLINE

Example

Sample Request
This request changes the tape library partition with the UUID 15c3a202-07e9-4ff9-8e4b-
05dcaa55875a to quiesced=pending.
PUT http://blackpearl-hostname/_rest_/tape_partition/15c3a202-07e9-4ff9-8e4b-

05dcaa55875a/?quiesced=PENDING HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>

   <AutoCompactionEnabled>FALSE</AutoCompactionEnabled>

   <AutoQuiesceEnabled>false</AutoQuiesceEnabled>

<DriveIdleTimeoutInMinutes>7</DriveIdleTimeoutInMinutes>
   <DriveType/>

   <ErrorMessage/>

   <Id>15c3a202-07e9-4ff9-8e4b-05dcaa55875a</Id>

   <ImportExportConfiguration>

      SUPPORTED

   </ImportExportConfiguration>
   <LibraryId>8cf68800-8845-4c88-84af-3278d76f0bcf</LibraryId>

   <MinimumReadReservedDrives>0</MinimumReadReservedDrives>

   <MinimumWriteReservedDrives>0</MinimumWriteReservedDrives>

   <Name>MoviePartition</Name>
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   <Quiesced>PENDING</Quiesced>

   <SerialId>01000090A5000950</SerialId>

   <SerialNumber>21130090A5000950</SerialNumber>

   <State>ONLINE</State>

</Data>

MODIFY TAPE PARTITIONS

Description
Sets all tape partitions to unquiesced (NO), or pending quiesce (PENDING) state. The gateway
changes the state from pending quiesce (PENDING) to quiesced (YES).

Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/tape_partition/[?quiesced=NO|PENDING]

To determine the UUID for a tape partition, see Get Tape Partitions on page 765.

Request Parameters

Parameter Description Required

quiesced Request that the gateway prepare all tape partitions to go into an
inactive state (PENDING) or return all tape partitions to an active
state (NO). Values: NO, PENDING

yes

Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 409: Conflict (requested modification is not allowed)

April 2023 DS3 API Reference-Spectra BlackPearl Nearline Gateway
- 820 -



Chapter 16 - Tape Library and Component Operations Online Tape

Example

Sample Request
This request changes the quiesced state of all tape library partitions to “No”.
PUT http://blackpearl-hostname/_rest_/tape_partition/?quiesced=NO HTTP/1.1

Sample Response
HTTP/1.1 204 No Content

ONLINE TAPE

Description
Onlines (moves the tape from the entry/exit pool to the storage pool) the specified tape.
Tapes must be onlined before they can be used.

Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/tape/{tape UUID or barcode}/?operation=ONLINE

To determine the UUID for a tape, see Get Tapes on page 770.

Request Parameters

Parameter Description Required

operation The operation to perform. For this request, the operation is online.
Value: ONLINE

yes
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Responses

Response Elements
<Data>

   <AssignedToStorageDomain>TRUE|FALSE</AssignedToStorageDomain>

   <AvailableRawCapacity>{64-bit integer}</AvailableRawCapacity>

   <BarCode>{string}</BarCode>

   <BucketId>{string}</BucketId>

   <DescriptionForIdentification>

{string}

   </DescriptionForIdentification>

   <EjectDate>{YYYY-MM-DDThh:mm:ss.xxxZ}</EjectDate>

   <EjectLabel>{string}</EjectLabel>

   <EjectLocation>{string}</EjectLocation>

   <EjectPending>{YYYY-MM-DDThh:mm:ss.xxxZ}</EjectPending>

   <FullOfData>TRUE|FALSE</FullOfData>

   <Id>{string}</Id>
   <LastAccessed>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastAccessed>

   <LastCheckpoint>{string}</LastCheckpoint>

   <LastModified>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastModified>

   <LastVerified>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastVerified>
   <PartiallyVerifiedEndOfTape>

{YYYY-MM-DDThh:mm:ss.xxxZ}

   </PartiallyVerifiedEndOfTape>
   <PartitionId>{string}</PartitionId>
   <PreviousState>

      NORMAL|AUTO_COMPACTION_IN_PROGRESS|BAD|BAR_CODE_MISSING|

      CANNOT_FORMAT_DUE_TO_WRITE_PROTECTION|

      DATA_CHECKPOINT_FAILURE|

      DATA_CHECKPOINT_FAILURE_DUE_TO_READ_ONLY|

      DATA_CHECKPOINT_MISSING|EJECT_FROM_EE_PENDING|

      EJECT_TO_EE_IN_PROGRESS|EJECTED|FOREIGN|FORMAT_IN_PROGRESS|

      FORMAT_PENDING|IMPORT_IN_PROGRESS|IMPORT_PENDING|

      INCOMPATIBLE|LOST|LTFS_WITH_FOREIGN_DATA|OFFLINE|

      ONLINE_IN_PROGRESS|ONLINE_PENDING|PENDING_INSPECTION|

      RAW_IMPORT_IN_PROGRESS|RAW_IMPORT_PENDING|

      SERIAL_NUMBER_MISMATCH|UNKNOWN

   </PreviousState>
   <Role>NORMAL|TEST</Role>
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   <SerialNumber>{string}</SerialNumber>

   <State>

      NORMAL|AUTO_COMPACTION_IN_PROGRESS|BAD|BAR_CODE_MISSING|

      CANNOT_FORMAT_DUE_TO_WRITE_PROTECTION|

      DATA_CHECKPOINT_FAILURE|

      DATA_CHECKPOINT_FAILURE_DUE_TO_READ_ONLY|

      DATA_CHECKPOINT_MISSING|EJECT_FROM_EE_PENDING|

      EJECT_TO_EE_IN_PROGRESS|EJECTED|FOREIGN|FORMAT_IN_PROGRESS|

      FORMAT_PENDING|IMPORT_IN_PROGRESS|IMPORT_PENDING|

      INCOMPATIBLE|LOST|LTFS_WITH_FOREIGN_DATA|OFFLINE|

      ONLINE_IN_PROGRESS|ONLINE_PENDING|PENDING_INSPECTION|

      RAW_IMPORT_IN_PROGRESS|RAW_IMPORT_PENDING|

      SERIAL_NUMBER_MISMATCH|UNKNOWN

   </State>
   <StorageDomainMemberId>{string}</StorageDomainMemberId>

   <TakeOwnershipPending>TRUE|FALSE</TakeOwnershipPending>

   <TotalRawCapacity>{64-bit integer}</TotalRawCapacity>

   <Type>

      LTO5|LTO6|LTO7|LTO8|LTOM8|LTO9|LTO_CLEANING_TAPE|TS_JC|TS_JD|

      TS_JE|TS_JK|TS_JL|TS_JM|TS_JV|TS_JY|TS_JZ|TS_CLEANING_TAPE

      |UNKNOWN|FORBIDDEN

   </Type>
   <VerifyPending>

      CRITICAL|URGENT|HIGH|NORMAL|LOW|BACKGROUND

   </VerifyPending>

   <WriteProtected>TRUE|FALSE</WriteProtected>

</Data>

where the response elements are defined as follows:

Parameter Description

Data A container for the response.

AssignedToStorageDomain Whether the tape is currently assigned to a storage domain.
Values: TRUE, FALSE

AvailableRaw
Capacity

The amount of unused raw capacity on the tape in bytes.

BarCode The barcode on the label of the tape cartridge.

BucketId The UUID for the bucket to which the tape is assigned.
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Parameter Description

DescriptionFor
Identification

The LTFS Volume ID and name, if applicable. This is only provided
if the BlackPearl gateway cannot identify the tape.

EjectDate The date and time that the BlackPearl gateway discovered that the
tape was ejected, in the format YYYY-MM-DDThh:mm:ss.xxxZ. If
the parameter is empty, the tape has not been ejected.

EjectLabel The user-entered information to assist in the handling of the tape.

EjectLocation The user-entered information to describe where the ejected tape
can be located.

EjectPending The date and time that the tape was put in the queue to be ejected
in the format YYYY-MM-DDThh:mm:ss.xxxZ. If the parameter is
empty, the tape has not been queued to be ejected or the eject has
started and is no longer cancelable.

FullOfData Whether the tape is completely full of data.
Values: TRUE, FALSE

Id The UUID for the tape.

LastAccessed The last date and time the tape was loaded into a tape drive in the
format YYYY-MM-DDThh:mm:ss.xxxZ.

LastCheckpoint An identifier, internal to the BlackPearl gateway, for verifying the
application integrity of the tape.

LastModified The last date and time the tape was modified in the format YYYY-
MM-DDThh:mm:ss.xxxZ.

LastVerified The last date and time the checksum of the data was verified in
the format YYYY-MM-DDThh:mm:ss.xxxZ.

PartiallyVerified
EndOfTape

The last date and time the BlackPearl gateway verified the data on
a specified percentage of the tape capacity before the EOD marker
in the format
YYYY-MM-DDThh:mm:ss.xxxZ.

PartitionId The UUID for the partition to which the tape belongs.

PreviousState The previous status of the tape. See State on page 664.

Role The role assigned to the tape. Values: Normal, Test

SerialNumber The manufacturer-assigned serial number for the tape.
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Parameter Description

State The status of the tape. See State on page 664.

StorageDomain
MemberId

The UUID for the storage domain member.

TakeOwnership Pending Whether a tape from another BlackPearl gateway is waiting for
the current gateway to complete taking ownership.
Values:
• TRUE — The foreign tape was imported when
WriteProtected was TRUE, preventing the tape from being
claimed by the current gateway.

• FALSE — The tape was imported successfully.

TotalRawCapacity The total raw capacity of the tape in bytes.

Type The tape format and generation of the tape cartridge.
Values: LTO5, LTO6, LTO7, LTO8, LTOM8, LTO9, LTO_CLEANING_
TAPE, TS_JC, TS_JD, TS_JE, TS_JK, TS_JL, TS_JM, TS_JV, TS_JY,
TS_JZ, TS_CLEANING_TAPE, UNKNOWN, FORBIDDEN

VerifyPending The priority for the verify requested, or null if a verify has not
been requested. The priority determines the resources assigned
and the processing order.
Values: CRITICAL, URGENT, HIGH, NORMAL, LOW, BACKGROUND

WriteProtected Whether the tape is write protected. Values: TRUE, FALSE

Example

Sample Request
This request queues the tape with the UUID 1c3fe1dc-95b7-4152-a286-951d0af2a27e to be
moved to the storage pool.
PUT http://blackpearl-hostname/_rest_/tape/1c3fe1dc-95b7-4152-a286-

951d0af2a27e/?operation=ONLINE HTTP/1.1
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Sample Response
HTTP/1.1 200 OK

<Data>

   <AssignedToStorageDomain>FALSE</AssignedToStorageDomain>

   <AvailableRawCapacity>2408088338432</AvailableRawCapacity>

   <BarCode>018675L6</BarCode>

   <BucketId>0acaac0a-55f9-4d6b-b410-4179d4696f37</BucketId>

   <DescriptionForIdentification/>

   <EjectDate/>

   <EjectLabel/>

   <EjectLocation/>

   <EjectPending/>

   <FullOfData>FALSE</FullOfData>

   <Id>1c3fe1dc-95b7-4152-a286-951d0af2a27e</Id>

   <LastAccessed/>

   <LastCheckpoint/>

   <LastModified/>

   <LastVerified/>

   <PartiallyVerifiedEndOfTape/>

   <PartitionId>bd91171d-7738-4aea-b319-7abce892a7b1</PartitionId>

   <PreviousState/>
   <Role>NORMAL</Role>

   <SerialNumber>HP-AE1WRUY90E</SerialNumber>

   <State>ONLINE_PENDING</State>

   <StorageDomainMemberId/>

   <TakeOwnershipPending>FALSE</TakeOwnershipPending>

   <TotalRawCapacity>2408088338432</TotalRawCapacity>

   <Type>LTO6</Type>

   <VerifyPending/>
   <WriteProtected>FALSE</WriteProtected>

</Data>

ONLINE TAPES

Description
Onlines (moves tapes from the entry/exit pool to the storage pool) all tapes in the entry/exit
pool. Tapes must be onlined before they can be used.
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Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/tape/?operation=ONLINE

Request Parameters

Parameter Description Required

operation The operation to perform. For this request, the operation is online.
Value: ONLINE

yes

Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 207: Multi-Status (with list of errors)

Example

Sample Request
This request onlines all tapes in the entry/exit pool.
PUT http://blackpearl-hostname/_rest_/tape/?operation=ONLINE HTTP/1.1

Sample Response
HTTP/1.1 204 No Content
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Test Tape Drive

Description
Tests a specified tape drive. This operation takes approximately 10 minutes.

Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/tape_drive/{drive UUID or other unique

attribute}/?operation=TEST[&skip_clean][&tape_id={tape UUID or other unique

attribute]

Request Parameters

Parameter Description Required

operation The operation to perform. For this request, the operation is to test a
tape drive. Value: TEST

yes

skip_clean Whether or not to skip cleaning of the tape drive before the drive is
tested

no

tape_id User UUID, name, or other unique attribute of the tape cartridge to
use for the drive test.

no

Responses

Response Elements
<Data>
   <CleaningRequired>TRUE|FALSE</CleaningRequired>
   <ErrorMessage>{string}</ErrorMessage
   <ForceTapeRemoval>TRUE|FALSE</ForceTapeRemoval>
   <Id>{string}</Id>
   <LastCleaned>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastCleaned>
   <MaxFailedTapes>{64-bit integer}</MaxFailedTapes>
   <MfgSerialNumber>{string}</MfgSerialNumber>
   <MinimumTaskPriority>ANY|LOW|NORMAL|HIGH|URGENT</MinimumTaskPriority>
   <PartitionId>{string}</PartitionId>
   <Quiesced>NO|PENDING|YES</Quiesced>
   <ReservedTaskType>ANY|READ|WRITE|MAINTENANCE</ReservedTaskType>
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   <State>

      NORMAL|AUTO_COMPACTION_IN_PROGRESS|BAD|BAR_CODE_MISSING|

      CANNOT_FORMAT_DUE_TO_WRITE_PROTECTION|

      DATA_CHECKPOINT_FAILURE|

      DATA_CHECKPOINT_FAILURE_DUE_TO_READ_ONLY|

      DATA_CHECKPOINT_MISSING|EJECT_FROM_EE_PENDING|

      EJECT_TO_EE_IN_PROGRESS|EJECTED|FOREIGN|FORMAT_IN_PROGRESS|

      FORMAT_PENDING|IMPORT_IN_PROGRESS|IMPORT_PENDING|

      INCOMPATIBLE|LOST|LTFS_WITH_FOREIGN_DATA|OFFLINE|

      ONLINE_IN_PROGRESS|ONLINE_PENDING|PENDING_INSPECTION|

      RAW_IMPORT_IN_PROGRESS|RAW_IMPORT_PENDING|

      SERIAL_NUMBER_MISMATCH|UNKNOWN

   </State>
   <TapeId>{string}</TapeId>
   <Type>{string}</Type>

</Data>

where the response elements are defined as follows:

Parameter Description

Data A container for the response.

CleaningRequired Whether the tape drive indicates that it needs to be cleaned. Values: TRUE,
FALSE

ErrorMessage A description of any current error, if applicable.

ForceTapeRemoval Whether the tape drive is in an error state and asking that the tape in it be
forcibly removed. If required, this is performed before any other
operations.
Values: TRUE, FALSE

ID The UUID for the tape drive.

LastCleaned The last date and time the tape drive was cleaned in the format YYYY-MM-
DDThh:mm:ss.xxxZ.

MaxFailedTapes The maximum number of times a drive can fail tasks with different tapes
before it is no longer used. If set to zero, the BlackPearl gateway does not
automatically quiesce the tape drive.

MfgSerialNumber The manufacturer-assigned serial number for the tape drive.

MinimumTask
Prioirity

The minimum priority task for which the drive is reserved. Values: ANY,
LOW, NORMAL, HIGH, URGENT
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Parameter Description

PartitionId The UUID for the partition to which the drive belongs.

Quiesced Whether the tape drive is in a temporarily inactive state. Values: NO,
PENDING, YES

ReservedTaskType Whether the drive is reserved for reads only or writes only, or can be used
for reads or writes.
Values: ANY, READ, WRITE, MAINTENANCE

SerialNumber The location-based serial number for the drive while it is in the library.

State The status of the tape drive. Test Tape Drive on page 828.

TapeId The UUID for the tape in the tape drive, if present.

Type The tape format and generation of the tape drive.
Values: LTO5, LTO6, LTO7, LTO8, LTOM8, LTO9, TS1140, TS1150, TS1155,
TS1160, UNKNOWN

Example

Sample Request
This initiates a tape drive test to the drive with UUID 2bebf2dc-5388-4ac1-9168-063d76108fcc.
PUT http[s]://blackpearl-hostnam/_rest_/tape_drive/2bebf2dc-5388-4ac1-9168-

063d76108fcc/?operation=test HTTP/1.1

Sample Response
<Data>
   <CleaningRequired>false</CleaningRequired>
   <ErrorMessage/>
   <ForceTapeRemoval>false</ForceTapeRemoval>
   <Id>2bebf2dc-5388-4ac1-9168-063d76108fcc</Id>
   <LastCleaned/>
   <MaxFailedTapes>3</MaxFailedTapes>
   <MfgSerialNumber/>
   <MinimumTaskPriority/>
   <PartitionId>1651288a-fd0d-43be-8cc5-1e7c6bbe55f</PartitionId>
   <Quiesced>NO</Quiesced>
   <ReservedTaskType>ANY</ReservedTaskType>
   <SerialNumber>td1</SerialNumber>
   <State>NORMAL</State><TapeId/>
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   <Type>LTO5</Type>

</Data>

VERIFY TAPE

Description
Verifies the media content on one tape.

Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/tape/{tape UUID or barcode}/?operation=VERIFY

[&task_priority=URGENT|HIGH|NORMAL|LOW]

To determine the UUID for a tape, see Get Tapes on page 770.

Request Parameters

Parameter Description Required

operation The operation to perform. For this request, the operation is verify.
Value: VERIFY

yes

task_priority The priority for processing this task. The task_priority
determines the resources assigned and the processing order. Verify
tasks can be interrupted every 30 minutes if a job with a higher
priority is received.
Values: URGENT, HIGH, NORMAL, LOW

no

Responses

Response Elements
<Data>

   <AssignedToStorageDomain>TRUE|FALSE</AssignedToStorageDomain>

   <AvailableRawCapacity>{64-bit integer}</AvailableRawCapacity>

   <BarCode>{string}</BarCode>

   <BucketId>{string}</BucketId>
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   <DescriptionForIdentification>

{string}

   </DescriptionForIdentification>
   <EjectDate>{YYYY-MM-DDThh:mm:ss.xxxZ}</EjectDate>

   <EjectLabel>{string}</EjectLabel>

   <EjectLocation>{string}</EjectLocation>

   <EjectPending>{YYYY-MM-DDThh:mm:ss.xxxZ}</EjectPending>
   <FullOfData>TRUE|FALSE</FullOfData>
   <Id>{string}</Id>
   <LastAccessed>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastAccessed>

   <LastCheckpoint>{string}</LastCheckpoint>
   <LastModified>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastModified>

   <LastVerified>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastVerified>
   <PartiallyVerifiedEndOfTape>

{YYYY-MM-DDThh:mm:ss.xxxZ}

   </PartiallyVerifiedEndOfTape>

   <PartitionId>{string}</PartitionId>
   <PreviousState>

      NORMAL|AUTO_COMPACTION_IN_PROGRESS|BAD|BAR_CODE_MISSING|

      CANNOT_FORMAT_DUE_TO_WRITE_PROTECTION|

      DATA_CHECKPOINT_FAILURE|

      DATA_CHECKPOINT_FAILURE_DUE_TO_READ_ONLY|

      DATA_CHECKPOINT_MISSING|EJECT_FROM_EE_PENDING|

      EJECT_TO_EE_IN_PROGRESS|EJECTED|FOREIGN|FORMAT_IN_PROGRESS|

      FORMAT_PENDING|IMPORT_IN_PROGRESS|IMPORT_PENDING|

      INCOMPATIBLE|LOST|LTFS_WITH_FOREIGN_DATA|OFFLINE|

      ONLINE_IN_PROGRESS|ONLINE_PENDING|PENDING_INSPECTION|

      RAW_IMPORT_IN_PROGRESS|RAW_IMPORT_PENDING|

      SERIAL_NUMBER_MISMATCH|UNKNOWN

   </PreviousState>
   <Role>NORMAL|TEST</Role>
   <SerialNumber>{string}</SerialNumber>

   <State>

      NORMAL|AUTO_COMPACTION_IN_PROGRESS|BAD|BAR_CODE_MISSING|

      CANNOT_FORMAT_DUE_TO_WRITE_PROTECTION|

      DATA_CHECKPOINT_FAILURE|

      DATA_CHECKPOINT_FAILURE_DUE_TO_READ_ONLY|

      DATA_CHECKPOINT_MISSING|EJECT_FROM_EE_PENDING|

      EJECT_TO_EE_IN_PROGRESS|EJECTED|FOREIGN|FORMAT_IN_PROGRESS|

      FORMAT_PENDING|IMPORT_IN_PROGRESS|IMPORT_PENDING|

      INCOMPATIBLE|LOST|LTFS_WITH_FOREIGN_DATA|OFFLINE|

      ONLINE_IN_PROGRESS|ONLINE_PENDING|PENDING_INSPECTION|

      RAW_IMPORT_IN_PROGRESS|RAW_IMPORT_PENDING|

      SERIAL_NUMBER_MISMATCH|UNKNOWN

   </State>
April 2023 DS3 API Reference-Spectra BlackPearl Nearline Gateway

- 832 -



Chapter 16 - Tape Library and Component Operations Verify Tape

   <StorageDomainMemberId>{string}</StorageDomainMemberId>

   <TakeOwnershipPending>TRUE|FALSE</TakeOwnershipPending>

   <TotalRawCapacity>{64-bit integer}</TotalRawCapacity>

   <Type>

      LTO5|LTO6|LTO7|LTO8|LTOM8|LTO9|LTO_CLEANING_TAPE|TS_JC|TS_JD|

      TS_JE|TS_JK|TS_JL|TS_JM|TS_JV|TS_JY|TS_JZ|TS_CLEANING_TAPE

      |UNKNOWN|FORBIDDEN

   </Type>
   <VerifyPending>

      CRITICAL|URGENT|HIGH|NORMAL|LOW|BACKGROUND

   </VerifyPending>

   <WriteProtected>TRUE|FALSE</WriteProtected>

</Data>

where the response elements are defined as follows:

Parameter Description

Data A container for the response.

AssignedToStorageDomain Whether the tape is currently assigned to a storage domain.
Values: TRUE, FALSE

AvailableRaw
Capacity

The amount of unused raw capacity on the tape in bytes.

BarCode The barcode on the label of the tape cartridge.

BucketId The UUID for the bucket to which the tape is assigned.

DescriptionFor
Identification

The LTFS Volume ID and name, if applicable. This is only provided
if the BlackPearl gateway cannot identify the tape.

EjectDate The date and time that the BlackPearl gateway discovered that the
tape was ejected, in the format YYYY-MM-DDThh:mm:ss.xxxZ. If
the parameter is empty, the tape has not been ejected.

EjectLabel The user-entered information to assist in the handling of the tape.

EjectLocation The user-entered information to describe where the ejected tape
can be located.

EjectPending The date and time that the tape was put in the queue to be ejected
in the format YYYY-MM-DDThh:mm:ss.xxxZ. If the parameter is
empty, the tape has not been queued to be ejected or the eject has
started and is no longer cancelable.
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Parameter Description

FullOfData Whether the tape is completely full of data.
Values: TRUE, FALSE

Id The UUID for the tape.

LastAccessed The last date and time the tape was loaded into a tape drive in the
format YYYY-MM-DDThh:mm:ss.xxxZ.

LastCheckpoint An identifier, internal to the BlackPearl gateway, for verifying the
application integrity of the tape.

LastModified The last date and time the tape was modified in the format YYYY-
MM-DDThh:mm:ss.xxxZ.

LastVerified The last date and time the checksum of the data was verified in
the format YYYY-MM-DDThh:mm:ss.xxxZ.

PartiallyVerified
EndOfTape

The last date and time the BlackPearl gateway verified the data on
a specified percentage of the tape capacity before the EOD marker
in the format
YYYY-MM-DDThh:mm:ss.xxxZ.

PartitionId The UUID for the partition to which the tape belongs.

PreviousState The previous status of the tape. See State on page 664.

Role The role assigned to the tape. Values: Normal, Test

SerialNumber The manufacturer-assigned serial number for the tape.

State The status of the tape. See State on page 664.

StorageDomain
MemberId

The UUID for the storage domain member.

TakeOwnership Pending Whether a tape from another BlackPearl gateway is waiting for
the current gateway to complete taking ownership.
Values:
• TRUE — The foreign tape was imported when
WriteProtected was TRUE, preventing the tape from being
claimed by the current gateway.

• FALSE — The tape was imported successfully.

TotalRawCapacity The total raw capacity of the tape in bytes.
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Parameter Description

Type The tape format and generation of the tape cartridge.
Values: LTO5, LTO6, LTO7, LTO8, LTOM8, LTO9, LTO_CLEANING_
TAPE, TS_JC, TS_JD, TS_JE, TS_JK, TS_JL, TS_JM, TS_JV, TS_JY,
TS_JZ, TS_CLEANING_TAPE, UNKNOWN, FORBIDDEN

VerifyPending The priority for the verify requested, or null if a verify has not
been requested. The priority determines the resources assigned
and the processing order.
Values: CRITICAL, URGENT, HIGH, NORMAL, LOW, BACKGROUND

WriteProtected Whether the tape is write protected. Values: TRUE, FALSE

Example

Sample Request
This verifies the content of the tape with the UUID 2ba9f40b-1781-4fd5-b650-5ed66903ad2f.
PUT http://blackpearl-hostname/_rest_/tape/2ba9f40b-1781-4fd5-b650-

5ed66903ad2f/?operation=VERIFY HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>

   <AssignedToStorageDomain>FALSE</AssignedToStorageDomain>

   <AvailableRawCapacity>10000</AvailableRawCapacity>

   <BarCode>018975L5</BarCode>

   <BucketId/>

   <DescriptionForIdentification/>
   <EjectDate/>

   <EjectLabel/>

   <EjectLocation/>

   <EjectPending/>

   <FullOfData>FALSE</FullOfData>
   <Id>2ba9f40b-1781-4fd5-b650-5ed66903ad2f</Id>

   <LastAccessed/>

   <LastCheckpoint/>

   <LastModified/>

   <LastVerified/>

   <PartiallyVerifiedEndOfTape/>
   <PartitionId>2789db6e-3c81-4e86-aec6-600b4c83e452</PartitionId>

   <PreviousState/>
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   <Role>NORMAL</Role>

   <SerialNumber/>

   <State>PENDING_INSPECTION</State>

   <StorageDomainMemberId/>
   <TakeOwnershipPending>FALSE</TakeOwnershipPending>

   <TotalRawCapacity>1425000103936</TotalRawCapacity>

   <Type>LTO5</Type>

   <VerifyPending/>

   <WriteProtected>FALSE</WriteProtected>

</Data>

VERIFY TAPES

Description
Verifies the media contents across all tapes. This request may take a very long time.

Note: To cancel this process, see Cancel Verify of Tapes on page 697.

Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/tape/?operation=VERIFY[&task_

priority=URGENT|HIGH|NORMAL|LOW]

Request Parameters

Parameter Description Required

operation The operation to perform. For this request, the operation is verify.
Value: VERIFY

yes

task_priority The priority for processing this task. The task_priority
determines the resources assigned and the processing order. Verify
tasks can be interrupted every 30 minutes if a job with a higher
priority is received.
Values: URGENT, HIGH, NORMAL, LOW (default)

no
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Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 207: Multi-Status (with list of errors)

Example

Sample Request
This request verifies the content on all tapes.
PUT http://blackpearl-hostname/_rest_/tape/?operation=VERIFY HTTP/1.1

Sample Response
HTTP/1.1 204 No Content
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VOLUME F - NOTIFICATION OPERATIONS
This section describes the operations available to handle notifications.

Notification of tape library events may also be configured from the Spectra Logic tape
library’s web interface. See the User Guide for your tape library (see
support.spectralogic.com/documentation).
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Get Tape Failure Notification Registrations 999

Get Tape Partition Failure Notification Registration 1003

Get Tape Partition Failure Notification Registrations 1005

CREATE AMAZON S3 TARGET FAILURE NOTIFICATION
REGISTRATION

Description
Create a notification registration for Amazon S3 target failures.

Requests

Syntax
POST http[s]://{datapathDNSname}/_rest_/s3_target_failure_notification_

registration/?notification_end_point={string}[&format=DEFAULT|JSON|XML][&naming_

convention=CONCAT_LOWERCASE|CONSTANT|UNDERSCORED|CAMEL_CASE_WITH_FIRST_LETTER_

UPPERCASE|CAMEL_CASE_WITH_FIRST_LETTER_LOWERCASE][&notification_http_

method=POST|PUT]

Request Parameters

Parameter Description Required

notification_
end_
point

The HTTP or HTTPS URL of a web server capable of receiving
notification messages from the BlackPearl gateway.

yes

format The format of the notification.
Values: DEFAULT (XML), JSON, XML

no

naming_
convention

The scheme used for naming within the notification sent. Values:
CONCAT_LOWERCASE, CONSTANT, UNDERSCORED, CAMEL_
CASE_WITH_FIRST_LETTER_UPPERCASE (default), CAMEL_CASE_
WITH_FIRST_LETTER_LOWERCASE

no

notification_
http_
method

The HTTP request method type used to send the notification.
Values: POST (default), PUT

no
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Responses

Response Elements
<Data>

   <CreationDate>{YYYY-MM-DDThh:mm:ss.xxxZ}</CreationDate>

   <Format>DEFAULT|JSON|XML</Format>

   <Id>{string}</Id>

   <LastFailure>{string}</LastFailure>

   <LastHttpResponseCode>{32-bit integer}</LastHttpResponseCode>

   <LastNotification>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastNotification>
   <NamingConvention>

      CONCAT_LOWERCASE|CONSTANT|UNDERSCORED|

      CAMEL_CASE_WITH_FIRST_LETTER_UPPERCASE|

      CAMEL_CASE_WITH_FIRST_LETTER_LOWERCASE

   </NamingConvention>
   <NotificationEndPoint>{string}</NotificationEndPoint>

   <NotificationHttpMethod>|POST|PUT</NotificationHttpMethod>

   <NumberOfFailuresSinceLastSuccess>

{32-bit integer}

   </NumberOfFailuresSinceLastSuccess>

   <UserId>{string}</UserId>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

CreationDate The date the notification registration was created in the
format YYYY-MM-DDThh:mm:ss.xxxZ.

Format The format of the notification.
Values: DEFAULT (XML), JSON, XML

ID The UUID for the notification.

LastFailure The exception message for the last failure to send a
notification to this notification registration.

LastHttpResponseCode The last response code returned by the notification end
point.
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Parameter Description

LastNotification Date and time of the last notification attempt by the
BlackPearl gateway.

NamingConvention The scheme used for naming within the notification sent.
Values: CONCAT_LOWERCASE, CONSTANT,
UNDERSCORED, CAMEL_CASE_WITH_FIRST_LETTER_
UPPERCASE, CAMEL_CASE_WITH_FIRST_LETTER_
LOWERCASE

NotificationEnd Point The HTTP or HTTPS URL of a web server capable of
receiving notification messages from the BlackPearl
gateway.

NotificationHttp Method The HTTP request method type. Values: POST (default),
PUT

NumberOfFailuresSinceLastSuccess Number of failed notification attempts since last
successful notification.

UserId The UUID for the user who created the notification
registration.

Example

Sample Request
This request creates a registration for Amazon S3 target failure notifications to be sent to DS3-
client-hostname.
POST http://blackpearl-hostname/_rest_/s3_target_failure_notification_

registration/?notification_end_point=DS3-client-hostname HTTP/1.1

Sample Response
HTTP/1.1 201 CREATED

<Data>
   <CreationDate>2017-02-22T00:51:00.000Z</CreationDate>
   <Format>DEFAULT</Format>
   <Id>486e5212-c4b7-43f4-b49d-3ae8b703204a</Id>
   <LastFailure/>
   <LastHttpResponseCode/>
   <LastNotification>
   <NamingConvention>

      CAMEL_CASE_WITH_FIRST_LETTER_UPPERCASE

   </NamingConvention>
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   <NotificationEndPoint>a</NotificationEndPoint>
   <NotificationHttpMethod>DELETE</NotificationHttpMethod>
   <NumberOfFailuresSinceLastSuccess>

      0

   </NumberOfFailuresSinceLastSuccess>
   <UserId/>
</Data>

Sample Notification Payload
Below is a sample Amazon S3 target failure notification payload:
<Name>S3TargetFailureNotificationPayload</Name>
<Payload>
   <Date>2016-04-07T23:27:27.000Z</Date>

   <ErrorMessage>{text}</ErrorMessage>

   <NotificationGenerationDate/>

   <TargetId>9dea633e-f1bc-4ccd-9c5e-651bdae65f3c</TargetId>

   <Type>NOT_ONLINE</Type>
</Payload>

CREATE AZURE TARGET FAILURE NOTIFICATION
REGISTRATION

Description
Create a notification registration for Azure target failures.

Requests

Syntax
POST http[s]://{datapathDNSname}/_rest_/azure_target_failure_notification_

registration/?notification_end_point={string}[&format=DEFAULT|JSON|XML][&naming_

convention=CONCAT_LOWERCASE|CONSTANT|UNDERSCORED|CAMEL_CASE_WITH_FIRST_LETTER_

UPPERCASE|CAMEL_CASE_WITH_FIRST_LETTER_LOWERCASE][&notification_http_

method=POST|PUT]
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Request Parameters

Parameter Description Required

notification_
end_
point

The HTTP or HTTPS URL of a web server capable of receiving
notification messages from the BlackPearl gateway.

yes

format The format of the notification.
Values: DEFAULT (XML), JSON, XML

no

naming_
convention

The scheme used for naming within the notification sent. Values:
CONCAT_LOWERCASE, CONSTANT, UNDERSCORED, CAMEL_
CASE_WITH_FIRST_LETTER_UPPERCASE (default), CAMEL_CASE_
WITH_FIRST_LETTER_LOWERCASE

no

notification_
http_
method

The HTTP request method type used to send the notification.
Values: POST (default), PUT

no

Responses

Response Elements
<Data>

   <CreationDate>{YYYY-MM-DDThh:mm:ss.xxxZ}</CreationDate>

   <Format>DEFAULT|JSON|XML</Format>

   <Id>{string}</Id>

   <LastFailure>{string}</LastFailure>

   <LastHttpResponseCode>{32-bit integer}</LastHttpResponseCode>

   <LastNotification>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastNotification>

   <NamingConvention>

      CONCAT_LOWERCASE|CONSTANT|UNDERSCORED|

      CAMEL_CASE_WITH_FIRST_LETTER_UPPERCASE|

      CAMEL_CASE_WITH_FIRST_LETTER_LOWERCASE

   </NamingConvention>

   <NotificationEndPoint>{string}</NotificationEndPoint>

   <NotificationHttpMethod>POST|PUT</NotificationHttpMethod>

   <NumberOfFailuresSinceLastSuccess>

{32-bit integer}

   </NumberOfFailuresSinceLastSuccess>

   <UserId>{string}</UserId>

</Data>

April 2023 DS3 API Reference-Spectra BlackPearl Nearline Gateway
- 845 -



Chapter 17 - Notification Operations Create Azure Target Failure Notification Registration

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

CreationDate The date the notification registration was created in the
format YYYY-MM-DDThh:mm:ss.xxxZ.

Format The format of the notification.
Values: DEFAULT (XML), JSON, XML

ID The UUID for the notification.

LastFailure The exception message for the last failure to send a
notification to this notification registration.

LastHttpResponseCode The last response code returned by the notification end
point.

LastNotification Date and time of the last notification attempt by the
BlackPearl gateway.

NamingConvention The scheme used for naming within the notification sent.
Values: CONCAT_LOWERCASE, CONSTANT,
UNDERSCORED, CAMEL_CASE_WITH_FIRST_LETTER_
UPPERCASE, CAMEL_CASE_WITH_FIRST_LETTER_
LOWERCASE

NotificationEnd Point The HTTP or HTTPS URL of a web server capable of
receiving notification messages from the BlackPearl
gateway.

NotificationHttp Method The HTTP request method type. Values: POST (default),
PUT

NumberOfFailuresSinceLastSuccess Number of failed notification attempts since last
successful notification.

UserId The UUID for the user who created the notification
registration.
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Example

Sample Request
This request creates a registration for Azure target failure notifications to be sent to Azure-
client-hostname.
POST http://blackpearl-hostname/_rest_/azure_target_failure_notification_

registration/?notification_end_point=Azure-client-hostname HTTP/1.1

Sample Notification Payload
Below is a sample Azure target failure notification payload:
<Name>AzureTargetFailureNotificationPayload</Name>
<Payload>
   <Date>2016-04-07T23:27:27.000Z</Date>

   <ErrorMessage>{text}</ErrorMessage>

   <NotificationGenerationDate/>

   <TargetId>f42e7219-6285-4d39-801a-8987254e341e</TargetId>

   <Type>NOT_ONLINE</Type>
</Payload>

CREATE BUCKET CHANGE NOTIFICATION REGISTRATION

Description
Create a notification registration for bucket changes.

Requests

Syntax
POST http[s]://{datapathDNSname}/_rest_/bucket_change_notification_

registration/?notification_end_point={string}[&bucketID=

{string}&format=DEFAULT|JSON|XML][&naming_convention=CONCAT_

LOWERCASE|CONSTANT|UNDERSCORED|CAMEL_CASE_WITH_FIRST_LETTER_UPPERCASE|CAMEL_CASE_

WITH_FIRST_LETTER_LOWERCASE][&notification_http_method=POST|PUT]
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Request Parameters

Parameter Description Required

notification_
end_
point

The HTTP or HTTPS URL of a web server capable of receiving
notification messages from the BlackPearl gateway.

yes

bucketID The UUID for the bucket for which you want notifications. If not
included, notifications are sent for all buckets.

no

format The format of the notification.
Values: DEFAULT (XML), JSON, XML

no

naming_
convention

The scheme used for naming within the notification sent. Values:
CONCAT_LOWERCASE, CONSTANT, UNDERSCORED, CAMEL_
CASE_WITH_FIRST_LETTER_UPPERCASE (default), CAMEL_CASE_
WITH_FIRST_LETTER_LOWERCASE

no

notification_
http_
method

The HTTP request method type used to send the notification.
Values: POST (default), PUT

no

Responses

Response Elements
<Data>

   <CreationDate>{YYYY-MM-DDThh:mm:ss.xxxZ}</CreationDate>
   <BucketID>{string}</BucketID>

   <Format>DEFAULT|JSON|XML</Format>

   <Id>{string}</Id>

   <LastFailure>{string}</LastFailure>

   <LastHttpResponseCode>{32-bit integer}</LastHttpResponseCode>

   <LastNotification>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastNotification>
   <NamingConvention>

      CONCAT_LOWERCASE|CONSTANT|UNDERSCORED|

      CAMEL_CASE_WITH_FIRST_LETTER_UPPERCASE|

      CAMEL_CASE_WITH_FIRST_LETTER_LOWERCASE

   </NamingConvention>

   <NotificationEndPoint>{string}</NotificationEndPoint>
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   <NotificationHttpMethod>POST|PUT</NotificationHttpMethod>

   <NumberOfFailuresSinceLastSuccess>

{32-bit integer}

   </NumberOfFailuresSinceLastSuccess>

   <UserId>{string}</UserId>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

BucketID The UUID for the bucket for which notifications are sent.

CreationDate The date the notification registration was created in the
format YYYY-MM-DDThh:mm:ss.xxxZ.

Format The format of the notification.
Values: DEFAULT (XML), JSON, XML

ID The UUID for the notification.

LastFailure The exception message for the last failure to send a
notification to this notification registration.

LastHttpResponseCode The last response code returned by the notification end
point.

LastNotification Date and time of the last notification attempt by the
BlackPearl gateway.

NamingConvention The scheme used for naming within the notification sent.
Values: CONCAT_LOWERCASE, CONSTANT,
UNDERSCORED, CAMEL_CASE_WITH_FIRST_LETTER_
UPPERCASE, CAMEL_CASE_WITH_FIRST_LETTER_
LOWERCASE

NotificationEnd Point The HTTP or HTTPS URL of a web server capable of
receiving notification messages from the BlackPearl
gateway.

NotificationHttp Method The HTTP request method type. Values: POST (default),
PUT

NumberOfFailuresSinceLastSuccess Number of failed notification attempts since last
successful notification.
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Parameter Description

UserId The UUID for the user who created the notification
registration.

Example

Sample Request
This request creates a registration for a bucket with the UUID 0e8e91ab-a622-4fe3-9e3c-
7696d9fba7cd to be sent to an end point named Azure-client-hostname.
POST http://blackpearl-hostname/_rest_/bucket_change_notification_

registrationn/?notification_end_point=Azure-client-hostname&bucketID=0e8e91ab-a622-

4fe3-9e3c-7696d9fba7cd HTTP/1.1

Sample Notification Payload
Below is a sample bucket change notification payload:
<Name>BucketChangesNotificationPayload</Name>
<Payload>

   <Changes>

      <BucketId>0e8e91ab-a622-4fe3-9e3c-7696d9fba7cd</BucketId>

      <Id>8282153d-8c51-476f-9654-56c1f6ae0035</Id>

      <ObjectName>o1</ObjectName>

      <SequenceNumber>1</SequenceNumber>

      <Type>CREATE</Type>

      <VersionId>567ce05b-bbd1-4afd-85f5-416d793027cb</VersionId>

   </Changes>
   <Changes>

      <BucketId>0e8e91ab-a622-4fe3-9e3c-7696d9fba7cd</BucketId>

      <Id>bd195b2d-0b6c-40cf-ac9a-c93b674a44e9</Id>

      <ObjectName>o1</ObjectName>

      <SequenceNumber>2</SequenceNumber>

      <Type>MARK_LATEST</Type>

      <VersionId>049dffae-30f9-41c8-be68-28c1e3688fe4</VersionId>

   </Changes>
   <LastProcessedEvent>0</LastProcessedEvent>

   <NotificationGenerationDate/>

</Payload>
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CREATE DS3 TARGET FAILURE NOTIFICATION
REGISTRATION

Description
Create a notification registration for DS3 target failures.

Requests

Syntax
POST http[s]://{datapathDNSname}/_rest_/ds3_target_failure_notification_

registration/?notification_end_point={string}[&format=DEFAULT|JSON|XML][&naming_

convention=CONCAT_LOWERCASE|CONSTANT|UNDERSCORED|CAMEL_CASE_WITH_FIRST_LETTER_

UPPERCASE|CAMEL_CASE_WITH_FIRST_LETTER_LOWERCASE][&notification_http_

method=POST|PUT]

Request Parameters

Parameter Description Required

notification_
end_
point

The HTTP or HTTPS URL of a web server capable of receiving
notification messages from the BlackPearl gateway.

yes

format The format of the notification.
Values: DEFAULT (XML), JSON, XML

no

naming_
convention

The scheme used for naming within the notification sent. Values:
CONCAT_LOWERCASE, CONSTANT, UNDERSCORED, CAMEL_
CASE_WITH_FIRST_LETTER_UPPERCASE (default), CAMEL_CASE_
WITH_FIRST_LETTER_LOWERCASE

no

notification_
http_
method

The HTTP request method type used to send the notification.
Values: POST (default), PUT

no
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Responses

Response Elements
<Data>

   <CreationDate>{YYYY-MM-DDThh:mm:ss.xxxZ}</CreationDate>

   <Format>DEFAULT|JSON|XML</Format>

   <Id>{string}</Id>

   <LastFailure>{string}</LastFailure>

   <LastHttpResponseCode>{32-bit integer}</LastHttpResponseCode>

   <LastNotification>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastNotification>
   <NamingConvention>

      CONCAT_LOWERCASE|CONSTANT|UNDERSCORED|

      CAMEL_CASE_WITH_FIRST_LETTER_UPPERCASE|

      CAMEL_CASE_WITH_FIRST_LETTER_LOWERCASE

   </NamingConvention>
   <NotificationEndPoint>{string}</NotificationEndPoint>

   <NotificationHttpMethod>POST|PUT</NotificationHttpMethod>

   <NumberOfFailuresSinceLastSuccess>

{32-bit integer}

   </NumberOfFailuresSinceLastSuccess>

   <UserId>{string}</UserId>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

CreationDate The date the notification registration was created in the
format YYYY-MM-DDThh:mm:ss.xxxZ.

Format The format of the notification.
Values: DEFAULT (XML), JSON, XML

ID The UUID for the notification.

LastFailure The exception message for the last failure to send a
notification to this notification registration.

LastHttpResponseCode The last response code returned by the notification end
point.
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Parameter Description

LastNotification Date and time of the last notification attempt by the
BlackPearl gateway.

NamingConvention The scheme used for naming within the notification sent.
Values: CONCAT_LOWERCASE, CONSTANT,
UNDERSCORED, CAMEL_CASE_WITH_FIRST_LETTER_
UPPERCASE, CAMEL_CASE_WITH_FIRST_LETTER_
LOWERCASE

NotificationEnd Point The HTTP or HTTPS URL of a web server capable of
receiving notification messages from the BlackPearl
gateway.

NotificationHttp Method The HTTP request method type. Values: POST (default),
PUT

NumberOfFailuresSinceLastSuccess Number of failed notification attempts since last
successful notification.

UserId The UUID for the user who created the notification
registration.

Example

Sample Request
This request creates a registration for DS3 target failure notifications to be sent to Spectra-
DS3-client-hostname.
POST http://blackpearl-hostname/_rest_/ds3_target_failure_notification_

registration/?notification_end_point=Spectra-DS3-client-hostname HTTP/1.1

Sample Notification Payload
Below is a sample DS3 target failure notification payload:
<Name>Ds3TargetFailureNotificationPayload</Name>
<Payload>
   <Date>2016-04-07T23:27:27.000Z</Date>

   <ErrorMessage>{text}</ErrorMessage>

   <NotificationGenerationDate/>

   <TargetId>85f02c30-4f83-41b0-ba2f-01308be3ece6</TargetId>

   <Type>NOT_ONLINE</Type>
</Payload>
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CREATE JOB COMPLETED NOTIFICATION REGISTRATION

Description
Create a notification registration for job completed events.

Requests

Syntax
POST http[s]://{datapathDNSname}/_rest_/job_completed_notification_

registration/?notification_end_point={string}[&format=DEFAULT|JSON|XML][&job_id=

{string}][&naming_convention=CONCAT_LOWERCASE|CONSTANT|UNDERSCORED|CAMEL_CASE_WITH_

FIRST_LETTER_UPPERCASE|CAMEL_CASE_WITH_FIRST_LETTER_LOWERCASE][&notification_http_

method=POST|PUT]

Request Parameters

Parameter Description Required

notification_
end_
point

The HTTP or HTTPS URL of a web server capable of receiving
notification messages from the BlackPearl gateway.

yes

format The format of the notification.
Values: DEFAULT (XML), JSON, XML

no

job_id The UUID or a unique attribute for the job. If not included,
notifications are sent for all jobs.

no

naming_
convention

The scheme used for naming within the notification sent. Values:
CONCAT_LOWERCASE, CONSTANT, UNDERSCORED, CAMEL_
CASE_WITH_FIRST_LETTER_UPPERCASE (default), CAMEL_CASE_
WITH_FIRST_LETTER_LOWERCASE

no

notification_
http_
method

The HTTP request method type used to send the notification.
Values: POST (default), PUT

no
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Responses

Response Elements
<Data>

   <CreationDate>{YYYY-MM-DDThh:mm:ss.xxxZ}</CreationDate>

   <Format>DEFAULT|JSON|XML</Format>

   <Id>{string}</Id>

   <JobId>{string}</JobId>
   <LastFailure>{string}</LastFailure>

   <LastHttpResponseCode>{32-bit integer}</LastHttpResponseCode>

   <LastNotification>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastNotification>

   <NamingConvention>

      CONCAT_LOWERCASE|CONSTANT|UNDERSCORED|

      CAMEL_CASE_WITH_FIRST_LETTER_UPPERCASE|

      CAMEL_CASE_WITH_FIRST_LETTER_LOWERCASE

   </NamingConvention>

   <NotificationEndPoint>{string}</NotificationEndPoint>

   <NotificationHttpMethod>POST|PUT</NotificationHttpMethod>

   <NumberOfFailuresSinceLastSuccess>

{32-bit integer}

   </NumberOfFailuresSinceLastSuccess>

   <UserId>{string}</UserId>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

CreationDate The date the notification registration was created in the
format YYYY-MM-DDThh:mm:ss.xxxZ.

Format The format of the notification.
Values: DEFAULT (XML), JSON, XML

ID The UUID for the notification.

JobId The UUID for the job that completed.

LastFailure The exception message for the last failure to send a
notification to this notification registration.
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Parameter Description

LastHttpResponseCode The last response code returned by the notification end
point.

LastNotification Date and time of the last notification attempt by the
BlackPearl gateway.

NamingConvention The scheme used for naming within the notification sent.
Values: CONCAT_LOWERCASE, CONSTANT,
UNDERSCORED, CAMEL_CASE_WITH_FIRST_LETTER_
UPPERCASE, CAMEL_CASE_WITH_FIRST_LETTER_
LOWERCASE

NotificationEnd Point The HTTP or HTTPS URL of a web server capable of
receiving notification messages from the BlackPearl
gateway.

NotificationHttp Method The HTTP request method type. Values: POST, PUT

NumberOfFailuresSinceLastSuccess Number of failed notification attempts since last
successful notification.

UserId The UUID for the user who created the notification
registration.

Example

Sample Request
This request creates a registration for job completed notifications to be sent to DS3-client-
hostname.
POST http://blackpearl-hostname/_rest_/job_completed_notification_

registration/?notification_end_point=DS3-client-hostname HTTP/1.1
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Sample Response
HTTP/1.1 201 CREATED

<Data>

   <CreationDate>2014-10-02T11:40:25.683Z</CreationDate>

   <Format>DEFAULT</Format>

   <Id>e2ae9bc2-d70e-46d4-9af7-82d971827cb8</Id>

   <JobId/>

   <LastFailure/>

   <LastHttpResponseCode/>

   <LastNotification/>

   <NamingConvention>

      CAMEL_CASE_WITH_FIRST_LETTER_UPPERCASE

   </NamingConvention>

   <NotificationEndPoint>

      DS3-client-hostname

   </NotificationEndPoint>

   <NotificationHttpMethod>POST</NotificationHttpMethod>

   <NumberOfFailuresSinceLastSuccess>

      0

   </NumberOfFailuresSinceLastSuccess>

   <UserId>2bb8b755-857b-4eec-91cd-cef188f55aac</UserId>

</Data>

Sample Notification Payload
Below is a sample job completed notification payload:
<Name>JobCompletedNotificationPayload</Name>
<Payload>
   <CancelOccurred>TRUE</CancelOccurred>

   <JobId>d7f5e47c-fbe6-4067-b834-9f829f150333</JobId>

   <NotificationGenerationDate/>

   <ObjectsNotPersisted>

      <Object Id="6d0c304e-8609-4f69-8e57-ad61787c2172"

      Latest="true" Length="10" Name="o1" Offset="0"

      VersionId="7ee8bd7a-b883-4100-ad2b-13440a44f200"/>

      <Object Id="628a1df8-d440-4caf-9e31-089b95b5cbe7"

      Latest="true" Length="10" Name="o1" Offset="0"

      VersionId="01a33693-ba75-4668-a2c9-89fa423b219f"/>

   </ObjectsNotPersisted>
</Payload>
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CREATE JOB CREATED NOTIFICATION REGISTRATION

Description
Create a notification registration for job created events.

Requests

Syntax
POST http[s]://{datapathDNSname}/_rest_/job_created_notification_

registration/?notification_end_point={string}[&format=DEFAULT|JSON|XML][&naming_

convention=CONCAT_LOWERCASE|CONSTANT|UNDERSCORED|CAMEL_CASE_WITH_FIRST_LETTER_

UPPERCASE|CAMEL_CASE_WITH_FIRST_LETTER_LOWERCASE][&notification_http_

method=POST|PUT]

Request Parameters

Parameter Description Required

notification_
end_
point

The HTTP or HTTPS URL of a web server capable of receiving
notification messages from the BlackPearl gateway.

yes

format The format of the notification.
Values: DEFAULT (XML), JSON, XML

no

naming_
convention

The scheme used for naming within the notification sent. Values:
CONCAT_LOWERCASE, CONSTANT, UNDERSCORED, CAMEL_
CASE_WITH_FIRST_LETTER_UPPERCASE (default), CAMEL_CASE_
WITH_FIRST_LETTER_LOWERCASE

no

notification_
http_
method

The HTTP request method type used to send the notification.
Values: POST (default), PUT

no
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Responses

Response Elements
<Data>

   <CreationDate>{YYYY-MM-DDThh:mm:ss.xxxZ}</CreationDate>

   <Format>DEFAULT|JSON|XML</Format>

   <Id>{string}</Id>

   <LastFailure>{string}</LastFailure>

   <LastHttpResponseCode>{32-bit integer}</LastHttpResponseCode>

   <LastNotification>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastNotification>
   <NamingConvention>

      CONCAT_LOWERCASE|CONSTANT|UNDERSCORED|

      CAMEL_CASE_WITH_FIRST_LETTER_UPPERCASE|

      CAMEL_CASE_WITH_FIRST_LETTER_LOWERCASE

   </NamingConvention>
   <NotificationEndPoint>{string}</NotificationEndPoint>

   <NotificationHttpMethod>POST|PUT</NotificationHttpMethod>

   <NumberOfFailuresSinceLastSuccess>

{32-bit integer}

   </NumberOfFailuresSinceLastSuccess>

   <UserId>{string}</UserId>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

CreationDate The date the notification registration was created in the
format YYYY-MM-DDThh:mm:ss.xxxZ.

Format The format of the notification.
Values: DEFAULT (XML), JSON, XML

ID The UUID for the notification.

LastFailure The exception message for the last failure to send a
notification to this notification registration.

LastHttpResponseCode The last response code returned by the notification end
point.
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Parameter Description

LastNotification Date and time of the last notification attempt by the
BlackPearl gateway.

NamingConvention The scheme used for naming within the notification sent.
Values: CONCAT_LOWERCASE, CONSTANT,
UNDERSCORED, CAMEL_CASE_WITH_FIRST_LETTER_
UPPERCASE, CAMEL_CASE_WITH_FIRST_LETTER_
LOWERCASE

NotificationEnd Point The HTTP or HTTPS URL of a web server capable of
receiving notification messages from the BlackPearl
gateway.

NotificationHttp Method The HTTP request method type. Values: POST, PUT

NumberOfFailuresSinceLastSuccess Number of failed notification attempts since last
successful notification.

UserId The UUID for The UUID for the user who created the
notification registration.

Example

Sample Request
This request creates a registration for job created notifications to be sent to DS3-client-
hostname.
POST http://blackpearl-hostname/_rest_/job_created_notification_

registration/?notification_end_point=DS3-client-hostname HTTP/1.1

Sample Response
HTTP/1.1 201 CREATED

<Data>

   <CreationDate>2014-10-02T11:40:25.983Z</CreationDate>

   <Format>DEFAULT</Format>

   <Id>dfe027c8-e3ba-4e8a-a484-66d5577d5040</Id>

   <LastFailure/>

   <LastHttpResponseCode/>

   <LastNotification/>
   <NamingConvention>

      CAMEL_CASE_WITH_FIRST_LETTER_UPPERCASE

   </NamingConvention>
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   <NotificationEndPoint>

      DS3-client-hostname

   </NotificationEndPoint>
   <NotificationHttpMethod>POST</NotificationHttpMethod>

   <NumberOfFailuresSinceLastSuccess>

      0

   </NumberOfFailuresSinceLastSuccess>

   <UserId/>

</Data>

Sample Notification Payload
Below is a sample job created notification payload:
<Name>JobCreatedNotificationPayload</Name>
<Payload>
   <JobId>dd4a2196-0255-489d-8706-ae5ffe1335e8</JobId>

   <NotificationGenerationDate/>
</Payload>

CREATE JOB CREATION FAILED NOTIFICATION
REGISTRATION

Description
Create a notification registration for job creation failures.

Requests

Syntax
POST http[s]://{datapathDNSname}/_rest_/job_creation_failed_notification_

registration/?notification_end_point={string}[&format=DEFAULT|JSON|XML][&naming_

convention=CONCAT_LOWERCASE|CONSTANT|UNDERSCORED|CAMEL_CASE_WITH_FIRST_LETTER_

UPPERCASE|CAMEL_CASE_WITH_FIRST_LETTER_LOWERCASE][&notification_http_

method=POST|PUT]
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Request Parameters

Parameter Description Required

notification_
end_
point

The HTTP or HTTPS URL of a web server capable of receiving
notification messages from the BlackPearl gateway.

yes

format The format of the notification.
Values: DEFAULT (XML), JSON, XML

no

naming_
convention

The scheme used for naming within the notification sent. Values:
CONCAT_LOWERCASE, CONSTANT, UNDERSCORED, CAMEL_
CASE_WITH_FIRST_LETTER_UPPERCASE (default), CAMEL_CASE_
WITH_FIRST_LETTER_LOWERCASE

no

notification_
http_
method

The HTTP request method type used to send the notification.
Values: POST (default), PUT

no

Responses

Response Elements
<Data>

   <CreationDate>{YYYY-MM-DDThh:mm:ss.xxxZ}</CreationDate>

   <Format>DEFAULT|JSON|XML</Format>

   <Id>{string}</Id>

   <LastFailure>{string}</LastFailure>

   <LastHttpResponseCode>{32-bit integer}</LastHttpResponseCode>

   <LastNotification>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastNotification>
   <NamingConvention>

      CONCAT_LOWERCASE|CONSTANT|UNDERSCORED|

      CAMEL_CASE_WITH_FIRST_LETTER_UPPERCASE|

      CAMEL_CASE_WITH_FIRST_LETTER_LOWERCASE

   </NamingConvention>
   <NotificationEndPoint>{string}</NotificationEndPoint>

   <NotificationHttpMethod>POST|PUT</NotificationHttpMethod>

   <NumberOfFailuresSinceLastSuccess>

{32-bit integer}

   </NumberOfFailuresSinceLastSuccess>

   <UserId>{string}</UserId>

</Data>
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where the response elements are defined as follows:

Parameter Description

Data The container for the response.

CreationDate The date the notification registration was created in the
format YYYY-MM-DDThh:mm:ss.xxxZ.

Format The format of the notification.
Values: DEFAULT (XML), JSON, XML

ID The UUID for the notification.

LastFailure The exception message for the last failure to send a
notification to this notification registration.

LastHttpResponseCode The last response code returned by the notification end
point.

LastNotification Date and time of the last notification attempt by the
BlackPearl gateway.

NamingConvention The scheme used for naming within the notification sent.
Values: CONCAT_LOWERCASE, CONSTANT,
UNDERSCORED, CAMEL_CASE_WITH_FIRST_LETTER_
UPPERCASE, CAMEL_CASE_WITH_FIRST_LETTER_
LOWERCASE

NotificationEnd Point The HTTP or HTTPS URL of a web server capable of
receiving notification messages from the BlackPearl
gateway.

NotificationHttp Method The HTTP request method type. Values: POST, PUT

NumberOfFailuresSinceLastSuccess Number of failed notification attempts since last
successful notification.

UserId The UUID for The UUID for the user who created the
notification registration.
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Example

Sample Request
This request creates a registration for job creation failed notifications to be sent to DS3-client-
hostname.
POST http://blackpearl-hostname/_rest_/job_creation_failed_notification_

registration/?notification_end_point=DS3-client-hostname HTTP/1.1

Sample Response
HTTP/1.1 201 CREATED

<Data>

   <CreationDate>2016-06-09T01:14:48.000Z</CreationDate>

   <Format>DEFAULT</Format>

   <Id>76454453-4969-419d-99d3-96fa533760ad</Id>

   <LastFailure/>

   <LastHttpResponseCode/>

   <LastNotification/>
   <NamingConvention>

      CAMEL_CASE_WITH_FIRST_LETTER_UPPERCASE

   </NamingConvention>

   <NotificationEndPoint>

      DS3-client-hostname

   </NotificationEndPoint>
   <NotificationHttpMethod>POST</NotificationHttpMethod>

   <NumberOfFailuresSinceLastSuccess>

      0

   </NumberOfFailuresSinceLastSuccess>

   <UserId/>

</Data>

Sample Notification Payload
Below is a sample job creation failed notification payload:
<Name>JobCreationFailedNotificationPayload</Name>
<Payload>
   <NotificationGenerationDate/>

   <TapesMustBeOnlined>

   <TapesToOnline>

         <TapeBarCodes>018616L6</TapeBarCodes>

         <TapeBarCodes>138271L6</TapeBarCodes>

   </TapesToOnline>
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   </TapesMustBeOnlined>

   <UserName>Test</UserName>

   <ErrorMessage/>

</Payload>

CREATE OBJECT CACHED NOTIFICATION REGISTRATION

Description
Create a notification registration for object cached events.

Requests

Syntax
POST http[s]://{datapathDNSname}/_rest_/object_cached_notification_

registration/?notification_end_point={string}[&format=DEFAULT|JSON|XML][&job_id=

{string}][&naming_convention=CONCAT_LOWERCASE|CONSTANT|UNDERSCORED|CAMEL_CASE_WITH_

FIRST_LETTER_UPPERCASE|CAMEL_CASE_WITH_FIRST_LETTER_LOWERCASE][&notification_http_

method=POST|PUT]

Request Parameters

Parameter Description Required

notification_
end_
point

The HTTP or HTTPS URL of a web server capable of receiving
notification messages from the BlackPearl gateway.

yes

format The format of the notification.
Values: DEFAULT (XML), JSON, XML

no

job_id The UUID or a unique attribute for the job. If not included,
notifications are sent for all jobs.

no

naming_
convention

The scheme used for naming within the notification sent. Values:
CONCAT_LOWERCASE, CONSTANT, UNDERSCORED, CAMEL_
CASE_WITH_FIRST_LETTER _UPPERCASE (default), CAMEL_CASE_
WITH_FIRST_LETTER_LOWERCASE

no

notification_
http_
method

The HTTP request method type used to send the notification.
Values: POST (default), PUT

no
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Responses

Response Elements
<Data>

   <CreationDate>{YYYY-MM-DDThh:mm:ss.xxxZ}</CreationDate>

   <Format>DEFAULT|JSON|XML</Format>

   <Id>{string}</Id>

   <JobId>{string}</JobId>

   <LastFailure>{string}</LastFailure>

   <LastHttpResponseCode>{32-bit integer}</LastHttpResponseCode>

   <LastNotification>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastNotification>

   <NamingConvention>

      CONCAT_LOWERCASE|CONSTANT|UNDERSCORED|

      CAMEL_CASE_WITH_FIRST_LETTER_UPPERCASE|

      CAMEL_CASE_WITH_FIRST_LETTER_LOWERCASE

   </NamingConvention>

   <NotificationEndPoint>{string}</NotificationEndPoint>

   <NotificationHttpMethod>POST|PUT</NotificationHttpMethod>

   <NumberOfFailuresSinceLastSuccess>

{32-bit integer}

   </NumberOfFailuresSinceLastSuccess>

   <UserId>{string}</UserId>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

CreationDate The date the notification registration was created in the
format YYYY-MM-DDThh:mm:ss.xxxZ.

Format The format of the notification.
Values: DEFAULT (XML), JSON, XML

ID The UUID for the notification.

JobId The UUID for the job that cached the object.

LastFailure The exception message for the last failure to send a
notification to this notification registration.
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Parameter Description

LastHttpResponseCode The last response code returned by the notification end
point.

LastNotification Date and time of the last notification attempt by the
BlackPearl gateway.

NamingConvention The scheme used for naming within the notification sent.
Values: CONCAT_LOWERCASE, CONSTANT,
UNDERSCORED, CAMEL_CASE_WITH_FIRST_LETTER_
UPPERCASE, CAMEL_CASE_WITH_FIRST_LETTER_
LOWERCASE

NotificationEnd Point The HTTP or HTTPS URL of a web server capable of
receiving notification messages from the BlackPearl
gateway.

NotificationHttp Method The HTTP request method type. Values: POST, PUT

NumberOfFailuresSinceLastSuccess Number of failed notification attempts since last
successful notification.

UserId The UUID for the user who created the notification
registration.

Example

Sample Request
This request creates a registration for object cached notifications to be sent to DS3-client-
hostname.
POST http://blackpearl-hostname/_rest_/object_cached_notification_

registration/?notification_end_point=DS3-client-hostname HTTP/1.1
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Sample Response
HTTP/1.1 201 CREATED

<Data>

   <CreationDate>2014-10-16T18:33:47.522Z</CreationDate>

   <Format>DEFAULT</Format>

   <Id>b7ed9175-aeb5-4cee-a696-0c858382453f</Id>

   <JobId/>

   <LastFailure/>

   <LastHttpResponseCode/>

   <LastNotification/>

   <NamingConvention>

      CAMEL_CASE_WITH_FIRST_LETTER_UPPERCASE

   </NamingConvention>

   <NotificationEndPoint>

      DS3-client-hostname

   </NotificationEndPoint>

   <NotificationHttpMethod>POST</NotificationHttpMethod>

   <NumberOfFailuresSinceLastSuccess>

      0

   </NumberOfFailuresSinceLastSuccess>

   <UserId/>

</Data>

Sample Notification Payload
Below is a sample objects cached notification payload:
<Name>S3ObjectsCachedNotificationPayload</Name>
<Payload>
   <JobId>f2f5296b-4d93-45f7-a03b-a3161553003f</JobId>

   <NotificationGenerationDate/>

   <Objects>

      <Object Id="f7b3b9b1-6cc5-4ba4-89e8-6138bba2af8b"

      Latest="true" Length="100" Name="o1" Offset="0"

      VersionId="01a33693-ba75-4668-a2c9-89fa423b219f">
      <Object Id="60b51e5f-2218-4c63-affa-450cd2da7a79"

      Latest="true" Length="100" Name="o2" Offset="0"

      VersionId="7ee8bd7a-b883-4100-ad2b-13440a44f200">

   </Objects>
</Payload>
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CREATE OBJECT LOST NOTIFICATION REGISTRATION

Description
Create a notification registration for object lost events.

Requests

Syntax
POST http[s]://{datapathDNSname}/_rest_/object_lost_notification_

registration/?notification_end_point={string}[&format=DEFAULT|JSON|XML][&naming_

convention=CONCAT_LOWERCASE|CONSTANT|UNDERSCORED|CAMEL_CASE_WITH_FIRST_LETTER_

UPPERCASE|CAMEL_CASE_WITH_FIRST_LETTER_LOWERCASE][&notification_http_

method=POST|PUT]

Request Parameters

Parameter Description Required

notification_
end_
point

The HTTP or HTTPS URL of a web server capable of receiving
notification messages from the BlackPearl gateway.

yes

format The format of the notification.
Values: DEFAULT (XML), JSON, XML

no

naming_
convention

The scheme used for naming within the notification sent. Values:
CONCAT_LOWERCASE, CONSTANT, UNDERSCORED, CAMEL_
CASE_WITH_FIRST_LETTER _UPPERCASE (default), CAMEL_CASE_
WITH_FIRST_LETTER_LOWERCASE

no

notification_
http_
method

The HTTP request method type used to send the notification.
Values: POST (default), PUT

no
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Responses

Response Elements
<Data>

   <CreationDate>{YYYY-MM-DDThh:mm:ss.xxxZ}</CreationDate>

   <Format>DEFAULT|JSON|XML</Format>

   <Id>{string}</Id>

   <LastFailure>{string}</LastFailure>

   <LastHttpResponseCode>{32-bit integer}</LastHttpResponseCode>

   <LastNotification>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastNotification>

   <NamingConvention>

      CONCAT_LOWERCASE|CONSTANT|UNDERSCORED|

      CAMEL_CASE_WITH_FIRST_LETTER_UPPERCASE|

      CAMEL_CASE_WITH_FIRST_LETTER_LOWERCASE

   </NamingConvention>

   <NotificationEndPoint>{string}</NotificationEndPoint>

   <NotificationHttpMethod>POST|PUT</NotificationHttpMethod>

   <NumberOfFailuresSinceLastSuccess>

{32-bit integer}

   </NumberOfFailuresSinceLastSuccess>

   <UserId>{string}</UserId>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

CreationDate The date the notification registration was created in the
format YYYY-MM-DDThh:mm:ss.xxxZ.

Format The format of the notification.
Values: DEFAULT (XML), JSON, XML

ID The UUID for the notification.

LastFailure The exception message for the last failure to send a
notification to this notification registration.

LastHttpResponseCode The last response code returned by the notification end
point.
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Parameter Description

LastNotification Date and time of the last notification attempt by the
BlackPearl gateway.

NamingConvention The scheme used for naming within the notification sent.
Values: CONCAT_LOWERCASE, CONSTANT,
UNDERSCORED, CAMEL_CASE_WITH_FIRST_LETTER_
UPPERCASE, CAMEL_CASE_WITH_FIRST_LETTER_
LOWERCASE

NotificationEnd Point The HTTP or HTTPS URL of a web server capable of
receiving notification messages from the BlackPearl
gateway.

NotificationHttp Method The HTTP request method type. Values: POST, PUT

NumberOfFailuresSinceLastSuccess Number of failed notification attempts since last
successful notification.

UserId The UUID for the user who created the notification
registration.

Example

Sample Request
This request creates a registration for object lost notifications to be sent to DS3-client-
hostname.
POST http://blackpearl-hostname/_rest_/object_lost_notification_

registration/?notification_end_point=DS3-client-hostname HTTP/1.1
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Sample Response
HTTP/1.1 201 CREATED

<Data>

   <CreationDate>2014-10-02T11:40:32.265Z</CreationDate>

   <Format>DEFAULT</Format>

   <Id>aa663b70-878a-4d96-a1ee-6dd5a004e185</Id>

   <LastFailure/>

   <LastHttpResponseCode/>

   <LastNotification/>

   <NamingConvention>

      CAMEL_CASE_WITH_FIRST_LETTER_UPPERCASE

   </NamingConvention>

   <NotificationEndPoint>

      DS3-client-hostname

   </NotificationEndPoint>

   <NotificationHttpMethod>POST</NotificationHttpMethod>

   <NumberOfFailuresSinceLastSuccess>

      0

   </NumberOfFailuresSinceLastSuccess>

   <UserId/>

</Data>

Sample Notification Payload
Below is a sample object lost notification payload:
<Name>S3ObjectsLostNotificationPayload</Name>
<Payload>
   <NotificationGenerationDate/>

   <Objects>

      <Object Bucket="bucket"

         Id="07c0da3d-73ce-4ca1-b987-e3b55f83dbb7"

         Latest="true" Length="100" Name="o1" Offset="0"

         VersionId="7ee8bd7a-b883-4100-ad2b-13440a44f200">
      <Object Bucket="bucket"

         Id="d95fb8d7-8dc0-4a4d-b85d-eb7c31e0da42"

         Latest="true" Length="100" Name="o1" Offset="0"

         VersionId="7ee8bd7a-b883-4100-ad2b-13440a44f200">

   </Objects>
</Payload>
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CREATE OBJECT PERSISTED NOTIFICATION REGISTRATION

Description
Create a notification registration for object persisted events.

Requests

Syntax
POST http[s]://{datapathDNSname}/_rest_/object_persisted_notification_

registration/?notification_end_point={string}[&format=DEFAULT|JSON|XML][&job_id=

{string}][&naming_convention=CONCAT_LOWERCASE|CONSTANT|UNDERSCORED|CAMEL_CASE_WITH_

FIRST_LETTER_UPPERCASE|CAMEL_CASE_WITH_FIRST_LETTER_LOWERCASE][&notification_http_

method=POST|PUT]

Request Parameters

Parameter Description Required

notification_
end_
point

The HTTP or HTTPS URL of a web server capable of receiving
notification messages from the BlackPearl gateway.

yes

format The format of the notification.
Values: DEFAULT (XML), JSON, XML

no

job_id The UUID or a unique attribute for the job. If not included,
notifications are sent for all jobs.

naming_
convention

The scheme used for naming within the notification sent. Values:
CONCAT_LOWERCASE, CONSTANT, UNDERSCORED, CAMEL_
CASE_WITH_FIRST_LETTER _UPPERCASE (default), CAMEL_CASE_
WITH_FIRST_LETTER_LOWERCASE

no

notification_
http_
method

The HTTP request method type used to send the notification.
Values: POST (default), PUT

no
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Responses

Response Elements
<Data>

   <CreationDate>{YYYY-MM-DDThh:mm:ss.xxxZ}</CreationDate>

   <Format>DEFAULT|JSON|XML</Format>

   <Id>{string}</Id>

   <JobId>{string}</JobId>

   <LastFailure>{string}</LastFailure>

   <LastHttpResponseCode>{32-bit integer}</LastHttpResponseCode>

   <LastNotification>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastNotification>

   <NamingConvention>

      CONCAT_LOWERCASE|CONSTANT|UNDERSCORED|

      CAMEL_CASE_WITH_FIRST_LETTER_UPPERCASE|

      CAMEL_CASE_WITH_FIRST_LETTER_LOWERCASE

   </NamingConvention>

   <NotificationEndPoint>{string}</NotificationEndPoint>

   <NotificationHttpMethod>POST|PUT</NotificationHttpMethod>

   <NumberOfFailuresSinceLastSuccess>

{32-bit integer}

   </NumberOfFailuresSinceLastSuccess>

   <UserId>{string}</UserId>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

CreationDate The date the notification registration was created in the
format YYYY-MM-DDThh:mm:ss.xxxZ.

Format The format of the notification.
Values: DEFAULT (XML), JSON, XML

ID The UUID for the notification.

JobId The UUID for the job that wrote the object.

LastFailure The exception message for the last failure to send a
notification to this notification registration.
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Parameter Description

LastHttpResponseCode The last response code returned by the notification end
point.

LastNotification Date and time of the last notification attempt by the
BlackPearl gateway.

NamingConvention The scheme used for naming within the notification sent.
Values: CONCAT_LOWERCASE, CONSTANT,
UNDERSCORED, CAMEL_CASE_WITH_FIRST_LETTER_
UPPERCASE, CAMEL_CASE_WITH_FIRST_LETTER_
LOWERCASE

NotificationEnd Point The HTTP or HTTPS URL of a web server capable of
receiving notification messages from the BlackPearl
gateway.

NotificationHttp Method The HTTP request method type. Values: POST, PUT

NumberOfFailuresSinceLastSuccess Number of failed notification attempts since last
successful notification.

UserId The UUID for the user who created the notification
registration.

Example

Sample Request
This request creates a registration for object persisted notifications to be sent to DS3-client-
hostname.
POST http://blackpearl-hostname/_rest_/object_persisted_notification_

registration/?notification_end_point=DS3-client-hostname HTTP/1.1
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Sample Response
HTTP/1.1 201 CREATED

<Data>

   <CreationDate>2014-10-02T11:40:19.821Z</CreationDate>

   <Format>DEFAULT</Format>

   <Id>9c94de0f-a8c5-454f-abcb-f3ee47c9d8b1</Id>

   <JobId/>

   <LastFailure/>

   <LastHttpResponseCode/>

   <LastNotification/>

   <NamingConvention>

      CAMEL_CASE_WITH_FIRST_LETTER_UPPERCASE

   </NamingConvention>

   <NotificationEndPoint>

      DS3-client-hostname

   </NotificationEndPoint>

   <NotificationHttpMethod>POST</NotificationHttpMethod>

   <NumberOfFailuresSinceLastSuccess>

      0

   </NumberOfFailuresSinceLastSuccess>

   <UserId/>

</Data>

Sample Notification Payload
Below is a sample object persisted notification payload:
<Name>S3ObjectsPersistedNotificationPayload</Name>
<Payload>
   <JobId>4eabeacb-af9d-45bd-93aa-6a1ed98309ba</JobId>

   <NotificationGenerationDate/>

   <Objects>

      <Object Id="7e0de092-edf1-4027-a342-a13361ccc5f"

         Latest="true" Length="100" Name="o1" Offset="0"

         VersionId="7ee8bd7a-b883-4100-ad2b-13440a44f200">

      <Object Id="42039297-1c10-476d-a4ba-316cdab667e5"

         Latest="true" Length="100" Name="o1" Offset="0"

         VersionId="7ee8bd7a-b883-4100-ad2b-13440a44f200">

</Payload>
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CREATE POOL FAILURE NOTIFICATION REGISTRATION

Description
Create a notification registration for pool failure events.

Requests

Syntax
POST http[s]://{datapathDNSname}/_rest_/pool_failure_notification_

registration/?notification_end_point={string}[&format=DEFAULT|JSON|XML][&naming_

convention=CONCAT_LOWERCASE|CONSTANT|UNDERSCORED|CAMEL_CASE_WITH_FIRST_LETTER_

UPPERCASE|CAMEL_CASE_WITH_FIRST_LETTER_LOWERCASE][&notification_http_

method=POST|PUT]

Request Parameters

Parameter Description Required

notification_
end_
point

The HTTP or HTTPS URL of a web server capable of receiving
notification messages from the BlackPearl gateway.

yes

format The format of the notification.
Values: DEFAULT (XML), JSON, XML

no

naming_
convention

The scheme used for naming within the notification sent. Values:
CONCAT_LOWERCASE, CONSTANT, UNDERSCORED, CAMEL_
CASE_WITH_FIRST_LETTER_UPPERCASE (default), CAMEL_CASE_
WITH_FIRST_LETTER_LOWERCASE

no

notification_
http_
method

The HTTP request method type used to send the notification.
Values: POST (default), PUT

no
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Responses

Response Elements
<Data>

   <CreationDate>{YYYY-MM-DDThh:mm:ss.xxxZ}</CreationDate>

   <Format>DEFAULT|JSON|XML</Format>

   <Id>{string}</Id>

   <LastFailure>{string}</LastFailure>

   <LastHttpResponseCode>{32-bit integer}</LastHttpResponseCode>

   <LastNotification>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastNotification>

   <NamingConvention>

      CONCAT_LOWERCASE|CONSTANT|UNDERSCORED|

      CAMEL_CASE_WITH_FIRST_LETTER_UPPERCASE|

      CAMEL_CASE_WITH_FIRST_LETTER_LOWERCASE

   </NamingConvention>

   <NotificationEndPoint>{string}</NotificationEndPoint>

   <NotificationHttpMethod>POST|PUT</NotificationHttpMethod>

   <NumberOfFailuresSinceLastSuccess>

{32-bit integer}

   </NumberOfFailuresSinceLastSuccess>

   <UserId>{string}</UserId>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

CreationDate The date the notification registration was created in the
format YYYY-MM-DDThh:mm:ss.xxxZ.

Format The format of the notification. Values: DEFAULT (XML),
JSON, XML

ID The UUID for the notification.

LastFailure The exception message for the last failure to send a
notification to this notification registration.

LastHttpResponseCode The last response code returned by the notification end
point.
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Parameter Description

LastNotification Date and time of the last notification attempt by the
BlackPearl gateway.

NamingConvention The scheme used for naming within the notification sent.
Values: CONCAT_LOWERCASE, CONSTANT,
UNDERSCORED, CAMEL_CASE_WITH_FIRST_LETTER_
UPPERCASE, CAMEL_CASE_WITH_FIRST_LETTER_
LOWERCASE

NotificationEnd Point The HTTP or HTTPS URL of a web server capable of
receiving notification messages from the BlackPearl
gateway.

NotificationHttp Method The HTTP request method type. Values: POST, PUT

NumberOfFailuresSinceLastSuccess Number of failed notification attempts since last
successful notification.

UserId The UUID for the user who created the notification
registration.

Example

Sample Request
This request creates a registration for pool failure notifications to be sent to DS3-client-
hostname.
POST http://blackpearl-hostname/_rest_/pool_failure_notification_

registration/?notification_end_point=DS3-client-hostname HTTP/1.1
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Sample Response
HTTP/1.1 201 CREATED

<Data>

   <CreationDate>2015-10-02T15:57:19.614Z</CreationDate>

   <Format>DEFAULT</Format>

   <Id>3cbe9025-8b65-4bc0-bae9-8abf18afb882</Id>

   <LastFailure/>

   <LastHttpResponseCode/>

   <LastNotification/>

   <NamingConvention>

      CAMEL_CASE_WITH_FIRST_LETTER_UPPERCASE

   </NamingConvention>

   <NotificationEndPoint>

      DS3-client-hostname

   </NotificationEndPoint>

   <NotificationHttpMethod>POST</NotificationHttpMethod>

   <NumberOfFailuresSinceLastSuccess>

      0

   </NumberOfFailuresSinceLastSuccess>

   <UserId/>

</Data>

Sample Notification Payload
Below is a sample pool failure notification payload:
<Name>PoolFailureNotificationPayload</Name>
<Payload>
   <Date>Wed Sep 23 12:48:45 MDT 2015</Date>

   <ErrorMessage>The inspection failed.</ErrorMessage>

   <NotificationGenerationDate/>

   <PoolId>fc732108-3d0b-49ac-979d-5dbdc3b2f6a5</PoolId>

   <Type>INSPECT_FAILED</Type>
</Payload>

CREATE STORAGE DOMAIN FAILURE NOTIFICATION
REGISTRATION

Description
Create a notification registration for storage domain failure events.
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Requests

Syntax
POST http[s]://{datapathDNSname}/_rest_/storage_domain_failure_notification_

registration/?notification_end_point={string}[&format=DEFAULT|JSON|XML][&naming_

convention=CONCAT_LOWERCASE|CONSTANT|UNDERSCORED|CAMEL_CASE_WITH_FIRST_LETTER_

UPPERCASE|CAMEL_CASE_WITH_FIRST_LETTER_LOWERCASE][&notification_http_

method=POST|PUT]

Request Parameters

Parameter Description Required

notification_
end_
point

The HTTP or HTTPS URL of a web server capable of receiving
notification messages from the BlackPearl gateway.

yes

format The format of the notification.
Values: DEFAULT (XML), JSON, XML

no

naming_
convention

The scheme used for naming within the notification sent. Values:
CONCAT_LOWERCASE, CONSTANT, UNDERSCORED, CAMEL_
CASE_WITH_FIRST_LETTER_UPPERCASE (default), CAMEL_CASE_
WITH_FIRST_LETTER_LOWERCASE

no

notification_
http_
method

The HTTP request method type used to send the notification.
Values: POST (default), PUT

no

Responses

Response Elements
<Data>

   <CreationDate>{YYYY-MM-DDThh:mm:ss.xxxZ}</CreationDate>

   <Format>DEFAULT|JSON|XML</Format>

   <Id>{string}</Id>

   <LastFailure>{string}</LastFailure>

   <LastHttpResponseCode>{32-bit integer}</LastHttpResponseCode>

   <LastNotification>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastNotification>
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   <NamingConvention>

      CONCAT_LOWERCASE|CONSTANT|UNDERSCORED|

      CAMEL_CASE_WITH_FIRST_LETTER_UPPERCASE|

      CAMEL_CASE_WITH_FIRST_LETTER_LOWERCASE

   </NamingConvention>
   <NotificationEndPoint>{string}</NotificationEndPoint>

   <NotificationHttpMethod>POST|PUT</NotificationHttpMethod>

   <NumberOfFailuresSinceLastSuccess>

{32-bit integer}

   </NumberOfFailuresSinceLastSuccess>

   <UserId>{string}</UserId>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

CreationDate The date the notification registration was created in the
format YYYY-MM-DDThh:mm:ss.xxxZ.

Format The format of the notification. Values: DEFAULT (XML),
JSON, XML

ID The UUID for the notification.

LastFailure The exception message for the last failure to send a
notification to this notification registration.

LastHttpResponseCode The last response code returned by the notification end
point.

LastNotification Date and time of the last notification attempt by the
BlackPearl gateway.

NamingConvention The scheme used for naming within the notification sent.
Values: CONCAT_LOWERCASE, CONSTANT,
UNDERSCORED, CAMEL_CASE_WITH_FIRST_LETTER_
UPPERCASE, CAMEL_CASE_WITH_FIRST_LETTER_
LOWERCASE

NotificationEnd Point The HTTP or HTTPS URL of a web server capable of
receiving notification messages from the BlackPearl
gateway.

NotificationHttp Method The HTTP request method type. Values: POST, PUT
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Parameter Description

NumberOfFailuresSinceLastSuccess Number of failed notification attempts since last
successful notification.

UserId The UUID for the user who created the notification
registration.

Example

Sample Request
This request creates a registration for storage domain failure notifications to be sent to DS3-
client-hostname.
POST http://blackpearl-hostname/_rest_/storage_domain_failure_notification_

registration/?notification_end_point=DS3-client-hostname HTTP/1.1

Sample Response
HTTP/1.1 201 CREATED

<Data>

   <CreationDate>2015-07-13T11:33:15.91Z</CreationDate>

   <Format>DEFAULT</Format>

   <Id>ec3bfb0a-c788-4fbf-a6aa-12c1c70319d6</Id>

   <LastFailure/>

   <LastHttpResponseCode/>
   <LastNotification/>

   <NamingConvention>

      CAMEL_CASE_WITH_FIRST_LETTER_UPPERCASE

   </NamingConvention>
   <NotificationEndPoint>

      DS3-client-hostname

   </NotificationEndPoint>

   <NotificationHttpMethod>POST</NotificationHttpMethod>
   <NumberOfFailuresSinceLastSuccess>

      0

   </NumberOfFailuresSinceLastSuccess>

   <UserId/>

</Data>
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CREATE SYSTEM FAILURE NOTIFICATION REGISTRATION

Description
Create a notification registration for storage domain failure events.

Requests

Syntax
POST http[s]://{datapathDNSname}/_rest_/system_failure_notification_

registration/?notification_end_point={string}[&format=DEFAULT|JSON|XML][&naming_

convention=CONCAT_LOWERCASE|CONSTANT|UNDERSCORED|CAMEL_CASE_WITH_FIRST_LETTER_

UPPERCASE|CAMEL_CASE_WITH_FIRST_LETTER_LOWERCASE][&notification_http_

method=POST|PUT]

Request Parameters

Parameter Description Required

notification_
end_
point

The HTTP or HTTPS URL of a web server capable of receiving
notification messages from the BlackPearl gateway.

yes

format The format of the notification.
Values: DEFAULT (XML), JSON, XML

no

naming_
convention

The scheme used for naming within the notification sent. Values:
CONCAT_LOWERCASE, CONSTANT, UNDERSCORED, CAMEL_
CASE_WITH_FIRST_LETTER_UPPERCASE (default), CAMEL_CASE_
WITH_FIRST_LETTER_LOWERCASE

no

notification_
http_
method

The HTTP request method type used to send the notification.
Values: POST (default), PUT

no
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Responses

Response Elements
<Data>

   <CreationDate>{YYYY-MM-DDThh:mm:ss.xxxZ}</CreationDate>

   <Format>DEFAULT|JSON|XML</Format>

   <Id>{string}</Id>

   <LastFailure>{string}</LastFailure>

   <LastHttpResponseCode>{32-bit integer}</LastHttpResponseCode>

   <LastNotification>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastNotification>
   <NamingConvention>

      CONCAT_LOWERCASE|CONSTANT|UNDERSCORED|

      CAMEL_CASE_WITH_FIRST_LETTER_UPPERCASE|

      CAMEL_CASE_WITH_FIRST_LETTER_LOWERCASE

   </NamingConvention>
   <NotificationEndPoint>{string}</NotificationEndPoint>

   <NotificationHttpMethod>POST|PUT</NotificationHttpMethod>

   <NumberOfFailuresSinceLastSuccess>

{32-bit integer}

   </NumberOfFailuresSinceLastSuccess>

   <UserId>{string}</UserId>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

CreationDate The date the notification registration was created in the
format YYYY-MM-DDThh:mm:ss.xxxZ.

Format The format of the notification. Values: DEFAULT (XML),
JSON, XML

ID The UUID for the notification.

LastFailure The exception message for the last failure to send a
notification to this notification registration.

LastHttpResponseCode The last response code returned by the notification end
point.
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Parameter Description

LastNotification Date and time of the last notification attempt by the
BlackPearl gateway.

NamingConvention The scheme used for naming within the notification sent.
Values: CONCAT_LOWERCASE, CONSTANT,
UNDERSCORED, CAMEL_CASE_WITH_FIRST_LETTER_
UPPERCASE, CAMEL_CASE_WITH_FIRST_LETTER_
LOWERCASE

NotificationEnd Point The HTTP or HTTPS URL of a web server capable of
receiving notification messages from the BlackPearl
gateway.

NotificationHttp Method The HTTP request method type. Values: POST, PUT

NumberOfFailuresSinceLastSuccess Number of failed notification attempts since last
successful notification.

UserId The UUID for the user who created the notification
registration.

Example

Sample Request
This request creates a registration for system failure notifications to be sent to DS3-client-
hostname.
POST http://blackpearl-hostname/_rest_/system_failure_notification_

registration/?notification_end_point=DS3-client-hostname HTTP/1.1

Sample Response
HTTP/1.1 201 CREATED

<Data>

   <CreationDate>2015-12-07T03:20:14.000Z</CreationDate>

   <Format>DEFAULT</Format>

   <Id>50df41ca-bec6-412c-b770-18f944a3e06d</Id>

   <LastFailure/>

   <LastHttpResponseCode/>

   <LastNotification/>
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   <NamingConvention>

      CAMEL_CASE_WITH_FIRST_LETTER_UPPERCASE

   </NamingConvention>

   <NotificationEndPoint>

      DS3-client-hostname

   </NotificationEndPoint>
   <NotificationHttpMethod>POST</NotificationHttpMethod>

   <NumberOfFailuresSinceLastSuccess>

      0

   </NumberOfFailuresSinceLastSuccess>

   <UserId/>

</Data>

Sample Notification Payload
Below is a sample storage domain failure notification payload:
<Name>SystemFailureNotificationPayload</Name>
<Payload>
   <Date>2015-12-04T21:01:24.000Z</Date>

      <ErrorMessage>There was an error</ErrorMessage>

      <NotificationGenerationDate/>

      <Type>RECONCILE_TAPE_ENVIRONMENT_FAILED</Type>
</Payload>

CREATE TAPE FAILURE NOTIFICATION REGISTRATION

Description
Create a notification registration for tape failure events.

Requests

Syntax
POST http[s]://{datapathDNSname}/_rest_/tape_failure_notification_

registration/?notification_end_point={string}[&format=DEFAULT|JSON|XML][&naming_

convention=CONCAT_LOWERCASE|CONSTANT|UNDERSCORED|CAMEL_CASE_WITH_FIRST_LETTER_

UPPERCASE|CAMEL_CASE_WITH_FIRST_LETTER_LOWERCASE][&notification_http_

method=POST|PUT]
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Request Parameters

Parameter Description Required

notification_
end_
point

The HTTP or HTTPS URL of a web server capable of receiving
notification messages from the BlackPearl gateway.

yes

format The format of the notification.
Values: DEFAULT (XML), JSON, XML

no

naming_
convention

The scheme used for naming within the notification sent. Values:
CONCAT_LOWERCASE, CONSTANT, UNDERSCORED, CAMEL_
CASE_WITH_FIRST_LETTER_UPPERCASE (default), CAMEL_CASE_
WITH_FIRST_LETTER_LOWERCASE

no

notification_
http_
method

The HTTP request method type used to send the notification.
Values: POST (default), PUT

no

Responses

Response Elements
<Data>

   <CreationDate>{YYYY-MM-DDThh:mm:ss.xxxZ}</CreationDate>

   <Format>DEFAULT|JSON|XML</Format>

   <Id>{string}</Id>

   <LastFailure>{string}</LastFailure>

   <LastHttpResponseCode>{32-bit integer}</LastHttpResponseCode>
   <LastNotification>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastNotification>

   <NamingConvention>

      CONCAT_LOWERCASE|CONSTANT|UNDERSCORED|

      CAMEL_CASE_WITH_FIRST_LETTER_UPPERCASE|

      CAMEL_CASE_WITH_FIRST_LETTER_LOWERCASE

   </NamingConvention>
   <NotificationEndPoint>{string}</NotificationEndPoint>

   <NotificationHttpMethod>POST|PUT</NotificationHttpMethod>

   <NumberOfFailuresSinceLastSuccess>

{32-bit integer}

   </NumberOfFailuresSinceLastSuccess>

   <UserId>{string}</UserId>

</Data>
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where the response elements are defined as follows:

Parameter Description

Data The container for the response.

CreationDate The date the notification registration was created in the
format YYYY-MM-DDThh:mm:ss.xxxZ.

Format The format of the notification.
Values: DEFAULT (XML), JSON, XML

ID The UUID for the notification.

LastFailure The exception message for the last failure to send a
notification to this notification registration.

LastHttpResponseCode The last response code returned by the notification end
point.

LastNotification Date and time of the last notification attempt by the
BlackPearl gateway.

NamingConvention The scheme used for naming within the notification sent.
Values: CONCAT_LOWERCASE, CONSTANT,
UNDERSCORED, CAMEL_CASE_WITH_FIRST_LETTER_
UPPERCASE, CAMEL_CASE_WITH_FIRST_LETTER_
LOWERCASE

NotificationEnd Point The HTTP or HTTPS URL of a web server capable of
receiving notification messages from the BlackPearl
gateway.

NotificationHttp Method The HTTP request method type. Values: POST, PUT

NumberOfFailuresSinceLastSuccess Number of failed notification attempts since last
successful notification.

UserId The UUID for the user who created the notification
registration.
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Example

Sample Request
This request creates a registration for tape failure notifications to be sent to DS3-client-
hostname.
POST http://blackpearl-hostname/_rest_/tape_failure_notification_

registration/?notification_end_point=DS3-client-hostname HTTP/1.1

Sample Response
HTTP/1.1 201 CREATED

<Data>

   <CreationDate>2015-07-13T11:33:15.988Z</CreationDate>

   <Format>DEFAULT</Format>

   <Id>086c89a6-2a57-44d0-9968-fbcab161dd85</Id>

   <LastFailure/>

   <LastHttpResponseCode/>
   <LastNotification/>

   <NamingConvention>

      CAMEL_CASE_WITH_FIRST_LETTER_UPPERCASE

   </NamingConvention>
   <NotificationEndPoint>

      DS3-client-hostname

   </NotificationEndPoint>

   <NotificationHttpMethod>POST</NotificationHttpMethod>
   <NumberOfFailuresSinceLastSuccess>

      0

   </NumberOfFailuresSinceLastSuccess>

   <UserId/>

</Data>

Sample Notification Payload
Below is a sample tape failure notification payload:
<Name>TapeFailureNotificationPayload</Name>
<Payload>

   <Date>Mon Jun 08 16:20:42 MDT 2015</Date>

   <ErrorMessage>There was an error</ErrorMessage>

   <NotificationGenerationDate/>

   <TapeDriveId>703cbc16-6a53-4ba8-829d-b1aa64c3cc10</TapeDriveId>

   <TapeId>09ae4429-2e34-41a7-8a03-0d28b901871d</TapeId>

   <Type>INSPECT_FAILED</Type>

</Payload>
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CREATE TAPE PARTITION FAILURE NOTIFICATION
REGISTRATION

Description
Create a notification registration for tape partition failure events.

Requests

Syntax
POST http[s]://{datapathDNSname}/_rest_/tape_partition_failure_notification_

registration/ ?notification_end_point={string}[&format=DEFAULT|JSON|XML][&naming_

convention=CONCAT_LOWERCASE|CONSTANT|UNDERSCORED|CAMEL_CASE_WITH_FIRST_LETTER_

UPPERCASE|CAMEL_CASE_WITH_FIRST_LETTER_LOWERCASE][&notification_http_

method=POST|PUT]

Request Parameters

Parameter Description Required

notification_
end_
point

The HTTP or HTTPS URL of a web server capable of receiving
notification messages from the BlackPearl gateway.

yes

format The format of the notification.
Values: DEFAULT (XML), JSON, XML

no

naming_
convention

The scheme used for naming within the notification sent. Values:
CONCAT_LOWERCASE, CONSTANT, UNDERSCORED, CAMEL_
CASE_WITH_FIRST_LETTER_UPPERCASE (default), CAMEL_CASE_
WITH_FIRST_LETTER_LOWERCASE

no

notification_
http_
method

The HTTP request method type used to send the notification.
Values: POST (default), PUT

no
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Responses

Response Elements
<Data>

   <CreationDate>{YYYY-MM-DDThh:mm:ss.xxxZ}</CreationDate>

   <Format>DEFAULT|JSON|XML</Format>

   <Id>{string}</Id>

   <LastFailure>{string}</LastFailure>

   <LastHttpResponseCode>{32-bit integer}</LastHttpResponseCode>

   <LastNotification>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastNotification>

   <NamingConvention>

      CONCAT_LOWERCASE|CONSTANT|UNDERSCORED|

      CAMEL_CASE_WITH_FIRST_LETTER_UPPERCASE|

      CAMEL_CASE_WITH_FIRST_LETTER_LOWERCASE

   </NamingConvention>

   <NotificationEndPoint>{string}</NotificationEndPoint>

   <NotificationHttpMethod>POST|PUT</NotificationHttpMethod>

   <NumberOfFailuresSinceLastSuccess>

{32-bit integer}

   </NumberOfFailuresSinceLastSuccess>

   <UserId>{string}</UserId>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

CreationDate The date the notification registration was created in the
format YYYY-MM-DDThh:mm:ss.xxxZ.

Format The format of the notification.
Values: DEFAULT (XML), JSON, XML

ID The UUID for the notification.

LastFailure The exception message for the last failure to send a
notification to this notification registration.

LastHttpResponseCode The last response code returned by the notification end
point.
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Parameter Description

LastNotification Date and time of the last notification attempt by the
BlackPearl gateway.

NamingConvention The scheme used for naming within the notification sent.
Values: CONCAT_LOWERCASE, CONSTANT,
UNDERSCORED, CAMEL_CASE_WITH_FIRST_LETTER_
UPPERCASE, CAMEL_CASE_WITH_FIRST_LETTER_
LOWERCASE

NotificationEnd Point The HTTP or HTTPS URL of a web server capable of
receiving notification messages from the BlackPearl
gateway.

NotificationHttp Method The HTTP request method type. Values: POST, PUT

NumberOfFailuresSinceLastSuccess Number of failed notification attempts since last
successful notification.

UserId The UUID for the user who created the notification
registration.

Example

Sample Request
This request creates a registration for tape partition failure notifications to be sent to DS3-
client-hostname.
POST http://blackpearl-hostname/_rest_/tape_partition_failure_notification_

registration/?notification_end_point=DS3-client-hostname HTTP/1.1
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Sample Response
HTTP/1.1 201 CREATED

<Data>

   <CreationDate>2014-10-02T11:40:19.821Z</CreationDate>

   <Format>DEFAULT</Format>

   <Id>085586b1-23e2-40bd-93e4-92b236af41e6</Id>

   <LastFailure/>

   <LastHttpResponseCode/>

   <LastNotification/>

   <NamingConvention>

      CAMEL_CASE_WITH_FIRST_LETTER_UPPERCASE

   </NamingConvention>

   <NotificationEndPoint>

      DS3-client-hostname

   </NotificationEndPoint>

   <NotificationHttpMethod>POST</NotificationHttpMethod>

   <NumberOfFailuresSinceLastSuccess>

      0

   </NumberOfFailuresSinceLastSuccess>

   <UserId/>

</Data>

Sample Notification Payload
Below is a sample tape partition failure notification payload:
<Name>TapePartitionFailureNotificationPayload</Name>
<Payload>
   <Date>Mon Jun 08 16:20:43 MDT 2015</Date>

   <ErrorMessage>No cleaning tape available.</ErrorMessage>

   <NotificationGenerationDate/>

   <PartitionId>08bde4a0-5125-46b0-b9d2-8efb8af7435c</PartitionId>

   <Type>CLEANING_TAPE_REQUIRED</Type>
</Payload>
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DELETE AMAZON S3 TARGET FAILURE NOTIFICATION
REGISTRATION

Description
Delete an Amazon S3 target failure notification registration.

Requests

Syntax
DELETE http[s]://{datapathDNSname}/_rest_/s3_target_failure_notification_

registration/{UUID for the notification}/

To determine the UUID for a notification, see Get Amazon S3 Target Failure Notification
Registrations on page 912.

Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 404: Not Found

Example

Sample Request
This request deletes the Amazon S3 target failure notification registration with the UUID
934fc113-1d0a-40f4-ad14-57c6e5b86fee.
DELETE http://blackpearl-hostname/_rest_/s3_target_failure_notification_

registration/934fc113-1d0a-40f4-ad14-57c6e5b86fee/ HTTP/1.1

Sample Response
HTTP/1.1 204 No Content
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DELETE AZURE TARGET FAILURE NOTIFICATION
REGISTRATION

Description
Delete an Azure target failure notification registration.

Requests

Syntax
DELETE http[s]://{datapathDNSname}/_rest_/azure_target_failure_notification_

registration/{UUID for the notification}/

To determine the UUID for a notification, see Get Azure Target Failure Notification
Registrations on page 919.

Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 404: Not Found

Example

Sample Request
This request deletes the Azure target failure notification registration with the UUID 9098a43c-
588d-4036-80d7-fdd8851aec47.
DELETE http://blackpearl-hostname/_rest_/azure_target_failure_notification_

registration/9098a43c-588d-4036-80d7-fdd8851aec47/ HTTP/1.1

Sample Response
HTTP/1.1 204 No Content
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DELETE BUCKET CHANGE NOTIFICATION REGISTRATION

Description
Delete a bucket change notification registration.

Requests

Syntax
DELETE http[s]://{datapathDNSname}/_rest_/bucket_change_notification_registration/

{UUID for the notification}/

To determine the UUID for a notification, see Get Bucket Changes Notification Registrations
on page 925.

Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 404: Not Found

Example

Sample Request
This request deletes the bucket change notification registration with the UUID 8282153d-8c51-
476f-9654-56c1f6ae0035.
DELETE http://blackpearl-hostname/_rest_/bucket_change_notification_

registration/8282153d-8c51-476f-9654-56c1f6ae0035/ HTTP/1.1

Sample Response
HTTP/1.1 204 No Content
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DELETE DS3 TARGET FAILURE NOTIFICATION REGISTRATION

Description
Delete a DS3 target failure notification registration.

Requests

Syntax
DELETE http[s]://{datapathDNSname}/_rest_/ds3_target_failure_notification_

registration/{UUID for the notification}/

To determine the UUID for a notification, see Get DS3 Target Failure Notification
Registrations on page 935.

Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 404: Not Found

Example

Sample Request
This request deletes the DS3 target failure notification registration with the UUID 2a8154df-
fa4c-4290-a12f-2865988ab2e9.
DELETE http://blackpearl-hostname/_rest_/ds3_target_failure_notification_

registration/2a8154df-fa4c-4290-a12f-2865988ab2e9/ HTTP/1.1

Sample Response
HTTP/1.1 204 No Content
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DELETE JOB COMPLETED NOTIFICATION REGISTRATION

Description
Delete a job completed notification registration.

Requests

Syntax
DELETE http[s]://{datapathDNSname}/_rest_/job_completed_notification_registration/

{UUID for the notification}/

To determine the UUID for a notification, see Get Job Completed Notification Registrations
on page 942.

Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 404: Not Found

Example

Sample Request
This request deletes the job completed notification registration with the UUID e2ae9bc2-d70e-
46d4-9af7-82d971827cb8.
DELETE http://blackpearl-hostname/_rest_/job_completed_notification_

registration/e2ae9bc2-d70e-46d4-9af7-82d971827cb8/ HTTP/1.1

Sample Response
HTTP/1.1 204 No Content
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DELETE JOB CREATED NOTIFICATION REGISTRATION

Description
Delete a job created notification registration.

Requests

Syntax
DELETE http[s]://{datapathDNSname}/_rest_/job_created_notification_registration/

{UUID for the notification}/

To determine the UUID for a notification, see Get Job Created Notification Registrations on
page 948.

Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 404: Not Found

Example

Sample Request
This request deletes the job created notification registration with the UUID dfe027c8-e3ba-
4e8a-a484-66d5577d5040.
DELETE http://blackpearl-hostname/_rest_/job_created_notification_

registration/dfe027c8-e3ba-4e8a-a484-66d5577d5040/ HTTP/1.1

Sample Response
HTTP/1.1 204 No Content
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DELETE JOB CREATION FAILED NOTIFICATION
REGISTRATION

Description
Delete a job creation failure notification registration.

Requests

Syntax
DELETE http[s]://{datapathDNSname}/_rest_/job_creation_failed_notification_

registration/{UUID for the notification}/

To determine the UUID for a notification, see Get Job Creation Failed Notification
Registrations on page 954.

Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 404: Not Found

Example

Sample Request
This request deletes the job creation failure notification registration with the UUID 76454453-
4969-419d-99d3-96fa533760ad.
DELETE http://blackpearl-hostname/_rest_/job_creation_failed_notification_

registration/76454453-4969-419d-99d3-96fa533760ad/ HTTP/1.1

Sample Response
HTTP/1.1 204 No Content
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DELETE OBJECT CACHED NOTIFICATION REGISTRATION

Description
Delete an object cached notification registration.

Requests

Syntax
DELETE http[s]://{datapathDNSname}/_rest_/object_cached_notification_registration/

{UUID for the notification}/

To determine the UUID for a notification, see Get Object Cached Notification Registrations on
page 961.

Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 404: Not Found

Example

Sample Request
This request deletes the object cached notification registration with the UUID b7ed9175-aeb5-
4cee-a696-0c858382453f.
DELETE http://blackpearl-hostname/_rest_/object_cached_notification_

registration/b7ed9175-aeb5-4cee-a696-0c858382453f/ HTTP/1.1

Sample Response
HTTP/1.1 204 No Content
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DELETE OBJECT LOST NOTIFICATION REGISTRATION

Description
Delete an object lost notification registration.

Requests

Syntax
DELETE http[s]://{datapathDNSname}/_rest_/object_lost_notification_registration/

{UUID for the notification}/

To determine the UUID for a notification, see Get Object Lost Notification Registrations on
page 968.

Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 404: Not Found

Example

Sample Request
This request deletes the object lost notification registration with the UUID aa663b70-878a-
4d96-a1ee-6dd5a004e185.
DELETE http://blackpearl-hostname/_rest_/object_lost_notification_

registration/aa663b70-878a-4d96-a1ee-6dd5a004e185/ HTTP/1.1

Sample Response
HTTP/1.1 204 No Content
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DELETE OBJECT PERSISTED NOTIFICATION REGISTRATION

Description
Delete an object persisted notification registration.

Requests

Syntax
DELETE http[s]://{datapathDNSname}/_rest_/object_persisted_notification_

registration/{UUID for the notification}/

To determine the UUID for a notification, see Get Object Persisted Notification Registrations
on page 974.

Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 404: Not Found

Example

Sample Request
This request deletes the object persisted notification registration with the UUID 9c94de0f-
a8c5-454f-abcb-f3ee47c9d8b1.
DELETE http://blackpearl-hostname/_rest_/object_persisted_notification_

registration/9c94de0f-a8c5-454f-abcb-f3ee47c9d8b1/ HTTP/1.1

Sample Response
HTTP/1.1 204 No Content
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DELETE POOL FAILURE NOTIFICATION REGISTRATION

Description
Delete a pool failure notification registration.

Requests

Syntax
DELETE http[s]://{datapathDNSname}/_rest_/pool_failure_notification_registration/

{UUID for the notification}/

To determine the UUID for a notification, see Get Pool Failure Notification Registrations on
page 980.

Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 404: Not Found

Example

Sample Request
This request deletes the pool failure notification registration with the UUID 3a082f87-e720-
4d60-839d-d45216647f00.
DELETE http://blackpearl-hostname/_rest_/pool_failure_notification_

registration/3a082f87-e720-4d60-839d-d45216647f00/ HTTP/1.1

Sample Response
HTTP/1.1 204 No Content
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DELETE STORAGE DOMAIN FAILURE NOTIFICATION
REGISTRATION

Description
Delete a storage domain failure notification registration.

Requests

Syntax
DELETE http[s]://{datapathDNSname}/_rest_/storage_domain_failure_notification_

registration/{UUID for the notification}/

To determine the UUID for a notification, see Get Storage Domain Failure Notification
Registrations on page 987.

Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 404: Not Found

Example

Sample Request
This request deletes the storage domain failure notification registration with the UUID
ec3bfb0a-c788-4fbf-a6aa-12c1c70319d6.
DELETE http://blackpearl-hostname/_rest_/storage_domain_failure_notification_

registration/ec3bfb0a-c788-4fbf-a6aa-12c1c70319d6/ HTTP/1.1

Sample Response
HTTP/1.1 204 No Content
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DELETE SYSTEM FAILURE NOTIFICATION REGISTRATION

Description
Delete a system failure notification registration.

Requests

Syntax
DELETE http[s]://{datapathDNSname}/_rest_/system_failure_notification_registration/

{UUID for the notification}/

To determine the UUID for a notification, see Get System Failure Notification Registrations
on page 993.

Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 404: Not Found

Example

Sample Request
This request deletes the system failure notification registration with the UUID 50df41ca-bec6-
412c-b770-18f944a3e06d.
DELETE http://blackpearl-hostname/_rest_/storage_domain_failure_notification_

registration/50df41ca-bec6-412c-b770-18f944a3e06d/ HTTP/1.1

Sample Response
HTTP/1.1 204 No Content
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DELETE TAPE FAILURE NOTIFICATION REGISTRATION

Description
Delete a tape failure notification registration.

Requests

Syntax
DELETE http[s]://{datapathDNSname}/_rest_/tape_failure_notification_registration/

{UUID for the notification}/

To determine the UUID for a notification, see Get Tape Failure Notification Registrations on
page 999.

Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 404: Not Found

Example

Sample Request
This request deletes the tape failure notification registration with the UUID 086c89a6-2a57-
44d0-9968-fbcab161dd85.
DELETE http://blackpearl-hostname/_rest_/tape_failure_notification_

registration/086c89a6-2a57-44d0-9968-fbcab161dd85/ HTTP/1.1

Sample Response
HTTP/1.1 204 No Content
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DELETE TAPE PARTITION FAILURE NOTIFICATION
REGISTRATION

Description
Delete a tape partition failure notification registration.

Requests

Syntax
DELETE http[s]://{datapathDNSname}/_rest_/tape_partition_failure_notification_

registration/{UUID for the notification}/

To determine the UUID for a notification, see Get Tape Partition Failure Notification
Registrations on page 1005.

Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 404: Not Found

Example

Sample Request
This request deletes the tape partition failure notification registration with the UUID
085586b1-23e2-40bd-93e4-92b236af41e6.
DELETE http://blackpearl-hostname/_rest_/tape_partition_failure_notification_

registration/085586b1-23e2-40bd-93e4-92b236af41e6/ HTTP/1.1

Sample Response
HTTP/1.1 204 No Content
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GET AMAZON S3 TARGET FAILURE NOTIFICATION
REGISTRATION

Description
Get information about an Amazon S3 target failure notification registration.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/s3_target_failure_notification_registration/

{UUID for the notification}/

To determine the UUID for a notification, see Get Amazon S3 Target Failure Notification
Registrations on page 912.

Responses

Response Elements
<Data>

   <CreationDate>{YYYY-MM-DDThh:mm:ss.xxxZ}</CreationDate>

   <Format>DEFAULT|JSON|XML</Format>

   <Id>{string}</Id>

   <LastFailure>{string}</LastFailure>

   <LastHttpResponsoeCode>{32-bit integer}</LastHttpResponseCode>
   <LastNotification>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastNotification>

   <NamingConvention>

      CONCAT_LOWERCASE|CONSTANT|UNDERSCORED|

      CAMEL_CASE_WITH_FIRST_LETTER_UPPERCASE|

      CAMEL_CASE_WITH_FIRST_LETTER_LOWERCASE

   </NamingConvention>
   <NotificationEndPoint>{string}</NotificationEndPoint>

   <NotificationHttpMethod>POST|PUT</NotificationHttpMethod>
   <NumberOfFailuresSinceLastSuccess>

{32-bit integer}

   </NumberOfFailuresSinceLastSuccess>

   <UserId>{string}</UserId>

</Data>
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where the response elements are defined as follows:

Parameter Description

Data The container for the response.

CreationDate The date the notification registration was created in the
format YYYY-MM-DDThh:mm:ss.xxxZ.

Format The format of the notification.
Values: DEFAULT (XML), JSON, XML

ID The UUID for the notification.

LastFailure The exception message for the last failure to send a
notification to this notification registration.

LastHttpResponseCode The last response code returned by the notification end
point.

LastNotification Date and time of the last notification attempt by the
BlackPearl gateway.

NamingConvention The scheme used for naming within the notification sent.
Values: CONCAT_LOWERCASE, CONSTANT,
UNDERSCORED, CAMEL_CASE_WITH_FIRST_LETTER_
UPPERCASE, CAMEL_CASE_WITH_FIRST_LETTER_
LOWERCASE

NotificationEnd Point The HTTP or HTTPS URL of a web server capable of
receiving notification messages from the BlackPearl
gateway.

NotificationHttp Method The HTTP request method type. Values: POST, PUT

NumberOfFailuresSinceLastSuccess Number of failed notification attempts since last
successful notification.

UserId The UUID for the user who created the notification
registration.
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Example

Sample Request
This request gets information about the Amazon S3 target failure notification registration
with the UUID 2a8154df-fa4c-4290-a12f-2865988ab2e9.
GET http://blackpearl-hostname/_rest_/s3_target_failure_notification_

registration/2a8154df-fa4c-4290-a12f-2865988ab2e9/ HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>

   <CreationDate>2017-01-09T01:14:51.000Z</CreationDate>

   <Format>DEFAULT</Format>

   <Id>2a8154df-fa4c-4290-a12f-2865988ab2e9</Id>

   <LastFailure/>

   <LastHttpResponseCode/>
   <LastNotification/>

   <NamingConvention>

      CAMEL_CASE_WITH_FIRST_LETTER_UPPERCASE

   </NamingConvention>
   <NotificationEndPoint>

      DS3-client-hostname

   </NotificationEndPoint>

   <NotificationHttpMethod>POST</NotificationHttpMethod>
   <NumberOfFailuresSinceLastSuccess>

      0

   </NumberOfFailuresSinceLastSuccess>

   <UserId>26d35f40-d899-441d-9506-937b7cdd67eb</UserId>

</Data>

GET AMAZON S3 TARGET FAILURE NOTIFICATION
REGISTRATIONS

Description
Get a list of all Amazon S3 target failure notification registrations.
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Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/s3_target_failure_notification_registration/

[?last_page][&page_length={32-bit integer}][&page_offset={32-bit integer}][&page_

start_marker={string}][&user_id={string}]

Request Parameters

Parameter Description Required

last_page If included, only the last page of results is returned. no

page_length The maximum number of registrations to list. The default is all
items after page_offset.

no

page_offset The starting point for the first registration to list. The default is 0. no

page_start_
marker

The UUID or other unique attribute for the item just before the first
item to list.
Notes:
• Specifying both page_offset and page_start_marker causes
an error.

• If neither page_offset, nor page_start_marker are specified,
the page_offset default is used.

no

user_id 1 The UUID, username, or other unique attribute for the user who
created the notification registration.

no

Responses

Response Elements
<Data>

   <S3TargetFailureNotificationRegistration>

      <CreationDate>{YYYY-MM-DDThh:mm:ss.xxxZ}</CreationDate>

      <Format>DEFAULT|JSON|XML</Format>

      <Id>{string}</Id>

      <LastFailure>{string}</LastFailure>

1) Parameter values can use wild cards (see Wild Card Syntax on page 30).
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      <LastHttpResponseCode>

{32-bit integer}

      </LastHttpResponseCode>

      <LastNotification>

{YYYY-MM-DDThh:mm:ss.xxxZ}

      </LastNotification>
      <NamingConvention>

         CONCAT_LOWERCASE|CONSTANT|UNDERSCORED|

         CAMEL_CASE_WITH_FIRST_LETTER_UPPERCASE|

         CAMEL_CASE_WITH_FIRST_LETTER_LOWERCASE

      </NamingConvention>
      <NotificationEndPoint>{string}</NotificationEndPoint>

      <NotificationHttpMethod>POST|PUT</NotificationHttpMethod>

      <NumberOfFailuresSinceLastSuccess>

{32-bit integer}

      </NumberOfFailuresSinceLastSuccess>

      <UserId>{string}</UserId>

   </S3TargetFailureNotificationRegistration>
   ...

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

S3TargetFailure Notification
Registration

The container for the information for a single notification
registration.

CreationDate The date the notification registration was created in the
format YYYY-MM-DDThh:mm:ss.xxxZ.

Format The format of the notification.
Values: DEFAULT (XML), JSON, XML

ID The UUID for the notification.

LastFailure The exception message for the last failure to send a
notification to this notification registration.

LastHttpResponseCode The last response code returned by the notification end
point.

LastNotification Date and time of the last notification attempt by the
BlackPearl gateway.
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Parameter Description

NamingConvention The scheme used for naming within the notification sent.
Values: CONCAT_LOWERCASE, CONSTANT,
UNDERSCORED, CAMEL_CASE_WITH_FIRST_LETTER_
UPPERCASE, CAMEL_CASE_WITH_FIRST_LETTER_
LOWERCASE

NotificationEnd Point The HTTP or HTTPS URL of a web server capable of
receiving notification messages from the BlackPearl
gateway.

NotificationHttp Method The HTTP request method type. Values: POST, PUT

NumberOfFailuresSinceLastSuccess Number of failed notification attempts since last
successful notification.

UserId The UUID for the user who created the notification
registration.

Example

Sample Request
This request gets information about all Amazon S3 target failure notification registrations.
GET http://blackpearl-hostname/_rest_/s3_target_failure_notification_registration/

HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>

   <S3TargetFailureNotificationRegistration>

      <CreationDate>2016-06-09T01:14:52.000Z</CreationDate>

      <Format>DEFAULT</Format>

      <Id>a662e451-9db7-4274-8c05-845d2a422988</Id>

      <LastFailure/>
      <LastHttpResponseCode/>

      <LastNotification/>

      <NamingConvention>

         CAMEL_CASE_WITH_FIRST_LETTER_UPPERCASE

      </NamingConvention>
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      <NotificationEndPoint>

         DS3-client-hostname

      </NotificationEndPoint>

      <NotificationHttpMethod>POST</NotificationHttpMethod>
      <NumberOfFailuresSinceLastSuccess>

         0

      </NumberOfFailuresSinceLastSuccess>

      <UserId>6698ab0d-2257-47ff-bec1-ec5d1f9f2e61</UserId>

   </S3TargetFailureNotificationRegistration>

</Data>

GET AZURE TARGET FAILURE NOTIFICATION REGISTRATION

Description
Get information about an Azure target failure notification registration.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/azure_target_failure_notification_

registration/{UUID for the notification}/

To determine the UUID for a notification, see Get Azure Target Failure Notification
Registrations on page 919.
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Responses

Response Elements
<Data>

   <CreationDate>{YYYY-MM-DDThh:mm:ss.xxxZ}</CreationDate>

   <Format>DEFAULT|JSON|XML</Format>

   <Id>{string}</Id>

   <LastFailure>{string}</LastFailure>

   <LastHttpResponsoeCode>{32-bit integer}</LastHttpResponseCode>

   <LastNotification>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastNotification>

   <NamingConvention>

      CONCAT_LOWERCASE|CONSTANT|UNDERSCORED|

      CAMEL_CASE_WITH_FIRST_LETTER_UPPERCASE|

      CAMEL_CASE_WITH_FIRST_LETTER_LOWERCASE

   </NamingConvention>

   <NotificationEndPoint>{string}</NotificationEndPoint>

   <NotificationHttpMethod>POST|PUT</NotificationHttpMethod>

   <NumberOfFailuresSinceLastSuccess>

{32-bit integer}

   </NumberOfFailuresSinceLastSuccess>

   <UserId>{string}</UserId>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

CreationDate The date the notification registration was created in the
format YYYY-MM-DDThh:mm:ss.xxxZ.

Format The format of the notification.
Values: DEFAULT (XML), JSON, XML

ID The UUID for the notification.

LastFailure The exception message for the last failure to send a
notification to this notification registration.

LastHttpResponseCode The last response code returned by the notification end
point.
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Parameter Description

LastNotification Date and time of the last notification attempt by the
BlackPearl gateway.

NamingConvention The scheme used for naming within the notification sent.
Values: CONCAT_LOWERCASE, CONSTANT,
UNDERSCORED, CAMEL_CASE_WITH_FIRST_LETTER_
UPPERCASE, CAMEL_CASE_WITH_FIRST_LETTER_
LOWERCASE

NotificationEnd Point The HTTP or HTTPS URL of a web server capable of
receiving notification messages from the BlackPearl
gateway.

NotificationHttp Method The HTTP request method type. Values: POST, PUT

NumberOfFailuresSinceLastSuccess Number of failed notification attempts since last
successful notification.

UserId The UUID for the user who created the notification
registration.

Example

Sample Request
This request gets information about the Azure target failure notification registration with the
UUID 2a8154df-fa4c-4290-a12f-2865988ab2e9.
GET http://blackpearl-hostname/_rest_/azure_target_failure_notification_

registration/2a8154df-fa4c-4290-a12f-2865988ab2e9/ HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>
   <CreationDate>2017-02-22T00:51:02.000Z</CreationDate>
   <Format>DEFAULT</Format>
   <Id>faa51a2f-ac5d-4349-be79-a036a6b029f3</Id>
   <LastFailure/>
   <LastHttpResponseCode/>
   <LastNotification/>
   <NamingConvention>
      CAMEL_CASE_WITH_FIRST_LETTER_UPPERCASE
   </NamingConvention>
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   <NotificationEndPoint>a</NotificationEndPoint>
   <NotificationHttpMethod>POST</NotificationHttpMethod>
   <NumberOfFailuresSinceLastSuccess>
      0
   </NumberOfFailuresSinceLastSuccess>
   <UserId>d40362ad-dd4e-48fd-95d4-57603d1265a8</UserId>
</Data>

GET AZURE TARGET FAILURE NOTIFICATION REGISTRATIONS

Description
Get a list of all Azure target failure notification registrations.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/azure_target_failure_notification_

registration/[?last_page][&page_length={32-bit integer}][&page_offset=

{32-bit integer}][&page_start_marker={string}][&user_id={string}]

Request Parameters

Parameter Description Required

last_page If included, only the last page of results is returned. no

page_length The maximum number of registrations to list. The default is all
items after page_offset.

no

page_offset The starting point for the first registration to list. The default is 0. no

page_start_
marker

The UUID or other unique attribute for the item just before the first
item to list.
Notes:
• Specifying both page_offset and page_start_marker causes
an error.

• If neither page_offset, nor page_start_marker are specified,
the page_offset default is used.

no

April 2023 DS3 API Reference-Spectra BlackPearl Nearline Gateway
- 919 -



Chapter 17 - Notification Operations Get Azure Target Failure Notification Registrations

Parameter Description Required

user_id 1 The UUID, username, or other unique attribute for the user who
created the notification registration.

no

Responses

Response Elements
<Data>

   <AzureTargetFailureNotificationRegistration>

      <CreationDate>{YYYY-MM-DDThh:mm:ss.xxxZ}</CreationDate>

      <Format>DEFAULT|JSON|XML</Format>

      <Id>{string}</Id>

      <LastFailure>{string}</LastFailure>

      <LastHttpResponseCode>

{32-bit integer}

      </LastHttpResponseCode>

      <LastNotification>

{YYYY-MM-DDThh:mm:ss.xxxZ}

      </LastNotification>
      <NamingConvention>

         CONCAT_LOWERCASE|CONSTANT|UNDERSCORED|

         CAMEL_CASE_WITH_FIRST_LETTER_UPPERCASE|

         CAMEL_CASE_WITH_FIRST_LETTER_LOWERCASE

      </NamingConvention>

      <NotificationEndPoint>{string}</NotificationEndPoint>

      <NotificationHttpMethod>POST|PUT</NotificationHttpMethod>

      <NumberOfFailuresSinceLastSuccess>

{32-bit integer}

      </NumberOfFailuresSinceLastSuccess>

      <UserId>{string}</UserId>

   </AzureTargetFailureNotificationRegistration>
   ...

</Data>

1) Parameter values can use wild cards (see Wild Card Syntax on page 30).
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where the response elements are defined as follows:

Parameter Description

Data The container for the response.

AzureTargetFailure Notification
Registration

The container for the information for a single notification
registration.

CreationDate The date the notification registration was created in the
format YYYY-MM-DDThh:mm:ss.xxxZ.

Format The format of the notification.
Values: DEFAULT (XML), JSON, XML

ID The UUID for the notification.

LastFailure The exception message for the last failure to send a
notification to this notification registration.

LastHttpResponseCode The last response code returned by the notification end
point.

LastNotification Date and time of the last notification attempt by the
BlackPearl gateway.

NamingConvention The scheme used for naming within the notification sent.
Values: CONCAT_LOWERCASE, CONSTANT,
UNDERSCORED, CAMEL_CASE_WITH_FIRST_LETTER_
UPPERCASE, CAMEL_CASE_WITH_FIRST_LETTER_
LOWERCASE

NotificationEnd Point The HTTP or HTTPS URL of a web server capable of
receiving notification messages from the BlackPearl
gateway.

NotificationHttp Method The HTTP request method type. Values: POST, PUT

NumberOfFailuresSinceLastSuccess Number of failed notification attempts since last
successful notification.

UserId The UUID for the user who created the notification
registration.
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Example

Sample Request
This request gets information about all Azure target failure notification registrations.
GET http://blackpearl-hostname/_rest_/azure_target_failure_notification_

registration/ HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>
   <AzureTargetFailureNotificationRegistration>
     <CreationDate>2017-02-22T00:50:59.000Z</CreationDate>
     <Format>DEFAULT</Format>
     <Id>4f1b3f59-b3e6-452f-8c52-207d380047cb</Id>
     <LastFailure/>
     <LastHttpResponseCode/>
     <LastNotification/>
     <NamingConvention>
        CAMEL_CASE_WITH_FIRST_LETTER_UPPERCASE
     </NamingConvention>
     <NotificationEndPoint>a</NotificationEndPoint>
     <NotificationHttpMethod>POST</NotificationHttpMethod>
     <NumberOfFailuresSinceLastSuccess>
        0
     </NumberOfFailuresSinceLastSuccess>
     <UserId>5c9ec971-11af-48cf-a348-21e30bc5c22b</UserId>
   </AzureTargetFailureNotificationRegistration>
   <AzureTargetFailureNotificationRegistration>
     <CreationDate>2017-02-22T00:50:59.000Z</CreationDate>
     <Format>DEFAULT</Format>
     <Id>0759cc0d-92f0-45e0-bad9-f9b664495881</Id>
     <LastFailure/>
     <LastHttpResponseCode/>
     <LastNotification/>
     <NamingConvention>
        CAMEL_CASE_WITH_FIRST_LETTER_UPPERCASE
     </NamingConvention>
     <NotificationEndPoint>b</NotificationEndPoint>
     <NotificationHttpMethod>POST</NotificationHttpMethod>
     <NumberOfFailuresSinceLastSuccess>
        0
     </NumberOfFailuresSinceLastSuccess>
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     <UserId>5c9ec971-11af-48cf-a348-21e30bc5c22b</UserId>
   </AzureTargetFailureNotificationRegistration>
</Data>

GET BUCKET CHANGE NOTIFICATION REGISTRATION

Description
Get information about a bucket change notification registration.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/bucket_change_notification_registration/{UUID

for the notification}/

To determine the UUID for a notification, see Get Bucket Changes Notification Registrations
on page 925.

Responses

Response Elements
<Data>

   <BucketID>{string}</BucketID>
   <CreationDate>{YYYY-MM-DDThh:mm:ss.xxxZ}</CreationDate>

   <Format>DEFAULT|JSON|XML</Format>

   <Id>{string}</Id>

   <LastFailure>{string}</LastFailure>
   <LastHttpResponsoeCode>{32-bit integer}</LastHttpResponseCode>

   <LastNotification>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastNotification>

   <NamingConvention>

      CONCAT_LOWERCASE|CONSTANT|UNDERSCORED|

      CAMEL_CASE_WITH_FIRST_LETTER_UPPERCASE|

      CAMEL_CASE_WITH_FIRST_LETTER_LOWERCASE

   </NamingConvention>
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   <NotificationEndPoint>{string}</NotificationEndPoint>

   <NotificationHttpMethod>POST|PUT</NotificationHttpMethod>

   <NumberOfFailuresSinceLastSuccess>

{32-bit integer}

   </NumberOfFailuresSinceLastSuccess>

   <UserId>{string}</UserId>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

BucketID The UUID for the bucket for which notifications are sent.

CreationDate The date the notification registration was created in the
format YYYY-MM-DDThh:mm:ss.xxxZ.

Format The format of the notification.
Values: DEFAULT (XML), JSON, XML

ID The UUID for the notification.

LastFailure The exception message for the last failure to send a
notification to this notification registration.

LastHttpResponseCode The last response code returned by the notification end
point.

LastNotification Date and time of the last notification attempt by the
BlackPearl gateway.

NamingConvention The scheme used for naming within the notification sent.
Values: CONCAT_LOWERCASE, CONSTANT,
UNDERSCORED, CAMEL_CASE_WITH_FIRST_LETTER_
UPPERCASE, CAMEL_CASE_WITH_FIRST_LETTER_
LOWERCASE

NotificationEnd Point The HTTP or HTTPS URL of a web server capable of
receiving notification messages from the BlackPearl
gateway.

NotificationHttp Method The HTTP request method type. Values: POST, PUT

NumberOfFailuresSinceLastSuccess Number of failed notification attempts since last
successful notification.
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Parameter Description

UserId The UUID for the user who created the notification
registration.

Example

Sample Request
This request gets information about the bucket change notification registration with the UUID
2a8154df-fa4c-4290-a12f-2865988ab2e9.
GET http://blackpearl-hostname/_rest_/bucket_change_notification_

registration/2a8154df-fa4c-4290-a12f-2865988ab2e9/ HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>
   <BucketId>0e8e91ab-a622-4fe3-9e3c-7696d9fba7cd</BucketId>
   <CreationDate>2017-02-22T00:51:02.000Z</CreationDate>
   <Format>DEFAULT</Format>
   <Id>faa51a2f-ac5d-4349-be79-a036a6b029f3</Id>
   <LastFailure/>
   <LastHttpResponseCode/>
   <LastNotification/>
   <NamingConvention>
      CAMEL_CASE_WITH_FIRST_LETTER_UPPERCASE
   </NamingConvention>
   <NotificationEndPoint>a</NotificationEndPoint>
   <NotificationHttpMethod>POST</NotificationHttpMethod>
   <NumberOfFailuresSinceLastSuccess>
      0
   </NumberOfFailuresSinceLastSuccess>
   <UserId>d40362ad-dd4e-48fd-95d4-57603d1265a8</UserId>
</Data>

GET BUCKET CHANGES NOTIFICATION REGISTRATIONS

Description
Get a list of all bucket changes notification registrations.
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Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/bucket_changes_notification_registration/

[?last_page][&page_length={32-bit integer}][&page_offset={32-bit integer}][&page_

start_marker={string}][&user_id={string}]

Request Parameters

Parameter Description Required

last_page If included, only the last page of results is returned. no

page_length The maximum number of registrations to list. The
default is all items after page_offset.

no

page_offset The starting point for the first registration to list. The
default is 0.

no

page_start_
marker

The UUID or other unique attribute for the item just
before the first item to list.
Notes:
• Specifying both page_offset and page_start_
marker causes an error.

• If neither page_offset, nor page_start_
marker are specified, the page_offset default is
used.

no

user_id 1 The UUID, username, or other unique attribute for
the user who created the notification registration.

no

1) Parameter values can use wild cards (see Wild Card Syntax on page 30).
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Responses

Response Elements
<Data>

   <BucketChangesNotificationRegistration>

      <BucketID>{string}</BucketID>

      <CreationDate>{YYYY-MM-DDThh:mm:ss.xxxZ}</CreationDate>

      <Format>DEFAULT|JSON|XML</Format>

      <Id>{string}</Id>

      <LastFailure>{string}</LastFailure>
      <LastHttpResponseCode>

{32-bit integer}

      </LastHttpResponseCode>

      <LastNotification>

{YYYY-MM-DDThh:mm:ss.xxxZ}

      </LastNotification>
      <NamingConvention>

         CONCAT_LOWERCASE|CONSTANT|UNDERSCORED|

         CAMEL_CASE_WITH_FIRST_LETTER_UPPERCASE|

         CAMEL_CASE_WITH_FIRST_LETTER_LOWERCASE

      </NamingConvention>

      <NotificationEndPoint>{string}</NotificationEndPoint>
      <NotificationHttpMethod>POST|PUT</NotificationHttpMethod>

      <NumberOfFailuresSinceLastSuccess>

{32-bit integer}

      </NumberOfFailuresSinceLastSuccess>

      <UserId>{string}</UserId>

   </BucketChangesNotificationRegistration>
   ...

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

BucketChangesNotificationRegistration The container for the information for a single
notification registration.

BucketID The UUID for the bucket for which notifications are
sent.
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Parameter Description

CreationDate The date the notification registration was created in
the format YYYY-MM-DDThh:mm:ss.xxxZ.

Format The format of the notification.
Values: DEFAULT (XML), JSON, XML

ID The UUID for the notification.

LastFailure The exception message for the last failure to send a
notification to this notification registration.

LastHttpResponseCode The last response code returned by the notification
end point.

LastNotification Date and time of the last notification attempt by the
BlackPearl gateway.

NamingConvention The scheme used for naming within the notification
sent. Values: CONCAT_LOWERCASE, CONSTANT,
UNDERSCORED, CAMEL_CASE_WITH_FIRST_LETTER_
UPPERCASE, CAMEL_CASE_WITH_FIRST_LETTER_
LOWERCASE

NotificationEnd Point The HTTP or HTTPS URL of a web server capable of
receiving notification messages from the BlackPearl
gateway.

NotificationHttp Method The HTTP request method type. Values: POST, PUT

NumberOfFailuresSinceLastSuccess Number of failed notification attempts since last
successful notification.

UserId The UUID for the user who created the notification
registration.

Example

Sample Request
This request gets information about all bucket change notification registrations.
GET http://blackpearl-hostname/_rest_/bucket_change_notification_registration/

HTTP/1.1
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Sample Response
HTTP/1.1 200 OK

<Data>
   <BucketChangesNotificationRegistration>
     <CreationDate>2020-02-22T00:50:59.000Z</CreationDate>
     <Format>DEFAULT</Format>
     <Id>4f1b3f59-b3e6-452f-8c52-207d380047cb</Id>
     <LastFailure/>
     <LastHttpResponseCode/>
     <LastNotification/>
     <NamingConvention>
        CAMEL_CASE_WITH_FIRST_LETTER_UPPERCASE
     </NamingConvention>
     <NotificationEndPoint>a</NotificationEndPoint>
     <NotificationHttpMethod>POST</NotificationHttpMethod>
     <NumberOfFailuresSinceLastSuccess>
        0
     </NumberOfFailuresSinceLastSuccess>
     <UserId>5c9ec971-11af-48cf-a348-21e30bc5c22b</UserId>
   </BucketChangesNotificationRegistration>
   <BucketChangesNotificationRegistration>
     <CreationDate>2020-02-22T00:50:59.000Z</CreationDate>
     <Format>DEFAULT</Format>
     <Id>0759cc0d-92f0-45e0-bad9-f9b664495881</Id>
     <LastFailure/>
     <LastHttpResponseCode/>
     <LastNotification/>
     <NamingConvention>
        CAMEL_CASE_WITH_FIRST_LETTER_UPPERCASE
     </NamingConvention>
     <NotificationEndPoint>b</NotificationEndPoint>
     <NotificationHttpMethod>POST</NotificationHttpMethod>
     <NumberOfFailuresSinceLastSuccess>
        0
     </NumberOfFailuresSinceLastSuccess>
     <UserId>5c9ec971-11af-48cf-a348-21e30bc5c22b</UserId>
   </BucketChangesNotificationRegistration>
</Data>
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GET BUCKET HISTORY

Description
Get the history of changes to a bucket.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/bucket_history/[?bucket_ID={string}][&last_

page][&min_sequence_number={64-bit integer}][&page_length={32-bit integer}][&page_

offset={32-bit integer}][&page_start_marker={string}]

Request Parameters

Parameter Description Required

bucket_id The UUID or other unique identifier for the
bucket. If not included, changes for all buckets
are returned.

no

last_page If included, only the last page of results is
returned.

no

min_sequence_
number

The starting sequence number to list. The
default is 1.

no

page_length The maximum number of registrations to list.
The default is all items after page_offset.

no

page_offset The starting point for the first registration to
list. The default is 0.

no

page_start_marker The UUID or other unique attribute for the
item just before the first item to list.
Notes:
• Specifying both page_offset and page_
start_marker causes an error.

• If neither page_offset, nor page_start_
marker are specified, the page_offset
default is used.

no
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Responses

Response Elements
<BucketHistory>

   <Changes>
      <BucketID>{string}</BucketID>

      <ObjectCreationDate>{YYYY-MM-DDThh:mm:ss.xxxZ}</ObjectCreationDate>

      <Id>{string}</Id>

      <ObjectName>{string}</ObjectName>

      <SequenceNumber>{32-bit integer}</SequenceNumber>
      <Type>CREATE|DELETE|MARK_LATEST|UNMARK_LATEST</Type>

      <VersionId>{string}</VersionId>
</Changes>
   ...

</BucketHistory>

where the response elements are defined as follows:

Parameter Description

BucketHistory The container for the response.

Changes The container for the information for a single change.

BucketID The UUID for the bucket for which notifications are sent.

ID The UUID for the change.

ObjectCreationDate The date the object was created in the format YYYY-MM-
DDThh:mm:ss.xxxZ.

ObjectName The name for the object.

SequenceNumber The number indicating the order in which the changes in the
bucket occurred.

Type The type of change.
Values: Create, Delete, Mark_Latest, Unmark_Latest.

VersionID The UUID of the version of the object.

April 2023 DS3 API Reference-Spectra BlackPearl Nearline Gateway
- 931 -



Chapter 17 - Notification Operations Get DS3 Target Failure Notification Registration

Example

Sample Request
This request gets the bucket history for the bucket with the UUID 0e8e91ab-a622-4fe3-9e3c-
7696d9fba7cd.
GET http://blackpearl-hostname/_rest_/bucket_history/[?bucket_ID=0e8e91ab-a622-4fe3-

9e3c-7696d9fba7cd HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<BucketHistoryEvent>
   <Changes>

      <BucketId>0e8e91ab-a622-4fe3-9e3c-7696d9fba7cd</BucketId>

      <Id>8282153d-8c51-476f-9654-56c1f6ae0035</Id>

      <ObjectCreationDate>o1</ObjectCreationDate>

      <ObjectName>o1</ObjectName>

      <SequenceNumber>1</SequenceNumber>

      <Type>CREATE</Type>

      <VersionId>567ce05b-bbd1-4afd-85f5-416d793027cb</VersionId>

   </Changes>

   <Changes>

      <BucketId>0e8e91ab-a622-4fe3-9e3c-7696d9fba7cd</BucketId>

      <Id>bd195b2d-0b6c-40cf-ac9a-c93b674a44e9</Id>

      <ObjectName>o1</ObjectName>

      <SequenceNumber>2</SequenceNumber>

      <Type>MARK_LATEST</Type>

      <VersionId>049dffae-30f9-41c8-be68-28c1e3688fe4</VersionId>

   </Changes>
<BucketHistoryEvent>

GET DS3 TARGET FAILURE NOTIFICATION REGISTRATION

Description
Get information about a DS3 target failure notification registration.
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Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/ds3_target_failure_notification_registration/

{UUID for the notification}/

To determine the UUID for a notification, see Get DS3 Target Failure Notification
Registrations on page 935.

Responses

Response Elements
<Data>

   <CreationDate>{YYYY-MM-DDThh:mm:ss.xxxZ}</CreationDate>

   <Format>DEFAULT|JSON|XML</Format>

   <Id>{string}</Id>

   <LastFailure>{string}</LastFailure>

   <LastHttpResponsoeCode>{32-bit integer}</LastHttpResponseCode>

   <LastNotification>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastNotification>

   <NamingConvention>

      CONCAT_LOWERCASE|CONSTANT|UNDERSCORED|

      CAMEL_CASE_WITH_FIRST_LETTER_UPPERCASE|

      CAMEL_CASE_WITH_FIRST_LETTER_LOWERCASE

   </NamingConvention>

   <NotificationEndPoint>{string}</NotificationEndPoint>

   <NotificationHttpMethod>POST|PUT</NotificationHttpMethod>

   <NumberOfFailuresSinceLastSuccess>

{32-bit integer}

   </NumberOfFailuresSinceLastSuccess>

   <UserId>{string}</UserId>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

CreationDate The date the notification registration was created in the
format YYYY-MM-DDThh:mm:ss.xxxZ.
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Parameter Description

Format The format of the notification.
Values: DEFAULT (XML), JSON, XML

ID The UUID for the notification.

LastFailure The exception message for the last failure to send a
notification to this notification registration.

LastHttpResponseCode The last response code returned by the notification end
point.

LastNotification Date and time of the last notification attempt by the
BlackPearl gateway.

NamingConvention The scheme used for naming within the notification sent.
Values: CONCAT_LOWERCASE, CONSTANT,
UNDERSCORED, CAMEL_CASE_WITH_FIRST_LETTER_
UPPERCASE, CAMEL_CASE_WITH_FIRST_LETTER_
LOWERCASE

NotificationEnd Point The HTTP or HTTPS URL of a web server capable of
receiving notification messages from the BlackPearl
gateway.

NotificationHttp Method The HTTP request method type. Values: POST, PUT

NumberOfFailuresSinceLastSuccess Number of failed notification attempts since last
successful notification.

UserId The UUID for the user who created the notification
registration.

Example

Sample Request
This request gets information about the DS3 target failure notification registration with the
UUID 2a8154df-fa4c-4290-a12f-2865988ab2e9.
GET http://blackpearl-hostname/_rest_/ds3_target_failure_notification_

registration/2a8154df-fa4c-4290-a12f-2865988ab2e9/ HTTP/1.1
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Sample Response
HTTP/1.1 200 OK

<Data>

   <CreationDate>2016-06-09T01:14:51.000Z</CreationDate>

   <Format>DEFAULT</Format>

   <Id>2a8154df-fa4c-4290-a12f-2865988ab2e9</Id>

   <LastFailure/>

   <LastHttpResponseCode/>

   <LastNotification/>

   <NamingConvention>

      CAMEL_CASE_WITH_FIRST_LETTER_UPPERCASE

   </NamingConvention>

   <NotificationEndPoint>

      DS3-client-hostname

   </NotificationEndPoint>

   <NotificationHttpMethod>POST</NotificationHttpMethod>

   <NumberOfFailuresSinceLastSuccess>

      0

   </NumberOfFailuresSinceLastSuccess>

   <UserId>26d35f40-d899-441d-9506-937b7cdd67eb</UserId>

</Data>

GET DS3 TARGET FAILURE NOTIFICATION REGISTRATIONS

Description
Get a list of all DS3 target failure notification registrations.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/ds3_target_failure_notification_registration/

[?last_page][&page_length={32-bit integer}][&page_offset={32-bit integer}][&page_

start_marker={string}][&user_id={string}]
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Request Parameters

Parameter Description Required

last_page If included, only the last page of results is returned. no

page_length The maximum number of registrations to list. The default is all
items after page_offset.

no

page_offset The starting point for the first registration to list. The default is 0. no

page_start_
marker

The UUID or other unique attribute for the item just before the first
item to list.
Notes:
• Specifying both page_offset and page_start_marker causes
an error.

• If neither page_offset, nor page_start_marker are specified,
the page_offset default is used.

no

user_id 1 The UUID, username, or other unique attribute for the user who
created the notification registration.

no

Responses

Response Elements
<Data>

   <Ds3TargetFailureNotificationRegistration>

      <CreationDate>{YYYY-MM-DDThh:mm:ss.xxxZ}</CreationDate>

      <Format>DEFAULT|JSON|XML</Format>

      <Id>{string}</Id>

      <LastFailure>{string}</LastFailure>
      <LastHttpResponseCode>

{32-bit integer}

      </LastHttpResponseCode>

      <LastNotification>

{YYYY-MM-DDThh:mm:ss.xxxZ}

      </LastNotification>

1) Parameter values can use wild cards (see Wild Card Syntax on page 30).
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      <NamingConvention>

         CONCAT_LOWERCASE|CONSTANT|UNDERSCORED|

         CAMEL_CASE_WITH_FIRST_LETTER_UPPERCASE|

         CAMEL_CASE_WITH_FIRST_LETTER_LOWERCASE

      </NamingConvention>

      <NotificationEndPoint>{string}</NotificationEndPoint>

      <NotificationHttpMethod>POST|PUT</NotificationHttpMethod>
      <NumberOfFailuresSinceLastSuccess>

{32-bit integer}

      </NumberOfFailuresSinceLastSuccess>

      <UserId>{string}</UserId>

   </Ds3TargetFailureNotificationRegistration>

   ...

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

Ds3TargetFailure Notification
Registration

The container for the information for a single notification
registration.

CreationDate The date the notification registration was created in the
format YYYY-MM-DDThh:mm:ss.xxxZ.

Format The format of the notification.
Values: DEFAULT (XML), JSON, XML

ID The UUID for the notification.

LastFailure The exception message for the last failure to send a
notification to this notification registration.

LastHttpResponseCode The last response code returned by the notification end
point.

LastNotification Date and time of the last notification attempt by the
BlackPearl gateway.

NamingConvention The scheme used for naming within the notification sent.
Values: CONCAT_LOWERCASE, CONSTANT,
UNDERSCORED, CAMEL_CASE_WITH_FIRST_LETTER_
UPPERCASE, CAMEL_CASE_WITH_FIRST_LETTER_
LOWERCASE
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Parameter Description

NotificationEnd Point The HTTP or HTTPS URL of a web server capable of
receiving notification messages from the BlackPearl
gateway.

NotificationHttp Method The HTTP request method type. Values: POST, PUT

NumberOfFailuresSinceLastSuccess Number of failed notification attempts since last
successful notification.

UserId The UUID for the user who created the notification
registration.

Example

Sample Request
This request gets information about all DS3 target failure notification registrations.
GET http://blackpearl-hostname/_rest_/ds3_target_failure_notification_registration/

HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>

   <Ds3TargetFailureNotificationRegistration>

      <CreationDate>2016-06-09T01:14:52.000Z</CreationDate>

      <Format>DEFAULT</Format>

      <Id>a662e451-9db7-4274-8c05-845d2a422988</Id>

      <LastFailure/>

      <LastHttpResponseCode/>

      <LastNotification/>
      <NamingConvention>

         CAMEL_CASE_WITH_FIRST_LETTER_UPPERCASE

      </NamingConvention>

      <NotificationEndPoint>

         DS3-client-hostname

      </NotificationEndPoint>
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      <NotificationHttpMethod>POST</NotificationHttpMethod>

      <NumberOfFailuresSinceLastSuccess>

         0

      </NumberOfFailuresSinceLastSuccess>

      <UserId>6698ab0d-2257-47ff-bec1-ec5d1f9f2e61</UserId>

   </Ds3TargetFailureNotificationRegistration>

</Data>

GET JOB COMPLETED NOTIFICATION REGISTRATION

Description
Get information about a job completed notification registration.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/job_completed_notification_registration/{UUID

for the notification}/

To determine the UUID for a notification, see Get Job Completed Notification Registrations
on page 942.

Responses

Response Elements
<Data>

   <CreationDate>{YYYY-MM-DDThh:mm:ss.xxxZ}</CreationDate>

   <Format>DEFAULT|JSON|XML</Format>

   <Id>{string}</Id>

   <JobId>{string}</JobId>

   <LastFailure>{string}</LastFailure>

   <LastHttpResponseCode>{32-bit integer}</LastHttpResponseCode>

   <LastNotification>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastNotification>
   <NamingConvention>

      CONCAT_LOWERCASE|CONSTANT|UNDERSCORED|

      CAMEL_CASE_WITH_FIRST_LETTER_UPPERCASE|

      CAMEL_CASE_WITH_FIRST_LETTER_LOWERCASE

   </NamingConvention>
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   <NotificationEndPoint>{string}</NotificationEndPoint>
   <NotificationHttpMethod>POST|PUT</NotificationHttpMethod>

   <NumberOfFailuresSinceLastSuccess>

{32-bit integer}

   </NumberOfFailuresSinceLastSuccess>

   <UserId>{string}</UserId>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

CreationDate The date the notification registration was created in the
format YYYY-MM-DDThh:mm:ss.xxxZ.

Format The format of the notification.
Values: DEFAULT (XML), JSON, XML

ID The UUID for the notification.

JobId The UUID for the job that completed.

LastFailure The exception message for the last failure to send a
notification to this notification registration.

LastHttpResponseCode The last response code returned by the notification end
point.

LastNotification Date and time of the last notification attempt by the
BlackPearl gateway.

NamingConvention The scheme used for naming within the notification sent.
Values: CONCAT_LOWERCASE, CONSTANT,
UNDERSCORED, CAMEL_CASE_WITH_FIRST_LETTER_
UPPERCASE, CAMEL_CASE_WITH_FIRST_LETTER_
LOWERCASE

NotificationEnd Point The HTTP or HTTPS URL of a web server capable of
receiving notification messages from the BlackPearl
gateway.

NotificationHttp Method The HTTP request method type. Values: POST, PUT

NumberOfFailuresSinceLastSuccess Number of failed notification attempts since last
successful notification.
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Parameter Description

UserId The UUID for the user who created the notification
registration.

Example

Sample Request
This request gets information about the job completed notification registration with the UUID
e2ae9bc2-d70e-46d4-9af7-82d971827cb8.
GET http://blackpearl-hostname/_rest_/job_completed_notification_

registration/e2ae9bc2-d70e-46d4-9af7-82d971827cb8/ HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>

   <CreationDate>2014-10-16T18:33:58.339Z</CreationDate>

   <Format>DEFAULT</Format>

   <Id>e2ae9bc2-d70e-46d4-9af7-82d971827cb8</Id>

   <JobId>14112486-8adc-4015-be56-2261c58f2dab</JobId>

   <LastFailure/>
   <LastHttpResponseCode/>

   <LastNotification/>

   <NamingConvention>

      CAMEL_CASE_WITH_FIRST_LETTER_UPPERCASE
   </NamingConvention>

   <NotificationEndPoint>

      DS3-client-hostname

   </NotificationEndPoint>

   <NotificationHttpMethod>POST</NotificationHttpMethod>
   <NumberOfFailuresSinceLastSuccess>

      0

   </NumberOfFailuresSinceLastSuccess>

   <UserId>930460a4-0bfc-46ea-a03c-49da45944c50</UserId>

</Data>
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GET JOB COMPLETED NOTIFICATION REGISTRATIONS

Description
Get a list of all job completed notification registrations.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/job_completed_notification_registration/

[?last_page][&page_length={32-bit integer}][&page_offset={32-bit integer}][&page_

start_marker={string}][&user_id={string}]

Request Parameters

Parameter Description Required

last_page If included, only the last page of results is returned. no

page_length The maximum number of registrations to list. The default is all
items after page_offset.

no

page_offset The starting point for the first registration to list. The default is 0. no

page_start_
marker

The UUID or other unique attribute for the item just before the first
item to list.
Notes:
• Specifying both page_offset and page_start_marker causes
an error.

• If neither page_offset, nor page_start_marker are specified,
the page_offset default is used.

no

user_id 1 The UUID, username, or other unique attribute for the user who
created the notification registration.

no

1) Parameter values can use wild cards (see Wild Card Syntax on page 30).
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Responses

Response Elements
<Data>

   <JobCompletedNotificationRegistration>

      <CreationDate>{YYYY-MM-DDThh:mm:ss.xxxZ}</CreationDate>

      <Format>DEFAULT|JSON|XML</Format>

      <Id>{string}</Id>

      <JobId>{string}</JobId>

      <LastFailure>{string}</LastFailure>
      <LastHttpResponseCode>

{32-bit integer}

      </LastHttpResponseCode>

      <LastNotification>

{YYYY-MM-DDThh:mm:ss.xxxZ}

      </LastNotification>
      <NamingConvention>

         CONCAT_LOWERCASE|CONSTANT|UNDERSCORED|

         CAMEL_CASE_WITH_FIRST_LETTER_UPPERCASE|

         CAMEL_CASE_WITH_FIRST_LETTER_LOWERCASE

      </NamingConvention>

      <NotificationEndPoint>{string}</NotificationEndPoint>
      <NotificationHttpMethod>POST|PUT</NotificationHttpMethod>

      <NumberOfFailuresSinceLastSuccess>

{32-bit integer}

      </NumberOfFailuresSinceLastSuccess>

      <UserId>{string}</UserId>

   </JobCompletedNotificationRegistration>

   ...

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

JobCompleted Notification
Registration

The container for the information for a single notification
registration.

CreationDate The date the notification registration was created in the
format YYYY-MM-DDThh:mm:ss.xxxZ.
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Parameter Description

Format The format of the notification.
Values: DEFAULT (XML), JSON, XML

ID The UUID for the notification.

JobId The UUID for the job that completed.

LastFailure The exception message for the last failure to send a
notification to this notification registration.

LastHttpResponseCode The last response code returned by the notification end
point.

LastNotification Date and time of the last notification attempt by the
BlackPearl gateway.

NamingConvention The scheme used for naming within the notification sent.
Values: CONCAT_LOWERCASE, CONSTANT,
UNDERSCORED, CAMEL_CASE_WITH_FIRST_LETTER_
UPPERCASE, CAMEL_CASE_WITH_FIRST_LETTER_
LOWERCASE

NotificationEnd Point The HTTP or HTTPS URL of a web server capable of
receiving notification messages from the BlackPearl
gateway.

NotificationHttp Method The HTTP request method type. Values: POST, PUT

NumberOfFailuresSinceLastSuccess Number of failed notification attempts since last
successful notification.

UserId The UUID for the user who created the notification
registration.

Example

Sample Request
This request gets information about all job completed notification registrations.
GET http://blackpearl-hostname/_rest_/job_completed_notification_registration/

HTTP/1.1
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Sample Response
HTTP/1.1 200 OK

<Data>

   <JobCompletedNotificationRegistration>

      <CreationDate>2014-10-16T18:33:53.31Z</CreationDate>

      <Format>DEFAULT</Format>

      <Id>14362d62-2d3c-490e-b369-34df3dcb474a</Id>

      <JobId>1999523d-df6f-4c22-b8b2-82becc55e0a2</JobId>
      <LastFailure/>

      <LastHttpResponseCode/>

      <LastNotification/>

      <NamingConvention>

         CAMEL_CASE_WITH_FIRST_LETTER_UPPERCASE

      </NamingConvention>
      <NotificationEndPoint>

         DS3-client-hostname

      </NotificationEndPoint>

      <NotificationHttpMethod>POST</NotificationHttpMethod>
      <NumberOfFailuresSinceLastSuccess>

         0

      </NumberOfFailuresSinceLastSuccess>

      <UserId>2cc42ec3-fb32-4fcb-a421-437f5fb18531</UserId>

   </JobCompletedNotificationRegistration>

   ...

</Data>

GET JOB CREATED NOTIFICATION REGISTRATION

Description
Get information about a job created notification registration.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/job_created_notification_registration/{UUID

for the notification}/

To determine the UUID for a notification, see Get Job Created Notification Registrations on
page 948.
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Responses

Response Elements
<Data>

   <CreationDate>{YYYY-MM-DDThh:mm:ss.xxxZ}</CreationDate>

   <Format>DEFAULT|JSON|XML</Format>

   <Id>{string}</Id>

   <LastFailure>{string}</LastFailure>

   <LastHttpResponseCode>{32-bit integer}</LastHttpResponseCode>

   <LastNotification>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastNotification>

   <NamingConvention>

      CONCAT_LOWERCASE|CONSTANT|UNDERSCORED|

      CAMEL_CASE_WITH_FIRST_LETTER_UPPERCASE|

      CAMEL_CASE_WITH_FIRST_LETTER_LOWERCASE

   </NamingConvention>

   <NotificationEndPoint>{string}</NotificationEndPoint>

   <NotificationHttpMethod>POST|PUT</NotificationHttpMethod>

   <NumberOfFailuresSinceLastSuccess>

{32-bit integer}

   </NumberOfFailuresSinceLastSuccess>

   <UserId>{string}</UserId>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

CreationDate The date the notification registration was created in the
format YYYY-MM-DDThh:mm:ss.xxxZ.

Format The format of the notification.
Values: DEFAULT (XML), JSON, XML

ID The UUID for the notification.

LastFailure The exception message for the last failure to send a
notification to this notification registration.

LastHttpResponseCode The last response code returned by the notification end
point.
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Parameter Description

LastNotification Date and time of the last notification attempt by the
BlackPearl gateway.

NamingConvention The scheme used for naming within the notification
sent. Values: CONCAT_LOWERCASE, CONSTANT,
UNDERSCORED, CAMEL_CASE_WITH_FIRST_LETTER_
UPPERCASE, CAMEL_CASE_WITH_FIRST_LETTER_
LOWERCASE

NotificationEnd Point The HTTP or HTTPS URL of a web server capable of
receiving notification messages from the BlackPearl
gateway.

NotificationHttp Method The HTTP request method type. Values: POST, PUT

NumberOfFailuresSinceLastSuccess Number of failed notification attempts since last
successful notification.

UserId The UUID for the user who created the notification
registration.

Example

Sample Request
This request gets information about the job created notification registration with the UUID
dfe027c8-e3ba-4e8a-a484-66d5577d5040.
GET http://blackpearl-hostname/_rest_/job_created_notification_

registration/dfe027c8-e3ba-4e8a-a484-66d5577d5040/ HTTP/1.1
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Sample Response
HTTP/1.1 200 OK

<Data>

   <CreationDate>2014-10-16T18:33:48.334Z</CreationDate>

   <Format>DEFAULT</Format>

   <Id>dfe027c8-e3ba-4e8a-a484-66d5577d5040</Id>

   <LastFailure/>

   <LastHttpResponseCode/>

   <LastNotification/>

   <NamingConvention>

      CAMEL_CASE_WITH_FIRST_LETTER_UPPERCASE

   </NamingConvention>

   <NotificationEndPoint>

      DS3-client-hostname

   </NotificationEndPoint>

   <NotificationHttpMethod>POST</NotificationHttpMethod>

   <NumberOfFailuresSinceLastSuccess>

      0

   </NumberOfFailuresSinceLastSuccess>

   <UserId>839bb9f6-c5b8-486f-9298-bb05e98f485b</UserId>

</Data>

GET JOB CREATED NOTIFICATION REGISTRATIONS

Description

Get a list of all job created notification registrations.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/job_created_notification_registration/[?last_

page][&page_length={32-bit integer}][&page_offset={32-bit integer}][&page_start_

marker={string}][&user_id={string}]
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Request Parameters

Parameter Description Required

last_page If included, only the last page of results is returned. no

page_length The maximum number of registrations to list. The default is all
items after page_offset.

no

page_offset The starting point for the first registration to list. The default is 0. no

page_start_
marker

The UUID or other unique attribute for the item just before the first
item to list.
Notes:
• Specifying both page_offset and page_start_marker causes
an error.

• If neither page_offset, nor page_start_marker are specified,
the page_offset default is used.

no

user_id 1 The UUID, username, or other unique attribute for the user who
created the notification registration.

no

Responses

Response Elements
<Data>

   <JobCreatedNotificationRegistration>

      <CreationDate>{YYYY-MM-DDThh:mm:ss.xxxZ}</CreationDate>

      <Format>DEFAULT|JSON|XML</Format>

      <Id>{string}</Id>

      <LastFailure>{string}</LastFailure>
      <LastHttpResponseCode>

{32-bit integer}

      </LastHttpResponseCode>
      <LastNotification>

{YYYY-MM-DDThh:mm:ss.xxxZ}

      </LastNotification>
      <NamingConvention>

         CONCAT_LOWERCASE|CONSTANT|UNDERSCORED|

         CAMEL_CASE_WITH_FIRST_LETTER_UPPERCASE|

         CAMEL_CASE_WITH_FIRST_LETTER_LOWERCASE

      </NamingConvention>

1) Parameter values can use wild cards (see Wild Card Syntax on page 30).
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      <NotificationEndPoint>{string}</NotificationEndPoint>

      <NotificationHttpMethod>POST|PUT</NotificationHttpMethod>
      <NumberOfFailuresSinceLastSuccess>

{32-bit integer}

      </NumberOfFailuresSinceLastSuccess>

      <UserId>{string}</UserId>

   </JobCreatedNotificationRegistration>

   ...

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

JobCreated Notification Registration The container for the information for a single notification
registration.

CreationDate The date the notification registration was created in the
format YYYY-MM-DDThh:mm:ss.xxxZ.

Format The format of the notification.
Values: DEFAULT (XML), JSON, XML

ID The UUID for the notification.

LastFailure The exception message for the last failure to send a
notification to this notification registration.

LastHttpResponseCode The last response code returned by the notification end
point.

LastNotification Date and time of the last notification attempt by the
BlackPearl gateway.

NamingConvention The scheme used for naming within the notification sent.
Values: CONCAT_LOWERCASE, CONSTANT,
UNDERSCORED, CAMEL_CASE_WITH_FIRST_LETTER_
UPPERCASE, CAMEL_CASE_WITH_FIRST_LETTER_
LOWERCASE

NotificationEnd Point The HTTP or HTTPS URL of a web server capable of
receiving notification messages from the BlackPearl
gateway.

NotificationHttp Method The HTTP request method type. Values: POST, PUT
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Parameter Description

NumberOfFailuresSinceLastSuccess Number of failed notification attempts since last
successful notification.

UserId The UUID for the user who created the notification
registration.

Example

Sample Request
This request gets information about all job created notification registrations.
GET http://blackpearl-hostname/_rest_/job_created_notification_registration/

HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>

   <JobCreatedNotificationRegistration>

      <CreationDate>2014-10-16 18:34:02.431</CreationDate>

      <Format>DEFAULT</Format>

      <Id>8ef0579c-7fd9-463b-acde-2c91024d9cbd</Id>

      <LastFailure/>

      <LastHttpResponseCode/>

      <LastNotification/>
      <NamingConvention>

         CAMEL_CASE_WITH_FIRST_LETTER_UPPERCASE

      </NamingConvention>

      <NotificationEndPoint>

         DS3-client-hostname

      </NotificationEndPoint>
      <NotificationHttpMethod>POST</NotificationHttpMethod>

      <NumberOfFailuresSinceLastSuccess>

         0

      </NumberOfFailuresSinceLastSuccess>

      <UserId>14d99f82-4bcb-4786-9a7e-eee14b35d665</UserId>

   </JobCreatedNotificationRegistration>

   ...

</Data>
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GET JOB CREATION FAILED NOTIFICATION REGISTRATION

Description
Get information about a job creation failed notification registration.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/job_creation_failed_notification_

registration/{UUID for the notification}/

To determine the UUID for a notification, see Get Job Creation Failed Notification
Registrations on page 954.

Responses

Response Elements
<Data>

   <CreationDate>{YYYY-MM-DDThh:mm:ss.xxxZ}</CreationDate>

   <Format>DEFAULT|JSON|XML</Format>

   <Id>{string}</Id>

   <LastFailure>{string}</LastFailure>

   <LastHttpResponseCode>{32-bit integer}</LastHttpResponseCode>

   <LastNotification>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastNotification>
   <NamingConvention>

      CONCAT_LOWERCASE|CONSTANT|UNDERSCORED|

      CAMEL_CASE_WITH_FIRST_LETTER_UPPERCASE|

      CAMEL_CASE_WITH_FIRST_LETTER_LOWERCASE

   </NamingConvention>
   <NotificationEndPoint>{string}</NotificationEndPoint>

   <NotificationHttpMethod>POST|PUT</NotificationHttpMethod>
   <NumberOfFailuresSinceLastSuccess>

{32-bit integer}

   </NumberOfFailuresSinceLastSuccess>

   <UserId>{string}</UserId>

</Data>
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where the response elements are defined as follows:

Parameter Description

Data The container for the response.

CreationDate The date the notification registration was created in the
format YYYY-MM-DDThh:mm:ss.xxxZ.

Format The format of the notification.
Values: DEFAULT (XML), JSON, XML

ID The UUID for the notification.

LastFailure The exception message for the last failure to send a
notification to this notification registration.

LastHttpResponseCode The last response code returned by the notification end
point.

LastNotification Date and time of the last notification attempt by the
BlackPearl gateway.

NamingConvention The scheme used for naming within the notification sent.
Values: CONCAT_LOWERCASE, CONSTANT,
UNDERSCORED, CAMEL_CASE_WITH_FIRST_LETTER_
UPPERCASE, CAMEL_CASE_WITH_FIRST_LETTER_
LOWERCASE

NotificationEnd Point The HTTP or HTTPS URL of a web server capable of
receiving notification messages from the BlackPearl
gateway.

NotificationHttp Method The HTTP request method type. Values: POST, PUT

NumberOfFailuresSinceLastSuccess Number of failed notification attempts since last
successful notification.

UserId The UUID for the user who created the notification
registration.
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Example

Sample Request
This request gets information about the job creation failed notification registration with the
UUID d55d6358-8958-4bf8-b954-d1068c29b0e09.
GET http://blackpearl-hostname/_rest_/job_creation_failed_notification_

registration/d55d6358-8958-4bf8-b954-d1068c29b0e0/ HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>

   <CreationDate>2016-06-09T01:14:51.000Z</CreationDate>

   <Format>DEFAULT</Format>

   <Id>d55d6358-8958-4bf8-b954-d1068c29b0e0</Id>

   <LastFailure/>
   <LastHttpResponseCode/>

   <LastNotification/>

   <NamingConvention>

      CAMEL_CASE_WITH_FIRST_LETTER_UPPERCASE

   </NamingConvention>
   <NotificationEndPoint>

      DS3-client-hostname

   </NotificationEndPoint>
   <NotificationHttpMethod>POST</NotificationHttpMethod>

   <NumberOfFailuresSinceLastSuccess>

      0

   </NumberOfFailuresSinceLastSuccess>

   <UserId>2a75b7dc-f492-45f6-a9d8-1b6fcff1bc46</UserId>

</Data>

GET JOB CREATION FAILED NOTIFICATION REGISTRATIONS

Description
Get a list of all job creation failed notification registrations.
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Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/job_creation_failed_notification_

registration/[?last_page][&page_length={32-bit integer}][&page_offset=

{32-bit integer}][&page_start_marker={string}][&user_id={string}]

Request Parameters

Parameter Description Required

last_page If included, only the last page of results is returned. no

page_length The maximum number of registrations to list. The default is all
items after page_offset.

no

page_offset The starting point for the first registration to list. The default is 0. no

page_start_
marker

The UUID or other unique attribute for the item just before the first
item to list.
Notes:
• Specifying both page_offset and page_start_marker causes
an error.

• If neither page_offset, nor page_start_marker are specified,
the page_offset default is used.

no

user_id 1 The UUID, username, or other unique attribute for the user who
created the notification registration.

no

1) Parameter values can use wild cards (see Wild Card Syntax on page 30).
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Responses

Response Elements
<Data>

   <JobCreationFailedNotificationRegistration>

      <CreationDate>{YYYY-MM-DDThh:mm:ss.xxxZ}</CreationDate>

      <Format>DEFAULT|JSON|XML</Format>

      <Id>{string}</Id>

      <LastFailure>{string}</LastFailure>

      <LastHttpResponseCode>

{32-bit integer}

      </LastHttpResponseCode>

      <LastNotification>

{YYYY-MM-DDThh:mm:ss.xxxZ}

      </LastNotification>
      <NamingConvention>

         CONCAT_LOWERCASE|CONSTANT|UNDERSCORED|

         CAMEL_CASE_WITH_FIRST_LETTER_UPPERCASE|

         CAMEL_CASE_WITH_FIRST_LETTER_LOWERCASE

      </NamingConvention>

      <NotificationEndPoint>{string}</NotificationEndPoint>

      <NotificationHttpMethod>POST|PUT</NotificationHttpMethod>

      <NumberOfFailuresSinceLastSuccess>

{32-bit integer}

      </NumberOfFailuresSinceLastSuccess>

      <UserId>{string}</UserId>

   </JobCreationFailedNotificationRegistration>

   ...

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

JobCreationFailedNotification
Registration

The container for the information for a single notification
registration.

CreationDate The date the notification registration was created in the
format YYYY-MM-DDThh:mm:ss.xxxZ.
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Parameter Description

Format The format of the notification.
Values: DEFAULT (XML), JSON, XML

ID The UUID for the notification.

LastFailure The exception message for the last failure to send a
notification to this notification registration.

LastHttpResponseCode The last response code returned by the notification end
point.

LastNotification Date and time of the last notification attempt by the
BlackPearl gateway.

NamingConvention The scheme used for naming within the notification sent.
Values: CONCAT_LOWERCASE, CONSTANT,
UNDERSCORED, CAMEL_CASE_WITH_FIRST_LETTER_
UPPERCASE, CAMEL_CASE_WITH_FIRST_LETTER_
LOWERCASE

NotificationEnd Point The HTTP or HTTPS URL of a web server capable of
receiving notification messages from the BlackPearl
gateway.

NotificationHttp Method The HTTP request method type. Values: POST, PUT

NumberOfFailuresSinceLastSuccess Number of failed notification attempts since last
successful notification.

UserId The UUID for the user who created the notification
registration.

Example

Sample Request
This request gets information about all job creation failed notification registrations.
GET http://blackpearl-hostname/_rest_/job_creation_failed_notification_registration/

HTTP/1.1
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Sample Response
HTTP/1.1 200 OK

<Data>

   <JobCreationFailedNotificationRegistration>

      <CreationDate>2016-06-09T01:14:52.000Z</CreationDate>

      <Format>DEFAULT</Format>

      <Id>a662e451-9db7-4274-8c05-845d2a422988</Id>

      <LastFailure/>

      <LastHttpResponseCode/>

      <LastNotification/>

      <NamingConvention>

         CAMEL_CASE_WITH_FIRST_LETTER_UPPERCASE

      </NamingConvention>

      <NotificationEndPoint>

         DS3-client-hostname

      </NotificationEndPoint>

      <NotificationHttpMethod>POST</NotificationHttpMethod>

      <NumberOfFailuresSinceLastSuccess>

         0

      </NumberOfFailuresSinceLastSuccess>

      <UserId>6698ab0d-2257-47ff-bec1-ec5d1f9f2e61</UserId>

   </JobCreationFailedNotificationRegistration>

   ...

</Data>

GET OBJECT CACHED NOTIFICATION REGISTRATION

Description
Get an object cached notification registration.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/object_cached_notification_registration/{UUID

for the notification}/

To determine the UUID for a notification, see Get Object Cached Notification Registrations on
page 961.
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Responses

Response Elements
<Data>

   <CreationDate>{YYYY-MM-DDThh:mm:ss.xxxZ}</CreationDate>

   <Format>DEFAULT|JSON|XML</Format>

   <Id>{string}</Id>

   <JobId>{string}</JobId>

   <LastFailure>{string}</LastFailure>

   <LastHttpResponseCode>{32-bit integer}</LastHttpResponseCode>

   <LastNotification>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastNotification>

   <NamingConvention>

      CONCAT_LOWERCASE|CONSTANT|UNDERSCORED|

      CAMEL_CASE_WITH_FIRST_LETTER_UPPERCASE|

      CAMEL_CASE_WITH_FIRST_LETTER_LOWERCASE

   </NamingConvention>

   <NotificationEndPoint>{string}</NotificationEndPoint>

   <NotificationHttpMethod>POST|PUT</NotificationHttpMethod>

   <NumberOfFailuresSinceLastSuccess>

{32-bit integer}

   </NumberOfFailuresSinceLastSuccess>

   <UserId>{string}</UserId>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

CreationDate The date the notification registration was created in the
format YYYY-MM-DDThh:mm:ss.xxxZ.

Format The format of the notification.
Values: DEFAULT (XML), JSON, XML

ID The UUID for the notification.

JobId The UUID for the job that cached the object.

LastFailure The exception message for the last failure to send a
notification to this notification registration.
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Parameter Description

LastHttpResponseCode The last response code returned by the notification end
point.

LastNotification Date and time of the last notification attempt by the
BlackPearl gateway.

NamingConvention The scheme used for naming within the notification sent.
Values: CONCAT_LOWERCASE, CONSTANT,
UNDERSCORED, CAMEL_CASE_WITH_FIRST_LETTER_
UPPERCASE, CAMEL_CASE_WITH_FIRST_LETTER_
LOWERCASE

NotificationEnd Point The HTTP or HTTPS URL of a web server capable of
receiving notification messages from the BlackPearl
gateway.

NotificationHttp Method The HTTP request method type. Values: POST, PUT

NumberOfFailuresSinceLastSuccess Number of failed notification attempts since last
successful notification.

UserId The UUID for the user who created the notification
registration.

Example

Sample Request
This request gets information about the object cached notification registration with the UUID
b7ed9175-aeb5-4cee-a696-0c858382453f.
GET http://blackpearl-hostname/_rest_/object_cached_notification_

registration/b7ed9175-aeb5-4cee-a696-0c858382453f/ HTTP/1.1
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Sample Response
HTTP/1.1 200 OK

<Data>

   <CreationDate>2014-10-16T18:33:46.093Z</CreationDate>

   <Format>DEFAULT</Format>

   <Id>b7ed9175-aeb5-4cee-a696-0c858382453f</Id>

   <JobId>9c053bdc-4a18-4c43-99db-ae61b3c9871a</JobId>

   <LastFailure/>

   <LastHttpResponseCode/>

   <LastNotification/>

   <NamingConvention>

      CAMEL_CASE_WITH_FIRST_LETTER_UPPERCASE

   </NamingConvention>

   <NotificationEndPoint>

      DS3-client-hostname

   </NotificationEndPoint>

   <NotificationHttpMethod>POST</NotificationHttpMethod>

   <NumberOfFailuresSinceLastSuccess>

      0

   </NumberOfFailuresSinceLastSuccess>

   <UserId>fd7e3b64-f33a-4cc0-bbc2-87b2c6f3f8af</UserId>

</Data>

GET OBJECT CACHED NOTIFICATION REGISTRATIONS

Description
Get a list of all object cached notification registrations.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/object_cached_notification_registration/

[?last_page][&page_length={32-bit integer}][&page_offset={32-bit integer}][&page_

start_marker={string}][&user_id={string}]
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Request Parameters

Parameter Description Required

last_page If included, only the last page of results is returned. no

page_length The maximum number of registrations to list. The default is all
items after page_offset.

no

page_offset The starting point for the first registration to list. The default is 0. no

page_start_
marker

The UUID or other unique attribute for the item just before the first
item to list.
Notes:
• Specifying both page_offset and page_start_marker causes
an error.

• If neither page_offset, nor page_start_marker are specified,
the page_offset default is used.

no

user_id 1 The UUID, username, or other unique attribute for the user who
created the notification.

no

Responses

Response Elements
<Data>

   <S3ObjectCachedNotificationRegistration>

      <CreationDate>{YYYY-MM-DDThh:mm:ss.xxxZ}</CreationDate>

      <Format>DEFAULT|JSON|XML</Format>

      <Id>{string}</Id>

      <JobId>{string}</JobId>

      <LastFailure>{string}</LastFailure>
      <LastHttpResponseCode>

{32-bit integer}

      </LastHttpResponseCode>

      <LastNotification>

{YYYY-MM-DDThh:mm:ss.xxxZ}

      </LastNotification>

1) Parameter values can use wild cards (see Wild Card Syntax on page 30).
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      <NamingConvention>

         CONCAT_LOWERCASE|CONSTANT|UNDERSCORED|

         CAMEL_CASE_WITH_FIRST_LETTER_UPPERCASE|

         CAMEL_CASE_WITH_FIRST_LETTER_LOWERCASE

      </NamingConvention>
      <NotificationEndPoint>{string}</NotificationEndPoint>

      <NotificationHttpMethod>POST|PUT</NotificationHttpMethod>
      <NumberOfFailuresSinceLastSuccess>

{32-bit integer}

      </NumberOfFailuresSinceLastSuccess>

      <UserId>{string}</UserId>

   </S3ObjectCachedNotificationRegistration>

   ...

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

S3ObjectCached Notification
Registration

The container for the information for a single notification
registration.

CreationDate The date the notification registration was created in the
format YYYY-MM-DDThh:mm:ss.xxxZ.

Format The format of the notification.
Values: DEFAULT (XML), JSON, XML

ID The UUID for the notification.

JobId The UUID for the job that cached the object.

LastFailure The exception message for the last failure to send a
notification to this notification registration.

LastHttpResponseCode The last response code returned by the notification end
point.

LastNotification Date and time of the last notification attempt by the
BlackPearl gateway.
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Parameter Description

NamingConvention The scheme used for naming within the notification sent.
Values: CONCAT_LOWERCASE, CONSTANT,
UNDERSCORED, CAMEL_CASE_WITH_FIRST_LETTER_
UPPERCASE, CAMEL_CASE_WITH_FIRST_LETTER_
LOWERCASE

NotificationEnd Point The HTTP or HTTPS URL of a web server capable of
receiving notification messages from the BlackPearl
gateway.

NotificationHttp Method The HTTP request method type. Values: POST, PUT

NumberOfFailuresSinceLastSuccess Number of failed notification attempts since last
successful notification.

UserId The UUID for the user who created the notification
registration.

Example

Sample Request
This request gets information about all object cached notification registrations.
GET http://blackpearl-hostname/_rest_/object_cached_notification_registration/

HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>

   <S3ObjectCachedNotificationRegistration>

      <CreationDate>2014-10-16T18:33:58.753Z</CreationDate>

      <Format>DEFAULT</Format>

      <Id>fd5222a4-6eb3-486b-8c2d-64e2eb4fcb75</Id>

      <JobId>f0904baa-27e1-491c-8826-beddf613683f</JobId>
      <LastFailure/>

      <LastHttpResponseCode/>

      <LastNotification/>
      <NamingConvention>

         CAMEL_CASE_WITH_FIRST_LETTER_UPPERCASE

      </NamingConvention>
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      <NotificationEndPoint>

         DS3-client-hostname

      </NotificationEndPoint>
      <NotificationHttpMethod>POST</NotificationHttpMethod>
      <NumberOfFailuresSinceLastSuccess>

         0

      </NumberOfFailuresSinceLastSuccess>

      <UserId>44e582df-8e62-4981-8514-7d19650ff0c3</UserId>

   </S3ObjectCachedNotificationRegistration>

   ...

</Data>

GET OBJECT LOST NOTIFICATION REGISTRATION

Description
Get information about an object lost notification registration.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/object_lost_notification_registration/{UUID

for the notification}/

To determine the UUID for a notification, see Get Object Lost Notification Registrations on
page 968.

Responses

Response Elements
<Data>

   <CreationDate>{YYYY-MM-DDThh:mm:ss.xxxZ}</CreationDate>

   <Format>DEFAULT|JSON|XML</Format>

   <Id>{string}</Id>

   <LastFailure>{string}</LastFailure>

   <LastHttpResponseCode>{32-bit integer}</LastHttpResponseCode>

   <LastNotification>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastNotification>
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   <NamingConvention>

      CONCAT_LOWERCASE|CONSTANT|UNDERSCORED|

      CAMEL_CASE_WITH_FIRST_LETTER_UPPERCASE|

      CAMEL_CASE_WITH_FIRST_LETTER_LOWERCASE

   </NamingConvention>
   <NotificationEndPoint>{string}</NotificationEndPoint>
   <NotificationHttpMethod>POST|PUT</NotificationHttpMethod>

   <NumberOfFailuresSinceLastSuccess>

{32-bit integer}

   </NumberOfFailuresSinceLastSuccess>

   <UserId>{string}</UserId>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

CreationDate The date the notification registration was created in the
format YYYY-MM-DDThh:mm:ss.xxxZ.

Format The format of the notification.
Values: DEFAULT (XML), JSON, XML

ID The UUID for the notification.

LastFailure The exception message for the last failure to send a
notification to this notification registration.

LastHttpResponseCode The last response code returned by the notification end
point.

LastNotification Date and time of the last notification attempt by the
BlackPearl gateway.

NamingConvention The scheme used for naming within the notification sent.
Values: CONCAT_LOWERCASE, CONSTANT,
UNDERSCORED, CAMEL_CASE_WITH_FIRST_LETTER_
UPPERCASE, CAMEL_CASE_WITH_FIRST_LETTER_
LOWERCASE

NotificationEnd Point The HTTP or HTTPS URL of a web server capable of
receiving notification messages from the BlackPearl
gateway.

NotificationHttp Method The HTTP request method type. Values: POST, PUT
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Parameter Description

NumberOfFailuresSinceLastSuccess Number of failed notification attempts since last
successful notification.

UserId The UUID for the user who created the notification
registration.

Example

Sample Request
This request gets information about the object lost notification registration with the UUID
aa663b70-878a-4d96-a1ee-6dd5a004e185.
GET http://blackpearl-hostname/_rest_/object_lost_notification_

registration/aa663b70-878a-4d96-a1ee-6dd5a004e185/ HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>

   <CreationDate>2014-10-16T18:33:53.945Z</CreationDate>

   <Format>DEFAULT</Format>

   <Id>aa663b70-878a-4d96-a1ee-6dd5a004e185</Id>

   <LastFailure/>

   <LastHttpResponseCode/>
   <LastNotification/>

   <NamingConvention>

      CAMEL_CASE_WITH_FIRST_LETTER_UPPERCASE

   </NamingConvention>
   <NotificationEndPoint>

      DS3-client-hostname

   </NotificationEndPoint>

   <NotificationHttpMethod>POST</NotificationHttpMethod>
   <NumberOfFailuresSinceLastSuccess>

      0

   </NumberOfFailuresSinceLastSuccess>

   <UserId>400a0552-1743-4dbc-809f-43b27dd2a5bb</UserId>

</Data>
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GET OBJECT LOST NOTIFICATION REGISTRATIONS

Description
Get a list of all object lost notification registrations.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/object_lost_notification_registration/[?last_

page][&page_length={32-bit integer}][&page_offset={32-bit integer}][&page_start_

marker={string}][&user_id={string}]

Request Parameters

Parameter Description Required

last_page If included, only the last page of results is returned. no

page_length The maximum number of registrations to list. The default is all
items after page_offset.

no

page_offset The starting point for the first registration to list. The default is 0. no

page_start_
marker

The UUID or other unique attribute for the item just before the first
item to list.
Notes:
• Specifying both page_offset and page_start_marker causes
an error.

• If neither page_offset, nor page_start_marker are specified,
the page_offset default is used.

no

user_id 1 The UUID, username, or other unique attribute for the user who
created the notification registration.

no

1) Parameter values can use wild cards (see Wild Card Syntax on page 30).
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Responses

Response Elements
<Data>

   <S3ObjectLostNotificationRegistration>

      <CreationDate>{YYYY-MM-DDThh:mm:ss.xxxZ}</CreationDate>

      <Format>DEFAULT|JSON|XML</Format>

      <Id>{string}</Id>

      <LastFailure>{string}</LastFailure>
      <LastHttpResponseCode>

{32-bit integer}

      </LastHttpResponseCode>

      <LastNotification>

{YYYY-MM-DDThh:mm:ss.xxxZ}

      </LastNotification>
      <NamingConvention>

         CONCAT_LOWERCASE|CONSTANT|UNDERSCORED|

         CAMEL_CASE_WITH_FIRST_LETTER_UPPERCASE|

         CAMEL_CASE_WITH_FIRST_LETTER_LOWERCASE

      </NamingConvention>
      <NotificationEndPoint>{string}</NotificationEndPoint>

      <NotificationHttpMethod>POST|PUT</NotificationHttpMethod>
      <NumberOfFailuresSinceLastSuccess>

{32-bit integer}

      </NumberOfFailuresSinceLastSuccess>

      <UserId>{string}</UserId>

   </S3ObjectLostNotificationRegistration>

   ...

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

S3ObjectLost Notification
Registration

The container for the information for a single notification
registration.

CreationDate The date the notification registration was created in the
format YYYY-MM-DDThh:mm:ss.xxxZ.
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Parameter Description

Format The format of the notification.
Values: DEFAULT (XML), JSON, XML

ID The UUID for the notification.

LastFailure The exception message for the last failure to send a
notification to this notification registration.

LastHttpResponseCode The last response code returned by the notification end
point.

LastNotification Date and time of the last notification attempt by the
BlackPearl gateway.

NamingConvention The scheme used for naming within the notification sent.
Values: CONCAT_LOWERCASE, CONSTANT,
UNDERSCORED, CAMEL_CASE_WITH_FIRST_LETTER_
UPPERCASE, CAMEL_CASE_WITH_FIRST_LETTER_
LOWERCASE

NotificationEnd Point The HTTP or HTTPS URL of a web server capable of
receiving notification messages from the BlackPearl
gateway.

NotificationHttp Method The HTTP request method type. Values: POST, PUT

NumberOfFailuresSinceLastSuccess Number of failed notification attempts since last
successful notification.

UserId The UUID for the user who created the notification
registration.

Example

Sample Request
This request gets information about all object lost notification registrations.
GET http://blackpearl-hostname/_rest_/object_lost_notification_registration/

HTTP/1.1
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Sample Response
HTTP/1.1 200 OK

<Data>

   <S3ObjectLostNotificationRegistration>

      <CreationDate>2014-10-16T18:34:00.48Z</CreationDate>

      <Format>DEFAULT</Format>

      <Id>734afa9f-0af0-476a-80c5-e4cc50358ff5</Id>

      <LastFailure/>
      <LastHttpResponseCode/>

      <LastNotification/>

      <NamingConvention>

         CAMEL_CASE_WITH_FIRST_LETTER_UPPERCASE

      </NamingConvention>
      <NotificationEndPoint>

         DS3-client-hostname

      </NotificationEndPoint>
      <NotificationHttpMethod>POST</NotificationHttpMethod>
      <NumberOfFailuresSinceLastSuccess>

         0

      </NumberOfFailuresSinceLastSuccess>

      <UserId>059b0d3d-6ac6-47e9-ab47-bce1d68b5cb6</UserId>

   </S3ObjectLostNotificationRegistration>

   ...

</Data>

GET OBJECT PERSISTED NOTIFICATION REGISTRATION

Description
Get information about an object persisted notification registration.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/object_persisted_notification_registration/

{UUID for the notification}/

To determine the UUID for a notification, see Get Object Persisted Notification Registrations
on page 974.
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Responses

Response Elements
<Data>

   <CreationDate>{YYYY-MM-DDThh:mm:ss.xxxZ}</CreationDate>

   <Format>DEFAULT|JSON|XML</Format>

   <Id>{string}</Id>

   <JobId>{string}</JobId>

   <LastFailure>{string}</LastFailure>
   <LastHttpResponseCode>{32-bit integer}</LastHttpResponseCode>

   <LastNotification>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastNotification>
   <NamingConvention>

      CONCAT_LOWERCASE|CONSTANT|UNDERSCORED|

      CAMEL_CASE_WITH_FIRST_LETTER_UPPERCASE|

      CAMEL_CASE_WITH_FIRST_LETTER_LOWERCASE

   </NamingConvention>
   <NotificationEndPoint>{string}</NotificationEndPoint>
   <NotificationHttpMethod>POST|PUT</NotificationHttpMethod>
   <NumberOfFailuresSinceLastSuccess>

{32-bit integer}

   </NumberOfFailuresSinceLastSuccess>

   <UserId>{string}</UserId>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

CreationDate The date the notification registration was created in the
format YYYY-MM-DDThh:mm:ss.xxxZ.

Format The format of the notification.
Values: DEFAULT (XML), JSON, XML

ID The UUID for the notification.

JobId The UUID for the job that wrote the object.

LastFailure The exception message for the last failure to send a
notification to this notification registration.
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Parameter Description

LastHttpResponseCode The last response code returned by the notification end
point.

LastNotification Date and time of the last notification attempt by the
BlackPearl gateway.

NamingConvention The scheme used for naming within the notification sent.
Values: CONCAT_LOWERCASE, CONSTANT,
UNDERSCORED, CAMEL_CASE_WITH_FIRST_LETTER_
UPPERCASE, CAMEL_CASE_WITH_FIRST_LETTER_
LOWERCASE

NotificationEnd Point The HTTP or HTTPS URL of a web server capable of
receiving notification messages from the BlackPearl
gateway.

NotificationHttp Method The HTTP request method type. Values: POST, PUT

NumberOfFailuresSinceLastSuccess Number of failed notification attempts since last
successful notification.

UserId The UUID for the user who created the notification
registration.

Example

Sample Request
This request gets information about the object persisted notification registration with the
UUID 9c94de0f-a8c5-454f-abcb-f3ee47c9d8b1.
GET http://blackpearl-hostname/_rest_/object_persisted_notification_

registration/9c94de0f-a8c5-454f-abcb-f3ee47c9d8b1/ HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>

   <CreationDate>2014-10-16T18:33:54.381Z</CreationDate>

   <Format>DEFAULT</Format>

   <Id>9c94de0f-a8c5-454f-abcb-f3ee47c9d8b1</Id>

   <JobId>dac25d84-eab6-4595-95ff-6a42950c7e35</JobId>

   <LastFailure/>
   <LastHttpResponseCode/>

   <LastNotification/>
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   <NamingConvention>

      CAMEL_CASE_WITH_FIRST_LETTER_UPPERCASE

   </NamingConvention>
   <NotificationEndPoint>

      DS3-client-hostname

   </NotificationEndPoint>
   <NotificationHttpMethod>POST</NotificationHttpMethod>
   <NumberOfFailuresSinceLastSuccess>

      0

   </NumberOfFailuresSinceLastSuccess>

   <UserId>7fe04a75-0fdc-4d73-8f4c-f2a0e01fc859</UserId>

</Data>

GET OBJECT PERSISTED NOTIFICATION REGISTRATIONS

Description
Get a list of all object persisted notification registrations.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/object_persisted_notification_registration/

[?last_page][&page_length={32-bit integer}][&page_offset={32-bit integer}][&page_

start_marker={string}][&user_id={string}]

Request Parameters

Parameter Description Required

last_page If included, only the last page of results is returned. no

page_length The maximum number of registrations to list. The default is all
items after page_offset.

no

page_offset The starting point for the first registration to list. The default is 0. no
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Parameter Description Required

page_start_
marker

The UUID or other unique attribute for the item just before the first
item to list.
Notes:
• Specifying both page_offset and page_start_marker causes
an error.

• If neither page_offset, nor page_start_marker are specified,
the page_offset default is used.

no

user_id 1 The UUID, username, or other unique attribute for the user who
created the notification registration.

no

Responses

Response Elements
<Data>

   <S3ObjectPersistedNotificationRegistration>

      <CreationDate>{YYYY-MM-DDThh:mm:ss.xxxZ}</CreationDate>

      <Format>DEFAULT|JSON|XML</Format>

      <Id>{string}</Id>

      <JobId>{string}</JobId>
      <LastFailure>{string}</LastFailure>

      <LastHttpResponseCode>

{32-bit integer}
      </LastHttpResponseCode>

      <LastNotification>

{YYYY-MM-DDThh:mm:ss.xxxZ}

      </LastNotification>
      <NamingConvention>

         CONCAT_LOWERCASE|CONSTANT|UNDERSCORED|

         CAMEL_CASE_WITH_FIRST_LETTER_UPPERCASE|

         CAMEL_CASE_WITH_FIRST_LETTER_LOWERCASE

      </NamingConvention>
      <NotificationEndPoint>{string}</NotificationEndPoint>

      <NotificationHttpMethod>POST|PUT</NotificationHttpMethod>

1) Parameter values can use wild cards (see Wild Card Syntax on page 30).
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      <NumberOfFailuresSinceLastSuccess>

{32-bit integer}

      </NumberOfFailuresSinceLastSuccess>

      <UserId>{string}</UserId>

   </S3ObjectPersistedNotificationRegistration>

   ...

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

S3ObjectPersistedNotification
Registration

The container for the information for a single notification
registration.

CreationDate The date the notification registration was created in the
format YYYY-MM-DDThh:mm:ss.xxxZ.

Format The format of the notification.
Values: DEFAULT (XML), JSON, XML

ID The UUID for the notification.

JobId The UUID for the job that wrote the object.

LastFailure The exception message for the last failure to send a
notification to this notification registration.

LastHttpResponseCode The last response code returned by the notification end
point.

LastNotification Date and time of the last notification attempt by the
BlackPearl gateway.

NamingConvention The scheme used for naming within the notification sent.
Values: CONCAT_LOWERCASE, CONSTANT,
UNDERSCORED, CAMEL_CASE_WITH_FIRST_LETTER_
UPPERCASE, CAMEL_CASE_WITH_FIRST_LETTER_
LOWERCASE

NotificationEnd Point The HTTP or HTTPS URL of a web server capable of
receiving notification messages from the BlackPearl
gateway.

NotificationHttp Method The HTTP request method type. Values: POST, PUT
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Parameter Description

NumberOfFailuresSinceLastSuccess Number of failed notification attempts since last
successful notification.

UserId The UUID for the user who created the notification
registration.

Example

Sample Request
This request gets information about all object persisted notification registrations.
GET http://blackpearl-hostname/_rest_/object_persisted_notification_registration/

HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>

   <S3ObjectPersistedNotificationRegistration>

      <CreationDate>2014-10-16T18:33:56.026Z</CreationDate>

      <Format>DEFAULT</Format>

      <Id>c91cd5a7-3b5b-442d-a1df-6cd5b021ebac</Id>
      <JobId>49cda2c9-934a-461a-ab76-709bf6c35d44</JobId>

      <LastFailure/>

      <LastHttpResponseCode/>
      <LastNotification/>

      <NamingConvention>

         CAMEL_CASE_WITH_FIRST_LETTER_UPPERCASE

      </NamingConvention>
      <NotificationEndPoint>

         DS3-client-hostname

      </NotificationEndPoint>
      <NotificationHttpMethod>POST</NotificationHttpMethod>
      <NumberOfFailuresSinceLastSuccess>

         0

      </NumberOfFailuresSinceLastSuccess>

      <UserId>cf2918f1-100d-4448-91fe-60dfbb1abe10</UserId>

   </S3ObjectPersistedNotificationRegistration>

   ...

</Data>
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GET POOL FAILURE NOTIFICATION REGISTRATION

Description
Get information about a pool failure notification registration.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/pool_failure_notification_registration/{UUID

for the notification}/

To determine the UUID for a notification, see Get Pool Failure Notification Registrations on
page 980.

Responses

Response Elements
<Data>

   <CreationDate>{YYYY-MM-DDThh:mm:ss.xxxZ}</CreationDate>

   <Format>DEFAULT|JSON|XML</Format>

   <Id>{string}</Id>

   <LastFailure>{string}</LastFailure>

   <LastHttpResponseCode>{32-bit integer}</LastHttpResponseCode>

   <LastNotification>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastNotification>
   <NamingConvention>

      CONCAT_LOWERCASE|CONSTANT|UNDERSCORED|

      CAMEL_CASE_WITH_FIRST_LETTER_UPPERCASE|

      CAMEL_CASE_WITH_FIRST_LETTER_LOWERCASE

   </NamingConvention>
   <NotificationEndPoint>{string}</NotificationEndPoint>
   <NotificationHttpMethod>POST|PUT</NotificationHttpMethod>
   <NumberOfFailuresSinceLastSuccess>

{32-bit integer}

   </NumberOfFailuresSinceLastSuccess>

   <UserId>{string}</UserId>

</Data>
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where the response elements are defined as follows:

Parameter Description

Data The container for the response.

CreationDate The date the notification registration was created in the
format YYYY-MM-DDThh:mm:ss.xxxZ.

Format The format of the notification.
Values: DEFAULT (XML), JSON, XML

ID The UUID for the notification.

LastFailure The exception message for the last failure to send a
notification to this notification registration.

LastHttpResponseCode The last response code returned by the notification end
point.

LastNotification Date and time of the last notification attempt by the
BlackPearl gateway.

NamingConvention The scheme used for naming within the notification sent.
Values: CONCAT_LOWERCASE, CONSTANT,
UNDERSCORED, CAMEL_CASE_WITH_FIRST_LETTER_
UPPERCASE, CAMEL_CASE_WITH_FIRST_LETTER_
LOWERCASE

NotificationEnd Point The HTTP or HTTPS URL of a web server capable of
receiving notification messages from the BlackPearl
gateway.

NotificationHttp Method The HTTP request method type. Values: POST, PUT

NumberOfFailuresSinceLastSuccess Number of failed notification attempts since last
successful notification.

UserId The UUID for the user who created the notification
registration.
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Example

Sample Request
This request gets information about the pool failure notification registration with the UUID
ab151b77-c286-497e-b2e5-034a84a34eb1.
GET http://blackpearl-hostname/_rest_/pool_failure_notification_

registration/ab151b77-c286-497e-b2e5-034a84a34eb1/ HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>

   <CreationDate>2015-10-02T15:57:22.343Z</CreationDate>

   <Format>DEFAULT</Format>

   <Id>ab151b77-c286-497e-b2e5-034a84a34eb1</Id>

   <LastFailure/>

   <LastHttpResponseCode/>
   <LastNotification/>
   <NamingConvention>

      CAMEL_CASE_WITH_FIRST_LETTER_UPPERCASE

   </NamingConvention>
   <NotificationEndPoint>

      DS3-client-hostname

   </NotificationEndPoint>
   <NotificationHttpMethod>POST</NotificationHttpMethod>
   <NumberOfFailuresSinceLastSuccess>

      0

   </NumberOfFailuresSinceLastSuccess>

   <UserId>cef6f4d0-779a-4479-9469-a1373e567b0a</UserId>

</Data>

GET POOL FAILURE NOTIFICATION REGISTRATIONS

Description
Get a list of all pool failure notification registrations.
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Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_//pool_failure_notification_registration/

[?last_page][&page_length={32-bit integer}][&page_offset={32-bit integer}][&page_

start_marker={string}][&user_id={string}]

Request Parameters

Parameter Description Required

last_page If included, only the last page of results is returned. no

page_length The maximum number of registrations to list. The default is all
items after page_offset.

no

page_offset The starting point for the first registration to list. The default is 0. no

page_start_
marker

The UUID or other unique attribute for the item just before the first
item to list.
Notes:
• Specifying both page_offset and page_start_marker causes
an error.

• If neither page_offset, nor page_start_marker are specified,
the page_offset default is used.

no

user_id 1 The UUID, username, or other unique attribute for the user who
created the notification registration.

no

Responses

Response Elements
<Data>

   <PoolFailureNotificationRegistration>

      <CreationDate>{YYYY-MM-DDThh:mm:ss.xxxZ}</CreationDate>

      <Format>DEFAULT|JSON|XML</Format>

      <Id>{string}</Id>

      <LastFailure>{string}</LastFailure>
      <LastHttpResponseCode>{32-bit integer}</LastHttpResponseCode>

1) Parameter values can use wild cards (see Wild Card Syntax on page 30).
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      <LastNotification>

{YYYY-MM-DDThh:mm:ss.xxxZ}

      </LastNotification>
      <NamingConvention>

         CONCAT_LOWERCASE|CONSTANT|UNDERSCORED|

         CAMEL_CASE_WITH_FIRST_LETTER_UPPERCASE|

         CAMEL_CASE_WITH_FIRST_LETTER_LOWERCASE

      </NamingConvention>
      <NotificationEndPoint>{string}</NotificationEndPoint>
      <NotificationHttpMethod>POST|PUT</NotificationHttpMethod>
      <NumberOfFailuresSinceLastSuccess>

{32-bit integer}

      </NumberOfFailuresSinceLastSuccess>

      <UserId>{string}</UserId>

   </PoolFailureNotificationRegistration>

   ...

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

PoolFailure Notification Registration The container for the information for a single notification
registration.

CreationDate The date the notification registration was created in the
format YYYY-MM-DDThh:mm:ss.xxxZ.

Format The format of the notification.
Values: DEFAULT (XML), JSON, XML

ID The UUID for the notification.

LastFailure The exception message for the last failure to send a
notification to this notification registration.

LastHttpResponseCode The last response code returned by the notification end
point.

LastNotification Date and time of the last notification attempt by the
BlackPearl gateway.
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Parameter Description

NamingConvention The scheme used for naming within the notification sent.
Values: CONCAT_LOWERCASE, CONSTANT,
UNDERSCORED, CAMEL_CASE_WITH_FIRST_LETTER_
UPPERCASE, CAMEL_CASE_WITH_FIRST_LETTER_
LOWERCASE

NotificationEnd Point The HTTP or HTTPS URL of a web server capable of
receiving notification messages from the BlackPearl
gateway.

NotificationHttp Method The HTTP request method type. Values: POST, PUT

NumberOfFailuresSinceLastSuccess Number of failed notification attempts since last
successful notification.

UserId The UUID for the user who created the notification
registration.

Example

Sample Request
This request gets information about all pool failure notification registrations.
GET http://blackpearl-hostname/_rest_/pool_failure_notification_registration/

HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>

   <PoolFailureNotificationRegistration>

      <CreationDate>2015-10-02T15:57:22.453Z</CreationDate>

      <Format>DEFAULT</Format>

      <Id>3a082f87-e720-4d60-839d-d45216647f00</Id>
      <LastFailure/>

      <LastHttpResponseCode/>

      <LastNotification/>
      <NamingConvention>

         CAMEL_CASE_WITH_FIRST_LETTER_UPPERCASE

</NamingConvention>
      <NotificationEndPoint>

         DS3-client-hostname

      </NotificationEndPoint>
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      <NotificationHttpMethod>POST</NotificationHttpMethod>
      <NumberOfFailuresSinceLastSuccess>

         0

      </NumberOfFailuresSinceLastSuccess>

      <UserId>818fc597-a480-4827-99c0-472483abb94a</UserId>

   </PoolFailureNotificationRegistration>

   ...

</Data>

GET STORAGE DOMAIN FAILURE NOTIFICATION
REGISTRATION

Description
Get information about a storage domain failure notification registration.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/storage_domain_failure_notification_

registration/{UUID for the notification}/

To determine the UUID for a notification, see Get Storage Domain Failure Notification
Registrations on page 987.

Responses

Response Elements
<Data>

   <CreationDate>{YYYY-MM-DDThh:mm:ss.xxxZ}</CreationDate>

   <Format>DEFAULT|JSON|XML</Format>

   <Id>{string}</Id>

   <LastFailure>{string}</LastFailure>

   <LastHttpResponseCode>{32-bit integer}</LastHttpResponseCode>

   <LastNotification>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastNotification>

April 2023 DS3 API Reference-Spectra BlackPearl Nearline Gateway
- 984 -



Chapter 17 - Notification Operations Get Storage Domain Failure Notification Registration

   <NamingConvention>

      CONCAT_LOWERCASE|CONSTANT|UNDERSCORED|

      CAMEL_CASE_WITH_FIRST_LETTER_UPPERCASE|

      CAMEL_CASE_WITH_FIRST_LETTER_LOWERCASE

   </NamingConvention>
   <NotificationEndPoint>{string}</NotificationEndPoint>
   <NotificationHttpMethod>POST|PUT</NotificationHttpMethod>
   <NumberOfFailuresSinceLastSuccess>

{32-bit integer}

   </NumberOfFailuresSinceLastSuccess>

   <UserId>{string}</UserId>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

CreationDate The date the notification registration was created in the
format YYYY-MM-DDThh:mm:ss.xxxZ.

Format The format of the notification.
Values: DEFAULT (XML), JSON, XML

ID The UUID for the notification.

LastFailure The exception message for the last failure to send a
notification to this notification registration.

LastHttpResponseCode The last response code returned by the notification end
point.

LastNotification Date and time of the last notification attempt by the
BlackPearl gateway.

NamingConvention The scheme used for naming within the notification sent.
Values: CONCAT_LOWERCASE, CONSTANT,
UNDERSCORED, CAMEL_CASE_WITH_FIRST_LETTER_
UPPERCASE, CAMEL_CASE_WITH_FIRST_LETTER_
LOWERCASE

NotificationEnd Point The HTTP or HTTPS URL of a web server capable of
receiving notification messages from the BlackPearl
gateway.

NotificationHttp Method The HTTP request method type. Values: POST, PUT
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Parameter Description

NumberOfFailuresSinceLastSuccess Number of failed notification attempts since last
successful notification.

UserId The UUID for the user who created the notification
registration.

Example

Sample Request
This request gets information about the storage domain failure notification registration with
the UUID ec3bfb0a-c788-4fbf-a6aa-12c1c70319d6.
GET http://blackpearl-hostname/_rest_/storage_domain_failure_notification_

registration/ec3bfb0a-c788-4fbf-a6aa-12c1c70319d6/ HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>

   <CreationDate>2014-10-16T18:33:54.381Z</CreationDate>

   <Format>DEFAULT</Format>

   <Id>ec3bfb0a-c788-4fbf-a6aa-12c1c70319d6</Id>

   <LastFailure/>

   <LastHttpResponseCode/>

   <LastNotification/>
   <NamingConvention>

      CAMEL_CASE_WITH_FIRST_LETTER_UPPERCASE

   </NamingConvention>
   <NotificationEndPoint>

      DS3-client-hostname

   </NotificationEndPoint>
   <NotificationHttpMethod>POST</NotificationHttpMethod>
   <NumberOfFailuresSinceLastSuccess>

      0

   </NumberOfFailuresSinceLastSuccess>

   <UserId>7fe04a75-0fdc-4d73-8f4c-f2a0e01fc859</UserId>

</Data>
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GET STORAGE DOMAIN FAILURE NOTIFICATION
REGISTRATIONS

Description
Get a list of all storage domain failure notification registrations.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/storage_domain_failure_notification_

registration/[?last_page][&page_length={32-bit integer}][&page_offset=

{32-bit integer}][&page_start_marker={string}][&user_id={string}]

Request Parameters

Parameter Description Required

last_page If included, only the last page of results is returned. no

page_length The maximum number of registrations to list. The default is all
items after page_offset.

no

page_offset The starting point for the first registration to list. The default is 0. no

page_start_
marker

The UUID or other unique attribute for the item just before the first
item to list.
Notes:
• Specifying both page_offset and page_start_marker causes
an error.

• If neither page_offset, nor page_start_marker are specified,
the page_offset default is used.

no

user_id 1 The UUID, username, or other unique attribute for the user who
created the notification registration.

no

1) Parameter values can use wild cards (see Wild Card Syntax on page 30).
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Responses

Response Elements
<Data>

   <StorageDomainFailureNotificationRegistration>

      <CreationDate>{YYYY-MM-DDThh:mm:ss.xxxZ}</CreationDate>

      <Format>DEFAULT|JSON|XML</Format>

      <Id>{string}</Id>

      <LastFailure>{string}</LastFailure>
      <LastHttpResponseCode>

{32-bit integer}

      </LastHttpResponseCode>

      <LastNotification>
{YYYY-MM-DDThh:mm:ss.xxxZ}

      </LastNotification>
      <NamingConvention>

         CONCAT_LOWERCASE|CONSTANT|UNDERSCORED|

         CAMEL_CASE_WITH_FIRST_LETTER_UPPERCASE|

         CAMEL_CASE_WITH_FIRST_LETTER_LOWERCASE

      </NamingConvention>
      <NotificationEndPoint>{string}</NotificationEndPoint>
      <NotificationHttpMethod>POST|PUT</NotificationHttpMethod>
      <NumberOfFailuresSinceLastSuccess>

{32-bit integer}

      </NumberOfFailuresSinceLastSuccess>

      <UserId>{string}</UserId>

   </StorageDomainFailureNotificationRegistration>

   ...

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

StorageDomain FailureNotification
Registration

The container for the information for a single notification
registration.

CreationDate The date the notification registration was created in the
format YYYY-MM-DDThh:mm:ss.xxxZ.
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Parameter Description

Format The format of the notification.
Values: DEFAULT (XML), JSON, XML

ID The UUID for the notification.

LastFailure The exception message for the last failure to send a
notification to this notification registration.

LastHttpResponseCode The last response code returned by the notification end
point.

LastNotification Date and time of the last notification attempt by the
BlackPearl gateway.

NamingConvention The scheme used for naming within the notification sent.
Values: CONCAT_LOWERCASE, CONSTANT,
UNDERSCORED, CAMEL_CASE_WITH_FIRST_LETTER_
UPPERCASE, CAMEL_CASE_WITH_FIRST_LETTER_
LOWERCASE

NotificationEnd Point The HTTP or HTTPS URL of a web server capable of
receiving notification messages from the BlackPearl
gateway.

NotificationHttp Method The HTTP request method type. Values: POST, PUT

NumberOfFailuresSinceLastSuccess Number of failed notification attempts since last
successful notification.

UserId The UUID for the user who created the notification
registration.

Example

Sample Request
This request gets information about all storage domain failure notification registrations.
GET http://blackpearl-hostname/_rest_/storage_domain_failure_notification_

registration/ HTTP/1.1
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Sample Response
HTTP/1.1 200 OK

<Data>

   <StorageDomainFailureNotificationRegistration>

      <CreationDate>2014-10-16T18:33:56.026Z</CreationDate>

      <Format>DEFAULT</Format>

      <Id>ec3bfb0a-c788-4fbf-a6aa-12c1c70319d6</Id>

      <LastFailure/>
      <LastHttpResponseCode/>

      <LastNotification/>
      <NamingConvention>

         CAMEL_CASE_WITH_FIRST_LETTER_UPPERCASE

      </NamingConvention>
      <NotificationEndPoint>

         DS3-client-hostname

      </NotificationEndPoint>
      <NotificationHttpMethod>POST</NotificationHttpMethod>
      <NumberOfFailuresSinceLastSuccess>

         0

      </NumberOfFailuresSinceLastSuccess>

      <UserId>cf2918f1-100d-4448-91fe-60dfbb1abe10</UserId>

   </StorageDomainFailureNotificationRegistration>

   ...

</Data>

GET SYSTEM FAILURE NOTIFICATION REGISTRATION

Description
Get information about a system failure notification registration.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/system_failure_notification_registration/

{UUID for the notification}/

To determine the UUID for a notification, see Get System Failure Notification Registrations
on page 993.
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Responses

Response Elements
<Data>

   <CreationDate>{YYYY-MM-DDThh:mm:ss.xxxZ}</CreationDate>

   <Format>DEFAULT|JSON|XML</Format>

   <Id>{string}</Id>

   <LastFailure>{string}</LastFailure>

   <LastHttpResponseCode>{32-bit integer}</LastHttpResponseCode>

   <LastNotification>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastNotification>
   <NamingConvention>

      CONCAT_LOWERCASE|CONSTANT|UNDERSCORED|

      CAMEL_CASE_WITH_FIRST_LETTER_UPPERCASE|

      CAMEL_CASE_WITH_FIRST_LETTER_LOWERCASE

   </NamingConvention>
   <NotificationEndPoint>{string}</NotificationEndPoint>
   <NotificationHttpMethod>POST|PUT</NotificationHttpMethod>
   <NumberOfFailuresSinceLastSuccess>

{32-bit integer}

   </NumberOfFailuresSinceLastSuccess>

   <UserId>{string}</UserId>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

CreationDate The date the notification registration was created in the
format YYYY-MM-DDThh:mm:ss.xxxZ.

Format The format of the notification.
Values: DEFAULT (XML), JSON, XML

ID The UUID for the notification.

LastFailure The exception message for the last failure to send a
notification to this notification registration.

LastHttpResponseCode The last response code returned by the notification end
point.
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Parameter Description

LastNotification Date and time of the last notification attempt by the
BlackPearl gateway.

NamingConvention The scheme used for naming within the notification sent.
Values: CONCAT_LOWERCASE, CONSTANT,
UNDERSCORED, CAMEL_CASE_WITH_FIRST_LETTER_
UPPERCASE, CAMEL_CASE_WITH_FIRST_LETTER_
LOWERCASE

NotificationEnd Point The HTTP or HTTPS URL of a web server capable of
receiving notification messages from the BlackPearl
gateway.

NotificationHttp Method The HTTP request method type. Values: POST, PUT

NumberOfFailuresSinceLastSuccess Number of failed notification attempts since last
successful notification.

UserId The UUID for the user who created the notification
registration.

Example

Sample Request
This request gets information about the system failure notification registration with the UUID
4cb5fc45-d2c0-4e8e-a177-bafcf50f7229.
GET http://blackpearl-hostname/_rest_/storage_domain_failure_notification_

registration/4cb5fc45-d2c0-4e8e-a177-bafcf50f7229/ HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>

   <CreationDate>2015-12-07T03:20:18.000Z</CreationDate>

   <Format>DEFAULT</Format>

   <Id>4cb5fc45-d2c0-4e8e-a177-bafcf50f7229</Id>

   <LastFailure/>

   <LastHttpResponseCode/>
   <LastNotification/>

   <NamingConvention>

      CAMEL_CASE_WITH_FIRST_LETTER_UPPERCASE

   </NamingConvention>
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   <NotificationEndPoint>

      DS3-client-hostname

   </NotificationEndPoint>
   <NotificationHttpMethod>POST</NotificationHttpMethod>
   <NumberOfFailuresSinceLastSuccess>

      0

   </NumberOfFailuresSinceLastSuccess>

   <UserId>9ddbe37f-f697-4d7a-a014-8ea36f4dc7da</UserId>

</Data>

GET SYSTEM FAILURE NOTIFICATION REGISTRATIONS

Description
Get a list of all system failure notification registrations.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/system_failure_notification_registration/

[?last_page][&page_length={32-bit integer}][&page_offset={32-bit integer}][&page_

start_marker={string}][&user_id={string}]

Request Parameters

Parameter Description Required

last_page If included, only the last page of results is returned. no

page_length The maximum number of registrations to list. The default is all
items after page_offset.

no

page_offset The starting point for the first registration to list. The default is 0. no

April 2023 DS3 API Reference-Spectra BlackPearl Nearline Gateway
- 993 -



Chapter 17 - Notification Operations Get System Failure Notification Registrations

Parameter Description Required

page_start_
marker

The UUID or other unique attribute for the item just before the first
item to list.
Notes:
• Specifying both page_offset and page_start_marker causes
an error.

• If neither page_offset, nor page_start_marker are specified,
the page_offset default is used.

no

user_id 1 The UUID, username, or other unique attribute for the user who
created the notification registration.

no

Responses

Response Elements
<Data>

   <SystemFailureNotificationRegistration>

      <CreationDate>{YYYY-MM-DDThh:mm:ss.xxxZ}</CreationDate>

      <Format>DEFAULT|JSON|XML</Format>

      <Id>{string}</Id>
      <LastFailure>{string}</LastFailure>

      <LastHttpResponseCode>

{32-bit integer}

      </LastHttpResponseCode>

      <LastNotification>
{YYYY-MM-DDThh:mm:ss.xxxZ}

      </LastNotification>
      <NamingConvention>

         CONCAT_LOWERCASE|CONSTANT|UNDERSCORED|

         CAMEL_CASE_WITH_FIRST_LETTER_UPPERCASE|

         CAMEL_CASE_WITH_FIRST_LETTER_LOWERCASE

      </NamingConvention>
      <NotificationEndPoint>{string}</NotificationEndPoint>
      <NotificationHttpMethod>POST|PUT</NotificationHttpMethod>

1) Parameter values can use wild cards (see Wild Card Syntax on page 30).
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      <NumberOfFailuresSinceLastSuccess>

{32-bit integer}

      </NumberOfFailuresSinceLastSuccess>

      <UserId>{string}</UserId>

   </SystemFailureNotificationRegistration>

   ...

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

SystemFailure Notification
Registration

The container for the information for a single notification
registration.

CreationDate The date the notification registration was created in the
format YYYY-MM-DDThh:mm:ss.xxxZ.

Format The format of the notification.
Values: DEFAULT (XML), JSON, XML

ID The UUID for the notification.

LastFailure The exception message for the last failure to send a
notification to this notification registration.

LastHttpResponseCode The last response code returned by the notification end
point.

LastNotification Date and time of the last notification attempt by the
BlackPearl gateway.

NamingConvention The scheme used for naming within the notification sent.
Values: CONCAT_LOWERCASE, CONSTANT,
UNDERSCORED, CAMEL_CASE_WITH_FIRST_LETTER_
UPPERCASE, CAMEL_CASE_WITH_FIRST_LETTER_
LOWERCASE

NotificationEnd Point The HTTP or HTTPS URL of a web server capable of
receiving notification messages from the BlackPearl
gateway.

NotificationHttp Method The HTTP request method type. Values: POST, PUT

NumberOfFailuresSinceLastSuccess Number of failed notification attempts since last
successful notification.
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Parameter Description

UserId The UUID for the user who created the notification
registration.

Example

Sample Request
This request gets information about all system failure notification registrations.
GET http://blackpearl-hostname/_rest_/system_failure_notification_registration/

HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>

   <StorageDomainFailureNotificationRegistration>

      <CreationDate>2015-12-07T03:20:18.000Z</CreationDate>

      <Format>DEFAULT</Format>

      <Id>a046e103-9dbc-46e7-bff4-c070d01714eb</Id>
      <LastFailure/>

      <LastHttpResponseCode/>

      <LastNotification/>
      <NamingConvention>

         CAMEL_CASE_WITH_FIRST_LETTER_UPPERCASE

      </NamingConvention>
      <NotificationEndPoint>

         DS3-client-hostname

      </NotificationEndPoint>
      <NotificationHttpMethod>POST</NotificationHttpMethod>
      <NumberOfFailuresSinceLastSuccess>

         0

      </NumberOfFailuresSinceLastSuccess>

      <UserId>07c9ae50-3d84-4782-8253-02316b83e89e</UserId>

   </StorageDomainFailureNotificationRegistration>

   ...

</Data>
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GET TAPE FAILURE NOTIFICATION REGISTRATION

Description
Get information about a tape failure notification registration.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/tape_failure_notification_registration/{UUID

for the notification}/

To determine the UUID for a notification, see Get Tape Failure Notification Registrations on
page 999.

Responses

Response Elements
<Data>

   <CreationDate>{YYYY-MM-DDThh:mm:ss.xxxZ}</CreationDate>

   <Format>DEFAULT|JSON|XML</Format>

   <Id>{string}</Id>

   <LastFailure>{string}</LastFailure>

   <LastHttpResponseCode>{32-bit integer}</LastHttpResponseCode>
   <LastNotification>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastNotification>
   <NamingConvention>

      CONCAT_LOWERCASE|CONSTANT|UNDERSCORED|

      CAMEL_CASE_WITH_FIRST_LETTER_UPPERCASE|

      CAMEL_CASE_WITH_FIRST_LETTER_LOWERCASE

   </NamingConvention>
   <NotificationEndPoint>{string}</NotificationEndPoint>
   <NotificationHttpMethod>POST|PUT</NotificationHttpMethod>
   <NumberOfFailuresSinceLastSuccess>

{32-bit integer}

   </NumberOfFailuresSinceLastSuccess>

   <UserId>{string}</UserId>

</Data>
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where the response elements are defined as follows:

Parameter Description

Data The container for the response.

CreationDate The date the notification registration was created in the
format YYYY-MM-DDThh:mm:ss.xxxZ.

Format The format of the notification.
Values: DEFAULT (XML), JSON, XML

ID The UUID for the notification.

LastFailure The exception message for the last failure to send a
notification to this notification registration.

LastHttpResponseCode The last response code returned by the notification end
point.

LastNotification Date and time of the last notification attempt by the
BlackPearl gateway.

NamingConvention The scheme used for naming within the notification sent.
Values: CONCAT_LOWERCASE, CONSTANT,
UNDERSCORED, CAMEL_CASE_WITH_FIRST_LETTER_
UPPERCASE, CAMEL_CASE_WITH_FIRST_LETTER_
LOWERCASE

NotificationEnd Point The HTTP or HTTPS URL of a web server capable of
receiving notification messages from the BlackPearl
gateway.

NotificationHttp Method The HTTP request method type. Values: POST, PUT

NumberOfFailuresSinceLastSuccess Number of failed notification attempts since last
successful notification.

UserId The UUID for the user who created the notification
registration.
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Example

Sample Request
This request gets information about the tape failure notification registration with the UUID
70e191f7-9520-4901-89a0-c3808e04f9d5.
GET http://blackpearl-hostname/_rest_/tape_failure_notification_

registration/70e191f7-9520-4901-89a0-c3808e04f9d5/ HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>

   <CreationDate>2014-10-16T18:33:54.381Z</CreationDate>

   <Format>DEFAULT</Format>

   <Id>70e191f7-9520-4901-89a0-c3808e04f9d5</Id>

   <LastFailure/>
   <LastHttpResponseCode/>

   <LastNotification/>
   <NamingConvention>

      CAMEL_CASE_WITH_FIRST_LETTER_UPPERCASE

   </NamingConvention>
   <NotificationEndPoint>

      DS3-client-hostname

   </NotificationEndPoint>
   <NotificationHttpMethod>POST</NotificationHttpMethod>
   <NumberOfFailuresSinceLastSuccess>

      0

   </NumberOfFailuresSinceLastSuccess>

   <UserId>7fe04a75-0fdc-4d73-8f4c-f2a0e01fc859</UserId>

</Data>

GET TAPE FAILURE NOTIFICATION REGISTRATIONS

Description
Get a list of all tape failure notification registrations.
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Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/tape_failure_notification_registration/

[?last_page][&page_length={32-bit integer}][&page_offset={32-bit integer}][&page_

start_marker={string}][&user_id={string}]

Request Parameters

Parameter Description Required

last_page If included, only the last page of results is returned. no

page_length The maximum number of registrations to list. The default is all
items after page_offset.

no

page_offset The starting point for the first registration to list. The default is 0. no

page_start_
marker

The UUID or other unique attribute for the item just before the first
item to list.
Notes:
• Specifying both page_offset and page_start_marker causes
an error.

• If neither page_offset, nor page_start_marker are specified,
the page_offset default is used.

no

user_id 1 The UUID, username, or other unique attribute for the user who
created the notification registration.

no

Responses

Response Elements
<Data>

   <TapeFailureNotificationRegistration>

      <CreationDate>{YYYY-MM-DDThh:mm:ss.xxxZ}</CreationDate>

      <Format>DEFAULT|JSON|XML</Format>

      <Id>{string}</Id>

      <LastFailure>{string}</LastFailure>

1) Parameter values can use wild cards (see Wild Card Syntax on page 30).

April 2023 DS3 API Reference-Spectra BlackPearl Nearline Gateway
- 1000 -



Chapter 17 - Notification Operations Get Tape Failure Notification Registrations

      <LastHttpResponseCode>

{32-bit integer}

      </LastHttpResponseCode>

      <LastNotification>

{YYYY-MM-DDThh:mm:ss.xxxZ}

      </LastNotification>
      <NamingConvention>

         CONCAT_LOWERCASE|CONSTANT|UNDERSCORED|

         CAMEL_CASE_WITH_FIRST_LETTER_UPPERCASE|

         CAMEL_CASE_WITH_FIRST_LETTER_LOWERCASE

      </NamingConvention>
      <NotificationEndPoint>{string}</NotificationEndPoint>
      <NotificationHttpMethod>POST|PUT</NotificationHttpMethod>
      <NumberOfFailuresSinceLastSuccess>

{32-bit integer}

      </NumberOfFailuresSinceLastSuccess>

      <UserId>{string}</UserId>

   </TapeFailureNotificationRegistration>

   ...

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

TapeFailure Notification Registration The container for the information for a single notification
registration.

CreationDate The date the notification registration was created in the
format YYYY-MM-DDThh:mm:ss.xxxZ.

Format The format of the notification.
Values: DEFAULT (XML), JSON, XML

ID The UUID for the notification.

LastFailure The exception message for the last failure to send a
notification to this notification registration.

LastHttpResponseCode The last response code returned by the notification end
point.

LastNotification Date and time of the last notification attempt by the
BlackPearl gateway.
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Parameter Description

NamingConvention The scheme used for naming within the notification sent.
Values: CONCAT_LOWERCASE, CONSTANT,
UNDERSCORED, CAMEL_CASE_WITH_FIRST_LETTER_
UPPERCASE, CAMEL_CASE_WITH_FIRST_LETTER_
LOWERCASE

NotificationEnd Point The HTTP or HTTPS URL of a web server capable of
receiving notification messages from the BlackPearl
gateway.

NotificationHttp Method The HTTP request method type. Values: POST, PUT

NumberOfFailuresSinceLastSuccess Number of failed notification attempts since last
successful notification.

UserId The UUID for the user who created the notification
registration.

Example

Sample Request
This request gets information about all tape failure notification registrations.
GET http://blackpearl-hostname/_rest_/tape_failure_notification_registration/

HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>

   <TapeFailureNotificationRegistration>

      <CreationDate>2014-10-16T18:33:56.026Z</CreationDate>

      <Format>DEFAULT</Format>

      <Id>70e191f7-9520-4901-89a0-c3808e04f9d5</Id>

      <LastFailure/>
      <LastHttpResponseCode/>

      <LastNotification/>
      <NamingConvention>

         CAMEL_CASE_WITH_FIRST_LETTER_UPPERCASE

      </NamingConvention>
      <NotificationEndPoint>

         DS3-client-hostname

      </NotificationEndPoint>
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      <NotificationHttpMethod>POST</NotificationHttpMethod>
      <NumberOfFailuresSinceLastSuccess>

         0

      </NumberOfFailuresSinceLastSuccess>

      <UserId>cf2918f1-100d-4448-91fe-60dfbb1abe10</UserId>

   </TapeFailureNotificationRegistration>

   ...

</Data>

GET TAPE PARTITION FAILURE NOTIFICATION REGISTRATION

Description
Get information about a tape partition failure notification registration.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/tape_partition_failure_notification_

registration/{UUID for the notification}/

To determine the UUID for a notification, see Get Tape Partition Failure Notification
Registrations on page 1005.

Responses

Response Elements
<Data>

   <CreationDate>{YYYY-MM-DDThh:mm:ss.xxxZ}</CreationDate>

   <Format>DEFAULT|JSON|XML</Format>

   <Id>{string}</Id>

   <LastFailure>{string}</LastFailure>

   <LastHttpResponseCode>{32-bit integer}</LastHttpResponseCode>

   <LastNotification>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastNotification>
   <NamingConvention>

      CONCAT_LOWERCASE|CONSTANT|UNDERSCORED|

      CAMEL_CASE_WITH_FIRST_LETTER_UPPERCASE|

      CAMEL_CASE_WITH_FIRST_LETTER_LOWERCASE

   </NamingConvention>
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   <NotificationEndPoint>{string}</NotificationEndPoint>
   <NotificationHttpMethod>POST|PUT</NotificationHttpMethod>
   <NumberOfFailuresSinceLastSuccess>

{32-bit integer}

   </NumberOfFailuresSinceLastSuccess>

   <UserId>{string}</UserId>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

CreationDate The date the notification registration was created in the
format YYYY-MM-DDThh:mm:ss.xxxZ.

Format The format of the notification.
Values: DEFAULT (XML), JSON, XML

ID The UUID for the notification.

LastFailure The exception message for the last failure to send a
notification to this notification registration.

LastHttpResponseCode The last response code returned by the notification end
point.

LastNotification Date and time of the last notification attempt by the
BlackPearl gateway.

NamingConvention The scheme used for naming within the notification sent.
Values: CONCAT_LOWERCASE, CONSTANT,
UNDERSCORED, CAMEL_CASE_WITH_FIRST_LETTER_
UPPERCASE, CAMEL_CASE_WITH_FIRST_LETTER_
LOWERCASE

NotificationEnd Point The HTTP or HTTPS URL of a web server capable of
receiving notification messages from the BlackPearl
gateway.

NotificationHttp Method The HTTP request method type. Values: POST, PUT

NumberOfFailuresSinceLastSuccess Number of failed notification attempts since last
successful notification.

UserId The UUID for the user who created the notification
registration.
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Example

Sample Request
This request gets information about the tape partition failure notification registration with the
UUID 085586b1-23e2-40bd-93e4-92b236af41e6.
GET http://blackpearl-hostname/_rest_/tape_partition_failure_notification_

registration/085586b1-23e2-40bd-93e4-92b236af41e6/ HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>

   <CreationDate>2014-10-16T18:33:54.381Z</CreationDate>

   <Format>DEFAULT</Format>

   <Id>085586b1-23e2-40bd-93e4-92b236af41e6</Id>

   <LastFailure/>
   <LastHttpResponseCode/>

   <LastNotification/>
   <NamingConvention>

      CAMEL_CASE_WITH_FIRST_LETTER_UPPERCASE

   </NamingConvention>
   <NotificationEndPoint>

      DS3-client-hostname

   </NotificationEndPoint>
   <NotificationHttpMethod>POST</NotificationHttpMethod>
   <NumberOfFailuresSinceLastSuccess>

      0

   </NumberOfFailuresSinceLastSuccess>

   <UserId>7fe04a75-0fdc-4d73-8f4c-f2a0e01fc859</UserId>

</Data>

GET TAPE PARTITION FAILURE NOTIFICATION
REGISTRATIONS

Description
Get a list of all tape partition failure notification registrations.
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Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/tape_partition_failure_notification_

registration/[?last_page][&page_length={32-bit integer}][&page_offset=

{32-bit integer}][&page_start_marker={string}][&user_id={string}]

Request Parameters

Parameter Description Required

last_page If included, only the last page of results is returned. no

page_length The maximum number of registrations to list. The default is all
items after page_offset.

no

page_offset The starting point for the first registration to list. The default is 0. no

page_start_
marker

The UUID or other unique attribute for the item just before the first
item to list.
Notes:
• Specifying both page_offset and page_start_marker causes
an error.

• If neither page_offset, nor page_start_marker are specified,
the page_offset default is used.

no

user_id 1 The UUID, username, or other unique attribute for the user who
created the notification registration.

no

Responses

Response Elements
<Data>

   <TapePartitionFailureNotificationRegistration>

      <CreationDate>{YYYY-MM-DDThh:mm:ss.xxxZ}</CreationDate>

      <Format>DEFAULT|JSON|XML</Format>

      <Id>{string}</Id>

      <LastFailure>{string}</LastFailure>
      <LastHttpResponseCode>{32-bit integer}</LastHttpResponseCode>

1) Parameter values can use wild cards (see Wild Card Syntax on page 30).
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      <LastNotification>

{YYYY-MM-DDThh:mm:ss.xxxZ}

      </LastNotification>
      <NamingConvention>

         CONCAT_LOWERCASE|CONSTANT|UNDERSCORED|

         CAMEL_CASE_WITH_FIRST_LETTER_UPPERCASE|

         CAMEL_CASE_WITH_FIRST_LETTER_LOWERCASE

      </NamingConvention>
      <NotificationEndPoint>{string}</NotificationEndPoint>
      <NotificationHttpMethod>POST|PUT</NotificationHttpMethod>
      <NumberOfFailuresSinceLastSuccess>

{32-bit integer}

      </NumberOfFailuresSinceLastSuccess>

      <UserId>{string}</UserId>

   </TapePartitionFailureNotificationRegistration>

   ...

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

TapePartition FailureNotification
Registration

The container for the information for a single notification
registration.

CreationDate The date the notification registration was created in the
format YYYY-MM-DDThh:mm:ss.xxxZ.

Format The format of the notification.
Values: DEFAULT (XML), JSON, XML

ID The UUID for the notification.

LastFailure The exception message for the last failure to send a
notification to this notification registration.

LastHttpResponseCode The last response code returned by the notification end
point.

LastNotification Date and time of the last notification attempt by the
BlackPearl gateway.
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Parameter Description

NamingConvention The scheme used for naming within the notification sent.
Values: CONCAT_LOWERCASE, CONSTANT,
UNDERSCORED, CAMEL_CASE_WITH_FIRST_LETTER_
UPPERCASE, CAMEL_CASE_WITH_FIRST_LETTER_
LOWERCASE

NotificationEnd Point The HTTP or HTTPS URL of a web server capable of
receiving notification messages from the BlackPearl
gateway.

NotificationHttp Method The HTTP request method type. Values: POST, PUT

NumberOfFailuresSinceLastSuccess Number of failed notification attempts since last
successful notification.

UserId The UUID for the user who created the notification
registration.

Example

Sample Request
This request gets information about all tape partition notification registrations.
GET http://blackpearl-hostname/_rest_/tape_partition_failure_notification_

registration/ HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>

   <TapeFailureNotificationRegistration>

      <CreationDate>2014-10-16T18:33:56.026Z</CreationDate>

      <Format>DEFAULT</Format>

      <Id>085586b1-23e2-40bd-93e4-92b236af41e6</Id>
      <LastFailure/>

      <LastHttpResponseCode/>

      <LastNotification/>
      <NamingConvention>

         CAMEL_CASE_WITH_FIRST_LETTER_UPPERCASE

      </NamingConvention>
      <NotificationEndPoint>

         DS3-client-hostname

      </NotificationEndPoint>
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      <NotificationHttpMethod>POST</NotificationHttpMethod>
      <NumberOfFailuresSinceLastSuccess>

         0

      </NumberOfFailuresSinceLastSuccess>

      <UserId>cf2918f1-100d-4448-91fe-60dfbb1abe10</UserId>

   </TapeFailureNotificationRegistration>

   ...

</Data>
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VOLUME G - MISCELLANEOUS OPERATIONS
This section describes operations that are available to provide information and make rarely
needed changes to the BlackPearl configuration.

• Cache Operations on page 1011

• Capacity Operations on page 1027

• Data Planner Operations on page 1035

• Degradation Operations on page 1051

• System Operations on page 1120
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CHAPTER 18 - CACHE OPERATIONS
This chapter provides detailed information about operations you can perform on the
BlackPearl cache. The cache is used to prepare objects for the most efficient transfer to deep
storage and to retrieve objects from storage.

Force Full Cache Reclaim 1011

Get Cache Filesystem 1012

Get Cache Filesystems 1015

Get Cache State 1018

Modify Cache Filesystem 1023

FORCE FULL CACHE RECLAIM

Description
Forces a full reclaim of all caches, and waits until the reclaim completes. Cache contents that
need to be retained because they are a part of an active job are retained. Any cache contents
that can be reclaimed will be. This operation may take a very long time to complete,
depending on how much of the cache can be reclaimed and how many blobs the cache is
managing.

Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/cache_filesystem/?reclaim

Request Parameters

Parameter Description Required

reclaim Indicates to perform a reclaim operation. yes
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Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)

Example

Sample Request
This request reclaims all cache on the BlackPearl gateway.
PUT http[s]://blackpearl-hostname/_rest_/cache_filesystem/?reclaim HTTP/1.1

Sample Response
HTTP/1.1 204 No Content

GET CACHE FILESYSTEM

Description
Get information about the specified cache filesystem.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/cache_filesystem/{Cache filesystem UUID}/

To determine the UUID for a cache filesystem, see Get Cache Filesystems on page 1015.
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Responses

Response Elements
<Data>

   <AutoReclaimInitiateThreshold>

{double}

   </AutoReclaimInitiateThreshold>

   <AutoReclaimTerminateThreshold>

{double}

   </AutoReclaimTerminateThreshold>
   <BurstThreshold>{double}</BurstThreshold>
   <CacheSafetyEnabled>TRUE|FALSE</CacheSafetyEnabled>

   <Id>{string}</Id>

   <MaxCapacityInBytes>{64-bit integer}</MaxCapacityInBytes>

   <MaxPercentUtilizationOfFilesystem>

{double}

   </MaxPercentUtilizationOfFilesystem>
   <NodeId>{string}</NodeId>

   <Path>{string}</Path>

</Data>

Note: double=double-precision floating point number

where the response elements are defined as follows:

Parameter Description

Data A container for the response.

AutoReclaim
InitiateThreshold

The percentage full at which cache reclamation begins, expressed as a
double-precision floating point number.

AutoReclaim
Terminate Threshold

The percentage full at which cache reclamation terminates, expressed as
a double-precision floating point number.

BurstThreshold The percent utilization the cache must exceed to disable bursting, which
permits the allocation of all cache resources on one job regardless of the
job's priority. Having a bust threshold below 1.0 ensures that one job
does not prevent resources from being available for other jobs.

CacheSafetyEnabled Whether the BlackPearl system waits for all data to be transferred the
system cache before returning that the operation is complete.

Id The UUID for the cache filesystem.
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Parameter Description

MaxCapacityIn Bytes The maximum capacity that can be used by the cache.
Note: If both MaxCapacityInBytes and
MaxPercentUtilizationOfFilesystem are specified, the lesser of
the two is used for the maximum cache capacity.

MaxPercent
UtilizationOf
Filesystem

The maximum capacity that can be used by the cache as a percentage of
the total usable cache capacity.
Note: If both MaxCapacityInBytes and
MaxPercentUtilizationOfFilesystem are specified, the lesser of
the two is used for the maximum cache capacity.

NodeId The UUID for the for the node associated with the cache.

Path The path to the cache filesystem on the BlackPearl gateway.

Example

Sample Request
This request gets information about the cache filesystem with UUID 8dfef781-a13c-4ea5-ac22-
db4f7425a8c4.
GET http://blackpearl-hostname/_rest_/cache_filesystem/8dfef781-a13c-4ea5-ac22-

db4f7425a8c4/ HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>

   <AutoReclaimInitiateThreshold>

      0.82

   </AutoReclaimInitiateThreshold>
   <AutoReclaimTerminateThreshold>

      0.72

   </AutoReclaimTerminateThreshold>
   <BurstThreshold>0.85</BurstThreshold>
   <CacheSafetyEnabled>FALSE</CacheSafetyEnabled>

   <Id>8dfef781-a13c-4ea5-ac22-db4f7425a8c4</Id>

   <MaxCapacityInBytes>524288000</MaxCapacityInBytes>

   <MaxPercentUtilizationOfFilesystem/>

   <NodeId>6f3baf6a-acdc-4626-b930-3062f5b70fb6</NodeId>
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   <Path>

      /usr/local/BlackPearl/frontend/cachedir/

   </Path>

</Data>

GET CACHE FILESYSTEMS

Description
Gets information about all cache filesystems.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/cache_filesystem/[?last_page][&node_id=

{string}][&page_length={32-bit integer}][&page_offset={32-bit integer}][&page_start_

marker={string}]

Request Parameters

Parameter Description Required

last_page If included, only the last page of results is returned. no

node_id 1 The UUID, DNS name, or other unique attribute for the node
associated with the cache.

no

page_length The maximum number of cache filesystems to list.
Default: all items after page_offset.

no

page_offset The starting point for the first filesystem to list. Default: 0. no

page_start_
marker

The UUID or other unique attribute for the item just before the first
item to list.
Notes:
• Specifying both page_offset and page_start_marker causes
an error.

• If neither page_offset, nor page_start_marker are specified,
the page_offset default is used.

no

1) Parameter values can use wild cards (see Wild Card Syntax on page 30).
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Responses

Response Elements
<Data>

   <CacheFilesystem>

      <AutoReclaimInitiateThreshold>

{double}

      </AutoReclaimInitiateThreshold>

      <AutoReclaimTerminateThreshold>

{double}

      </AutoReclaimTerminateThreshold>

      <BurstThreshold>{double}</BurstThreshold>
      <CacheSafetyEnabled>TRUE|FALSE</CacheSafetyEnabled>

      <Id>{string}</Id>

      <MaxCapacityInBytes>{64-bit integer}</MaxCapacityInBytes>

      <MaxPercentUtilizationOfFilesystem>

{double}

      </MaxPercentUtilizationOfFilesystem>
      <NodeId>{string}</NodeId>

      <Path>{string}</Path>

   </CacheFilesystem>

   ...

</Data>

where the response elements are defined as follows:

Parameter Description

Data A container for the response.

CacheFilesystem A container for information about the cache filesystem.

AutoReclaim
InitiateThreshold

The percentage full at which cache reclamation begins, expressed as a
double-precision floating point number.

AutoReclaim
Terminate Threshold

The percentage full at which cache reclamation terminates, expressed as
a double-precision floating point number.

BurstThreshold The percent utilization the cache must exceed to disable bursting, which
permits the allocation of all cache resources on one job regardless of the
job’s priority. Having a bust threshold below 1.0 ensures that one job
does not prevent resources from being available for other jobs.
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Parameter Description

CacheSafetyEnabled Whether the BlackPearl system waits for all data to be transferred the
system cache before returning that the operation is complete.

Id The UUID for the cache filesystem.

MaxCapacityIn Bytes The maximum capacity that can be used by the cache.
Note: If both MaxCapacityInBytes and
MaxPercentUtilizationOfFilesystem are specified, the lesser of
the two is used for the maximum cache capacity.

MaxPercent
UtilizationOf
Filesystem

The maximum capacity that can be used by the cache as a percentage of
the total usable cache capacity.
Note: If both MaxCapacityInBytes and
MaxPercentUtilizationOfFilesystem are specified, the lesser of
the two is used for the maximum cache capacity.

NodeId The UUID for the for the node associated with the cache.

Path The path to the cache filesystem on the BlackPearl gateway.

Example

Sample Request
This request lists all cache filesystems.
GET http://blackpearl-hostname/_rest_/cache_filesystem/ HTTP/1.1
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Sample Response
HTTP/1.1 200 OK
<Data>

   <CacheFilesystem>

      <AutoReclaimInitiateThreshold>

         0.82

      </AutoReclaimInitiateThreshold>

      <AutoReclaimTerminateThreshold>

         0.72

      </AutoReclaimTerminateThreshold>

      <BurstThreshold>0.85</BurstThreshold>
      <CacheSafetyEnabled>TRUE|FALSE</CacheSafetyEnabled>

      <Id>93c28334-e6b5-450e-ad7d-0380b706c5f4</Id>

      <MaxCapacityInBytes>524288000</MaxCapacityInBytes>

      <MaxPercentUtilizationOfFilesystem/>

      <NodeId>d1c919d5-70b5-4062-96b6-1000b2b56ee2</NodeId>

      <Path>

         /usr/local/BlackPearl/frontend/cachedir/

      </Path>

   </CacheFilesystem>
   ...

</Data>

GET CACHE STATE

Description
Gets the utilization information for all cache filesystems on the BlackPearl gateway.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/cache_state/
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Responses

Response Elements
<Data>

   <Filesystems>

      <AvailableCapacityInBytes>

{64-bit integer}

      </AvailableCapacityInBytes>
<CacheFilesystem>

         <AutoReclaimInitiateThreshold>

{double}

         </AutoReclaimInitiateThreshold>

         <AutoReclaimTerminateThreshold>

{double}

         </AutoReclaimTerminateThreshold>

         <BurstThreshold>{double}</BurstThreshold>
         <CacheSafetyEnabled>TRUE|FALSE</CacheSafetyEnabled>
         <Id>{string}</Id>

         <MaxCapacityInBytes>{64-bit integer}</MaxCapacityInBytes>

         <MaxPercentUtilizationOfFilesystem>

{double}

         </MaxPercentUtilizationOfFilesystem>

         <NodeId>{string}</NodeId>

         <Path>{string}</Path>

      </CacheFilesystem>
      <Entries>

         <Blob>

            <ByteOffset>32-bit integer</ByteOffset>

            <Checksum>{string}</Checksum>

            <ChecksumType>CRC|CRC_32C|MD5|SHA_256|SHA_512</ChecksumType>

            <Id>{string}</Id>

            <Length>32-bit integer</Length>

            <ObjectId>{string}</ObjectId>

         </Blob>
         <State>IN_CACHE</State
      </Entries>
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      <JobLockedCacheInBytes>

{64-bit integer}

      </JobLockedCacheInBytes>

      <Summary>{string}</Summary>

      <TotalCapacityInBytes>

{64-bit integer}

      </TotalCapacityInBytes>

      <UnavailableCapacityInBytes>

{64-bit integer}

      </UnavailableCapacityInBytes>

      <UsedCapacityInBytes>{64-bit integer}</UsedCapacityInBytes>

   </Filesystems>

</Data>

where the response elements are defined as follows:

Parameter Description

Data A container for the response.

FileSystem A container for information about filesystems.

AvailableCapacity
InBytes

The capacity available for cache filesystems.

CacheFilesystem A container for information about the cache filesystem.

AutoReclaim
InitiateThreshold

The percentage full at which cache reclamation begins, expressed as a
double-precision floating point number.

AutoReclaim
Terminate Threshold

The percentage full at which cache reclamation terminates, expressed as
a double-precision floating point number.

BurstThreshold The percent utilization the cache must exceed to disable bursting, which
permits the allocation of all cache resources on one job regardless of the
job’s priority. Having a bust threshold below 1.0 ensures that one job
does not prevent resources from being available for other jobs.

CacheSafetyEnabled Whether the BlackPearl system waits for all data to be transferred the
system cache before returning that the operation is complete.

Id The UUID for the cache filesystem.

MaxCapacityIn Bytes The maximum capacity that can be used by the cache.
Note: If both MaxCapacityInBytes and
MaxPercentUtilizationOfFilesystem are specified, the lesser of
the two is used for the maximum cache capacity.
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Parameter Description

MaxPercent
UtilizationOf
Filesystem

The maximum capacity that can be used by the cache as a percentage of
the total usable cache capacity.
Note: If both MaxCapacityInBytes and
MaxPercentUtilizationOfFilesystem are specified, the lesser of
the two is used for the maximum cache capacity.

NodeId The UUID for the for the node associated with the cache.

Path The path to the cache filesystem on the BlackPearl gateway.

Entries A container for information about blobs currently in cache.

Blob A container for information about one blob.

ByteOffset The offset in bytes where this blob starts compared to the start of the
object.

Checksum The checksum value for the blob.

ChecksumType The type of checksum calculated.
Values: CRC|CRC_32C|MD5|SHA_256|SHA_512

Id The UUID for the blob.

Length The length in bytes of the object.

ObjectId The UUID for the object associated with the blob.

State The state of the object with respect to the cache.

JobLockedCache
InBytes

The amount of cache currently being used by jobs.

Summary A textual summary intended for human and not programmatic use.

TotalCapacityIn Bytes The total capacity across all cache filesystems.

Unavailable
CapacityInBytes

Capacity that has been released from the cache but is not yet deleted and
made available on the underlying physical filesystem.

UsedCapacityIn Bytes The total capacity used across all cache filesystems.
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Example

Sample Request
This request gets the state information for all cache filesystems.
GET http[s]://blackpearl-hostname/_rest_/cache_state/ HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>

   <Filesystems>

   <AvailableCapacityInBytes>54321</AvailableCapacityInBytes>

      <CacheFilesystem>

         <AutoReclaimInitiateThreshold>

            0.82

         </AutoReclaimInitiateThreshold>
         <AutoReclaimTerminateThreshold>

            0.72

         </AutoReclaimTerminateThreshold>

         <BurstThreshold>0.85</BurstThreshold>
         <CacheSafetyEnabled>FALSE</CacheSafetyEnabled>

         <Id>4322504e-556b-11e4-b466-080027200702</Id>
         <MaxCapacityInBytes>12345</MaxCapacityInBytes>

         <MaxPercentUtilizationOfFilesystem>

            0.8

         </MaxPercentUtilizationOfFilesystem>

         <NodeId>b9fd225a-ead8-41c7-b65b-71802c10d05a</NodeId>
         <Path>

            /usr/local/BlackPearl/frontend/cachedir/

         </Path>

      </CacheFilesystem>
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      <Entries>

         <Blob>

            <ByteOffset>10</ByteOffset>

            <Checksum>

               a8a2f6ebe286697c527eb35a58b5539532e9b3ae3b64d4eb0a46fb657b41562c

            </Checksum>

            <ChecksumType>SHA_256</ChecksumType>

            <Id>438fc336-556b-11e4-8dc0-080027200702</Id>

            <Length>123</Length>

            <ObjectId>440622ba-556b-11e4-896c-080027200702</ObjectId>

         </Blob>

         <State>IN_CACHE</State

      </Entries>
      <JobLockedCacheInBytes>1234</JobLockedCacheInBytes>

      <Summary>summary message</Summary>

      <TotalCapacityInBytes>6789</TotalCapacityInBytes>
      <UnavailableCapacityInBytes>

         4321

      </UnavailableCapacityInBytes>

      <UsedCapacityInBytes>3456</UsedCapacityInBytes>

   </Filesystems>

</Data>

MODIFY CACHE FILESYSTEM

Description
Modify the auto reclaim initiate threshold, auto reclaim terminate threshold, burst threshold,
or maximum capacity for the specified cache filesystem.

Note: If an optional request parameter is not included, the previous setting is retained.

Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/cache_filesystem/{cache filesystem UUID}/

[?auto_reclaim_initiate_threshold={double}][&auto_reclaim_terminate_threshold=

{double}][&burst_threshold={double}][&cachesafetyenabled=TRUE|FALSE][&max_capacity_

in_bytes={64-bit integer}]

To determine the UUID for a cache filesystem, see Get Cache Filesystems on page 1015.

April 2023 DS3 API Reference-Spectra BlackPearl Nearline Gateway
- 1023 -



Chapter 18 - Cache Operations Modify Cache Filesystem

Request Parameters

Parameter Description Required

AutoReclaim
InitiateThreshold

The percentage full at which cache reclamation begins,
expressed as a double-precision floating point number.
Note: AutoReClaimInitiateThreshold must be equal
or larger than AutoReclaimTerminateThreshold.

no

AutoReclaim
Terminate Threshold

The percentage full at which cache reclamation
terminates, expressed as a double-precision floating point
number.
Note: AutoReClaimInitiateThreshold must be equal
or larger than AutoReclaimTerminateThreshold.

no

BurstThreshold The percent utilization the cache must exceed to disable
bursting, which permits the allocation of all cache
resources on one job regardless of the job’s priority.
Having a bust threshold below 1.0 ensures that one job
does not prevent resources from being available for other
jobs.

no

CacheSafetyEnabled Whether the BlackPearl system waits for all data to be
transferred the system cache before returning that the
operation is complete.
Values: TRUE, FALSE (default)

no

MaxCapacityIn Bytes The maximum capacity that can be used by the cache. no

Responses

Response Elements
<Data>

   <AutoReclaimInitiateThreshold>

{double}

   </AutoReclaimInitiateThreshold>

   <AutoReclaimTerminateThreshold>

{double}

   </AutoReclaimTerminateThreshold>
   <BurstThreshold>{double}</BurstThreshold>
   <CacheSafetyEnabled>TRUE|FALSE</CacheSafetyEnabled>

   <Id>{string}</Id>

   <MaxCapacityInBytes>{64-bit integer}</MaxCapacityInBytes>

April 2023 DS3 API Reference-Spectra BlackPearl Nearline Gateway
- 1024 -



Chapter 18 - Cache Operations Modify Cache Filesystem

   <MaxPercentUtilizationOfFilesystem>

{double}

   </MaxPercentUtilizationOfFilesystem>

   <NodeId>{string}</NodeId>

   <Path>{string}</Path>
</Data>

where the response elements are defined as follows:

Parameter Description

Data A container for the response.

AutoReclaim
InitiateThreshold

The percentage full at which cache reclamation begins, expressed as a
double-precision floating point number.

AutoReclaim
Terminate Threshold

The percentage full at which cache reclamation terminates, expressed as
a double-precision floating point number.

BurstThreshold The percent utilization the cache must exceed to disable bursting, which
permits the allocation of all cache resources on one job regardless of the
job’s priority. Having a bust threshold below 1.0 ensures that one job
does not prevent resources from being available for other jobs.

CacheSafetyEnabled Whether the BlackPearl system waits for all data to be transferred the
system cache before returning that the operation is complete.

Id The UUID for the cache filesystem.

MaxCapacityIn Bytes The maximum capacity that can be used by the cache.
Note: If both MaxCapacityInBytes and
MaxPercentUtilizationOfFilesystem are specified, the lesser of
the two is used for the maximum cache capacity.

MaxPercent
UtilizationOf
Filesystem

The maximum capacity that can be used by the cache as a percentage of
the total usable cache capacity.
Note: If both MaxCapacityInBytes and
MaxPercentUtilizationOfFilesystem are specified, the lesser of
the two is used for the maximum cache capacity.

NodeId The UUID for the for the node associated with the cache.

Path The path to the cache filesystem on the BlackPearl gateway.
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Example

Sample Request
This request changes the auto reclaim initiate threshold for the cache filesystem with UUID
f2e97b09-75c0-47f6-8118-e96677f30869 to .90.
PUT http[s]://blackpearl-hostname/_rest_/cache_filesystem/f2e97b09-75c0-47f6-8118-

e96677f30869/?auto_reclaim_initiate_threshold=.90 HTTP/1.1

Sample Response
HTTP/1.1 200 OK
<Data>

   <AutoReclaimInitiateThreshold>

      0.90

   </AutoReclaimInitiateThreshold>

   <AutoReclaimTerminateThreshold>

      0.72

   </AutoReclaimTerminateThreshold>
   <BurstThreshold>1.01</BurstThreshold>
   <CacheSafetyEnabled>{TRUE|FALSE}</CacheSafetyEnabled>

   <Id>f2e97b09-75c0-47f6-8118-e96677f30869</Id>

   <MaxCapacityInBytes/>

   <MaxPercentUtilizationOfFilesystem/>
   <NodeId>9a50d885-00d0-468c-a7a6-bdc54060923a</NodeId>

   <Path>

      /usr/local/BlackPearl/frontend/cachedir/

   </Path>
</Data>
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This chapter provides detailed descriptions for capacity information operations.

Get Bucket Capacity Summary 1027

Get Storage Domain Capacity Summary 1029

Get System Capacity Summary 1032

GET BUCKET CAPACITY SUMMARY

Description
Get the capacity summary for the specified bucket on the specified storage domain. Use
parameters as selection criteria to return capacity information for a portion of the bucket.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/capacity_summary/?bucket_id={string}&storage_

domain_id={string}[&pool_health=OK|DEGRADED][&pool_

state=BLANK|NORMAL|LOST|FOREIGN|IMPORT_PENDING|IMPORT_IN_PROGRESS][&pool_

type=NEARLINE|ONLINE][&tape_state=NORMAL|BAD|BAR_CODE_MISSING|DATA_CHECKPOINT_

MISSING|EJECT_FROM_EE_PENDING|EJECT_TO_EE_IN_PROGRESS|EJECTED|FOREIGN|FORMAT_IN_

PROGRESS|FORMAT_PENDING|IMPORT_IN_PROGRESS|INCOMPATIBLE|PENDING_

INSPECTION|LOST|LTFS_WITH_FOREIGN_DATA|OFFLINE|ONLINE_IN_PROGRESS|ONLINE_

PENDING|SERIAL_NUMBER_MISMATCH|UNKNOWN][&tape_

type=LTO5|LTO6|LTO7|LTO8|LTOM8|LTO9|LTO_CLEANING_TAPE|TS_JC|TS_JD|TS_JE|TS_JK|TS_

JL|TS_JM|TS_JV|TS_JY|TS_JZ|TS_CLEANING_TAPE|UNKNOWN|FORBIDDEN]

Request Parameters

Parameter Description Required

bucket_id The UUID, name, or other unique identifier for the bucket. yes

storage_
domain_id

The UUID for the storage domain assigned to the bucket. yes
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Parameter Description Required

pool_health The current health of the pool. Values: OK, DEGRADED. no

pool_type The type of pool.
Values: NEARLINE (Deep Storage), ONLINE (High Performance)

no

pool_state The status of the pool. See State on page 600. no

tape_state The status of the tape partition. See State on page 664. no

tape_type The tape format and generation of the tape cartridge.
Values: LTO5, LTO6, LTO7, LTO8, LTOM8, LTO9, LTO_CLEANING_
TAPE, TS_JC, TS_JD, TS_JE, TS_JK, TS_JL, TS_JM, TS_JV, TS_JY, TS_
JZ, TS_CLEANING_TAPE, UNKNOWN, FORBIDDEN

no

Responses

Response Elements
<Data>

   <Pool>

      <PhysicalAllocated>{64-bit integer}</PhysicalAllocated>

      <PhysicalFree>{64-bit integer}</PhysicalFree>

      <PhysicalUsed>{64-bit integer}</PhysicalUsed>

   </Pool>

   <Tape>

      <PhysicalAllocated>{64-bit integer}</PhysicalAllocated>

      <PhysicalFree>{64-bit integer}</PhysicalFree>

      <PhysicalUsed>{64-bit integer}</PhysicalUsed>

   </Tape>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

Pool The container for capacity information for a pool in the storage domain.

PhysicalAllocated The physical capacity currently allocated, in bytes.

PhysicalFree The physical capacity currently allocated, AND free (not used).
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Parameter Description

PhysicalUsed The physical capacity currently used, in bytes.
Note: The physical used + physical free = physical allocated.

Tape The container for capacity information for tape
partitions in the storage domain.

Example

Sample Request
This request gets the capacity summary for the bucket named “bucket1” on the storage
domain named “LTO-5Tape”.
GET http://blackpearl-hostname/_rest_/capacity_summary/?bucket_id=bucket1&storage_

domain_id=LTO-5Tape HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>

   <Pool>

      <PhysicalAllocated>0</PhysicalAllocated>

      <PhysicalFree>0</PhysicalFree>

      <PhysicalUsed>0</PhysicalUsed>

   </Pool>

   <Tape>

      <PhysicalAllocated>800</PhysicalAllocated>

      <PhysicalFree>200</PhysicalFree>

      <PhysicalUsed>600</PhysicalUsed>

   </Tape>

</Data>

GET STORAGE DOMAIN CAPACITY SUMMARY

Description
Get the capacity summary for the specified storage domain. Use parameters as selection
criteria to return capacity information for a portion of the storage domain.
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Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/capacity_summary/?storage_domain_id={string}

[&pool_health=OK|DEGRADED][&pool_state=BLANK|NORMAL|LOST|FOREIGN|IMPORT_

PENDING|IMPORT_IN_PROGRESS][&pool_type=NEARLINE|ONLINE][&tape_state=NORMAL|BAD|BAR_

CODE_MISSING|DATA_CHECKPOINT_MISSING|EJECT_FROM_EE_PENDING|EJECT_TO_EE_IN_

PROGRESS|EJECTED|FOREIGN|FORMAT_IN_PROGRESS|FORMAT_PENDING|IMPORT_IN_

PROGRESS|INCOMPATIBLE|PENDING_INSPECTION|LOST|LTFS_WITH_FOREIGN_DATA|OFFLINE|ONLINE_

IN_PROGRESS|ONLINE_PENDING|SERIAL_NUMBER_MISMATCH|UNKNOWN][&tape_

type=LTO5|LTO6|LTO7|LTO8|LTOM8|LTO9|LTO_CLEANING_TAPE|TS_JC|TS_JD|TS_JE|TS_JK|TS_

JL|TS_JM|TS_JV|TS_JY|TS_JZ|TS_CLEANING_TAPE|UNKNOWN|FORBIDDEN]

Request Parameters

Parameter Description Required

storage_
domain_id

The UUID for the storage domain assigned to the bucket. yes

pool_health The current health of the pool. Values: OK, DEGRADED. no

pool_type The type of pool.
Values: NEARLINE (Deep Storage), ONLINE (High Performance)

no

pool_state The status of the pool. See State on page 600. no

tape_state The status of the tape partition. See State on page 664. no

tape_type The tape format and generation of the tape cartridge.
Values: LTO5, LTO6, LTO7, LTO8, LTOM8, LTO9, LTO_CLEANING_
TAPE, TS_JC, TS_JD, TS_JE, TS_JK, TS_JL, TS_JM, TS_JV, TS_JY, TS_
JZ, TS_CLEANING_TAPE, UNKNOWN, FORBIDDEN

no
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Responses

Response Elements
<Data>

   <Pool>

      <PhysicalAllocated>{64-bit integer}</PhysicalAllocated>

      <PhysicalFree>{64-bit integer}</PhysicalFree>

      <PhysicalUsed>{64-bit integer}</PhysicalUsed>

   </Pool>

   <Tape>

      <PhysicalAllocated>{64-bit integer}</PhysicalAllocated>

      <PhysicalFree>{64-bit integer}</PhysicalFree>

      <PhysicalUsed>{64-bit integer}</PhysicalUsed>

   </Tape>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

Pool The container for capacity information for all pools in
the storage domain.

PhysicalAllocated The physical capacity currently allocated, in bytes.

PhysicalFree The physical capacity currently free (not used or
allocated), in bytes.

PhysicalUsed The physical capacity currently used, in bytes.

Tape The container for capacity information for all tape
partitions in the storage domain.

Example

Sample Request
This request gets the capacity summary for the storage domain named “accounting”.
GET http://blackpearl-hostname/_rest_/capacity_summary/?storage_domain_id=accounting

HTTP/1.1
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Sample Response
HTTP/1.1 200 OK

<Data>

   <Pool>

      <PhysicalAllocated>1500</PhysicalAllocated>

      <PhysicalFree>1000</PhysicalFree>

      <PhysicalUsed>500</PhysicalUsed>

   </Pool>

   <Tape>

      <PhysicalAllocated>1501</PhysicalAllocated>

      <PhysicalFree>1000</PhysicalFree>

      <PhysicalUsed>501</PhysicalUsed>

   </Tape>

</Data>

GET SYSTEM CAPACITY SUMMARY

Description
Get the Spectra BlackPearl Nearline Gateway system-wide capacity summary. Use
parameters as selection criteria to return capacity information for a portion of the system.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/capacity_summary/[?pool_health=OK|DEGRADED]

[&pool_state=BLANK|NORMAL|LOST|FOREIGN|IMPORT_PENDING|IMPORT_IN_PROGRESS][&pool_

type=NEARLINE|ONLINE][&tape_state=NORMAL|BAD|BAR_CODE_MISSING|DATA_CHECKPOINT_

MISSING|EJECT_FROM_EE_PENDING|EJECT_TO_EE_IN_PROGRESS|EJECTED|FOREIGN|FORMAT_IN_

PROGRESS|FORMAT_PENDING|IMPORT_IN_PROGRESS|INCOMPATIBLE|PENDING_

INSPECTION|LOST|LTFS_WITH_FOREIGN_DATA|OFFLINE|ONLINE_IN_PROGRESS|ONLINE_

PENDING|SERIAL_NUMBER_MISMATCH|UNKNOWN][&tape_

type=LTO5|LTO6|LTO7|LTO8|LTOM8|LTO9|LTO_CLEANING_TAPE|TS_JC|TS_JD|TS_JE|TS_JK|TS_

JL|TS_JM|TS_JV|TS_JY|TS_JZ|TS_CLEANING_TAPE|UNKNOWN|FORBIDDEN]
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Request Parameters

Parameter Description Required

pool_health The current health of the pool. Values: OK, DEGRADED. no

pool_type The type of pool.
Values: NEARLINE (Deep Storage), ONLINE (High Performance)

no

pool_state The status of the pool. See State on page 600. no

tape_state The status of the tape partition. See State on page 664. no

tape_type The tape format and generation of the tape cartridge.
Values: LTO5, LTO6, LTO7, LTO8, LTOM8, LTO9, LTO_CLEANING_
TAPE, TS_JC, TS_JD, TS_JE, TS_JK, TS_JL, TS_JM, TS_JV, TS_JY, TS_
JZ, TS_CLEANING_TAPE, UNKNOWN, FORBIDDEN

no

Responses

Response Elements
<Data>

   <Pool>

      <PhysicalAllocated>{64-bit integer}</PhysicalAllocated>

      <PhysicalAvailable>{64-bit integer}</PhysicalAvailable>

      <PhysicalFree>{64-bit integer}</PhysicalFree>

      <PhysicalUsed>{64-bit integer}</PhysicalUsed>

   </Pool>

   <Tape>

      <PhysicalAllocated>{64-bit integer}</PhysicalAllocated>

      <PhysicalAvailable>{64-bit integer}</PhysicalAvailable>

      <PhysicalFree>{64-bit integer}</PhysicalFree>

      <PhysicalUsed>{64-bit integer}</PhysicalUsed>

   </Tape>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

Pool The container for capacity information across all pools.
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Parameter Description

PhysicalAllocated The physical capacity currently allocated, in bytes.

PhysicalAvailable The physical capacity not allocated, in bytes. (physical allocated + physical
available = total physical capacity)

PhysicalFree The physical capacity currently free (not used or
allocated), in bytes.

PhysicalUsed The physical capacity currently used, in bytes.

Tape The container for capacity information for all tape
partitions.

Example

Sample Request
This request gets the capacity summary for the BlackPearl gateway.
GET http://blackpearl-hostname/_rest_/capacity_summary/ HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>

   <Pool>

      <PhysicalAllocated>0</PhysicalAllocated>

      <PhysicalAvailable>0</PhysicalAvailable>

      <PhysicalFree>0</PhysicalFree>

      <PhysicalUsed>0</PhysicalUsed>

   </Pool>

   <Tape>

      <PhysicalAllocated>3000</PhysicalAllocated>

      <PhysicalAvailable>15000</PhysicalAvailable>

      <PhysicalFree>2000</PhysicalFree>

      <PhysicalUsed>1000</PhysicalUsed>

   </Tape>

</Data>
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CHAPTER 20 - DATA PLANNER OPERATIONS
This chapter provides detailed descriptions for operation to get the status of and modify the
performance of the data planner.

Get Data Path Backend 1035

Get Data Planner Blob Store Tasks 1040

Modify Data Path Backend 1043

GET DATA PATH BACKEND

Description
Get information about the data path backend.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/data_path_backend/

Responses

Response Elements
<Data>

   <Activated>TRUE|FALSE</Activated>
   <AllowNewJobRequests>TRUE|FALSE</AllowNewJobRequests>

   <AutoActivateTimeoutInMins>

{32-bit integer}

   </AutoActivateTimeoutInMins>

   <AutoInspect>DEFAULT|MINIMAL|NEVER</AutoInspect>
   <CacheAvailableRetryAfterInSeconds>

{32-bit integer}

   </CacheAvailableRetryAfterInSeconds>
   <DefaultVerifyDataAfterImport>

      URGENT|HIGH|NORMAL|LOW

   </DefaultVerifyDataAfterImport>

- 1035 -



Chapter 20 - Data Planner Operations Get Data Path Backend

   <DefaultVerifyDataPriorToImport>

      TRUE|FALSE

   </DefaultVerifyDataPriorToImport>
   <Id>{string}</Id>

   <InstanceId>{string}</InstanceId>
   <IomCacheLimitationPercent>{double}</IomCacheLimitationPercent>

   <IomEnabled>TRUE|FALSE</IomEnabled>

   <LastHeartbeat>YYYY-MM-DDThh:mm:ss.xxxZ</LastHeartbeat>

   <MaxAggregatedBlobsPerChunk>

{32-bit integer}

   </MaxAggregatedBlobsPerChunk>

   <LastHeartbeat>YYYY-MM-DDThh:mm:ss.xxxZ</LastHeartbeat>

   <PartiallyVerifyLastPercentOfTape>

{32-bit integer}

   </PartiallyVerifyLastPercentOfTape>
   <PoolSafetyEnabled>TRUE|FALSE</PoolSafetyEnabled>
   <UnavailableMediaPolicy>

       ALLOW|DISCOURAGED|DISALLOW

   </UnavailableMediaPolicy>
   <UnavailablePoolMaxJobRetryInMins>

{32-bit integer}

   </UnavailablePoolMaxJobRetryInMins>
   <UnavailableTapePartitionMaxJobRetryInMins>

{32-bit integer}

   </UnavailableTapePartitionMaxJobRetryInMins>
   <VerifyCheckpointBeforeRead>TRUE|FALSE</VerifyCheckpointBeforeRead>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

Activated Whether the BlackPearl gateway is allowed to send to the
data path backend (pool or tape partitions).
Values: TRUE, FALSE

AllowNewJob Requests Whether the BlackPearl gateway allows new jobs to be
initiated. Values: TRUE, FALSE
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Parameter Description

AutoActivate TimeoutInMins The number of minutes allowed for the data planner to
take between when it is shut down and when it comes
back up, and have the data path back end automatically
activate. If the data planner remains shutdown for longer
than this number of minutes, the data path backend will
not automatically activate. If this parameter is null, the
data path backend will never automatically activate.

AutoInspect Whether tape inspections are automatically scheduled
whenever the data planner starts.
Values: DEFAULT, MINIMAL, NEVER
See auto_inspect on page 1044.

CacheAvailable RetryAfterIn
Seconds

The recommended number of seconds for clients to wait
between sending Get Job Chunks Ready for Processing (see
page 222) requests.

DefaultVerifyDataAfterImport The priority for verifying the data after import. This
determines the resources assigned and the processing
order.
Values: URGENT, HIGH, NORMAL, LOW

DefaultVerifyData PriorToImport Whether the data must be verified before the tape is
imported. Values: TRUE, FALSE
Note: It is recommended to verify data prior to import
whenever it is possible that the tapes being imported
contain objects with the same name as objects already in
the bucket. Without verifying data prior to import, it is
possible for the existing object to be replaced with the one
being imported, even if the one being imported is partially
corrupt and cannot be read.

Id The UUID for the record. This is only useful to the
BlackPearl gateway.

InstanceID The UUID for the BlackPearl gateway session.

IomCacheLimitationPercent The percentage of the cache, represented as a decimal, that
can be used for IOM tasks.

IomEnabled Whether Intelligent Object Management (IOM) is enabled.

LastHeartbeat The date and time that the gateway last sent a heartbeat in
the format YYYY-MM-DDThh:mm:ss.xxxZ.
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Parameter Description

MaxAggregatedBlobsPerChunk The maximum number of blobs that can be aggregated into
a single tape task.

PartiallyVerifyLastPercentOfTapes The percentage of the overall tape capacity before the EOD
marker that the BlackPearl gateway verifies during data
integrity verification. Verifying a percentage of the tape,
rather than the entire tape is useful when you only want to
verify the most recent data written to the tape.
Values: 1-99
Note: To verify the entire tape, see Verify Tape on
page 831.

PoolSafetyEnabled Whether the BlackPearl system waits for all data to be
transferred the storage pool before returning that the
operation is complete.
Values: TRUE (default), FALSE

UnavailableMedia Policy Whether new job requests are allowed to use partitions
that are currently unavailable.
Values: ALLOW, DISCOURAGE, DISALLOW
See unavailable_media_policy on page 1045.

UnavailablePool MaxJobRetryIn
Mins

How long job requests using unavailable pools will retry
before being re-chunked or failing if re-chunking cannot
solve the problem.

UnavailableTape PartitionMaxJob
RetryInMins

How long job requests using unavailable tape partitions
will retry before being re-chunked or failing if re-chunking
cannot solve the problem.

VerifyCheckpointBeforeRead When a tape cartridge is loaded into a drive, this
parameter controls whether the BlackPearl system verifies
the starting checkpoint of the tape before reading data.
Values: TRUE (default), FALSE

Example

Sample Request
This request gets information about the data path backend.
GET http://blackpearl-hostname/_rest_/data_path_backend/ HTTP/1.1
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Sample Response
HTTP/1.1 200 OK

<Data>

   <Activated>TRUE</Activated>
   <AllowNewJobRequests>TRUE</AllowNewJobRequests>
   <AutoActivateTimeoutInMins>30</AutoActivateTimeoutInMins>
   <AutoInspect>DEFAULT</AutoInspect>

   <CacheAvailableRetryAfterInSeconds>

      300

   </CacheAvailableRetryAfterInSeconds>
   <DefaultVerifyDataAfterImport/>
   <DefaultVerifyDataPriorToImport>

      TRUE

   </DefaultVerifyDataPriorToImport>
   <Id>7d7601d0-4dba-47a4-8235-8a1ceefe91fa</Id>

   <InstanceId>51db3e63-f63a-4503-8d48-6b8b52d6eb98</InstanceId>

   <IomCacheLimitationPercent>.5</IomCacheLimitationPercent>

   <IomEnabled>TRUE</IomEnabled>

   <LastHeartbeat>2016-01-21T18:53:55.000Z</LastHeartbeat>
   <MaxAggregatedBlobsPerChunk>

      20000

   </MaxAggregatedBlobsPerChunk>
   <PartiallyVerifyLastPercentOfTape>

15

   </PartiallyVerifyLastPercentOfTape>
   <PoolSafetyEnabled>TRUE</PoolSafetyEnabled>
   <UnavailableMediaPolicy>DISCOURAGED</UnavailableMediaPolicy>

   <UnavailablePoolMaxJobRetryInMins>

      20

   </UnavailablePoolMaxJobRetryInMins>

   <UnavailableTapePartitionMaxJobRetryInMins>

      20

   </UnavailableTapePartitionMaxJobRetryInMins>
   <VerifyCheckpointBeforeRead>FALSE</VerifyCheckpointBeforeRead>

</Data>
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GET DATA PLANNER BLOB STORE TASKS

Description
Get the actively in progress tasks the BlackPearl gateway is processing in the backend. If the
full details flag is specified, this also includes all queued work in the backend.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/blob_store_task/[?full_details]

Request Parameters 

Parameter Description Required

full_details If included, all tasks are reported, without it, only tasks that are
pending execution or are currently executing are reported.

no

Responses

Response Elements
<Data>

   <Tasks>

      <DateScheduled>{YYYY-MM-DDThh:mm:ss.xxxZ}</DateScheduled>

      <DateStarted>{YYYY-MM-DDThh:mm:ss.xxxZ}</DateStarted>

      <Description>{string}</Description>

      <Id>{64-bit integer}</Id>

      <Name>{string}</Name>

      <Priority>
         CRITICAL|URGENT|HIGH|NORMAL|LOW|BACKGROUND

      </Priority>
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      <State>

         COMPLETED|IN_PROGRESS|NOT_READY|PENDING_EXECUTION|READY

      </State>

      <PoolId>{string}</PoolId>

      <TapeId>{string}</TapeId>

   </Tasks>

   ...

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

Tasks The container for information about one task.

DateScheduled The date and time the task was scheduled by the data planner in the format
YYYY-MM-DDThh:mm:ss.xxxZ.

DateStarted The date and time the task execution started in the format YYYY-MM-
DDThh:mm:ss.xxxZ.

Description A description of the task.

Id The ID for the task. This is only useful to the BlackPearl gateway.

Name The name of the task.

Priority The task priority. This determines the resources assigned and the processing
order.
Values: CRITICAL, URGENT, HIGH, NORMAL, LOW, BACKGROUND

State The state of the task.
Values:
• COMPLETED —The task is complete and its resources may be released and
re-used for another task.

• IN_PROGRESS — The task is being executed.
• NOT_READY — The task is temporarily suspended (likely due to too many
failures in a row) or otherwise not ready and cannot be executed at this
time.

• PENDING_EXECUTION — The task is scheduled for immediate execution,
with all required resources locked and provisioned, so that execution may
begin imminently.

• READY — The task is ready for execution once all required resources are
available.
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Parameter Description

PoolId The UUID for the pool acted on by the task, if applicable.

TapeId The UUID for the tape acted on by the task, if applicable.

Example

Sample Request
This request gets information about all data planner blob store tasks.
GET http://blackpearl-hostname/_rest_/blob_store_task/ HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>

   <Tasks>

      <DateScheduled>2015-11-23T16:29:51.000Z</DateScheduled>
      <DateStarted>2015-11-23T17:12:15.000Z</DateStarted>
      <Description>

          Inspect Tape 3b682d17-3f7b-4f69-9f13-7dd2b7577c7c

      </Description>
      <DriveId>31269ab2-2bca-45c3-b9dd-e13b55cfae86</DriveId>

      <Id>41</Id>

      <Name>InspectTapeTask</Name>
      <Priority>LOW</Priority>

      <State>IN_PROGRESS</State>

      <TapeId>3b682d17-3f7b-4f69-9f13-7dd2b7577c7c</TapeId>

   </Tasks>

</Data>
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MODIFY DATA PATH BACKEND

Description
Activate the data path or configure automatic data path activation. Setting the auto activation
timeout to null disables auto activation. If a tape partition is connected to more than one
BlackPearl gateway, for example, for failover purposes, it is critical that at most one gateway
attached to the same tape partition, is active at a time. Otherwise, multiple BlackPearl
gateways may issue conflicting requests to robots and tape drives. This can cause data
corruption or data loss. If your configuration has only one BlackPearl gateway, it is safe to
increase the auto activate timeout. If your configuration has multiple BlackPearl gateways
attached to the same tape partition, consider modifying the auto activate timeout to null in
order to guarantee that both gateways cannot be auto-activated at the same time.

CAUTION Having two BlackPearl gateways connected to the same tape partition, active at the
same time can cause database corruption or data loss.

Note: If an optional request parameter is not included, the previous setting is retained.

Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/data_path_backend/[?activated=TRUE|FALSE]

[&allow_new_job_requests=TRUE|FALSE][&auto_activate_timeout_in_mins=

{32-bit integer}][&auto_inspect=NEVER|MINIMAL|DEFAULT][&cache_available_retry_after_

in_seconds={32-bit integer}][&default_verify_data_after_

import=CRITICAL|URGENT|HIGH|NORMAL|LOW|BACKGROUND][&default_verify_data_prior_to_

import=TRUE|FALSE][&iom_cache_limitation_percent={double}][&iom_enabled][&max_

aggregated_blobs_per_chunk={32-bit integer}][&partially_verify_last_percent_of_

tapes={32-bit integer}][&pool_safety_enabled=TRUE|FALSE][&unavailable_media_

policy=ALLOW|DISCOURAGED|DISALLOW][&unavailable_pool_max_job_retry_in_mins=

{32-bit integer}][&unavailable_tape_partition_max_job_retry_in_mins=

{32-bit integer}][&verify_checkpoint_before_read=TRUE|FALSE]
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Request Parameters

Parameter Description Required

activated Whether the BlackPearl gateway is allowed to send data to the
data path backend (pool or tape partitions).
Values: TRUE, FALSE

no

allow_new_
job_ requests

Whether the BlackPearl gateway allows new jobs to be initiated.
Values: TRUE, FALSE

no

auto_activate_
timeout_in_
mins

The number of minutes allowed for the data planner to take
between when it is shut down and when it comes back up, and
have the data path back end automatically activate. If the data
planner remains shutdown for longer than this number of
minutes, the data path backend will not automatically activate. If
this parameter is null, the data path backend will never
automatically activate. Default: 30 minutes

no

auto_inspect Whether tape inspections are automatically scheduled whenever
the data planner starts.
Values:
• DEFAULT — Tapes have inspections scheduled for them if an
inspection is necessary given the tape's current state, as well as
every time the data path starts up.

• MINIMAL — Tapes have inspections scheduled for them if an
inspection is necessary given the tape's current state.

• NEVER — Tapes are not automatically scheduled for inspection.

no

cache_
available_
retry_after_in_
seconds

Set the recommended number of seconds for clients to wait
between sending Get Job Chunks Ready for Processing (see
page 222) requests. The default is 300.

no

default_verify_
data_after_
import

The priority for verifying the data after import. This determines
the resources assigned and the processing order. Tasks with
priority URGENT can use up all of the resources and prevent other
jobs from making progress. Use this priority sparingly.
Values: URGENT, HIGH, NORMAL, LOW

no
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Parameter Description Required

default_verify_
data_ prior_to_
import

Whether the data must be verified before the media is imported.
Values: TRUE, FALSE
Note: It is recommended to verify data prior to import whenever
it is possible that the media being imported contain objects with
the same name as objects already in the bucket. Without verifying
data prior to import, it is possible for the existing object to be
replaced with the one being imported, even if the one being
imported is partially corrupt and cannot be read.

no

iom_cache_
limitation_
percent

The percentage of the cache, represented as a decimal, that can be
used for IOM tasks. The default is 0.5 (50%).

no

iom_enabled When included, Intelligent Object Management (IOM) is enabled.
When enabled, the gateway attempts to repair any objects or
tapes that are faulty is other copies of the objects exist.

no

max_
aggregated_
blobs_per_
chunk

The maximum number of blobs that can be aggregated into a
single tape task. The default is 20000.

no

partially_
verify_ last_
percent_of_
tapes

The percentage of the overall tape capacity before the EOD
marker that the BlackPearl gateway verifies during data integrity
verification. Verifying a percentage of the tape, rather than the
entire tape is useful when you only want to verify the most recent
data written to the tape.
Values: 1-99
Note: To verify the entire tape, see Verify Tape on page 831.

no

pool_safety_
enabled

Whether the BlackPearl system waits for all data to be transferred
the storage pool before returning that the operation is complete.
Values: TRUE (default), FALSE

no

unavailable_
media_policy

Whether new job requests are allowed to use media that are
currently unavailable.
Values:
• ALLOW —New job requests for unavailable media are allowed
and will retry for the duration of the unavailable_pool_max_
job_retry_in_mins or unavailable_tape_partition_max_job_
retry_in_mins.

• DISCOURAGE (default) — Unavailable partitions can be used,
but only if no other media is available.

• DISALLOW — New job requests for unavailable media will fail.

no

April 2023 DS3 API Reference-Spectra BlackPearl Nearline Gateway
- 1045 -



Chapter 20 - Data Planner Operations Modify Data Path Backend

Parameter Description Required

unavailable_
pool_max_job_
retry_in_mins

How long job requests using unavailable pools will retry before
being re-chunked or failing if re-chunking cannot solve the
problem. Default: 20 minutes

no

unavailable_
tape_partition_
max_job_
retry_in_mins

How long job requests using unavailable tape partitions will retry
before being re-chunked or failing if re-chunking cannot solve the
problem. Default: 20 minutes

no

verify_
checkpoint_
before_read

When a tape cartridge is loaded into a drive, this parameter
controls whether the BlackPearl system verifies the starting
checkpoint of the tape before reading data.
Values: TRUE (default), FALSE

no

Responses

Response Elements
<Data>

   <Activated>TRUE|FALSE</Activated>

   <AllowNewJobRequests>TRUE|FALSE</AllowNewJobRequests>

   <AutoActivateTimeoutInMins>

{32-bit integer}

   </AutoActivateTimeoutInMins>
   <AutoInspect>DEFAULT|MINIMAL|NEVER</AutoInspect>

   <CacheAvailableRetryAfterInSeconds>

{32-bit integer}

   </CacheAvailableRetryAfterInSeconds>

   <DefaultVerifyDataAfterImport>

      URGENT|HIGH|NORMAL|LOW

   </DefaultVerifyDataAfterImport>
   <DefaultVerifyDataPriorToImport>

      TRUE|FALSE

   </DefaultVerifyDataPriorToImport>

   <Id>{string}</Id>

   <InstanceId>{string}</InstanceId>
   <IomCacheLimitationPercent>{double}</IomCacheLimitationPercent>

   <IomEnabled>TRUE|FALSE</IomEnabled>

   <LastHeartbeat>YYYY-MM-DDThh:mm:ss.xxxZ</LastHeartbeat>

   <MaxAggregatedBlobsPerChunk>

{32-bit integer}

   </MaxAggregatedBlobsPerChunk>
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   <PartiallyVerifyLastPercentOfTape>

{32-bit integer}

   </PartiallyVerifyLastPercentOfTape>
   <PoolSafetyEnabled>TRUE|FALSE</PoolSafetyEnabled>
   <UnavailableMediaPolicy>

       ALLOW|DISCOURAGED|DISALLOW

   </UnavailableMediaPolicy>

   <UnavailablePoolMaxJobRetryInMins>

{32-bit integer}

   </UnavailablePoolMaxJobRetryInMins>

   <UnavailableTapePartitionMaxJobRetryInMins>

{32-bit integer}

   </UnavailableTapePartitionMaxJobRetryInMins>
   <VerifyCheckpointBeforeRead>TRUE|FALSE</VerifyCheckpointBeforeRead>
</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

Activated Whether the BlackPearl gateway is allowed to send to the
data path backend (pool or tape partitions).
Values: TRUE, FALSE

AllowNewJob Requests Whether the BlackPearl gateway allows new jobs to be
initiated. Values: TRUE, FALSE

AutoActivate TimeoutInMins The number of minutes allowed for the data planner to
take between when it is shut down and when it comes
back up, and have the data path back end automatically
activate. If the data planner remains shutdown for longer
than this number of minutes, the data path backend will
not automatically activate. If this parameter is null, the
data path backend will never automatically activate.

AutoInspect Whether tape inspections are automatically scheduled
whenever the data planner starts.
Values: DEFAULT, MINIMAL, NEVER
See auto_inspect on page 1044.

CacheAvailable RetryAfterIn
Seconds

The recommended number of seconds for clients to wait
between sending Get Job Chunks Ready for Processing (see
page 222) requests.

April 2023 DS3 API Reference-Spectra BlackPearl Nearline Gateway
- 1047 -



Chapter 20 - Data Planner Operations Modify Data Path Backend

Parameter Description

DefaultVerifyDataAfterImport The priority for verifying the data after import. This
determines the resources assigned and the processing
order.
Values: URGENT, HIGH, NORMAL, LOW

DefaultVerifyData PriorToImport Whether the data must be verified before the tape is
imported. Values: TRUE, FALSE
Note: It is recommended to verify data prior to import
whenever it is possible that the tapes being imported
contain objects with the same name as objects already in
the bucket. Without verifying data prior to import, it is
possible for the existing object to be replaced with the one
being imported, even if the one being imported is partially
corrupt and cannot be read.

Id The UUID for the record. This is only useful to the
BlackPearl gateway.

InstanceID The UUID for the BlackPearl gateway session.

IomCacheLimitationPercent The percentage of the cache, represented as a decimal, that
can be used for IOM tasks.

IomEnabled Whether Intelligent Object Management (IOM) is enabled.

LastHeartbeat The date and time that the gateway last sent a heartbeat in
the format YYYY-MM-DDThh:mm:ss.xxxZ.

MaxAggregatedBlobsPerChunk The maximum number of blobs that can be aggregated into
a single tape task.

PartiallyVerifyLastPercentOfTapes The percentage of the overall tape capacity before the EOD
marker that the BlackPearl gateway verifies during data
integrity verification. Verifying a percentage of the tape,
rather than the entire tape is useful when you only want to
verify the most recent data written to the tape.
Values: 1-99
Note: To verify the entire tape, see Verify Tape on
page 831.

PoolSafetyEnabled Whether the BlackPearl system waits for all data to be
transferred the storage pool before returning that the
operation is complete.
Values: TRUE (default), FALSE
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Parameter Description

UnavailableMedia Policy Whether new job requests are allowed to use partitions
that are currently unavailable.
Values: ALLOW, DISCOURAGE, DISALLOW
See unavailable_media_policy on page 1045.

UnavailablePool MaxJobRetryIn
Mins

How long job requests using unavailable pools will retry
before being re-chunked or failing if re-chunking cannot
solve the problem.

UnavailableTape PartitionMaxJob
RetryInMins

How long job requests using unavailable tape partitions
will retry before being re-chunked or failing if re-chunking
cannot solve the problem.

VerifyCheckpointBeforeRead When a tape cartridge is loaded into a drive, this
parameter controls whether the BlackPearl system verifies
the starting checkpoint of the tape before reading data.
Values: TRUE (default), FALSE

Example

Sample Request
This request activates the data path backend.
PUT http://blackpearl-hostname/_rest_/data_path_backend/?activated=TRUE HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>

   <Activated>TRUE</Activated>

   <AllowNewJobRequests>TRUE</AllowNewJobRequests>

   <AutoActivateTimeoutInMins>44</AutoActivateTimeoutInMins>

   <AutoInspect>DEFAULT</AutoInspect>

   <CacheAvailableRetryAfterInSeconds>

      300

   </CacheAvailableRetryAfterInSeconds>

   <DefaultVerifyDataAfterImport/>

   <DefaultVerifyDataPriorToImport>

      TRUE

   </DefaultVerifyDataPriorToImport>
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   <Id>c9cebae2-a312-489e-b92c-84030957983a</Id>

   <InstanceId>2d6b0169-ce66-472a-9c61-c9dcd0b650b8</InstanceId>

   <IomCacheLimitationPercent>.5</IomCacheLimitationPercent>

   <IomEnabled>TRUE</IomEnabled>

   <LastHeartbeat>2016-01-21T18:53:55.000Z</LastHeartbeat>
   <MaxAggregatedBlobsPerChunk>

      20000

   </MaxAggregatedBlobsPerChunk>

   <PartiallyVerifyLastPercentOfTape>

      15

   </PartiallyVerifyLastPercentOfTape>
   <PoolSafetyEnabled>TRUE</PoolSafetyEnabled>

   <UnavailableMediaPolicy>DISCOURAGED</UnavailableMediaPolicy>

   <UnavailablePoolMaxJobRetryInMins>

      20

   </UnavailablePoolMaxJobRetryInMins>
   <UnavailableTapePartitionMaxJobRetryInMins>

      20

   </UnavailableTapePartitionMaxJobRetryInMins>
   <VerifyCheckpointBeforeRead>FALSE</VerifyCheckpointBeforeRead>

</Data>
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This chapter provides detailed information about suspect and degraded data. Data is
considered suspect if one or more copies of the data is corrupt (if the checksum read does not
match the expected value). Data is considered degraded if it is manually marked as lost (for
example, if an ejected tape that contains a copy is marked as permanently lost) or if suspect
data is manually marked as degraded. Degraded data can still be read provided that at least
one copy of the data is good. If every copy of copy of the data is marked as degraded, this
eliminates your ability to GET or VERIFY the object.

Clear Suspect Object Part in Storage Pool 1052

Clear Suspect Object Part on Tape 1053

Clear Suspect Object Part on an Amazon S3 Target 1055

Clear Suspect Object Part on an Azure Target 1057

Clear Suspect Object Part on a DS3 Target 1058

Get Degraded Object Parts 1060

Get Degraded Buckets 1063

Get Degraded Data Persistence Rules 1065

Get Degraded Amazon S3 Replication Rules 1068

Get Degraded Azure Replication Rules 1072

Get Degraded DS3 Replication Rules 1075

Get Suspect Object Parts in Storage Pools 1078

Get Suspect Object Parts on Tape Media 1080

Get Suspect Object Parts on Amazon S3 Targets 1082

Get Suspect Object Parts on Azure Targets 1084

Get Suspect Object Parts on DS3 Targets 1086

Get Suspect Buckets 1088

Get Suspect Objects 1091

Get Suspect Objects with Full Details 1094

Mark Suspect Object Part in a Storage Pool as Degraded 1110

Mark Suspect Object Part on Tape as Degraded 1112

Mark Suspect Object Part on an Amazon S3 Target as Degraded 1114

Mark Suspect Object Part on an Azure Target as Degraded 1116
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Mark Suspect Object Part on a DS3 Target as Degraded 1118

CLEAR SUSPECT OBJECT PART IN STORAGE POOL

Description
Clear the specified suspect blob (object part) degradation record for suspect object parts in a
storage pool, permitting the BlackPearl gateway to use the storage pool again to GET or
VERIFY those object parts.

Requests

Syntax
DELETE http[s]://{datapathDNSname}/_rest_/suspect_blob_pool/[?force]

Request Parameters

Parameter Description Required

force If included, the BlackPearl gateway clears the suspect blob
degradation records for all storage pools.

no

Request Elements
Unless you use the force parameter, an XML payload, formatted as follows, must be sent to
describe the suspect blob degradation records to clear.
<ids>

   <id>{string}</id>

   <id>{string}</id>

   <id>{string}</id>

</ids>

where the parameters are defined as follows:

Parameter Description Required

Ids The container for all suspect records to clear. yes

Id The UUID or other unique attribute for the suspect record to clear.
See Get Suspect Object Parts in Storage Pools on page 1078.

yes
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Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 400: Bad Request (force flag required)

Example

Sample Request
This request clears the suspect blob degradation record for suspect object parts in all storage
pools.
DELETE http://blackpearl-hostname/_rest_/suspect_blob_pool/?force HTTP/1.1

Sample Response
HTTP/1.1 204 No Content

CLEAR SUSPECT OBJECT PART ON TAPE

Description
Clear the specified suspect blob (object part) degradation record for suspect object parts on a
tape, permitting the BlackPearl gateway to use the tape again to GET or VERIFY those object
parts.

Requests

Syntax
DELETE http[s]://{datapathDNSname}/_rest_/suspect_blob_tape/[?force]
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Request Parameters

Parameter Description Required

force If included, the BlackPearl gateway clears the suspect blob
degradation records for all tape media.

no

Request Elements
Unless you use the force parameter, an XML payload, formatted as follows, must be sent to
describe the suspect blob degradation records to clear.
<ids>

   <id>{string}</id>

   <id>{string}</id>

   <id>{string}</id>

</ids>

where the parameters are defined as follows:

Parameter Description Required

Ids The container for all suspect records to clear. yes

Id The UUID or other unique attribute for the suspect record to clear.
See Get Suspect Object Parts on Tape Media on page 1080.

yes

Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 400: Bad Request (force flag required)
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Example

Sample Request
This request clears the suspect blob degradation record for the suspect object parts on all tape
media.
DELETE http://blackpearl-hostname/_rest_/suspect_blob_tape/?force HTTP/1.1

Sample Response
HTTP/1.1 204 No Content

CLEAR SUSPECT OBJECT PART ON AN AMAZON S3 TARGET

Description
Clear the specified suspect blob (object part) degradation record for suspect object parts on an
Amazon S3 target, permitting the BlackPearl gateway to use the target again to GET or
VERIFY those object parts.

Requests

Syntax
DELETE http[s]://{datapathDNSname}/_rest_/suspect_blob_s3_target/[?force]

Request Parameters

Parameter Description Required

force If included, the BlackPearl gateway clears the suspect blob
degradation records for all BlackPearl targets.

no
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Request Elements
Unless you use the force parameter, an XML payload, formatted as follows, must be sent to
describe the suspect Amazon S3 blob degradation records to clear.
<ids>

   <id>{string}</id>

   <id>{string}</id>

   <id>{string}</id>

</ids>

where the parameters are defined as follows:

Parameter Description Required

Ids The container for all suspect records to clear. yes

Id The UUID or other unique attribute for the suspect record to clear.
See Get Suspect Object Parts on Amazon S3 Targets on page 1082.

yes

Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 400: Bad Request (force flag required)

Example

Sample Request
This request clears the suspect blob degradation record for suspect object parts on all
Amazon S3 targets.
DELETE http://blackpearl-hostname/_rest_/suspect_blob_s3_target/?force HTTP/1.1

Sample Response
HTTP/1.1 204 No Content
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CLEAR SUSPECT OBJECT PART ON AN AZURE TARGET

Description
Clear the specified suspect blob (object part) degradation record for suspect object parts on an
Azure target, permitting the BlackPearl gateway to use the target again to GET or VERIFY
those object parts.

Requests

Syntax
DELETE http[s]://{datapathDNSname}/_rest_/suspect_blob_azure_target/[?force]

Request Parameters

Parameter Description Required

force If included, the BlackPearl gateway clears the suspect blob
degradation records for all Azure targets.

no

Request Elements
Unless you use the force parameter, an XML payload, formatted as follows, must be sent to
describe the suspect Azure blob degradation records to clear.
<ids>

   <id>{string}</id>

   <id>{string}</id>

   <id>{string}</id>

</ids>

where the parameters are defined as follows:

Parameter Description Required

Ids The container for all suspect records to clear. yes

Id The UUID or other unique attribute for the suspect record to clear.
See Get Suspect Object Parts on Azure Targets on page 1084.

yes
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Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 400: Bad Request (force flag required)

Example

Sample Request
This request clears the suspect blob degradation record for suspect object parts on all Azure
targets.
DELETE http://blackpearl-hostname/_rest_/suspect_blob_azure_target/?force HTTP/1.1

Sample Response
HTTP/1.1 204 No Content

CLEAR SUSPECT OBJECT PART ON A DS3 TARGET

Description
Clear the specified suspect blob (object part) degradation record for suspect object parts on a
BlackPearl target, permitting the BlackPearl gateway to use the target again to GET or
VERIFY those object parts.

Requests

Syntax
DELETE http[s]://{datapathDNSname}/_rest_/suspect_blob_ds3_target/[?force]
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Request Parameters

Parameter Description Required

force If included, the BlackPearl gateway clears the suspect blob
degradation records for all BlackPearl targets.

no

Request Elements
Unless you use the force parameter, an XML payload, formatted as follows, must be sent to
describe the suspect DS3 blob degradation records to clear.
<ids>

   <id>{string}</id>

   <id>{string}</id>

   <id>{string}</id>

</ids>

where the parameters are defined as follows:

Parameter Description Required

Ids The container for all suspect records to clear. yes

Id The UUID or other unique attribute for the suspect record to clear.
See Get Suspect Object Parts on DS3 Targets on page 1086.

yes

Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 400: Bad Request (force flag required)
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Example

Sample Request
This request clears the suspect blob degradation record for suspect object parts on all
BlackPearl targets.
DELETE http://blackpearl-hostname/_rest_/suspect_blob_ds3_target/?force HTTP/1.1

Sample Response
HTTP/1.1 204 No Content

GET DEGRADED OBJECT PARTS

Description
Get all degraded object part records. Use parameters as selection criteria to return
information for a subset of all degraded object parts.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/degraded_blob/[?blob_id={string}][&bucket_id=

{string}][&Ds3ReplicationRuleId={string}][&last_page][&page_length={32-bit integer}]

[&page_offset={32-bit integer}][&page_start_marker={string}][&persistence_rule_id=

{string}][&replication_rule_id={string}]

Request Parameters 

Parameter Description Required

blob_id The UUID or other unique attribute for the blob. no

bucket_id 1 The name, UUID, or other unique attribute for the bucket. no

1) Parameter values can use wild cards (see Wild Card Syntax on page 30).
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Parameter Description Required

ds3_
replication_
rule_Id 1

The name, UUID, or other unique attribute for the DS3 replication
rule.

no

last_page If included, only the last page of results is returned. no

page_length The maximum number of buckets to list. The default is all items
after page_offset.

no

page_offset The starting point for the first bucket to list. The default is 0. no

page_start_
marker

The UUID or other unique attribute for the item just before the
first item to list.
Notes:
• Specifying both page_offset and page_start_marker
causes an error.

• If neither page_offset, nor page_start_marker are
specified, the page_offset default is used.

no

persistence_
rule_
id 1

The UUID or other unique attribute for the persistence rule. no

Responses

Response Elements
<Data>

   <DegradedBlob>

      <AzureReplicationRuleId>{string}</AzureReplicationRuleId>

      <BlobId>{string}</BlobId>

      <BucketId>{string}</BucketId>

      <DS3ReplicationRuleId>{string}</DS3ReplicationRuleId>

      <Id>{string}</Id>

      <PersistenceRuleId>{string}</PersistenceRuleId>

      <S3ReplicationRuleId>{string}</S3ReplicationRuleId>

   </DegradedBlob>

   ...

</Data>
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where the response elements are defined as follows:

Parameter Description

Data The container for the response.

DegradedBlob The container for information about a single blob.

AzureReplication
RuleId

The UUID for the Azure replication rule.

BlobId The UUID for the blob.

BucketId The UUID for the bucket.

Ds3ReplicationRuleId The UUID for the DS3 replication rule.

PersistenceRuleId The UUID for the persistence rule.

S3ReplicationRule
Id

The UUID for the Amazon S3 replication rule.

Example

Sample Request
This request gets information about all degraded object parts.
GET http[s]://blackpearl-hostname/_rest_/degraded_blob/ HTTP/1.1

Sample Response
HTTP/1.1 200 OK
<Data>

   <DegradedBlob>

      <AzureReplicationRuleId/>

      <BlobId>dcbe024c-999d-4f79-ae9d-079a09b3a2f5</BlobId>

      <BucketId>059e4b7d-bed3-441a-93d4-463bc5d8a8d3</BucketId>

      <Ds3ReplicationRuleId/>

      <Id>6989f3a9-b247-4cc3-a007-3c2b914772b8</Id>

      <PersistenceRuleId>

         6840231b-1546-4560-a90b-76a6c86b3d1f

      </PersistenceRuleId>

      <S3ReplicationRuleId/>

   </DegradedBlob>
   ...
</Data>
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GET DEGRADED BUCKETS

Description
Get information about buckets containing degraded data. Use parameters as selection criteria
to return information for a subset of all buckets with degraded data.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/degraded_bucket/[?data_policy_id={string}]

[&last_page][&name={string}][&page_length={32-bit integer}][&page_offset=

{32-bit integer}][&page_start_marker={string}][&user_id={string}]

Request Parameters 

Parameter Description Required

data_policy_
id

The UUID, name, or other unique attribute for the data policy. no

last_page If included, only the last page of results is returned. no

name 1 The name of the bucket. no

page_length The maximum number of buckets to list. The default is all items
after page_offset.

no

page_offset The starting point for the first bucket to list. The default is 0. no

page_start_
marker

The UUID or other unique attribute for the item just before the first
item to list.
Notes:
• Specifying both page_offset and page_start_marker causes
an error.

• If neither page_offset, nor page_start_marker are specified,
the page_offset default is used.

no

user_id 1 The UUID, username, or a unique attribute for the bucket owner. no

1) Parameter values can use wild cards (see Wild Card Syntax on page 30).
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Responses

Response Elements
<Data>

   <Bucket>

      <CreationDate>{YYYY-MM-DDThh:mm:ss.xxxZ}</CreationDate>

      <DataPolicyId>{string}</DataPolicyId>

      <Id>{string}</Id>
      <LastPreferredChunkSizeInBytes>

{64-bit integer}

      </LastPreferredChunkSizeInBytes>

      <Name>{string}</Name>
      <Protected>TRUE|FALSE</Protected>

      <UserId>{string}</UserId>

   </Bucket>

   ...

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

Bucket The container for information about a single bucket.

CreationDate The date and time the bucket was created in the format YYYY-MM-
DDThh:mm:ss.xxxZ.

DataPolicyId The UUID for the assigned data policy.

Id The UUID for the bucket.

LastPreferred
ChunkSizeInBytes

The last preferred chunk size computed for a PUT job for this bucket.

Name The name of the bucket.

Protected The protection status of the bucket.

UserId The UUID for the bucket owner.
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Example

Sample Request
This request gets information about all degraded buckets.
GET http[s]://blackpearl-hostname/_rest_/degraded_bucket/ HTTP/1.1

Sample Response
HTTP/1.1 200 OK
<Data>

   <Bucket>

      <CreationDate>2015-11-18T10:56:11.847Z</CreationDate>

      <DataPolicyId>

         798ef69d-2a40-4c3e-a4c2-b3c1ff12d511

      </DataPolicyId>

      <Id>c0ac51be-e505-4cd5-b82a-6c8cc8daaf72</Id>

      <LastPreferredChunkSizeInBytes/>

      <Name>bucketName</Name>
      <Protected>FALSE</Protected>

      <UserId>c6f8cfeb-0ddf-42db-b999-767a4fb5bb44</UserId>

   </Bucket>

</Data>

GET DEGRADED DATA PERSISTENCE RULES

Description
Get information about data persistence rules containing degradation. Use parameters as
selection criteria to return information for a subset of all data persistence rules with degraded
data.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/degraded_data_persistence_rule/[?data_policy_

id={string}][&isolation_level=STANDARD|BUCKET_ISOLATED][&last_page][&page_length=

{32-bit integer}][&page_offset={32-bit integer}][&page_start_marker={string}]

[&state=NORMAL|INCLUSION_IN_PROGRESS][&storage_domain_id={string}]

[&type=PERMANENT|TEMPORARY|RETIRED]
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Request Parameters 

Parameter Description Required

data_policy_
id

Data policy UUID or other unique attribute. no

isolation_
level

The level of physical isolation required for the data retention.
Values: STANDARD, BUCKET_ISOLATED. See isolation_level on
page 324 for descriptions.

no

last_page If included, only the last page of results is returned. no

page_length The maximum number of data persistence rules to list.
Default: all items after page_offset.

no

page_offset The starting point for the first data persistence rule to list. Default:
0.

no

page_start_
marker

The UUID or other unique attribute for the item just before the first
item to list.
Notes:
• Specifying both page_offset and page_start_marker causes
an error.

• If neither page_offset, nor page_start_marker are specified,
the page_offset default is used.

no

state The state of the persistence rule.
Values:
NORMAL — The persistence rule is in a normal, included state.
INCLUSION_IN_PROGRESS — The persistence rule is being applied
and data copying is required before the persistence rule is in a
normal, fully included state.

no

storage_
domain_id

Storage domain UUID or other unique attribute. no

type The type of persistence rule.
Values: PERMANENT, RETIRED, TEMPORARY. See Type on page 349
for descriptions.

no
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Responses

Response Elements
<Data>

   <DataPersistenceRule>

      <DataPolicyId>{string}</DataPolicyId>

      <Id>{string}</Id>

      <IsolationLevel>STANDARD|BUCKET_ISOLATED</IsolationLevel>

      <MinimumDaysToRetain>{32-bit integer}</MinimumDaysToRetain>

      <State>NORMAL|INCLUSION_IN_PROGRESS</State>

      <StorageDomainId>{string}</StorageDomainId>

      <Type>PERMANENT|TEMPORARY|RETIRED</Type>

   </DataPersistenceRule>

   ...

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

DataPersistence
Rule

The container for information about one data persistence rule.

DataPolicyId The UUID for the data policy.

Id The UUID for the persistence rule.

IsolationLevel The level of physical isolation required for data retention.
Values: STANDARD, BUCKET_ISOLATED.
See isolation_level on page 324 for descriptions.

MinimumDaysTo
Retain

The minimum number of days the data should be retained based on a
TEMPORARY persistence rule.

State The state of the persistence rule.
Values:
NORMAL — The persistence rule is in a normal, included state.
INCLUSION_IN_PROGRESS — The persistence rule is being applied and data
copying is required before the persistence rule is in a normal, fully included
state.

StorageDomainId The UUID for the storage domain.
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Parameter Description

Type The type of persistence rule.
Values: PERMANENT, TEMPORARY, RETIRED. See Type on page 349 for
descriptions.

Example

Sample Request
This request gets information about all data persistence rules with degradation.
GET http://blackpearl-hostname/_rest_/degraded_data_persistence_rule/ HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>

   <DataPersistenceRule>

      <DataPolicyId>

         c71a3a94-517b-47ff-be02-4f190c74d3c6

      </DataPolicyId>

      <Id>00776a08-6ac2-4522-b2c9-c2e50102cadb</Id>

      <IsolationLevel>STANDARD</IsolationLevel>

      <MinimumDaysToRetain/>

      <State>NORMAL</State>

      <StorageDomainId>

         e3d3fb89-fdc2-440e-9607-2a32d5ca1133

      </StorageDomainId>

      <Type>PERMANENT</Type>
   </DataPersistenceRule>
   ...

</Data>

GET DEGRADED AMAZON S3 REPLICATION RULES

Description
Get information about Amazon S3 replication rules containing degradation. Use parameters
as selection criteria to return information for a subset of all Amazon S3 data replication rules
with degraded data.
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Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/degraded_s3_data_replication_rule/[?data_

policy_id={string}][&last_page][&page_length={32-bit integer}][&page_offset=

{32-bit integer}][&page_start_marker={string}][&state=NORMAL|INCLUSION_IN_PROGRESS]

[&target_id={string}][&type=PERMANENT|RETIRED]

Request Parameters 

Parameter Description Required

data_policy_
id

Data policy UUID or other unique attribute. no

last_page If included, only the last page of results is returned. no

page_length The maximum number of data replication rules to list.
Default: all items after page_offset.

no

page_offset The starting point for the first data replication rule to list. Default: 0. no

page_start_
marker

The UUID or other unique attribute for the item just before the first
item to list.
Notes:
• Specifying both page_offset and page_start_marker causes
an error.

• If neither page_offset, nor page_start_marker are specified,
the page_offset default is used.

no

state The state of the replication rule.
Values:
• NORMAL — The replication rule is in a normal, included state.
• INCLUSION_IN_PROGRESS — The replication rule is being applied
and data replication is required before the replication rule is in a
normal, fully included state.

no

target_id The Amazon S3 target name, UUID, or other unique attribute. no

type The type of replication rule.
Values:
• PERMANENT — A copy of the data is maintained on the target.
• RETIRED — A copy of already replicated data is maintained, but
the rule is not applied to new data.

no
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Responses

Response Elements
<Data>

   <S3DataReplicationRule>

      <DataPolicyId>{string}</DataPolicyId>

      <Id>{string}</Id>
      <InitialDataPlacement>

        STANDARD|REDUCED_REDUNDANCY|STANDARD_IA|GLACIER|DEEP_ARCHIVE

      </InitialDataPlacement>
      <MaxBlobPartSizeInBytes>

{64-bit integer}

      </MaxBlobPartSizeInBytes>

      <State>NORMAL|INCLUSION_IN_PROGRESS</State>

      <TargetId>{string}</TargetId>

      <Type>PERMANENT|RETIRED</Type>

   </S3DataReplicationRule>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

S3Data
ReplicationRule

The container for information about one Amazon S3 data replication rule.

DataPolicyId The UUID for the data policy.

Id The UUID for the data replication rule.

InitialPlacement The storage class for any blobs transferred to the Amazon S3 instance.
Values: Standard, Reduced Redundancy, Standard IA, Glacier, Deep Archive.
See initial_data_placement on page 334 for definitions.

MaxBlobSizeIn
Bytes

The maximum blob size used when creating bulk PUT jobs.
Default: 100 GB
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Parameter Description

State The state of the persistence rule.
Values:
NORMAL — The persistence rule is in a normal, included state.
INCLUSION_IN_PROGRESS — The persistence rule is being applied and data
copying is required before the persistence rule is in a normal, fully included
state.

TargetId The UUID for the Amazon S3 target.

Type The type of replication rule.
Values:
• PERMANENT — A copy of the data is replicated to the target.
• RETIRED — A copy of already replicated data is maintained, but the rule is
not applied to new data.

Example

Sample Request
This request gets information about all Amazon S3 data replication rules with degradation.
GET http://blackpearl-hostname/_rest_/degraded_s3_data_replication_rule/ HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>

   <S3DataReplicationRule>

      <DataPolicyId>

         3f934efd-ecc3-43ff-b802-0c21e19e28ec

      </DataPolicyId>

      <Id>4f4a1d7b-6325-4a0b-aeb7-868500ec81c0</Id>
      <InitialDataPlacement>STANDARD_IA</InitialDataPlacement>

      <MaxBlobPartSizeInBytes>1073741824</MaxBlobPartSizeInBytes>

      <State>NORMAL</State>

      <TargetId>

         b82d4784-509f-46e8-bdb0-e7e4a716bc75

      </TargetId>

      <Type>PERMANENT</Type>

   </S3DataReplicationRule>

</Data>
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GET DEGRADED AZURE REPLICATION RULES

Description
Get information about Azure replication rules containing degradation. Use parameters as
selection criteria to return information for a subset of all Azure data replication rules with
degraded data.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/degraded_azure_data_replication_rule/[?data_

policy_id={string}][&last_page][&page_length={32-bit integer}][&page_offset=

{32-bit integer}][&page_start_marker={string}][&state=NORMAL|INCLUSION_IN_PROGRESS]

[&target_id={string}][&type=PERMANENT|RETIRED]

Request Parameters 

Parameter Description Required

data_policy_
id

Data policy UUID or other unique attribute. no

last_page If included, only the last page of results is returned. no

page_length The maximum number of data replication rules to list.
Default: all items after page_offset.

no

page_offset The starting point for the first data replication rule to list. Default: 0. no

page_start_
marker

The UUID or other unique attribute for the item just before the first
item to list.
Notes:
• Specifying both page_offset and page_start_marker causes
an error.

• If neither page_offset, nor page_start_marker are specified,
the page_offset default is used.

no
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Parameter Description Required

state The state of the replication rule.
Values:
• NORMAL — The replication rule is in a normal, included state.
• INCLUSION_IN_PROGRESS — The replication rule is being applied
and data replication is required before the replication rule is in a
normal, fully included state.

no

target_id The Azure target name, UUID, or other unique attribute. no

type The type of replication rule.
Values:
• PERMANENT — A copy of the data is maintained on the target.
• RETIRED — A copy of already replicated data is maintained, but
the rule is not applied to new data.

no

Responses

Response Elements
<Data>

   <AzureDataReplicationRule>

      <DataPolicyId>{string}</DataPolicyId>

      <Id>{string}</Id>
      <MaxBlobPartSizeInBytes>

{64-bit integer}

      </MaxBlobPartSizeInBytes>

      <State>NORMAL|INCLUSION_IN_PROGRESS</State>

      <TargetId>{string}</TargetId>

      <Type>PERMANENT|RETIRED</Type>

   </AzureDataReplicationRule>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

AzureData
ReplicationRule

The container for information about one Azure data replication rule.

DataPolicyId The UUID for the data policy.
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Parameter Description

Id The UUID for the data replication rule.

MaxBlobSizeIn
Bytes

The maximum blob size used when creating bulk PUT jobs.
Default: 100 GB

State The state of the persistence rule.
Values:
NORMAL — The persistence rule is in a normal, included state.
INCLUSION_IN_PROGRESS — The persistence rule is being applied and data
copying is required before the persistence rule is in a normal, fully included
state.

TargetId The UUID for the Azure target.

Type The type of replication rule.
Values:
• PERMANENT — A copy of the data is replicated to the target.
• RETIRED — A copy of already replicated data is maintained, but the rule is
not applied to new data.

Example

Sample Request
This request gets information about all Azure data replication rules with degradation.
GET http://blackpearl-hostname/_rest_/degraded_azure_data_replication_rule/ HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>

   <AzureDataReplicationRule>

      <DataPolicyId>

         3f934efd-ecc3-43ff-b802-0c21e19e28ec

      </DataPolicyId>

      <Id>4f4a1d7b-6325-4a0b-aeb7-868500ec81c0</Id>
      <MaxBlobPartSizeInBytes>1073741824</MaxBlobPartSizeInBytes>

      <State>NORMAL</State>
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      <TargetDataPolicy/>

      <TargetId>

         b82d4784-509f-46e8-bdb0-e7e4a716bc75

      </TargetId>

      <Type>PERMANENT</Type>

   </AzureDataReplicationRule>

</Data>

GET DEGRADED DS3 REPLICATION RULES

Description
Get information about DS3 replication rules containing degradation. Use parameters as
selection criteria to return information for a subset of all Ds3data replication rules with
degraded data.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/degraded_ds3_data_replication_rule/[?data_

policy_id={string}][&last_page][&page_length={32-bit integer}][&page_offset=

{32-bit integer}][&page_start_marker={string}][&state=NORMAL|INCLUSION_IN_PROGRESS]

[&target_id={string}][&type=PERMANENT|RETIRED]

Request Parameters 

Parameter Description Required

data_policy_
id

Data policy UUID or other unique attribute. no

last_page If included, only the last page of results is returned. no

page_length The maximum number of data replication rules to list.
Default: all items after page_offset.

no

page_offset The starting point for the first data replication rule to list. Default: 0. no
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Parameter Description Required

page_start_
marker

The UUID or other unique attribute for the item just before the first
item to list.
Notes:
• Specifying both page_offset and page_start_marker causes
an error.

• If neither page_offset, nor page_start_marker are specified,
the page_offset default is used.

no

state The state of the replication rule.
Values:
• NORMAL — The replication rule is in a normal, included state.
• INCLUSION_IN_PROGRESS — The replication rule is being applied
and data replication is required before the replication rule is in a
normal, fully included state.

no

target_id The BlackPearl target name, UUID, or other unique attribute. no

type The type of replication rule.
Values:
• PERMANENT — A copy of the data is maintained on the target.
• RETIRED — A copy of already replicated data is maintained, but
the rule is not applied to new data.

no

Responses

Response Elements
<Data>

   <Ds3DataReplicationRule>

      <DataPolicyId>{string}</DataPolicyId>

      <Id>{string}</Id>

      <State>NORMAL|INCLUSION_IN_PROGRESS</State>
      <TargetDataPolicy>{string}</TargetDataPolicy>

      <TargetId>{string}</TargetId>

      <Type>PERMANENT|RETIRED</Type>

   </Ds3DataReplicationRule>

</Data>
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where the response elements are defined as follows:

Parameter Description

Data The container for the response.

Ds3Data
ReplicationRule

The container for information about one DS3 data replication rule.

DataPolicyId The UUID for the data policy.

Id The UUID for the data replication rule.

State The state of the persistence rule.
Values:
NORMAL — The persistence rule is in a normal, included state.
INCLUSION_IN_PROGRESS — The persistence rule is being applied and data
copying is required before the persistence rule is in a normal, fully included
state.

TargetDataPolicy The UUID for the data policy on the BlackPearl target.

TargetId The UUID for the BlackPearl target.

Type The type of replication rule.
Values:
• PERMANENT — A copy of the data is replicated to the target.
• RETIRED — A copy of already replicated data is maintained, but the rule
is not applied to new data.

Example

Sample Request
This request gets information about all DS3 data replication rules with degradation.
GET http://blackpearl-hostname/_rest_/degraded_ds3_data_replication_rule/ HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>

   <Ds3DataReplicationRule>

      <DataPolicyId>

         3f934efd-ecc3-43ff-b802-0c21e19e28ec

      </DataPolicyId>
      <Id>4f4a1d7b-6325-4a0b-aeb7-868500ec81c0</Id>
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      <State>NORMAL</State>
      <TargetDataPolicy/>

      <TargetId>

         b82d4784-509f-46e8-bdb0-e7e4a716bc75

      </TargetId>

      <Type>PERMANENT</Type>

   </Ds3DataReplicationRule>

</Data>

GET SUSPECT OBJECT PARTS IN STORAGE POOLS

Description
Get information about all object parts persisted to storage pools that the BlackPearl gateway
suspects are degraded.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/suspect_blob_pool/[?blob_id={string}][&last_

page][&page_length={32-bit integer}][&page_offset={32-bit integer}][&page_start_

marker={string}][&pool_id={string}]

Request Parameters 

Parameter Description Required

blob_id The UUID or other unique attribute for the object part. no

last_page If included, only the last page of results is returned. no

page_length The maximum number of buckets to list. The default is all items
after page_offset.

no

page_offset The starting point for the first bucket to list. The default is 0. no
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Parameter Description Required

page_start_
marker

The UUID or other unique attribute for the item just before the first
item to list.
Notes:
• Specifying both page_offset and page_start_marker causes
an error.

• If neither page_offset, nor page_start_marker are specified,
the page_offset default is used.

no

pool_id The UUID or other unique attribute for the storage pool. no

Responses

Response Elements
<Data>

   <SuspectBlobPool>

      <BlobId>{string}</BlobId>

      <BucketId>{string}</BucketId>

      <DateWritten>{YYYY-MM-DDThh:mm:ss.xxxZ}</DateWritten>

      <Id>{string}</Id>

      <LastAccessed>{YYYY-MM-DDThh:mm:ss.xxxZ}</LastAccessed>

      <PoolId>{string}</PoolId>

   </SuspectBlobPool>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

SuspectBlobPool The container for information about a single suspect object part in a storage
pool.

BlobId The UUID for the blob.

BucketId The UUID for the bucket.

DateWritten The date and time the object part was written in the format YYYY-MM-
DDThh:mm:ss.xxxZ.

Id The UUID for the suspect blob degradation record.

April 2023 DS3 API Reference-Spectra BlackPearl Nearline Gateway
- 1079 -



Chapter 21 - Degradation Operations Get Suspect Object Parts on Tape Media

Parameter Description

LastAccessed The last date and time the pool was accessed in the format YYYY-MM-
DDThh:mm:ss.xxxZ.

PoolId The UUID for the pool.

Example

Sample Request
This request gets information about all suspect object parts on storage pools.
GET http[s]://blackpearl-hostname/_rest_/suspect_blob_pool/ HTTP/1.1

Sample Response
HTTP/1.1 200 OK
<Data>

   <SuspectBlobPool>

      <BlobId>d991047d-e884-4e55-98ee-fdd3888bad2f</BlobId>

      <BucketId>fc4de051-392a-442f-8c72-c3237308f1d2</BucketId>

      <DateWritten>2016-05-19T00:47:48.000Z</DateWritten>

      <Id>c8ec1c60-80da-4d77-a1f9-6a5725e8728a</Id>

      <LastAccessed>2016-05-19T00:47:48.000Z</LastAccessed>

      <PoolId>c65797ba-d3ad-4ac3-aae8-defb0ee36614</PoolId>

   </SuspectBlobPool>

</Data>

GET SUSPECT OBJECT PARTS ON TAPE MEDIA

Description
Get information about all object parts persisted to tape that the BlackPearl gateway suspects
are degraded.
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Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/suspect_blob_tape/[?blob_id={string}][&last_

page][&page_length={32-bit integer}][&page_offset={32-bit integer}][&page_start_

marker={string}][&tape_id={string}]

Request Parameters 

Parameter Description Required

blob_id The UUID or other unique attribute for the object part. no

last_page If included, only the last page of results is returned. no

page_length The maximum number of buckets to list. The default is all items
after page_offset.

no

page_offset The starting point for the first bucket to list. The default is 0. no

page_start_
marker

The UUID or other unique attribute for the item just before the first
item to list.
Notes:
• Specifying both page_offset and page_start_marker causes
an error.

• If neither page_offset, nor page_start_marker are specified,
the page_offset default is used.

no

tape_id The UUID or other unique attribute for the tape. no

Responses

Response Elements
<Data>

   <SuspectBlobTape>

      <BlobId>{string}</BlobId>

      <Id>{string}</Id>

      <OrderIndex>{32-bit integer}</OrderIndex>

      <TapeId>{string}</TapeId>

   </SuspectBlobTape>

</Data>
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where the response elements are defined as follows:

Parameter Description

Data The container for the response.

SuspectBlobTape The container for information about a single suspect object part on tape.

BlobId The UUID for the blob.

Id The UUID for the suspect blob degradation record.

OrderIndex The position of the blob in the LTFS index.

TapeId The UUID for the tape.

Example

Sample Request
This request gets information about all suspect object parts on tape media.
GET http[s]://blackpearl-hostname/_rest_/suspect_blob_tape/ HTTP/1.1

Sample Response
HTTP/1.1 200 OK
<Data>

   <SuspectBlobTape>

      <BlobId>549b3056-ccff-4aff-acff-db46502d5706</BlobId>

      <Id>c0dbb9e8-ed3f-4666-8f41-476e34b9c947</Id>

      <OrderIndex>1</OrderIndex>

      <TapeId>d797ac01-e6b4-4966-b3dc-5027b154fbaa</TapeId>

   </SuspectBlobTape>

</Data>

GET SUSPECT OBJECT PARTS ON AMAZON S3 TARGETS

Description
Get information about all replicated object parts on Amazon S3 targets that the BlackPearl
gateway suspects are degraded.
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Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/suspect_blob_s3_target/[?blob_id={string}]

[&last_page][&page_length={32-bit integer}][&page_offset={32-bit integer}][&page_

start_marker={string}][&target_id={string}]

Request Parameters 

Parameter Description Required

blob_id The UUID or other unique attribute for the object part. no

last_page If included, only the last page of results is returned. no

page_length The maximum number of buckets to list. The default is all items
after page_offset.

no

page_offset The starting point for the first bucket to list. The default is 0. no

page_start_
marker

The UUID or other unique attribute for the item just before the first
item to list.
Notes:
• Specifying both page_offset and page_start_marker causes
an error.

• If neither page_offset, nor page_start_marker are specified,
the page_offset default is used.

no

target_id The UUID, name, or other unique attribute for the Amazon S3
target.

no

Responses

Response Elements
<Data>

   <SuspectBlobS3Target>

      <BlobId>{string}</BlobId>

      <Id>{string}</Id>
      <TargetId>{string}</TargetId>

   </SuspectBlobS3Target>

</Data>
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where the response elements are defined as follows:

Parameter Description

Data The container for the response.

SuspectBlobAzure
Target

The container for information about a single suspect object part on an
Amazon S3 target.

BlobId The UUID for the blob.

TargetId The UUID for the Amazon S3 target.

Id The UUID for the suspect blob degradation record.

Example

Sample Request
This request gets information about all suspect object parts on Amazon S3 targets.
GET http[s]://blackpearl-hostname/_rest_/suspect_blob_s3_target/ HTTP/1.1

Sample Response
HTTP/1.1 200 OK
<Data>

   <SuspectBlobS3Target>

      <BlobId>549b3056-ccff-4aff-acff-db46502d5706</BlobId>

      <Id>c0dbb9e8-ed3f-4666-8f41-476e34b9c947</Id>

      <TargeId>d797ac01-e6b4-4966-b3dc-5027b154fbaa</TargeId>

   </SuspectBlobS3Target>

</Data>

GET SUSPECT OBJECT PARTS ON AZURE TARGETS

Description
Get information about all replicated object parts on Azure targets that the BlackPearl gateway
suspects are degraded.
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Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/suspect_blob_azure_target/[?blob_id={string}]

[&last_page][&page_length={32-bit integer}][&page_offset={32-bit integer}][&page_

start_marker={string}][&target_id={string}]

Request Parameters 

Parameter Description Required

blob_id The UUID or other unique attribute for the object part. no

last_page If included, only the last page of results is returned. no

page_length The maximum number of buckets to list. The default is all items
after page_offset.

no

page_offset The starting point for the first bucket to list. The default is 0. no

page_start_
marker

The UUID or other unique attribute for the item just before the first
item to list.
Notes:
• Specifying both page_offset and page_start_marker causes
an error.

• If neither page_offset, nor page_start_marker are specified,
the page_offset default is used.

no

target_id The UUID, name, or other unique attribute for the Azure target. no

Responses

Response Elements
<Data>

   <SuspectBlobAzureTarget>

      <BlobId>{string}</BlobId>

      <Id>{string}</Id>
      <TargetId>{string}</TargetId>

   </SuspectBlobAzureTarget>

</Data>
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where the response elements are defined as follows:

Parameter Description

Data The container for the response.

SuspectBlobAzure
Target

The container for information about a single suspect object part on an
Azure target.

BlobId The UUID for the blob.

TargetId The UUID for the Azure target.

Id The UUID for the suspect blob degradation record.

Example

Sample Request
This request gets information about all suspect object parts on Azure targets.
GET http[s]://blackpearl-hostname/_rest_/suspect_blob_azure_target/ HTTP/1.1

Sample Response
HTTP/1.1 200 OK
<Data>

   <SuspectBlobAzureTarget>

      <BlobId>549b3056-ccff-4aff-acff-db46502d5706</BlobId>

      <Id>c0dbb9e8-ed3f-4666-8f41-476e34b9c947</Id>

      <TargeId>d797ac01-e6b4-4966-b3dc-5027b154fbaa</TargeId>

   </SuspectBlobAzureTarget>

</Data>

GET SUSPECT OBJECT PARTS ON DS3 TARGETS

Description
Get information about all replicated object parts on BlackPearl targets that the BlackPearl
gateway suspects are degraded.
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Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/suspect_blob_ds3_target/[?blob_id={string}]

[&last_page][&page_length={32-bit integer}][&page_offset={32-bit integer}][&page_

start_marker={string}][&target_id={string}]

Request Parameters 

Parameter Description Required

blob_id The UUID or other unique attribute for the object part. no

last_page If included, only the last page of results is returned. no

page_length The maximum number of buckets to list. The default is all items
after page_offset.

no

page_offset The starting point for the first bucket to list. The default is 0. no

page_start_
marker

The UUID or other unique attribute for the item just before the first
item to list.
Notes:
• Specifying both page_offset and page_start_marker causes
an error.

• If neither page_offset, nor page_start_marker are specified,
the page_offset default is used.

no

target_id The UUID, name, or other unique attribute for the BlackPearl target. no

Responses

Response Elements
<Data>

   <SuspectBlobDs3Target>

      <BlobId>{string}</BlobId>

      <Id>{string}</Id>
      <TargetId>{string}</TargetId>

   </SuspectBlobDs3Target>

</Data>
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where the response elements are defined as follows:

Parameter Description

Data The container for the response.

SuspectBlobDs3
Target

The container for information about a single suspect object part on a
BlackPearl target.

BlobId The UUID for the blob.

TargetId The UUID for the BlackPearl target.

Id The UUID for the suspect blob degradation record.

Example

Sample Request
This request gets information about all suspect object parts on BlackPearl targets.
GET http[s]://blackpearl-hostname/_rest_/suspect_blob_ds3_target/ HTTP/1.1

Sample Response
HTTP/1.1 200 OK
<Data>

   <SuspectBlobDs3Target>

      <BlobId>549b3056-ccff-4aff-acff-db46502d5706</BlobId>

      <Id>c0dbb9e8-ed3f-4666-8f41-476e34b9c947</Id>

      <TargeId>d797ac01-e6b4-4966-b3dc-5027b154fbaa</TargeId>

   </SuspectBlobDs3Target>

</Data>

GET SUSPECT BUCKETS

Description
Get information about all buckets that the BlackPearl gateway suspects are degraded.
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Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/suspect_bucket/[?data_policy_id={string}]

[&last_page][&name={string}][&page_length={32-bit integer}][&page_offset=

{32-bit integer}][&page_start_marker={string}][&user_id={string}]

Request Parameters 

Parameter Description Required

data_policy_
id

The UUID, name, or other unique attribute for the data policy. no

last_page If included, only the last page of results is returned. no

name 1 The name of the bucket. no

page_length The maximum number of buckets to list. The default is all items
after page_offset.

no

page_offset The starting point for the first bucket to list. The default is 0. no

page_start_
marker

The UUID or other unique attribute for the item just before the first
item to list.
Notes:
• Specifying both page_offset and page_start_marker causes
an error.

• If neither page_offset, nor page_start_marker are specified,
the page_offset default is used.

no

user_id 1 The UUID, username, or a unique attribute for the bucket owner. no

1) Parameter values can use wild cards (see Wild Card Syntax on page 30).
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Responses

Response Elements
<Data>

   <Bucket>

      <CreationDate>{string}</CreationDate>

      <DataPolicyId>{string}</DataPolicyId>

      <Id>{string}</Id>

      <LastPreferredChunkSizeInBytes>

{64-bit integer}

      </LastPreferredChunkSizeInBytes>

      <Name>{string}</Name>
      <Protected>TRUE|FALSE</Protected>

      <UserId>{string}</UserId>

   </Bucket>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

Bucket The container for information about a single bucket.

CreationDate The date and time the bucket was created in the format YYYY-MM-
DDThh:mm:ss.xxxZ.

DataPolicyId The UUID for the assigned data policy.

Id The UUID for the bucket.

LastPreferred
ChunkSizeInBytes

The last preferred chunk size computed for a PUT job for this bucket.

Name The name of the bucket.

Protected The protection status of the bucket.

UserId The UUID for the bucket owner.
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Example

Sample Request
This request gets information about all buckets that the BlackPearl gateway suspects are
degraded.
GET http[s]://blackpearl-hostname/_rest_/suspect_bucket/ HTTP/1.1

Sample Response
HTTP/1.1 200 OK
<Data>

   <Bucket>

      <CreationDate>2016-05-19T00:47:49.000Z</CreationDate>

      <DataPolicyId>

          c9d9c184-a748-4ae0-a8bc-551813bbd256

      </DataPolicyId>

      <Id>14058691-a3de-4fd3-9d3d-8401f10e0c59</Id>

      <LastPreferredChunkSizeInBytes/>

      <Name>bucket</Name>
      <Protected>FALSE</Protected>

      <UserId>8f63bd3f-d9a3-4899-8638-7817754e2e93</UserId>

   </Bucket>

</Data>

GET SUSPECT OBJECTS

Get a list of all objects that the BlackPearl gateway suspects are degraded. Use parameters as
selection criteria to return a subset of the list.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/suspect_object/[?bucket_id={string}][&last_

page][&page_length={32-bit integer}][&page_offset={32-bit integer}][&page_start_

marker={string}]
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Request Parameters 

Parameter Description Required

bucket_id 1 The UUID, name, or other unique identifier for the bucket on which
the job is operating.

no

last_page If included, only the last page of results is returned. no

page_length The maximum number of buckets to list. The default is all items
after page_offset.

no

page_offset The starting point for the first bucket to list. The default is 0. no

page_start_
marker

The UUID or other unique attribute for the item just before the first
item to list.
Notes:
• Specifying both page_offset and page_start_marker causes
an error.

• If neither page_offset, nor page_start_marker are specified,
the page_offset default is used.

no

Responses

Response Elements
<Data>

   <S3Object>

      <BucketId>{string}</BucketId>

      <CreationDate/>

      <Id>{string}</Id>

      <Latest>TRUE|FALSE</Latest>

      <Name>{string}</Name>

      <Type>DATA|FOLDER</Type>

   </S3Object>

</Data>

1) Parameter values can use wild cards (see Wild Card Syntax on page 30).
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where the response elements are defined as follows:

Parameter Description

Data The container for the response.

Data A container for the response.

S3Object The container for information about one object.

BucketId The UUID for the bucket to which the object is assigned.

CreationDate The date and time the bucket was created in the format YYYY-MM-
DDThh:mm:ss.xxxZ.

Id The UUID for the Object

Latest Whether this version of the object is the latest.
Values: TRUE, FALSE

Name The name of the object.

Type The type of object. Values: DATA, FOLDER

Example

Sample Request
This request gets information about all objects that the BlackPearl gateway suspects are
degraded.
GET http[s]://blackpearl-hostname/_rest_/suspect_object/ HTTP/1.1

Sample Response
<Data>

   <S3Object>

      <BucketId>d8299ae8-1be9-4a80-94a3-918a7846457b</BucketId>

      <CreationDate/>

      <Id>7a84ae35-d0e8-4d6d-baa6-f773065986f6</Id>

      <Latest>true</Latest>

      <Name>object1</Name>

      <Type>DATA</Type>

   </S3Object>

</Data>
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GET SUSPECT OBJECTS WITH FULL DETAILS

Description
Get detailed information about all objects that the BlackPearl gateway suspects are degraded.
Use parameters to get suspect object in one storage domain or one bucket.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/suspect_object/?full_details [&bucket_id=

{string}][&storage_domain={string}]

Request Parameters 

Parameter Description Required

full_details Included to get a response that includes physical placement
information.

yes

bucket_id 1 The UUID, name, or other unique identifier for the bucket on
which the job is operating.

no

storage_
domain 1

The UUID, name, or other unique attribute for the storage domain. no

Responses

Response Elements
<Data>

   <Object Id="{string}" InCache="TRUE|FALSE" Latest="TRUE|FALSE"

      Length="{64-bit integer}"Name="{string}
      "Offset="{64-bit integer}" VersionId="{string}">

      <PhysicalPlacement>
         <AzureTargets>

            <AzureTarget>

               <AccountKey>{string}</AccountKey>

1) Parameter values can use wild cards (see Wild Card Syntax on page 30).
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               <AccountName>{string}</AccountName>
               <AutoVerifyFrequencyInDays>

{integer}
               </AutoVerifyFrequencyInDays>
               <CloudBucketPrefix>{string}</CloudBucketPrefix>

               <CloudBucketSuffix>{string}</CloudBucketSuffix>
               <DefaultReadPreference>

                  MINIMUM_LATENCY|AFTER_ONLINE_POOL|

                  AFTER_NEARLINE_POOL|AFTER_NON_EJECTABLE_TAPE|

                  LAST_RESORT|NEVER

               </DefaultReadPreference>
               <Https>TRUE|FALSE</Https>

               <Id>{string}</Id>
               <LastFullyVerified/>

               <Name>{string}</Name>

               <PermitGoingOutOfSync>

                  TRUE|FALSE

               </PermitGoingOutOfSync>
               <Quiesced>NO|PENDING|YES</Quiesced>

               <State>ONLINE|OFFLINE|LIMITED_ACCESS</State>

            </AzureTarget>

            ...

         </AzureTargets>
         <Ds3Targets>

            <Ds3Target>

               <AccessControlReplication>

                  NONE|USERS

               </AccessControlReplication>

               <AdminAuthId>{string}</AdminAuthId>
               <AdminSecretKey>{string}</AdminSecretKey>

               <DataPathEndPoint>{string}</DataPathEndPoint>

               <DataPathHttps>TRUE|FALSE</DataPathHttps>

               <DataPathPort>{16-bit integer}</DataPathPort>
               <DataPathProxy>{string}</DataPathProxy>

               <DataPathVerifyCertificate>

                  TRUE|FALSE

               </DataPathVerifyCertificate>
               <DefaultReadPreference>

                  MINIMUM_LATENCY|AFTER_ONLINE_POOL|

                  AFTER_NEARLINE_POOL|AFTER_NON_EJECTABLE_TAPE|

                  LAST_RESORT|NEVER

               </DefaultReadPreference>

               <Id>{string}</Id>

               <Name>{string}</Name>
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               <PermitGoingOutOfSync>

                  TRUE|FALSE

               </PermitGoingOutOfSync>

               <Quiesced>NO|PENDING|YES</Quiesced>
               <ReplicatedUserDefaultDataPolicy>

{string}

               </ReplicatedUserDefaultDataPolicy>
               <State>ONLINE|OFFLINE</State>

            </Ds3Target>

            ...

         </Ds3Targets>
         <Pools>

            <Pool>

               <AssignedToStorageDomain>

                  TRUE|FALSE

               </AssignedToStorageDomain>

               <AvailableCapacity>

{64-bit integer}

               </AvailableCapacity>
               <BucketId>{string}</BucketId>

               <Guid>{string}</Guid>

               <Health>OK|DEGRADED</Health>

               <Id>{string}</Id>
               <LastAccessed>

{YYYY-MM-DDThh:mm:ss.xxxZ}

               </LastAccessed>

               <LastModified>

{YYYY-MM-DDThh:mm:ss.xxxZ}

               </LastModified>
               <LastVerified>

{YYYY-MM-DDThh:mm:ss.xxxZ}

               </LastVerified>

               <Mountpoint>/{string}</Mountpoint>

               <Name>{string}</Name>

               <PartitionId>{string}</PartitionId>

               <PoweredOn>TRUE|FALSE</PoweredOn>

               <Quiesced>NO|PENDING|YES</Quiesced>
               <ReservedCapacity>

{64-bit integer}

                </ReservedCapacity>
               <State>

                  NORMAL|FOREIGN|IMPORT_IN_PROGRESS|

                  IMPORT_PENDING|LOST

               </State>
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               <StorageDomainMemberId>

{string}

               </StorageDomainMemberId>
               <TotalCapacity>{64-bit integer}</TotalCapacity>

               <Type>NEARLINE|ONLINE</Type>

               <UsedCapacity>{64-bit integer}</UsedCapacity>

            </Pool>
            ...

         </Pools>
         <S3Targets>

            <S3Target>

               <AccessKey>{string}</AccessKey>

               <AutoVerifyFrequencyInDays>

{integer}

               </AutoVerifyFrequencyInDays>
               <CloudBucketPrefix>{string}</CloudBucketPrefix>
               <CloudBucketSuffix>{string}</CloudBucketSuffix>
               <DataPathEndPoint>{string}</DataPathEndPoint>
               <DefaultReadPreference>

                  MINIMUM_LATENCY|AFTER_ONLINE_POOL|

                  AFTER_NEARLINE_POOL|AFTER_NON_EJECTABLE_TAPE|

                  LAST_RESORT|NEVER

               </DefaultReadPreference>
               <Https>TRUE|FALSE</Https>
               <Id>{string}</Id>
               <LastFullyVerified>{string}</LastFullyVerified>
               <Name>{string}</Name>
               <NamingMode>BLACK_PEARL|AWS_S3</NamingMode>
               <OfflineDataStagingWindowInTb>

{64-bit integer}
               </OfflineDataStagingWindowInTb>
               <PermitGoingOutOfSync>

                  TRUE|FALSE

               </PermitGoingOutOfSync>
               <ProxyDomain>{string}</ProxyDomain>
               <ProxyHost>{string}</ProxyHost>
               <ProxyPassword>{string}</ProxyPassword>
               <ProxyPort>{64-bit integer}</ProxyPort>
               <ProxyUsername>{string}</ProxyUsername>
               <Quiesced>NO|PENDING|YES</Quiesced>
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               <Region>

                  US_EAST_1|US_EAST_2|US_WEST_1|US_WEST_2|

                  EU_WEST_1|EU_WEST_2|EU_CENTRAL_1|AP_SOUTH_1|

                  AP_SOUTHEAST_1|AP_SOUTHEAST_2|AP_NORTHEAST_1|

                  AP_NORTHEAST_2|SA_EAST_1|CN_NORTH_1|GOV_CLOUD|

                  CA_CENTRAL_1

               </Region>
               <SecretKey>{string}</SecretKey>
               <StagedDataExpirationInDays>

{64-bit integer}
               </StagedDataExpirationInDays>
               <State>ONLINE|OFFLINE|LIMITED_ACCESS</State>
            </S3Target>
            ...
         </S3Targets>
         <Tapes>

            <Tape>

               <AssignedToStorageDomain>

                  TRUE|FALSE

               </AssignedToStorageDomain>

               <AvailableRawCapacity>

{64-bit integer}
               </AvailableRawCapacity>

               <BarCode>{string}</BarCode>

               <BucketId>{string}</BucketId>

               <DescriptionForIdentification>

{string}

               </DescriptionForIdentification>
               <EjectDate>{YYYY-MM-DDThh:mm:ss.xxxZ}</EjectDate>

               <EjectLabel>{string}</EjectLabel>

               <EjectLocation>{string}</EjectLocation>

               <EjectPending>

{YYYY-MM-DDThh:mm:ss.xxxZ}

               </EjectPending>
               <FullOfData>TRUE|FALSE</FullOfData>

               <Id>{string}</Id>

               <LastAccessed>

{YYYY-MM-DDThh:mm:ss.xxxZ}

               </LastAccessed>
               <LastCheckpoint>{string}</LastCheckpoint>

               <LastModified>

{YYYY-MM-DDThh:mm:ss.xxxZ}

               </LastModified>
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               <LastVerified>

{YYYY-MM-DDThh:mm:ss.xxxZ}

               </LastVerified>
               <PartiallyVerifiedEndOfTape>

{YYYY-MM-DDThh:mm:ss.xxxZ}

               </PartiallyVerifiedEndOfTape>

               <PartitionId>{string}</PartitionId>
               <PreviousState>

                  NORMAL|AUTO_COMPACTION_IN_PROGRESS|BAD|

                  BAR_CODE_MISSING|CANNOT_FORMAT_DUE_TO_WRITE_

                  PROTECTION|DATA_CHECKPOINT_FAILURE|

                  DATA_CHECKPOINT_FAILURE_DUE_TO_READ_ONLY|

                  DATA_CHECKPOINT_MISSING|EJECT_FROM_EE_PENDING|

                  EJECT_TO_EE_IN_PROGRESS|EJECTED|FOREIGN|

                  FORMAT_IN_PROGRESS|FORMAT_PENDING|IMPORT_IN_

                  PROGRESS|IMPORT_PENDING|INCOMPATIBLE|

                  LOST|LTFS_WITH_FOREIGN_DATA|OFFLINE|

                  ONLINE_IN_PROGRESS|ONLINE_PENDING|PENDING_

                  INSPECTION|RAW_IMPORT_IN_PROGRESS|RAW_IMPORT_

                  PENDING|SERIAL_NUMBER_MISMATCH|UNKNOWN

               </PreviousState>
               <Role>NORMAL|TEST</Role>
               <SerialNumber>{string}</SerialNumber>

               <State>

                  NORMAL|AUTO_COMPACTION_IN_PROGRESS|BAD|

                  BAR_CODE_MISSING|CANNOT_FORMAT_DUE_TO_WRITE_

                  PROTECTION|DATA_CHECKPOINT_FAILURE|

                  DATA_CHECKPOINT_FAILURE_DUE_TO_READ_ONLY|

                  DATA_CHECKPOINT_MISSING|EJECT_FROM_EE_PENDING|

                  EJECT_TO_EE_IN_PROGRESS|EJECTED|FOREIGN|

                  FORMAT_IN_PROGRESS|FORMAT_PENDING|IMPORT_IN_

                  PROGRESS|IMPORT_PENDING|INCOMPATIBLE|

                  LOST|LTFS_WITH_FOREIGN_DATA|OFFLINE|

                  ONLINE_IN_PROGRESS|ONLINE_PENDING|PENDING_

                  INSPECTION|RAW_IMPORT_IN_PROGRESS|RAW_IMPORT_

                  PENDING|SERIAL_NUMBER_MISMATCH|UNKNOWN

               </State>
               <StorageDomainMemberId>

{string}

               </StorageDomainMemberId>
               <TakeOwnershipPending>

                  TRUE|FALSE

               </TakeOwnershipPending>
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               <TotalRawCapacity>

{64-bit integer}

               </TotalRawCapacity>

               <Type>

                  LTO5|LTO6|LTO7|LTO8|LTOM8|LTO9|LTO_CLEANING_TAPE|

                  TS_JC|TS_JD|TS_JE|TS_JK|TS_JL|TS_JM|TS_JV|

                  TS_JY|TS_JZ|TS_CLEANING_TAPE|UNKNOWN|FORBIDDEN

               </Type>
               <VerifyPending>

                  CRITICAL|URGENT|HIGH|NORMAL|LOW|BACKGROUND

               </VerifyPending>

               <WriteProtected>TRUE|FALSE</WriteProtected>

            </Tape>

            ...

         </Tapes>

      </PhysicalPlacement>

   </Object>

   ...

</Data>

where the response elements are defined as follows:

Parameter Description

Data A container for the response.

Object The container for information about one object.

Id The UUID for the Object

InCache Whether the object is currently in cache.
Values: TRUE, FALSE

Latest Whether this version of the object is the latest.
Values: TRUE, FALSE

Length The length in bytes of the object.

Name The name of the object.

Offset The offset in bytes from the start of the object.

VersionId The UUID of the version of the object.

PhysicalPlacement The container for the list of storage types containing the
object.
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Parameter Description

AzureTargets The container for information about all Azure targets with
degraded objects.

AzureTarget The container for information about one Azure target with a
degraded object.

AccountName The account name for the Microsoft Azure account.
Note: You can not use the same Account Name for multiple
Microsoft Azure targets.

AutoVerify
FrequencyInDays

The frequency at which a full verify of the data on the target
is scheduled. If null, no full verify is scheduled.

CloudBucketPrefix The Azure target bucket prefix. The gateway adds the prefix
to the BlackPearl bucket name when it replicates the bucket
to the Azure target.

CloudBucketSuffix The Azure target bucket suffix. The gateway adds the suffix
to the BlackPearl bucket name when it replicates the bucket
to the Azure target.

DefaultRead Preference When it is preferable to read from the Azure target rather
than the replication source.
Values: MINIMUM_LATENCY, AFTER_ONLINE_POOL, AFTER_
NEARLINE_POOL, AFTER_NON_EJECTABLE_TAPE, LAST_
RESORT, NEVER. See read_preference on page 455.

Https Whether the BlackPearl gateway uses the HTTPS protocol to
setup and replicate data to the target.
Values: TRUE, FALSE.

Id The UUID for the Azure target instance.

LastFullyVerified The date and time the target was last fully verified in the
format YYYY-MM-DDThh:mm:ss.xxxZ.

Name The name for the Azure target.

PermitGoingOutOfSync Whether a target is allowed to be out of sync with the source.
See permit_going_out_of_sync on page 474.
Note: This parameter is deprecated for Azure targets.

Quiesced Whether the Azure target is in a temporarily inactive state.
Values: NO, PENDING, YES
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Parameter Description

State The state of the Azure target.
Values: ONLINE, OFFLINE, LIMITED_ACCESS

Ds3Targets The container for information about all BlackPearl targets
with degraded objects.

Ds3Target The container for information about one BlackPearl target
with a degraded object.

AccessControl Replication The access control that is replicated to the BlackPearl target.
Values:
• NONE — No access control is replicated.
• USERS — The source BlackPearl gateway replicates its
users and passwords to the target gateway.

AdminAuthId The S3 access ID assigned to an Administrator.

AdminSecretKey The S3 secret key for the account matching the given
AdminAuthId.

DataPathEndPoint The IPv4 address or DNS name for the data path of the
BlackPearl target.

DataPathHttps Whether the source BlackPearl gateway uses the HTTPS
protocol to setup and replicate data to the target
gateway. Values: TRUE, FALSE

DataPathPort The value of the port on which the target BlackPearl
gateway’s S3 server is running. If null, the parameter
defaults to port 80 for HTTP connections and port 443
for HTTPS connections.

DataPathProxy The proxy server for the source BlackPearl gateway to
use to connect to the target gateway.

DataPathVerify Certificate Whether the data path certificate is verified. When
DataPathVerifyCertificate and DataPathHttps are both
TRUE, the source BlackPearl gateway fully validates the
target gateway’s certificate. If the certificate is not
trusted or problematic in anyway, it is not honored.
Values: TRUE, FALSE
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Parameter Description

DefaultRead Preference When it is preferable to read from the BlackPearl target
rather than the replication source. Only use the MINIMUM_
LATENCY read preference when the network between the
source and target is very inexpensive. In this mode, the
source BlackPearl gateway dynamically determines the read
preference based on whether the requested data resides in a
pool or on tape. For example, if the replication source has the
data in a pool, the gateway reads the data from the local
pool. If however, the replication source only has the data on
tape and the BlackPearl target has the data in a pool, the data
is read from the target pool.
Values: MINIMUM_LATENCY, AFTER_ONLINE_POOL, AFTER_
NEARLINE_POOL, AFTER_NON_EJECTABLE_TAPE, LAST_
RESORT, NEVER

Id The UUID for the BlackPearl target instance.
Note: If a BlackPearl target has its instance identifier reset
after it is registered on other BlackPearl gateways, the
replication link is forever invalid and must be deleted and re-
created.

Name The name for the BlackPearl target.

PermitGoingOutOfSync Whether a target is allowed to be out of sync with the source.
By default, if the data policy specifies that the BlackPearl
gateway must replicate local actions, actions that the gateway
cannot replicate fail. You can temporarily set this parameter to
TRUE in order to operate in full capacity locally while one or
more targets is down for a prolonged period of time.

Quiesced Whether the BlackPearl target is in a temporarily inactive
state. Values: NO, PENDING, YES

ReplicatedUser DefaultDataPolicy The data policy the target applies as the default data policy
for any users replicated to the target.

State The state of the BlackPearl target.
Values: ONLINE, OFFLINE, LIMITED_ACCESS

Pools The container for information about all storage pools with
degraded objects.

Pool The container for information about one storage pool with a
degraded object.
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Parameter Description

AssignedToStorageDomain Whether the pool is currently assigned to a storage domain.
Values: TRUE, FALSE

AvailableCapacity The amount of unused capacity on the pool in bytes.

BucketId The UUID for the bucket to which the pool is assigned.

Guid The ZFS identifier for the pool.

Health Whether the pool is in good health or degraded.
Values: OK, DEGRADED

Id The UUID for the pool.

LastAccessed The last date and time the pool was accessed in the format
YYYY-MM-DDThh:mm:ss.xxxZ.

LastModified The last date and time the object was modified in the format
YYYY-MM-DDThh:mm:ss.xxxZ.

LastVerified The last date and time the checksum of the data was verified
in the format YYYY-MM-DDThh:mm:ss.xxxZ.

MountPoint The logical directory used by the BlackPearl gateway to
access the pool.

Name The name for the pool.

PartitionId The UUID of the pool partition.

PoweredOn Whether the pool is powered on. Values: TRUE, FALSE

Quiesced Whether the pool is in a temporarily inactive state. Values:
NO, PENDING, YES

ReservedCapacity The capacity reserved to ensure pool performance.

State The status of the pool. See State on page 600.

StorageDomain
MemberId

The UUID for the storage domain member.

TotalCapacity The total capacity of the pool including used, reserved and
available capacity.
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Parameter Description

Type The type of pool.
Values: NEARLINE (Deep Storage), ONLINE (High
Performance)

UsedCapacity The amount of used capacity on the pool in bytes.

S3Targets The container for information about all Amazon S3 targets
with degraded objects.

S3Target The container for information about one Amazon S3 target
with a degraded object.

AccessKey The S3 Access Key of the user for the Amazon S3 account.

AutoVerify
FrequencyInDays

The frequency at which a full verify of the data on the target
is scheduled. If null, no full verify is scheduled.

CloudBucketPrefix The Amazon S3 target bucket prefix. The gateway adds the
prefix to the BlackPearl bucket name when it replicates the
bucket to the Amazon S3 target.

CloudBucketSuffix The Amazon S3 target bucket suffix. The gateway adds the
suffix to the BlackPearl bucket name when it replicates the
bucket to the Amazon S3 target.

DataPathEndpoint The IPv4 address or DNS name for the data path of the AWS
cloud service.

DefaultRead Preference When it is preferable to read from the Amazon S3 target
rather than the replication source.
Values: MINIMUM_LATENCY, AFTER_ONLINE_POOL, AFTER_
NEARLINE_POOL, AFTER_NON_EJECTABLE_TAPE, LAST_
RESORT, NEVER. See read_preference on page 455.

Https Whether the BlackPearl gateway uses the HTTPS protocol to
setup and replicate data to the target.
Values: TRUE, FALSE.

Id The UUID for the Amazon S3 target instance.

LastFullyVerified The date and time data on the target was last fully verified in
the format YYYY-MM-DDThh:mm:ss.xxxZ.

Name The name for the Amazon S3 target.
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Parameter Description

NamingMode Whether files written to the target use BlackPearl (file
UUIDs) or Amazon S3 (file names) naming conventions.
Values: BLACK_PEARL, AWS_S3

OfflineDataStagingWindowInTb The maximum size, in TB, of the window available for
staging data that is offline (in Glacier) so that it can be read.

PermitGoingOutOfSync Whether a target is allowed to be out of sync with the source.
See permit_going_out_of_sync on page 474.
Note: This parameter is deprecated for S3 targets.

ProxyDomain The domain name for the proxy server.

ProxyHost The host name or IP address for the proxy server to which
the BlackPearl gateway connects.

ProxyPassword The password used when connecting through the proxy
server.

ProxyPort The proxy server port through which the BlackPearl gateway
connects.

ProxyUsername The username used when connecting through the proxy
server.

Quiesced Whether the Amazon S3 target is in a temporarily inactive
state. Values: NO, PENDING, YES

Region The world region where the Amazon S3 target is physically
located. Values: US_EAST_1, US_WEST_1, US_WEST_2, EU_
WEST_1, EU_CENTRAL_1, AP_SOUTH_1, AP_SOUTHEAST_1,
AP_SOUTHEAST_2, AP_NORTHEAST_1, AP_NORTHEAST_2,
SA_EAST_1, CN_NORTH_1, GOV_CLOUD

SecretKey The secret key associated with the AccessKey.

StagedData
ExpirationInDays

The number of days before the pre-staged copy of data can
expire.

State The state of the Amazon S3 target.
Values: ONLINE, OFFLINE, LIMITED_ACCESS

Tapes The container for information about all tapes with degraded
objects.
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Parameter Description

Tape The container for information about the tape containing the
degraded object.

AssignedToStorageDomain Whether the tape is currently assigned to a storage domain.
Values: TRUE, FALSE

AvailableRaw
Capacity

The amount of unused raw capacity on the tape in bytes.

BarCode The barcode on the label of the tape cartridge.

BucketId The UUID for the bucket to which the tape is assigned.

DescriptionFor
Identification

The LTFS Volume ID and name, if applicable. This is only
provided if the BlackPearl gateway cannot identify the tape.

EjectDate The date and time that the BlackPearl gateway discovered
that the tape was ejected, in the format YYYY-MM-
DDThh:mm:ss.xxxZ. If the parameter is empty, the tape has
not been ejected.

EjectLabel The user-entered information to assist in the handling of the
tape.

EjectLocation The user-entered information to describe where the ejected
tape can be located.

EjectPending The date and time that the tape was put in the queue to be
ejected in the format YYYY-MM-DDThh:mm:ss.xxxZ. If the
parameter is empty, the tape has not been queued to be
ejected or the eject has started and is no longer cancelable.

FullOfData Whether the tape is completely full of data.
Values: TRUE, FALSE

Id The UUID for the tape.

LastAccessed The last date and time the tape was loaded into a tape drive
in the format YYYY-MM-DDThh:mm:ss.xxxZ.

LastCheckpoint An identifier, internal to the BlackPearl gateway, for
verifying the application integrity of the tape.

LastModified The last date and time the object was modified in the format
YYYY-MM-DDThh:mm:ss.xxxZ.
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Parameter Description

LastVerified The last date and time the checksum of the data was verified
in the format YYYY-MM-DDThh:mm:ss.xxxZ.

PartiallyVerified
EndOfTape

The last date and time the BlackPearl gateway verified the
data on a specified percentage of the tape capacity before the
EOD marker in the format
YYYY-MM-DDThh:mm:ss.xxxZ.

PartitionId The UUID for the partition to which the tape belongs.

PreviousState The previous status of the tape. See State on page 664.

Role The role assigned to the tape. Values: Normal, Test

SerialNumber The manufacturer-assigned serial number for the tape.

State The status of the tape. See State on page 664.

StorageDomain
MemberId

The UUID for the storage domain member.

TakeOwnership Pending Whether a tape from another BlackPearl gateway is waiting
for the current gateway to complete taking ownership.
Values:
• TRUE — The foreign tape was imported when
WriteProtected was TRUE, preventing the tape from
being claimed by the current gateway.

• FALSE — The tape was imported successfully.

TotalRawCapacity The total raw capacity of the tape in bytes.

Type The tape format and generation of the tape cartridge.
Values: LTO5, LTO6, LTO7, LTO8, LTOM8, LTO9, LTO_
CLEANING_TAPE, TS_JC, TS_JD, TS_JE, TS_JK, TS_JL, TS_JM,
TS_JV, TS_JY, TS_JZ, TS_CLEANING_TAPE, UNKNOWN,
FORBIDDEN

VerifyPending The priority for the verify requested, or null if a verify has
not been requested. The priority determines the resources
assigned and the processing order.
Values: CRITICAL, URGENT, HIGH, NORMAL, LOW,
BACKGROUND

WriteProtected Whether the tape is write protected. Values: TRUE, FALSE

April 2023 DS3 API Reference-Spectra BlackPearl Nearline Gateway
- 1108 -



Chapter 21 - Degradation Operations Get Suspect Objects with Full Details

Example

Sample Request
This request gets information about all suspect objects.
GET http[s]://blackpearl-hostname/_rest_/suspect_object/?full_details HTTP/1.1

Sample Response
HTTP/1.1 200 OK
<Data>

   <Object Bucket="bucket2"

      Id="def4e5f7-f0f7-44b7-9a48-0e0710935071" InCache="false"

      Latest="true" Length="10" Name="object2" Offset="0"

      VersionId="7ee8bd7a-b883-4100-ad2b-13440a44f200">

      <PhysicalPlacement>

         <AzureTargets/>

         <Ds3Targets/>

         <Pools/>

         <S3Targets/>
         <Tapes>

            <Tape>

               <AssignedToStorageDomain>

                  false

               </AssignedToStorageDomain>

               <AvailableRawCapacity>10000</AvailableRawCapacity>

               <BarCode>

                  d5a78a1f-4ffc-43d1-b302-a565d266d8a3

               </BarCode>
               <BucketId/>

               <DescriptionForIdentification/>

               <EjectDate/>

               <EjectLabel/>

               <EjectLocation/>

               <EjectPending/>
               <FullOfData>false</FullOfData>

               <Id>c50e8f13-21fe-48e5-b922-3ce4aca94017</Id>

               <LastAccessed/>

               <LastCheckpoint/>

               <LastModified/>

               <LastVerified/>
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               <PartiallyVerifiedEndOfTape/>

               <PartitionId>

                  4a72d5ad-a5b3-431d-8cdf-282c77620f53

               </PartitionId>
               <PreviousState/>
               <Role>NORMAL</Role>

               <SerialNumber/>

               <State>PENDING_INSPECTION</STATE>

               <StorageDomainMemberId>

                  78620692-8a4c-4c80-bfb6-02c47eced40d

               </StorageDomainMemberId>
               <TakeOwnershipPending>false</TakeOwnershipPending>

               <TotalRawCapacity>20000</TotalRawCapacity>

               <Type>LTO5</Type>

               <VerifyPending/>

               <WriteProtected>false</WriteProtected>

            </Tape>

         </Tapes>

      </PhysicalPlacement>

   </Object>

</Data>
<Data>

MARK SUSPECT OBJECT PART IN A STORAGE POOL AS
DEGRADED

Description
Mark the suspect object part in a storage pool, associated with the specified suspect blob
degradation record, as degraded.

CAUTION If you mark the last copy of a blob as degraded, you are not able to GET or VERIFY that
blob.

Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/suspect_blob_pool/[?force]
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Request Parameters

Parameter Description Required

force If included, the BlackPearl gateway marks as degraded all suspect
blobs in storage pools.

no

Request Elements
Unless you use the force parameter, an XML payload, formatted as follows, must be sent to
specify the suspect blob degradation record to update from suspect to degraded.
<ids>

   <id>{string}</id>

   <id>{string}</id>

   <id>{string}</id>

</ids>

where the parameters are defined as follows:

Parameter Description Required

Ids The container for all suspect blob degradation records for which to
mark object parts as degraded.

yes

Id The UUID or other unique attribute for the suspect blob
degradation record for which to mark object parts as degraded. See
Get Suspect Object Parts in Storage Pools on page 1078

yes

Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 400: Bad Request (force flag required)
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Example

Sample Request
This request marks suspect object parts in all storage pools as degraded.
PUT http://blackpearl-hostname/_rest_/suspect_blob_pool/?force HTTP/1.1

Sample Response
HTTP/1.1 204 No Content

MARK SUSPECT OBJECT PART ON TAPE AS DEGRADED

Description
Mark the suspect object part on tape, associated with the specified suspect blob degradation
record, as degraded.

CAUTION If you mark the last copy of a blob as degraded, you are not able to GET or VERIFY that
blob.

Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/suspect_blob_tape/[?force]

Request Parameters

Parameter Description Required

force If included, the BlackPearl gateway marks as degraded all suspect
object parts on tape media.

no
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Request Elements
Unless you use the force parameter, an XML payload, formatted as follows, must be sent to
describe the suspect blob degradation record to update from suspect to degraded.
<ids>

   <id>{string}</id>

   <id>{string}</id>

   <id>{string}</id>

</ids>

where the parameters are defined as follows:

Parameter Description Required

Ids The container for all suspect blob degradation records for which to
mark object parts as degraded.

yes

Id The UUID or other unique attribute for the suspect blob
degradation record for which to mark object parts as degraded. See
Get Suspect Object Parts in Storage Pools on page 1078

yes

Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 400: Bad Request (force flag required)

Example

Sample Request
This request marks suspect object parts on all tape as degraded.
PUT http://blackpearl-hostname/_rest_/suspect_blob_tape/?force HTTP/1.1

Sample Response
HTTP/1.1 204 No Content
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MARK SUSPECT OBJECT PART ON AN AMAZON S3 TARGET
AS DEGRADED

Description
Mark the suspect object part on an Amazon S3 target, associated with the specified suspect
blob degradation record, as degraded.

CAUTION If you mark the last copy of a blob as degraded, you are not able to GET or VERIFY that
blob.

Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/suspect_blob_s3_target/[?force]

Request Parameters

Parameter Description Required

force If included, the BlackPearl gateway marks as degraded all suspect
object parts on Amazon S3 targets.

no

Request Elements
Unless you use the force parameter, an XML payload, formatted as follows, must be sent to
describe the suspect blob degradation record to update from suspect to degraded.
<ids>

   <id>{string}</id>

   <id>{string}</id>

   <id>{string}</id>

</ids>
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where the parameters are defined as follows:

Parameter Description Required

Ids The container for all suspect blob degradation records for which to
mark object parts as degraded.

yes

Id The UUID or other unique attribute for the suspect blob
degradation record for which to mark object parts as degraded. See
Get Suspect Object Parts in Storage Pools on page 1078

yes

Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 400: Bad Request (force flag required)

Example

Sample Request
This request marks suspect object parts on all Amazon S3 targets as degraded.
PUT http://blackpearl-hostname/_rest_/suspect_blob_s3_target/?force HTTP/1.1

Sample Response
HTTP/1.1 204 No Content
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MARK SUSPECT OBJECT PART ON AN AZURE TARGET AS
DEGRADED

Description
Mark the suspect object part on an Azure target, associated with the specified suspect blob
degradation record, as degraded.

CAUTION If you mark the last copy of a blob as degraded, you are not able to GET or VERIFY that
blob.

Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/suspect_blob_azure_target/[?force]

Request Parameters

Parameter Description Required

force If included, the BlackPearl gateway marks as degraded all suspect
object parts on Azure targets.

no

Request Elements
Unless you use the force parameter, an XML payload, formatted as follows, must be sent to
describe the suspect blob degradation record to update from suspect to degraded.
<ids>

   <id>{string}</id>

   <id>{string}</id>

   <id>{string}</id>

</ids>
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where the parameters are defined as follows:

Parameter Description Required

Ids The container for all suspect blob degradation records for which to
mark object parts as degraded.

yes

Id The UUID or other unique attribute for the suspect blob
degradation record for which to mark object parts as degraded. See
Get Suspect Object Parts in Storage Pools on page 1078

yes

Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 400: Bad Request (force flag required)

Example

Sample Request
This request marks suspect object parts on all Azure targets as degraded.
PUT http://blackpearl-hostname/_rest_/suspect_blob_azure_target/?force HTTP/1.1

Sample Response
HTTP/1.1 204 No Content
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MARK SUSPECT OBJECT PART ON A DS3 TARGET AS
DEGRADED

Description
Mark the suspect object part on a BlackPearl target, associated with the specified suspect blob
degradation record, as degraded.

CAUTION If you mark the last copy of a blob as degraded, you are not able to GET or VERIFY that
blob.

Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/suspect_blob_ds3_target/[?force]

Request Parameters

Parameter Description Required

force If included, the BlackPearl gateway marks as degraded all suspect
object parts on BlackPearl targets.

no

Request Elements
Unless you use the force parameter, an XML payload, formatted as follows, must be sent to
describe the suspect blob degradation record to update from suspect to degraded.
<ids>

   <id>{string}</id>

   <id>{string}</id>

   <id>{string}</id>

</ids>
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where the parameters are defined as follows:

Parameter Description Required

Ids The container for all suspect blob degradation records for which to
mark object parts as degraded.

yes

Id The UUID or other unique attribute for the suspect blob
degradation record for which to mark object parts as degraded. See
Get Suspect Object Parts in Storage Pools on page 1078

yes

Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 400: Bad Request (force flag required)

Example

Sample Request
This request marks suspect object parts on all BlackPearl targets as degraded.
PUT http://blackpearl-hostname/_rest_/suspect_blob_ds3_target/?force HTTP/1.1

Sample Response
HTTP/1.1 204 No Content
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This chapter provides detailed descriptions for system level operations.

Force Feature Key Validation 1120

Get Feature Keys 1121

Get Formal API Contract 1124

Get General System Information 1125

Get Request Handlers 1128

Get System Failures 1130

Reset Instance Identifier 1133

Verify System Health 1138

FORCE FEATURE KEY VALIDATION

Description
Forces a synchronous feature key validation.

Note: Feature keys are validated automatically on a regular basis. Only use this
command under the direction of Spectra Logic Technical Support.

Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/feature_key/

Responses

Response Elements
The operation returns status only.

Notable status codes:

• 204: No Content (success)
• 500: Internal Error
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Example

Sample Request
This request validates the feature keys on the target BlackPearl gateway.
PUT http[s]://blackpearl-hostname/_rest_/feature_key/ HTTP/1.1

Sample Response
HTTP/1.1 204 No Content

GET FEATURE KEYS

Description
Returns a list of all feature keys installed on the BlackPearl gateway.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/feature_key/[?error_message={string}]

[&expiration_date={string}][&key={string}][&last_page][&page_length=

{32-bit integer}][&page_offset={32-bit integer}][&page_start_marker={string}]

Request Parameters 

Parameter Description Required

error_
message

The text of the error message. no

expiration_
date

The expiration date of the feature key. no

key The option of which the key enables.
Values: AWS_S3_CLOUD_OUT, MICROSOFT_AZURE_CLOUD_OUT

no

last_page If included, only the last page of results is returned. no
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Parameter Description Required

page_length The maximum number of feature keys to list. Default: all items
after page_offset.

no

page_offset The starting point for the first feature key to list. Default: 0. no

page_start_
marker

The UUID or other unique attribute for the item just before the first
item to list.
Notes:
• Specifying both page_offset and page_start_marker
causes an error.

• If neither page_offset, nor page_start_marker are
specified, the page_offset default is used.

no

Responses

Response Elements
<Data>
   <FeatureKey>
     <CurrentValue>{64-bit integer}</CurrentValue>
     <ErrorMessage>{string}</ErrorMessage>
     <ExpirationDate>{YYYY-MM-DDThh:mm:ss.xxxZ}</ExpirationDate>
     <Id>{string}</Id>
     <Key>AWS_S3_CLOUD_OUT|MICROSOFT_AZURE_CLOUD_OUT</Key>
     <LimitValue>{64-bit integer}</LimitValue>
   </FeatureKey>
...
</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

FeatureKey The container for information about one feature key.
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Parameter Description

CurrentValue The amount of data replicated by the BlackPearl gateway to the Azure or
Amazon S3 target.
Note: If you delete data directly from the target, the CurrentValue is not
updated until a full Verify Target
(see Verify Amazon S3 Target on page 447, or Verify Azure Target on
page 491) completes.

ErrorMessage A description of the error.

ExpirationDate The date and time the feature key expires in the form
YYYY-MM-DDThh:mm:ss.xxxZ .

Id The ID of the feature key.

Key The type of feature key.
Values: AWS_S3_CLOUD_OUT, MICROSOFT_AZURE_CLOUD_OUT

Limit Value The maximum logical cloud replication capacity licensed in bytes.

Example

Sample Request
This request gets information about all feature keys installed on the BlackPearl gateway.
GET http[s]://datapathdnsnameofappliance/_rest_/feature_key/ HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>
   <FeatureKey>
     <CurrentValue/>
     <ErrorMessage/>
     <ExpirationDate/>
     <Id>0f6fac07-624d-4ef6-a9e0-cc802ef8a952</Id>
     <Key>AWS_S3_CLOUD_OUT</Key>
     <LimitValue>1099511627776</LimitValue>
   </FeatureKey>
</Data>
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GET FORMAL API CONTRACT

Description
Provides documentation for each API request in an easy-to-parse format.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/request_handler_contract/

Responses

Response Elements
This operation lists all request handlers supported by the DS3 API. The following information
is given for each request handler:

Request

• Name of call
• Request classification: amazons3, spectrads3, or internal
• Path including path parameters and their types
• Query parameters specifying if the parameter is required or optional, and types (string,
integer, etc.)

• HTTP verb (PUT, GET, etc.)
• List of optional request headers, for example, range or metadata
• Description of the payload if there is one

Response

• Expected status codes
Note: The expected status are NOT exhaustive, nor are the response payload types.

• What the payload is for a specific status code
• What query parameters modify the payload

• Description of payload if there is one
• Request handler version
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Example

Sample Request
This request gets easily parsed documentation for each DS3 API request.
GET http://blackpearl-hostname/_rest_/request_handler_contract/ HTTP/1.1

Sample Response
<Data>

   <Contract>
      <RequestHandlers>
         <RequestHandler Classification="amazons3"

            Name="com.spectralogic.s3.server.handler.reqhandler.

            amazons3.AbortMultiPartUploadRequestHandler">
            <Request BucketRequirement="REQUIRED"

               HttpVerb="DELETE" ObjectRequirement="REQUIRED">
               <OptionalQueryParams/>
               <RequiredQueryParams>
                  <Param Name="UploadId" Type="java.util.UUID"/>
               </RequiredQueryParams>
            </Request>
            <ResponseCodes>
               <ResponseCode>
                  <Code>204</Code>
                  <ResponseTypes>
                     <ResponseType Type="null"/>
                  </ResponseTypes>
               </ResponseCode>
            </ResponseCodes>
         </RequestHandler>
         ...
      </RequestHandlers>
   </Contract>
</Data>

GET GENERAL SYSTEM INFORMATION

Description
Get basic system information, including software version and build information, and the
system serial number.
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Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/system_information/

Responses

Response Elements
<Data>

   <ApiVersion>{string}</ApiVersion>

   <BackendActivated>TRUE|FALSE</BackendActivated>

   <BuildInformation>

      <Branch>{string}</Branch>

      <Revision>{string}</Revision>

      <Version>{string}</Version>

   </BuildInformation>

   <InstanceId>{string}</InstanceId>

   <Now>{64-bit integer}</Now>

   <SerialNumber>{string}</SerialNumber>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

ApiVersion The version of the DS3 API. The version is in the form X.Y, where X is the
MD5 checksum across all request handler major revisions and Y is the MD5
checksum across all request handler full versions (including the minor
revision).

BackendActivated Whether the BlackPearl gateway is allowed to send data to the data path
backend (pool or tape partitions).
Values: TRUE, FALSE

BuildInformation A container for the information about the build.

Branch The branch used to build the API.

Revision The revision of the software build.
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Parameter Description

Version The version of the software build.

InstanceID The UUID for the BlackPearl gateway session.

Now The number of seconds that have elapsed since January 1, 1970 at 00:00:00
GM (UNIX time).

SerialNumber The serial number of the BlackPearl gateway.

Example

Sample Request
This request gets general system information.
GET http://blackpearl-hostname/_rest_/system_information/ HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>

   <ApiVersion>

      5107E9A4021B822F2533C3B619AB1C4C.

      4C2BB2339FC04CDAFB523E1B86F5F2D5

   </ApiVersion>

   <BuildInformation>

      <Branch>//BlueStorm/mainline</Branch>

      <Revision>1099282</Revision>

      <Version>1.0.0</Version>

   </BuildInformation>

   <InstanceId>3c498151-8e6f-4101-acca-7dd9279f0548</InstanceId>
   <Now>1465434924352</Now>

   <SerialNumber>50030480003e6abf</SerialNumber>

</Data>
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GET REQUEST HANDLERS

Description
Get information (and self-documentation) for all the request handlers supported by the
BlackPearl gateway as well as example usage.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/request_handler/[?full_details]

Request Parameters 

Parameter Description Required

full_details If included, the response will give additional details, such as sample
responses.

no

Responses

Response Elements
This operation lists all request handlers supported by the DS3 API. Request handlers
beginning with ‘amazons3’ are based on the Amazon S3 API. Request handlers beginning
with ‘spectrads3’ are specific to the Spectra BlackPearl Nearline Gateway. The following
information is given for each request handler:

• A description of the operation
• Whether the operation is RESTful using the DS3 _rest_ prefix, or it is an Amazon Web
Services operation

• The operation action
• The operation domain
• Required and optional query parameters
• Required component specifiers
• Sample responses
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Example

Sample Request
This request gets the list and all self documentation for all request handlers.
GET http://blackpearl-hostname/_rest_/request_handler/?full_details HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>
   <RequestHandler

Name="com.spectralogic.s3.server.handler.reqhandler.amazons3

        .AbortMultiPartUploadRequestHandler">
     <Documentation>

        Abort / cancel a multi-part upload that has been

        initiated, but has not yet been completed or aborted. This

        is an AWS request (see http://docs.aws.amazon.com/

        AmazonS3/latest/API/mpUploadAbort.html for AWS

        documentation).
     </Documentation>
     <RequestRequirements>

        Must be HTTP request type DELETE

     </RequestRequirements>

     <RequestRequirements>

        Must be an AWS-style request

     </RequestRequirements>
     <RequestRequirements>

        Must include an S3 bucket specification

     </RequestRequirements>
     <RequestRequirements>

        Must include an S3 object specification

     </RequestRequirements>
     <RequestRequirements>

        Query Parameters Required: [upload_id], Optional: []
     </RequestRequirements>
     <SampleResponses>
        <HttpRequest>
           DELETE 'bucket/object' with query parameters

{UPLOAD_ID=4d59acf1-e630-4dd9-a3a1-643889e3e267} and

           headers {Internal-Request=1}.
        </HttpRequest>
        <HttpResponse>
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           with headers {x-amz-request-id=42, RequestHandler-

           Version=1.9D854BF00D3B516D4045D9DBEB4B174A}.
        </HttpResponse>
        <HttpResponseCode>204</HttpResponseCode>
        <HttpResponseType>null</HttpResponseType>
        <Test>

           com.spectralogic.s3.server.handler.reqhandler.amazons3.

           AbortMultiPartUploadRequestHandler_Test.

testAbortMultiPartUploadDelegatesRequestToDataPlanner
        </Test>
     </SampleResponses>
     <SampleUrl>
        http[s]://datapathdnsnameofappliance/{bucket}/

{object}?upload_id={unique identifier or attribute}
     </SampleUrl>
     <Version>1.4C9CF642EA41630162015E7F21918975</Version>
   </RequestHandler>

   ...

</Data>

GET SYSTEM FAILURES

Description
Get a list of all system failures. Use parameters as selection criteria to return a subset of the
list.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/system_failure/[?error_message={string}]

[&last_page][&page_length={32-bit integer}][&page_offset={32-bit integer}][&page_

start_marker={string}][&type=RECONCILE_TAPE_ENVIRONMENT_FAILED|RECONCILE_POOL_

ENVIRONMENT_FAILED|SUSPECTED_DATA_LOSS_REQUIRES_USER_CONFIRMATION]
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Request Parameters

Parameter Description Required

error_
message 1

The description of an error. no

last_page If included, only the last page of results is returned. no

page_length The maximum number of failures to list. The default is all items
after page_offset.

no

page_offset The starting point for the first failure to list. The default is 0. no

page_start_
marker

The UUID or other unique attribute for the item just before the first
item to list.
Notes:
• Specifying both page_offset and page_start_marker causes
an error.

• If neither page_offset, nor page_start_marker are specified,
the page_offset default is used.

no

type The type of system error message.
Values: RECONCILE_TAPE_ENVIRONMENT_FAILED, RECONCILE_
POOL_ENVIRONMENT_FAILED, SUSPECTED_ DATA_LOSS_
REQUIRES_USER_CONFIRMATION
Note: See Degradation Operations on page 1051 for more
information about handling suspect objects.

no

1) Parameter values can use wild cards (see Wild Card Syntax on page 30).
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Responses

Response Elements
<Data>

   <SystemFailure>

      <Date>{YYYY-MM-DDThh:mm:ss.xxxZ}</Date>

      <ErrorMessage>{string}</ErrorMessage>

      <Id>{string}</Id>

      <Type>

         RECONCILE_TAPE_ENVIRONMENT_FAILED|

         RECONCILE_POOL_ENVIRONMENT_FAILED|

         SUSPECTED_DATA_LOSS_REQUIRES_USER_CONFIRMATION

      </Type>

   </SystemFailure>

   ...

</Data>

where the response elements are defined as follows:

Parameter Description

Data A container for the response.

SystemFailure A container for information about a single system failure.

Date The date and time the error occurred in the format
YYYY-MM-DDThh:mm:ss.xxxZ.

ErrorMessage A description of the error.

Id The UUID for the error.

Type The type of tape error message.
Values: RECONCILE_TAPE_ENVIRONMENT_FAILED, RECONCILE_POOL_
ENVIRONMENT_FAILED, SUSPECTED_ DATA_LOSS_REQUIRES_USER_
CONFIRMATION

Example

Sample Request
This request retrieves a list of all system failures.
GET http://blackpearl-hostname/_rest_/system_failure/ HTTP/1.1
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Sample Response
HTTP/1.1 200 OK

<Data>

   <SystemFailure>

      <Date>2015-12-07T03:20:39.000Z</Date>

      <ErrorMessage>{Error Message}</ErrorMessage>

      <Id>da981d00-d090-41d8-8921-3f14224dac16</Id>

      <Type>RECONCILE_POOL_ENVIRONMENT_FAILED</Type>

   </SystemFailure>
   ...
</Data>

RESET INSTANCE IDENTIFIER

Description
Reset and regenerate the BlackPearl gateway instance identifier. Resetting the instance
identifier is only necessary in rare circumstances where there are two branches of an instance
running at the same time. One of the two branches must have its instance identifier reset if
the two instances are to replicate between each other. The most common occurrence of this is
when one instance is initially configured with dual copy where one copy goes on one library
and the other copy goes on the other, then a new BlackPearl gateway is added and one
library and the new gateway moved to another physical location. In this case, both gateways
would start with the same database and each would have the persistence rule and storage
domain for the remote library converted to a replication rule. This requires that one or both
sites have their instance identifier reset first.

Requests

Syntax
PUT http[s]://{datapathDNSname}/_rest_/instance_identifier/
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Responses

Response Elements
<Data>

   <Activated>TRUE|FALSE</Activated>

   <AllowNewJobRequests>TRUE|FALSE</AllowNewJobRequests>

   <AutoActivateTimeoutInMins>

{32-bit integer}

   </AutoActivateTimeoutInMins>

   <AutoInspect>DEFAULT|MINIMAL|NEVER</AutoInspect>

   <CacheAvailableRetryAfterInSeconds>

{32-bit integer}

   </CacheAvailableRetryAfterInSeconds>

   <DefaultVerifyDataAfterImport>

      URGENT|HIGH|NORMAL|LOW

   </DefaultVerifyDataAfterImport>
   <DefaultVerifyDataPriorToImport>

      TRUE|FALSE

   </DefaultVerifyDataPriorToImport>

   <Id>{string}</Id>
   <InstanceId>{string}</InstanceId>

   <IomCacheLimitationPercent>{double}</IomCacheLimitationPercent>

   <IomEnabled>TRUE|FALSE</IomEnabled>

   <LastHeartbeat>YYYY-MM-DDThh:mm:ss.xxxZ</LastHeartbeat>

   <MaxAggregatedBlobsPerChunk>

{32-bit integer}

   </MaxAggregatedBlobsPerChunk>
   <PartiallyVerifyLastPercentOfTape>

{32-bit integer}

   </PartiallyVerifyLastPercentOfTape>
   <PoolSafetyEnabled>TRUE|FALSE</PoolSafetyEnabled>

   <UnavailableMediaPolicy>

       ALLOW|DISCOURAGED|DISALLOW

   </UnavailableMediaPolicy>

   <UnavailablePoolMaxJobRetryInMins>

{32-bit integer}

   </UnavailablePoolMaxJobRetryInMins>

   <UnavailableTapePartitionMaxJobRetryInMins>

{32-bit integer}

   </UnavailableTapePartitionMaxJobRetryInMins>
   <VerifyCheckpointBeforeRead>TRUE|FALSE</VerifyCheckpointBeforeRead>

</Data>
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where the response elements are defined as follows:

Parameter Description

Data The container for the response.

Activated Whether the BlackPearl gateway is allowed to send to the
data path backend (pool or tape partitions).
Values: TRUE, FALSE

AllowNewJob Requests Whether the BlackPearl gateway allows new jobs to be
initiated. Values: TRUE, FALSE

AutoActivate TimeoutInMins The number of minutes allowed for the data planner to
take between when it is shut down and when it comes
back up, and have the data path back end automatically
activate. If the data planner remains shutdown for longer
than this number of minutes, the data path backend will
not automatically activate. If this parameter is null, the
data path backend will never automatically activate.

AutoInspect Whether tape inspections are automatically scheduled
whenever the data planner starts.
Values: DEFAULT, MINIMAL, NEVER
See auto_inspect on page 1044.

CacheAvailable RetryAfterIn
Seconds

The recommended number of seconds for clients to wait
between sending Get Job Chunks Ready for Processing (see
page 222) requests.

DefaultVerifyDataAfterImport The priority for verifying the data after import. This
determines the resources assigned and the processing
order.
Values: URGENT, HIGH, NORMAL, LOW

DefaultVerifyData PriorToImport Whether the data must be verified before the tape is
imported. Values: TRUE, FALSE
Note: It is recommended to verify data prior to import
whenever it is possible that the tapes being imported
contain objects with the same name as objects already in
the bucket. Without verifying data prior to import, it is
possible for the existing object to be replaced with the one
being imported, even if the one being imported is partially
corrupt and cannot be read.

Id The UUID for the record. This is only useful to the
BlackPearl gateway.
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Parameter Description

InstanceID The UUID for the BlackPearl gateway session.

IomCacheLimitationPercent The percentage of the cache, represented as a decimal, that
can be used for IOM tasks.

IomEnabled Whether Intelligent Object Management (IOM) is enabled.

LastHeartbeat The date and time that the gateway last sent a heartbeat in
the format YYYY-MM-DDThh:mm:ss.xxxZ.

MaxAggregatedBlobsPerChunk The maximum number of blobs that can be aggregated into
a single tape task.

PartiallyVerifyLastPercentOfTapes The percentage of the overall tape capacity before the EOD
marker that the BlackPearl gateway verifies during data
integrity verification. Verifying a percentage of the tape,
rather than the entire tape is useful when you only want to
verify the most recent data written to the tape.
Values: 1-99
Note: To verify the entire tape, see Verify Tape on
page 831.

PoolSafetyEnabled Whether the BlackPearl system waits for all data to be
transferred the storage pool before returning that the
operation is complete.
Values: TRUE (default), FALSE

UnavailableMedia Policy Whether new job requests are allowed to use partitions
that are currently unavailable.
Values: ALLOW, DISCOURAGE, DISALLOW
See unavailable_media_policy on page 1045.

UnavailablePool MaxJobRetryIn
Mins

How long job requests using unavailable pools will retry
before being re-chunked or failing if re-chunking cannot
solve the problem.

UnavailableTape PartitionMaxJob
RetryInMins

How long job requests using unavailable tape partitions
will retry before being re-chunked or failing if re-chunking
cannot solve the problem.

VerifyCheckpointBeforeRead When a tape cartridge is loaded into a drive, this
parameter controls whether the BlackPearl system verifies
the starting checkpoint of the tape before reading data.
Values: TRUE (default), FALSE
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Example

Sample Request
This request gets information about the data path backend.
PUT http://blackpearl-hostname/_rest_/instance_identifier/ HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>

   <Activated>TRUE</Activated>
   <AllowNewJobRequests>TRUE</AllowNewJobRequests>

   <AutoActivateTimeoutInMins>30</AutoActivateTimeoutInMins>
   <AutoInspect>DEFAULT</AutoInspect>

   <CacheAvailableRetryAfterInSeconds>

      300

   </CacheAvailableRetryAfterInSeconds

   <DefaultVerifyDataAfterImport/>

   <DefaultVerifyDataPriorToImport>

      TRUE

   </DefaultVerifyDataPriorToImport>

   <Id>7d7601d0-4dba-47a4-8235-8a1ceefe91fa</Id>

   <InstanceId>11c2fc62-075c-4dd6-82b6-9b951638a95d</InstanceId>

   <IomCacheLimitationPercent>.5</IomCacheLimitationPercent>

   <IomEnabled>TRUE</IomEnabled>

   <LastHeartbeat>2016-01-21T18:53:55.000Z</LastHeartbeat>
   <MaxAggregatedBlobsPerChunk>

      20000

   </MaxAggregatedBlobsPerChunk>
   <PartiallyVerifyLastPercentOfTape>

{15}

   </PartiallyVerifyLastPercentOfTape>
   <PoolSafetyEnabled>TRUE</PoolSafetyEnabled>

   <UnavailableMediaPolicy>DISCOURAGED</UnavailableMediaPolicy>

   <UnavailablePoolMaxJobRetryInMins>

      20

   </UnavailablePoolMaxJobRetryInMins>

   <UnavailableTapePartitionMaxJobRetryInMins>

      20

   </UnavailableTapePartitionMaxJobRetryInMins>
   <VerifyCheckpointBeforeRead>FALSE</VerifyCheckpointBeforeRead>

</Data>
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VERIFY SYSTEM HEALTH

Description
Verifies that the system appears to be online and functioning normally and that there is
adequate free space for the database file system.

Requests

Syntax
GET http[s]://{datapathDNSname}/_rest_/system_health/

Responses

Response Elements
<Data>

   <DatabaseFilesystemFreeSpace>

      NORMAL|NEAR_LOW|LOW|CRITICAL

   </DatabaseFilesystemFreeSpace>

   <MsRequiredToVerifyDataPlannerHealth>

{32-bit integer}

   </MsRequiredToVerifyDataPlannerHealth>

</Data>

where the response elements are defined as follows:

Parameter Description

Data The container for the response.

DatabaseFilesystem
FreeSpace

The status of the file system free space.
Values:
• NORMAL — The BlackPearl gateway has enough free space for the file
system to operate.

• NEAR_LOW — Between 10% and 20% of the database file system is free.
Purchase additional SSDs or delete objects to increase free space.

• LOW — Between 5% and 10% of the database file system is free. Some
operations are unavailable until additional SSDs are added.

• CRITICAL — Less than 5% of the database file system is free. No
operations are available until additional SSDs are added.

Note: If you cannot add additional SSDs, contact Spectra Logic Technical
Support (see Contacting Spectra Logic on page 7)
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Parameter Description

MsRequiredTo
VerifyDataPlanner
Health

The amount of time, in milliseconds, that it took the BlackPearl gateway
to respond. If critical components in the data path between the client and
the BlackPearl gateway are unresponsive, an error is generated.

Example

Sample Request
This request checks the system health of the BlackPearl gateway.
GET http://blackpearl-hostname/_rest_/system_health/ HTTP/1.1

Sample Response
HTTP/1.1 200 OK

<Data>

   <DatabaseFilesystemFreeSpace>

      NORMAL

   </DatabaseFilesystemFreeSpace>

   <MsRequiredToVerifyDataPlannerHealth>

      0

   </MsRequiredToVerifyDataPlannerHealth>

</Data>
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